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About Automation Engine

Maximizing Productivity

Automation Engine doesn't only enable you to keep track of your files throughout your workflow, it also optimizes
and automates this workflow to increase your productivity.

Automation Engine:

• avoids double entry and possible operator errors,
• processes files faster (through digital standardization of production procedures, hot folders automation, smart

notifications...).
• frees operators from administrative tasks so they can concentrate on value-adding graphical tasks,
• allows operators to share their expertise through tickets,
• keeps jobs, related files and related customer information organized to facilitate communication and treatment of

additional orders.

All this maximizes your efficiency and the quality of your deliverables, while lowering the cost of prepress-related
actions.

Integrating with your Existing Systems

Automation Engine can integrate seamlessly with your graphical editors, RIP, file servers, MIS system...

It supports the industry standards (PDF, XML, XMP, SQL queries, JDF communication...).

The Automation Engine client application (the “Pilot”) can be installed on any Macintosh or Windows machine in
your network, so all your operators can view files, get information or launch processing tasks as needed.

Growing with You

Automation Engine is very modular and can be tailored to your needs, while always offering growth possibilities.

From a background assistant to Adobe® Illustrator® to a central prepress server to a complete server platform linking
to your administrative systems, Automation Engine can grow with you to let you handle larger accounts, accepting
more jobs without increasing your costs.

You can find an overview of all Automation Engine modules on the Esko website.

Copyright Notice

© Copyright 2013 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko
Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of
any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does
not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or
the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or
incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to
advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or
in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written
permission from Esko Software BVBA.

http://www.esko.com/Web/site.aspx?p=4589
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This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or
registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite,
Incorporated. © Pantone LLC, 2012. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright
©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop,
PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other
countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the
Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the
U.S. and other countries.

Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

Getting Help

You can find the PDF version of this manual on the Automation Engine Documentation DVD.

To get an overview all of the keyboard shortcuts you can use in the Automation Engine Pilot, go to  Help >
Shortcuts...
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What is Automation Engine

Automation Engine Architecture

Automation Engine is a client/server workflow software, running on Mac and PC. This means that one machine
runs the Automation Engine server, to which you can connect from all Mac and PC machines in your network (using
the Automation Engine Pilot).

Your Automation Engine server can connect to graphical editing software like ArtPro, PackEdge, Adobe Illustrator
(using the DeskPack plug-ins)...

It can also connect to your RIP software to ensure professional output.

You can store your files either on the Automation Engine server, on a dedicated file server, or on different machines
over the network (using containers).
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Automation Engine Processing

Automation Engine processes your files using Tasks (for example a Trap or RIP task), Task Chains (a succession
of tasks, for example normalizing your PDF file, trapping it, then zipping it), and Workflows (more powerful and
flexible grouping of tasks, that can take complete care of the file from input to output).

Files and Jobs in Automation Engine

In Automation Engine, your files can be part of jobs (customer orders that contain files and related customer
information), that are located in containers (local or remote shared folders that Automation Engine can access).
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Depending on how you want to work with Automation Engine, you can link your jobs to customer products, focus on
job pages, proofs, plates...

Automation Engine Integration

Automation Engine can not only connect to editing and RIP software, but also to WebCenter (Esko’s collaborative
web platform) and other Esko workflow software (Nexus and Odystar).

The Automation Engine Pilot

The Automation Engine server software runs on a Windows server. Every Automation Engine action is performed
through the Automation Engine client, called the Pilot.

The Pilot can be installed on any Mac or Windows machine on your local network.

Depending on the user access rights you will set, operators can use the Pilot to:

• organize jobs and files,
• create and modify tickets,
• launch and monitor tasks,
• control workflows and devices,
• administrate users and perform general configuration,
• etc.

The Pilot's Main Window

 

 

1. These icons show different modes in the Pilot:

•
Containers : this shows all the data that Automation Engine can access, in the different Containers. For
more information, see Containers.

•
Job Overview : this lists all jobs existing in the Automation Engine Job database. See Jobs.

•
Last used Job : this shows the last job you worked on, and the job's data (files and folders).

2. The Views highlight different parts of the Automation Engine functionality. Certain views are only accessible in
defined workflows. For more information, see Views.
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3. The Tools area contains tools useful to administrate Automation Engine. See Tools on page  for more
information.

4. •
The Create Job  button allows you to create a job.

•

The New Task  button creates a new Ticket from the pilot.
•

You can create a new workflow from the pilot using .
•

Using the  button, you can access the information regarding the files.

Note:  In the Job Overview mode, only Create Job  is available.

The contents of the central panes depend on the View you are in.

Views

The Pilot's Views highlight different parts of the Automation Engine functionality. You can use them to work with
your data in different ways (see Different Ways of Working with Automation Engine).

Note:

• Depending on the mode you are using (Containers, Job Overview or Last used job), you will have
access to different views.

• Depending on your access rights, you may not be able to see some of the views.

Files

The Files view allows you to manage your jobs, files, favorites, tasks... See The Files View on page  for more
information.

To Do List

The To Do List view lists all actions that need user intervention. For more information, see The To Do List View on
page  and To Do List on page .

Pages

The Pages view is only used in page workflows. It is extremely useful when working with impositions. For more
information, see Working with Pages.

Products

The Product view shows the production files associated with your jobs, and allows you to reuse those files for a
similar order from the same customer. For more information, see Working with Products.

Proofs

The Proof view is only used in page workflows. It shows the proof sets and the proof details. See Working with
Proofs.

WebCenter

Before you can use the WebCenter view, make sure that your WebCenter site is correctly configured. See
Integration with WebCenter.
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Plates

The Plates view is only used in page workflows. It shows details about all plates associated with a job. It also
includes advanced features for managing plates for jobs with multiple versions. See Working with Plates.

CDI

The CDI view shows all the files sent to the Digital Flexo Suite and used to image a flexo plate on a Cyrel Digital
Imager. See The CDI View on page .

Gang Run Printing

The Gang Run Printing view in the Pilot shows an overview of Jobs that are waiting to be nested and printed on
common sheets for each of the available substrates. It has two parts:

• The list of all substrates.
• The table of jobs waiting to be nested and printed on the selected substrate.

See Gang Run Printing View

The Tasks view shows the current state of processing: the running tasks, the tasks waiting for execution and the
recently finished tasks. See The Tasks View on page .

Devices

The Devices view lists all output devices connected to your Automation Engine server. It allows you to monitor, start
and stop your devices and device queues.

Milestones

The Milestone view shows all milestones set for your last job (in Last used job mode), or the milestones set for all
jobs (in Job Overview mode). See Milestones.

Hot Folders

The Hot Folders view lists all hot folders defined on the server (in Container mode) or all hot folders defined for a
job (in Last used job mode). It offers all the necessary tools to create and manage hot folders.

Tickets

The Tickets view shows a list of all tickets available on your server (both the default and your custom tickets). See
Tickets.

Jobs

This view is only visible in Job Overview mode. It lists all jobs defined on the server. See The Jobs View on page
.

SmartNames

This view is only visible in Containers mode. It lists all SmartNames defined on the server. See The SmartNames
View.

The Files View

This view is available in Containers and Job modes.
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1. The Folders pane shows your containers, folders and job folders (in Containers mode) or a job folder and its
subfolders (in Job mode).

2. The Contents pane shows the contents of the folder you selected in the Folders pane. It only shows the contents
of a job folder in Job mode.

3. The Launch Favorites pane allows you to add tickets to your favorites and find them again quickly to launch
them. For more information, see Favorite Tickets.

4. The Tasks pane shows all the tasks launched for a job (if a job is selected), or all tasks launched on your server.

The To Do List View

This view is available in Containers and Job modes.

The To Do List view lists all actions that need user intervention. Among these actions are Messages, Checkpoints,
Red Alerts, Milestone Actions.

Use this view to view, modify, forward and delete these actions, and all related files.

Note:  The To Do List view is job context dependent:

• in container mode you can see all To Dos,
• in a job context you only see the To Dos of that job.
•

you can release the jobs from this view by clicking on  .
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Tip:

• Initially, the entries in the To Do List are not sorted. You can sort them by clicking the appropriate
column heading.

You can also show / hide or reorganise columns by going to  View > Select Columns in 'To Do List'...
• You can refresh the list using Ctrl + R or  Edit > Refresh .

For more information, see To Do List on page .

The Pages View

This view is only available in Job mode. It is only used in page workflows.

The Pages View is divided into several panes. The top part of the view (the Page Gallery and the Details pane)
displays both assigned and unassigned pages, the bottom part displays the impositions, layers and assigned pages.
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1. The Page Gallery pane lists all incoming files, indicates the number of pages and the assignment status.
2. The Details pane displays thumbnails of the individual pages of the selected file.
3. The Imposition Gallery pane shows the imposition structure with its different books. It also allows you to create

books that later will be used in an imposition.
4. The Layers pane shows the different layers of the selected imposition. You can rename layers, approve them, and

set them empty or blank.

Note:  The Layers pane is only visible when the selected imposition or book contains more than one
layer.

5. The Page List shows you which pages are assigned and which are not. For each page status information can be
asked.

6. Click the Page List button to switch between thumbnail view or list view.

You can view both the task status and the page status information. Simply right-click the columns Page Gallery and /
or Imposition Gallery pane(s) and select both Task Status and Page Status.

 

 

See Working with Pages on page  for more information.
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The Products View

This view is available in Containers and Job modes.

The Products view is a user-friendly, searchable view on the Products defined on the Automation Engine server,
from which you can create new Products, search existing Products and link Products to Jobs.

You can see the Products in a thumbnail view  or a list view .

In list view, you can right-click the columns to choose the columns to show/hide.

 

 

When you select a Product with Parts, its Parts will be visible on the right hand side.

See Working with Products on page  for more information.

The Proofs View

This view is only available in Job mode. It is only used in page workflows.

The Proof View consists of two panes that give a different view on the proof:

1. The Proof Sets pane, where the proof sets are listed.
2. The Details pane is a visual presentation of all proofs of the set.

The Proof Sets pane shows you the names of the proof sets, both hardcopy proofs and softproofs, as well as the
number of flats, pages, status, the date on which they were last modified and information about the kind of proof that
has been made (Content proof if a file is proofed, or Imposition proof if an imp file is proofed).

Thumbnails of the proofs can be viewed with the corresponding application, for example Acrobat for PDF proofs.
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The Info button will open a properties file of that page (proof).

See Working with Proofs on page  for more information.

The WebCenter View

This view is only available in Job mode.

Attention:  You need to have configured the connection to your WebCenter site before you can use this view.
See WebCenter Sites on page .

Jobs that have been published on WebCenter (with the Publish on Web task or the Publish imposition on
WebCenter Chain) will appear in the WebCenter View.

Those jobs can have different statuses:

• When a job arrives on the WebCenter site and approval is required, its status will pending.
• Files which do not require approval are marked with approval is not required.
• After a file is approved or rejected in WebCenter, you can see its approved or rejected status in the WebCenter

view.

The status will be updated in Automation Engine as soon as the job is approved or rejected in WebCenter.
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Tip:

• Press F5 to update the WebCenter view to the latest information.
• Click the link in the top-left corner to open WebCenter in a browser window.

See Integration with WebCenter in the User Guide for more information.

The Plates View

This view is only available in Job mode. It is only used in page workflows.

• The Plates View makes it easier to manage the most important deliverables that prepress provides to the press
room, plates.

• It gives an overview of the total number of plates that have to be output.
• It allows you to track the progress of a job at a very detailed level.
• It allows you to detect discrepancies between the expected plate output and the supplied data very easily.

For example, when a sheet side is supposed to have only a black plate, but one of the supplied pages for that sheet
side contains CMYK, this can be easily seen in the Plates overview.

The same is true for the inverse situation (for example when an expected Pantone plate is not being realized).
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See Working with Plates on page  for more information.

The CDI View

This view is available in Job Overview and Job modes.

The CDI view shows all the files sent to the Digital Flexo Suite (using the Make Plate on CDI task) and used to
image a flexo plate on a Cyrel Digital Imager.

You can view the flexo plates created for all jobs (in Job Overview mode) or for a particular job (in Job mode).

You can double-click an entry in Job Overview mode to see all the plates and len files corresponding to that job in
Job mode.

You can also select an entry to view its Details at the bottom of the window.
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See Make Plate on CDI on page  for more information.

The Tasks View

This view is available in Containers and Job modes.

• In Containers mode, it shows all tasks, task chains and workflows run on the Automation Engine server.
• In Job mode, it shows all tasks, task chains and workflows run for that job.
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Tasks

For each entry in the Tasks list, you can see the Job Name, the File Name, the Task Type...

You can show / hide or reorganise columns by going to  View > Select Columns in 'Tasks'...

Filter

You can filter the list of entries using the drop-down menu at the top. The default filters are All Tasks, Cancelled,
Checkpoint, Errors, Normalize, Processor and Warnings.

You can also define a custom filter, or type text in the input field to search on the Task Type or File Name of the
entry.

Details

Select an entry in the Tasks list to show its Details below. They include extra information, like when processing was
Started and Finished, and some processing details.

Note:  For more information on how to run tasks and workflows on files, see Running Tasks on Files and
Running Workflows on Files in the User Guide.

The Milestones View

This view is available in Job Overview and Job modes.

For each milestone, a colored icon indicates the milestone's status:

•  indicates the "start" milestone for the job.
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•  indicates today on the time line.
•  indicates the selected milestone.
•  indicates a pending milestone.
•

 indicates an overdue milestone.
•

 indicates a milestone that is being handled.
•  indicates that a milestone is completed.
•

 indicates that a milestone is confirmed (the milestone must be completed before it can be confirmed).

In Job Overview Mode

When you are in Job Overview mode, you can see all milestones set for all jobs in your container.

The Milestones view can show you two overviews.

The Timeline View

The Timeline View  shows you all milestones for each job, for a period you define.

 

 

You can use:

•
 to show 1 day, 7 days, 14 days or 31 days.

•  to show the previous day, the previous week, the current day, the next day or the next week.

You can also click a milestone to see the Milestone Details at the bottom.
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The Status View

The Status View  shows you the status of your chosen milestones for each job.

 

 

Go to  View > Columns  to choose the milestones to display in the Status View.

If no icon appears in a milestone column, this means that this milestone is not defined for that job.

In Job Mode

In Last Used Job mode, the Milestones view shows all the milestones for a specific job.
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You can use:

•
 to show 1 day, 7 days, 14 days or 31 days.

•  to show the previous day, the previous week, the current day, the next day or the next week.

You can also click a milestone to see details at the bottom (for example, if there is an action attached to the
milestone).

The example above shows the milestones of the job “Orange_Juice”:

• The job is created on Friday, and the files arrive right afterwards.
• The imposition is ready on Monday, on schedule.
• The imposition proofs are expected to be ready on Tuesday.
• The imposition proofs should be approved by Thursday.

The Tickets View

This view is available in Containers and Job modes.

You can see all the available tickets in the Pilot's Tickets view.
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You can see:

• default and custom tickets,
• global and job tickets,
• public tickets.

See  Tickets on page  for more information about tickets.

The Jobs View

This view is only available in Job Overview mode (when the Job Overview button  is selected).

In this view, the Pilot lists all Jobs on the server.
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1. Menu
2. Tool bar: see Jobs View Tool Bar.
3. List: lists all Jobs defined on the server.
4. Job Details: display the details of the selected job.

If you want to edit the Job Details, select 'Info' from the 'File Menu' [CTRL + I] or right-click a Job and select
'Info' from the context menu.

For more information on the Job Details, see Creating a Job.

The SmartNames View

The SmartNames View is a dedicated View where you can :

•
create a new SmartName by clicking on the New SmartName icon  in the toolbar or by choosing  File > 
New SmartName . Read more in

•

duplicate a SmartName. Select the SmartName you want to duplicate and click on the Duplicate  icon in
the toolbar.

Note:  You cannot duplicate System SmartNames.

•

delete a SmartName. Select it and click on the Delete  button in the toolbar or choose  File > Delete . You
can also delete multiple SmartNames.
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•
Preview the SmartName's details by clicking on the Preview icon 

• filter the SmartNames on their Name, Scope, Type, Category, Description and Private.

You can create dedicated SmartViews for individual SmartNames. Read more in Creating Smart Views

Gang Run Printing View

The Gang Run Printing view in the Pilot shows an overview of all Jobs that are waiting to be nested and printed on
common sheets for each of the available substrates. You can create new Substrates and process the submitted Gang
Run jobs per substrate for nesting and printing.

The View contains:

• Substrates list containing available substrates.
• Jobs table displaying the jobs waiting to be nested and printed on the selected substrate.
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Read more in List of Substrates on page  and in Table of Jobs.

List of Substrates
This part lists all known and available Substrates.

The Substrates list:

• updates when a User makes changes to the substrates.
• updates when Jobs with a new substrate is submitted. This will use the default nesting and printing settings will be

applicable.
• displays how many associated nesting and printing jobs are waiting next to every substrate. This number updates

when jobs are added or deleted.
• shows animated substrate icon when nesting is going on.

Click the action menu button  located at the bottom of the page. The action menu will pop up with the following
options:

• Add Substrate... allows you to a new substrate.
• Edit Substrate... allows you to edit the sheet sizes, nesting settings and workflow of the selected substrate.
• Duplicate Substrate... allows you to add a new substrate using the sheet sizes, nesting settings and workflow of

an existing substrate.
• Delete Substrate allows you to delete the selected substrate.
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These options are also available via the File menu of the Gang Run Printing view.

When you choose to Add/Edit/Duplicate Substrate a dialog will pop up where you can set the name, the sheet sizes,
the nesting settings and the workflow for the substrate you are adding, editing or duplicating.

Read more in
Adding a Substrate

1. Click on the action menu button  located at the bottom of the Substrates list.

2. Select Add Substrate....
The Add Substrate dialog will pop up.

3. Enter the Name for the new substrate.

4. In the Sheet Sizes tab, specify sheet sizes.

You need to define at least one sheet size for the substrate, otherwise jobs specifying the substrate will not be
nested and printed.

5. Set the nesting settings for the substrate in the Nesting tab.

6. In the Workflow tab, set the workflow for the new substrate.

You need to define the workflow for the newly added substrate here.

7. Click OK.

Editing a Substrate

1. Select the substrate that you want to edit from the list of Substrates
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2. Click on the action menu button  located at the bottom of the Substrates list.

 

 

3. Select Edit Substrate....
The Edit Substrate dialog will pop up.

4. In the Sheet Sizes tab, you can add, modify or delete sheet sizes for the selected substrate.

5. Edit the nesting settings for the substrate in the Nesting tab.

6. In the Workflow tab, edit the workflow for the selected substrate.

7. Click OK to save the changes or Cancel to revert.

Duplicating a Substrate

1. Select the substrate that you want to duplicate from the list of Substrates

2. Click on the action menu button  located at the bottom of the Substrates list.

 

 

3. Select Duplicate Substrate....
The Duplicate Substrate dialog will pop up.

4. Enter the name for the new substrate.

5. In the Sheet Sizes tab, you can add, modify or delete sheet sizes for the new substrate.

6. Yo may edit the existing nesting settings for the substrate in the Nesting tab and the Workflow tab settings.

7. Click OK to save the changes or Cancel to revert.



Automation Engine | What is Automation Engine | 37

Deleting a Substrate

1. Select the substrate that you want to delete from the list of Substrates

2. Click on the action menu button  located at the bottom of the Substrates list.

3. Select Delete Substrate....

4. Confirm by clicking Delete.

Add/Edit/Duplicate Dialog

The Add/Edit/Duplicate Substrate dialog has the following tabs:

• The Sheet Sizes tab allows you to manage (add, edit and delete) the sheet sizes for the substrate and available
quantities.

• The Nesting tab allows you to set the nesting settings for the substrate (e.g. nesting type, search method, first cut,
gutter, minimum fill, etc).

• The Workflow tab allows you to set the workflow for the substrate and the workflow launch time.

Sheet Sizes tab
Adding a Sheet Size

1. In the Sheet Sizes tab, click on Add.
The Add Sheet Size dialog will open up.

2. Give a Name for the Sheet Size.
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3. Enter desired width and height under Sizeand margins.

4. Optionally, you can check Use available quantity of and set the available quantity.

5. Click OK.

6. Click OK in the Add Substrate/Edit Substrate/ Duplicate Substrate window.

Note:  This step is necessary to save your new sheet size.

 

 

Read about importing a sheet size from XML here :Import Sheet Size from XML on page 

Editing a Sheet Size

1. In the Sheet Sizes tab, select the sheet size to be edited. Click Edit.
The Edit Sheet Size dialog will open up.

2. Set the new width and height under Sizeand margins to modify.

3. Modify the set available quantity next to Use available quantity of if any.

4. Click OK.

5. Click OK in the Add Substrate/Edit Substrate/ Duplicate Substrate window.

Note:  This step is necessary to save your edited sheet size.

Deleting a Sheet Size

1. In the Sheet Sizes tab, select the sheet size to be edited. Click Remove.

2. Click OK in the Edit Substrate /Duplicate Sheet Size window.
The sheet size will be deleted.

Importing a Sheet Size

Context for the current task

Task step.
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Nesting Tab

Here, you can specify the nesting settings for the substrate. When jobs are submitted to the gang run for the substrate,
these settings will be applied.

 

 

Nesting Tab Settings

• Select the Nesting Type to use for the layout:

• Minimal Waste tries to reduce the waste in material to a minimum,
• Minimum Layouts reduces the number of production files to a minimum (as for each new layout, a new print

file and cutting file are generated),
• Guillotine Cut prepares layouts to be cut on a Guillotine table, reducing the number of cuts, and making sure

all cuts are possible on a guillotine cutter.
• Select the Search Method to use for calculating the layout.

Depending on if you are running a test or processing graphics for production, you can set the layout search from
Very Fast to Slow (Very Accurate) (the faster the search, the less accurate the result can be).

• Optionally, select Respect the graphics order if you want to nest the graphics in the order in which they are
coming in.

• If you have selected Minimal Waste or Minimum Layouts, you can set:

• the Fill Starting Point on Sheet (where the first graphic will be placed): at the Top Left, Top Right, Bottom
Left or Bottom Right,

• the Primary Fill Direction (in which direction the sheet will be filled): Horizontal or Vertical.
• If you have selected Guillotine Cut, you can set:

• the direction of the First Cut: Horizontal, Vertical or Don't Care,
• If desired, you can add a Gutter in between cut paths (specify the width).
• If the graphics in your files have a bleed outside the cut path, you can clip it away by entering the bleed distance

into Bleed Clipping Mask.
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• Choose

• a Maximum Overrun to get less different layouts: if you are printing different quantities of your various
graphics, some of the graphics with a lower quantity might get printed in excess to keep the number of layouts
to a minimum. Enter the maximum number of excess graphics that can be printed in Maximum Overrun.

If you only want to print the exact quantity you specified for each graphic, keep the Maximum Overrun to 0.
• In Rotation, specify if the task can rotate the layout in case a better fit is possible. You can choose:

• Allow any angle,
• Allow 90 degree,
• Allow 180 degree,
• No rotation.

• Enter a Minimum Fill if you only want to output the sheet if it's filled to a certain level.

Note:

Do not put 100% here as only the graphics inside the cut path count as fill. The margins, gutters etc. all
count as waste.

By default, the minimum fill is set to 75%.

Workflow Tab

Here, you can set the workflow for the substrate. The set Workflow will be launched automatically when the nesting
and printing of the jobs is finished.

Note:  It is mandatory to define a workflow for each substrate.
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Settings

• Workflow: give the name of the workflow connected to that specific substrate.
• Launch Automatically: Set the waiting durationin hours and minutes before the launch due date here. I

Table of Jobs

Here you can view the jobs waiting to be nested and printed on the selected substrate.

• This table is sorted in descending order by default. You can select the listed jobs and re-order them.
• The columns visible in the table of jobs can be selected and re-ordered.
• You can make the columns of the custom fields that are defined for submitted jobs visible.
• You can adjust the width of the columns.
• Your column settings are saved when you quit the Pilot to be restored for the next time.

In the table of jobs, you can hold, release and delete jobs or choose to nest and use print now (force out). The
toolbar contains:

• the Hold button to hold the selected jobs.
• the Release button to release the selected jobs on hold.
• the Print Now button allows you to launch the nesting and printing the selected jobs immediately (force out).
• The Delete button allows you to delete the selected jobs from the gang run for the substrate.

 

 

You can group the submitted jobs based on certain grouping keys configured in  Tools > Configure . Read more in
Gang Run Printing on page .

The values for these grouping keys are defined in Submit to Gang Run  task under the Extra tab. Read more in
Submit To Gang Run on page 

Showing/Hiding Columns in Gangrun View

1. In the Gang Run Printing view, go to  View > Select Columns in Gang Run Printing .

 

 

The Columns window will open up.
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2. Select and move the columns from Available columns to Show these columns or vice versa using the arrows.

3. Optionally, you can alter the order of the displayed columns by using Move Up and Move Down controls.

Troubleshooting Gang Run Printing

• Check if at least one Sheet Size is defined for the substrate.
• Check if a workflow is defined for the substrate.

Smart Views

The Smart Views feature allows you to filter your search scope and generate a list of search results that answers to
your specific request(s). You can use this to create filters for all the items available under Views.

You can save the filtered search to the Views bar for reuse. Smart Views also makes it easier to and to navigate
between views.

Creating Smart Views

Proceed as follows to create a Smart View that will filter all tasks based on these criteria:

• Belong to a chosen operator/administrator
• Launched during the past two days
• Failed

1. In the Automation Engine Pilot, go to the Containers view and then click Tasks to see an overview of all tasks.
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2. Press Ctrl + F to open the Search bar and see the extra filter options that can help you to limit your search results.

3. Set these filters:
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• Set the first filter to Operator + is + <the operator whose task you want to see>. You can browse for the
operator/administrator of your choice by clicking the Browse button in the Search field (1).

• Open a second filter line by clicking the +-button (2) in the first filter line.
• Set the following parameters for this second filter: Launched date + is + within last + 2 +

days

4. Click the +-sign in the second filter line while holding down the Alt-key.
It changes into a ... - sign and allows you to further specify that second filter line by adding one or more criteria to
it.

5. Add these filters:

• All of the following are true
• State is 'cancelled'

6. Click Save to save these filter settings in a Smart View and give it an appropriate name.

• Select the option All users to make this Smart View accessible for other users all well.
• Select the option Add to my views bar to add this smart view to the Views bar.

 

 
The Smart View 'Admin tasks - failed - 2 days' is now part of the Smart Views list.

Pilot Preferences

Go to  Edit > Preferences  to open the Pilot's Preferences.

Tickets

• Show default tickets: select/deselect this option to show/hide the default tickets.
• Use bold ticket names in task launching menu: select this if you want to see the ticket names in bold when

doing New Task or Launch with on a file.
• Show only Public Parameters in Tickets: this preference is only available if you have the Tickets: Show All

Tickets and their Parameters (Public and other) access right (see Access Rights on page ).
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It is selected by default. Deselect it to only see public tickets and public parameters in the Pilot (you will see the
Pilot as if you didn't have the Tickets: Show All Tickets and their Parameters (Public and other) access right).
You can select that preference again at any time to go back to the full Pilot.

This is useful for administrators who want to check how users without the full Pilot access right will see the
tickets and their parameters.

• Units: select the units you want to work with for Dimension (mm, cm, mil, inch, point), Resolution (ppi, ppmm,
ppcm) and Ruling (lpi, lpmm, lpcm).

• Enter the number of Decimals you want the system to display.

Files

The Preview Size allows you to define the size of the preview in the Info dialog for example (in pixels).

Open Normalized PDF files with

Indicate which application should become the default application when opening Normalized PDF files from within
the Pilot.

Normalized PDF files have a .PDF extension, which implies that the OS will not make a distinction between
Normalized PDF files and regular PDF files.

By default PDF files will be opened by the OS with Adobe Acrobat Reader if it is installed. However, when working
with the Pilot, you probably will want to see Normalized PDF files opened in an Esko editor. As making this
distinction is not possible on OS level, you will have to specify here which application you prefer to use.

So, if a PDF file is double-clicked in the Pilot, and it happens to be a Normalized PDF file, the application selected in
the Files tab will be used.

On OS level (for example in Windows Explorer or Macintosh Finder), Adobe Acrobat Reader will be the application
that is started up when you double-click a Normalized PDF file.

This preference will be taken into account:

• In the Files View, when double-clicking the file or selecting Open from the pop-up menu.
• In the Task View, when selecting Open Output File from the pop-up menu.
• In the To Do List, when clicking a URL link to a PDF.

Tip:  Still, the Pilot also offers Open with which allows you to indicate the non-default choice.

Pilot

You can indicate the Number of recently used jobs in the job selector. By default this is set to 10. Changes will be
applied when you log on to Automation Engine.

Jobs

The Jobs tab in the Preferences dialog consists of two areas:

Job Overview

Select the properties on which the Job filter in the Job Overview should search.

You can enable or disable the Order ID, Job Name, Project ID and Customer Job Reference fields.

Multi-Job Removal

Select your preferences for removing multiple jobs at once:

• Remove Jobs even when they are in use by other users.
• Remove Jobs even when they contain unfinished tasks.
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Data Management in Automation Engine

Automation Engine works with containers, jobs, files and folders.

In the Pilot, you can view your data (files and folders) inside containers or/and jobs. There are three modes:

•
Containers : this shows all the data that Automation Engine can access, in the different Containers. For more
information, see Containers.

•
Job Overview : this lists all jobs existing in the Automation Engine Job database. See Jobs.

•
Last used Job : this shows the last job you worked on, and the job's data (files and folders).

 Containers

A container is a special folder containing your files, folders and jobs, that Automation Engine can access. It can be
located either on your Automation Engine server or another machine.

By default, you have an empty ExampleJobContainer, on the drive Automation Engine was installed on.

You can have many containers, that you can see in the Pilots’ Containers mode.

 

 

To create a container, see Creating a Container.

 Jobs

What is a Job?

A job contains all the files and information relative to a customer job you process in Automation Engine.

It has a blue icon  and is stored in the Automation Engine Job Database. The database can hold up to 100 000
jobs.

In the Containers mode, you can see your job in its container.
 

 

In the Last used job mode, you can see your job’s subfolders and files.
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Job Metadata

You can attach an extended set of metadata to every job: customer information, inks to use, bar codes, impositions...).
This metadata is stored in the Automation Engine database, and will be used when launching tasks on the job.

Job Automation

Automation Engine is very job-centric. On top of launching tasks and workflows on the job, you can also have tasks
be launched automatically when the job reaches a certain status (for example: a new page has been delivered, the
sheet is complete...).

For more information about Jobs, please see Working with Jobs on page .

Files Processing in Automation Engine

In Automation Engine, you can process your files using Tasks, Task Chains (old BackStage workflows), and
Workflows.

Each of these has a Ticket, which contains all the parameters for that task, task chain or workflow.

Tasks

What is a Task?

A task is an action executed on a file, a folder or a job on the Automation Engine server.

Types of Tasks

There are seven types of tasks:

1. Conversion tasks such as Export to PDF, Export to PostScript...
2. File Creation tasks such as Create Wrapper File, Create PAF / JPG / XML...
3. File Editing tasks such as Contourize & Clean, Trap...
4. Verification tasks such as Check Job Parameters, Check Print Rules, Preflight...
5. Administration tasks such as Prepare to Archive, Upload via FTP, Zip...
6. RIP tasks.
7. Device Output tasks.

Task Settings

You can define settings for the tasks, and save these settings as Tickets to reuse them (see Tickets).

Task Progress

When a task is launched, you can monitor its progress in the Pilot. See Checking the Status of the Task.
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Task Chains

Old BackStage workflows are still supported in Automation Engine (just as in BackStage), but are now called Task
Chains.

A task chain is a succession of tasks, linked together in the task chain ticket.

 

 

You can build new workflows from your task chains, while keeping all your tickets settings (see Reusing a Task
Chain Ticket to Build a Workflow).

Workflows

Automation Engine workflows are more powerful and flexible than the old BackStage workflows.

You can build them and launch them on your files using the workflow editor (see The Workflow Editor). You can also
launch them from the Pilot or from Shuttle (see Using Shuttle to Upload and Process Files).

 Tickets

What is a Ticket?

The settings used when executing a task, task chain or workflow on a file can be saved as a ticket.

Default and Custom Tickets

The Pilot comes with a default ticket for each task, but you can also create custom tickets. You cannot overwrite or
delete default tickets.

You can see all the available tickets (default and custom) in the Pilot's Tickets view.
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Global and Job Tickets

Global tickets ( ) can be used on any file you can access through the Automation Engine Pilot, whereas job tickets

( ) are linked to a particular job.

Public Tickets

You can make tickets public if you want to submit files to them from Shuttle. There are several ways to make a ticket
public (see Making Your Ticket Public in the User Guide).

Public tickets have a mark in the Public column.

 

 

Note:  Depending on your access rights, you may only see public tickets, and public parameters inside the
tickets.

Inside a Ticket
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1. The menus:

• Use the File menu to create a New ticket, Save the ticket, save it under another name (Save As), or Close it.
• Use the View menu to Show different kind of tickets (when creating a task chain): All, Public, Global or Job

Tickets.
• Use the Advanced menu to Manage Public Parameters.

2. Use the Save and Close button when you are done editing the current ticket.

Note:  If you were editing a default ticket, the system will ask you to save the ticket under another name.

3. Steps: Use this part of the ticket to create task chains.

For more information, see Task Chains on page .
4. Most of the tickets offer the possibility to define an Output path and a File Name.

Use the Browse button to browse to the output path.

Use the SmartNames icon  to add SmartNames to the output path and / or file name.

For more information, see Using SmartNames on page .
5.

You can add a Notification to the task by clicking .

For more information, see Notifications on page .
6. The ticket's settings differ for all tasks.

For an in depth explanation on the various tasks and tickets, please see The Tasks: an Overview on page .
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Notifications

You can add notifications to tasks. This means that you can get the system to notify a user by sending a mail when a
task finishes, or notify another system by feeding it an XML or a TXT notification.

To add a notification:

1.
Click the notification button  in a ticket.
 

 

The 'Notification' dialog pops up.

 

 
2. Click 'Add'.

The 'Notification Rule Editor' pops up.
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3. Define the Notification.

Define the condition for the notification and the action.

A notification may consist of an e-mail sent to the task owner (or to any other valid address), it may also be an
entry in a XML/text file, or an XML/text file in a certain folder.

Note:  When selecting “Send an e-mail”, you can add more than 1 e-mail address in the 'To' field
(including SmartNames) by using ' ; ' as a separator.

You can add the input files, the output files, the task's log file and or the ticket to the notification.

The notification can be based on a template. Hit the 'Edit templates ...' button to create and modify templates.

For more information, please see 'Edit Notification Templates'.

Note:  The Template list and Edit templates button will only be visible if templates have been created
before.

Note that SmartNames can be used in the To field, for example to refer to e-mail addresses of:

• the Job’s CSR,
• up to 3 customer contacts.

4. Click OK.

The notification rule is added to the 'Notification' dialog.

E-mail notifications of tasks that end in a warning or error will contain the basic problem description (the messages
that appear in the task's details pane). This avoids having to analyze more complex log files.
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Customizing the Contents

It is possible to save XML notifications on Smart enabled paths. For example saving XML notifications inside the job
folder.

 

 

Early Notification

The Task Step is finished condition makes it possible to receive a notification message at the end of the step on
which it was set, before the rest of the workflow has finished.
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Note:  Use the Configure tool to configure general notification rules for tasks and devices, and to define the
places where the XML or text files will be saved.

Working with Tickets

From the Tickets view, you can:

• Create a new task ticket: double-click an existing task ticket (for example a default one), fill the settings in as
desired, and save it under a new name.

•

Create a new workflow ticket: click  and build your workflow (see Building Workflows in the User Guide
for details).

•
Copy a ticket: select the ticket to copy, click  and enter a name for the new ticket.

•
Delete a ticket:select the ticket to delete and click .

• Make a ticket public: right-click it and select Public Ticket.
•

Enter information about a ticket:select the ticket, click  and enter a Description.

 

 

The Description you enter here will be visible in the Description column of the Tickets view.

You can also make the ticket Public from here.
• Filter tickets: you can either filter by file type (to only show tickets valid for that file type), or by entering text in

the search field.
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Note:  Depending on your access rights, you may not be able to create, edit or delete tickets.

Favorite Tickets

You can add (tasks, task chains or workflow) tickets to your favorites, to be able to launch them quicker in the future.

Favorite tickets are linked to:

• your user account (so every user can have his/her own favorites),
• the file type selected in the Pilot (so the favorite tickets you can add or see are always suitable for the file you are

working with).

Adding a Ticket to your Favorites from the Files View

1. In the Containers or Last used job mode, select a file of the relevant file type (for example, select a PDF to add a
favorite ticket for all PDF files in the Automation Engine database).

2. Click the word add in the Launch Favorites pane.
 

 

3. In the Add Favorite dialog that opens, select the ticket you want to add as a favorite and click OK.
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Note:  This dialog contain all task, task chains and workflow tickets suitable for the file type selected in
the Pilot.

Adding a Ticket to your Favorites from the Tickets View

You can either:

• Right-click your chosen ticket and select Add to Favorites.
• When creating a ticket, select the Add to Favorites option in the Save As dialog.
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This add the ticket as a favorite for all file types that can be processed with this ticket.

For example a ticket for the Copy or Move File  task will be added as a favorite for all file types.

Using a Favorite Ticket

1. Select the file to process in the Containers or Last used job mode.

The Launch Favorites pane shows all the favorite tickets for this file type.

2. Click the favorite ticket you want to use.

Note:  If you want to use another ticket of the same task type (for example another Export to ArtPro File
ticket), click the arrow beside the favorite ticket and choose your desired ticket.
 

 

3. The ticket opens. If necessary, review or edit the ticket's parameters.

4. Click Launch.

Tip:  To launch the ticket's task / task chain / workflow on the file without opening the ticket, press Alt when
clicking the ticket.
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Different Ways of Working with Automation Engine

Working with Jobs

 Jobs

What is a Job?

A job contains all the files and information relative to a customer job you process in Automation Engine.

It has a blue icon  and is stored in the Automation Engine Job Database. The database can hold up to 100 000
jobs.

In the Containers mode, you can see your job in its container.
 

 

In the Last used job mode, you can see your job’s subfolders and files.
 

 

Job Metadata

You can attach an extended set of metadata to every job: customer information, inks to use, bar codes, impositions...).
This metadata is stored in the Automation Engine database, and will be used when launching tasks on the job.

Job Automation

Automation Engine is very job-centric. On top of launching tasks and workflows on the job, you can also have tasks
be launched automatically when the job reaches a certain status (for example: a new page has been delivered, the
sheet is complete...).

For more information about Jobs, please see Working with Jobs on page .

The Jobs View

This view is only available in Job Overview mode (when the Job Overview button  is selected).

In this view, the Pilot lists all Jobs on the server.
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1. Menu
2. Tool bar: see Jobs View Tool Bar.
3. List: lists all Jobs defined on the server.
4. Job Details: display the details of the selected job.

If you want to edit the Job Details, select 'Info' from the 'File Menu' [CTRL + I] or right-click a Job and select
'Info' from the context menu.

For more information on the Job Details, see Creating a Job.

Jobs View Tool Bar
 

 

1.
The Job Overview button  is a shortcut to the Job View.

The Containers button  lists all Containers known to the server.
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The Last Used job button  acts as a shortcut to the last used job.
2. The Job Overview list allows you to jump to recently accessed Jobs, or to the Containers.
3.

Create a new Job  When creating a job in Job Overview mode, the Pilot will automatically switch to Job
mode. See Creating a Job.

4. The Info button opens the job setup for the selected job.
5. Job Filter: You can filter the list with one of the predefined filters (see Filtering Jobs).

You can also use the search field to filter the job list: enter (a part of) the job name to list all jobs that have this
part in their name.

Tip:  You can use double quotes to restrict the search. For example:

• Job 519 will list jobs that have both Job and 519 in at least one attribute.
• "Job 519" will only list jobs that have this exact string in at least one attribute.

Creating a Job

You can create a job in the Pilot, through a Hot Folder (see Using Hot Folders to Upload and Process Files), or via
JDF/JMF (when using a MIS system).

To create a job in the Pilot:

1. Select the folder you want to turn into a job and either:

• go to  Job > New Job...
• right-click it and select New Job...
•

click the Create Job icon  (this button is available in all views),
• use Ctrl + Alt + N.

This opens the New Job dialog.
 

 

2. To...

... copy data from an existing job: ... create a blank job:

1. Select Use an existing job as a template.
2. Browse to the job you want to use as a

template.

Just click OK.
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... copy data from an existing job: ... create a blank job:

3. Choose what to copy from the template
(files, folders, Hot Folders...).

4. Click OK.

3. In the dialog that opens, fill in all the information you have about the job. See Job Setup on page  for
details.
 

 

4. Click OK.

Job Setup

You can fill in the job setup information when creating the job, or at any time (in a job context) by going to  Job >
Job Setup...
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Job Tab

The Job tab offers typical job information:
 

 

Order ID and SubOrder ID: Order and suborder identification numbers (that identify the Job).

Job Name: Name of the job.

Description: job description.
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Due Date: the due date / time.

Project ID: will display the ID of the project, entered via the MIS system.

Category: choose a category from the list. Click the Categories... button to add new categories.

• Custom Field 1
• Custom Field 2

Note:  If you have defined your own custom fields (upto 6) in the Job Setup in Configure, you will see
them here instead of "Custom Field".

Last Actor: the last one of the operators that has worked with the job.

Job folder: enter the path. This is also the place to relocate a job folder. When changing the job folder path you will
be asked whether or not to move or copy the data to new job folder.

Use the Smart Job Location defined in the Configure Tool: when this toggle is selected, the new job location will
be calculated on the fly depending on the information in the job or on the customer's default location. A preview of
the folder can be asked by clicking the 'Show Job Location' button.

 

 

Please see Smart Job Location for more information.

Customer Tab

Customer ID: Clicking 'Select...' opens the 'Select Customers' window, choose one or add a new customer. For more
information on how to add customers, see New Customer.

Customer Name and Customer Description: these fields will be filled out automatically after selecting a customer.

Customer's Job Reference: fill out the customer job reference. This is for example the name that your customer gave
to that Job. If it is used it will also identify the Job.

Customer Service Representative: select the Automation Engine user who manages this customer account.

The E-Mail address of the Automation Engine user you selected is automatically displayed. If it isn't, go to Tools >
Users, double-click the user and check if the e-mail address was entered.

You can also enter the e-mail address manually.
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You can click the Contact... button to open a mail message with the e-mail address in the To field (if a mail client is
configured).

Tip:

All fields:

• can be used to filter or search for a job.
• can be entered via JDF/JMF.
• exist as SmartNames.

E-mail notifications can be sent to all these contacts.

Inks Tab

The Inks tab allows to store ink specifications of the Job. These Job ink parameters will be used to interact with Esko
editors (when you edit files located in that Job or when you use the Check Job Parameter task).

Specifications that you can enter are: order, name, type, ruling, angle and dot shape. Ruling, angle and dot shape can
be defined per ink or for all inks.

Tip:

Choose the ink book you use most frequently in the Preferred Ink Book list. When you type an ink name in
the table, Automation Engine searches for the ink in your preferred ink book first.

For example, if you type 154 as ink name, and your preferred ink book is Pantone Colors Uncoated,
Automation Engine will automatically suggest the PANTONE 154 Uncoated ink.

Note:

In a page workflow, inks specified in the Inks list are taken into account when selecting a variant separation,
but are also used for creating "expected" separations (and corresponding plates) in the Plates view.

This means that for each ink and for each sheet an expected separation will be created.

If the assigned pages contain inks that are not listed in the inks list, "unexpected" separations will be created.

Parameters Tab

Here you can store Job Parameters related to output on FlexRip/Proof. They will be applied in the corresponding
FlexRip/Proof tickets when processing this job (they will overwrite the tickets parameters and be read-only).

Here, you can also store "general" parameters, which you can use as Job SmartNames (for example in a
DesignWizard use case).

By default, the Parameters tab is empty. You need to create job parameters.

You can either:

• create job parameters manually (see Creating a Job Parameter on page ),
• load an XML file containing your job parameters (see Loading Job Parameters from an XML File on page

),
• get the job parameters from a MIS system through JDF / JMF. In this case your parameters will have (JDF) at

the end of their name.

Creating a Job Parameter

1. Click the Add... button in the Parameters tab.

The Add Job Parameter dialog opens.
2. In Scope, choose the type of task you want to use a job parameter for (you can define inks, expose, proof...

settings).
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Click OK.
3. A list of the task parameters is displayed. Select the parameter to use and choose its Value.

 

 
4. When you have defined all your job parameters, click OK.

The Job Parameter will be added to the Parameters tab.
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5. When you have a look at a ticket of that particular task, you will see that the parameters are overruled by the Job
Parameters (for this job).

Job parameters are marked by an orange icon .

 

 

Loading Job Parameters from an XML File

If you have an XML file containing the parameters to use for your job, you can do the followwing:

1. Click the Load... button in the Parameters tab.

2. In the Load Job Parameters from XML pop-up, click Browse and browse to your XML file.

3. Click OK and the Parameters tab displays the parameters contained in the XML.

Modifying a Job Parameter

1. Select the parameter you want to modify and click the Modify button.
2. The Modify Job Parameter dialog pops up, allowing you to modify the settings.
3. Click OK and close the Job Setup dialog. The modifications have been saved.

Bar Codes Tab

Bar codes can be defined as job parameters. In the Bar Codes tab you can create multiple bar codes of different types.

These bar code parameters will then be used to interact with Esko editors, e.g. when you edit files located in that Job
or when you use the 'Check Job Parameters' task.

When selecting a bar code, the specified parameters are shown in the 'Details' area.

Bar code parameters can as easily be created and modified as other job parameters.

Step and Repeat Tab

The Step and Repeat tab allows you to organize specific Step and Repeat parameters.

These parameters are normally only used in a JDF workflow. The MIS system can specify the Step and Repeat
specifications via “JDF for Stripping for Packaging”.

These Step and Repeat parameters also become Job specific SmartNames and can so be picked up by Step and Repeat
tasks.

Categorization Tab

The Categorization tab allows you to assign up to four additional categories of your choice to a job. These additional
categories, added to the three category fields on the Job tab, allow you to:

• filter and search Jobs based on the categories
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• use your custom fields in SmartName-driven tasks. For example, you could define a Smart Fork selection that will
select the appropriate proofing ticket based on the value of the user-defined categories 'Brand' and 'Proofer type' in
the Job Setup.

Tip:

To define the category names, choose Tools > Configure > Jobs > Job Setup and type in the category
names.

To manage the list of items you can choose in each category, click the corresponding Manage... button, and
add or remove items to the list in the dialog that appears. In this dialog, you can also load lists of items from
an XML file by clicking Load....

Imposition Tab

Note:  This tab is only offered in page workflows.

The options in the Imposition tab offer more control over implicit normalization when JDF page assignment is being
used.

• Page assignment via naming convention

For more information, please see Page Assignment via Naming Convention.
• Variant setup

Allows you to select the correct use case and variant separation from the list. For more information, please see
Variant Setup.

• Output prerequisites

Allows you to decide when a separation can be considered as being ready.

• When no page is rejected: This is called implicit approval.The plate status in the Plates View will indicate
'ready for ripping' if all the pages of the plate are assigned and if no page is rejected. The output task on a plate
will fail when a page for that plate is unassigned or rejected.

• When all pages are approved: This is called explicit approval since it is more strict than implicit approval.The
plate status in the Plates View will only indicate 'ready for ripping' if all the pages of the plate are approved.
The output task on a plate will fail when not all the pages on that plate are approved.

Please see 'Task status information' for additional information.
• Plates View context menu operations

Allow you to define some rules. You can indicate what ticket should be used when creating a preview or
outputting a plate.

Note:  If this option is not available, please check if the flimp2gri licence is available.

Automation Tab

Note:  This tab is only offered in page workflows.

The Automation tab offers you the possibility to automate your workflow. When a certain event related to your job
happens, a particular task will be launched automatically, which leads to the next step in the workflow.

You can do this for Normalization, Proofing and Exposing.
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1. When a page is delivered, choose what ticket to normalize it with. The default ticket is Default (Normalize
PostScript / PDF / Illustrator 8.0 File).

2. Choose when to proof your job and what ticket to proof it with. You can proof it when a sheet side, a variant or
an imposition is complete.

The default proofing ticket is Mark as Proof (Export Imposition to PDF File Chain).
3. Choose when to expose your job and what ticket to expose it with. You can expose it when a plate, a separation

set or an imposition is ready (complete and approved if required).

The default exposing ticket is Default (RIP Imposition to Screened Tiff File).

Note:  You can always choose a Fork or Wait for Action (Checkpoint) ticket if you have other conditions
to take into account in your workflow.

Filtering Jobs

In Job Overview mode, a Job filter helps you to quickly find a job based on whatever information you have. For
example:

If you know... you can search on...

The last person who worked on this Job "Job" or "Last Actor"

(Part of) the Job ID "Job" or "Order ID contains"

Where is the customer based "City"

When the Job was finished "Date"

One element can be enough to shorten the list, but different filters can easily be combined.
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You can select a filter from the filter drop down list. You can define a new filter by selecting "Define Job Filters"
from the Job menu.

The "Job Filters" dialog pops up.
 

 

The Job Filters dialog allows you to create, modify rename and delete Job Filters.

Click "New..." to create a new filter. The Modify Filter <Filter Name> dialog box pops up. It consists of four tabs.

• In the Job tab, you can filter on strings in the Job Name, Description, Category, Last Actor, Order and Sub Order
ID, Place and Job File Format.

• In the Customer tab, you can filter on strings in the Customer name, Customer reference...
• In the Date tab, you can filter on the Date.
• In the Milestones tab, you can filter on the Milestone Name and Due Date.

Note:

Use the toggles to add extra filters:

• The Milestone's actions are finished.
• Some of the milestone's actions are pending or busy.
• The Milestone is confirmed.

Milestones

Milestones are important checkpoints in the life of an Automation Engine job which are scheduled events.
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Each job has at least the milestone representing the start of that job (the moment the job is entered in the Automation
Engine job database).

You can then add predefined milestones (with your own due date, responsible, etc.), or create custom milestones for
your job.

The end milestone is the "due date" set for that job. Due date can mean many things. It could be the due date for the
deliverables (plates, print production, shipping, invoice sent) or could simply stand for "waiting to be archived".

The Milestones View

This view is available in Job Overview and Job modes.

For each milestone, a colored icon indicates the milestone's status:

•  indicates the "start" milestone for the job.
•  indicates today on the time line.
•  indicates the selected milestone.
•  indicates a pending milestone.
•

 indicates an overdue milestone.
•

 indicates a milestone that is being handled.
•  indicates that a milestone is completed.
•

 indicates that a milestone is confirmed (the milestone must be completed before it can be confirmed).

In Job Overview Mode

When you are in Job Overview mode, you can see all milestones set for all jobs in your container.

The Milestones view can show you two overviews.

The Timeline View

The Timeline View  shows you all milestones for each job, for a period you define.
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You can use:

•
 to show 1 day, 7 days, 14 days or 31 days.

•  to show the previous day, the previous week, the current day, the next day or the next week.

You can also click a milestone to see the Milestone Details at the bottom.

The Status View

The Status View  shows you the status of your chosen milestones for each job.
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Go to  View > Columns  to choose the milestones to display in the Status View.

If no icon appears in a milestone column, this means that this milestone is not defined for that job.

In Job Mode

In Last Used Job mode, the Milestones view shows all the milestones for a specific job.
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You can use:

•
 to show 1 day, 7 days, 14 days or 31 days.

•  to show the previous day, the previous week, the current day, the next day or the next week.

You can also click a milestone to see details at the bottom (for example, if there is an action attached to the
milestone).

The example above shows the milestones of the job “Orange_Juice”:

• The job is created on Friday, and the files arrive right afterwards.
• The imposition is ready on Monday, on schedule.
• The imposition proofs are expected to be ready on Tuesday.
• The imposition proofs should be approved by Thursday.

Adding a Milestone to a Job

This explains how to add a predefined milestone to your job (with your own due date, responsible, etc.). To create a
custom milestone for a particular job, see Creating a Custom Milestone on page .

In the Milestones view (in Last Used Job mode):

1.
Click the New Milestone button , or go to  File > New Milestone .

The New Milestone dialog pops up.
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2. In the Milestone Name list, select the milestone you want to add to your job.
3. Enter a Description for your milestone if you wish.
4. Define a Due Date and time.
5. If you want, add a Reminder: at the time / date you choose, a reminder will be emailed to the person Responsible

for this milestone.

For example, if you choose 1 hour, an email will be sent to the responsible 1 hour before the milestone is due.
6. Select the person Responsible for this milestone.
7. Click OK.

Creating a Custom Milestone

There are many predefined milestones, but you can also create custom milestones for particular jobs.

In the Milestones view (in Last Used Job mode):

1.
Click the New Milestone button , or go to  File > New Milestone .

The New Milestone dialog pops up.

2. Click the Manage... button to open the Manage Milestone dialog.

You can see all existing milestones, with the nicknames, colors, icons... associated to them.
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3. Click the Add button.

 

 

4. In the Add dialog:

a) Enter a Name for your custom milestone. You can also enter a Nickname if you want.
b) If desired, choose a Color and / or an Icon to associate to your milestone.

These make it easier to notice and recognize the milestone.
c) You can also enter Comments to give more information about the milestone.
d) If you want to use this milestone is a Products context, select This can be used as Product Status.

See Working with Products on page  for more information about Products.
e) Click OK.

You can now see your custom milestone in the Manage Milestone dialog.
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Adding an Action to a Milestone

A milestone can be an indicator of the state of the job you are working on, or something another operator has to do
(for example, communicate changes to the design agency...).

To add a specific action to a milestone:

1. Select the milestone in the Milestones view.
2.

Click the New Action button  or go to  Milestones > New Action... .
3. In the New Action dialog that pops up, enter what needs to be done, who needs to do it and by when.

 

 

Later, the operator that needs to do the action can change the State from Pending to In Progress, Completed or
Aborted.

Tip:  You can add several actions with detailed messages to explain what exactly is needed before the
milestone can be confirmed.

Note:  The actions attached to a milestone need to be Completed before the milestone can be set as
Confirmed.

Using Milestone Statuses to Filter Jobs

You can create a filter based on milestone statuses, then use this filter in the Jobs view.

1. In Job Overview mode, go to  Job > Define Job Filters...
2. Click New in the Job Filters dialog.
3. In the Modify Filter dialog, go to the Milestones tab.
4. Choose:

• the name of the milestone to filter on,
• the Due Date,
• the milestone status (The milestone's actions are finished, Some of the milestone's actions are pending or

busy, or The milestone is confirmed).
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5. Click OK.
6. Give your new filter a name (for example Waiting for files today for the filter above).
7. In the Jobs view, choose your milestone status filter in the Job Filter list.
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Automating the Creation of Milestones

When creating a new job (manually of via JDF), you can copy the properties of another job (template), including that
job's milestones.

 

 

The milestones copied will be applied relatively to the new starting time.

For example, a typical job for a dog food company has a life-cycle of 9 days. A new job’s due date milestone will
then be 9 days after its starting date (and its intermediate milestones will be distributed accordingly).

Automating the Confirmation of Milestones

Although this is perfectly possible, we assume you do not want to create and confirm every Milestone manually.

The Manage Milestone task was created to automate this.

You can either:

• Make a favorite Manage Milestone ticket to confirm a certain type of milestone, and use it via quick launch.
• Add Manage Milestone tasks to your workflow, to confirm all the milestones automatically as they are

completed.

 

 

For example, the workflow above will:

1. Confirm the Files arrived milestone when receiving the input file.
2. Normalize the input files.
3. Perform Step & Repeat.
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4. Trap the file.
5. Wait for you to check the imposition in the Viewer, and decide if it's ok.
6. Confirm the Imposition complete milestone.
7. Proof the imposition.
8. Confirm the Imposition proofs ready milestone.
9. Send the imposition to the customer for approval.
10. If the customer doesn't approve it, you can correct the files and send it again.

When the customer had approved the imposition, the Imposition proofs approved milestone is confirmed.
11. Then the job is printed on a digital press.
12. Finally, the Job finished milestone is confirmed.

Informing Other Systems of the Milestones Statuses

To keep MIS systems, colleagues or customers up-to-date with milestones statuses, you can either:

• Set up the automatic sending of JMF signals when a Milestone is confirmed. Other (MIS) systems that support
JMF can "subscribe" to these signals.

For more details please refer to the Esko JDF documentation or ask Esko consultancy.
• Add a notification to your Manage Milestone tasks, for example an e-mail notification, or the creation of an XML

file containing the milestone information.

For details on how to set up a notification, see Notifications on page .

Working with Products

About Products

Why use Products

The Job concept corresponds to a to-do for the prepress/production department, representing a production order. A
Job consists of a folder containing all related files, and allows to define parameters such as Barcode specifications,
job inks, milestones, etc.

However, for recurring designs, the production files have to be copied into the Job folder. This can cause needless
searching, copying and design version problems.

In this case, Global Products can offer a solution.

The Products concept

Products is an easily searchable, operator-friendly database of approved one-up production files. These Products can
then be linked into one or more Jobs, without physically duplicating the production files.
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In general, the process of working with Products can be summarized as follows:

1. The MIS system gives a production order. This can be a completely new order, a rerun with changes or a rerun
without changes.

2. The order becomes a Job, and various parameters (inks, customer, due dates, milestones) are attached to the Job.

The order from the MIS also includes information about the Products ordered. The Job is added to the to do list of
the prepress production department.

3. The prepress department links the Products to the Job, and can start working on the approved one-up production
files straight away.

Global Products, Parts and Job Products

A Global product (using a yellow icon) is a digital representation of the one-up production file, that is not inside a
Job folder. A Global Product can be part of multiple Job-orders.
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Note:  A Product can also be incomplete, still in design or awaiting approval.

A Product can consist of more than one Part.

For example in case of a beer bottle, you can have a front label, back label and neck label that make up the end
product for the customer. Each of these Parts can have separate settings and parameters.

A Job Product (using a blue icon) is a Product that links to file(s) inside a Job Folder of one specific job, and can
only be used within the Job to which it is linked.

Whereas all files inside a Job use the same (Job) parameters, Job Products can have their own (per-file) parameters.
This means that Job Products can be used for parts of a Job, each with their own parameters (for example, a barcode).

Empty products

A Product can have an empty URL. Empty products can be created via JDF. If a JDF file in a Job requests a Product
that does not yet exists, that Product will be created in the Products database. It will have an empty URL and no
thumbnail.

A Product can also have a URL linking to a file that does not yet exist. As soon as the data that matches the exact
URL arrives, the thumbnail will pop up.

Creating a Product

There are a number of different ways to create a new Product:

• Automatically create a Product with the Add to Products task. See Creating a Product with the Add to Products
task.

• Manually add a Product to the Product Gallery. See Creating a New Product in the Product Gallery.
• Upload a one-up file and turn it into a Product in one operation. See Uploading a File to the Product Gallery.

Creating a Product with the Add to Products task

You can automate the creation of a Product, for example in a JDF workflow, using the Add to Products task. Read
more in: Add to Products

1. Select the file you want to add as a Product and run the Add to Products task.

2. Select the item to setup either Product or Product Part.

3. Configure the Product or Product Part Properties on the General tab. Note that all the fields on the tab are
SmartName-enabled.

4. Select the one-up production file you want to use for this Product in the General Tab under the item selection
Product Part .

5. If you are updating an existing Product or Prodcut Part (i.e. the Product ID or the Product Name matches an
existing Product), define the update rules on the Updating tab of the respective item selection.

6. Launch the task to add the new Product to the Product Gallery.

Creating a New Product in the Product Gallery

From the Product Gallery, you can add new Products manually:

1. Open the Products view and choose  Products > New Product....

2. In the Select File or Folder dialog that immediately appears, browse to and select the file(s) you want to make
into a Product. Alternatively, select a folder to choose from all the files in the folder.

Note:  If you select a file from within a Job folder, you will automatically create a Job Product (a Product
that can only be used in the Job).

For the same reason, you cannot add files from different Jobs to a single Product.
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3. Click Select.

The New Product dialog appears.

4. Select all the file(s) you want to add to the product, and click OK.

Note that if you select multiple files, these will automatically be considered to be Parts of the same Product.

The Product Properties dialog appears.

5. Specify any required properties for the Product itself in the Product Setup, and then complete the properties for
every Part in your Product.

6. Click OK to add the new Product to the Product Gallery.

Uploading a File to the Product Gallery

You can upload one-up production files from your hard drive or another network location to the Automation Engine
server and turn it into a Product in one operation. To upload a file to the Product Gallery:

1. Open the Products View and choose  Products > Upload as Product...

2. In the Select File or Folder dialog that immediately appears, browse to and select the file(s) you want to make
into a Product.

Alternatively, select a folder to choose from all the files in the folder.

3. Click Select.

The New Product dialog appears.

4. Select all the file(s) you want to add to the product, and click OK.

Note that if you select multiple files, these will automatically be considered to be Parts of the same Product.

The Product Properties dialog appears.

5. Specify any required properties for the Product itself in the Product Setup, and then complete the properties for
every Part in your product.

6. Specify the desired upload Destination for the production file itself.

Either select Use the Smart Product Location as set in Configure to upload the file to the folder path specified
in the Automation Engine Configure window; or disable that option and manually Browse for an upload
destination on the server.

7. Click OK to add the new Product to the Product Gallery.

Product Properties

To view or edit the properties of a Product, select it in the Products Gallery, and choose  Products > Product
Properties .

Tip:  You can change the properties of multiple files at once by selecting the files and choosing  Products >
Product Properties .

You can add new Parts by clicking the + button at the bottom of the Product Properties dialog.

Product Setup

Click Product Setup to show the product properties you entered when creating the Product. You can edit those as
necessary.

General Tab
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Property Description

Name Descriptive name of the product.

Product ID Unique product identification code.

Customer Name Displays the name of the customer to whom this product belongs. Click the
Select... button to choose a customer from the list of customers that has been
defined on the server.

Customer's
Product Reference

Allows you to add the customer's product reference code.

User-defined fields You can define up to three custom fields to help you filter and search the Products
database. Custom Fields are also available as SmartNames.

Description Text description of the product.

Status Status of the product.

Jobs Tab
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The Jobs tab shows the Job(s) the Product is linked to, and the Product Amount ordered for each Job.

The Product amount information can either be entered manually, or come from an MIS system. This information can
be accessed as a SmartName and is also available in Plato when performing Step & Repeat.

Parameters Tab

You can view and manage the Parameters of a Product in this tab. You can access Product Properties via the right-
click menu when a Product is selected.

Product Parameters are details associated with Products. These are applicable to the Product and their Parts. You
can enter Product Parameters in this tab.

You can Add/Edit/ Remove Product Parameters in this tab. It is possible to add/modify Product Parameters via
MIS or JDF.

 

 

Product or Product Part Properties

Select the individual Product or Product Part to enter or check more detailed information.

The use of Product or Product Part Parameter is similiar to the use of job parameters or workflow parameters.
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General Tab
 

 

Property Description

Data Zone The file path to the product part containing folder.

Note:  The Product Part Data Zone is a folder inside a Container
where all files related to a specific Product Part are located.

• The Data Zone can be different for every Part of the Product. It is a
standard practice to keep all the Parts at the same Data Zone.

• When a new Part is created, you can browse to a file. The Data
Zone of this Part should have the same Depth as the previous
Parts of the Product. You can use the default depth specified in
the  Tools > Configure > Products > Product Part Datazone .
Read more in Product Part Data Zone .

• The Data Zone should be a folder inside a Container. The Product
Parts should not be in the root Container.

File The digital production file used to print the Part. Click Browse...  to select a new
file.

Note:  If your file is in the subfolder within the Product Part Datazone,
you can specify the path subfoldername/file. You can view the
subfolder level in  Product View > Data Zone .

Name Descriptive name of the Product Part.

User-defined fields You can define up to three custom fields to help you filter and search the Products
database. Custom Fields are also available as SmartNames.

Barcode Tab

Use the Barcode tab to add barcodes to the Product. You will need to fill in the barcode Type and Code, and other
parameters depending on your barcode type (Bar Width Reduction, Magnification...).
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Status Tab

The Status tab shows the status of the Product. If nicknames were set for standard statuses, these will be used.

Note:  You can use this feature in workflows by setting up a Wait for Product Status ticket. Read more in:

Parameters Tab

Product Part Parameters are details associated with Product Parts. These are applicable only to the specific
Product Part selected. You can add or modify Product Part Parameters in this tab or via MIS or JDF.
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Note:  The Parameters tab is not available if you select multiple Product Part.

Inks Tab

The Inks tab shows Product Part Inks that are specific to the Product Part. In the Product Properties dialog, select a
Product Part from the list on and choose Inks tab.

You can define and store the Product Part Inks and the corresponding default ink settings here. These ink
parameters will be available for other Esko editors or during the Check Prduct Parameters  task.

You can store order, Ink Name, Ink Book, Ruling, Angle and Dot ShapeInk Type and Printing Method for all
inks.

Tip:

If you have added Preferred Ink Book, for each ink entry, Automation Engine searches for it in your
preferred ink book.

Using Product /Product Part Parameters

The use of Product/Product Part Parameters is ver similar to the use of Workflow Parameters and Job Parameters.
While Product Parameters are applicable to all the parts of the Product, Product Part Parameters are specific to
each part.

1. Select one or more Products or Product Parts from the Products view. Alternatively, select the files which are
Products/Parts from the Files View.

2. Right-click and select New Task and subsequently select a Ticket or a Workflow.

3. Double-click on the Ticket or select Edit Parameters... via the right-click menu .
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4. Select a SmartName-enabled field and click on []. Alternatively, use the shortcut Ctrl+Enter.
The SmartNames Dialog will pop up. It will contain Product Parameters or Product Part Parameters
depending on the choice you made in the Product Gallery under Category.

If you select a Product Part, you can insert both Product Parameters and Product Part Parameters applicable

to that Part.

5. Select either the Product Parameters or the Product Part Parameters category. Choose the Product or Product
Part Parameter you want to use.

You can choose multiple parameters from the right hand side of the pop-up.

6. Click on Insert or double-click on the parameter to add the Product or Product Part Parameter to the Ticket.
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In the case of Product Parts, you can only choose from the Product Part Parameters that are specific to the selected
Product Parts.

7. Click OK.

The Product Gallery

The Product Gallery is a user-friendly, searchable view on the Products defined on the Automation Engine server,
from which you can create new Products, search existing Products and link Products to Jobs.

 

 

You can see the Products in a thumbnail view  or a list view .

In list view, you can right-click the columns to choose the columns to show/hide.

Filtering and Searching the Product Gallery

You can use a filter to limit the number of Products displayed in the Product Gallery, or you can use the search
function to find a specific Product or set of Products.

• Type the name of the Product you want to find in the Search field. You can search a set of products by only
typing in the first letters of the name.

• Select an existing filter from the Filter list: either the standard All Products filter, or a previously saved filter
• Define and use a custom filter:

a) Select <custom> filter from the Filter list.
b) Click the Customize Current Filter button
c) Specify any needed criteria in the Modify filter dialog.
d) Click Save as to save this filter as a preset, or click Apply to filter the Product Gallery on the fly.

Managing Product Statuses

The Status of a Product is shown in the top bar of the thumbnail, or as text in the List View. Use Manage Product
Statuses to manage the visualisation of the Product statuses. It allows you to edit existing (standard) statuses and
add new (customized) statuses with your preferred colors or icons. Predefined Product statuses, however, cannot be
renamed.

1. Click  Product > Manage Statuses...

2. Click Add and enter the required parameters.

3. Click Choose... and Browse... to select the appropriate color and icon.

4. Double click a Product or click Edit on a selected Product to open the Edit dialog. If specified, nicknames will be
used instead of the official Product name.

A Product status can be used as a Milestone and vice versa.
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Note:  Product statuses can also be set via  Product > Product Properties... > Status .

Linking Products to Jobs

There are two ways of linking Products to Jobs. You will only be able to link Global Products to jobs as they are the
only ones that can be part of multiple Jobs.

• The best way of working is to link Products directly from within a Job:

a) Navigate to the Job folder and select the Products View.
b) In the Products Gallery, which is empty initially, choose  Products > Link Products...
c) In the Link Products dialog, select the Products you want to use in this Job, and click Select

The selected Products are added to the Products Gallery for this Job, and you can now use them in your
workflows.

• In Container mode you can make the reverse movement and link Products to Jobs. Linking via Container mode is
an easy way to link one Product to multiple Jobs.

a) Go to Container mode and select the Products View.
b) Select the Global Product(s) you want to link and choose  Products > Link to Job
c) Select a Job from the list.

You can see the Job(s) the Product is linked to in the Product Properties.

Archiving and Backing up Products

Archiving Products

The Products concept envisions that your Product data stays on-line.

Products that will not be re-ordered again should be removed from the database. It mostly concerns very old data or
rejected data you do not want to risk using again in production.

Jobs contain temporary data and should be removed after use. Those Jobs are supposed to be unique and are unlikely
to return.

The Archive tool archives and restores completes Job folders. The Product files that are not inside such Job folders
will consequently not be archived.

Backing up Products

Esko strongly advises to back up your valuable Products. You can back up the disks containing this data (with
non-Esko tools), but we also advise the following methods:

• An easy way to back up your Product files is to select all Products in the Products Gallery and launch the ‘Create
PAF/JPG/XML (LinkEdge)’ task and write those PAFs to a near line (disk) or off-line (disk / DVD) device.

• Should you want to back up the Products database, then remember that it is not a separate database. The
Products database is an extra database table in the Jobs database file, which will be backed up at the same time.

Working with Pages

About Pages

The Pages View is extremely useful when working with impositions. The Pages View allows you to:

1. View, check and (re-)assign pages to imposition or books.
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• If the Imposition file contains all pages, the Pages View can be used to simply check the presence and correct
order of the pages.

• If there are pages missing, you can assign them by either selecting the (multi-page) file in the Page Gallery or
individual pages in the Details pane, and drag them to the correct location in the Page List.

2. Generate proofs and follow up approval states.

Both PDF and IMP files can be exported, exposed, proofed, etc. from the Pages View. The same tasks as in the
Files View can be executed on both file types.

3. Upload and normalize PDF files.
4. Create impositions after templates.
5. Create books for later use in a new imposition.

The Pages View

This view is only available in Job mode. It is only used in page workflows.

The Pages View is divided into several panes. The top part of the view (the Page Gallery and the Details pane)
displays both assigned and unassigned pages, the bottom part displays the impositions, layers and assigned pages.

 

 

1. The Page Gallery pane lists all incoming files, indicates the number of pages and the assignment status.
2. The Details pane displays thumbnails of the individual pages of the selected file.
3. The Imposition Gallery pane shows the imposition structure with its different books. It also allows you to create

books that later will be used in an imposition.
4. The Layers pane shows the different layers of the selected imposition. You can rename layers, approve them, and

set them empty or blank.

Note:  The Layers pane is only visible when the selected imposition or book contains more than one
layer.
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5. The Page List shows you which pages are assigned and which are not. For each page status information can be
asked.

6. Click the Page List button to switch between thumbnail view or list view.

You can view both the task status and the page status information. Simply right-click the columns Page Gallery and /
or Imposition Gallery pane(s) and select both Task Status and Page Status.

 

 

See Working with Pages on page  for more information.

Adding Imposition Files to the Pages View

When you go to the Pages View for the first time, you will see that all panes are empty.

To send an imposition file from the Files View to the Pages View:

• Select the IMP file and launch the Add to Imposition Gallery task on it.

The imposition file will appear in the Pages View.

If the imposition contains pages, the corresponding files will appear in the Page Gallery.

Tip:

When an IMP file is already present in the Imposition Gallery of the Pages View, launching the Add to
Imposition Gallery task resynchronizes the IMP file.

This can be useful when problems with non-matching SmartIDs occur.

Creating an Imposition

To create a new imposition:

1.
Right click the Imposition Gallery and select New Imposition, or click the New Imposition  button.

This opens the New Imposition dialog.
2. Enter the Imposition Name.
3. Select the appropriate Imposition Template from the list, or browse to the correct location.
4. By default, Use Layer Name(s), Book Name(s) and Finished Page Sizes from Template is selected, which

makes the Width and Height parameters unavailable.

Deselect this option if you want to overrule the template sizes.

Additional information on the number of books and pages of the selected template is displayed.
5. If you want to automate the Page Assignment, insert the regular expression to use. You can include SmartNames.
6. By giving a particular Page Offset, the pages will be assigned to the correct page slots.
7. Select the correct Use case and Variant separation if necessary.
8. Click Create.

The imposition will appear in the Imposition Gallery.
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Creating a Book

To create a new book:

1.
Right click the Imposition Gallery and select New Book, or click the New Book  button.

This opens the New Book dialog.
2. Enter the Book Name.
3. Indicate the Number of Pages the new book should contain.
4. Set the correct Finished Page Size.
5. If you want to automate the Page Assignment, insert the regular expression to use. You can include SmartNames.
6. By giving a particular Page Offset, the pages will be assigned to the correct page slots.
7. Indicate the correct Folio numbering, if necessary.
8. Select the correct Use case and Variant separation if necessary.
9. Click Create.

The book will appear in the Imposition Gallery.

The properties of the book can be consulted or changed at any time by right-clicking the book and selecting Book
Setup...

Tip:  Use the Create Imposition task to turn your book into an imposition.

Adding (PDF) Content Files to the Pages View

When you go to the Pages View for the first time, you will see that all panes are empty.

To add a PDF file to the Pages View:

• Select a PDF in the Files View and choose Add to Page Gallery from the pop-up menu. The PDF will appear in
the Page Gallery, unnormalized.

Note:  The Add to Page Gallery option is only available if the selected file is not yet present in the Page
Gallery of the Pages View.

• Right-click the Page Gallery and select Get Data and Normalize to browse to the correct PDF file.

The PDF file will be copied to the root of the Job. After normalization your pages will automatically be added to
the Page Gallery.

Note:  You can upload files that are already present in the job folder. In this case, the files will be left in
their current location and will not be copied to the root folder of the Job.

Note:

You will only be able to create a limited number of workflows that work in combination with the Add to
Page Gallery:

When a PDF file is selected you can use:

• Copy or Move File > Normalize PostScript / PDF / Illustrator 8.0 File > Add to Page Gallery
• Normalize PostScript / PDF / Illustrator 8.0 File > Add to Page Gallery
• Add to Page Gallery

When a Normalized PDF File is selected you can use:

• Copy or Move File > Add to Page Gallery
• Add to Page Gallery
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Page Assignment

Pages can be assigned to the Page List in different ways:

• Drag a (multi-page) file from the Page Gallery and drop it on the correct page in the Page List. Reader's spreads
are automatically recognized and assigned correctly.

• Select one or multiple pages in the Details Gallery and drop them on the correct page(s) in the Page List.
• Selecting Replace Pages in the context menu of the Page List allows you to upload and normalize a PDF file

which will be assigned automatically when the Normalize task finishes.
• If you don't want to replace the pages that have already been assigned, you can use Insert Pages. In this case, the

new pages will be assigned, moving the 'old' pages to the next pages slots.
• Pages can also be assigned automatically, via a naming convention.

Note:  Within one Page List, pages can also be dragged to another location.

Approving and Rejecting Pages

You can approve or reject pages or files in different ways:

•
select the file or page and click the approve  or reject  button in the tool bar.

• select the file or page, click right and select Approve/Reject.... Then select the appropriate status in the pop-up
dialog.
 

 

If you select Automatic as approval type, the approval state will automatically show the result of the approval
task (Publish on Web).

• Choose Manual if you want to set the approval status yourself.
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•
Approve  approves the selected object.

•
Approve with warning  makes it possible to add a comment in which you can indicate what
modifications should be made or what should be kept in mind. The comment can be seen in the tool tip when
moving the cursor over the warning icon in the Page List.

•
Reject  rejects the selected object.

Note:  Pages can be proofed as such (content proofs) or in their imposition context. Content proofs are more
flexible, imposition proofs are more reliable.

Working with Plates

About Plates

The Plates View is a view that shows a whole range of details about all plates that are associated with a job. It
includes advanced features for managing plates for jobs with multiple versions.

• It visualizes the corresponding flat for a selected plate along with all relevant sheet layout information (plate size,
paper size, etc.).

• It makes it possible to expose or proof a set of plates with an ink & sheet selection preset according to the chosen
plates.

• It shows progress and status information about each plate.
• It shows both the expected and the realized plates, so differences between planning and production can be

detected.

The Plates View

This view is only available in Job mode. It is only used in page workflows.

• The Plates View makes it easier to manage the most important deliverables that prepress provides to the press
room, plates.

• It gives an overview of the total number of plates that have to be output.
• It allows you to track the progress of a job at a very detailed level.
• It allows you to detect discrepancies between the expected plate output and the supplied data very easily.

For example, when a sheet side is supposed to have only a black plate, but one of the supplied pages for that sheet
side contains CMYK, this can be easily seen in the Plates overview.

The same is true for the inverse situation (for example when an expected Pantone plate is not being realized).
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See Working with Plates on page  for more information.

Adding Plates

An imposition cannot be added to the Plates View only. The Plates View is always linked to the Pages View.When
an imposition is added to the Imposition Gallery of the Pages View, it is automatically added to the Plates View.
Likewise, it is removed from the Plates View when the imposition is removed from the Pages View.

Modifications in the Pages View (like adding and removing pages, approving or rejecting pages...) will usually have
an effect on the Plates View. Modifications in the Plates View will not affect the Pages View.

In a JDF workflow the Pages and Plates Views can be populated at the time of job creation if the JDF file contains the
relevant information.

Inks and Plates

Adding an imposition to the Imposition Gallery of the Pages View will also create the entries for the Plates View.

How the imposition was made is not important in this respect. It can be made interactively in FastImpose, by
executing the Create Imposition task or by creating a New Imposition in the Imposition Gallery of the Pages View.

All the columns of the Plates View will automatically be filled in.

When no pages have been assigned to a sheet side yet the Pages View will show a list of plates that are expected. This
list is based on the inks defined in the Job Setup of that job. When no inks are defined in the Job Setup, CMYK is
assumed.
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When all the pages of a sheet side have been delivered, the list of plates for that sheet side will represent the inks of
the pages on that sheet side.

 

 

Manipulating Plates

1. Separations need to be exposed together

It is not uncommon that two separations need to be exposed together, because the supplied file is not correct. The file
can be corrected interactively, but when it is simply a matter of combining two separations on the same plate, it can
also be done here.

Example: a file contains a designer ink “Text” which has to be exposed together with “Black”. This can be done by
selecting one of the plates and selecting “Add Separation...” from the pop-up menu.

2. There are superfluous separations

Sometimes a file contains inks for a special purpose that do not need to be exposed onto a plate e.g. a designer ink
called “dieshape”. Such a plate can be hidden by selecting “Hide” from the pop-up menu. In the top right corner of
the Plates View there is a toggle with which hidden separations can be shown.
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This operation can be reversed. When the “Hidden separations” toggle is on, select the hidden plate (separation?),
right click and select “Create Plate...” from the pop-up menu to turn the separation into a plate.

3. Separations are named incorrectly

Some MIS systems do not name spot colors (correctly). In the JDF file, a spot color could be named “Spot1”, but in
reality a designer ink is required. The pages, however, do contain the correct designer ink. This leads to a situation in
which there is an ordered plate which is not realized (Spot01) and a plate/separation which is there, but not ordered
(Designer Xbed).

 

 

Working with Proofs

About Proofs

Proofs are preferably made with the ImposeProof! functionality.

The Proofs View

This view is only available in Job mode. It is only used in page workflows.

The Proof View consists of two panes that give a different view on the proof:
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1. The Proof Sets pane, where the proof sets are listed.
2. The Details pane is a visual presentation of all proofs of the set.

The Proof Sets pane shows you the names of the proof sets, both hardcopy proofs and softproofs, as well as the
number of flats, pages, status, the date on which they were last modified and information about the kind of proof that
has been made (Content proof if a file is proofed, or Imposition proof if an imp file is proofed).

Thumbnails of the proofs can be viewed with the corresponding application, for example Acrobat for PDF proofs.

 

 

The Info button will open a properties file of that page (proof).

See Working with Proofs on page  for more information.

Marking Files As Proofs

Proof sets appear in the Proofs View after being 'marked as proof'. The Mark as Proof ticket has to be chained to an
export ticket, like for example the Export to PDF File ticket.

Perform the following steps to make proofs appear in the Proofs View:

1. Select an imposition in the Pages (or Files) View.
2. Click right and select the Export Imposition to PDF File Chain ticket via New Task.
3. Specify the appropriate settings.

Approving Proofs

Setting the approval status of the proof also sets the page state of the corresponding page. This is visible in the Pages
View.
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Approval statuses can be set manually by an operator or via JDF. Please refer to the presentation on JDF for more
information.

Pages can be proofed as such (content proofs) or in their imposition context. Content proofs are more flexible,
imposition proofs are more reliable.

The main properties of content proofs:

• Once a page has been proofed it can be moved or copied to any location in the imposition without loosing its
proofing and approval status.

• The order of the pages in the imposition is not checked.
• The placing (offset and scaling) of the page in its “window” is not checked.

The main properties of imposition proofs:

• Imposition proofs can only be made after the pages have been assigned to the imposition.
• Sheet Imposition proofs require large output devices and are harder to check since the pages are not in reading

order.
• ImposeProof imposition proofs put the pages in reading order. This makes it easier to check the order and does not

require large output devices.
• The safety of imposition proofs can sometimes hinder flexibility since the signature of the imposition is also

stored and checked. Many times impositions are changed without a consequence for the pages.
• Reassigning a page degrades the existing imposition proofs to content proofs.
• Changing the impositions degrades the existing imposition proofs to content proofs.
• Approval on an imposition proof on a page slot, implies content approval on the page assigned to that slot and

thus on all page slots to which this page is assigned.

Note:

The validity of the proofs is being maintained (based on Smart IDs).

When a page is changed, for example renormalized, the related proofs are rejected and get a note "Proof is
outdated”.

The link between the page and the proof is broken, which means that the proof is no longer valid for that
page.
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Server Administration Web Tool

A Server Admin Web Tool is installed with every Automation Engine Server from Automation Engine 12 onwards.
You can open the new Server Admin Web Tool by entering http://<name of your server>  or  http://
<name of   your server>:9999 in the address field of your browser.

You can download and launch Client Apps and conduct Server Admininstration via this tool.

System Requirements

Windows :

• Internet Explorer (8.0 or higher required), Firefox, Chrome or Safari.
• Windows XP or Windows Server 2003 or higher and Java JRE 1.7 or higher  

Mac

• Safari, Chrome or Firefox.
• Mac OS X 10.5 or higher and Java JRE 1.6 or higher

Main

The default start page of the Server Admin Web Tool is the  Client Apps > Main  page. You can access it by
browsing to http://<name of your server>  or  http://<name of   your server>:9999.

Main
You can download the main applications (the Pilot, the Shuttle and the Diagnostics tool) from this page.

• Automation Engine Pilot : The Pilot is the primary client tool for your prepress workflow automation. Read
more in The Automation Engine Pilot on page .

• Automation Engine Shuttle : The Automation Engine Shuttle is a client tool for easy submission of files to
Automation Engine workflows. Shuttle also allows monitoring of the workflows. Read more in the Automation
Engine User Guide.

• Automation Engine Diagnostics : You can use this app to monitor the status and activity of the Automation
Engine Server. It can be launched and used both on Mac and Windows.

You can click on Tools to access the other Client Apps.

Note:  The Client Apps are only available on Automation Engine Servers that are configured as Master
server.

Downloading A Client App

The Client Apps section is the place to launch or download the Automation Engine Client Apps. These apps works
both on Mac and PC. The Server Admin Web Tool will automatically detect the OS from which you access it and
provide the correct versions of the Client Apps that can be launched or downloaded.

To download Click the Download  button next to the Client App you want to download. The Server Admin Web Tool
will detect the Operating System and will download the appropriate installers.

Automation Engine Script Runner
You can automate tasks in applications like Illustrator, Photoshop and InDesign using Script Runner. Read more in
the Autiomation Engine User Guide Automation Engine Script Runner and in Using the ScriptRunner.
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Automation Engine ArtPro Action List Editor
Create and edit ArtPro Action List files to automate tasks in ArtPro. This tool is available for download on both Mac
and Windows. Read more in The ArtPro Action List Editor on page 

Automation Engine RunList Editor
This tool helps in creating and editing RunLists to collect several files into one job folder, or to make one final PDF
out of several smaller PDFs (e.g. for imposition). This tool is available for download on both Mac and Windows.
Read more in The RunList Editor on page 

Automation Engine PitStop Profile Editor
This tool helps in creating and managing PitStop PDF  Profiles and Action Lists. This tool is available for download
on both Mac and Windows. Read more in PitStop Profile Editor

Server Administration

Automation Engine features a new web tool for server administration. This means that you can access your server
administration tool from any workstation via http://servername or http://servername:9999/.

You can use this web tool to download the Automation Engine Client apps such as

• the Pilot
• the Script runner
• the ArtPro Action List Editor
• the Automation Engine 10 Backup Tool

The Server Admin Web Tool also includes a Server Admin section which can be used to administer the Automation
Engine Server and its settings, create and restore backups and manage databases, SQL Servers and the Application
Server.

Server administration consists of :

• Status Overview of the Server
• Setting up the server
• Backing up the server
• Restoring the server
• Managing databases
• Managing SQL servers

Read detailed information in Automation Engine Reference Guide.

Status Overview of the server

In the Status Overview you see an overview of the connected clients and the number of running tasks. You also get
an overview of the Server Version, Current role and Server databases. Here you can:

• Start and stop the Automation Engine server
• Activate the server after install
• Restart the web server
• Download the server administration log files for support purposes
• Start, stop or activate the local application server
• Download Application Server log files for support purposes
• Deploy components on the application server
• Log in to another server
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The Status Overview page contains more information from 12.1.1 onwards. Read below.

For each Server database, the SQL Server Instance and the SQL Server location is indicated at the Status
Overview page. The Status column indicates the following statuses :

• Online : The SQL Server instance where the server database is located is running. This also implies that the
user name and password used to login to the SQL Server instance are correct. The server database is online and
available for access.

• Not Accessible: The SQL Server instance where the server database is located is running. Valid credentials( user
name and password) are used. But the server database on the SQL Server instance is not accessible.

• Not Found : The SQL Server instance where the server database should be located is running and the credentials
used to login to the SQL Server instance are valid. But the server database could not be found on the SQL Server
instance.

• Login Failed:: The SQL Server instance where the server database should be located is running. The server
database is not available because the credentials used to login to the SQL Server instance are invalid.

• Offline: The server database is not available because the SQL Server instance where it is located is currently not
running.

• Unknown: The status of the server database on the SQL Server instance is unknown.

Tip:  When you move your cursor over the status of a server database, a pop-over message will indicate the
detailed status information.
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FAQ on Starting the Server

How to start or stop the server?

Click on either the Start server  or the Stop server  button. Starting or stopping the Automation Engine Server can
take up to one minute.  The Server Admin Web Tool will indicate the status during this process.

You can refresh manually or visit other pages while it is processing.

How to activate the server?

Click on the Activate server  button. When activating the server, a log window will indicate the server activation
progress.

How to stop or activate a server that still has connected clients?

If you try stopping or activating a Master or Assistant server with connected clients and/or executing tasks, you will
be asked to close all the Automation Engine applications. If you fail to do so, the open applications will be interrupted
and the server will be automatically stopped or activated within five minutes.

Note:  Stopping/ Activating process will make it impossible to login via a new client or start a new Task on
this Automation Engine Server

How to Cancel the Stop and Activate Processes?

You can cancel the Stop or Activate process by clicking on Cancel . You will be able to login again with a Client
and start new Tasks.

You can also Force stop or Force activate while waiting for the open applications to close. The server will then
break the connection with clients and will cancel all the executing Tasks.

How to download the Automation Engine Server log files?
When you click the Log Files button, a ZIP file containing the Automation Engine Viewer log files and the
Application Server log files will be downloaded. The ZIP file contains a folder named egappsrvlogs with Viewer
log files (ImageList*.log) and a folder jbosslogs with Application Server log files.

How to restart the Web Server?

You can restart the Tomcat Web Server using Restart Web Server button from the Web Server section. The Start/
Stop Server page will be automatically refreshed when the Tomcat Web Server is restarted. You can also refresh
manually to see if the Tomcat Web Server is restarted.

How to download the Web Server log files?

For Tomcat Web Server log files, click the Log Files button in the Web Server section. A ZIP file will be
downloaded to your computer containing the log files of the Tomcat Web Server and the log files of the Server
Admin Web Tool.

Log files for Client Apps are not found in the Server Admin Web Tool, because they are executed on the computer
itself.
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Gang Run Database

You can see the Gang Run Printing database in the Status Overview page when it is a separate database (separated
from Jobs database). The Gang Run data base will be listed under Server databases section.

 

 

When the Gang Run Printing database is a separate database, you can restore it indepdendently. Use the Restore page
of the Server Admin Web Tool.
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Read more about restoring databases in Restoring Database on page 

Setting up the server

In the Server Setup window you can change the server role: master, assistant or idle. You can also:

• View and remove Assistant Servers
• Change the system account and/or password
• Change the processing capabilities
• Redirect central resources to a central file server

Server Roles

You can configure an Automation Engine server installation as

• Automation Engine Master
• Automation Engine Assistant
• Data Server (Idle).

These act as a set of cooperating servers to distribute the workload and provide recovery when a system goes down.

Automation Engine Server Standalone Setup

The simplest configuration is a stand-alone Automation Engine server Setup. You can configure more than one such
setups. In this setup,

• each system has its own set of resources (such as CMS data, DGC data, font data, custom data, marks data, ink
planner data, task history database). Therefore, they function independently without sharing the workload.

• each system has separate local license management
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• you can create containers on shares of other systems.

 

 

Automation Engine Server setup with Assistant system(s)

This consists of Automation Engine Master server system and one or more Automation Engine Assistant systems. In
this setup,

• the Assistants use Master resources for performing tasks.
• Automation Engine Clients connect to the Master computer (but not to the Assistants).
• the workload on the different Automation Engine systems is allocated to the system with the smallest load. If one

of the Assistant systems goes down, it is automatically removed from the configuration and the other systems take
over the workload.

If the Master system goes down, the complete system shuts down.  
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Note:

• The Assistants take a copy of the complete configuration of the Master system. This helps in taking over
the Master role.

• The Assistants should have an Application Server and database engine installed locally for taking up the
Master role.

Automation Engine Server setup with Assistant system(s) and Data Server

You can configure an Automation Engine Data Server (Idle) which can be accessed when the Master goes down
along with the Assistants. A Data Server system can be set up for all the resources required to facilitate the take over
of the Master role by one of the Assistant systems.  

Note:  You need to save regular backups of the Application Server database on the Data server system. These
can be imported into the Assistant system's database when the Master goes down.
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Tip:  You can install the Application server software on another system instead of the Master.  

For more information on how to schedule backups read Creating a Back-Up Schedule on page 

General Remarks

• You should define and configure the PostScript printers on all the systems (Automation Engine Master and
Assistant) if the Print Task is used for outputting on PostScript printers. 

We recommend installing the PostScript printers locally on the:

• Master system (in Automation Engine Master- Assistant Setups)
• or on the Data Server (Automation Engine Data Server- Assistant server setups)

Configure them on the network so that you can access them on all other systems as network printer.
• Automation Engine Viewer and Automation Engine Server for CP applications require the Application Server

software. We recommend the Application Server Software to be installed on:

• the stand-alone systems ( they use own local installation of Application Server software and local database
engine)

•    the Master Server (in Automation Engine Master- Assistant Setups).

Note:  The tasks running on the Assistants always connect to the Application Server on the Master.

• the Data Server (Automation Engine Data Server- Assistant server setups)

Licensing Requirements for Different Server Setups

You require specific licenses for installing or converting systems to Automation Engine Assistant and/or Master 
server systems. These limit the number of Automation Engine Assistants and/or Master systems.

These licenses are installed on the Automation Engine Master (in Master- Assistant Server setups) and in the 
Automation Engine Data Server (in Assistant- Data Server Setups). These systems act as remote license manager 
systems for the Automation Engine Assistant or Master systems.

System Account

The Automation Engine Server service (BGMD), the Automation Engine Web Service (egwebsrv) and the 
Application Server service (EG Application Server) run on service account (user: BGSYSTEM - ask the default 
password to Esko).  You can change the username and password of this account.

 

Changing the System Account

• You can change the username to an existing Windows user. This user should be a member of the Windows
Administrators group of the Master computer.

• Modifying the system account will modify the service account of the:

• Automation Engine Server service (BGMD)
• Automation Engine Web Service (egwebsrv)
• Application Server service (EG Application Service) of the Master, Assistants and Data Server

in one operation.

You can use either local or domain username. However, the Application Server only supports the local BGSystem 
user.  If you specify another local user or a domain user as system account, the service account of the Application 
Server will NOT be modified automatically.  
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Tip:  You can use Windows tools (i.e. Service Manager) to modify the service account of the Application
Server.

• When the Application Server is not installed on the Master, Assistant or Data Server, the modification of the
system account is to be performed manually.

• If you have configured a Container or Resource a computer other than the Master, Assistant or Data Server, you
have to modify the system account manually.

Processing Capabilities

Can Run Tasks

You can select this setting to allocate the Task workload to this Server. If you have a Master Server with many
Assistants where the Master is heavily loaded, you can use this setting to allocate Task workload to the Assistants. Do
not enable this setting to run only File Streaming Sessions. 

Can Run File Streaming Sessions

Select this to set the Server to run File Streaming Sessions. This setting determines Automation Engine Viewer's deep
zoom abilities via File Streaming (implemented by a process called sdbserver.exe) which is started when you view a
file which has no prepared view data or when you zoom deeper than the resolution of the prepared view data.

The maximum sessions setting is the maximum number of simultaneous File Streaming sessions on the Server.

Important:  We recommend that only experienced system administrators or Esko Customer Service
engineers modify the maximum number of File Streaming sessions. Erroneous modification of the maximum
File Streaming sessions can seriously endanger the proper functioning of the setup.  

Redirect Central Resources

The Master uses the locally installed resources (fonts, CMS database, DGC curves etc) by default . You can use
Redirect Central Resources  task (only on Master) to redirect this to a Data server system.

You can redirect:

• bg_data_cms_v010 – the Color Engine database
• bg_data_custom_v010 - a resource containing various data like ArtPro action lists, Print Rule Checker profiles,

etc..
• bg_data_dgc_v010 - the Curve Pilot database contain dot gain curves
• bg_data_fonts_v040 – the Central fonts repository
• bg_data_ipldata_v010 – the Ink planner data
• bg_data_marks_v010 – the SmartMarks repository

Note:  You cannot redirect individual resources.

Backing up the server

In the Server Backup window you can manage the following backup settings:

• Specify a backup folder on the server.
• Specift the number of backups to be kept in Keep only last.
• Set a backup schedule or manage existing schedules.
• See the Backup history and details of each backup.

Tip:  Click on info to get more information about the selected backup. A Backup info window will list
the server, date, time, size and composition of the backup.

• Remove a backup.
•
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Creating a Back-Up Schedule

You can create a schedule to Back-Up the server configurations.

1. Go to the ServerAdmin pages. Task step.

2. Click on Back-Up in the left column.

3.
Click the lock  to make changes. You can specify where the Back-Up folder should be stored.

4. Click on the Add Back-Up Schedule button. A pop-up window will open asking for details.

You can also choose Make Back-Up Now to immediately start backing up.

5. Define when and what to back up and how many backups should be stored in the given fields. Fill in the
Frequency, Start time, Back-Up What and Keep only last fields.

FAQ on Backing-Up the Server

Is the configuration of the Automation Engine backed up automatically?

No. You need to set up a Back-Up schedule to achieve that. Read more about it in Creating a Back-Up Schedule on
page 

Can an Automation Engine Back-Up be made while the system is running ?

Yes. It can also be made when Automation Engine system is not running.

What is included in the Automation Engine Back-Up ?

The Back-Up includes the basic configuration always. Additionally, you can include DGC-files, Marks, CMS data,
Fonts and the data stored in the Databases in the Back-Up. This is called a Restore point which you can restore later.

Where are the backups stored ?

In the Server Back-Up window you can specify a Back-Up folder on the server. By default, the location of this folder
is a path local to the Automation Engine server.
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Tip:  A UNC path is accepted as the location. You need to make sure that the corresponding share is
accessible.

Tip:

You can keep a local path as destination Back-Up folder and save a copy on a DVD,/USB stick. The Back-Up
consists of a subfolder named like [Full]Backup__yyyy-MM-dd-HHMM.

Will I eventually run out of disk space when I schedule a regular Back-Up ?

You can configure this by setting how many backups you want to retain. Read more in Creating a Back-Up Schedule
on page .

Note:  The restore points (Back-Up including basic configuration, resources and databases) are never deleted.
Therefore, you need to save restore point backups on DVD/USB and delete them from the hard disk.

Restoring the server

In the Restore window you can view and restore back-ups. You can also:

• Restore, duplicate or migrate your server configuration
• Restore resources or databases only

Note:  Take into account that the server should be stopped before you can restore a back-up.

 

 

How to Restore the Server

You can use Restore when you want to:

• reverse to a previous backup inorder to correct some mistakes by going back in time.

You can use Restore Configuration to restore the Automation Engine backup that was made previously.
• build a testing scenario (alfa, beta or shadow production). You can take the production configuration settings from

the production computer by creating and copying a backup.
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After installing full Automation Engine on testing computer, you can restore the configuration in the testing
computer using Duplicate Configuration setting. You can therefore have production and testing systems run in
parallel.

• move to another computer. For example, upgrading from Automation Engine 10.1 on a separate computer or to
have a new computer where the Automation Engine will run henceforth.

Note:  You can create an Automation Engine 12 backup from an AE10.1 system. Read more in

You can choose Migrate Configuration after the full installation on the new computer. This will restore the old
production settings on the new computer.

• give the Master's configuration to an Assistant when the Master goes down.

You can restore the Master backup on the Assistant using Migrate Configuration restore action.

Note:  The Master backup can be found on the Assistant disk (C:\Esko\AEBackup.

1. Go to the ServerAdmin pages and click on Start/Stop Server  in the left column.

2. Click on Restore in the left column.

3.
Click the lock  to make changes.

4. Click Restore after selecting the corresponding entry in the Backup History list. For all other cases, click the
Select Backup Folder button and browse to the folder that contains the backup to be restored.

5. Finally, choose OK to start the restore action.

FAQ on Restoring the Server

Can I use a backup of one system to transfer its Workflow tickets to another Automation Engine
system ?

Yes, You need a dedicated Restore action. Consult Esko for this.

Can I use a backup of one system to just transfer its smartnames to another AE system ?

Yes, You need a dedicated Restore action. Consult Esko for this.

Do I need to restore backup when upgrading from Automation Engine 10 to Automation Engine
12 ?

No. When the same computer is used to run Automation Engine 12 , it will use the same configuration data and
databases.

Can I upgrade my BackStage 7Rx directly to Automation Engine 12 ?

No. You need to upgrade BackStage 7Rx to Automation Engine 10.1. You can upgrade this to Automation Engine 12.

Can I restore data from a backup of BS7Rx or AE 10 into an AE 12 ?

No. The format of BS 7Rx and Automation Egine 10.x backups is different from the format of the Automation Engine
12 backup.

How do I make Automation Engine 12 based backup of my Automation Engine 10.1 system ?

In the Client Apps view, click on Tools in the left column. Click on the Launch button next to Automation Engine 10
Backup.
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In the window that pops up, fill in the destination folder, decide whether to include the databases and click on
Backup Now.

Managing databases

In the Databases window you can manage all databases that are on any accessible SQL server in your network.
Depending on the permissions on the selected SQL instance, you can:

• View the SQL server status
• Login and view the properties and status for each database
• Create or remove databases
• Back-up or restore databases
• Repair or move databases

Note:  Take into account that, even if you are logged in to the Server Administration, you also need to log in
to the SQL Server instance separately.

 

 

In this page, you can manage the databases on any SQL Server in the network.

 

Managing SQL servers

In the SQL Server window you can manage any accessible SQL server in your network. You can:

• View the SQL server status
• Stop and restart an SQL server
• Login and change the properties: modify the maximum physical memory of the SQL server
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• Look at the SQL server logs

Note:  Take into account that, even if you are logged in to the Server Administration, you also need to log in
to the SQL Server instance separately.

How to Select and Log-In to SQL Server Instances

• You can select a SQL Server from the list of all SQL Servers that could be detected in your local network.

The local SQL Server will be selected as default if there is one.
• To choose one not in the list, you can click Select another SQL Server, enter the name of the SQL Server and

click OK.

You can see the list of SQL Server Instances and their statuses beneath the SQL Server list. You can select the
Server Instance on which you want to manage the databases.

Note:  If the SQL Server Browser service is not running or your access is blocked to the Server Service,
the status of the Instance will be unknown.

Note:  If the list of SQL Server Instances is not available, you can select a SQL Server Instance by
entering its port number. The port number of the default SQL Server Instance will already be filled in.

•
After selecting the SQL Server Instance, click the lock  at the bottom of the page. Enter your credentials to
login.

You should login to the SQL Server Instance to be able to manage the databases of a SQL Server Instance.

Note:  All SQL instances configured with Automation Engine has two users by default: sa and admin.
The sa  user has all permissions for managing databases.

The admin user has a limited set of permissions. Therefore, if you are logged in as admin, you may get
warnings while performing certain database actions.

•
You can log out from the SQL Server Instance by clicking on the lock .

• You can view the databases installed on an SQL Server Instance by selecting it and logging in. The list of
databases will load after logging in.

Detailed database information will be available to the right of the selected database.
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FAQ on SQL Server Instances

How to start or stop a SQL Server Instance?

Select the SQL Server Instance you want to start or stop and click on Start the server or Stop the server.

You are not required to login to the SQL Server Instance to Start or Stop the Server.

How to view the properties of a SQL Server Instance ?

You should select a SQL Server Instance and login to it. The properties will be loaded automatically after you
successfully logged in. Read more in How to Select and Log-In to SQL Server Instances on page 

How to modify the maximum physical memory of a SQL Server Instance?

Click on the Modify  link next to the current value of the maximum physical memory. The Change max. physical
memory dialog will open. Enter a value and click OK.

How to view SQL Server logs?

Click on the Show  link next to SQL Server logs. You can see the SQL Server logs in the following dialog.

Note:  You will get a warning when you attempt to view the SQL Server logs if you have limited
permissions.
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Creating an Empty Data base

1. Click on + button. The Create database dialog will follow.

2. Fill in Database name  with a name that is not currently used.

3. If you want to create a new empty database, leave the Use data setting to No (empty database).

4. Enter the location and the file name for the Master database file  and the Transaction log file. Alternatively, use
the Browse to a specific location for these files.

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the local SQL
Server, the Browse  will be disabled. In such cases, fill in the UNC path.

5. Click OK to create an empty database.

Creating A Database from Back-Up

1. Click on + button. The Create database dialog will follow.
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2. Change the Use data setting to From backup .

3. Enter the location and the file name of the Backup file or use the Browse  button to select it.

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the local SQL
Server, the Browse  will be disabled. In such cases, fill in the UNC path.

4. The information from the backup file will be loaded and the Database name, Master database file  and
Transaction log file textfields will be filled in. If not, fill them in manually. Check the fields to ensure that the
database will be re-created correctly.

5. Click OK  to create a database from the backup file.

Creating a Database from Existing Database Files

1. Click on + button. The Create database dialog will follow.

2. Change the Use data setting to  From existing database files .

3. Enter the location and the file name of the Master database file and Transaction log file or use Browse .

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the local SQL
Server, the Browse  will be disabled. In such cases, fill in the UNC path.

4. Click OK  to create a database from the backup file.

Deleting a Database

You can delete a database if that is not used by Automation Engine and the Automation Engine Server. If it is
running, trying to delete will prompt a warning.
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1. Select a database from the list and click the - button.

2. Choose either or both of the options.

• delete database files from disk
• close existing connections

3. Click OK to confirm.

Database Back Up

Context for the current task

• Select a database and click on Backup . The Backup database  dialog will open.
• Enter the location and the file name for the Backup file. use Browse  to choose a back-up file.

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the local SQL
Server, the Browse  will be disabled. In such cases, fill in the UNC path.

• Click OK.

If the selected SQL Server does not have access to the UNC path you entered, the Server Admin Web Tool will
show a warning: "Backup file for database X could not be created. Please make sure the path for the backup file is
correct.".

You can ensure access to the UNC path share by following the procedure outlined below:

1. In Windows Explorer, right-click the shared folder and then click Properties.
2. Select the Security  tab.
3. Click on Advanced . The Advanced Security Settings dialog will open.
4. Click on Change Permissions  under the Permissons tab.
5. Click on Add .
6. Click on Object Types button and make sure the Computers checkbox is checked. Click OK.
7.   In the textfield, give the SQL Server computer name for which you want to add permissions. Click on Check

Names . Click OK. The Permission Entry dialog will open.
8. Make sure the Allow checkbox next to Create files / write data  is checked. Click OK.
9.   Click OK  and close the open dialogs.

Restoring Database

You can restore a database by using Restore  function. You can will the location and file name in the Restore
database  dialog. Click OK to restore the backup. 

You can restore a database that does not exist (anymore) on the selected SQL Server Instance databases list. Click
on +  to create a database from a backup file or from existing database files. Read more in Creating A Database from
Back-Up on page  and in Creating a Database from Existing Database Files on page 

Note:

If the database you are trying to restore is used by Automation Engine and the Automation Engine Server is
running, it will not be possible to restore the database and you will get a warning.

Moving or Renaming a Database

Context for the current task

1. Select a database from the list and click on Move . The Move database  dialog will open. .

2. Enter the new location and the new file name for the Master database file and the Transaction log file or use the
Browse  button to select it.

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the local SQL
Server, the Browse  will be disabled. In such cases, fill in the UNC path.

3. Click OK  to move/rename a database.
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Application Server

You can manage the local Application Server which is installed on the same computer as the Automation Engine via
the Server Admin Web Tool. Go to Home/Server Admin/Application Server. In the Application Server
window you can view the status of any accessible application server in your network. You can:

• Start, stop or activate the local application server
• Download log files for support purposes
• Deploy components on the application server
• Log on to another application server

 

 

Among the actions available at this page. Deploy is only available when the server is configured as Master Server. All
the other actions are available when Application Server is installed.

Managing Application Server

Activating the Application Server

You can Activate the Application Server for repairing a serious malfunction of the Application Server and when
executing Deploy does not solve the malfunctioning of the Application Server.

Retrieving the Automation Engine Viewer Log Files
When you click the Log Files button, a ZIP file containing the Automation Engine Viewer log files and the
Application Server log files will be downloaded. The ZIP file contains a folder named egappsrvlogs with Viewer
log files (ImageList*.log) and a folder jbosslogs with Application Server log files.

Tip:  The log files of the Pages and Proofs View are contained in the log files of the Application Server. 

Deploy

When you click Deploy, Automation Engine Components are copied into the EG_APPSRV_DEPLOY and
EG_APPSRV_BINDEPLOY share of the computer indicated in the Deploy dialog. When you start the deploying, you
indicate which computer Automation Engine will use for connecting to the Application Server.
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Note:  Deploy can only be performed when the Master Server is running.

When to use Deploy?

You can use Deploy when:

• you want to use another computer as Application Server.
• the Application Server installationreinstalled, repaired or updated.
• fixing incomplete or failed deployments. 

The Automation Engine components are deployed on the Application Server during the installation of Automation
Engine.  If the deployment failed or was not executed, you can use Deploy to complete the procedure.

Note:  Incomplete deployments can cause the following issues :

• The Viewer window fails to open when clicking on View in the Pilot.
• The Pages and Proofs View fails to function.

Troubleshooting

If you get an error message “Failed to connect server: host:8080” while clicking View in the Automation Engine
Pilot:

•
Verify that the Application Server is started.  Check the status and click the refresh icon  next to the
status.  Restart the Application Server and open the View again.

• It is possible that the deployment is incomplete.  Click the Deploy button and verify that the deployment succeeds.
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 The Automation Engine Shuttle

The Automation Engine Shuttle is a client tool for easy submission of files to Automation Engine workflows. Shuttle
also allows monitoring of the workflows.

Download Shuttle from the Client Apps section of the Server Admin Web Tool. You can access it by browsing to
http://<name of your server>  or  http://<name of   your server>:9999. Read more in
Installing Client Applications

If the Shuttle application is installed on your computer, the system will check if you have the appropriate version and
download updates if necessary.

 

 

You need to setup the Shuttle in  Tools > Configure > Shuttle . Read more in Shuttle

Launching the Automation Engine Shuttle

When you launch the Shuttle application, a pop up window with the Shuttle Launch panel and a Task Monitor will
appear.
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• To open a new window, go to  File  >  New Window . You can use dedicated Shuttle windows for each of your
Workflows.

• Shuttle saves the settings of the open windows while closing. These settings are restored during the next launch.
• You can use View menu to hide or show the The Task Monitor, Shuttle Launch panel and the Status Bar.

• View > Tasks  hides/shows the Task monitor.
• View > Launch Panel  hides/shows the Launch Panel.
• View > Status Bar  hides/shows the Status Bar indicating the progress.

Working with the Automation Engine Shuttle

You must login to the Automation Engine Server to use the Shuttle.

Note:  You have access to Shuttle if you have access to Pilot. But your access to Pilot may be restricted even
when you are allowed to use Shuttle. This requires a user access right (Pilot: start the Pilot (in addition to
Shuttle)). Read more in Access Rights on page .

The following menus are available in the Shuttle application on Mac and Windows:

• File menu: submit one or more files and launch the selected Workflow, open new Shuttle windows and close
Shuttle windows.

• Edit menu: cut, copy, paste, delete a Task or Workflow, select all Tasks and Workflows in the Task Monitor.
• View menu: show or hide the Task Monitor, the Shuttle Launch panel and the Status Bar.
• Task menu: open or show the output file of the selected Task or Workflow, release or cancel the Task or

Workflow, add annotations and show detailed information.
• Window menu: minimize, zoom and switch between Shuttle windows.
• Help menu: open the Online Help (Esko Help Center).

Setting the Preferences for Shuttle

• On Mac, select Preferences... in the application menu.
• On Windows, go to  Edit > Preferences...

In the Preferences window, set the units for Dimension, Resolution, Ruling and the number of Decimals to use.
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The Task Monitor

When you are logged in, The Task Monitor displays your Automation Engine Workflows launched from both the
Shuttle and the Pilot.

You cannot view, open or edit the Tickets of the Tasks or the Workflows in the Task Monitor. This is only possible in
the Automation Engine Pilot.

You can intervene when a workflow is halted for user intervention provided the Workflow user intervention settings
designate you for intervention. To intervene,

• Click on User intervention needed link of a workflow.
• In the resulting To Do window, choose to Forward or Release.

 

 

Tip:  You cannot hide the columns displayed in the Task Monitor. However, you can change the order and
the width of the columns.

Right-click on a workflow/task to access the context menu with the following options:

• Open Output File opens the output file of the Task or Workflow with the appropriate application.
• Show Output File in Finder/Explorer shows the folder that contains the output file in Mac Finder or in

Windows Explorer.
• Release allows you to release the Task or Workflow if it is on Hold.
• Cancel allows you to cancel the Task or Workflow.
• Delete allows you to delete the Workflow from the list of Workflows the Task Monitor.
• Annotation... shows a dialog that allows you to add or modify an annotation.
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• Details shows the Details dialog with detailed information about the Task or Workflow.

These options are also available via the Task menu of the Shuttle application.

 

 

The Shuttle Launch Panel

You can drop one or more files as input files for the selected Workflow/Task through the Shuttle Launch Panel.

• Browse to the desired workflow using the drop-down list Workflow. This will be updated when new workflow
tickets are created. Shuttle launches the selected workflow when files are placed in the Shuttle Launch panel.

Attention:  The drop-down list only shows the Workflow Tickets that are public.

• The selected workflows are saved when you quit Shuttle. Shuttle restores the selection of workflows during the
next launch.

Launching a Workflow from the Automation Engine Shuttle

1. In the Shuttle window, go to View to display the Shuttle Launch Panel if it is not visible.



Automation Engine |  The Automation Engine Shuttle  | 127

2. Select the desired Workflow. Shuttle will launch this workflow when files arrive at the launch panel.

3. Submit one or more files in one of the following ways.

• Drag and drop files into Drop Files Here area.
• Click the Launch... button and select the files.
• Go to  File  > Launch...  and select the files.
• Use the keyboard shortcut Command-L on Mac or Ctrl-L on Windows and select the file(s).

Note:

• The selected files will be uploaded to the Upload Folder. This folder should be defined in the
Automation Engine Pilot if it is not in one of the Automation Engine Containers.

• If you want to submit externally referenced files, place them inside an Automation Engine container.
External references are not allowed in files if they are not placed in a Container.

4. If your workflow has Public Parameters, you can fill them in the New Task window which will pop-up. It also
possible to set the Task Options in this window.

a) You can set Task OptionsIn the New Task window, click the Task Options button.

In the resulting window, you can:

• set the Priority of the Task or Workflow as Low, Normal, High or Immediate by selecting from the drop-
down.

• select Hold if you want to hold the launch of the Workflow. The Workflow will not be launched until you
Release via the right-click menu in the Task Monitor or via the Task menu.
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Alternatively, hold the workflow until a set period of time after which it will be automatically released. To
do this, select Release at and specify the period or date and time.

Note:  You can bypass the automatic release setting by selecting Release via the right-click menu
in the Task Monitor or via the Task menu.

• Select Launch a separate Task per input file for launching a separate Task or Workflow for each input
file.

• You can also set an Annotation for the Task or Workflow in this window.

5. Click the Launch button to launch the workflow. It will immediately appear in the Task Monitor.

User Intervention from the Shuttle

If you have setup a Wait for Action step in the workflow, the process halts for user intervention (for a To Do action).
User intervention needed link will appear in the Task monitor when the workflow is halted.

1. Click on the User intervention needed link.
The To Do window will pop up.
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2. You may select I am currently handling this to do item to mark that you are handling the To Do.

3. You can now choose to Forward, Release or Delete the To Do.

• You can let the workflow continue by clicking Release. Select the output state that you require in the release.
The To Do window will close and the Workflow will continue processing.

• You can forward the To Do to another user. Click Forward and the workflow will not continue until the other
user handles the To Do.

• You can also delete the To Do by clicking on Delete. This will end the processing of the workflow.
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 The Workflow Editor

The Automation Engine workflow editor allows you to:

• build workflows,
• launch them on your files,
• monitor the progress of your files in the workflows,
• relaunch workflows with modified parameters,
• view processing details and log information,
• access to-do lists for the open workflow,
• view your (processed) files in the containers structure (in the Files view),
• view your (processed) files in the Automation Engine Viewer,
• open your (processed) files in your chosen application.

You can open it from the Pilot using  (from the Tickets view) or  (from the Files view).

The Workflow Editor Window

The workflow editor window consists of several areas:
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1. The Workflow Editor Menus on page .
2. The Tool Bar on page .
3. The files pane shows the files that you have launched on the workflow (only when opened from the Files view).
4. The favorites bar shows the most commonly used workflow controls (by default) and the other workflow steps

you have added as favorites (if any).
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5. The canvas shows your workflow (and the file it processes if you have launched it on a file).
6. The workflow step list shows all the Workflow Steps on page  (workflow controls and tickets) you can

include in your workflow (to know how to build a workflow, see Building Workflows in the User Guide).

The two fields (filter and search field) on top of the step list allow you to find specific steps.

The Workflow Editor Menus

While Building a Workflow

Use this menu... if you want to...

File • Launch a file into the workflow (when you
selected a file before building the workflow).

• Launch a file into the workflow and keep the
workflow editor window open (Launch And
Monitor).

• Select a file to launch in the workflow (Select
File...).

• Save your workflow parameters in a ticket
(Save Ticket).

• Save your workflow ticket under a different
name (Save Ticket as...).

• Show some information about the ticket (Show
Info): its Name, Task Type, if it is Public or
not, and a Description.

• Close this workflow editor window.
•

Edit • Undo or Redo your latest changes.
• Cut, Copy or Paste the selected item.
• Select All.
• Delete the selected item.

View • Change the zoom (you can view the
workflow's Actual Size, Zoom In, Zoom Out,
or Zoom to Fit the window).

• Show / Hide Favorites, Files, Tasks and
Sticky Notes.

• Expand or Collapse the Queue.

Advanced • Add this workflow tickets to your favorites.
• See a processing Log (when running the

workflow on a file). You can also send the log
contents as an email.

• Setup Task Options: Priority, Hold / Release,
Annotations...

• Setup Notification Rules (see Defining a
Notification Rule on page  for details).

• Manage Public Parameters for the selected
workflow step (see Managing Public
Parameters in Your Workflow in the User
Guide).
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Use this menu... if you want to...

• Check and Modify Public Parameters Values
for the whole workflow (see Checking All the
Workflow's Public Parameters Values in the
User Guide).

For a Saved Workflow

Use this menu... if you want to...

File • Save your workflow parameters in a ticket.
• Save your workflow ticket under a different

name (Save As...).
• Close this workflow editor window.
• Show some information about the ticket (Show

Info): its Name, Task Type, if it is Public or
not, and a Description.

• Print your workflow canvas.

Edit • Undo or Redo your latest changes.
• Cut, Copy or Paste the selected item.
• Delete the selected item.

View • Change the zoom (you can view the
workflow's Actual Size, Zoom In, Zoom Out,
or Zoom to Fit the window).

• Show / Hide Favorites, Tasks and Sticky
Notes.

Advanced • Setup Notification Rules (see Defining a
Notification Rule on page  for details).

• Manage Public Parameters for the selected
workflow step (see Managing Public
Parameters in Your Workflow in the User
Guide).

• Check and Modify Public Parameters Values
for the whole workflow (see Checking All the
Workflow's Public Parameters Values in the
User Guide).

The Tool Bar

The tool bar has buttons to:

• perform specific actions on the workflow ticket (save it, setup task options, notification rules or add public

parameters): ,
• launch the workflow on the selected files (only when you opened the workflow editor from the Files view):

,
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•

change the zoom in the workflow pane (zoom in , zoom out , zoom to fit ),

Tip:

You can also use the following shortcuts:

• Ctrl + Space (on Windows) or Space + Cmd (on Mac) to activate the zoom in tool, then click or drag
in the window.

• Ctrl + Alt + Space (on Windows) or Cmd + Option + Space (on Mac) to activate the zoom out tool,
then click in the window.

•
delete a step you selected ( ),

•

show / hide certain areas of the window (files  -when opened from the Files view-, favorites , tasks

, tickets ).

Workflow Steps

Workflow Controls and Tickets

Workflow steps consists of workflow controls and tickets.

• Workflow controls are steps that perform an operation of your files (for example routing it to another step, or
splitting groups of related files), but do not have a ticket.

See Workflow Controls.
• Tickets are all the other workflow steps. They are equivalent to the Automation Engine tasks tickets, but used in a

workflow context. As with the tasks tickets, there are default tickets, and custom tickets that you create.

To show both custom and default tickets, or just default tickets in the workflow steps list, see Displaying Your
Custom Tickets.

A Step Close Up

Every step (except for the OK, Warning, Error and Cancel Workflow workflow controls) has one or more outputs,
shown as green and red pins.

Green pins indicate a successful output, and red pins a failed output.

 

 

To make a workflow, you need to connect the output of each step to another step.

To do this, click its green pin and drag it onto the other step. This links the two steps with a green tube.
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For more information about how to make a workflow, please see Building Workflows in the User Guide.

Workflow Controls

The workflow editor window contains tickets and workflow controls.

You can see these workflow controls:

• at the start of the workflow step list,
• in your favorites bar (by default, this shows the most commonly used workflow controls, but you can add or

remove workflow controls or tickets from this bar).

 

 

Note:  To only see workflow controls in your step list, use the Workflow Controls filter.

The workflow controls are:

•

 Start: This is already in the canvas (by default) so you don't need to manually add it at the start of a new
workflow.

•
 Set Priority: Use this to assign a different priority to certain branches of your workflow. See Set Priority on

page  for details.
•

 Sort: Use this to change the order of the files in a file set, based on certain criteria. See Sort on page 
for details.
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•

 Router: This allows you to automatically route files based on certain criteria. See Router on page 
for details.

•

 Mark: Use this to tag files that you will need to select later in the workflow (with the Select workflow
control). See Mark and Select on page  for details.

•

 Select: Use this to select files that you have tagged earlier in the workflow (with the Mark workflow
control). See Mark and Select on page  for details.

•

 Data Splitter: Use this when you want to send related files one by one to the next task instead of all
together. See Data Splitter on page  for details.

•

 Data Collector: Use this to collect all related files travelling one by one in the workflow and send them
all together to the next task. See Data Collector on page  for details.

•

 Fork: Use this to tag files (all related files get the same tag). See Fork and Join on page  for
details.

•

 Join: Use this to group all related files tagged the same way by the Fork workflow control. See Fork and
Join on page  for details.

•

 Cancel Workflow: This cancels your workflow processing when a file is sent to it.
•

 OK: By default, there is already one OK step in the canvas. You can add more and route files processed
successfully to the appropriate OK step.

For more information about routing, see Using Routing in Your Workflow in the Automation Engine User Guide.
•

 Warning: Add this at the end of your workflow to route files that generated a warning during processing.
•

 Error: Add this at the end of your workflow to route files that generated an error during processing.

Note:

To have a general error output in your workflow, you don't need to add an Error step and connect all of
the steps’ red pins to it.

You can see files with an error status in the step's output widget.
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For more information about output widgets, see Processing in the Workflow Editor Window.

Set Priority

Use the Set Priority workflow control to assign a different priority to certain branches of your workflow.

You can set that priority to:

• Workflow (to use the general priority assigned to the workflow),

Note:  By default, the general workflow priority is set to Normal. You can change it by going to 
Advanced > Task Options...  in the workflow editor window.

• Low,
• Normal,
• High,
• Immediate.

You can see the priority you have chosen in blue under the workflow control.

 

 

Example

In this example, the most important operation is ripping the files and sending them to the device.

The other branches (generating View files in case they are needed for later troubleshooting, and uploading low-
resolution JPEGs to an FTP site) can have a low priority.
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Sort

Use the Sort workflow control to change the order of the files in a file set, based on certain criteria.

 

 

You can sort the files by:

• file name,
• workflow inputs (so files that entered the workflow first will be at the top of the list),
• Smart Name (to calculate the value of a specific Smart Name in each file and sort the files on that value).

You can sort in ascending or descending order.

Regular expression

When sorting the files on their file name, you can use a Regular expression to select the part of the file name to sort
on.

There are two default regular expressions built into the workflow control:

• (.*) matches the entire file name,
• .*?([0-9]+) matches the number in the file name (use this for example for files called cover1.pdf,

page_2.pdf, etc.).

Smart Name

When sorting on Smart Names, select the Smart Name you want to sort on. This only lists custom Smart Names.

Sort numerically
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This option is available when sorting on file names using a Regular expression, or when sorting on Smart Names.

Select it if you are using a regular expression to extract a number from file names, or a Smart Name returning a
numeric value.

The results will then be evaluated numerically (and not textually). For example, a value of 10 will be sorted after 9
when this option is selected (but before when evaluating the results textually).

Accept non-matching files

Select this option if you are using a regular expression or Smart Name, and expect that some files may not be
matched.

Use it for example when some files supplied to you have an unexpected name structure (that differs from the rest of
the files), or when the Smart Name you are sorting on cannot be resolved for a certain file.

In those cases, the mismatched file will be put at the top of the sorted list.

If you don't use this option and encounter a mismatched file, all your files will go to error.

Keep ... file(s)

Use this if you only want to send some of the files that have been sorted to the next workflow task.

Tip:

For example, you can use the Sort workflow control to pick the file with the lowest Total Area Coverage out
of several similar files:

1. Select Sort by Smart Name in descending order.
2. Select your custom Smart Name extracting the Total Area Coverage value in each file (for example

[TotalAreaCoverage]).
3. Select Keep and enter 1 file(s).

When sending your files through the Sort, only the file with the lowest Total Area Coverage will be passed
on to the next task.

Example

In this example, the Data Collector collects the pages of a page list after Normalizing, and sends them to the Sort
workflow control.

The Sort workflow control then sorts them in the right order, before sending them to the Create Imposition task.

In this case, the files are sorted on file name, in ascending order, using a Regular expression to extract the number
in the file name (and with the Sort numerically option).
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Router

You can use the Router workflow control  to route your files automatically.

In the Router’s settings, you can choose to automatically route your files based on certain criteria (the file type, the
number of separations, the value of a job parameter., the job operation context..).

Files matching your chosen criteria will automatically be sent through the corresponding output.

Router Settings
 

 

Route based on: choose what criterion to use to route your files automatically:

• Job Parameter Value: choose this to route your file based on a job parameter (you can find job parameters in the
Parameters and Step&Repeat tabs of the Job Setup).

Enter the Parameter Name and select Case sensitive if you want to match the exact case of the value.
• Job Field Value: choose this to route your file based on a job's custom field (Job Category 1 to 7). You can find

job categories in the Job and Categorization (if you have more 3 or more job categories) tabs of the Job Setup.

Select the Field Name and select Case sensitive if you want to match the exact case of the value.
• Number of Files: choose this to route collections of files based on the number of files in the collection.
• Milestone: choose this to route your file based on a Milestone. Type in the Milestone to check for, and decide

where to send the file when the Milestone is Set or Not Set.

Note:  If the Milestone doesn't exist, or you aren't running the task in a job context, the Milestone will be
considered Not Set.
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• File Name: choose this to route files based on their name.

Select Case sensitive if you want to match the exact case of the file name, and choose to Include the file
extension or not.

• File Type: choose this to route files based on their type.
 

 
• File Size: choose this to route files based on their size.

Select Consider the combined size of all files in the collection if you want to match the size of the whole file
collection and not of its individual files.

• Number of Pages: choose this to route files based on their number of pages.

Select Consider the combined page count of all files in the collection if you want to match the page count of
the whole file collection and not of its individual files.

• Page Orientation: choose this to route files based on their orientation (Portrait, Landscape or Square).
• Page Size: choose this to route files based on their page size.

In Page box to use, you can choose either Trimbox or Mediabox. For non PDF files, the Mediabox is equal to
the Trimbox plus the margins of the document.

Note:  This doesn't take the page orientation into account. For example Page size is equal to
210 x 297 mm will match both portrait and landscape A4 files.

• Number of Separations: choose this to route files based on their number of separations.

Select Consider the combined separation count of all files in the collection if you want to match the number of
separation of the whole file collection and not of its individual files.

Note:  This counts the number of unique separations. For example, if you have a CMYK+Red and a
CMYK+Green file, the collection’s combined separation count will be 6.
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• Separation Name: choose this to route files based on the name of their separation(s).

Select Case sensitive if you want to match the exact case of the separation name.

Note:

You can check if any, all or none of the separation names match.

For example:

• all does not contain Cyan or none contains Cyan will match files with no Cyan
separation. It will not match CMYK files.

• any does not contain Cyan will match files that have separations other than Cyan. It will
match CMYK files (it will match the M, Y and K separations).

• Layer Name: choose this to route files based on the name of their layer(s).

Select Case sensitive if you want to match the exact case of the layer name.

Note:

You can check if any, all or none of the layer names match. When using any, only one layer name needs
to match for the file to be considered matching.

• Smart Name Value: choose this to route files based on a Smart Name value.

Enter or select the Smart Name to use and select:

• Treat as numeric value if you want to evaluate the Smart Name value numerically (and not textually).

For example, a value of 10 will be sorted after 9 when this option is selected (but before when evaluating the
Smart Name value textually).

• Case sensitive if you want to match the exact case of the Smart Name (for textual Smart Names).

Note:

As routing on SmartNames requires more resources, we advise you to use another routing criterion instead
if possible.

If you need to use SmartNames to retrieve job information, we advise you to add a Data Collector step
in front of your Router. This will group the files into a collection and allow the Router to perform the
SmartNames check only once.

Mark and Select

Use the Mark workflow control to tag files, then the Select workflow control to select those files later in your
workflow.

Mark Settings

In Mark all incoming items with tag, enter the tag to set on the files passing through this workflow control.

Select Settings

In Select all items with tag, select the tag you entered in the corresponding Mark workflow control.

You can filter the tagged files using SmartNames: select Only select when name matches and choose your
SmartNames. You can use the asterisk * as a wildcard.

If you are working with nested workflows (see Nested Workflows in the User Guide), you can choose to Also search
workflows containing this workflow.

Example

You can tag the One-Up file in a Step & Repeat workflow with the Mark workflow control, then select it with the
Select workflow control and archive it.
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Note:

You need to use the same tag (here: One-Up) in the Mark and Select steps.

You can have several pairs of Mark and Select in your workflow, as long as each pair has its own tag.

 

 
Data Collector

Use the Data Collector workflow control to collect all related files travelling one by one in the workflow and send
them all together to the next task.

Example

In this example, the Data Collector waits for all of the files (input files and reports) to arrive to it, and sends them
together to the Zip.

The result is one big zip containing all of the input files and their reports.
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Data Splitter

You can use the Data Splitter if you want to process each file of a file set individually.

Example

In this example, the Data Splitter sends the unzipped files to the Checkpoint (“Prepare for trapping”) one by one.

The operator gets a To-Do for each file, prepares it and releases it to the Trap step. The files are trapped one after the
other.
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Advanced Data Splitting Using Regular Expressions or SmartNames

You can use the Data Splitter without any parameters to simply split files, or you can use it to split the files and
group them according to a criterion you define.

For instance, when you create Ripped output, you can automate the grouping of all separations for next task Prepare
for Viewing. For this, you can choose a smartname wthout the separation variable.

You can do this by using a regular expression or by using SmartNames.

There are two default regular expressions built into the workflow control:

• (.*) matches the entire file name,
• .*_pag([0-9]+).*? matches the number directly after _pag in the file name (use this for example for files

called page_1.pdf, pagina_2.pdf, etc.).

To create your own regular expression, see Regular Expressions on page  or contact Esko Professional
Services.

Note:

To automate the nesting process in an i-cut Workflow, you can produce a grouped output using Xpath
SmartNames mapping to the 'substrate name's. All the data under the same 'substrate' will be produced as one
output for the nesting.

Example

In this example:



146 | Automation Engine |  The Workflow Editor

1. The RIP generates a C, M, Y and K separation for each page of a multi-page file.
2. The Data Splitter groups these separations per page using a regular expression.
3. The Create Wrapper task receives those groups and outputs one file per page, containing all four separations.

 

 
Fork and Join

The Fork workflow control automatically tags every file running through it, and files later generated from this file
(for example report files) get the same tag.

The Join workflow control groups all the files with the same tag.

Example

In this example, the box10.pdf file gets a tag in Fork, and goes to Create Report which generates a report file
(box10_report.pdf) with the same tag.

The Join workflow control groups box10.pdf and box10_report.pdf based on their common tag, and sends
them together to the Zip step.

The final output (the zip) contains box10.pdf and box10_report.pdf.
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Displaying Your Custom Tickets

By default, the workflow editor’s step list only shows the default tickets (sorted by task type). To show your custom
tickets as well, do the following:

• Right-click in the workflow step list and select Show Custom Tickets.
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• To revert to showing only default tickets, right-click again and select Hide Custom Tickets.

Deprecated Steps

There are two steps from the old workflows (task chains) that are deprecated in Automation Engine 10: Mark File
and Fork.

They have been replaced by the Mark workflow control, and by advanced routing functionality (see Using Routing in
Your Workflow in the User Guide).

These replacements make the new workflows more efficient and more flexible.

Processing in the Workflow Editor Window
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You can see your file(s)  going from task to task, with the status displayed in blue.

Note:  The file icon can represent a single file or a collection of related files, depending on your workflow
step’s output.

Each task or workflow control indicates the number of files ran successfully (in green) or with an error (in red)
through it.
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Click on a pin to show an output widget containing the file(s) processed by this step.
 

 

You can:

• click a file in the widget to see the workflow path it followed (in yellow),

 

 
• right-click the widget to perform more actions on the file (view it, relaunch it...).
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Workflow Parameters

You can create and use Workflow parameters specific for workflows. Their use is similar to the use of Job / Product
Parameters. Access them from any SmartName-enabled field of the workflow tickets.

The values for these workflow parameters have to be defined before the workflow is launched.

Note:  Workflow parameters are public parameters which are only accessible from the workflows in which
they are defined including the child workflows.

Managing Workflow Parameters

You can view and manage the Workflow Parameters from the workflow canvas. Go to  Advanced > Manage
Workflow Parameters...  or  Tools > Manage Workflow Parameters... . Use the resulting Manage Workflow
Parameters dialog to add, edit and remove workflow parameters.

• This window lists all the Workflow Parameters defined in the current workflow and all of its child workflows.

Note:  Workflow Parameters defined in the parent workflow is not visible in this dialog.

• This window can be kept open while making changes in the current workflow (or child workflows) and while
navigating to and from child workflows. The list of Workflow Parameters is instantly updated to reflect changes.

• Read more about manually creating workflow parameters in : Creating Workflow Parameters.
• Read more about loading workflow paramteres from an XML file in Editing the Workflow Parameters.
• Read more about editing and removing workflow parameters in Using Workflow Parameter Values from XML

Creating Workflow Parameters

1. Open the workflow or child workflow where you need a new Workflow Parameter.

2. Go to  Advanced > Manage Workflow Parameters...  or  Tools > Manage Workflow Parameters... .
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Manage Workflow Parameters dialog will open.

3. Click on Add.

 

 

Workflow Parameter window will pop up.

4. Enter the Name and Value for the Workflow Parameter.

5. Click Ok.

Loading Workflow Parameters from XML

You can create Workflow Parametrs from an XML element. Make sure that your XML file has an element with the
following structure:

<wfparams>
<Material>Forex</Material>
<PrintingMethod>Offset</PrintingMethod>
<OutputFolder>output</OutputFolder>
<RepeatX>3</RepeatX>
<RepeatY>5</RepeatY>
</wfparams>

1. Open the workflow or the child workflow where you want to add Workflow Parameters

2. Go to  Advanced > Manage Workflow Parameters...  or  Tools > Manage Workflow Parameters... .

3. On Mac, select Load... from the action pop-up menu. On Windows, click Load....

4. Browse to the location of the XML file. Select the XML file and click Open.
The  Load Workflow Parameters from XML  dialog will pop up.

5. Select an XML element from the XML file to load Workflow Parameters from. You can leave it blank to select
the Root Element of the XML file. 
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6. Click OK. New Workflow Parameters will be created in the workflow.
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Using Workflow Parameter Values from XML

You can use values from an XML file and apply them to the workflow parameter existing in a workflow. You need to
make sure that XML file has the following structure:

<wfparams>
<Material>Forex</Material>
<PrintingMethod>Offset</PrintingMethod>
<OutputFolder>output</OutputFolder>
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<RepeatX>3</RepeatX>
<RepeatY>5</RepeatY>
</wfparams>

1. Open the workflow in which the Workflow parameter values need to be applied.

2. Go to  Advanced > Manage Workflow Parameters...  or  Tools > Manage Workflow Parameters... .

3. Select the Use values from XML file checkbox. You will be asked to confirm this step. Click OK.

 

 

Note:  If you use values from an XML file, the resulting Workflow Parameters will not be Public.

4. Select the XML file using Browse. Alternatively, use SmartNames.

5. Launch the workflow.

Editing the Workflow Parameters

1. Go to  Advanced > Manage Workflow Parameters...  or  Tools > Manage Workflow Parameters... .

2. In the resulting dialog, click Edit. Alternatively, double-click the Workflow Parameter.
Workflow Parameter dialog will pop up.

3. Enter new Value for the Parameter.

4. Click OK.

Note:  If you edit the value of a Workflow Parameter that is defined in a referenced workflow, its value
will be overruled with the new value without changing in the referenced workflow. In the  Manage
Workflow Parameters  dialog, a pencil icon will appear next to the Workflow Parameters that are
overruled.
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Note:  You cannot overrule the Workflow Parameters that come from an XML source.

Removing the Workflow Parameters

1. Go to  Advanced > Manage Workflow Parameters...  or  Tools > Manage Workflow Parameters... .

2. Select the Workflow Parameter to be removed.

3. Click Remove. The selected parameter will be deleted.

Using Workflow Parameters

The use of Workflow Parameters is very similar to the use of Job Parameters and Product Parameters. Workflow
Parameters will appear as SmartNames that can be used in any SmartName-enabled field of the Tickets in the specific
workflow(and child workflows) where they were defined.

You can define the values from the workflow canvas as well as via XML. While using Shuttle, you can change the
values of the workflow parameters provided they are Public Parameters.

Note:  The values for the Workflow Parameters have to be defined before the workflow is launched.

Note:  Workflow Parameters are Public Parameters by default. However, it is possible to remove it from the
Public Parameters list. Once deleted from Public Parameters, you cannot change the value of that Workflow
Parameter via the Shuttle.

Note:  If the vales are set via XML (if Use values from XML file is selected in Manage Workflow
Parameter window), you cannot set or overrule values via Shuttle.
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1. Open the workflow or the child workflow where Workflow Parameters are defined.

2. Double-click on the Ticket or select Edit Parameters... via the right-click menu .

3. Select a SmartName-enabled field and click on []. Alternatively, use the shortcut Ctrl+Enter.
The SmartNames Dialog will pop up. It will contain Workflow Parameters as a Category.

 

 

4. Select the Workflow Parameters category. Choose the Workflow Parameter you want to use.

You can choose multiple parameters from the right hand side of the pop-up.

5. Click on Insert or double-click on the parameter to add to the Ticket.

6. Click OK.

Sample Workflow: Packaging
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Sample Workflow: Commercial Printing
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The Tasks: an Overview

Some of the tasks and tools are optional.

Add Ink Eaters

Ink Eater areas are the non-printed areas that are not part of the printing jobs. These can be left-overs that will be cut
off or the white spaces next to and in between one-ups. Ink Eater areas help to achieve a constant ink consumption
over the width of the plate. This makes it easier for press operators to set the ink keys, and results in a faster setup
time for the press.

Ink Eater areas helps to avoid excess ink buildup by stabilizing "peaks" and "lows" in the ink key histogram. This
prevents spilling of excess ink onto the printed zones of the printing jobs. You can flatten the ink key histogram by
filling non-printed zones with a gradient. A gradient(resolution) is used to avoid hard edges in the compensation
object. You can adjust the settings for minimum ink density and minimum ink key value. You can get warnings
when the maximum total area coverage (TAC) is too high depending on the settings of this task. These areas are then
compensated(filled with ink) depending on the strategy settings you give in the task.

 

 
Using this task you can :

• create Ink Eater areas or choose a predetermined Ink Eater area
• fill Ink Eater areas with predefined settings.

Select the Ink Eater tab to create ink eater area and to define settings for filling Ink Eater zones.

Ink Eater tab
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Ink Eaters Areas

You can choose predefined and named objects as Ink Eater by choosing Fill Named objects. This is useful when you
have defined the Ink Eater areas in another software such as Plato.

Create Ink Eater Areas

You can choose from four options in the Start from Station's field to create Ink Eater areas:

• Die Shape: when the Die Shape is pre-defined(for example in Plato) and when it can be used as edge for the Ink
Eater object.

• Trim Box: when the edge of the Ink Eater object is defined by the Trim Box of the one-up on the plate.
• Media Box: when the edge of the Ink Eater object is defined by the Media Box of the one-up on the plate. Media

Box is larger and it contains the Trim Box.
• Die Annotation: You can mark an object as a die in a software such as Plato. When you choose this option, these

objects will be used to define the edge of Ink Eater area.

You can restrict the creation of Ink Eater areas by choosing the shape as above. The selected shapes will be saved
as Ink Eater areas. To set the offset for the Ink Eater object in relation to the Die Shape or Trim Box, you can fill
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in the distance in the Keep Away field . You can exclude SmartMarks in the Ink Eater object by enabling Exclude
SmartMarks option.

Scan Ink Coverage

When you have selected a contour object or a group of contour objects for ink coverage, you can use the options
under Scan Ink Coverage for filling the Ink Eaters

• Scan: You can specify the area the scan has to cover by selecting either of the two choices. All Inside Sheet
(Sheet View) will scan within the sheet and will exclude objects that are outside the sheet. All Inside Plate (Sheet
View) option will scan all objects on the sheet and plate. If you have objects that extend or are outside the plate,
they are not included.

• Direction:You can specify the direction for ink coverage. Horizontal means that the ink zones are vertical on the
plate and the ink histogram is on the horizontal base of the document. The direction of the compensation gradient
in the ink eater area is horizontal.

• Resolution: This indicates the number of intermediate steps of the gradient to be used as compensation.

Note:

You can achieve global compensation by giving a low resolution value (e.g. 5 gradient steps). This gives
a very smooth compensation gradient along the length of the press. The ink histogram zones are very wide
with this setting.

You can achievevery local compensation by setting up a high resolution value (e.g. 60 gradient steps).
This results in a gradient with more banding.

Use Very Low for 5 steps, Low for 15 steps, Medium for 30 steps, High for 45 steps and Very High for 60 steps.

Compensation

You can choose the ink use strategy for filling the Ink Eater zones from the options given below.

• Economic : you can minimize the ink use by choosing this strategy to fill Ink Eater areas.
• Best performance: you can have the best performance in print by using the maximum ink to fill the Ink Eater

zones.
• Intermediate: you can optimize the ink use and to get medium performance, you can use this strategy.

You can specify the Ink key settings for filling the Ink Eater areas by defining the follwing settings.

• Minimum Ink DensityYou can set the minimum ink density of the ink separation in the ink eater area by
enabling this option and specifying the percentage.

• Minimum Inkkey Value: This indicates the minimum ink key value for the ink eater area. The ink density of the
gradient is adjusted to make sure the ink key value is higher than this settings.

• Maximum Total Area Coverage: You can enable the option and enter a maximum total area coverage (for
example, 270%) to display warnings in those areas of the histogram where the total ink coverage exceeds your
limits.

Inks tab

You can exclude inks such as Non-process, Opaque and Varnish inks by enabling these options in the Inks tab. You
can keep the original separations by enabling Keep similiar inks in their original separations

Add Marks To Imposition

Use this task to add mark definitions to impositions, plates or pages. This task can add marks at all these levels:

• page
• sheet
• section
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For example, you can add sluglines to include text at sheet level or page level and collating marks for the entire
section.

 

 

The added marks will be included while exporting the output using the Export Imposition to PDF file task or the
Export Imposition to JDF file task .

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

Use Add to compose the list of marks.

You can choose from the following mark definitions:

• Trim Mark: Info about adding a Trim mark in Adding Trim Marks on page ,
• Rectangle: Read about adding a rectangle mark in Adding Rectangle Marks on page 
• Text: Read about adding text marks such as collating marks in Adding Text Marks on page 
• Image: Info about adding an image mark in Topic title
• Bar Code

When you have selected the type of smart mark, a Properties dialog will open where you can define appropriate
settings.

Adding Trim Marks
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1. In Add marks to imposition task, click on Add.

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

The Add mark dialog will open up.
 

 

2. Click on the Trim Mark icon.
The Trim Mark window will open up.

3.

Click the trim marks button  located adjacent to the four courners around the page image to activate/
deactivate the individual marks.

Note:  This right hand side of the page image is pointing outwards.

4. Give a Namewhich will be displayed in the Add marks to Imposition task panel.

5. Enter Lengthand Weight of the individual trim mark.

6. Set  Offset which is the distance between the trim box of the page and the trim mark.

7. Choose Color for the marks. You can choose from:

• None : This is useful when enabling or disabling the trim marks using SmartNames.
• Registration: to choose all inks
• Darkest: choose this when you want a Color darker than Process Black.
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• Black or Darkest
• Knockout

Note:  When creep is applied, set trim marks will move depending on the creep settings of the individual
pages.

Adding Rectangle Marks

You can create Rectangle Marks at:

• page level
• sheet level
• section level.

Most of the settings of adding a rectangle mark is similiar as in Adding Text Marks on page .

In the rectangle smart option, you can specify the intensity for the chosen color of the mark and its background. This
is useful when building control strips using rectangles.

1. In Add marks to imposition task, click on Add.

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

The Add mark dialog will open up.

2. Click on Rectangle icon.
Rectangle Mark Properties window will open where you can specify the mark settings.

3. Specify the settings as in Adding Text Marks on page .

4. Specify an intensity for the Color and Background.

Adding Text Marks

You can create a text mark at:

• page level
• sheet level
• section level.
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1. In Add marks to imposition task, click on Add.

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

The Text Mark Properties dialog will open up.

2. Give a Namewhich will be displayed in the Add marks to Imposition task panel.

3. Give the specific content by:

• typing it in
• using SmartNames
• by browsing to the file with the intended text.

Use the InkNames SmartName in the content to identify the individual printing plates. The text mark will be set
for each plate and the SmartName will be replaced with the indiviual Ink name.

4. Select the level of the smart Mark. In the Attach to field, select from Sheet, Page or Section.

5. Select the Reference to your desired level. You can choose from

• Paper
• Plate
• Trim Box
• Bleed Box

The reference is the rectangle you will use as a reference to position your mark.

6. Set the Position tool to the precise location of the reference.

The Position tool allows you to snap the blue rectangle (your mark) relative to the inner gray rectangle ( your
reference rectangle).

7. Click on Size and Margins to define the size and margins of the text mark.

You can specify the final dimensions of the mark in this window. The resulting mark will be positioned and
rotated using the parameters from the Text Mark Properties dialog.
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a) Specify a height and width for the text mark. You can either choose Fixed and specify the dimenstions or
choose Fit to text.

b) Set the Clip on level to limit the boundaries of your mark. You can choose to clip the mark at Plate, Paper or
Mark levels.

c) Select the Margins. These are extra margins on top of the text box height and width.

Note:  These margins are taken into account for positioning the mark and are included when creating
background color.

d) Set Alignment to position the text within text box. relative positioning when the "InkName" smartname is
used and multiple text lines are set on top of each other.

The Size and Margins window will open up.

8. Choose the Orientation of the text and set the dimensions. Use the orientation mark to rotate your mark.

Specify a vertical and horizontal offset after positioning the mark relative to the reference rectangle.

9. If you have choosen Section in Step 4, you can use the text mark as a collating mark. Enable Use as collating
mark.

a) Click on Collating Properties.
The Collating Properties window will open.

b) Select the Pattern and Direction of the collating mark from the symbols given. Alternatively, use
SmartNames.

c) Specify the Offset which is the distance between two collating marks.
d) Specify the Step which is the height of the collating mark.

Note:  You can pick any mark except a trim mark to be used as collating mark.

Use the following settings for a standard collation mark.
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• Position: Place the top center of the mark attached to the top left of the Reference trimbox.
• Set -back as horizontal offset. Enter a hyphen (- and use SmartName Back from the SmartName category

Mark Information.
• Set aFixed height and width for your mark in the S
• ize and margins window.
• In the Collating Properties, use markheight" as the collating step.

• Use SmartName Markheight from the Mark Information category as Step
• Choose the saw tooth pattern.
• Select down as stepping direction

• Use vertical text Orientation.
• Select Registration as background color.
• Select Knockout as the mark color.

10. Select the Color which is the selection of the color for the text in the mark.

Note:  This value is ignored if you use the InkName Smartname in the Content field.

11. Select a Background Color which is the color of the rectangle within which the text mark is placed.
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Background color is the color of the rectangle surrounding your slug line, you can influence the dimensions of this
rectangle using the Size and Margins dialog.

Adding Image Marks

You can create image marks at:

• page level
• sheet level
• section level.

Most of the settings of adding a image mark are the same as in Adding Rectangle Marks on page .

1. In Add marks to imposition task, click on Add.

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

The Add mark dialog will open up.

2. Click on Image icon.
Image Marks Properties dialog will open up.

3. Specify the settings as in Adding Text Marks on page .

In the Image Marks Properties window, you can choose Mapped as a Color.

4. Specify an intensity for the Color and Background Color.

Adding Bar Code Marks

You can create Bar Code marks at:

• page level
• sheet level
• section level.

1. In Add marks to imposition task, click on Add.

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

The Add mark dialog will open up.

2. Click on Bar code icon.
Bar Code Marks Properties dialog will open up.

3. Specify most of the settings as in Adding Text Marks on page .

Note:  If you use Registration as the Color, the mark will appear in all the plates you have defined in the
plates viePlates View.

4. Click on Select Bar code. This will result in Select Bar Code window.
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5. Specify Bar Code Parameters.

• Bar Width Reduction: Use this option to compensate for the ink spreading on the press..
• Narrow Bar: Fill this in to change the default size of the bars.
• Magnification: Use this to make your barcode bigger or smaller than its default size.
• Add Bar Code Text: Select No to remove the text located below the bar code.

Note:  You cannot choose the Bar Code type. The default is Code-128

Add to Pages View

The Add to Imposition Gallery task brings IMP files from the Files View into the Pages View. This task will
especially be used in chained tickets or when working with hot folders.

The following workflows work in combination with the 'Add to Pages View' ticket.

On a PDF file:

• Copy or Move > Normalize PDF File > Add to Pages View
• Normalize PDF File > Add to Pages View
• Right-click the file in the Files View and select 'Add to Page Gallery' from the context menu.

On a PDFSC file:

• Copy or Move > Add to Pages View
• Right-click the file in the Files View and select 'Add to Page Gallery' from the context menu.

Note:

This task is only used in page workflows.

Add to Products

You can use this task to add/modify parameters for a Product or Product Part. However, you cannot delete product or
product part parameters using this task.

You can use the panel on top to select the item Product or Product Part..

Product

When you choose Product in the top panel, you can configure the settings in the three tabs.

• General : Here you can give the Product details. This tab is similiar to the General Tab in the Product Setup. Read
more about each field in this table.
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• Parameters: You can add Product Parameters in this tab. This is similiar to the Parameters Tab in the Product
Setup. Read more in Parameters Tab on page 84.

• Updating: When you are updating an existing Product with Product ID, Product Name etc, you can define the
rules here.

Product Setup :

• Update : if you want the existing Product Setup to be updated with the info from the task.
• Do not update
• Update and provide a warning
• Do not update and provide an error

Link Global Product to the Current Job: if you enable this the Product in the task will be linked to the current
Job context.

Product Part
Under the Product Part  selection, you have three tabs:
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• General : Use this tab to enter Product Part details. This tab is similiar to the General Tab in the Product Part
Setup. Read more about each field in thistable.

• Parameters: You can add Product Parameters in this tab. This is similiar to the Parameters Tab in the Product
Setup. Read more in Parameters Tab on page 86.

• Updating: When you are updating an existing Product Part, you can define the rules here.

You can set Part Setup depending on your requirement :

• Update if you want the existing Product Part Setup to be updated with the info from the task.
• Do not update
• Update and provide a warning
• Do not update and provide an error

Set File to:

• Update if you want to update the Product Part with the File added in the task.
• Do not update when the Product Part should not be updated with the File.
• Update and provide a warning

Please refer to Creating a Product with the Add to Products task for more information on how to us e the Add to
Products ticket.

Adjust PDF Screening

You can apply rule-based modifications of screening parameters using this task. This helps to limit the changes to
specific requirements. For example, you can set just one rule. However the task is flexible enough to let you make
a complex set of rules for changing the screening parameters. See the example screenshot below which has criteria
defined to change the screening parameters of a CMYK document (of corresponding separations).

You can preview the Separation Details when a file is selected. This will display the results for the specified set of
rules in the current file.

This task:

• limits the changes to what is needed. For example, when you only want to change the ruling for all separations.
• can use the criteria like inkbook, printing method or ink type. For example, you can set rule such as : when

printing method is "flexo"; set dotshape to "F".
• can use SmartNames. You can set SmartNames for screening parameter values and specify the condition

accordingly. For example, if the name is "Cyan" or "Magenta" or "Yellow" or "Black"; set dotshape to
[mydotshape] .
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• add complex and elaborate set of rules. For example, in the case of Object Based Screening, use a rule such as :
when name is "Cyan" and angle is between "0" and "45" ; set angle to 30 and dotshape to "R" 

Note:

The screening parameter DotShape does not exist in native PDF. Instead there is a SpotFunction Name,
which can have a limited number of values like SimpleDot, Ellipse, Square which are mapped to the Esko
DotShapes "C", "E", "S" respectively. Other SpotFunctionName values are mapped to "C".

The task Normalize AI/Illustrator/PDF File does not take account of the DotShapes (SpotFunction Name
Values) specified in Native PDF fIles. You need to adjust the PDF Screening parameters during or after
normalization.

1. In the task settings, click on Add. This will start a dialog where you can enter the rules for screening parameters.

 

 

2. Enter a Name  for the rule. For example, you can type in the same name as ink name.

3. Select Apply rule to all separations if the rule applies to all separations.

4. Select the the condition for the criterion under If separation matches. You can choose from Ink name, Ink
book, Ink type, Printing method, Ruling, Angle and Dot shape. Set the condition specific and give related text
in the field. If needed, add more criteria by clicking on +.
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5. Select and specify the Apply Separation settings as per the requirement. You can specify Rulingand /or Angle
and /orDotShape.

6. Click OK

7. Repeat steps 1-6 to add more rules.
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For each of the separations, the rules are accounted for in the set order. In the current example (see the
screenshot), when a separation (Cyan, 135lpi, 60deg, no Dotshape) is present in the document, the first rule is
considered. Since it complies with the set conditions, a new angle is set (45deg). In the remaining set of rules, only
the last one is relevant. According to the last rule, the task sets the dothape and the ruling. but does not modify the
already set angle.

If a file is selected, you can preview the applied rules under Separation Details. To be able to do this, enable
Preview.

8. Click OK  to save the task.

Apply ArtPro Action List
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In Automation Engine the Apply ArtPro Action List task automates tasks in ArtPro and converts Nexus workflows
into one or more Automation Engine workflows.

The Processor uses an ArtPro Action List to define the chain of actions which are to be executed. This file can be
created and edited by using the ArtPro Action List Editor. An Edit button in the Apply ArtPro Action List task
panel launches the ArtPro Action List Editor with the selected Action List.

Complicated NexusProcessor workflows with file dependencies and "Select File" activities are broken into a set of
processor tasks with relatively small Action Lists. These tasks are chained in Automation Engine using router, select
file etc. All Action Lists are placed in a custom folder on the server.
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The Processor window consists of a section in which users can choose ArtPro Action List items.

Click Using SmartNames radio button to define ArtPro Action List items using SmartNames (please see Using
SmartNames for more information about SmartNames).

Or click the Selecting Below and Customizing Parameters radio button and pick one from the list. Click the Edit
button to open the selected action list in the ArtPro Action List Editor.

Click the Refresh button to update the panel. This not only updates the list of Action List items but also updates the
parameters of the selected item. However, it does not change any parameter values.

Click the Refresh button while holding the Shift key to revert the parameter values in the panel to the values that
were saved in the Action List.

Using Automation Engine SmartNames in Apply Artpro Action List Task

This task has access to Automation Engine SmartNames linking to Artlink parameters in ArtPro files. Use
smartnames from the following categories:

• File Information
• Global ( custom created smartnames )
• Job Information
• Job barcodes
• Job parameters
• Miscellanous
• Path information
• Product information
• Product Parameters
• Product Part Parameters

Note:

• The Automation Engine SmartNames are resolved when you open the ArtPro file.
• You cannot use SmartNames for which a task is required to resolve the values ( for eg. TaskID ). Use

SmartNames based on the file location or file name.
• You cannot use a Workflow Parameter directly as an Artlink parameter.

Tip:  You can create a Global SmartName based on the Workflow parameter and link this as
Artlink Parameter Value. Read more in ArtPro User Guide.

• When an ArtPro file is saved in a Job and linked to a Job Parameter, the information is only kept within
that Job. When the same file is saved outside that Job, this Job Parameter info is lost.

• When a Global Product is linked to multiple Jobs and Job SmartNames are used, any of these values can
be stored in the file. The ArtPro Processor does not update the parameter to the current Job.

Apply Creep

Use this task to define compensation for 'creep'. When a publication is folded, the bulk of the paper causes the inner
pages to extend beyond the outer pages. Creep defines by how much the edges of each inserted spread or signature
extend beyond the edges of the one enclosing it.

When used correctly Apply creep task will ensure that the pages are correctly aligned after folding. This task works
for Perfect Bound as well as Saddle Stitched impositions.

• Set creep for each new Sheet in the case of Perfect Bound impositions.
• Apply creep across all sheets in the case of Saddle Stitched impositions.

You can apply either outer creep or inner creep depending on the bleed.
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• Use outer creep when there is enough bleed in the back of your pages. This will add bleed to the back of outer
pages.

• Use inner creep when there is not enough bleed in the back of your pages. This removes small strips from the back
of inner pages for proper alignment.

Creep is applied when exporting an Imposition or Plate to PDF or JDF using the Export Imposition to PDF file or
Export Imposition to JDF file

tasks.You can inspect the results of your Creep settings by using the "Open in Browser" function on an Imposition in
the pages view or a Plate in the plates view. 

Using the Task

1. Go to Plates View and select the Imposition. If you are selecting Pages, go to Pages View and select Page Slots.
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2. Specify a Creep Type. Choose from:

•
None 

•
Inner 

•
Outer 

Alternatively, choose the relevant SmartName.

Note:  You need to create SmartNames with values None, Inner and Outer .

You can create exceptions to the top level Creep Type for particular Sheets or Pages (like no creep) . To do that:

• Select the Page where you want exception to the general Creep Type.
• Right-click and start a new Apply Creep task.

Attention:  If you apply higher level creep after setting lower level creep settings made earlier will be
overruled. Therefore, first create the higher level creep and then apply exceptions to lower levels.

3. Set the Distance per page depending on the expected shift.

Note:  You can calculate it as Pi/2 times the thickness of the paper.

Note:  The distance values gets converted to mm. For example: '0.01 in' the ticket will be returned as
'0.254 mm'.

Archive Job

You can use this task to archive a whole job folder as a folder or as a ZIP file. You can use the Archive Job ticket
right after a Milestone is completed in a workflow to keep the job archived.
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1. Use the Output in field to define where to place the archive.

You can enter a file path, browse to a location or use SmartNames.

2. Define the File Name to give the archive file.

3. If you want your archive to be in the ZIP format, select Generate ZIP file.

Deselect it if you want to move the job folder to the location specified in Output in without zipping it.

4. Select Generate XML if you want to create an XML file containing basic job information (Job Name, Original
Job Folder, Order ID...). The example shows the standard XML output from this task.

Define where to place that XML file (you can leave the field empty to place it next to the archive).

Tip:  If you use an external database system to store your archives, you can search for archives using the
information contained in this XML file.

 

 

5. Select Apply XSL if you want to condition the XML file using an XSL format from an external archiving
solutions provider. The output XML will be modified according to the XSL requirements. The example here
shows the output XML after applying XSL format for Perennity archiving.

6. Select Keep Job and Job Folder if you want to keep the job folder in its original location in the Pilot.

Deselect this option if you want to delete the job folder once it is archived.

7. Click Launch.

Calculate Ink Key Settings (InkPlanner)

The InkPlanner ticket is used to create CIP3 files (mainly PPF), which contain all necessary data for the printing and
further processing of a job.

Note:  The InkPlanner ticket cannot be launched separately. It always needs to be chained to an Expose to
FlexRip ticket. It cannot be chained to Proof or Approval tickets.

Global settings

Select the Plate Setting File (*.ini), which contains specific information for the CIP3 generation, like image position,
rotation, compensation, etc.

Select the Press Configuration File (*.dat), which contains data about the press and the InkPlanner output.

Note:  You need to have created the Plates Setting and Press Configuration files with the CIPress Setup tool
before using this ticket.
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The name entered in the Output File Name will be used for making files created by InkPlanner. This InkPlanner
output will be stored in the 'output directory' specified in 'Press Configuration File' (*.dat).

Page Side: select Automatic, Front, or Back from the list.

Note:  The option selected here has priority over the page side option selected in the Plate Settings file.

Tip:  If an imposition file is processed, the page side option should be set as Automatic. The page side
settings typical of the imposition file will then be processed.

CIP3

Use the input fields provided to enter administrative data in the output file. This information will be useful when
further processing CIP3 files.

• Job Name: (required) If nothing is specified, the default job name will be used.
• Sheet Name: (optional)
• JobCode: (optional) is the code used for the job identification.
• Make: (optional) refers to the make of expose device.
• Artist: (optional) refers to the person who created the sheet.
• Customer: (optional) refers to the target customer.
• Software: (optional) refers to the software used to create the sheet.
• Paper Weight: (optional) the weight of the paper to be used.
• Paper Thickness: (optional) the thickness of the paper to be used.

Note:

If you do not enter anything in the input fields, the corresponding input fields in the CIP3 tab of the Plate
Settings tab in the CIPress Setup tool will be checked.

Anything that is entered in there will be taken into account.

Check Job Parameters

The 'Check Job Parameters' task makes sure that the Job parameters used in your file have the same settings as the
ones defined in the Inks and Parameters tabs of the Job Setup dialog box.

Select whether the task should finish with an error (Stop with Error), or whether Automation Engine should
automatically correct the settings (Auto Correct) when the bar code or ink parameters don't match. For Inks, you can
also select the option Auto Correct (Strict Checking): this will attempt to automatically correct the ink parameters,
but the task will finish with an error if it finds unexpected inks (i.e. inks that are in the file, but not defined in the Job
parameters) or missing inks (i.e. inks that are not in the file but are defined in the Job parameters).
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Suppose your Normalized PDF file includes an Esko bar code of type EAN-13 '123456789012'. One of the Job's
parameters state that barcodes of type EAN-13 should have the number '5449000050205'. The Check Job Parameters
task will then automatically correct the bar code number.

Note:

The check job parameters task will only check the barcodes created with job parameters in PackEdge. The
system will generate a warning for the bar codes that were not made with job parameters.

The Check Job Parameters task allows you to correct barcodes when the job specifications were altered after
the bar codes were created in the editor.

Note:

For the task to function properly, the file should be part of the Job.

Check Print Rules (PRC)



184 | Automation Engine | The Tasks: an Overview

Print Rule Checker inspects jobs, completely or partially, for potential printing problems and violations of standard
printing conventions. Insufficient line thickness, wrong halftone densities, the use of too many inks, and various
other production-related issues are brought up instantly. The PRC task will add the results of the checking pass to
the Normalized PDF file. The Normalized PDF file can be inspected in detail using the graphic editor. In the editor
the user will see a full report of the checking pass and has tools to quickly navigate to the parts of the job where rules
have been violated. Additionally, a report file with a list of all the errors that were found in the job can be generated.

 

 

The Print Rule Checker consists of one tab.

Select the PRC Ruleset from the dropdown list. You can choose a standard Ruleset, or you can use a customized one.
You can customize the PRCrules in the graphic editor.

PRC Report. Select the toggle to make sure the system generates a PRC report. Enter a name for the report and select
the place where you want the report to be stored. You can use SmartNames (please see Using SmartNames).

Decide what the state of the task will be when the rules are violated.

•
The task ends with a warning .

•
The task fails .

Check Product Parameters

Use Check Product Parameters task to make sure that the barcode and/or inks used in the input file have
correponding values to the inks and barcodes in the Product Setup.

Note:  The input file must be a Product Part for this task to function properly.
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For Barcode settings, you can select:

• Auto Correct when you want automatic correction of file settings when the barcode do not correspond to the
Product Setup barcodes.

For example, if your Normalized PDF includes an Esko barcode of type EAN-13 : '123456789012' and your
Product Part contains EAN-13 : '5449000050205', this task will automatically correct the barcode number in the
PDF file.

• Stop with Error when you want the task to finish with an error if the barcode in the Product Part Settings does
not match the barcode present in the file.

For Inks, you can select:

• Auto Correct (Strict Checking): when you want correction of the ink parameters and the ink order.
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If the Product Part ink settings do not correspond to the file inks or ink order, the task will auto-correct the file
settings.

In this setting, the task returns an error when an ink which is not specified in the Product Part Settings is present in
the file.

• Auto Correct when you want automatic correction of file ink settings.

In this setting, if the Product Part Ink Settings are different from the file Ink settings, the task will correct the file
ink settings.

• Stop with Error when you want the task to finish with an error if the inks specified in the Product Part settings
and the file are different.

Note:

• This task checks and autocorrect the barcodes created in  PackEdge and DeskPack. The task will
generate a warning on the barcodes made in other softwares. You can correct the barcodes even if the
Product specifications were altered after their creation .

• You cannot use this task to check and autocorrect the barcodes in Artpro generated Normalized PDFs.

Check Technical Inks

The Check Technical Inks task checks whether the input file (Normalized PDF, Plato File or PDF File) contains
technical objects in knockout.

When technical objects are in knockout, the task will fail or end with a warning according to the task settings.

Read more in Esko white paper Working with Technical Inks in Suite 12 assembly 3.

Compare PDF

Use this task to make a comparison between two PDF files. You can define what you want to compare and how you
want the comparison results to be viewed and saved.

Note:  You can use SmartNames in most fields of this dialog. For information on SmartNames, see Using
SmartNames

1. In the Compare with field, browse for the reference file with which you want to compare your PDF file.

2. Select the Compare Region or media box within which you want to make the comparison. This allows you to
restrict the comparison to the contents of one of the media boxes.

3. Set the Compare Resolution. This is the resolution you want to RIP the files to before comparing them.

This value should be between 50 and 300 ppi

4. Set the Noise Tolerance.

5. If necessary, add the separation(s) that should be ignored. E.g. for multilingual magazines you may want to ignore
the separation(s) that contain(s) text.

6. In the Output in field browse for the folder where you want to save the file containing the differences between the
two PDF files.

7. Select the Create Differences layer option to save the differences between the two files in a separate layer. Then
browse for a Layer file or make one automatically using SmartNames.

Note:  If pageboxes are different and/or separations do not match, the task will report a mismatch but it
will not create a difference layer.

8. Select the Report differences to file option to save the differences in a separate XML report. When files don’t
match, this report contains the coordinates of the mismatched pixels for each separation. Then browse for a report
file or make one automatically using SmartNames.
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Convert CMYK Colors

 

 

This task allows you to convert your file from one CMYK Profile to another.

Use Link Profile Link profiles describe a transformation from 1 device dependent color space to another. This is
actually a concatenation of a forward transformation of 1 profile and a backward transformation of another profile.
This means that all other options will be grayed out as the Link Profile takes complete care of the color management.

Source CMYK Profile Select the source CMYK Profile.

Destination CMYK Profile Select the source CMYK Profile

Render intent

• No Background: Use this option if you do not want any background simulation. The white point of the source will
be mapped on the white point of the destination process. This rendering intent takes into account the ability of the
human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped on white of
destination colorspace). Use this option if you don't care too much about an exact color match but you want the
pictures at least to look nice on your proofer. It will give a visually pleasing result. If the gamut of the source is
wider than the proofer, the entire gamut is shrunk so that it fits inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an exact color match,
including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent will map saturated
colors on saturated colors.
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Use the document profile as source profile if available If a document profile is defined, then that one will be used
as a source profile. The one chosen from the Source Profile dropdown list will be overruled. If no document profile is
present while processing, the default source profile will be used.

Convert CMYK Objects. Choose what objects need to be converted.

• Images and Linework (everything)
• Images only
• Linework only

Black

• Map black on black: All colors will be converted, but the conversion will treat the black separation separately. As
a result, the black separation will only slightly change (to compensate for possible differences in dot gain). Colors
that contain only black, will remain black-only. Use this setting if you want to convert a file from one color profile
to another, but you do not want to change the UCR/GCR level of the file.

• Keep Gray: Gray colors (colors that only have a certain percentage of black and no cyan, magenta or yellow) will
be kept unchanged. All colors that contain some cyan, magenta or yellow are converted according to the profile.
Use this setting if you want to use the UCR/GCR settings from the destination profile, but you would like to keep
black text and other gray objects untouched.

• Convert: black: All CMYK colors will be converted according to the destination profile. The output file will have
the black-generation and UCR/GCR settings from the destination profile. Because of this, the black separation can
possibly change a lot. Use this setting if you are using this task to change the UCR/GCR level of a file. Note that
black text might get converted into a rich composite black, depending on the destination profile.

Keep Registration Color In case you use marks in your file, and if you do not want them to be converted, then check
this toggle.

Flatten document Select to flatten the entire document. Objects may be flattened that should not have been resolved,
and in some occasions new CTs are generated during resolving. However, flattening may eliminate some unexpected
results in color conversions.

Convert IMP File to Normalized PDF

Use this task to convert your GRS impositions to Normalized PDF impositions.

This convert the GRS imposition’s template, marks and content to Normalized PDF, and adapts the imposition around
it.
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Overwrite existing files

This option determines what the task will do if it finds some of the imposition’s files (mark files for example) already
converted to Normalized PDF.

• Select the option to overwrite the existing Normalized PDF files with the new ones generated by the task.
• Leave it deselected to keep the existing Normalized PDF files.

Note:  The remaining options are similar to those of the Export to Normalized PDF File task (see Export to
Normalized PDF File).

Convert Selection
You can use this task in a workflow to automate file conversion. For example, you can convert some of the layers
from an Imposition from the Pages view to a PDF format for proofing before proceeding with the next task.

You can convert formats such as

• PDF
• Page
• Runlist
• Layer
• PageSlot
• Imposition
• Plate

into any of these output formats

• PDF
• Page
• Runlist
• Layer
• PageSlot
• Imposition
• Plate

This task is useful in a workflow when you need a certain file format to continue the flow.

You can choose the output format of the task in the Output Format field.
 

 

Copy or Move File

This task copies or moves the input file or marked files to a new location.

To mark a file, please insert the Mark File task in your task chain.

Check the box if you want the task to fail when the file to be copied or moved already exists in the output folder.
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You can also choose to not take over the Extension of the Input file in the Output file.

Tip:  The Copy or Move File task can also be launched on folders.

Create Design (DesignWizard)

Note:  This Task requires an PackEdge license.

This task is intended for the automatic generation of template-based designs with different content. The template is
made in PackEdge.

The objects that vary between the different versions are generated by SmartMarks.

DesignWizard will simply regenerate the SmartMarks using different data sets. These data sets can come as field in a
database (accessible from the Automation Engine server through ODBC) OR as fields in XML files.

Tip:  SmartName support for path to XML file makes it possible to create more generic tickets. For extra
information on DesignWizard please check our dedicated web page and downloads on http://www.esko.com/
web/site.aspx?p=461.

 

 
 

 

These labels vary in color, text and bar code. External references an also vary (images, logos). The task gets the
correct input from an XML file:
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Using SmartNames in a DesignWizard template

DesignWizard assumes the texts are available as either:

• fields in a database (accessible for the Automation Engine server through ODBC)
• fields in XML file(s)
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In the case of a live connection to a database, you need to define a set of SmartNames through the Automation Engine
Configure panel.

In the case of XML files, the XML file is expected to have a similar format as when saving a database query into an
XML file. This means the data can either be split over 1 file per instance (i.e. each XML file contains all the data for 1
flavor) or there can be multiple sets in 1 XML file.

Taking such an XML file, you can easily convert all the tags from this XML file into job parameters. This is done via
the  Load button in the Parameters tab of the Job Setup dialog:

 

 

Once this is done, all these job parameters are also available as SmartNames (inside this job).

As a result, building the templates is in this case similar to using global SmartNames (defined in the Automation
Engine Configure panel).

Create IMP File

The Create Imposition ticket makes it possible to create an imposition file simply by selecting an imposition
template.

The pages selected in the Files View will be automatically assigned to the template.

In the Pages View, the input will be a book to which you attach an imposition template.
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Settings
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• Select an Imposition Template you previously created in FastImpose. The pages will automatically be assigned
to that template.

An imposition file can also be used as a template. The pages assigned to that imposition will then be overwritten.
• Paper: you can either use the width / height from the template you selected, or specify an adapted paper size.
• Trim: you can either use the width / height from the pages, from the template, or specify an adapted trim size.
• Fill remaining pages with blanks: In case not enough pages have been selected to fill all pages of the template,

the empty pages at the end will be filled with blank pages if this option has been selected. The task will not shrink
the template.

• Extend Automatically: select this option to automatically generate extra sheets in the template if it doesn’t have
enough sheets for your imposition.

Note:

To do this, your template must have at least one master sheet, and no more than one exception sheet.

The task will generate the number of extra master sheets needed, and use the template’s exception sheet if
it fits the last sheet of your imposition better.

Possible Workflows

What follows is an overview of all possible situations that can occur when creating impositions.

Note:  You can start by selecting either a number of files, or an entire folder. In both cases, situations 1 to
3 can occur. As far as the incremental workflow is concerned (see below), only situation 1 can occur when
selecting a folder.

Possible situations (and their message in the log window):

1. If the number of pages selected equals the number of pages in the selected template, the task will be processed
correctly.

2. If fewer pages are selected than there are pages in the template, we call that a page 'underflow'.

• The task will end with a warning.

Log message: Page x in page list remains empty.Page underflow in AutoImpose: the template contains x
pages, x pages remain empty.

• The task will be processed correctly if the Fill remaining pages with blanks toggle is selected.

Log message: Page x in page list is made blank.Page underflow in AutoImpose: the template contains x pages,
x blanks are added.

3. If more pages are selected than there are pages in the template, we call that a page 'overflow'. Since the excess
pages are not clipped, the task will end with an warning.

Log message: Page overflow in AutoImpose: x excess pages, the template contains only x pages.

You can also opt to assign your pages in different steps. Do not forget to check the 'Fill page list incrementally'
toggle.

1. Select for example pages 1 & 4. The pages will be assigned to pages 1 & 4 of the template (and not to 1 & 2).

• The task will end with a warning if the 'Fill remaining pages with blanks' toggle has not been selected.

Log message: Page underflow in AutoImpose: the template contains 4 pages, 2 pages remain empty. Page 2 in
pagelist remains empty. Page 3 in pagelist remains empty.

• The task will be processed correctly if the 'Fill remaining pages with blanks' toggle has been selected.

Log message: Page underflow in AutoImpose: the template contains 4 pages, 2 blanks are added. Page 2 in the
pagelist is made blank. Page 3 in the pagelist is made blank.

2. Suppose you want to overwrite page 1 of an imposition called 1234. Select page 1 again in Pilot and launch with
the 1234.imp file as template.
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Log message: Adding file x to the page list. Page number 1 not free in template, overwritten by page (path),
placed on page 1.

Create Imposition from JDF Layout

You can import a complete imposition including layout and page assignments into the Pages and Plates view using
this task. This creates an IMP file from a JDF Layout file.

 

 

• Imposition Name: Here you can assign a name to the Imposition which will be visible in the Imposition Gallery.
• Page Root Path: You can specify the path to the pages referred in the JDF layout here.
• Mark Root Path: This path will be used as root to look for the marks reffered from the JDF Layout File.
• Apply Color Mappings: Enable this option when you want to use the same ink mapping scheme which is defined

in the JDF file.  This mapping can be viewed in Plates View.

Note:

• This option works only when the input JDF file contains a color mapping.
• The mapped inks will be visible in the Plates View after applying color mapping . However, the inks

in the referenced input PDF files will remain the same as before.
• When you enable Apply Color Mapping in the Export Imposition to PDF file ticket, the color

mapping from the Plates View will be exported to the output PDF file.

 

 

Create Imposition from RunList
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You can use this ticket in a workflow to create an Imposition from a RunList. This creates an IMP file from a RunList
file.

Settings

 

 

• Imposition Name: You can use this name to identify the Imposition in the Imposition Gallery
• Template: You can browse to your JDF layout file here.

Note:  You can use SmartNames like nPages, pageHeight and pageWidth to make the selection
of the Layout Template dependent on the RunList.

• Mark Root Path: You have to enter the path to the file with marks referred from the JDF layout.
• Fill remaining pages with blanks:You can enable this if you want to add blank pages when the layout contains

more pages than the RunList.
• Remove RunList: You can enable this if you want to remove the RunList after it is included in the Imposition.
• Extend Automatically: Enable this to expand the number of sheets in the template to accommodate for all pages

in the runlist.

• Assembly: Choose from : Saddle Stitch, Perfect Bound, Cut & Stack  and Automatic. You can use
SmartNames to select an Assembly provided your SmartNames are prepared using the localized assembly
name.

Attention:

• All sheets in the template should contain equal number of pages.
• If Assembly is set to Automatic , the template should contain a minimum of 2 sheets to establish

the numbering scheme. Numbering should be consistent across the template when there are more
sheets than 2.



198 | Automation Engine | The Tasks: an Overview

• If the imposition contains printgroups of multiple sheets, the renumbering will be at the printgroup
level as that is the logical foldable unit.

• If the runlist has layers, individual layers will be handled independantly while renumbering.
Similiarly, independant flats will be added.

• Optimize Sheet: When Extend Automatically  is enabled, you can select and optimize sheets. When this
option is set, the task removes the back side of the selected sheet and uses the front side for printing (Work &
Turn or Work & Tumble printing depending on your template numbering).

• Select from : First Sheet, Second Sheet, One but last Sheet and Last Sheet.

Note:  The works only when the assembly is Perfect Bound or Saddle stitched.

Note:  Use Optimize Sheetonly when the sheets are filled up to 50 percent or less.

You can view the results of this task in the Imposition Gallery.

 

 

Create Job

The Create Job task greatly simplifies the integration of Automation Engine with business systems that are typically
not JDF enabled.

It enables you to automatically create Jobs, and populate the Job Setup with order information, customer information
and generic parameters - through a simple XML file.

You can create those XML files using a MIS system, a dedicated application, or manually.

When running the Create Job task on your XML file (or on a PDF file with XMP metadata), it retrieves the job
parameters from the XML file / XMP metadata using a set of custom SmartNames or XPath expressions mapping
to XML file.

Note:  We recommend you ask an Esko consultant for help to analyse your XML files and create the
appropriate SmartNames.

See sample XML code in Create Job XML

Automating Job Creation with the Create Job Task
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1. Analyse the structure of your XML files / your PDFs' XMP metadata.

2. Create a custom XPath SmartName for each parameter you want to set using that XML information.

See Creating a SmartName on page .

Note:  This step is optional. You can type in Xpath  expressions directly into the Create Job settings.
These

3. Make a custom Create Job ticket using those SmartNames/ Xpath expressions.

See Create Job Settings on page .

4. Send XML files / PDF files with XMP metadata to Automation Engine and process them using this ticket.

Create Job XML

Note:  You can also run this task on an existing job, to update the job parameters.

Create Job Settings

Job Tab

You can use either the custom SmartNames or XPath expressions to extract the job details from the XML file.

 

 

• Order ID : For example, XPath://CreateJob/Job/OrderID
• Sub Order ID:
• Name
• Description
• Due Date
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• Project ID
• Category

Note:  You can also choose from categories you created in another Job Setup (see Job Tab on page
).

 

 
• Custom Field 1
• Custom Field 2

Note:  If you have defined your own custom fields(upto 6) in the Job Setup in Configure, you will see
them here instead of "Custom Field".

• Job folder

Note:  Here you can:

• use a custom SmartName to extract the job location from the input file,
• use the [Smart Job Location] default SmartName (to use the Smart Job Location defined in the

Configure tool),
• browse to the desired job location.

Customer Tab

Use the custom SmartNames/corresponding Xpath Expressions to extract the customer information related to the job:

 

 

• Customer ID

Note:  You can also click the Select button to choose a customer, or to add a new customer.

• Customer Name
• Customer Description

Note:  If you have chosen a Customer ID using the Select button, the Customer Name and Customer
Description will be filled in automatically (if they have been defined when creating the customer).
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• Customer's Job Reference

In Customer Service Representative, click the arrow to select the Automation Engine user who manages this
customer account.

The E-Mail address of the Automation Engine user you selected is automatically displayed. If it isn't, go to Tools >
Users, double-click the user and check if the e-mail address was entered.

You can also enter the e-mail address manually.

You can click the Contact... button to open a mail message with the e-mail address in the To field (if a mail client is
configured).

Inks Tab

Load Ink Information from an XML element : Enable this to specify the Element or XPath under which all ink
atributes are stored.
 

 

• Name : Name of the XML element. For instance, InkSpecifications
• XPath : Example: /CreateJob/Farben

Give the names of all ink attributes exactly as in the XML file in the following fields.
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• Ink Name
• Ink Type
• Ink Book
• Angle
• Ruling
• Dot Shape
• Printing Method

Parameters Tab

Use this tab to add custom parameters to your job.

1. Click the Add button.

The Add Job Parameter dialog opens.
 

 
2. Use your custom SmartNames to extract the Job Parameter Name and corresponding Job Parameter Value.

Click Add.

Bar Codes Tab

You can Add or Remove multiple Bar Codes in this area.

In the Add Bar Code window,
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• Fill in :

• Type : Choose from the drop-down list.
• Sub Type will be filled in according to the Type.

• Fill in the details using SmartNames or as XPath expressions which map to the XML file.

• Code : for example, XPath://CreateJob/Job/Barcode/Code .
• Composite Code
• Output Resolution
• Bar Width Reduction
• Device Compensation
• Narrow Bar
• Magnification
• Ratio

Template Tab

Select Use an existing job as a template if you want to create your job based on another job.

In Choose Job, use a SmartName to select the job to use, or click Select to choose it in the list of Automation Engine
jobs.

Then choose what to Include from the job used as a template into the new job:

• Files
• Folders
• Hot Folders
• Tickets
• Milestones
• Parameters
• Inks
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• Categories

Tip:  You can choose a template with a task / workflow attached, so that task / workflow will automatically
process the newly created job, using the new job context (the parameters from the XML).

Create Job XML
  
<?xml version="1.0" encoding="UTF-8" ?> 
- <CreateJob>
- <Job>
  <OrderID>123</OrderID> 
  <SubOrderID>456</SubOrderID> 
  <Name>TL_AE_S_CreateJobXMLExtension</Name> 
  <Description>This is a job to test the Create Job Task.</Description> 
  <DueDate>2015-06-01T08:00:00.00Z</DueDate> 
  <ProjectID>Project123</ProjectID> 
  <Category>Offset</Category> 
  <CustomField1>CustomField1</CustomField1> 
  <CustomField2>CustomField2</CustomField2> 
  <JobFolder>file://homer/gdm_container/CreateJob-Translated</JobFolder> 
- <Barcode>
  <Code>1234569874522</Code> 
  <Resolution>2400</Resolution> 
  <BarWitdhReduction>0.04183333</BarWitdhReduction> 
  <DeviceCompensation>1.080</DeviceCompensation> 
  <Magnification>0.994192</Magnification> 
  </Barcode>
  </Job>
- <Farben>
  <Farbe Farbbuch="Process" Farbtyp="Normal" Farbnamen="Cyan" Winkel="15"
 Lineatur="150" Punktform="CS4" Druckmethode="Offset" /> 
  <Farbe Farbbuch="Process" Farbtyp="Normal" Farbnamen="Magenta" Winkel="75"
 Lineatur="150" Punktform="CS4" Druckmethode="Offset" /> 
  <Farbe Farbbuch="Process" Farbtyp="Normal" Farbnamen="Yellow" Winkel="0"
 Lineatur="150" Punktform="CS4" Druckmethode="Offset" /> 
  <Farbe Farbbuch="Process" Farbtyp="Normal" Farbnamen="Black" Winkel="45"
 Lineatur="150" Punktform="CS4" Druckmethode="Offset" /> 
  <Farbe Farbbuch="PANTONE+ Solid Coated" Farbtyp="Normal" Farbnamen="PANTONE
 Warm Red C" Winkel="45" Lineatur="150" Punktform="R" Druckmethode="Offset" /
> 
  <Farbe Farbbuch="ClassicColors" Farbtyp="Opaque" Farbnamen="White"
 Winkel="45" Lineatur="120" Punktform="R" Druckmethode="Offset" /> 
  <Farbe Farbbuch="PANTONE+ Pastels & Neons Coated" Farbtyp="Transparent"
 Farbnamen="PANTONE 9284 C" Winkel="45" Lineatur="150" Punktform="R"
 Druckmethode="Letterpress" /> 
  <Farbe Farbbuch="Designer" Farbtyp="Technical" Farbnamen="Die" /> 
  </Farben>
- <Customer>
  <CustomerID>123456</CustomerID> 
  <CustomerName>Coca Cola Company</CustomerName> 
  <CustomerDescription>This is a description for Coca Cola</
CustomerDescription> 
  <CustomersJobReference>JobReference123</CustomersJobReference> 
  <CustomerServiceRepresentative>gdm</CustomerServiceRepresentative> 
  <Email>gdm@esko.com</Email> 
  </Customer>
- <Parameters>
- <JobParameter01>
  <Name>TrappingDistance</Name> 
  <Value>1</Value> 
  </JobParameter01>
- <JobParameter02>
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  <Name>NumberOfPages</Name> 
  <Value>36</Value> 
  </JobParameter02>
  </Parameters>
  </CreateJob>

Create or Modify WebCenter Project

With this task, you can create an Automation Engine job and a corresponding project in WebCenter at the same time,
which avoids double entries and duplication errors.

For example, select this ticket in the Advanced tab of the New Job dialog to launch the task and create a WebCenter
project automatically at job creation.

This can be triggered from an MIS system for even more automatization.

This task can:

• Send Automation Engine job parameters to WebCenter (the Order ID, the SubOrder ID, and any parameter
defined in the Parameters tab of the job setup).

Other parameters like barcode information, job inks, imposition parameters, etc. are not sent.
• Retrieve information from WebCenter (Project Template, Customer Company...) and add it to the WebCenter

project created (from Automation Engine).

To use this task successfully, you need:

• In Automation Engine:

• to be in / create a job (with at least an Order ID),
• the credentials of a WebCenter Project Manager.

• In WebCenter:

• a project template with attributes matching the Automation Engine job parameters (Order ID,
SubOrder ID, and any parameter defined in the Parameters tab of the job setup). The attributes will be filled
in with the content of the job parameters.

Note:

Make sure the WebCenter attributes have the correct type for your job parameter data.

For example, when passing on a date parameter, the corresponding WebCenter attribute should have
the Date and Time type. When passing on a numeric value, the WebCenter attribute should have a
numeric type (Float or Integer).

See the WebCenter documentation for more information about attributes.

Attention:  If the WebCenter attributes don't have the exact same name as the Automation Engine job
parameters, the job parameters will not be passed on.

• optionally, Customer Company and Customer Location information.

You can use SmartNames in every field of the ticket.

1. Choose in which WebCenter Site you want to create the project. The sites available are the ones defined in
Configure.

2. In the Site Logon area at the bottom, fill in your WebCenter User Name and Password.

You can choose to type in your password (which is then Encrypted) or to Use SmartNames that resolve into
your password.

Note:  The user you enter here must be a Project Manager in WebCenter to be able to create projects.
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3. Enter the Project Name and Project Description to give the new project.

Tip:  By using the [JobName] SmartName as Project Name you can map the jobs in Automation
Engine to the projects in WebCenter.

4. In Project Manager Username, enter the user name of the WebCenter Project Manager that will manage the
newly created project.

Note:

• This user must already exist in WebCenter.
• This can be the same user as the one you logged on with, or a different one.
• The user you logged on with must have at least as much visibility in WebCenter as the Project

Manager you enter here.

5.
Click the Refresh  buttons.

6. The Project Template, Customer Company, Customer Location and Project
Status fields should now contain a list of the WebCenter Project Templates /
Customer Companies / Customer Locations / Project Status visible to that Project

Manager.

Choose the Project Template, Customer Company, Customer Location and Project Status to continue.

Note:  Make sure you select the Project Template containing attributes matching the Automation Engine
job parameters!
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7. Click Launch.

Create PAF / JPG / XML (LinkEdge)

LinkEdge started as an interactive tool to link 2 sites both using PackEdge. This tool packed the Esko native data
(with all its references) and allowed to unpack it again at the receiving site.However, this is more than just 'Esko-
Zip'. The (un)Packing also communicates with the Esko editing kernel and resource folders like central or local font
folders. Automation Engine then started a background server version of this historical tool. It was logic to also add
extra file representation data like thumbnails and metadata (XMP-XML).

 

 

Pack/UnPack

Select Create Packed File to create a PAF file (a packed file) from a GRS file, Normalized PDF file, GRQ file, Plato
PLA file and the Plato Scope file.

Set the Pack/Unpack Options:

Select an action:

• Pack File, this creates a .PAF or a .PDFSC file
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• Unpack File

• You can include the Fonts
• Tick the Unpack in Local Directory toggle if you want to be sure that all elements of your packed file will be

unpacked in the same directory. Be it the default directory or the one you defined as output directory. If you
deselect this option, LinkEdge will try to restore the original file structure.

Suppose you have packed a Normalized PDF (D:/Jobs/2345 banana/2345_50ml.pdfsc) and it has one referenced
image (residing in a different folder: D:/Jobs/2345 banana/images/banana.eps ). If you were to unpack using the
Unpack in Local Directory option, the LinkEdge task would drop all files in the same directory. If you were to
Unpack without the option, then the LinkEdge task would put the CT in a CT folder.

• Use the Password toggle to protect the Packed file. You will be prompted to enter the password when you want to
unpack.

 

 

XML

The system is also able to generate an XML Report, which contains information about the file: CTs, inks, angles,
LPI, ...

XML Structure: choose between standard XMP and the Automation Engine version 1.2 (based on XMP, but
contains less information), and define the units.
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Note:  Detailed information on Esko XMP tags can be found on the technology pages on www.esko.com.

JPEG

Tick the Extract JPEG Preview toggle if you want a preview file. This is useful for archive systems that work with
thumbnails.

Set the various Image settings:

• Horizontal and Vertical resolution in dpi
• Set the width and height in pixels
• Choose a compression from the dropdown list
• Select the anti aliasing toggle (use the dropdown list to define the quality of the anti aliasing)
• Decide if you want the JPEG to contain data from outside your borders. Check 'Account for margins' to select the

margins of the job as the true boundary. Normally the borders of the job are taken as the true boundary of the job.
Sometimes however you may also want to convert everything that is situated within the margins too.

• Check the option 'Use varnish inks in output' if you want the inks which have the attribute 'varnish' in the input
file to be included in the JPEG file.

• Page range: choose between 'All pages' or enter a page number / range.
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Note:  Detailed information on Esko XMP tags can be found on the technology pages on www.esko.com.

Create PDF File from RunList

This task uses JDF RunLists to combine individual PDF (one-up) files into one multipage PDF file. You send the JDF
RunList to the task, and define where to find the individual PDFs.

You can create JDF RunLists using the Split Pages on page  task, or The RunList Editor on page .

The RunList contains the file names of the files to be joined, their joining order and their original location.

One Up Location: select how to define the location of the one-up PDFs:

• select Absolute Location if you want to use the location defined in the RunList,
• select External Folder if you want to specify the one-ups' location yourself.

This brings up the External Folder Location field, in which you can define the location by browsing to it,
entering a path or/and using SmartNames.



Automation Engine | The Tasks: an Overview | 211

Replace * in File Names By: If you created your RunList manually using the RunList Editor, you may have
wildcards (*) in the file names of the PDFs to be joined. For example, the file names in your RunList may look like
this: *_01.pdf, *_02.pdf, etc.

With the Replace * in File Names By parameter, you can define the part of the file name that the * matches.

Note:

The output PDF will be Normalized except if:

• at least one input file is not Normalized,
• at least two input files have different media or trim boxes.

The XMP information of the individual PDFs will be merged into the multipage PDF.

Create Report (ReportMaker)

Note:  This Task requires an PackEdge license.

The ReportMaker task is used to to automate the creation of design print cards (in French: fiche technique, in
German: Drueck Karten).

The idea is that you generate reports containing all kinds of information: job name, used inks, name of the operator,
an image of the job...

All this information is defined in a report template, then this template is used to generate a specific job. For more
information about templates, see ReportMaker Templates.

Settings
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Select a Report Template (you can browse to it or use SmartNames to define the path).

If you want your report to be a regular PDF instead of a Normalized PDF, select Export to PDF, and choose a Ticket
for the PDF export. For example, use this to make a report containing a 3D object (see Creating a Report Containing
a 3D Object).
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Example

This is an example of how a report may look when viewing it in Acrobat.

 

 

ReportMaker Templates

You need PackEdge 3.0 or higher to make a ReportMaker template.
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The ReportMaker Template - how the resulting print card will look - is a Normalized PDF which you can design
yourself.

You are placing an image of your input file before you even know what your input file will be (since it's a template
and should be generic), but PackEdge offers a solution.

Let's make a template that will give us this result:

 

 

1. The name of the Job
2. The date/time of the report
3. The operator who made the report
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4. An image of the job (possibly scaled to fit the report)

The name of the job, the date and time, the operator are all Text Marks that are placed in the file and they are resolved
when the ReportMaker task is executed.

In fact, you can place as many SmartMarks as you see fit.

Note:

SmartMarks used in a ReportMaker template can give you useful information:

• If you use ink-related SmartMarks, they will reflect the inks of the input job, not of the generated report.
• Ink coverage will give you the ink coverage of the unscaled version of the input job (the report may

contain a scaled version of the input job).

 

 

The image of the input file is a special kind of ImageMark.

1. Select a new Image Mark
2. Use Smart Text [taskinputfile] to define the name of your Image Mark.

taskinputfile is the one smart text that's able to define the Image Mark in such a way that it will place the input file
in the Report at the time of outputting.
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3. The Linework Editor will place the Image Mark, it will look like a square because at that time the editor has no

idea how big the input file will be.
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4. You can use Named Objects to further define the behavior of the Image Mark during output. You can make any
object a placeholder, in this example we'll make the white contour a placeholder
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Select the object you want to make a contour, select 'Placeholders...' from the Production Menu, add a new one
and give it a name (in this example: Job Window).

5. Now you can define the Image Mark according to the Placeholder. Choose On Placeholder from the Position
dropdown list. Choose the correct placeholder from the Placeholder dropdown list.
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You'll see that the editor places the Image Mark in the Placeholder.
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6. Bear in mind that the task inputfile Image Mark has the same functionality of any other SmartMark, it behaves the
same, it can defined in the same way, it can be scaled, the inks can be defined...

Viewports in ReportMaker

A ReportMaker report can show you several ‘viewports’ of a file. This is ideal to zoom in on smaller objects
(ingredient copy, small logos, bar codes...). It also proves to be very useful if the design contains only few graphic
objects, as could be the case for example on corrugated boxes.

When creating ReportMaker templates in PackEdge, you can specify a named object to attach the task input file to.
This task input file will make sure that the file will be pasted in the named object, which will act as a ‘window’.
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1. Select an object or draw a box and give it a name.
2. Select the named object and open the SmartMarks dialog box. Make sure that you add the new mark to the named

object.
3. Select the SmartMark type ‘Image Mark’ which allows to indicate that you want to place only a detail of the

[taskinputfile] (under ‘reportmaker’).

You can zoom in by taking the bounding box of the named object and applying the specified scale factor on this
bounding box. For example 'Scale to Fit' will calculate the scale factor without taking into account the size of the
input file but the size of the named object in the input file.

If the named object is a contour object, the contour object will be used as a clip mask on the input file. If the named
object is a different object (CT, group of objects…) a rectangular clip mask (with size equal to the bounding box of
the named object) will be applied.
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Creating a Report Containing a 3D Object

To create a report containing a 3D object, you need:

• a report template with image marks allowing 3D objects,
• a Normalized PDF file with a link to a CAD (.ard, .dae or .zae) file.

1. In PackEdge:

a) create a template,
b) add an image mark where you want your 3D object to be,
c) use the SmartNames button to use Smart Text for your image mark name,
d) in the Smart Text pop-up, choose ReportMaker then task inputfile in 3D,
e) save your template.

 



224 | Automation Engine | The Tasks: an Overview

 

2. In Automation Engine:

a) launch the Create Report (ReportMaker) task on your Normalized PDF with a linked CAD file,
b) in Report Template, browse to the 3D-enabled report you created in PackEdge,
c) select Export to PDF,
d) choose a Ticket for the PDF export.
e) click Launch.

You will get a report containing a 3D object corresponding to your CAD file.

You can open this report and view the 3D object on all computers running Adobe Reader 8.0.1 or later.

Create RunList

You can create RunList of a set of input files using this task. A RunList collects several PDF files sequentially to
make one final JDF runlist (e.g. for imposition). It contains the names of the files to be collected or joined, their
collecting / joining order and their original location. You can create a RunList from:

• imported JDF layout file
• imported JDF runlist
• one or more PDF files.

Note:  If you start from a JDF layout file, the layout part will be ignored.
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1. Give a suitable name in the RunList Name field. You can use SmartNames for this. You can see this name in the
Pages view.
 

 

Note:  The tiles are outputted as multipage PDFs. When starting from a multipage PDF, one (multipage)
PDF file will be generated for each page of the original file.

2. Enable Plate reuse between runs if you have language variants. This enables reuse of the image plates among the
language variants. This option will consider each input file as a separate variant, if the number of pages in these
files are equal.
 

 

You should use this in combination with the Variant Separation settings in Job Setup.
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This will produce a RunList with multiple layers. Plates will be reused for common images in these language
variants.
 

 
When you create an Impostion from a multilayer RunList, the system will take this into account when creating the
plates in the Plates view.

Create Sheet Report from IMP File

Use this task to output your imposition report as a PDF.

Note:  The report is created in FastImpose, when you make the imposition (you choose a report template).
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Report Units: You can choose to show the imposition’s dimensions in either millimeters or inches in the report.

Decimal Places: Choose how many decimal places you want in the dimensions.

The report below uses millimeters and 3 decimal places.

 

 

Create Tiles

Use this task to tile very big graphics (for example billboards) into smaller graphics to be printed. You can select the
size/number of the tiles, and allow for an overlap if necessary.
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You can send PDF (single page or multipage), TIFF, PSD or JPEG files to this task. Progressive JPEG compression is
not supported.

Note:  Input files don't need to be scaled at 100% as this task can compensate for downscaling.

1. Use the Output in and File Name parameters to define where to save the resulting tiles and with which name.

Note:  The tiles are output into multipage PDFs. When starting from a multipage PDF, one (multipage)
PDF file will be generated for each page of the original file.

2. Enter/choose the ink used for the cut path in the Cut path table (the drop-down list will contain all inks used in
the input file).

You can Add several inks (for example if you have customers from different countries using different ink names
like cut, découpe, taglio...) and Move them Up or Down the list. The order is important as the task will use
the first ink it finds in the list.

You can use SmartNames to retrieve ink names from the job setup.

Select Create cut path from trim box if no ink is found if you want to use the trim box to create a cut path when
a file doesn't contain any of the inks you specified.

The task will tile the graphic inside the cut path. The tiles created will have a cut path in the same ink as the input
file's cut path (if the cut path is created from the trim box, this will be the Cut ink.

3. If the input file is a downscaled version of your graphic, enter the Scale to use.

For example, enter 1000% to compensate a graphic that was downscaled to 10%.

4. Choose how to determine the number and size of the tiles:

• If the number of tiles is more important to you than their size, choose Fixed Number of Tiles and enter the

number of tiles you want vertically  and horizontally .
• If the tile size is the most important (for example you can only print a certain size), choose Fixed Tile Size and

enter the tiles' vertical  and horizontal  size.

Note:

• The last tiles might be smaller (depending on the tile size and the size of the original file).
• The graphic will be auto-rotated by 90 degrees in case a better fit is possible (to use less tiles).

• If you don't know the exact number or size of the tiles you want, but you can only print up to a certain size,
choose Maximum Tile Size and enter the maximum size.

The number and size of the tiles are calculated to have the least waste and the least tiles possible, within that
maximum size.

All tiles will have the same size (except when adding an overlap).

Note:  The graphic will be auto-rotated by 90 degrees in case a better fit is possible (to use less tiles).

5. If you want to print overlaps (for example if the tiles' edges are to be glued on top of each other), select Add
Overlap and define the Overlap distance.

Note:  The sequence of the tiles starts at the top left and goes snake-wise vertical .

Attention:  Adding overlaps increases the tiles size (of all tiles except the last ones). If using a Fixed Tile
Size or a Maximum Tile Size, you should take the overlap distance into account.

6. If the graphics in your files have a bleed outside the cut path, you can clip it away by entering the bleed distance
into Bleed Clipping Mask.
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7. If desired, you can add SmartMarks (that you created in i-cut Layout or PackEdge) to the tiles.

For example, you can add SmartMarks containing glueing instructions in the overlap zones. You can use
SmartNames to define SmartMarks.

Tip:  We recommend you define your SmartMarks in i-cut Layout, as it contains tiling-specific
SmartMarks fields (for adding tile numbers).

Create Wrapper File

The Create Wrapper File task creates a Normalized PDF that encapsulate a given image, for example a screened TIFF
copydot file. The Normalized PDF encapsulating the image can then be processed further via tasks that can handle
Normalized PDF data such as FlexRip tasks.
 

 

You can bind a set of stand-alone files containing bitmap or copydot data that contains ink separations of one image
using the the Separations  tab. The output file will be a normalized PDF document.
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The Create Wrapper File task supports the following file types:

• TIFF
• TIFF_IT
• PSD
• JPG
• BG_CT
• BG_LP
• BG_JS
• EPS
• DCS
• Copydot

Page Size tab
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Page size

The default page size is Job size. When Job size is selected, the page size found in the selected file will be taken
into account when importing. The Custom option allows you to enter page size values manually. The dropdown list
displays all possible options (for example Custom, A5, A3, Letter, Tabloid, Scanner Trim Size...). Click the arrow in
the dropdown list to switch between millimeters and inches.

Note:

All the Eskoscan scanners have a feature to indicate the trim size of the page when making a scan. Scanners
equipped with software release JPS9.0 build 99 or higher will write that information into the master DCS file.

When choosing the option 'Scanner Trim Size' in the 'Job Size' list, the borders of the resulting file will be
automatically positioned where intended. The placement of that Normalized PDF file in FastImpose or Plato
will not require any manual correction.

Offset: Enter the appropriate values to give the page a horizontal and/or vertical offset. When no offset is given,
the center of the image will be positioned on the center of the page. If the page is smaller than the image (width,
height, or both), then margins will be set that enclose the image completely.The size of the margins will not be fixed.
Margins indicate the differences between the image size and the user-defined page size.

Margins: Tick the margins toggle and define the margins' dimensions if you want to give the margins of the page
a fixed size (for example 3 mm for bleed). Click the arrow in the dropdown list to switch between millimeters and
inches.

Reader's Spread None of the file formats that can be wrapped into a Normalized PDF file have the notion of reader's
spread. It can be useful, for example when using the Normalized PDF files in FastImpose, to give an indication of
whether the file is a single page or a reader's spread.
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• Single Page forces the file as single page output.
• Reader's Spread forces the file into a reader's spread format. The file will be set as double pages.
• Auto checks the size of the image and when the image width equals or exceeds two times the selected page width,

the reader's spread option is set. Otherwise it is treated as a single page.

Page number: Select the correct page number from the Normalized PDF that you want to output.

Display images: This option allows you to change the Normalized PDF preview settings. Select None, Thumbnail or
Image from the dropdown list.

Inks tab

 

 

The Inks tab contains a fixed list of inks (default, cyan, magenta, yellow, and black) to which you can add other inks
manually.

Tip:

Choose the ink book you use most frequently in the Preferred Ink Book list. Doing so ensures that when
you type an ink name in the table, Automation Engine searches for the ink in your preferred ink book first.
For example, if you type the ink name "154" and your preferred ink book is set to Pantone Colors Uncoated,
Automation Engine will automatically suggest the ink PANTONE 154 Uncoated.

If an image contains definitions for its inks (for example a CMYK Tiff or a PhotoShop DCS2) and an ink of the
image matches an ink selected in the inks tab, then the angles, screen ruling, etc... in the Normalized PDF file will be
the ones from the inks tab. All inks in the image that do not match the selected ink in the inks tab will be processed
according to the values for angle, screen ruling and dotshape in the Default options.

For images that contain no ink definition:
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• If only one ink is selected in the inks tab, the Normalized PDF file generated will contain that specific ink with
angles, lpi and dotshape as specified in the inks tab.

• If multiple inks are selected and K is part of that selection, the Normalized PDF file generated will contain K with
angles, lpi and dotshape as defined in the inks tab.

• If multiple inks are selected and K is not part of that selection, then the Normalized PDF file generated will
contain the first ink from the list with angles, lpi and dotshape as defined in the inks tab.

• If no ink, or the wrong ink (which cannot be found in the Pantone or Designer book) is selected, then a
Normalized PDF file will be generated which contains K with default parameters.

• If the wrong ink is selected, together with the default ink, then a Normalized PDF file will be generated with
parameters from the default ink.

Overprint: Select the appropriate overprint from the dropdown list. Choose between Opaque and Darken.

Create XML File

This task generates XML files which can then be used in other softwares as input files. For example, all SmartNames
can be added as content of one XML file. This supports the optimization of the integration between Automation
Engine and an external system.

Settings

You can enter the XML code in the blank field.

Note:  Specify an XML declaration at the start to choose the file encoding. For example, type in <?xml
version="1.0" encoding="UTF-8"?>  for UTF-8 encoding.

The task can fill in specific variable information (for e.g. Job Category, Job Customer ID etc) from corresponding
SmartNames. Click on [ ] to access SmartNames from the line of code.
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• Replace reserved characters in SmartName values with XML entities: check this option if you want the task
to output reserved characters from SmartNames as XML entities. The reserved characters and corresponding
predefined XML entities are given below.

SmartName Characters XML Entities

" &amp;quot;

' &amp;apos;

& &amp;amp;

> &amp;gt;

< & amp;lt;

 
• Validate XML : Enable this to check the validity of the XML. If this option is on, the task will fail if the XML is

not valid. The validation checks the XML formatting and the XML tag endings.

Note:  This task does not check XML schemas such as XSD, DTD, etc.

Note:  The links to external DTDs may influence performance. For instance if a DTD URL points to a slow
web server, the performance will be affected. Preferably, remove such links from the XML file.

Delete File



236 | Automation Engine | The Tasks: an Overview

This task is mostly used at the end of a workflow ticket, where the original input may be deleted since the data have
already gotten 'so far' in the workflow.

Tip:  This task can also be combined with the wait task. For example: first wait 2 hours, then delete the
marked file.

Tip:  To delete Marked files, you can perform the following actions: Mark File + any other action + Select
File (in which you select the Marked files) + Delete File.

 

 

Enrich Black

This task automatically creates rich black (super-black) objects. A darker, deeper color is obtained by adding a layer
of overprinting objects covering all the pure black areas in a color of your choice. The task can also be used to enrich
other inks than process black.

In the example below 80% Cyan is added (as separate layer of overprinting objects) to all areas containing pure black,
resulting in an enriched black:

 

 

Two tabs:

• General
• Scan (identical to the Scan tab in the Trap - Prepare and Create Trap layer ticket).

General Tab
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Add Inks

A color containing up to four inks can be added to all colors containing an ink of your choice. Typically 80%C or
a more neutral combination of CMY such as 60%C 40%M 40%Y are used for rich black generation. Alternatively
PANTONE ink names may be entered in these input fields. When the percentage next to an ink name is set to 0%, the
ink will not be used.

Choke Distance

Defines the distance between the edge of the area in the defined color and the edge of the original (black) object.
If this distance is not zero, the generated area in the defined color will be smaller than the original (black) area to
prevent registration errors on the press.

Corners

This option allows you to change the way sharp corners in the trap areas will be handled.

•
Mitered:  If the distance from the base of the trap to the corner point is larger than the miter ratio multiplied
by the trap distance then the corner will be beveled, otherwise it will remain sharp. See also miter ratio option.
(default)

•
Round:  A round cap will be placed at all corners.

•
Beveled: 
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Miter Ratio

Determines when a sharp corner is beveled. If the Distance from the base of the trap to the corner point is larger than
the miter ratio multiplied by the trap distance then the corner will be beveled, otherwise it will remain sharp. This
option is only available when mitered corners are selected (default value 2).

To Ink

Specifies the ink to which the selected color will be added. This ink is typically Process Black. An alternative process
or PANTONE ink name may be entered in this input field, to enrich colors containing that specific ink.

Minimal Density

Specifies the minimum percentage of 'To Ink' needed in an area before the specified color will be added to that area.
The default percentage is 100%, which means that the selected color will be added to areas containing 100% of the
'To Ink'.

Export ArtPro to Normalized PDF File

The Export ArtPro to Normalized PDF File can generate a normalized PDF file based on an ArtPro file.
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Preferred ink book Select the ink book.

Embed all images Embeds all images referenced in the ArtPro document in the PDF file.

Add non-prinable layers

If switched on, layers set to non printing are exported into the PDF file. With this option off, these layers are not
output, so the PDF file contains only layers with the Print option on.

Output Fully Transparent Objects
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Without this option, fully transparent objects are ignored. With this option on, transparent objects are output.

Folder Mapping:

When the ArtPro file contains links to images that reside on a Mac OS-based file server, you can mount the drive
of the Mac OS server on the Automation Engine server and use the Folder Mapping feature in the Export ArtPro to
Normalized PDF task to keep the references to the images working in the normalized PDF.

To map folders from the ArtPro file to the Normalized PDF file:

1. Click Add.
2. In the Client column, type the drive name on the Mac OS system.
3. In the Server column, type the drive letter that is used to mount the Mac OS drive on the Automation Engine

server.

For example, in our ArtPro file, the path of an externally linked image is: Intel_Mac:images:image1.

We mount the Intel_Mac drive of the Mac OS file server on our Windows-based Automation Engine system, using
the G:\ drive letter.

To allow Automation Engine to automatically locate the images on the Mac OS file server when exporting the ArtPro
file, we use the Folder Mapping feature to map "Intel_Mac" to "G:/".

Export IMP File to GRI File

In the unlikely event that some editing is required, the Export Imposition to GRI File task can generate a .gri file that
can be opened in PackEdge.

Sheets
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Print Mode

• Select the Press Sheet button to create a .gri file and select the appropriate radio button in the Output Area field to
specify the output format.

• Select One Up to create output of a user-definable size, containing one page per output page.
• Select Spread to create output of a user-definable size, containing a printer's spread per output page.

Front/Back

This is only available when Press Sheet is selected. Select the appropriate option to indicate which side of the sheets
you want to expose: Front, Back, Both or Both, but reversed.

Output Files

You can choose how many output files to generate.

When Press Sheet is selected, you can generate:

• One (output file) per Press Sheet Side,
• One per Press Sheet,
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• All Press Sheets in one file.

You can also choose to Reverse Sheet order to generate the sheets in reverse order.

When either One Up or Spread is selected, you can generate:

• One (output file) per Proof Sheet Side,
• One per Proof Sheet,
• One per Section,
• One per Booklet,
• One per Book.

Sheets

This is only available when Press sheet is selected. Select the sheets you want to expose by checking the appropriate
boxes. If you want to select all sheets, check the file.

Layers

• Check the Trimboxes box to expose the trimboxes layer, so that you will be able to see where the sheets will be
trimmed.

• Check the Marks box to expose the layer containing all marks.
• Check the Pages box to expose the layer containing the pages.

Output Area

• All outputs all elements, even those that are situated outside the plate.
• Plate outputs all elements within the plate format.
• Paper outputs all elements within the paper format.
• Zones outputs all elements within the signature format.

Area growth: enter a positive or negative value in the input box to enlarge or reduce the output area formats
mentioned above. Select the appropriate unit from the dropdown list.

Pages

This is only available when One Up or Spread is selected.

• Check the All toggle to select all pages.
• Enter the correct Range of pages.

• All pages in range prints only the pages indicated.
• Include front and back prints the selected pages and the corresponding front and back sides.

Paper

This is only available when One Up or Spread is selected.

Specify the appropriate paper width and height. When nothing is entered, the size of the file is used when sent to an
output device.

Other Settings

When a one-up is selected, you can enter a BackBleed value to be able to check the bleed in the spine of the book for
one-up proofs.

Checking the Show ImposeProof numbers box puts a page number on the recto side of the page.

Check the Skip administrative cover box if you do not want to have a cover printed, containing administrative
information about the job.
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Checking the Optimize for OutRight toggle makes sure that all pages are incorporated in the file.

Note:  All data that is outside the clipping masks will be clipped before being processed. This results in better
performance and smaller files.

Mockup

Check the elements you want to be visible on output and select the appropriate mockup color from the dropdown list
to enhance visibility.

 

 

Tiling

If the job is too big to fit the selected paper/plate size, it may be interesting to opt for a tiled output. The job will then
be exported to a series of smaller pages/plates (tiles).

Select No tiling if no tiled output is required.

Deselect all toggles to obtain a tiled output, omitting tiles that contain only marks. To include these kind of tiles,
select Allow mark-only tiles. Enter width and height of the tiles, and a certain amount of overlap.
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Export IMP File to JDF Layout

The JDF Export task converts IMP files to JDF files, referring to PDF pages.

This task combines elements of the Export to PDF File tasks and the Export Imposition to GRI File task.

JDF version: JDF 1.2 or JDF 1.3

Pages format: PDF or Normalized File. If you select 'Normalized File' all PDF related tabs will be greyed out.
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This task consists of six tabs:

• The Output tab is identical to the Output tab of the Export to PDF File task.
• The Rasterize tab is identical to the Rasterize tab of the Export to PDF File task.
• The Compression tab is identical to the Compression tab of the Export to PDF File task.
• The Advanced tab is identical to the Advanced tab of the Export to PostScript task.
• The Sheets tab is identical to the Sheets tab of the Export Imposition to GRI task.
• The Mockup tab is identical to the Mockup tab of the Export Imposition to GRI task.
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Export IMP File to JDF Post-Press

The Export to JDF PostPress task creates JDF for cutting and saddlestitching, starting from an imposition file. The
resulting JDF file will be interpreted directly by cutting machines (like for example Wohlenberg or POLAR-Mohr)
and binding machines (like for example the Muller Martini Amrys SaddleStitcher or Heidelberg StitchMaster).The
JDF capabilities of finishing equipment vary significantly depending on the supplier and the machine model. Contact
your supplier for more information.

The aim is to output in JDF all information that can be extracted from prepress and that serves to optimize the
production workflow downstream.

JDF Version: Select whether you want to generate a JDF version 1.2 or 1.3 file.

Export JDF: Indicate what data should be included in the JDF file: cutting, saddlestitching or both.

Maximum Trim: If the distance between the edge of the paper and the cut line is smaller than or equals the trim
indicated then no cutting will take place.

Cutting

The JDF file generated by the task contains a set of Cut Blocks that the cutting machine needs to cut out of a sheet of
paper.
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Sheets: allows you to indicate which sheets must be exported.

Sheet Lay: determines how the paper is placed in the feeder.You should indicate the reference edge of the paper
relative to the front side of the sheet as seen in FastImpose.
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• Automatic: determines the Sheet Lay by looking at the location of the Side Guide mark. If there is exactly one
side guide mark found its location is used. When there is no Side Guide or more than one Side Guide, the Sheet
Lay cannot automatically be determined, and consequently an error will be generated.

• Not Automatic: allows the user to select one of the four corners of the paper as Sheet Lay.

Cut Blocks: indicate where the cutting machine will have to cut, on the finished page size of each cell of the
signature or on the unfinished signature.Cutting on the finished page size of each signature cell is useful when
individual elements are combined as flat work, for example postcards or posters.

Print: indicate which side will be printed first, front or back.

Saddlestitching

The JDF file generated by the task contains the number of signatures that need to be bound, their size, overfold and
number of pages. It also contains information for stitching and trimming.
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Saddlestitch

• Staple Shape: Crown, Overlap, Butted, ClinchOut, Eyelet
• Stitch Width



250 | Automation Engine | The Tasks: an Overview

• Wire Gauge
• Wire Brand
• The Position boxes allow you to indicate the positions of the stiches.Positions are measured starting from the

trimmed side of the Registered Jog Edge. Stitches will be centered on these positions.

Registered Jog Edge

The Jog Edge is the reference edge of the folded signatures. This is the side that is used to align the different
signatures to.

• Automatic: the smallest of the FastImpose Head and Foot is used as Jog Edge.

When the head and foot trims are equal, the FastImpose head is used as Jog Edge.
• FastImpose Head
• FastImpose Foot

Export IMP File to PDF File

This task combines elements of the Export to PDF File task and the Export Imposition to GRI File task.

See Export to PDF File and Export IMP File to GRI File.

Export IMP File to PDF File Chain

This task chain ticket consists of the Export IMP File to PDF File on page  ticket, linked to the Mark as Proof
on page  ticket. The result of the action is a PDF file that can be checked in the Proofs View.

Note:  This task is used only in page workflows.

 

 

Depending on where the output file name is specified, in the PDF step or in the Proof step, a different naming
mechanism for the Proof Sets is triggered.
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PDF step

 

 

When a task is launched from the Pages or Plates View, the default proof file name is proof_[File].

Mark as Proof step

 

 

The default proof set name is: Output file name. extension.

Use SmartMarks to build up the name or enter it manually.

In the Details pane you'll see the original name of the file, including extra information on trimboxes, side, etc.

Export IMP File to PostScript File

This task combines elements of the Export to PostScript File task and the Export Imposition to GRI File task.

Export Imposition to JDF Layout

Using this task, you can export Imposition, RunList, Layer, Plate and Page to JDF Layout and JDF Runlist format.
This task will send an Imposition or a part of an Imposition to a workflow that requires JDF Layout as input. The
JDF Layout contains a JDF RunList which you can use in the Join Pages task to produce a multipage PDF book for
getting approval.
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Apply Color Mapping: You can enable this to export the layout file with the same color mapping as defined in the
Plates view.

Check page status: You can use this option to check if the approval status of the pages is compliant with the Job
setup settings. The task will fail if it is not compliant.

Export Imposition to PDF File
This task exports Imposition, RunList, Layer, Plate and Page formats to PDF format.

Number of Flats per File: You can use this option to specify how you want to split the output file. One sheet side of
an Imposition is considered as a Flat.

• If you enter 0 , the output will be one multipage file.
• If you enter 1 , the output will be two PDF files containing front(recto) and back(verso) sides separately. For each

sheet in the Imposition, there will be two PDF files like this.
• If you enter 2 , the output will contain front(recto) and back(verso) side together in one PDF file with two pages.

This will bethe outcome for each sheet in the Imposition .

Page Label: The page labels as they will appear in the output file(s).

Note:  You can make use of SmartNames from the categories Page Information and Plate Information
here.

Apply Color Mapping: You can enable this to export the layout file with the same color mapping as defined in the
Plates view.

Check page status: You can use this option to check if the approval status of the pages is compliant with the Job
setup settings. The task will fail if it is not compliant.

Export Nested Layouts
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Use this task to  create production files (a PDF  print file and a cutting file) for digital printing and finishing. The
input file is a PDFPLA file generated by the nesting process of the Gang Run. Read more about Gang Run in Gang
Run Printing View on page 

Note:

In a workflow, this task has four output pins (Print Files, Cutting Files, Done Graphics and Error), so you
can send each type of file to the right place more easily.

If you select Create report, the task will have a 5th output pin for the report.

Read more in:

• Sheet Tab on page 
• Production Files Tab on page 
• Reports Tab on page 

Sheet Tab

• If desired, you can add SmartMarks (that you have already created ) to your sheet.
• Specify how to center the lay out in Center Layout on Sheet as :

• Horizontally.
• Vertically
• Horizontally and vertically
• No

• Fit Sheet to :
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You can fit the sheet size to the size of the nesting (you can fit either the Sheet Height, the Sheet Width or the
Width & Height).

For example, for roll-fed printing, the sheet height will typically be the height of the roll, and the width will be
fitted to the size of the nesting.

You can also set No for this option.
• If printing Front and Back, define how the sheet will be turned for back printing in Backing Up: either Work-

and-Turn or Work-and-Tumble.

Production Files Tab

The task will output:

• PDF print files
• cutting files (in your desired format)

Content-Reference to:

• In Save Print Files, select how to output the PDF print files:

• as Single Files to have one single page PDF file per layout,
• as 1 Multipage File to have one multipage PDF file containing all the layouts.

Attention:  If the dimensions of the different layouts vary (for example when using substrate-based
nesting or the Fit option), the task cannot create a multipage output.

Note:

If multiple copies of the same layout need to be printed:

• For single page output, the number of copies will be part of the PDF file name.
• For multipage PDF output (and if the number of copies per page is less than 10), the same page will be

inserted multiple times, using forms to prevent the file size from growing.
• In Save Cutting Files, choose the cutting file format you want to generate (i-cut, HPGL, PDF, MFG or ACM).

Note:  When generating an ACM file (for a Kongsberg table), you can select Print Side Up, to cut with
the print side visible.

Tip:

• If you have several cutting tables and you don't know yet which one you will use to cut the sheet,
you can generate several file formats: choose Select File Types..., select all the file types you want to
generate and click OK.

• If you want to check your cutting files for quality control, you can also output a PDF file and inspect it
in Acrobat.

• If desired, you can Add Extra Structural Inks (for fold lines for example) that will be added to the cutting file
and excluded from the print file.

Tip:  Use commas to separate the list. You can use wildcards (*).

• In Output Name, enter the base name to use for the output files.

For example, if you enter Promotional_Coasters, the first layout will be called
Promotional_Coasters_1.pdf, the second Promotional_Coasters_2.pdf, etc.

If you don't enter anything, the name of the first input file will be used.
• Define where to save the production files, the report(s) and the XML file(s) referencing any non-nested graphics:

• If you want to save all output files in the same folder, select Save all files in the same folder, and browse to
that Output Folder.
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• Otherwise, make sure Save all files in the same folder isn't selected, and browse to your chosen folder for
the Print Files, Cutting Files, Report Files and Remaining Files (XML file(s) referencing any non-nested
graphics).

Reports Tab

If you want, you can create a nesting report (for example to use as feedback for a MIS system).

Select Create report per graphic if you want a report detailing in which layout(s) each graphic is nested.

Select Create layout XML report if you want a XML report detailing the different graphics used in each layout.

Select Create layout PDF report if you want a PDF report detailing the different graphics used in each layout.

Export Step and Repeat to JDF Layout

This task makes it possible to export a JDF Layout file. Stations, masks and marks are exported to PDF 1.5 files. A
JDF file containing references to all these files will be generated. You can select whether you want to generate a JDF
version 1.2 or 1.3 file.

When selecting the 'Create MIME file' toggle, the JDF and the referenced PDF files are put together in a MIME
packed file.

 

 

Export to 3D

This task produces 3D output files which you can view in 3D viewers. 3D viewing helps in

• Quality control
• Better viewing of directions, positioning and visibility of the elements
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With this task, you can export a Normalized PDF or PDFSTA (Station file) with a linked structural design (CAD)
file into a 3D file. The task accepts multiple input files with support to define one scene . For example, you can give
multiple input files belonging to one Scene which you can load in the task separately.

• two input PDFs containting the same structural design
• one input PDF with three pages referring to one part of a scene
• three input single page PDFs referring to one part of a scene

This task can create output in the following formats:

• 3D Collada file : this can be uploaded to WebCenter and viewed in the integrated 3D Viewer.
• Tiff image
• PDF with 3D Design: view this as 3D in Adobe Reader or Acrobat Professional (version 8.0.1 or later).
• U3D : it is a common exchange format for 3D objects. In Acrobat Professional 8.0.1 or higher you can place U3D

files in PDF files.

Attention:  Your input file must have a linked CAD file or the task will fail.

About Structural Design Files

A structural design file (2D and 3D) contains all the cut and crease lines for a specific type of package. A structural
design file may also contain folding angles that define how the package is to be folded into its final shape. The
structural design file does not contain the graphics, only the structural lines.

To bring the structural design and the graphic design together, a structural design file can be placed or opened in
either:

• Adobe Illustrator using the Esko Data Exchange plug-ins,

Note:  You can get the Data Exchange plug-ins for free at http://www.esko.com/.

• ArtPro,
• PackEdge.

Supported structural design file formats:

• ArtiosCAD or Studio Toolkit for Boxes (.ard files) for boxes
• Score! (.vlm or .scb files) for boxes
• Studio Toolkit for Flexibles (.bag files)
• Collada files with a printable part (.dae or .zae files)

A printable part is an Esko extension to the Collada format. Collada files with one or more printable parts can be
created in Studio Designer, Studio Toolkit for Shrink Sleeves, Studio Toolkit for Labels and ArtiosCAD.

 

http://www.esko.com/
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Export to 3D Settings
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This task will work of multiple file belonging to a Scene.

Note:  You can create a Scene using Esko ArtiosCAD. The Scene will contain links to multiple .ARD files
which contains Structural Designs. For example
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Exporting to Collada

Choose Collada File to export the 3D design to a Collada file.

Specify the Resolution of the image.

Define the View Angle from which the package should be rendered. You can either inherit the angle from the file
(using the view angle the file was saved with in Illustrator, Studio or PackEdge), or specify it manually by entering
the angles numerically.

Adapt the Perspective. A high value has the effect of a camera with a wide angle lens, close to the object. A low
value has the effect of a camera with a zoom lens, further away from the object. The default perspective is 45 degrees.

Note:  The object will always fit completely inside the exported image.

Choose a Background Color: White, Black or Transparent. For example, choose a transparent background if you
want to use the file for a product placement.

Exporting to TIFF

Choose Tiff Image to export the 3D design to an RGB TIFF image.

You can define the Width / Height of the image that you want to export. The TIFF image will always be square and
will contain the whole package.

You can also specify the Resolution of the image.

You also need to specify the View Angle from which the package should be rendered. You can either inherit the
angle from the file (using the view angle the file was saved with in Illustrator, Studio or PackEdge), or specify it
manually by entering the angles numerically.

You can also change the Perspective. A high value has the effect of a camera with a wide angle lens, close to the
object. A low value has the effect of a camera with a zoom lens, further away from the object. The default perspective
is 45 degrees.

Note:  The object will always fit completely inside the exported image.

Choose a Background Color: White, Black or Transparent. For example, choose a transparent background if you
want to use the file for a product placement.

Exporting to PDF with 3D Design

Choose PDF File with 3D Design as File Type.

You can define the Width, Height and Resolution of the PDF file.

The Show Footer toggle allows you to switch the Footer Text on or off. Instead of the default Esko text you can
personalize the footer text to include your own message. You can also use SmartNames.

As when exporting to TIFF, you can use the View Angle saved in the file or enter it manually, and change the
Perspective.

You can choose a White or Black Background Color.

Exporting to U3D File

Choose U3D File as File Type.

You can set the U3D file’s Resolution, View Angle and Perspective.

You can choose a White or Black Background Color.
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Using Prepare Station with Export to 3D

You can chain the Prepare Station and the Export to 3D tasks, or link them in a workflow, to get both a one-up file
for your Step and Repeat, and a 3D preview of the final result (box, bag, can or bottle).

• As input, you need your design in Normalized PDF format (you can export Normalized PDF from Illustrator using
the DeskPack plug-ins), with a link to your CAD file (see Export to 3D for a list of supported CAD files).

• As output, you will get a PDFSTA one-up, collada (ZAE) and a 3D file in TIFF, PDF or U3D format.

For more information, see Prepare Station and Export to 3D Settings.

Export to ArtPro File

This task allows you to export a Normalized PDF file to the ArtPro file format.

Version: you can export your file as:

• an ArtPro 10.x/9.x/8.x file,
• an ArtPro 7.5/7.0 file.

ArtPro 7.5/7.0 files do not contain version-specific information or blend modes (the file will be flattened).

Copy linked files next to output file: select this to copy the linked images next to the ArtPro file created.



Automation Engine | The Tasks: an Overview | 261

Export to EPS / DCS File

The EPS Export ticket has five tabs:

• Output
• Color Management is the same as the Color Management tab of the PostScript Export task.
• Rasterize is the same as the Rasterize tab of the PostScript Export task.
• Compression is the same as the Compression tab of the PostScript Export task.
• Advanced is the same as the Advanced tab of the PostScript Export task.

Note:  The names of multiple DCS files consist of the name of the original EPS DCS file followed by
_C, _M, _Y, _K (for process ink plates) or _1, _2, _3, ... (for all other kinds of inks). The files have .x as
extension.

Output

 

 

PostScript version: choose between PostScript 3 or PostScript level 2.

Output type: choose between an EPS, a Single DCS and a Multiple DCS file.

EPS: This will create an EPS file with an RGB preview. When the selected PostScript version is PostScript 3 and
the color management toggle in the Processing Tab is switched off, this will be a deviceN EPS, in all other cases a
CMYK composite EPS will be created.
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Single DCS file: This will create one EPS DCS file containing multiple separations. The DCS file always contains an
RGB preview used when placing the EPS DCS file. In addition a composite grayscale or color CMYK preview may
be added used for composite printing.

Multiple DCS file: This will create a master EPS DCS file referring to multiple separations (one file per ink). The
names of these files consist of the output filename followed by the name of the ink. The master DCS file always
contains an RGB preview used when placing the EPS DCS file. In addition a composite grayscale or color CMYK
preview may be added used for composite printing.

• EPS
• Single DCS file, no composite
• Single DCS file, grayscale composite
• Single DCS file, color composite
• Multiple DCS file, no composite
• Multiple DCS file, grayscale composite
• Multiple DCS file, color composite

Preview Resolution

The default resolution is set on 72 ppi. This option can change the resolution of the RGB preview used when placing
the EPS DCS file. A higher value will produce a finer, more detailed preview but will also increase the files size of
the EPS DCS. The minimum value is 72 ppi.

Resolution

The default resolution is set to 4.000 ppi. If you do not know where the EPS will be placed, you might want to make a
high resolution file. Mind, however, that the higher the resolution, the bigger the file size of the EPS will become.

Page Number: To select the page of the job you want to export.

Scale: allows you to scale using percentages.

Add SmartMarks sets by selecting one from the dropdown list.

Account for job margins: selects the margins of the job as the true boundary. Normally the borders of the job are
taken as the true boundary of the job. Sometimes, however, you may want to convert everything that is situated within
the margins too.

Hide Trap Layer in output: allows you to export your file with or without the trap layer.

Export to Normalized PDF File

This task converts a GRS file to a Normalized PDF file.

Note:  This task is only available when you are working in a Normalized PDF job folder.
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External References

External references have to be converted, you can define what the system needs to do.

• 'Write local external references to the output folder and other external references to their original folder'.

Upon exporting, external references in subfolders or neighboring folder will be written to the output folder.
External references in for example central folders will be written in their original folder.

• Write all external references to the output folder.
• Write all external references to their original folder.

When converting again, you can opt to:

• Reconvert if recently updated: only updated references will be reconverted, all other conversions will be used as
they were.

• Use previous conversions: the existing conversions will be used, potential updates will not be considered.
• Always reconvert: all external references will be converted at all times.

Embed External Images

Referenced external files in GRS format can be converted to referenced files in Normalized PDF file format. Indicate
which images you want to have converted.

1. All images
2. Images with uncompressed data size smaller than 640 kB (as specified via Configure > Processing Preferences

> Embedded Images). This option is identical to the option in the Inks tab of the Normalize PostScript / PDF /
Illustrator 8.0 File task.

3. None

Indicate what should happen with the external images. You can have them copied to the output folder, or you can opt
to leave them in their original folder.

Fail when fonts are not found

When the fonts used in the file are not found the task will fail, when the toggle is not selected, the task will end with a
warning.

Fail when external references are not found

The task will fail when not all external files were found.

Export to Normalized PDF File (Embed All)

This task embeds all the external references, images and fonts to a Normalized PDF file. You
can use this task to include external references and links in a PDFPLA or Normalized PDF file.

You can specify the output file name and location in the ticket settings.
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The output will be one Normalized PDF file with all the external references, fonts and images embedded.

Note:  In the Export to Normalized PDF task you can embed the images, but the external references in a
normalized PDF file is exported together to the specified location. Read more in Export to Normalized PDF
File

Export to PDF File

We advise to use one of the following factory settings. Using a factory setting does not mean that you cannot modify
the settings:

 

 

These settings are a quick way to define your ticket. There are seven settings, select one from the drop down list:

• PDF for data interchange (PDF 1.3): High compatibility but slow and less editable.

• Acrobat 4 and lower
• Ripping

• PDF for data interchange (PDF 1.4): Interchange with modern applications, well editable. For example Acrobat
5 and more recent.

• PDF for data interchange (PDF 1.5): Interchange with modern applications, well editable for example Acrobat 6
(and higher).
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• PDF for data interchange (PDF 1.6): Interchange with modern applications, well editable for example Acrobat 7
(and higher).

• PDF for data interchange (PDF/X-1a:2001 (ISO 15930-1)): PDF/X-1a is a standardized subset of PDF designed
specifically for reliable prepress data interchange. PDF/X-1a ensures complete exchange using CMYK and spot
color data. Uses: ripping and imposition

• PDF for data interchange (PDF/X-3:2003 (ISO 15930-3)): PDF/X-3 is a standardized subset of PDF designed
specifically for reliable prepress data interchange. PDF/X-3 ensures complete exchange suitable for coloured
managed workflows. Uses: ripping and imposition

• PDF for Illustrator CS2 or higher: PDF file meant for editing in Adobe Illustrator CS2 (or higher). Note that
this mode improves the editability in Adobe Illustrator, but does not guarantee full editability.

• PDF for viewing / proofing (CMYK Composite): Useful when using hard copy proofers, or when the result
doesn't have to be editable or when the result is used for softproofing. It is not useful to serve as final output.

• PDF for viewing / proofing (RGB): Useful for softproofing (smaller file, and it's faster to generate).
• PDF for viewing/proofing DeviceN: Interchange file for proofing/viewing. Adobe Acrobat Reader 7.0 or later is

required to view overprint settings correctly.

If you change the predefined settings, the user interface will indicate that the Factory Settings are modified.
 

 

Note:

If you define a ticket using the Factory Settings, and you save it, the Factory Settings option disappears.

If you overwrite a Default ticket, the Factory Settings will be gone as well.

Note:

Even though Acrobat 7 Professional now offers the possibility to define an ink as Opaque ("Ink Manager")
for Trapping reasons it has no influence on the preview.

The PDF Export ticket has seven tabs:

• Output,
• Device,
• Color Management,
• Inks (similar to the Inks tab in the Export to PostScript File task, see Inks / Separations),
• Rasterize (similar to the Rasterize tab in the Export to PostScript File task, see Rasterize),
• Compression,
• Advanced.

Output
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PDF Version

Select a PDF version from the list.

• PDF for Illustrator: Select this version if you want to open the generated PDF 1.4 file in Adobe Illustrator
CS2 or higher. Because Adobe Illustrator only supports a (undocumented) subset of PDF 1.4 features some
objects and/or colorspaces must be split up, transformed and/or pre ripped in order to correctly represent them in
Illustrator.

• PDF/X-1a:2001 (ISO 15930-1)
• PDF/X-3:2003 (ISO 15930-3)
• PDF 1.6: the Acrobat 7 file format
• PDF 1.5: the Acrobat 6 file format
• PDF 1.4: the Acrobat 5 file format
• PDF 1.3: the Acrobat 4 file format

Password security

Allows you to make your file password protected. For more information, please see Password Security.

Output type

• Composite: Generates a composite file, which if no color management is used produces a deviceN pdf for data
interchange. DeviceN means colors can be combinations of the standard CMYK process colors and/or spot colors,
guaranteeing perfectly separable PDF files which can also be proofed on a composite PostScript 3 device. The
generated PDF file will proof correctly and separate correctly. Color management for spot color objects must be
handled by the device.

• Separated: Activate this option to generate separations. Multiple pages will be generated, corresponding to the
inks in the job.

Scale

Define the scale in percentages. You might want to scale your job to make it easier to softproof via e-mail.
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Select SmartMarks from the dropdown list.

Put marks with ink coverage on a hardcopy proof (or view it in Acrobat).

Account for job margins

To select the margins of the job as the true boundary. Normally, the borders of the job are taken as the true boundary
of the job. Sometimes, however, you may want to convert everything that is situated within the margins too.

Hide trap layers in output

Toggle this option on if you do not want the trap layers included in your output.

Page Range

• Output All pages.
• Output a number of Pages. Enter page numbers or page ranges separated by commas, for example 1,3,5-8.

Password Security

The options in the Password Security window depend on the PDF version you chose in the Output tab.

Click the Password Security button in the Output tab (Export to PDF task), the Password Security window opens:
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Compatibility: the compatibilities offered here depend on the PDF version you chose in the Output Tab.

Encryption level: Low (40–bit RC4)

Require a password to open the document: enter a password.

Use a password to restrict permissions: enter a password.

Printing Allowed

• Select 'None' to prevent users from printing the file.
• Select 'low resolution (150 dpi)' to give users permission to print the file at a resolution of 150 dpi only.(Acrobat

5.0 and later)
• Select 'High resolution' to give users permission to print the file at high resolution only.

Changes allowed
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• Select 'None' to prevent users from doing anything with the file, including filling in signature and form fields.
• Select 'Inserting, deleting and rotating', lets users insert, delete, and rotate pages, as well as create bookmarks and

thumbnail pages. This option is available only if a high encryption level is selected. (Acrobat 5.0 and later)
• Select 'Any except extracting pages' to let users do anything to the document except extract contents.

Enable copying of content: Lets the user select and copy the contents of the PDF document. This option is available
only if the Compatibility option is set to Acrobat 5.0 and later.

Enable Text Access: (Acrobat 5.0 and later) Enables visually impaired users to read the document with screen
readers. This option does not allow users to copy or extract the document's contents. This option is available only if
the Compatibility option is set to Acrobat 5.0 and later.

Device

Make your export PDF device specific by adding a description of the dot gain compensation curves inside that PDF.

Note:  These are not calculated, but they are stored as PDF standard transfer curves. Opening the PDF in
Acrobat will not show any difference.

 

 

Dot Gain Compensation

You can select Dot Gain Compensation (DGC) curves made with IntelliCurve or IntelliCurvePro.

• Single curve: Allows you to select one DGC curve (.dgc file) that will be applied to all your data.
• Automatic: Allows you to select a Screen-Based DGC table (.scrdgc file) or a DGC Strategy (.icpro file).

The former allows you to apply dot gain compensation selectively depending on the dot shape, screen ruling,
angles and even Contone or Linework properties. The latter does the same but also offers ink-based dot gain
compensation.

Note:

You can also apply both single curve and automatic DGC simultaneously, resulting in a cumulation of both
effects.

Color Management
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Convert to

• CMYK: all inks are converted to CMYK values.
• RGB: all inks are converted to RGB values.
• Gray: all inks are converted to Gray values.

Use link profile: Link profiles describe a transformation from 1 device-dependent color space to another. This is
actually a concatenation of a forward transformation of 1 profile and a backward transformation of another profile.
This means that all other options will be grayed out as the Link Profile takes complete care of the color management.

Source profile: If any CMYK objects are to be converted, choose a source profile. The list shows all CMYK print
profiles in the color database. The source profile defines the target that the destination profile is supposed to match.

Destination profile: Choose a color profile for your destination color space. The list shows all print profiles in the
color database. These profiles are either measured in Color Engine Pilot or imported ICC-profiles.

Rendering intent

• Relative (No Background): Use this option if you do not want any background simulation. The white point of the
source will be mapped on the white point of the destination process. This rendering intent takes into account the
ability of the human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped on white of
destination colorspace). Use this option if you don't care too much about an exact color match but you want the
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pictures at least to look nice on your proofer. It will give a visually pleasing result. If the gamut of the source is
wider than the proofer, the entire gamut is shrunk so that it fits inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an exact color match,
including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent will map saturated
colors on saturated colors.

Black Mapping: When toggled on, the CMY-part of the composite colors are converted separately from the black
component. As a result, the type of black separation (Skeleton, UCR, GCR...) is preserved by the conversion. (It is
still possible that the black percentage changes slightly due to different dot gain in the color profiles.) When toggled
off, the converted CMYK colors are completely re-separated into the black behavior that is built into the destination
profile.

Use the document profile as source profile if available: If a document profile is defined, then that one will be used
as a source profile. The one chosen from the Source Profile dropdown list will be overruled.

Embed the Destination profile as an intermediate color space

If this toggle is off, the colors in the PDF file will not be tagged with an ICC color profile. The document is device
dependent and its colors will only be reproduced accurately if the PDF file is output on the device that is specified in
the Destination Profile. This choice is preferable if we are sure the PDF file will be sent to the device specified in the
Destination Profile.

If this toggle is on, the color in the PDF file will be tagged with an ICC color profile. The document then becomes
device independent, and its colors will be reproduced accurately even on devices with a color space different from the
one specified in the Destination Profile. In this case, the Destination Profile is an intermediate colorspace between the
Source Profile and the color profile of the device that will eventually process the PDF file.This method is preferable
when the PDF file will be sent to an unknown device.

Embed the document profile as PDF Output intent: The output intent is an ICC profile that specifies the intended
output device. If this option is toggled on, the document profile will be saved as the PDF output intent. For certain
PDF flavors (PDF-X/3) an output intent is mandatory and this option is always on. If no document profile was set
explicitly, the default document profile (crom_offs) is used instead. If the document profile is a Color Engine Pilot
profile, it will first be converted to an ICC profile.

Compression
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General

Optimized lossless image compression

Selecting an overall lossless image compression method seldom results in the smallest overall file size. This option
will use the smallest lossless compression method for every image seperately (JPEG2000, Flate, FlateDiff, LZW,
LZWDiff, CCITT3, CCITT4 or RLE) depending on the image type and the allowed lossless compression methods for
the chosen PDF version. When activating this option the compression methods for Contones and Bitmaps are disabled
and the encoding is set to Binary. Please do not overrule this option unless you have good reasons to choose another
encoding method, otherwise the resulting file will become larger.

Attention:  Activating this option will slow down PDF export considerably, so use it only for file size critical
jobs.

Check Crop images on clip mask to crop the image(s) on the clip mask. All information located outside the clip
mask will be lost.

Encoding

• Binary: The image data is represented as binary data. This results in compact files that however are not editable in
a common ASCII editor. Nor can these files be sent over a communication line using a communication protocol
that relies on control characters in the data stream itself.

• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They also can be sent
over a communication line using whatever communication protocol is available. The drawback, however, is that
hexadecimal image data may take up to twice as much size as binary data.

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly all of the printable
ASCII character set. The resulting expansion factor is 4:5, making this encoding more efficient than hexadecimal.

Bitmaps

Downsample The images referenced in your design are subsampled approximately to the specified value. Activating
this option, allows you to reduce the size of the generated PDF file. Select the unit for subsampling from the
dropdown list: lpmm or ppi. Please be aware that 1–bit copydot Images cannot be downsampled.

Compression

• None
• CCITT group 3 and CCITT group 4
• Run Length
• LZW
• LZW Diff
• Flate (ZIP)
• Flate (ZIP) Diff

Contones

Downsample The images referenced in your design are subsampled approximately to the specified value. Activating
this option, allows you to reduce the size of the generated PDF file. Select the unit for subsampling from the
dropdown list: lpmm or ppi.

Compression

• None
• LZW
• LZW Diff
• JPEG Compressions
• JPEG2000
• Flate (ZIP)
• Flate (ZIP) Diff
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When selecting JPEG, an extra dropdown list becomes activated. It allows you to select the quality of the JPEG
compression that needs to be used: from Limited over Standard to Extreme.When selecting JPEG2000, the dropdown
list offers the following compression types: lossless, limited, low, standard, high or extreme compression.

Text and Lineart

Compression

• None
• LZW
• Flate (ZIP)

Advanced

 

 

Fonts

• Contourize fonts

Note:  Protected CID fonts will be referenced by name.

• Embed BG and Type1 and CID fonts: Allows you to include the used BG and Type 1 fonts of your design in
your PostScript file.
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Split Complex Paths

Note:  These are workarounds for typical PostScript level 1 path limitations. Only use these when absolutely
necessary.

• Filled and stroked paths at X points Use this option to split linework with more than x points into several
smaller linework parts. This option decreases the complexity of the linework. A suitable value for the selected
device type is calculated for this option.

• Clip paths at X points Use this option to split linework masks for images with more than x points into several
smaller linework parts. This option decreases the complexity of the masks.

Workaround

• Limit filename to 31 characters Use this toggle if you want to make sure your imported files can be seen/read
from/by all Apple operating systems.

• Ignore varnish inks Varnish inks will not be included while outputting.
• Resolve pure black overprint. Overprints are normally resolved, but by default, pure black is left untouched. If

you want Rich Black to be resolved too, select this option. This option is only available when Color Management
in the Processing tab is activated.

• Resolve once identical external files Instead of resolving the complete file and all its external references,
identical external files will be resolved only once.

• Resolve once identical one-ups in Step & repeat file Instead of resolving the complete Step & Repeat file,
identical one-ups will be resolved only once.

• Suffix for PANTONE ink names Enter a suffix for PANTONE ink names. The default is C.
• Split multi-page jobs into multiple files Every page of a multi-page job will be output as a separate PDF file.
• Add ruling, angle and dotshape information in PDF Data section
• Add Ink Coverage data in XMP

Uncheck this to not save the ink coverage data in the XMP section of the exported PDF file (calculating the ink
coverage might be time consuming and slow the PDF export down).

Export to PDF File Chain

This task chain ticket consists of the Export to PDF File, linked to the Mark as Proof ticket. The result of the action is
a PDF file that can be checked in the Proofs View.

Note:  This task is used only in page workflows.
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Depending on where the output file name is specified, in the PDF step or in the Proof step, a different naming
mechanism for the Proof Sets is triggered.

PDF Step

 

 

When a task is launched from the Pages or Plates View, the default proof file name is proof_[File].

Mark as Proof Step

 

 

The default proof set name is: Output file name. extension.

Use SmartMarks to build up the name or enter it manually.
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In the Details pane you'll see the original name of the file, including extra information on trimboxes, side, etc.

Export to PostScript File

The Factory settings supplied are a quick way to define your ticket.

We advise you use one of these settings (but you can modify them if needed).

 

 

• PostScript for press (separated)
• PostScript for press (DeviceN composite): This output mode (only supported by PostScript 3 devices) uses the

PostScript DeviceN colorspace to produce high-fidelity colors.

These colors are combinations of the standard CMYK process colorants and/or spot colors, guaranteeing perfectly
separable PostScript code that can be proofed on a composite PostScript 3 device.

• PostScript for viewing / proofing (CMYK composite)

If you change the predefined settings, the user interface will indicate that the Factory Settings are modified.
 

 

Note:  If you define a ticket using the Factory Settings, and you save it, the Factory Settings option
disappears. If you overwrite a Default ticket the Factory Settings will also be gone.

Output
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Device type: To select the output device you want your design to be exported to or printed to, the corresponding PPD
is chosen and will be used.

Output type: To export or print your design as CMYK Composite, Separated or Composite.

• CMYK Composite: Activate this option to generate a composite PostScript file for proofing.

Note:  Remark that a CMYK composite PostScript file will proof correctly but separations will not be
correct since all spot color are converted to CMYK.

• Separated: Activate this option to generate separations. Multiple pages will be generated, corresponding to the
inks in the job.

• Composite: this output type can only be selected for PostScript 3 devices since they support deviceN colorspace to
produce high-fidelity colors.

These colors are combinations of the standard CMYK process colorants and/or spot colorants, guaranteeing
perfectly separable PostScript code which can also be proofed on a composite PostScript 3 device.

The generated PostScript file will proof correctly and separate correctly. Color management for spot color objects
must be handled by the device.

Emulsion Up: To obtain Right Reading (= emulsion up) or Wrong Reading (=emulsion down).

Image: To specify Positive or Negative print mode.

Note:  Image and Emulsion up becomes unavailable (appears dimmed) when CMYK Composite Output was
chosen.
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Enter the Vertical and/or Horizontal distortion in percentages.

Select SmartMarks from the dropdown list.

Account for job margins: To select the margins of the job as the true boundary.

If you deselect this toggle, the borders of the job are taken as the true boundary.

When you want to output everything that is placed within the margins too, leave the option activated.

Hide trap layer(s) in output: Trap layers will not be included in the output.

Page range

• Output All pages.
• Output a number of pages. Enter pagenumbers or page ranges separated by commas. For example 1,3,5–8.

Scale & Tile

• Enter a Scale factor (percentage).
• Fit job on page scales the job so it fits the selected paper size.
• Shrink oversized jobs to paper size.
• Select 'Tile Job' to obtain a tiled output if the job is too big to fit on the selected paper size.

The tiling option which can be used to export a large job to a series of smaller pages (tiles) allows the user to cycle
through the tiles which will be produced and see just how many tiles there are.

Overlap X mm/inches: To specify a tiling overlap. The value you enter here, is the amount of overlap in all four
directions between adjacent tiles. It defaults to 5 mm.

Page Setup

• Select a paper size from the drop-down list. The list that appears here is based on the page sizes supported by the
selected ppd.

• Orientation: Auto, None, 90° cw, 90°ccw, 180°. The orientation options are disabled when 'Tile job' is selected.
• Alignment: Bottom left, Top left, Top right, Bottom right, Centered. The alignment options are disabled when

'Tile job' is selected.
• Enter the number of copies.

Device
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The Resolution depends on your output device and on the purpose of the PostScript file. For proofing for example, a
lower resolution might be sufficient.

Select the Dot shape.

Halftoning: If you select CMYK Composite or Composite as Output type, you can choose to include screen
information when outputting (lpi and angle).

• Use Printer Defaults: the output device's default screen information will be used.
• Take over from job
• Some devices offer other dotshapes if they are available in the PPD.

Dot Gain Compensation: You can select Dot Gain Compensation (DGC) curves made with IntelliCurve or
IntelliCurvePro to be added as transfer curve.

Note:  A screen-based DGC file was the format written by the two DGC Editors (DGC Editor and Screen-
based DGC Editor). These two editors have been replaced by IntelliCurve, which writes DGC Strategies.
However, a screen-based DGC file can still be applied.

• Single curve: Allows you to select one DGC curve (.dgc file) that will be applied to all your data.
• Automatic: Allows you to select a Screen-Based DGC table (.scrdgc file) or a DGC Strategy (.icpro file).

The former allows you to apply dot gain compensation selectively depending on the dot shape, screen ruling,
angles and even Contone or Linework properties. The latter does the same but also offers ink based dot gain
compensation.
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Note:  You can also apply both single curve and automatic DGC simultaneously, resulting in a cumulation of
both effects.

Note:  When a DGC curve is selected, the job will be flattened to ensure the correct Dot Gain Compensation
is applied to transparent objects. This may result in a larger file.

Roll Fed Devices: Account for Media Width allows the conversion program to find the best printing orientation. For
roll-fed devices, mostly imagesetters, a Media Width (film width) can be specified.

The conversion program finds the best printing orientation in order not to waste paper or file if Rotation is set to
Auto.

The Media Width value is expressed in mm.

The option 'Extra Gap' allows you to specify extra width for the film or paper feed. The Extra Gap value is expressed
in mm. By default, no Extra Gap is set.

For Device specific options please refer to the manual of your output device.

Color Management

 

 

Convert to

• CMYK: all inks are converted to CMYK values
• Gray: all inks are converted to Gray values.

Use link profile: Link profiles describe a transformation from 1 device dependent color space to another. This is
actually a concatenation of a forward transformation of 1 profile and a backward transformation of another profile.
This means that all other options will be grayed out as the Link Profile takes complete care of the color management.
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Source profile: If any CMYK objects are to be converted, choose a source profile. The list shows all CMYK print
profiles in the color database. The source profile defines the target that the destination profile is supposed to match.

Destination profile: Choose a color profile for your destination color space. The list shows all print profiles in the
color database. These profiles are either measured in Color Engine Pilot or imported ICC-profiles.

Rendering intent

• Relative (No Background): Use this option if you do not want any background simulation. The white point of the
source will be mapped on the white point of the destination process. This rendering intent takes into account the
ability of the human eye to adapt to the surrounding white.

• Absolute (Background): Use this option if you want background simulation and you want an exact color match,
including the paper simulation.

Map black on black: When toggled on, the CMY-part of the composite colors is converted separately from the black
component. As a result, the type of black separation (Skeleton, UCR, GCR...) is preserved by the conversion. (It is
still possible that the black percentage changes slightly due to different dot gain in the color profiles.) When toggled
off, the converted CMYK colors are completely re-separated into the black behavior that is built into the destination
profile.

Use the document profile as source profile if available: If a document profile is defined, then that one will be used
as a source profile. The one chosen from the Source Profile dropdown list will be overruled.

Inks / Separations

The Inks/Separations tab depends on the output type you selected in the Output tab.

• If you choose CMYK Composite or Composite, the Inks tab will be visible.
 

 
• If you choose separated output, the Separations tab will be visible.
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All Inks: The standard behavior of the default ticket is to offer all inks in the job to be exposed. Deactivating All Inks
opens an ink-list panel where you can select specific inks. The list contains ink names, ruling, angle, dot shape and
ink type.

Note:  The Inks panel only shows the inks that are present in the input file(s) for the first task in your
workflow chain. When no files are selected (for example, when building workflows in the Tickets view, you
will not be able to “preselect” inks.

Use technical inks in output: Normally technical inks are hidden when you save a job in an Esko editor. Check the
box to output the visible (non hidden) technical inks.

Convert all inks to CMYK: inks will be converted to CMYK.

Use Merge with to output inks on top of each other in the same output file. This is common when you use different
rulings for 1 ink.

For example, let's assume that the job contains two Cyans, and that they have a different ruling. You might want to
put them on the same separation.

You can do so by clicking in the Merge with column and selecting the ink it has to be merged with.

Rasterize

 

 

Rasterizing resolution: Enter the resolution for the objects that will be resolved.

Output as image: When this toggle is activated an image is made of the job. The resolution entered above will be
taken into account.

Anti-aliasing: is relevant for the line-art objects in your design, that need pre-processing and for which images are
generated. Anti-aliasing smoothens the staircase effect you get in the generated images of lineart objects that need
pre-processing.

Tip:  This option increases the readability of small text that is pre-processed to image.
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Convert vignettes to image: To avoid banding in the vignettes when exporting. Exporting vignettes to a PostScript
Format, may result in blends and banding due to restrictions in PostScript. However, to obtain a nice result in your
export file, activate Convert Vignettes to CT. All the vignettes present in your design will be converted to images.

Vignette noise: When exporting to PostScript, some vignettes or parts of vignettes will be converted to images. This
happens when the vignettes overlap other objects with translucency or overprint between the vignette and the other
objects.

When the option 'Convert Vignettes to Image' is activated all vignettes are converted to images regardless of overlap
with other objects. Vignettes that are converted to images may have tone jumps in the final result. To reduce this
banding effect, noise is applied on the image. The amount of noise can be specified in the field Vignette Noise.

Compression

 

 

Encoding:

• Binary: The image data is represented as binary data. This results in compact files that however are not editable in
a common ASCII editor. Nor can these files be sent over a communication line using a communication protocol
that relies on control characters in the data stream itself.

• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They also can be sent
over a communication line using whatever communication protocol is available. The drawback, however, is that
hexadecimal image data may take up to twice as much size as binary data.

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly all of the printable
ASCII character set. The resulting expansion factor is 4:5, making this encoding more efficient than hexadecimal.

Compression: None, LZW or Flate (PostScript3 devices).

Downsampling The images referenced in your design are subsampled approximately to the specified value.
Activating this option allows you not only to reduce the size of the generated PostScript file, but also a quicker
generation of the PostScript file.

Select the unit for subsampling from the dropdown list: lpmm or ppi. You can subsample both bitmaps and contones.

Please be aware that 1–bit copydot Images cannot be downsampled.
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Advanced

Fonts

• Contourize fonts

Note:  Protected CID fonts will be referenced by name.

• Embed BG and Type1 fonts: Allows you to include the used BG and Type 1 fonts of your design in your
PostScript file.

Split Complex Paths

Note:  These are workarounds for typical PostScript level 1 path limitations. Only use these when really
necessary.

• Filled and stroked paths at X points: Use this option to split linework with more than x points into several
smaller linework parts. This option decreases the complexity of the linework. A suitable value for the selected
device type is calculated for this option.

• Clip paths at X points: Use this option to split linework masks for images with more than x points into several
smaller linework parts. This option decreases the complexity of the masks.

Workaround

• Limit filename to 31 characters: Use this to make sure your imported files can be seen/read from/by old Apple
operating systems.

• Ignore varnish inks : Varnish inks will not be included when outputting to PostScript.
• Resolve pure black overprint: Overprints are normally resolved, but by default, pure black is left alone. If you

want Rich Black to be resolved too, select this toggle.

This toggle is only available when the Color Management in the Processing tab is activated.
• Resolve once identical external files: Instead of resolving the complete file and all its external references,

identical external files will be resolved only once.
• Resolve once identical one-ups in Step & Repeat files: Instead of resolving the complete Step & Repeat file,

identical one-ups will be resolved only once.
• Suffix for PANTONE ink names: Enter a suffix, the default is C.
• Suppress hairlines at clips : Due to the PostScript limitation of the maximum number of points allowed for a

path, complex paths will be cut into smaller pieces.

When the PostScript file is printed/exposed on some older PostScript RIPs, hairlines can become visible. To avoid
this problem, activate Suppress hairlines at clips.

• Split multi page job into multiple files: Every page will be output as a separate file.
• Image to paper edge: This moves the origin of the converted job to the lower left corner of the paper or film.

Activate this option to align your job to the edge of the paper or film to use the full area.

Note:  Exporting to a paper PostScript device: For most of these devices, there is always a border on the
output page on which nothing can be imaged. Parts of your design that are located in that border area will
be lost.

• Avoid tabular number problem: When digits are written as tabular numbers, exporting to some PostScript RIPs
may result in bad positioning of the numbers. The tabular numbers are not correctly placed at the text base line.

To avoid this problem, activate Avoid tabular number problem.
• Disable path clipping: By default, paths are clipped by the borders of the job, but if there are instances where you

do not want the paths to be clipped, check this box.
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• Map spot color separations to CMYK: This option is intended to export a job containing spot colors to pre-
separated PostScript for systems which are limited to handling process color separations only (for example a
Scitex Brisque Workflow).

This option is available when Pre-Separated is selected.

Spot color separations can only be handled on such systems by remapping them to a specific process separation.
When this box is checked, spot colors will be exported as a C, M, Y or K separation according to a simple rotating
name principle (C->M->Y->K->C->...).

Spot colors which are named exactly after process colors remain unchanged.
• Omit “Process” For CMYK in %% PlateColor comment: This option is intended to export a job to a device

that does not understand "Process".

If your different separations all have the K (Black separation) Angle and Rulings when output to your Image
Setter, you must activate this option.

• Split separated output into multiple files: Instead of writing one file containing all separations, the system will
write one file per separation.

• Force Black Overprint: Select this if you want all 100% black objects to overprint in your PostScript file.

Extract Inks

You can keep ink separations according to the Printing Methods present in the PDF file. The output PDF contains
only those inks which are corresponding to the printing methods specified in this task.

Note:  This task extracts inks(keeps inks) in a file according to the printing method/criteria you specify.
Therefore, it is essential that it contains the information on the printing methods.

 

 

Note:

You can set the the printing methods in a PDF file via Automation Engine Job setup or in Plato/PackEdge.In
the Inks panel of the Job Setup dialog in Automation Engine, the printing method can be set for each
separation. Read more in How Can the Printing Method of a Separation Be Defined?

You can use Extract Inks task while setting up separate processing workflows for individual separations with
specific printing methods. This is especially useful in hybrid press industry where press- specific inks can be
kept in the output PDF. Another instance where this task is useful is when you want to generate separate reports
corresponding to inks. Read more on tasks relating to hybrid press industry in How Can You Differentiate the
Processing of Separations for Different Printing Methods?
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You can specify Printing method in the field about which the information is pre-defined in the file. You can have
multiple printing methods specified by adding fields using +. If you use a combination of Alt and ... , you can exclude
printing methods.

 

 

Image to MJM File

The Image to MJM File task will pack the JDF that describes the ImageSetting process together with the data files
(ripped data) into one .mjm file.

This file can then be easily transported to another site for exposing or archiving purposes.

At the remote site, the exposure can be started by sending this .mjm file to a JDF/JMF enabled device controller using
the task as described in Make Plate on CDI on page .

If an .mjm file is selected as input file, the task panel will be empty. This is normal as all crucial information is stored
in the .mjm file itself.
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Import Image

The Image Import task is able to convert pixel images to native CT or LP file format. This task can optionally convert
RGB images to CMYK for easier processing in workflow. You can also convert CMYK CTs with Inkswitch or
BlackSmith.

Mask/Path Settings

Use these toggles to control the conversion of pixel masks and clipping paths. They can be removed or kept during
conversion.

• Select the Keep Pixel Masks toggle to keep the original pixel mask.
• Keep the original Clipping Path, the resulting file will contain the original clipping path.

Preview Settings

• Create a Thumbnail image
• Create a Preview

Keep Indexed

If the colors in the image are reduced (indexed) and you want to keep it like that, use this toggle.

RGB Conversion Method

You may want to convert the image you want to import to a CMYK colorspace. There are two ways to convert to
CMYK.

• Device Link Profile
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This allows you to select a Process Link, made in Color Engine Pilot. This option will give you the best result.

Link profiles describe a transformation from 1 device dependent color space to another.

This is actually a concatenation of a forward transformation of 1 profile and a backward transformation of another
profile.

This means that all other options will be grayed out as the Link Profile takes complete care of the color
management.

• Device Profile

This enables you to select a source and a destination (proofer) process.

Use this option if you did not make a Process Link in Color Engine Pilot but you still want a better color result.
The process links will be made for you.

RGB Profile: Source profile used for conversion.

CMYK Profile: Destination profile used for conversion.

Rendering intent: Possibilities are:

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped on white of
destination colorspace). Use this option if you don't care too much about an exact color match but you want the
pictures at least to look nice on your proofer. It will give a visually pleasing result. If the gamut of the source is
wider than the proofer, the entire gamut is shrunk so that it fits inside the gamut of the proofer.

• Relative Colorimetric: Use this option if you do not want any background simulation. The white point of the
source will be mapped on the white point of the destination process. This rendering intent takes into account
the ability of the human eye to adapt to the surrounding white.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent will map
saturated colors on saturated colors.

• Absolute Colorimetric: Use this option if you want background simulation and you want an exact color
match, including the paper simulation.

Note:  For BGCMS profiles Perceptual, Relative Colorimetric and Saturation are in fact identical.

Import JDF Layout

The JDF Imposition task handles JDF files generated by JDF compliant imposition programs. It imports the JDF
layout into Esko native files.

The JDF file is a low level JDF file, which means that the delivered imposition is a flat imposition and thus no longer
editable. Automation Engine will handle this kind of JDF file as a GRx file.

The JDF file contains two parts:

1. A page list, referring to PDF or PostScript files.
2. Geometrical layout info.

The JDF Imposition task converts all PDF and PostScript files and creates 1 GRO file per sheet side.

This tickets’s tabs are identical to the Normalize PostScript/PDF/Illustrator 8.0 File ticket’s tab, and the Sheets tab
differs a little from the Sheets tab of the Export Imposition to GRI File task, but has the same functionality.

Sheets

Indicate of which pages you want to import the JDF layout. For the front as well as the back sheets, you can either
select all pages or choose for a range of pages.
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Import JDF Step & Repeat

With this task, you can generate a Step & Repeat (PDFPLA) file from a JDF ticket you get from a MIS system.

You can launch this task on:

• a JDF file containing a link to a CAD file and PDF station files, to perform CAD-based Step & Repeat,
• a JDF file containing a link to PDF station files, to perform tabular Step & Repeat.

Note:  The JDF ticket you use should always contain a list of the input files.

General

SmartMarks

Select your desired SmartMark (created in PackEdge) in the list, or enter a SmartMark name. You can use
SmartNames to define your SmartMark name.

Load Mark Set in Bottom Layer

Select this if you want to make sure the marks are positioned in the bottom layer, "behind" the graphics.

Limit Bleed to

Use this option to limit the bleed to a specific distance.

Note:  The bleed mask is created by spreading the die shape.

Plate Setup

Use Sheet Size from JDF
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You can either use the sheet size defined in your JDF ticket, or define a Sheet Size yourself.

When defining a sheet (or a plate) size, choose the Unit to use: either mm or inch.

Use Plate Size from JDF

You can either use the plate size defined in your JDF ticket, or define a Plate Size yourself.

When defining a plate size manually, you also need to define the Sheet Offset and the Sheet Position on Plate.

Sheet Offset

Define by how much the sheet should be offset from the plate corner, horizontally and vertically.

Sheet Position on Plate

Position the sheet on the plate by dragging and dropping the small red rectangle (the sheet) to the right position on the
big blue rectangle (the plate).

Note:  Take into account the point of Origin from which the repetition will be built. This is defined in the
JDF and is always bottom left.
 

 

Shrink

Enter horizontal and vertical shrink values to compensate for printing distortion (especially in Flexo). The default
value is 100 both horizontally and vertically (no distortion compensation).

Screen Registration

Select this option to restart the screening for each unit (use this when you need each unit of the Step & Repeat to have
the exact same screening, for example in a workflow aimed at printing stamps).

Attention:  This setting is only supported by FlexRIP / Imaging Engine. It will be lost if you use another PDF
RIP on your file.

Tip:  You can use SmartNames on all the input fields of this tab. Just click in a field then click the Insert
SmartNames button.

CAD Options

Mapping

If you are working with DFX, you can map your DFX layers, line styles and color numbers to ArtiosCAD line styles
(for example cut lines, crease lines...). You need to create a mapping in Plato or PackEdge, then select it here.

Fore more information, please see the Plato / PackEdge documentation.

CAD Style

Use this to map the ArtiosCAD line styles of your CAD file (cut lines, crease lines...) to Plato / PackEdge inks. You
need to create a CAD style in Plato or PackEdge, then select it here.

Fore more information, please see the Plato / PackEdge documentation.

Include CAD info for Digital Flexo Suite

If you are using the Digital Flexo Suite, select this option to write technical cutting and creasing information into the
header of the output file.
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This information will be embedded in the LEN files output by the FlexRIP, and used in the Digital Flexo Suite to help
visualizing the output.

Use Blank Position from JDF

You can either use the blank position defined in your JDF ticket, or position the blank on the sheet yourself.

Note:  The blank is a representation of the single design that will be stepped & repeated. It is equivalent to the
one-up without the artwork (or the bounding box of the one-up).

Position Blank on Sheet

Position the blank on the sheet by dragging and dropping the small red rectangle (the blank) to the right position on
the big blue rectangle (the sheet).

Note:  Take into account the point of Origin from which the repetition will be built. This is defined in the
JDF and is always bottom left.

Blank to Sheet Offset

Define by how much the blank should be offset from the sheet corner, horizontally and vertically.

Note:  When defining the blank to sheet offset, choose the Unit to use: either mm or inch.

Import JDF Stripping

One of the possibilities of an MIS system is 'production planning'. This determines how an order (a job) will be
produced.

Taking into account for example the presses available, folding and cutting machines, a production plan will be
worked out.

This may not necessarily be the cheapest way, but it will certainly be the most efficient way at that particular moment
(for example because a certain press is in maintenance, another - less economical press - will be used.)

The JDF file that is sent to the Prepress department contains a lot more information than only imposition information.

This valuable imposition information, like for example sheet and signature information will be retrieved from the JDF
file, in other words, the file will be stripped.

A JDF file can contain several parts, for example cover, pages, insert... Each part has to be stripped separately. You
can also opt to strip all parts in one go. Select 'All parts from the list'.

The result of the stripping task is an empty imposition (IMP) file.

All signatures and positioning are decided upon, as well as a number of other valuable imposition settings that are not
visible in the Stripping task, like for example finished and unfinished page properties.

Note that these parameters are fixed in the JDF file and can therefore not be modified interactively.

The JDF Stripping task retrieves all relevant imposition information from the JDF file.
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Sheets

• Name indicates the name of the sheet.
• WorkStyle indicates the work style for the particular sheets: Sheetwise, Work&Turn, Work&Tumble, etc.
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• Paper shows the dimensions of the paper on which will be printed.
• Press indicates the type of press on which the sheet will be printed.

All of the above settings are retrieved from the MIS system (JDF file).

• Plate settings have to be determined by the operator.

If no specific plate is selected, the values for the Master are taken into account, which is Auto in the example
above.

Auto refers to the value specified for Auto in the Other tab.

Master indicates that the same plate as the one indicated on Master level will be used.

In the example below, the plate SM72x102 V_tumble will be used for both sheets.

 

 

Assembly

 

 

• Type: is determined by the MIS system.
• Template: The operator has to map the correct template to the assembly type.

Other
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Auto Rules

Here you can indicate which plate or assembly template should be used when 'Auto' is selected in the Sheets tab.

Clicking the SmartNames icon  opens the list of available SmartNames.Click the SmartNames category to see
the SmartNames that have already been created. For each SmartName, a description is given in the description area at
the bottom of the dialog.
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Positioning of signatures

Indicate how the signature should be positioned on the paper.

• Vertical

• Expert: positions the signature so that the bleed margin coincides with the gripper in a turn workflow. In case
of a tumble workflow, the signature will be positioned in the center of the paper.

• Center in paper
• Use bottom of paper as origin

• Horizontal

• Expert: In case of a horizontal positioning, the Expert option is identical to the Center in paper option.
• Center in paper
• Use left side of paper as origin
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Search for productID of plates: check this toggle if you want to have the JDF file searched for Plate Product IDs.
You can then use this Plate Product ID as a text or barcode mark on the plate.

Import Sheet Size from XML

object . property  =  trueorfalse

Prop name Prop value

Integrate via External Hot Folder

The Integrate via External Hot Folder task allows you to integrate external prepress applications into your workflow
tickets. The only requirement is that the external system works with hot folders.

1. In the Integrate via External Hot Folder ticket, you define the location of the hot folder used by the external
application, as well as the Result subfolders in which the external application will output processed jobs (the OK
Folder), failed jobs (Error Folder) or jobs that produced warnings (Warnings Folder).

2. When you process a job with this ticket, Automation Engine copies the files to the external hot folder.
3. The external application picks up the files in its hot folder and processes them. The processed files are saved in the

subfolder that matches the processing result: OK, Warning or Error.
4. Automation Engine monitors the OK, Warning and Error folders for any files that have been processed.
5. If it detects a file in the OK folder, Automation Engine copies it to the Output folder defined in the Integrate via

External Hot Folder ticket, and continues its workflow. Depending on your settings, Error or Warning files might
also be copied into the Output folder, or they might be deleted.
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Note:

In the Error area of the ticket, you can define an amount of time after which the external processing should
be considered as failed. To do this, enable the option Error when no result after ... and define a time period
(for example, you could enter one hour, a number of days, or even a specific date).

Interact with Database

This task allows you to directly communicate with an external database. Using this, you can extract information from
and send information to an external database.

You can update records in a MIS database by using this task in a workflow. For example,you can set up the task to
update a table in the MIS when a workflow has reached a certain stage (for eg. when the proofs are ready).

Note:  You cannot use this task to interact with Automation Engine Databases.

Read about configuring External Databases in Configuring Exteral Databases.

Important:  Please check your license agreements with the database manufacturer before linking Automation
Engine with an External Database.

Settings

The External Database drop down will list the configured databases.

In the Statement drop down, you can select the task mode as either SELECT or OTHER

• SELECT: In this mode, you can execute a selected Statement.

 

 

In the SELECT mode, the output of the task will be an XML dump.
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You can avoid creating a big XML file by limiting the number of entries per file with the option Maximum
number of entries per file. The task will generate as many files as needed.

• OTHER:

In this mode, you can execute any other statement such as INSERT, UPDATE etc. However, the task will not
generate an output file.

Note:  When Statement type is set to Other, you cannot execute a select statement.

 

 

Make Plate on CDI

The Make Plate on CDI task can send ripped data (.len, .tiff files) directly to the Digital Flexo Suite (version 10.1
and later).

The Digital Flexo Suite drives a Cyrel Digital Imager that will image a flexo plate using the ripped data from the
Make Plate on CDI task.

Advantages of Using the Make Plate on CDI Task

• You can enforce the plate type through job parameters (that can be filled in from a MIS system) to reduce errors.
• It automates your plate-making workflow: ripped files are automatically pushed to the Digital Flexo Suite operator

(no need to FTP those files, or browse through a file server to get them).
• You can get feedback about the waste per plate.
• It builds up a Flexo Plate History, which makes it easier to remake a plate if necessary.
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Settings

 

 

Destination

Enter the Address of the computer on which the Digital Flexo Suite software is installed.

It will typically take the following shape: http://<computer name>:4410/JDFP/JMF.

Priority

Choose the Priority you want to give to the task: Low, Normal or High.

Choose a Due Date: either choose Job Due Date, or choose Other... and pick the due date yourself.

Plate

Tip:  You can use job parameter SmartNames to retrieve the plate information from the job.

Enter the plate Manufacturer and Type.

Select the Media Type you want to use (Plate or Sleeve).
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• If you want to expose a Plate, enter its Thickness.
• If you want to expose a Sleeve, enter its Width and its Circumference.

Enter the Relief Thickness.

XML Notifications

You can use the standard Automation Engine notification mechanism to create an XML file containing:

• a history of your job's different statuses in the Digital Flexo Suite and on the CDI,
• information useful for billing (total area used on the plate, waste...).

Once the task is finished, this XML file will be saved in the location you defined. You can then use your MIS system
to pick it up and use that information.

Defining an XML Notification

1.
Click  in the Make Plate on CDI ticket.

2. Click Add in the Notification dialog.
3. In the Notification Rule Editor, define your notification as follows:

 

 

Note:  Using [Job URL]/Notification/[ShortID].xml as Location saves your XML file:

• in a subfolder of the job folder called Notification,
• with the run ID of the task ([ShortID], visible in the Tasks pane) as name.

See Notifications for the basics of defining notifications.
4. Click OK in the Notification Rule Editor and the Notification dialog.

See Feedback in the XML Notification File for an example of a file generated by an XML notification.

The Make Plate on CDI Task in a Workflow

The Make Plate on CDI task is commonly used in combination with a RIP ticket (for example RIP to CDI LEN
File) in a workflow.
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1. The workflow is launched on the one-up.
2. The one-up is stepped and repeated.
3. The Step and Repeat file is ripped.
4. View Data is created for the ripped file.
5. The operator gets a To Do asking him to view the ripped file and check if it's OK.
6. If the file is OK, the Make Plate on CDI task sends the ripped file to the Digital Flexo Suite.

After this the Digital Flexo Suite operator:

1. gets the file automatically in the Digital Flexo Suite,
2. places it on a virtual plate using the Merger application,
3. exposes the flexo plate when it is full enough.

The Automation Engine operator gets feedback from the Digital Flexo Suite at each point. See Feedback on page
 for details.

Feedback

When using the Make Plate on CDI task, you can receive feedback in two ways:

• XML notifications that can be used by your MIS system.
• Live status feedback in the Pilot's Tasks and CDI views.

In the XML Notification File

In the XML file generated by the Make Plate on CDI task notification, you can see:

• A description of how a separation was processed by the Digital Flexo Suite.

For example:

<MESSAGES>
<COMMENT Type="INFO">Fetching (XMP) bitmap info for strawberry_123.len</
COMMENT>
<COMMENT Type="INFO">Initializing ImageSetting Process for
 strawberry_123.len.</COMMENT>
<COMMENT Type="INFO">Logging JDF file: file://begeloppem/
AutomationEngineTmpFolder/14951_temp_21782062_imagesetting.jdf</COMMENT>
<COMMENT Type="INFO">Doing SubmitQueueEntry towards http://begeloppem:4410/
JDFP/JMF.</COMMENT>
<COMMENT Type="INFO">03:18:38 Remote QueueEntry ID:
 CDI1_@_20110620151838_@_171</COMMENT>
<COMMENT Type="INFO">03:18:39 CDI state change(NEW): NEW job in Merger JDF
 list</COMMENT>
<COMMENT Type="INFO">03:24:26 CDI state change(MERGE): Job in Merge editor</
COMMENT>
<COMMENT Type="INFO">03:24:58 CDI state change(CDI): Job Sent to the CDI
 Queue</COMMENT>
<COMMENT Type="INFO">03:25:10 CDI state change(RUN): Job Running on the
 CDI</COMMENT>
<COMMENT Type="INFO">03:25:29 CDI state change(DONE): Job Completed on CDI</
COMMENT>
<COMMENT Type="REPORT">&lt;HTML&gt;03:25:52 Received
 the processed JDF File: &lt;A href="file://begeloppem/
AutomationEngineTmpFolder/14951_temp_21782135_imagesetting.jdf"&gt;c:
\fastlane\data_v100\Tmp\14951_temp_21782135_imagesetting.jdf&lt;/A&gt; &lt;/
HTML&gt;</COMMENT>
</MESSAGES>

with time stamps that your MIS system can use:

<StateInfo>
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<CDI.NEW>2011-06-20T13:18:39.50Z</CDI.NEW>
<CDI.MERGE>2011-06-20T13:24:26.44Z</CDI.MERGE>
<CDI.CDI>2011-06-20T13:24:58.70Z</CDI.CDI>
<CDI.RUN>2011-06-20T13:25:10.39Z</CDI.RUN>
<CDI.DONE>2011-06-20T13:25:29.63Z</CDI.DONE>
</StateInfo>

• Statistics and valuable accounting information.

For example:

<PlateInfo>
<Plate.PlateJobId>20jun15_24_49_stry_Kstr945str1@76298443584</
Plate.PlateJobId>
<Plate.MediaType>Plate</Plate.MediaType>
<Plate.TotalArea>263537.4</Plate.TotalArea>
<Plate.UsedArea>26356.48514455161</Plate.UsedArea>
<Plate.TotalUsedArea>79069.45543365483</Plate.TotalUsedArea>
<Plate.Manufacturer>Flint</Plate.Manufacturer>
<Plate.Brand>ACE_114</Plate.Brand>
</PlateInfo>

Monitoring the Waste per Plate

Waste per plate can be monitored using the PlateJobId (unique to each plate).

You can calculate the total amount of waste per plate as follows: TotalArea - TotalUsedArea

Monitoring the Cost per Separation

To calculate the plate cost per separation, multiply the UsedArea value by the cost per square unit.

To take into account the plate waste, you can use this: (UsedArea/TotalUsedArea) x Plate Waste.

In the Tasks View

After running the Make Plate on CDI Task, you will get detailed feedback in the Tasks view (and the Tasks pane of
the CDI view in Job mode).

You will see the following statuses:

• NEW job in Merger JDF list,
• Job in Merge editor (while the Digital Flexo Suite operator is placing the job files on the virtual plate),
• Job Sent to the CDI Queue,
• Job Running on the CDI,
• Job Completed on CDI.

Once the plate is made, you will see a green check  (or a red cross  if there was an error).

In the CDI View

The CDI view shows all the files sent to the Digital Flexo Suite and used to image a flexo plate on a Cyrel Digital
Imager.

You can view the flexo plates created for all jobs (in Job Overview mode) or for a particular job (in Job mode). You

can also use the filters to only view certain plates (or click  to define your own filters).

You can double-click an entry in Job Overview mode to see all the plates and LEN files corresponding to that job in
Job mode.

You can also select an entry to view its Details (in Job Overview mode), or the related task (in Job mode) at the
bottom of the window.
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For each plate, you can see valuable:

• administrative information (Order ID, Customer Name...),
• technical information (plate Manufacturer, Type and Thickness, imaging Device),
• production information (Launched date, Due Date, Priority...),
• accounting information (UsedArea and Waste).

Tip:  Go to  View > Select Columns in 'FlexoPlates'...  to pick the information to show or hide.

You can also see the plates' status in real time.

Statuses

In Job Overview mode, you will see the following statuses:

• Queued on CDI,
• Done or Done, with errors, or Done, with cancellations.

You can also see the number of plates that are ready in the Done column. The status will be Queued on CDI until all
plates are ready.

In Job mode, you will see:

• NEW job in Merger JDF list,
• Job in Merge editor (while the Digital Flexo Suite operator is placing the job files on the virtual plate),
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• Job Sent to the CDI Queue,
• Job Running on the CDI,
• Job Completed on CDI,
• Exposed,
• Error or Cancelled if applicable.

Checking the Files

In the CDI view, you can:

• Open the LEN file(s) in the Viewer: right-click the entry (in Job or Job Overview mode) and select View.

You can then show / hide separations using the Viewer's Channels panel.
• Go to the LEN file(s) in the Files view:

• in Job Overview mode, right-click the entry and select Go To Folder.

This opens the job folder and the subfolder containing the LEN files.
• in Job mode, right-click the entry and select Go To File.

This opens the job folder and the subfolder containing the LEN files, and selects the LEN file.

Re-exposing the Plate

If one or several of the plates need(s) to be re-exposed (it turned out wrong, or broke coming out of the CDI or after a
number of print runs), it can easily be sent to the Digital Flexo Suite again.

1. Use the filters to find the right (set of) plate(s).

2. Right-click the desired plate entry and select Go To Workflow to open the workflow used to process the file in
the workflow editor.

3. Right-click the workflow step where you want to relaunch processing from, and select Relaunch.

For example,

• if the resolution of the LEN files is wrong, relaunch from the RIP.
• if the plate broke, relaunch from Make Plate on CDI.

Attention:

Make sure you have kept the LEN files if you are relaunching the workflow after the RIP step!

We recommend you either:

• Save them somewhere consistent and easy to find in your job folder structure, for example using:
 

 
• Save them in an external location if you have the habit of quickly deleting jobs (but if you delete the

job without deleting its folder and files, you can still store them in your job folder).

Manage Milestone

Use this task to automatically change a certain milestone's status from Pending to Completed for your job.

Set all pending actions of the following milestone in state "Completed": select the milestone you want to set as
"Completed".
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Create the milestone if it does not exist: if the milestone you selected wasn't added to the job, you can select this
option to add it (it will be created with the "Completed" status).

Automatically confirm the milestone:

• Select this if you want to set the milestone as "Confirmed".

If one or more tasks are waiting on that milestone to be confirmed, they will (all) be started.
• Deselect it if you are still waiting for a confirmation.

You can use this to pause a workflow until the files are approved for example.

 

 

When they are approved, set the milestone as "Confirmed" (either from the Tasks pane, the Milestones view or
via a JDF file from your MIS system), and the next task(s) will start.

Note:  If you experience problems with an old custom Manage Milestone ticket, we recommend you recreate
this ticket from the latest default Manage Milestone ticket.

For more information about Milestones, please see Milestones on page .

Manage Product Status

Insert the Manage Product Status task in a chain to automatically update the status of the Product.
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Mark as Proof

Note:  This task is used only in page workflows.

The Mark as Proof ticket can only be used in a chain, for example in combination with the Proof (Imposition) to PDF
File ticket. It is used to make the proofs appear in the Proofs View. Automation Engine offers a ready-made Export
Imposition to PDF File workflow ticket, which contains the export ticket, linked to the Mark as Proof ticket.

The Proof Set Name will by default be indicated as [File].[File Type], but can be addapted with SmartNames or hard
text.

 

 

Mark File

Note:  This is deprecated from Automation Engine 10. You can use the Mark workflow control in the
Workflow Editor instead.

This tasks marks the input file. Use it in a chained task ticket, in combination with the Copy or Move File and / or the
Delete File task.

Normalize PDF File

Section 1

Text

Colors

Use the Colors tab to define the conversion settings needed when converting the document's (non-process) colors
during Normalization.
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Note:  The conversion is done by Esko's Color Engine.

Objects With Profile Tags: In this parameter, choose how to convert non process color images that have an
embedded ICC profile. Choose either:

• Ignore Tag to use the Default RGB Profile or Default Gray Profile set in this tab to convert the RGB or gray
images. This disregards the images' own profiles, and is the default option.

• Convert Using Profile Tag to use the images' own profiles to convert them to CMYK.

Rendering Intent

• Relative (No Background): Use this option if you do not want any background simulation. The white point of the
source will be mapped on the white point of the destination process. This rendering intent takes into account the
ability of the human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped on white of
destination colorspace). Use this option if you don't care too much about an exact color match but you want the
pictures at least to look nice on your proofer. It will give a visually pleasing result. If the gamut of the source is
wider than the proofer, the entire gamut is shrunk so that it fits inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an exact color match,
including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent will map saturated
colors on saturated colors.

Default CMYK Profile: Select the default profile to use for CMYK objects without an embedded color profile. It
will be used as a source profile for colorspace conversions.

You can choose any CMYK profile in the Color Engine database.

Default RGB Profile: Select the default profile to use for RGB objects without an embedded color profile. It will be
used as a source profile for colorspace conversions.

You can choose any RGB profile in the Color Engine database.

Default Gray Profile: Select the default profile to use for gray objects without an embedded color profile. It will be
used as a source profile for colorspace conversions.

You can choose:

• any gray profile in the Color Engine database,
• Convert to Black Channel, if you want your grayscale object to only have a value in the Black separation when

outputting it to CMYK.

Output Color Profile: Enter the colorspace of the output device (e.g. proofer or press) in this parameter.

You can choose any CMYK profile in the Color Engine database.

Separations

Use the Separations tab to define ink specifications for the input file. These ink specifications will be used when you
edit that file with an Esko editor.

Note:  The settings in this tab only affect Normalized PDF output. They are ignored if the file is output as a
regular PDF.

1. Choose your Preferred Ink Book.

When you type an ink name in the table, Automation Engine will first look up its color information (CMYK,
RGB, or LAB values), or ink type (Technical, Varnish, Opaque...) directly in the PDF.

If it cannot find it there, it will look it up the Preferred Ink Book you define here.
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For example, if you type 154 as ink name, and your preferred ink book is Pantone Colors Uncoated,
Automation Engine will automatically suggest the PANTONE 154 Uncoated ink.

2. Enter the name of the first ink to define in the Ink Name column.
3. The Ink Book column shows the first ink book containing this ink (or your Preferred Ink Book if it contains the

ink). To select another ink book, click the ink book name.
4. If the Ruling, Angle and Dot Shape information are defined for this ink, they will be shown automatically.

If they aren't, you can enter them manually.

Note:  You can also specify Default Values to use when a ruling, angle or dotshape is not specified.
 

 
5. If the Ink Type shown is not correct, you can click it to change it.
6. Do the same for the remaining inks you want to define.
7. If desired, you can change the ink order using the Move Up and Move Down buttons.

Normalize PostScript / PDF / Illustrator 8.0 File

Note:

• The PostScript / PDF interpreter extracts fonts embedded in PostScript, Illustrator and PDF files. Only
Type 1 fonts embedded in a PostScript / PDF file will be extracted.

The extracted fonts will be installed locally automatically.
• For copyright reasons extracted fonts can only be used to view and output the particular PostScript, PDF

or Illustrator job containing the font.

Any other use of that font (for example editing the text) requires a license of that font.

Tip:  When using an XMP XPath SmartName in the Output field of a Normalize PostScript / PDF /
Illustrator 8.0 File ticket, and the XMP XPath cannot be resolved (because there is an error in the
SmartName or, for some reason, the queried data cannot be found), the output file is saved in a /
xmp_unresolved subfolder.

Pages
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Select All Pages or specify a Range of pages.

Split up a multipage file

Check the box to divide the original multipage PostScript file into smaller parts. You define the amount of pages to
open (of the specified pages or range). What you need to know:

• Each part is stored as a separate Normalized PDF file. It is either stored locally or stored in the Output Directory.
• Each part is stored with the name of the imported PostScript file followed by _001, _002, _0001_001... or it gets

the Output Name.

Compose a Group of CT Images into 1 CT Image

Some ArtPro files have tiled CTs, those are CTs which are actually divided into a number of little CTs (tiles). Some
jobs are so large that there are thousands of these little CTs.

Select this toggle to merge the tiles into one CT to improve the editability of the Normalized PDF and to optimize
further processing.

This option is selected by default, it doesn't matter if you import a file with no tiled CTs.

Note:  When errors occur when a PostScript file is imported (for example a font is not found), the Merge
Tiled CTs to one CT will not be performed.

Merge Separated file to Composite

Merges separated single-page and multipage PostScript or PDF files to a composite file.

Optimize Merged File

This option optimizes the merged file. This is useful when you need to edit the imported file. This option becomes
available when 'Merge Separate File to Composite Page' is activated.
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Note:  When errors occur when a PostScript file is imported (for example a font is not found), the Optimize
Merged PostScript File will not be performed.

Password: You can enter a password for protected PDF files.

Color Management

 

 

Destination Color Space

Here you define what colorspace the opened/imported document will have.

Colorspace:

• CMYK
• Grayscale

Destination Profile: choose a color profile from the list. Currently only CMYK and Grayscale profiles are supported,
you can choose between standard ICC profiles and Esko profiles made in Color Engine Pilot.

Use PDF Output intent if available: in some PDF files, the PDF Output intent is defined (for example PDF/X-3).
(The output intent is the intended output color space.)

If you want to use the color space as defined in the output intent, select this option. If you selected it for a file without
PDF Output intent, the chosen Destination Profile will be used.

Rendering intent
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• Relative (No Background): Use this option if you do not want any background simulation. The white point of the
source will be mapped on the white point of the destination process. This rendering intent takes into account the
ability of the human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped on white of
destination colorspace). Use this option if you don't care too much about an exact color match but you want the
pictures at least to look nice on your proofer. It will give a visually pleasing result. If the gamut of the source is
wider than the proofer, the entire gamut is shrunk so that it fits inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an exact color match,
including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent will map saturated
colors on saturated colors.

Set Document Profile

A Document Profile is the color space of the process inks used in the document.

• Always: you can 'tag' a Normalized PDF file with its Document Profile. This means that the file 'knows' what its
Document Profile is, which may make further color conversion throughout a workflow more correct.

If you selected the Use PDF Output intent if available option, the Document Profile will be the same as the PDF
Output intent (if the imported file had one).

• From PDF File: the Document Profile is taken from the PDF file, if there is an output intent defined in the PDF
file (this option is only available when the Use PDF Output Intent option is selected). If there is no Output Intent
defined in the PDF file, then the Document Profile is not set (untagged).

• Never: the Document Profile is not set.

Spot Colors

PANTONE inks

• Keep All: No PANTONE inks will be converted to process inks.
• Convert All: All PANTONE inks will be converted to process inks.
• Keep list: All PANTONE inks will be converted except for those listed in the Inks tab.

Method

• Use Destination Profile: PANTONE and Designer inks will be converted using the selected Destination Profile.
This gives the most accurate color reproduction.

• PANTONE Solids to Process (Euroscale). PANTONE inks will be converted to process inks according to a fixed
conversion table provided by PANTONE. The result is independent of the selected Destination Profile. This
assumes the Euroscale print conditions.

• PANTONE Solids to Process (SWOP). PANTONE inks will be converted to process inks according to a fixed
conversion table provided by PANTONE. The result is independent of the selected Destination Profile. This
assumes the American SWOP print conditions.

Designer Inks:

• Keep All: No Designer inks will be converted to process inks.
• Convert All: All Designer inks will be converted to process inks.
• Keep list: All Designer inks will be converted except those listed in the Inks tab.

Note:

If the 'Flatten PDF transparencies and layers' box is checked and you select 'Convert all' or 'Keep list', the
color conversion may give unexpected results when overprint is involved.

RGB

RGB will always be converted to process inks during import.

RGB Method:Select one from the list
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• Source to destination profile: the user needs to specify both the Source Profile (RGB) and the Destination Profile
(CMYK or Grayscale).

• With Link profile: the user specifies a Color Engine Pilot Device Link Profile. this Link Profile implicitly
determines the Source and Destination profiles.

Source Profile / Link Profile: Select one from the list.

Objects with RGB Profile tags: The RGB objects in a PostScript or PDF file may be tagged with a Color Profile.

• Convert using the RGB Profile tags: The user may choose to use that Color Profile as a Source Profile
(overruling the Source / Link Profile selected above).

Tip:  In strictly controlled workflows, the embedded tags are probably accurate, so this option may be
preferable.

• Ignore tags: the embedded Color Profile will be ignored, the Source / Link Profile defined above will be used
during conversion of RGB objects.

CMYK and Gray

The CMYK objects in a PostScript or PDF file may be tagged with a Color Profile. The color percentages of untagged
objects will always be preserved. For tagged objects, users have a choice:

• Ignore tags, preserve percentages: the Color Profile tag will be ignored, the percentages will be those of the
object's color.

• Convert, preserve appearance: the objects' color profile will be taken into account; this means that their color
values will change.

The Gray objects in a PostScript or PDF file may be tagged with a Color Profile. The color percentages of untagged
objects will always be preserved. For tagged objects, users have a choice:

• Ignore tags, preserve percentages: the Color Profile tag will be ignored, the percentages will be those of the
object's color.

• Convert, preserve appearance: the objects' color profile will be taken into account; this means that their color
values will change.

Inks
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Use rulings, angles and dot gain compensation from PostScript file if available: If the PostScript file contains
rulings, angles and dot gain compensation, these will be used when this toggle is selected. Other settings in this tab
will be overruled.

Force Ink settings from Job Setup: If inks were defined for your Job setup, you can use this toggle to make sure the
Normalize PostScript / PDF / Illustrator 8.0 File task uses these parameters.

For more information, please refer to the section on Job Parameters.

Apply Screen Swap Table: Select a screen swap table from the list.

Map PANTONE Inks to: Enable this option to map all Pantone inks found in the source file to the Pantone ink book
of your choice.

For example, if you enable this option and select the Uncoated ink book, any Matte or Coated Pantone inks will be
automatically mapped to the nearest equivalent Pantone Uncoated ink.

Search Custom Ink Names: Determines how Automation Engine searches for inks in its ink books when you type in
an ink name in the Inks table.
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Choose Only in the ink book 'designer' to search for ink names from the "designer" ink book only; or choose
First in <your ink book> and then in designer to search in another ink book of your choice first, and only use the
designer ink book if no match is found there.

Inks table: double-click the fields to edit them. Select one or more inks to limit the effect of the task to those
separations.

Default values, used when a ruling, angle or dotshape is not specified: Enter the default values for ruling angle
and dot shape, the system will take these values when they are not specified elsewhere (i.e. in the PostScript file, or in
Job Parameters...).

Overprint

 

 

Strict overprint behavior

CertIn (the Esko input module) will honor the overprint parameter 100% according to the rules mentioned in the
"PostScript Language Reference" (in case of PostScript / EPS /AI import) and "PDF Reference Manual" (in case of
PDF).

This option must be set when the user wants to process test files like the Altona test suite or other test suites which
verify overprint behavior correctness.

This option controls how zero percentage inks are handled when reading composite files.

When Strict overprint behavior is switched on all zero percentage inks of a color are kept and correspondingly
affect the overprint behavior.

When Never strict overprint behavior is selected, all zero percentage inks are removed.

• Never strict overprint behavior: all zero percentage inks are removed
• Always strict overprint behavior: CertIn will honor the overprint parameter 100% according to the rules

mentioned in the "PostScript Language Reference" (in case of PostScript / EPS /AI import) and "PDF Reference
Manual" (in case of PDF import).

• Only strict overprint behavior for PDF: CertIn will honor the overprint parameter 100% according to the rules
mentioned in the "PDF Reference Manual" (in case of PDF).

Overprinting default is non-zero overprinting
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Prevents overprinted objects with zero CMYK values from knocking out CMYK objects beneath them.

Default: To set the overprint mode that the conversion needs to apply when importing the file.

• Opaque: Ignores any overprint of your job.
• BG Overprint: Converts all overprint present in your PostScript job to BG Overprint.
• PS Overprint: All PS overprint present in the job is imported correctly. (This is the default setting.)

Pure Black: To set the overprint mode for objects containing 100% black only. Possible Pure Black overprint modes
in the list:

• Default: As it is defined in the job.
• Force Opaque: Forces Opaque for objects in 100% black and knocking out all underlying inks.
• Force PS Overprint: Forces PS overprint for objects in 100% black.
• Force BG Overprint: Forces BG overprint for ALL objects in 100% black. The black color is printed on top of

other colors, instead of erasing the color underneath.

Note:

There are two problems:

• Sometimes ink saturation can occur.

100% black text on a 100% red (this is, 100% magenta and 100% yellow) background, results in three
inks printed at 100%.

• Black is best handled as knockout for flexo, since it is better to add a small trapping region than to
make the complete black region overprint.

Rich Black

Set the paint mode for objects containing 100% black and at least one other ink.

• Default: As it is defined in the job.
• Force Opaque (masking): Sets the overprint mode to opaque for all objects containing 100% black and at least

one other ink.
• Force PS Overprint: Keeps the PS overprint for objects in 100% black and at least one other ink (overprint

objects stay in overprint and opaque objects stay opaque).
• Force BG Overprint: Sets BG Overprint for all objects in 100% black and at least one other ink.

White

Possible white paint modes to select from the list:

• Opaque: Forces all objects in white to opaque.
• Keep PS Overprint: Keeps the PS overprint for objects in white (overprint objects stay in overprint, opaque

objects stay opaque).

Images
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Embed all images Toggle this on if you want to embed all 1–bit, 8–bit and native images. If the box is not checked,
then only images with uncompressed image data smaller than 640 kB will be embedded.

Optimize DCS LineWork Without linework DCS optimization, the result after conversion of linework DCS files
can be difficult to edit afterwards. However it will be correct when viewed in extended preview or RIPped. 'Optimize
DCS Linework' will do an additional operation to combine the elements on each DCS plate to a composite and a more
editable result.

Search Preconverted Files This option forces the system to look for the GRx, CT or LP equivalent for the original
EPS file. If this equivalent is not found, it will use the EPS instead.

Link External Images (OPI, DCS, Helios, ...) Force the system to look for referenced images.

Fail if not Found Activate this option if you do NOT want the system to continue importing / normalizing your
PostScript file when it cannot find an image. When this option is not activated the imported (E)PS file will appear on
screen but without the missing images.

Images Determines how images are treated when the task is run:

• Use Most Recent: forces the system to use the existing images of a previous conversion of the same job.
• Reconvert: forces the system to regenerate the images on-the fly.

Use Masks Available in the list are:

• PS Mask: Forces the system to take the PS mask present in the EPF file. The mask available in the external image
is discarded. If no PS mask is present in the file, no mask will be taken.

• External Mask: if any, PS Mask otherwise: Forces the system to take the mask present in the external image.
The PS mask is discarded. If the external image has no mask, but there is a PS mask available in the EPF file, this
PS mask will be taken.
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• External Mask: if any, no mask otherwise: Forces the system to take the mask present in the external image.
The PS mask is discarded. If the external image has no mask, no mask will be taken.

• No Masks: The PS mask and the mask of the external image are discarded.
• Joined External and PS Mask: Forces the system to join the available PostScript mask in the EPF file and the

available mask in the external image.

Search directories. To specify a list of directories to look for referenced images.

Use the 'Add'  and 'Remove'  buttons to optimize the Search Directories list.

Clicking  opens the directory selector.

You can browse to the correct directory and click OK to add the directory to the Search Directory list.

Note:  You can also use SmartNames in the Search directories.

Path Translation To define an understandable link for paths from a platform to another platform. The Path
Translation dialog opens, it has three columns:

• From platform: Use the list to select a platform from which the files are to be retrieved: NT, Macintosh, Unix or
VMS.

• From path: specify the syntax of the path(s) of the platform you want to retrieve files from. For example
Mywork:PostScript:job1

• To Path: define the syntax of the paths so that the destination platform understands. For example Mywork/
PostScript/job1

For example, when going from Macintosh to Windows NT, the path translation would look like this:

 

 

You can do the same for files: File Translation.
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Page Size

 

 

The default page size is PS Page Size. PS Page Size is the page size found in the selected PostScript file for import.
The list displays all possible options (Custom, A5...).

Reader's Spread: To determine how the PostScript file, which has reader's spread format, must be opened.

• Single Page: Forces the reader's spread in the PostScript file into single page output.
• Double Page: Forces PS File into reader's spread format. When the PostScript file contains no reader's spread

info, the single pages will be set as double pages.

Scale vertical : To enter the vertical scale percentage. 100 % is the original size of the PostScript file.

Scale horizontal : To enter the horizontal scale percentage. 100 % is the original size of the PostScript file.
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Rotate : Forces the system to rotate the PostScript File with the specified angle. The origin for rotation is bottom
left.

Possible angles in the list:

• 0: No rotation is to be performed.
• 90: Forces to rotate over 90 degrees counterclockwise
• 180: Forces to rotate over 180 degrees.
• 270: Forces to rotate over 270 degrees counterclockwise.

Offset : The original offset is Bottom Left.

Specifying a positive vertical/horizontal offset moves your PostScript file upwards/to the right in relation to the
bottom/right border.

Specifying a negative vertical/horizontal offset moves your PostScript file downwards/left in relation to the bottom/
left border.

Other

 

 

Substitute Missing Fonts

Roman Fonts by: Choose a default replacement font for the missing fonts for this job on your system.

Japanese Fonts by: Choose a default replacement font for the missing fonts for this job on your system.

Fail if Font Not Found: The task will fail if the font is not found.
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Images

Import 1-bit images as:

• Intern: Images become internal black and white bitmaps.
• Extern: Images are imported as external referenced LP files.
• Contours: Images are contourized during import of the (E)PS file.

CT display images: Choose Yes to create a display image for the generated CT files on-the-fly.

Output file display images: Select the type of display from the list: None, Thumbnail or Image and Thumbnail.

Miscellaneous

Device resolution: The resolution used internally by CertIn during the normalization.

Normally the produced output is not dependent of this internal resolution but in some rare cases like when converting
RIP test strips or device specific tests it is important that this value is the same resolution of the final RIP device
which will be used to print output.

Virtual Memory limit: The default value for the virtual memory is 50MB. The limit is set on 1 gigabyte.

Convert text to contours

Note:  Conversion might increase the file size.

Workaround Options

Skip Images: To open the (E)PS file without linking to external images or converting embedded images.

Preserve Quark trapping: Forces the system to keep the trap strokes made by QuarkXpress.

Disable optimizations: Vignettes recognition and optimization for Photoshop Multitone images are performed
(whenever possible) when this option is not activated.

Sometimes after updating your DTP applications, Esko can no longer perform the optimization and the conversion of
the (E)PS file might fail. Switching this option ON will allow you to import the (E)PS file.

Show PS comments: All PS comments present in the (E)PS file are displayed on screen.

Disable OPI: This option is valuable when you are importing (E)PS files of QuarkXpress containing high resolution
Tiffs files for which the option 'Include tiff, omit ...' or 'Include all' was activated.

In this case, when importing such a file and if Link External Images is activated, the matching for the TIFF files will
surely fail. It fails because at the time the (E)PS file was generated OPI commands were also inserted for the TIFF
files.

Therefore the system will try to link to images for the Tiff files. To overcome this, activate Disable OPI.

Show external images searches: Displays the path(s) in which the system has found and linked to external images.

Optimize Illustrator Patterns: Illustrator writes patterns in a different way than PostScript does, default behavior is
that Illustrator patterns will be optimized.

Normally this speeds up the further processing (less linework in your file) sometimes, though, the optimization itself
may take some time.

Use PostScript rules for color conversion: This toggle makes sure that all color management will happen using
PostScript rules, instead of BGCMS. Most options in the Color Management tab will be grayed out.

Recognize ArtScreen (lpi-angle): Check this box and the application will try to recognize screens that are created in
ArtPro applications and swap them to Esko screens.

If a (E)PS or PDF file with an unknown ArtScreen is imported, an error will be generated.

For more information, please refer to the ScreenFilter user manual.
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Object Based Color Conversion: Object by object color conversion does not take overprint and transparency
interaction between objects into account, and may therefore produce undesirable results. However, it may greatly
improve editability.

Output

As a CT folder is no longer automatically created in every new job folder, you can specify your own favorite local
images folder here.

 

 

Image Creation Path

Browse to a location or define one with SmartNames.

If, during normalization, extra image data is created, you can indicate here where these images should be written.

If no output directory is specified, then CT images generated during the conversion will be saved in the current
working directory.

Limit Filename Length to Maximum 31 characters

Use this toggle if you want to make sure your imported files can be seen/read from/by all Apple operating systems
(CTs that are kept on a Windows share but might be edited on a Mac for instance).

Keep Layers

Keeps the Illustrator layer information. This will only work for Illustrator 8 files. It will not work for native Illustrator
9 files (or higher).

When normalizing PDF 1.5 files (or higher), the 'Keep Layer' option will also preserve the PDF layers.

Fit Media Box (margins)

Allows you to automatically fit the margins.

Optimize and Clean (PSFix)

PSFix is a type of technology that will optimize and clean up ex-PS/PDF data: removing redundant objects is a
typical action. The optimization and clean-up will speed up further processing. PSFix is typically executed right after
normalization to Normalized PDF.
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General

 

 

Delete

• Spurious Contours are:

• Single points that only have a fill attribute.
• Single points that have a stroke attribute with but or square caps.
• Contours that contain two points, that have a mask attribute, but do not mask out any object. These contours

can be created by accident or generated by PostScript printer drivers.
• Double Contours: removes double contours by recombining the fill and stroke attribute of two identical objects

into one object again. Double contours are created when importing PostScript files, in which case an object with a
fill and a stroke attribute is split into two objects with each one attribute.

• Gross Clipping: selects and deletes the objects whose bounding boxes fall completely outside the bounding box of
the clipping path. Gross Clipping can also be applied on composed text and externally referenced objects.

• Useless Clips: Selects and deletes useless clipping paths, objects that are totally clipped away or objects that are
totally covered by other objects.

• Hidden Objects: Selects and deletes objects that are covered completely with another object, because the designer
did not want to delete them or could not delete them on a certain page, as they were components of a master page.

• Contours outside margins: Selects and deletes contours outside the margins.
• Clean up unused inks: Automatically removes all unused inks.

Strokes
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• Regenerate Strokes: searches and selects simple objects that contain 20 points or less and converts them to the
equivalent strokes.Select the 'Select Complex Objects too' toggle if you want the system to search all objects that
might be degenerated strokes, instead of limiting the search to objects of less than 20 points.

• Minimal Linewidth defines the minimal width for strokes.

Correct

• 'Blend to CT' converts all recognized blends in the job to externally referenced CT objects.

In PostScript files, blends are constructed by a large amount of contours that lie close to each other and that have
slightly different colors. The more accurate the blend, the more contours and colors. This leads to very large jobs
and decreases the processing speed.

For each detected blend, 'Blend to image' creates 1 image.

Note:  After conversion to different images, the display of the blend can change. However, the conversion
does not affect the printed result.

'Resolution' defines the resolution of the blend that was converted into a CT.
• 'Simplify Linked Mask Objects' will try to reduce the number of linked contours for complex mask objects. This

option is only useful for linked mask objects with a huge number of contours (>50). When used with a lower
number, PSFix will become less powerful and it will have no effect whatsoever on the complexity of the mask
object.

 

 
• Fix bleed: It is a common occurrence for pages to be supplied without any bleed. This means that either a new

page has to be sent or the page has to be manually corrected in PackEdge. Especially the latter can be a time-
consuming process. "Optimize and Clean" (PSFix) now has the capability of fixing this problem automatically, by
adding bleed where there is none, or not enough. There are three parameters to control the process:

• 'Bleed Distance' is the amount of bleed that is required. For any object that does not have this amount of bleed
the correct bleed will be created.

• 'Gap': any object that is inside the borders, and that is closer than this distance to the borders will be considered
to require bleed. Typically, this value will be small. It makes sure that objects which do not really touch the
borders because of inaccuracies in the design, are taken into account for bleed creation anyhow.
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• 'Maximum Image Scale': in the case of linework objects all the bleeds that are created are added to an
additional layer called "Bleedlayer". This layer can be removed at all times to return to the original file. This
is not possible with images, however. Images are modified in their original location. There are two possible
ways in which images can be handled. When an image is larger than its clip mask, it is possible to create
bleed by extending the clip mask of the image; hidden pixels will become visible and the missing bleed
problem is fixed. When the image is not larger than its clip mask, the only way in which bleed can be created
is by scaling the image. When doing so, the position of the image inside the page does not change, but it is
disproportionately scaled to create the correct bleed. To avoid an unacceptable distortion of the image this
parameter determines how much scaling of an image is allowed. If no scaling is desired, then the value can be
set to 0.

In order for the bleed-fixing to work properly it is imperative that the borders of the file are set correctly. "Optimize
and Clean (PSFix)" also has functions to correct borders and it now also has a new function to set the borders of a file
automatically to the trim marks.

When no bleeds have been corrected the exit status of the Automation Engine task will be OK (green). When bleeds
have been corrected, the exit status will be a warning (orange), and when the maximum scale factor was not enough
to create bleed for an image an error will be generated (red).

Adjust Borders
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Select the Adjust Borders to make the options available.

To move any of the four borders numerically, to measure manipulations applied to borders and to save the borders
manipulation to an option file. This can be done separately for odd and even pages.

Fit borders to : select from the dropdown list:

• All inks
• Any ink in your file

'Auto fit borders on trim marks' tries to detect the presence of trim marks. When valid trim marks are recognized
the borders will be set accordingly. When not, the borders will remain unaffected. This feature is useful when the trim
size of the supplied files is unknown and unreliable (for example missing or wrongly defined TrimBox in a PDF file)
and the user wants to determine it automatically. Even when the desired trim size is known to the user, it can still be
interesting to see if the automatically determined border size corresponds to the desired one: a difference between the
two is likely to point to an error. Users very often neglect to work with accurately set borders, because the intelligent
placement of files in FastImpose and Plato does not require them to do so. However, if you want to use the function to
fix wrong bleeds it is a requirement to have the borders defined correctly.

You can define the borders:choose Even and/or Odd and fill out the specifications for Top, Bottom, Left and Right.

You can load a Borders Adjust file (.psbaf file), you can create such a file in the interactive editor.

Set Margins: enter a value for the margins.

Optimize PDF Document

The Optimize PDF Document task enables you to make some prepress-specific changes to a PDF document.

If you want to output the files in a different location, you can define that location in Output in. You can enter a path
manually, browse to a location, or use Smart Names.

If you want to give the output file a different name, enter it in File Name field. You can enter a name manually,
browse to an existing file to replace it, or use Smart Names.

Document

Select Preserve fonts if you want to make sure external systems receiving the PDF file can print or display the fonts
correctly. You can choose:

• Embed Fonts: this embeds all used fonts.
• Embed & Rename: this embeds Base 14 Fonts fonts under a different name (their name in the Esko PDF

Library), and all other fonts under their existing name. This prevents Acrobat from replacing the document font
with a local font of the same name when using live text.

Note:  Base 14 fonts are: Courier, Courier Bold, Courier Oblique, Courier Bold-Oblique, Helvetica,
Helvetica Bold, Helvetica Oblique, Helvetica Bold-Oblique, Times Roman, Times Bold, Times Italic,
Times Bold-Italic, Symbol and Zapf Dingbats.

• Vectorize: this converts all text to outlines.

Apply document's rotation flags: A rotation flag is a property of a PDF page that specifies by what angle the
contents should be rotated when previewing or printing the file.

Some older applications/output devices ignore or mishandle the rotation flag. If you are sending your file to such an
application/device, select this option to execute the rotation specified in the rotation flag (that is, actually rotate the
file's contents).

Expand forms: Enable this parameter if you want to replace forms with inline content.

Select Outline strokes if you want to convert the document's strokes to outlines. You can choose either:

• All: this converts all strokes to regular outlines.
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• Dash Only: this converts dashed strokes (only) into individual outline objects. This can significantly improve
trapping.

If you want to change the strokes’ width in your document, select Increase line width and enter the Minimum Line
Width to use. All strokes widths below this value will be enlarged to it.

Rotate Job: Use this parameter to change the rotation of the contents of your file by 0º, 90º, 180º or 270º.

• If Apply document's rotation flags is off, this changes the rotation flag's value but doesn't rotate the file's
contents.

• If Apply document's rotation flags is on, this rotates the file's contents.

Adjust Page Box: This option allows to change some or all of the document's page boxes, or add page boxes in your
document. See Adjust Page Box on page  for details.

Outline Page Box: This option allows to outline some or all of the document's page boxes. Use this if you want to
show the page boxes on proof (for example, you can outline the trim box to show where the artwork will be).

See Outline Page Box on page  for details.

Adjust Page Box

To add or change a page box:

1. Click the Add button. This opens the Adjust Page Box pop-up.
 

 

2. Select the Page Box to add or change.

3. Choose what you want the new page box size to be Based on:

• Choose Absolute if you want to define the page box size independently of the document's contents or existing
page boxes.

• Choose Content if you want to base the page box size on the document's contents. This takes clipping paths
and masks into account.

• Choose Media Box, Crop Box, Trim Box, Bleed Box, or Art Box if you want to base the page box size on
another one of the document's page boxes.

4. Determine the new Width and Height.

• If you have chosen to use an Absolute size, enter the page box's Width and Height.
• If you have chosen to base the page box size on the document's Content or on another page box, you can

adjust the width and height in Increase Width and Increase Height.

Note:

• Use a negative value to reduce the page box size instead of extending it.
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• You can use Smart Names.

5. If desired, enter an Horizontal Offset and / or a Vertical Offset.

• A positive horizontal offset will move the page box to the right, a negative one to the left.
• A positive vertical offset will move the page box to the top, a negative one to the bottom.

You can use Smart Names.

Note:  This is applied after the Alignment!

6. Choose the page box's Alignment (relatively to the old page box):
 

 

7. Apply your changes to either:

• All Pages,
• Odd Pages Only,
• Even Pages Only.

8. Click the Add button.

Note:  You can Remove a page box you have added.

Outline Page Box

To outline a page box:

1. Click the Add button. This opens the Outline Page Box pop-up.
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2. Select the Page Box to outline.

3. Select the Ink to use.

You can type in the Ink Name, use Smart Names, or click the color patch to open a color picker.

4. Enter the ink Density to use.

You can use Smart Names.

5. Specify the Stroke Width to use.

You can use Smart Names.

6. Click the Add button.

Note:  You can Remove a page box outline you have added.

Layers

Use the Layers tab to rename, remove, or add layers, as well as handle the PDF's layer visibility and printability.

Note:

• The layer functionality is executed in the order shown in the user interface (Action 1, Action 2...).
• You can use wildcards (*) in the layer names.

Action 1: Rename Layers

Use this parameter to rename layers.

Click Add to open the Rename Layer pop-up, then enter the Old Layer Name and the New Layer Name. You can
use Smart Names and / or wildcards (to replace part of the layer name).

 

 

Tip:

You can also merge layers by renaming a layer to an existing layer's name, or by renaming several layers to
the same name.

The layers to merge have to be directly on top of each other in the file.

Action 2: Remove Layers

Use this to remove layers from the file.
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Click Add and enter the names of the layer you want to remove. You can use Smart Names and / or wildcards.

 

 

Except for: When using a wildcard to remove layers, use this parameter to keep certain layers, even if they match the
name entered in Remove Layers.

 

 

Action 3: Add Layers

Use this to add empty layers to all pages of your PDF.

Click Add and enter the name of the layer to add. Repeat as necessary.

Update Layer Visibility: Select how to handle layers’ visibility in your document. You can choose either:

• Don't Change Layer Visibility,
• Make All Layers Visible,
• Remove Non Visible Layers.

Update Layer Printability: Select how to handle layers’ printability in your document. You can choose either:

• Don't Change Layer Printability,
• Make All Layers Printable,
• Remove Non Printable Layers.

Images

Downsample Images

Select this parameter if you want to downsample images’ resolution. This makes the parameters underneath it
available.

• Choose what resolution you want to Downsample bitmap (black & white or one-bit) images to, if their
resolution is above a certain resolution.

• Choose what resolution you want to Downsample contone (grayscale or color) images to, if their resolution is
above a certain resolution.

You can use Smart Names.

Crop Images

Select this parameter to crop images clipped by a clipping path to the rectangular bounding box of the clipping path.
This makes the Split images area... parameter available.
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Split images area when at least ... % of the images is clipped away: This parameter defines how the task will crop
the image, depending on how much of it is clipped away (for example, for images that have multiple clipping paths
on them).

• If the part of the images clipped away is less than what you enter here, the images will stay together and be
cropped to the bounding box of the combined clipping paths.

• If the part of the images clipped away is greater than what you enter here, the images will be split into multiple
clipped images, each cropped to the rectangular bounding box of its clipping path.

The default percentage is 50%.

Recompress Image Data

This option allows you to re-compress images in the PDF file. Selecting it makes the parameters underneath available.

• For Color, Gray Scale and Soft Mask Images, you can choose between the JPEG and ZIP compressions.

For JPEG compression, you can choose between Minimum, Low, Medium or High Quality.
• For Bitmap Images, you can choose between the CCITT Group 3, CCITT Group 4, ZIP, and Run Length

compressions.

Note:  DeviceN images will always be compressed to ZIP files when Recompress Image Data is selected.

Optimize PDF Separations

The Optimize PDF Separations  task enables you to make changes to a PDF document's separations.

If you want to output the files in a different location, you can define that location in Output in. You can enter a path
manually, browse to a location, or use Smart Names.

If you want to give the output file a different name, enter it in File Name. You can enter a name manually, browse to
an existing file to replace it, or use Smart Names.

In File Type, choose if you want to output a PDF or a Normalized PDF file:

Colors

Use the Colors tab to define the conversion settings needed to convert the document's (non-process) colors.

Note:  The conversion is done by Esko's Color Engine.

Embed Profiles Mode: This parameter handles color profiles embedding. You can select:

• Do not change: this doesn't make any changes to color profiles embedding.
• Embed: this embeds all color profiles.
• Embed & Overwrite: this re-embeds all color profiles, overwriting profiles already embedded.
• Remove All Embedded: this removes all embedded profiles.

The task uses the embedded profile(s) as source profiles for conversions.

Convert RGB, LAB, Gray etc To CMYK: Enable this parameter to convert all non-process color spaces (except
spot colors) to CMYK.

Note:  This will generate errors/warnings when trying to convert non-separable blend modes.
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Fail When Converting Colorspaces: Converting color spaces that have blend modes can generate visually
unexpected results. For example, some blends modes in CalibratedRGB can't be converted 100% accurately to
CMYK, and generate a colorspace conversion error.

• Select this option if you want the task to end in error when this problem happens.
• Leave it deselected if you only want the task to generate a warning for this.

Default CMYK Profile: Select the default profile to use for CMYK objects without an embedded color profile. It
will be used as a source profile for colorspace conversions.

You can choose any CMYK profile in the Color Engine database.

Default RGB Profile: Select the default profile to use for RGB objects without an embedded color profile. It will be
used as a source profile for colorspace conversions.

You can choose any RGB profile in the Color Engine database.

Default Gray Profile: Select the default profile to use for gray objects without an embedded color profile. It will be
used as a source profile for colorspace conversions.

You can choose:

• any gray profile in the Color Engine database,
• Convert to Black Channel, if you want your grayscale object to only have a value in the Black separation when

outputting it to CMYK.

Output Color Profile: Enter the colorspace of the output device (e.g. proofer or press) in this parameter.

You can choose any CMYK profile in the Color Engine database.

Inks

Use the Inks tab to define how to handle inks, particularly spot colors.

Update spot color equivalents: This parameter handles CMYK values for spot color inks.

• Enable it to overwrite the CMYK values found in the file with the CMYK values stored in the ink book.
• Leave it off to use the CMYK values found in the file for spot color inks.

Spot Color Lookup: In this parameter, select where to look for the spot colors' information.

• Look in Ink Books First: the task first looks in the ink books you defined in the Preferred Ink Book option (see
Optimize PDF Separations  on page ) .

If it doesn't find the spot colors' information in those ink books, it then looks for it in the job.
• Look in Ink Books Only: the task only looks in the ink books you defined in the Preferred Ink Book option.

If it doesn't find the spot colors’ information in those ink books, it ends in error.
• Use Colors in File: the task looks for the spot colors’ alternate color values (generally in the CMYK color space)

in the file, and uses those values.

Pantone Color Lookup:

Use the following parameters to rename, convert or remove inks.

Note:  This functionality is executed in the order shown in the user interface (Action 1, Action 2...).

Action 1: Rename Inks

Use this parameter to rename inks.

Click Add to open the Rename Ink pop-up, then enter the Old Ink Name and the New Ink Name. You can use
Smart Names.
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Tip:  You can also merge inks by renaming a ink to an existing ink's name, or by renaming several inks to the
same name.

Note:  If your original ink has a PANTONE Suffix, add it to the Old Ink Name, even if you are changing this
suffix. This is because when you use both the Rename Inks and Pantone Suffix parameters, the task renames
the inks first.

Pantone Suffix: With this parameter, you can change the suffix (e.g. CV, CVC, CU...) of PANTONE colors.

• Do not change: this keeps the suffix as it is.
• Convert: this changes the suffix to the one you select in the To list, for all PANTONE colors.
• Convert If Found In Ink Books: this changes the suffix to the one you select in the To list, for PANTONE colors

found in the ink books you defined (see Optimize PDF Separations  on page ).

Note:  This can also merge inks (for example if you have PANTONE 484 U and PANTONE 484 C, and you
changing all the suffixes to C).

Action 2: Convert Inks

This parameter allows you to convert spot colors to CMYK. You can use wildcard characters (*) in the ink’s name.

Note:  This parameter is case-sensitive.

Action 3: Remove Inks

Use this to remove inks from the file.

Click Add and enter the names of the ink you want to remove. You can use Smart Names and / or wildcards.

Except for: When using a wildcard to remove inks, use this parameter to keep certain inks, even if they match the
name entered in Remove Inks.

For example, you can remove all the inks except the die cut ink, to send your file to the die-cutter.

 

 

Note:

• If you only use Except for and don't add anything in Remove Inks, no ink will be removed. You must
explicitly specify the inks to remove.

• These parameters are case-sensitive.

Preserve Separation Interaction: Use this parameter to define what to do when the separations you remove contain
objects knocking out on other separations.

• None: this only deletes knockout objects that are only defined in the removed separation(s).



Automation Engine | The Tasks: an Overview | 335

Use this when removing separations that don't influence the final result (e.g. die cut separations).
• Standalone: this converts knock-out objects that are only defined in the removed separation(s) to white knock-out

objects defined in one of the remaining separations. The remaining separations keep looking the same.

This method is recommended for most use cases.
• For Versioning: this converts knock-out objects that are only defined in the removed separations to white

overprinting objects.

Those are defined in a color space made from the remaining separations of the file, and overprinting on all other
separations.

This ensures that when re-adding separation layers for versioning, the final result looks the same as the original
file.

Note:  This may create objects in DeviceN color spaces, that some applications can't handle. Only use this
method if you want to do versioning on your file.

Remove unused separations: Enable this to remove unused separations (separations containing no objects) from the
file.

Ink Properties

You can define a list of Inks with associated characteristics to overrule the ink behavior of the incoming files.
Mapping of desired ink characteristics assure the printing requirements. However, these attributes must be consistent
for the entire workflow.

The Ink Properties tab allows to apply ink types and printing methods to the inks in native and normalized PDF files.
These properties can be used to steer behavior of tasks later on in the workflow, e.g. the Extract Inks task for printing
methods.
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Apply Ink Type : You can define the Ink Type for each Ink Name. The task will accept Ink Names containing
wildcards(asterisks).

Use Add to add an entry to the Apply Ink Type. You can type in the Ink name and Ink type or use corresponding
SmartNames.

Note:

• The Ink Name may contain wildcards (asterisks). In such instances, the inks matching the pattern of the
Inkname will have the specified properties set. If one ink matches more than one pattern, the first one is
taken.

• When matching, the letter case is ignored.

Ink Type can be:

• Normal, Opaque, Varnish, Technical. Limitations for opaque can be imposed by CMS.

Note:  process colors (CMYK) can only be normal

Use Add to add an entry to the Apply Ink Type. You can type in the Ink name and Ink type or use corresponding
SmartNames.

Apply Printing Method : Set the Printing Method corresponding to Ink name here. Choose from predefined
printing methods:
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• Offset, Gravure, Flexo, Letterpress, Screen, Inkjet, Toner, Thermal Transfer, Other, Unknown.

Note:  You can use SmartNames to specify Printing Method.

Note:  The task settings will overrule the incoming file settings.

Overprints

To Knockout

Use this tab to change the Overprint versus Knockout behaviour of inks in a PDF file.

All overprint objects: Select this to disable all overprints in your file.

Attention:  This can change the file's appearance.

White text: Use this to set white text to knockout.

White vector: Use this to set white line art to knockout.

Technical Objects: Use this to set technical objects to knockout.

Varnish Objects: Use this to set varnish objects to knockout

To Overprint

All knockout objects: This parameter changes all knockout objects to overprinting objects, and modifies their color
space(s), so that the file keeps the same appearance.

Attention:

• Only use this parameter in versioning situations.
• This parameter affects how you can place the file afterwards. If you place this overprinting file on top of

another file, all the bottom file's channels not present in the top file will be visible.

Black text: Use this to set black text to overprint. You can choose to make:

• All black text overprint,
• black text Smaller Than a value you define overprint.

Black vector: Use this to set black line art to overprint.

Technical Objects: Use this to set technical objects to overprint.

Varnish Objects: Use this to set varnish objects to overprint.

Opaque ink vector: Use this to set line art in opaque ink to overprint. Opaque inks are defined in the ink book.

Opaque ink text: Use this to set text in opaque ink to overprint. Opaque inks are defined in the ink book.

Outline Fonts

This task will contourize ALL fonts in a file (and in all files it refers to). All live and composed text will be
contourized. ‘Internal’ text (executed SmartMarks for example) is already contourized.

The task will save the output as a copy of the original job, and will add the suffix _c, this behavior can be overruled
by using SmartNames.
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Tip:

When you processed a file that did not contain any fonts, the details pane of the Tasks View will tell you so.

Preflight via External Application

The Preflight via External Application task allows you to preflight a PDF file by integrating external (non-
Automation Engine) preflight software into Automation Engine.

Using the Task in a Workflow

Note:  When preflighting in a workflow, the Preflight via External Application workflow step has four
output pins:
 

 

• Preflight OK: your files will go through this pin if the preflight gave an OK status, or if you chose
Task ends OK for When warnings appear in the ticket (and the preflight gave warnings). See Task
Parameters on page .

• Preflight with Warnings: your files will go through this pin if the preflight gave an error or a warning
(depending on what you chose in the ticket).

• Preflight with Errors: your files will go through this pin if the preflight gave an error or a warning
(depending on what you chose in the ticket).

• Error: your files will go through this pin in case of a processing error unrelated to the preflight status.

Supported Preflight Software

Third party preflight products that Automation Engine can link up to are:

• Callas PDFInspektor (batch version): versions 2, 3 and 4
• Enfocus PitStop Server: versions 3, 4, 8, 9 and 10

Note:  The preflight software should be able to run in the background.

Task Parameters

Tool: select a supported preflight tool from the list.

Note:

Changes made in the Enfocus PitStop Server application's preferences will not affect the Automation Engine
Preflight task.

To change the Report Language, Profiles and Action Lists folders, use Configure (go to Tools > Configure
> Preflight Tools).

Executable File: indicate the path to the preflight engine executable or dll (PDF Inspektor only).

Profile: browse to, or select a preflight profile from the list. Note that a profile can also contain action lists.
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Tip:  You can also create these preflight profiles with Adobe Acrobat Professional.

Action: use the buttons at right to Add or Remove actions from the list (only from PitStop Server 4). You can also
reorganize the list using Move up and Move down.

Attention:  Tickets created with versions of BackStage prior to BackStage 70R5 will be loaded with one
single action in the list.

Report: define the name and location of the preflight report file that will be generated. You can use SmartNames.

When rules are violated: choose what status you want the task to have when preflighting gives errors:

• Task ends with a warning
• Task fails

When warnings appear: choose what status you want the task to have when preflighting gives warnings:

• Task ends OK
• Task ends with a warning
• Task fails

Preflight Report

The Preflight Report file generated by the task contains the Errors and Warnings found by the preflight, and any
Fixes it implemented.

 

 

If you generated a PDF report, you can open it in the Viewer (or the application associated with this file type).

Preflight with PitStop

The Preflight with PitStop task allows you to preflight a PDF file in Automation Engine, without needing external
preflight software.
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This task uses the latest PitStop preflight technology.

Using the Task in a Workflow

Note:  When preflighting in a workflow, the Preflight with PitStop workflow step has four output pins:

• Finished OK: your files will go through this pin if the preflight gave an OK status, or if you chose Task
ends OK for When warnings appear in the ticket (and the preflight gave warnings). See Settings on page

.
• Finished with Warnings: your files will go through this pin if the preflight gave an error or a warning

(depending on what you chose in the ticket).
• Finished with Errors: your files will go through this pin if the preflight gave an error or a warning

(depending on what you chose in the ticket).
• Error: your files will go through this pin in case of a processing error unrelated to the preflight status.

Settings

Preflight Tab
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Action Lists: Use Add or Remove buttons to add/remove Action Lists. You can reorganize the list using Move up
and Move down.

Attention:  Tickets created with versions of BackStage prior to BackStage 7R5 will be loaded with one single
action in the list.

Profile: You can browse to, or select a preflight profile from the list. Note that a profile can also contain action lists.

Tip:  You can create these preflight profiles with Adobe Acrobat Professional.

When rules are violated: Choose your preferred status when preflighting rules are violated:
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• Task ends with a warning
• Task fails

When warnings appear: If preflighting gives warnings, you can set your preferred status from the choices:

• Task ends OK
• Task ends with a warning
• Task fails

Certified Tab

 

 

You can certify a PDF file in this task (for example, when a Pre-Media company wants certified files to be sent to the
Converter). This certification can be verified using Verify Certification task, for example in a converter's workflow
(Read more in Verify Certification).

• Set Certify to:

• Make Certified: to certify the file.
• Keep Certified: to preserve the existing certified/uncertified status of the file.
• Make Uncertified: to remove all the certified information from the PDF file.

If your choice is Make Certifiedor Keep Certified, you need to set the following items:

• User: fill in the user name to be added to the certified PDF.
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• E-Mail: fill in the E-mail that needs to be added to the certified PDF.
• Session Comment: use this space for comments.
• Allow to Roll Back: Enable (default) this, if you want the users to be able to roll back to previous sessions of

the file (e.g. to compare versions). If you disable it, users cannot roll back to previous versions. But the Certified
history will be in the file.

Report Tab

 

 

• Generate a Report : Enable this (default) if you want to gnerate a report of the preflighting session.
• Settings for the generated report :

Choose the settings according to your report requirements:

• Units : select from mm, cm, Pointand Pica.
• Language : choose from the list of eight major languages.
• Type : Set your preferred file type. Choose from PDF, PDF + XML and XML.

Read more in Preflight Report

Color Tab

You can correct color space errors (for example convert RGB colors to CMYK) in this tab. Select Enable Color
Management and choose the Grayscale, RGB, CMYK and Lab ICC profiles for color conversions.
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Preflight Report

The Preflight Report file generated by the task contains the Errors and Warnings found by the preflight, and any
Fixes it implemented.

Report: define the name and location of the preflight report file that will be generated. You can use SmartNames.

 

 

If you generated a PDF report, you can open it in the Viewer (or the application associated with this file type).

Prepare for Inspection

You can set measurement points in from the design which can be later monitored through an automated /sem-
automated inspection system. This will take a JDF-Layout file to create a JDF-Inspection file.

The JDF-Inspection file contains the layout of the sheet/sheets and for each one-up information on the following:

• the contour of the retained area (ClipPath)
• the location of the barcodes (IdentificationField)
• the location of the text areas (IdentificationField)
• the location and values of Spectrometer measurements (CIELabMeasurement)

The Prepare for Inspection task generates a preview of the one-up PDF files in RGB TIFF format, and a rendering
of the ClipPath as a monochrome mask in TIFF format. The task packs the results as a MIME file which can be
delivered to the inspection system as a single self-contained file. Read more about the task settings in Settings

Sample Workflow using Prepare for Inspection

This sample workflow starts with a PDFPLA Step and Repeat file. As a first step, you can export the file as a JDF
Layout file. This creates a JDF file and self-contained PDF files for each one-up.
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Prepare JDF for Inspection task uses this JDF layout to create the MIME file containing the JDF file and the TIFF
previews. Next task publishes this MIME file to a hotfolder to be picked up by the designated inspection system.

You can use the Router tasks to select the correct file as input file.

Preview and Cut Mask Samples

Speed Label One-Up:
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Preview Sample: Note that the cut contours are not visible in the Preview.

 



Automation Engine | The Tasks: an Overview | 347

 

Cut Mask Sample:
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Settings

Document Tab

Specify the output requirements here. You can output at each step of the processing separately as a Preview, Cut
Mask and or the entire results as MIME pack. You can enable/disable Create MIME pack, Render Preview and the
Render cut mask options.

Configure the rendering resolution via setting the Preview Resolution manually or via SmartNames.
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Add extra SmartName/ free text parameters such as a a "profile" dictating the settings for the inspection system
(for example, "commercial labels").Specify these free-text parameters for inspection system under Inspection
Parameters. Use Add or Remove to add or delete these parameters.

Separations Tab

Use this tab to indicate the selection of colors to be extracted (the “Die Cut” separations) and to specify the non-
printable (the technical ink separations) areas to be excluded.
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Specify the Separations to exclude from the preview under Exclude Separations. Enter the separations to be rendered
as cut mask under Cut Path Separations.

Prepare for Viewer

About View Data

The Prepare for Viewer task prepares View Data for the Automation Engine Viewer.

This View Data will help the Viewer to quickly open the file (the Viewer will use the prepared View Data instead of
asking the server to make or stream it).

Note:  When you start zooming in, there will be a point where the View Data is no longer sufficient and when
the server will be asked to stream ‘new’ data anyway. This point depends on the size of your file and the
zoom-in that you request.

How to Prepare View Data

You can prepare View Data manually, or in a (semi-)automatic way.

• Select a file and launch this task manually.
• Include this task in a workflow ticket (semi-automatic).
• Create View Data by activating 'Speed up for Viewing' on a folder.
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When should I prepare View Data?

Only create View Data when it is certain that the file reached its final state, preferably before the QA operator opens
the file. What you could do is add a checkpoint to indicate when the View Data is ready to your QA operator.

Using the Task

The Prepare for Viewer ticket, which allows you to generate View Data semi-automatically, has the following
options:

 

 

• Resolution for non-images: Optimal allows Automation Engine to use its own logic to generate the optimal
speed/quality compromise, Custom allows you to indicate a desired resolution manually.

• Anti-aliasing
• Automatic grouping of input files into digital film sets: will group digital film separations into sets that can be

combined for viewing a composite image.

For example, when the input files are 123_C.len, 123_M.len, 123_Y.len, 123_K.len, then these will be
grouped into one digital film set and rendered in a composite view.
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If you disable this option, all input digital films are grouped and displayed in a composite view, regardless of the
file names.

Fully Automatic View Data Generation

If you decide to use the Prepared View Data mode, you will want the data to be prepared as automatically as possible.

This can be done by setting an attribute to a specific folder of choice: Speed Up for Viewing. The fold er will get a

specific icon .

When Speed Up for Viewing is activated, Automation Engine will automatically launch the Prepare for Viewer
task on all Esko PDF and Esko PLA files in the folder which are new or have been changed (indicated by a changed
SmartID). You can Configure to indicate other file types.

The Speed Up for Viewing attribute of the folder can be inherited from other Jobs and it can simply be removed
again. It will be removed automatically when the Job is removed from the Automation Engine database, manually, via
the Archive task or via JDF.

Note:  Extra smart integration with Esko editors is guaranteed. When a file is being edited in PackEdge or
Plato, you definitely do not want to have View Data re-created every time you click Save. Of course, the
‘Prepare View Data’ task only starts and updates your View Data when you indicate that you have finished
the editing session.
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Prepare Graphics for Nesting

Use this task to extract graphics contours from graphic files using a cut path (this is especially useful when working
with irregular shaped graphics). If your graphics files don't have a cut path, you can create one automatically here.

You can also add SmartMarks and bleed to your graphic.

You can send PDF (single page or multipage), TIFF, PSD or JPEG files to this task. Progressive JPEG compression is
not supported.

1. Define the cut path:

• If you have a cut path in the file, select From Ink or Trim Box in Create Cut Path, and enter/choose the ink
used for the cut path in the Ink Name table below (the drop-down list will contain all inks used in the input
file).

You can Add several inks (for example if you have customers from different countries using different ink
names like cut, découpe, taglio...) and Move them Up or Down the list. The order is important as the
task will use the first ink it finds in the list as cut path.
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Tip:  Select Any SpotColor if you always receive CMYK graphics with one spot color used for the
cut path.

Note:  You can use wildcards in your ink names and/or SmartNames to retrieve ink names from the
graphic file.

Select Create cut path from trim box if no ink is found if you want to use the trim box to create a cut path
when a file doesn't contain any of the inks you specified.

• If you have a cut path in an external ArtiosCAD or PDF file, select From File and Browse to that file.
• If there is no cut path in the file but the graphic has a white background, select From White Background to

create the cut path from the contour of the graphic on the white background.

Note:  This works on lineart or pixel images, but only on PDF or JPEG files.

If your file has layers, you can select Flatten Objects to make sure the right contour is used.

2. Assign an ink to the cut path in Cut Path's Ink Name.

Even if you have extracted your cut path from an ink, you should do this to standardize cut path ink names across
files (especially when your files come from different customers).

3. If the graphic contains no color outside of the cut path, you can use Create Bleed to create a bleed.

In case of lineart graphics, the graphics will get enlarged, in case of contone graphics, the contone pixels will be
cloned.

You can specify a bleed distance or use a SmartName to retrieve that distance from the job setup.

4. If desired, you can add SmartMarks (that you created in i-cut Layout or PackEdge) to the resulting graphics.

For example, you can add marks around the cut path to indicate the customer and the job name. These will be
visible in the bleed on the cutting table and can help organize your printed graphics after cutting.

You can define SmartMarks using SmartNames.

5. Optimize the cut path in the Optimize tab (this is especially useful if you created the cut path with the From
White Background method). You can:

• Select Remove holes so the cut path will only contain the outside borders. Contours inside these borders will
be disregarded.

This means that if there is white inside your graphic, it won't be considered part of the background, so there
won't be a "hole" created by the cut path in your graphic.

• Smooth the cut path by eliminating jagged edges: select Smooth cut path with minimum distance between
path points and enter the distance under which jagged edges will be smoothed.

Depending on the distance, you will loose some detail, but it will facilitate and speed up the cutting process.
• Remove small contours: select Remove contours smaller than and enter the size under which small objects

will be removed from the cut path.
• Move the cut path inwards or outwards: select Offset cut path and enter a positive offset value (to move it

outwards) or a negative one (to move it inwards).

You can use SmartNames to specify any of those values.

This outputs the graphic inside of the cut path (and its trim box) in a PDF file.

You can send this PDF to the Add Parameters for Nesting task, where you can specify parameters (quantity, scale
factor) for nesting graphics based on the cut path.

The nesting will happen in the Create Nested Layouts task.

Note:  See the User Guide for an example workflow using those tasks.
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Prepare Station

This task is used to prepare one ups for use in Step and Repeat. The task's input is a Normalized PDF file.

If the orientation of the PDF does not match the orientation used in the one-up CAD, the automatic repetition will fail.
This is why a one-up ARD/CFF2 file is loaded on top of the PDF.

The position of the one-up CAD will use the die shape (defined by an ink) as a reference. The die shape and the one-
up CAD will be compared in order to derive the rotation angle. If the rotation angle is not identical, the one-up CAD
will be placed rotated on top of the PDF file.

The Prepare Station task can create either Station files or Normalized PDF files. The kind of output that will be
generated depends on whether or not the Create Station File toggle is activated.

Check the 'Create Station File' box to create a Station File (STA or PDFSTA file).

 

 

• The input file is always placed externally.
• Check the option 'Extract Die using Ink' to create a die by extracting all contours in a specific separation.If the

box is not checked then the trim box of the station will be used as die shape. This is the default situation.
• ‘Load CAD’ is only active when the option ‘Create Station File’ is selected. It allows you to place a CAD file.

Supported CAD files include ARD files and 1-up CFF2 files.
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Note:  In case a layout CFF2 file is selected, the task will generate an error.

You can browse to the appropriate CAD file or use SmartNames.If needed, you can select a CAD mapping file
which will determine how the CFF2 line attributes are mapped to the ArtiosCAD line types. This will happen
only when a CFF2 file was selected.S elect the appropriate CAD style file to determine in which separations the
different CAD lines will appear.

• The bleed can be limited to a specific distance. The bleed mask is created by spreading the die shape.
• Graphics on the backside of the station can be loaded (also through an external reference).
• To load a SmartMark set, select a set from the dropdown list or enter the set via SmartNames. Note that only one

set will be loaded for both front and back.

Note:

Keep the following in mind when positioning graphics on the back side:

• If the image PDF contains objects in the ‘die ink’, the graphics for the back side are positioned so that
these object (in the die ink) are centered on the die of the front side.

• In the other case, the graphics on the back are positioned centered on the original borders (i.e. unfitted) of
the front side graphics.

When placing a CAD file, the following sequence of operations takes place:

• The graphics file is placed in a station.
• If the option ‘Extract die ink’ is selected, the die shape is extracted from the graphics. If not, die shape is set to

trim box.
• The CAD file is loaded and the outline of the CAD file is compared to the outline of the die shape generated in the

above mentioned step. The graphics is rotated in such a way to create a maximal intersection of the CAD outline
and the outline of the die shape. If a rotation is applied, the log file will contain a message.

• The CAD is taken as the die shape for the station.

If the 'Create Station File' box is not checked, a Normalized PDF file will be created:
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• The input file is opened (so it is not placed externally).
• Borders can be fitted to objects in a specific ink.
• Margins can be limited to a specific value.
• SmartMarks can be placed around the graphics.

Print

Select a Device from the dropdown list. The devices that appear in the list are the ones that are configured on the
server.

Note:

The devices should be configured on the server using the user BGSYSTEM. The Print Task will not be
available for devices configured by other users.

The configured devices must be PostScript printeres.

Factory settings: These settings are a quick way to define your ticket.
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There are two settings, select one from the drop down list and don't forget to click Apply:

• PostScript for press (Separated)
• PostScript for Press (DeviceN Composite), only available with PostScript 3 devices.
• PostScript for viewing/proofing (CMYK Composite)

If you change the predefined settings, the user interface will indicate that the Factory Settings are modified.
 

 

Note:

If you define a ticket using the Factory Settings, and you save it, the Factory Settings option disappears. If
you overwrite a Default ticket the Factory Settings will be gone as well.

Please refer to Export to PostScript File.

Print IMP File

This task is a combination of the Print task and the Export Imposition to GRI File task.

Print on Digital Press

Working with a Digital Front End Server

Automation Engine can create print jobs on an Esko Digital Front End Server (DFE) using the files in your
Automation Engine containers. It will monitor those print jobs until they are printed on the digital press.

In Automation Engine:

• use the Print on Digital Press task to create print jobs on the DFE server. If Automation Engine is connected
to a DFE server lower than version 4.0, the Print on Digital Press Task can only create static print jobs.  When
connected to a DFE server of version 4.0 or higher, this task can create both static and variable print jobs. Read
more in Print on Digital Press Task on page .

• use the Print on Digital Press (PPML) task to create variable print jobs on the DFE server from Automation
Engine from Esko PPML input file (see Print on Digital Press (PPML)  on page ),

• the Print on Digital Press (Track) task is started automatically to track DFE print jobs created from within the
DFE server. This means you can monitor print jobs created from sources other than Automation Engine. This
being an automatic task, there are no task settings to be filled in.

Each of those tasks shows detailed feedback (for each step of the DFE printing process) in Automation Engine's
Tasks pane.

Setup

Before using those tasks, you must connect your Automation Engine server to your DFE server in Configure.

If your DFE server drives several digital presses, you also need to select the press to connect to from Automation
Engine.

See Digital Press for details.
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Supported File Types

You can send the following file types to a digital press:

For static print jobs: For variable print jobs:

Either:

• Normalized PDF
• PDF
• PDFPLA

An Esko PPML file, with links to several
Normalized PDF files (for the fixed background
and the variable data).

An Esko PPML is a PPML file generated by
DeskPack, PackEdge or Plato.

Note:  Make sure that the files referenced
by the PPML file (the fixed PDF and
the variable PDFs and images) are in
an Automation Engine container, so the
Digital Front End server can access them.

Note:

• If you are using an MIS system to store print job parameters, you can add the JDF ticket created by your
MIS system to the input of the Print on Digital Press task.

• If you want to send other file types to the digital press, you should convert them to Normalized PDF first.

Using the Print on Digital Press Ticket in a Workflow

Unlike most workflow steps, the Print on Digital Press or Print on Digital Press (PPML)) step does not create
output files to be transferred to another Automation Engine workflow step, but sends data to the Esko DFE server.

This means it is always the final task in a workflow.

In the workflow editor, you can see the number of files it has successfully processed on the pin called Inputs at the
end of the step.

 

 

Print on Digital Press Task

Use the Print on Digital Press task to create static or variable (only on DFE version 4.0 or higher) print jobs on the
DFE server from Automation Engine .

Settings
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Device: This list contains all the digital press devices that you connected to in Configure. Choose the digital press you
want to send your file to.

Print Job Ticket: Choose the print job ticket you have created on the DFE server to process and print static print
jobs.

General settings: see General Tab on page .

Step and Repeat settings: see Step and Repeat Tab on page .

Transformation settings: see Transformation Tab on page .

Color Management settings: see Color Management Tab on page .

Note:

When using the Print on Digital Press task, make sure the DFE server is running.

If your task is stuck, check if the Digital Press connection is still OK in Configure.

General Tab

Note:

For all parameters, you can choose [From Print Job Ticket] to use the parameter value defined in the DFE
Print Job Ticket you selected.

The value defined in the Print Job Ticket is then shown beside the parameter.
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If you added a JDF ticket to the task input, you can choose [From JDF Ticket] to use the parameter value
defined in your JDF ticket.

Print Job Name: You can specify a name. You can type in a name or select a SmartName / Public Parameter /
Workflow Parameter .

Substrate: Contains a list of substrates available at the press. The substrate specified in the ticket is selected by
default.

Copies: Enter the number of copies to be printed by the press.

Finishing Marks: Choose if finishing marks have to be applied (you have more options if Step and Repeat is
enabled).

Comments: Choose Custom to enter print job related comments here. They will be included into the file sent to the
press, and be visible on the press (if your press model supports it).

Step and Repeat Tab

You can either:

• Use the Step and Repeat settings contained in the DFE ticket you selected: choose [From Print Job Ticket] in
Step and Repeat Settings.

• Define Step and Repeat settings in the Automation Engine ticket: choose Custom in Step and Repeat Settings.

If you chose Custom, select Step and Repeat to make the Step and Repeat options available.

Note:  When using the PowerLayout DeskPack plug-in to send jobs to the DFE, you have already defined
your Step and Repeat grid, so you don't need to set Step and Repeat options here.
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Available Repeat Area: Define the width and length of the repeat.

• The Width can be set to Maximum (the width of the substrate width you chose in the General tab) or to a
Custom value.

• The Length can be set to the Maximum repeat length or to a Custom value.

Margins: Click this button to set the margins for your Step and Repeat.

 

 

Each gap (1, 2, 3 and 4) can be defined using following values:

• Gap (Length or Width): The size of a gap between one-ups.
• Gap (Length or Width) / 2: Half the size of a gap between one-ups.
• Custom: A custom number (formulas are not allowed).

Note:  These margins must be large enough to provide space for the finishing marks.

Size Repeat Cell: Choose whether the dimensions of the one-up's Trim Box or Media Box will be used to calculate
the repetition grid.

Rotation: Choose the rotation of the one-up (None, 90# CW, 180# or 90# CCW).

Based on those parameters, you can see the Current Cell Size displayed below.

Repeat: This defines the number of vertical and horizontal steps in the repetition grid. You can choose either:

• Maximum: Automation Engine will calculate the maximum amount of repetition steps possible within the
Available Repeat Area.

• Custom: Enter the repetition amount of your choice.

Gaps: The values you enter here (for a horizontal and a vertical gap) will be used as a distance between borders of
one-ups in the repetition grid.

Repeat Area: The Width and Length values are calculated based on the Step and Repeat parameters, including
gaps. You cannot edit them.

After creation of the print job, the Repeat Area shows the area actually used by the repetition.

Note:  The amount of gaps is equal to the number of repetition steps, in order to provide seamless printing.
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Trim box clipping mask with bleed: If the Trim Box / Media Box of the one-up is too large for the desired
repetition, you can clip it to the desired value to avoid overlapping between one-ups.

Note:  The value should not be larger than half of the gap defined in corresponding direction.

Preview Sheet: This shows the Step and Repeat after creation of the print job.

Tip:

If you see some red in the preview, it means that the repetition does not fit on the chosen substrate width.

Choose a wider substrate or reduce the number of horizontal repeats.

Transformation Tab

Note:

For all parameters, you can choose [From Print Job Ticket] to use the parameter value defined in the DFE
Print Job Ticket you selected.

The value defined in the Print Job Ticket is then shown beside the parameter.

If you added a JDF ticket to the task input, you can choose [From JDF Ticket] to use the parameter value
defined in your JDF ticket.

Vertical Scale: Use this to scale the print job vertically (in the length).

Horizontal Scale: Use this to scale the print job horizontally (in the width).

Rotation: Choose the rotation of the print job (None, 90# CW, 180# or 90# CCW).

Note:  The Rotation option is disabled when Step and Repeat is enabled.

Mirror: Choose whether to mirror the contents of the print job or not.

Color Management Tab

Note:

For all parameters, you can choose [From Print Job Ticket] to use the parameter value defined in the DFE
Print Job Ticket you selected.

The value defined in the Print Job Ticket is then shown beside the parameter.

If you added a JDF ticket to the task input, you can choose [From JDF Ticket] to use the parameter value
defined in your JDF ticket.

Ink Set: Choose the set of process inks that will be generated by the RIP (this depends on the model of the press
used).

Use: Define if you want to use color management when ripping the print job (to convert the file separations to the
press ink set), and what kind of color management.

• Choose <None> if you don't want to use any color management settings for the conversion.
• Choose Color Strategy to select a Color Strategy to use for the conversion.

When you select Color Strategy in the Use drop-down menu, you can choose the Color Strategy to use for color
conversion of the print job.

Print on Digital Press (PPML)

Use the Print on Digital Press (PPML) task to create variable print jobs on the DFE server from Automation
Engine.
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Settings

Device: This list contains all the digital press devices that you connected to in Configure. Choose the digital press you
want to send your file to.

Variable Print Job Ticket: Choose the print job ticket you have created on the DFE server to process and print
variable print jobs.

General settings: see General Tab on page .

Transformation settings: see Transformation Tab on page .

Color Management settings: see Color Management Tab on page .

Note:

When using the Print on Digital Press (PPML) task, make sure the DFE server is running.

If your task is stuck, check if the Digital Press connection is still OK in Configure.

Process PDF Spreads

PDF Spread options: process modes

There are three process modes:

• Split Reader Spread: to create single pages from an incoming spread
• Make Reader Spread: to create spread pages from incoming single pages.
• Make Printer Spread: to create spread pages that can be used to create an imposition mock-up from incoming

single pages

The settings for each process mode are described in the following sections.

Settings for Split Reader Spread

Spread position:

• Reference Box: Select a page box to choose how much of the page to include in, or retrieve from a spread. E.g.
select Crop box to crop everything outside that box. Reference boxes include the Media Box, Crop Box, Bleed
Box, Trim Box, and Art Box.

• Reference Box Offset: Enter an exact offset distance from the reference box specified in Reference Box field.
The offset distance will extend beyond the box boundaries.This parameter is commonly used when creating
spreads of asymmetric files.

• Bleed Mode: Control the placement and size of bleeds. There are three options:

  
  

Remove Bleed Only the content of the reference box will be
retained, any bleeds present in the incoming
job will be removed.

  

Bleed from Bleed Box The bleed will be the Bleed Box but only if
the reference box is the Trim Box.

Bleed from Bleed Distance This option will add the specified bleed
distance to the chosen reference box. Enter
the bleed distance in millimeters. A bleed
distance will extend beyond the borders



Automation Engine | The Tasks: an Overview | 365

of the TrimBox and therefore will set the
boundaries of the Media Box when output.

Spread structure:

• Flow Direction: Determine whether pages are arranged in numerical order from either left to right or right to left.
When set at left to right direction, page one will be on the left hand side of a two-page spread, with the second
page on the right. If the flow direction is right to left, page one will be on the right hand side of the spread, with
page two on the left hand side.

• First Spread Contains Control how pages will be organized in the output job:

  
  

Page 1 and 2 To divide a spread into single pages. If you
use this mode in conjunction with the “Mixed
Spreads” option, you can split spread pages
in a job while leaving single pages intact.

Note:  Note: The reference page for
a splitting job using Mixed Spreads
should be a spread page, not one of
the single pages.

  

First page only If you place the first page of the job on the
right-hand side of the first spread page; the
left-hand side remains blank.

For jobs with an even number of pages,
the last page will be also be placed on a
spread page, on the left-hand side, with an
accompanying blank page.

The left / right positioning of pages on
spreads is determined by the selection made
in the Flow Direction field.The description
above assumes a left to right flow direction.

Last and first page When making a spread in Last and First Page
mode, the last and first pages of the input
job are placed side by side on the first spread
page.

In a left to right flow direction setting, the
last page will be on the left and page one on
the right of the first spread page output.

In “Split Reader Spread” mode the task will
simply reverse the make mode. A job with
spread pages will have the spread pages split
but the page on the left side of the first spread
will be output as the last single page of the
output job.

Even number of pages To prevent incoming jobs with an even
number of pages from losing any pages while
being split.



366 | Automation Engine | The Tasks: an Overview

The parameter produces different results
depending on which of these spread types it
is combined with.

• Select the Even Number of Pages option
together with the First Page Only spread
type to split the output job. The left side
of the first spread and the right side of the
last spread will not be output.

• A combination of the Last and First
Page spread type and the Even number
of Pages parameter will split a job
successfully.

Note:  This option is active only
in the Split Reader Spread process
mode and with the First Page Only
and the Last and First Page spread
types.

Mixed spreads:

Use this option for incoming jobs with a variety of paper sizes for which you need to define the Reference page.

For example, if a job contains both an A4 page as page one and a two-page spread as page two, enter page two as the
reference page and indicate that this page has two pages on it. All the spread pages are correctly detected and split
correctly while leaving the single pages intact.

• Auto Detect Spread Reference: to take the most frequently featured page size as the Reference page
• Reference Page Number: to specify an exact page as the Reference Page. Use the actual page number in the

series of pages, not the page’s number label
• Reference Page contains X One-Ups: enter the number of single pages to be positioned on the Reference Page.

Settings for Make Reader Spread

Select this process mode to create spread pages from incoming single pages.

The Spread position and Spread Structure options are the same as for the process mode Split Reader Spread.

Settings for Make Printer Spread

Select this process mode to create spread pages that can be used to make an imposition mock-up from incoming
single pages.

The Spread position and Spread Structure options are largely the same as for the process mode Split Reader Spread.

Processing PDF Spreads

Use this task to manage PDF Spreads. You can create spread files, split spread files, specify bleed distances and
control the order and positioning of the pages in spreads. This task can handle jobs that contain a combination of
single pages and spread pages.

1. Use the Output in field to define where to place the PDF spreads.

This can be the job's original location, or another location.

2. Define the Job Name to use.

By default, this field contains the [JobName] SmartName, meaning that the original job name will be used for the
PDF spreads.

3. Choose one of the following Actions:
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• Split Reader Spread
• Make Reader Spread
• Make Printer Spread

4. ChoosingSplit Reader Spreadallows you to create single pages from an incoming spread. Set the following
parameters:

• the Reference Box: Media, Crop, Trim, Bleed or Art box
• the Reference Box Offset
• The Bleed Mode and Bleed distance, when relevant
• The Spread Structure: the flow direction and the contents of the First Spread
• If you have mixed page sizes in the PDF spread, choose your Reference page and specify the number of one-

ups on that Reference page.

5. Choosing Make Reader Spread allows you to create spread pages from incoming single pages. Set the following
parameters:

• the Reference Box: Media, Crop, Trim, Bleed or Art box
• the Reference Box Offset
• The Bleed Mode and Bleed distance, when relevant
• The Spread Structure: the flow direction and the contents of the First Spread

6. ChoosingMake Printer Spread allows you to create spread pages that can be used to create an imposition mock-
up from incoming single pages. Set the following parameters:

• the Reference Box: Media, Crop, Trim, Bleed or Art box
• the Reference Box Offset
• The Bleed Mode and Bleed distance, when relevant
• The Spread Flow Direction

7. Click OK to save your settings for this task.

Process Remote Proofs

Read about Remote Proofing here:

Proof (FlexProof)

In the Device list, select the FlexRip Proofer Output you added in Configure.

General

Transformations

Enter a percentage in Scale V and/or Scale H to scale the design vertically or horizontally. The scaling direction is
always applied ‘as the file is’ (so the vertical and horizontal dimensions are as you see them in the editor).

Rotate: Choose the requested rotation from the list. The rotation is counter clockwise.

You can also select Fit On Paper to fit the design on the paper of your proofing device. This makes the Scale and
Rotate options unavailable.

Positive-negative : Define whether you want a positive or negative output file.



368 | Automation Engine | The Tasks: an Overview

Mirroring : choose whether you want mirroring or not.

Original Size (incl. Margins)

The system provides the original Job size, margins included.

Output Size (incl. Margins)

The size shown here is the real output size, that is the original job size influenced by the scaling factors (and/or
distortions) and the chosen rotation.

Marks

If desired, you can add SmartMarks to your file. SmartMarks are created in an Esko editor.

Dot Gain Compensation

Single Curve: Select the preferred Dot Gain Compensation Curve.

Automatic: Select the preferred screen based Dot Gain Curve.

Inks

All Inks. The standard behavior of the default ticket is to offer all inks in the job to be exposed. Deactivating ‘All
Inks’ opens the ink list where you can select specific inks.The list contains ink names, ruling, angle, dot shape and ink
type.

Use technical inks in output. Normally technical inks are hidden when you save a job in an Esko editor. Check the
box to output the visible (non hidden) technical inks.

Keep similar inks in their original separations. Check the box if you want to keep similar inks in their original
separations.

Keep inks separated. Do not merge the inks.

Use Merge with to output inks on top of each other in the same output file. This is common when you use different
rulings for 1 ink.

Let's assume that the job contains two Cyans, and that they have a different ruling. You might want to put them on the
same separation. You can do so by clicking in the 'Merge with' column and selecting the ink it has to be merged with.

Click Merge Similar Inks to prompt the system to look for the same inks with a different ruling or angle. The image
shows how two Cyans (with a different ruling) were detected and put together. You can reset any modifications by
clicking Reset.
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Advanced

Hold In Rip Queue This options offers to hold the task in the rip-queue until someone manually releases this task.
For more information, please see the Tasks View.

Choose between:

• Don't change Y ruling: this is the default, the Y ruling is not adapted.
• Change Y ruling: change the Y ruling, possibilities are: -15%, -7%, 0% (changes nothing), + 7% and +15%.
• Change Y ruling stochastic: same as the 'Change Y ruling' settings, but the dotshapes is adapted to the Monet

dot.

Pre - Rip

The Pre-Rip tab contains options that are only relevant when the job really needs pre-ripping. The Pre-ripping
mentioned here is the ‘simplification’ that can be necessary before the job-objects can be offered to the Rip. The
decision to do this is taken automatically. And even when this is done, the options are best left to their default
settings. Special objects (in Normalized PDF format) that require the need for this ‘simplification for rip’ pre-ripping
are:

• ‘Edge vignettes ’ (vignettes with alpha channels effect on the edge of the object)
• Barco Blends (=non contourized GRO-blends)
• Warped CTs (warping done on Placed CTs)

Pre-ripping results in making a CT of these special objects that the rip can handle them. The resolution of such a CT
and the anti-aliasing can be set here.

Specify the output resolution for the generated CT(s). Default output resolution is 12 lpmm or 304 ppi.

Anti-aliasing is relevant for the lineart objects in your design, that need pre-processing and for which CTs are
generated. Anti-Aliasing smoothens the staircase effect you get in the generated CTs of lineart objects that need pre-
processing.
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Vignette Noise When exporting to some EPS vignettes or parts of vignettes will be converted to CTs. This happens
when the vignettes overlap other objects with translucency or overprint between the vignette and the other objects.
When the option Convert Vignettes to CT is activated all vignettes are converted to CT regardless of overlap with
other objects. Vignettes that are converted to CT can result in tone jumps in the final result. To reduce this banding
effect, noise is applied on the CT. The amount of noise can be specified in the field Vignette Noise.

The  Blend to CT toggle converts the Barco Graphics blend objects into a CT when exporting your job.

Use the Smooth Blend toggle to set the steps of the blend objects to 255 steps when exporting your job. As long as
Convert Blend Objects to CT is not activated, Smooth Blend appears dimmed. When Convert Blend Objects to CT is
activated and Smooth Blend also, the generated CT will ignore the original steps of the blends of your Barco Graphics
design. The amount of steps is set at the maximum which is 255. The goal is to obtain a fluid blend effect.

Output

Configuration Set

Indicates the name of the selected configuration file. These configuration files represent specific behavior of the
output device. The list of configurations is filtered according to the CMS license that the selected dispatcher holds.
For example if it has a 4 channel license, no multi channel configurations will be visible.

Output Folder

Leave this empty to use the output path as defined in the Dispatcher (EskoLink queue – Output tab). If your EskoLink
queue has no value for the output place; then you can define output folders here.

Output File

Leave this blank to get an output file name based on the input file. Edit this to overrule this standard behavior. Only
plain letters and numbers will be allowed. Other, unsupported characters (symbols) will be replaced by an _.

Output Type

Choose between Composite and Separate and select the appropriate Output Color.

Output Color

In case of Composite output, you can choose between Colored and Greyscale. In case of Separate output, you can
choose between Colored and Black & White.

• Colored: all inks are converted to CMYK values
• Greyscale: all inks are converted to grey values.
• Black and White: if you want a Black & White proof.

Anti-Aliasing is relevant for the lineart objects in your design, that need pre-processing and for which CTs are
generated. Anti-Aliasing smoothens the staircase effect you get in the generated CTs of lineart objects that need pre-
processing.

Enter the Number of Copies you need.

Check Keep job files for relaunch purposes to be able to proof jobs a second time without having to rip them again.

Note:

When using this option, the files created for the proof (and the proof job on the Esko Proof Client) will not be
automatically cleaned up.

You will have to delete them manually.

White Coloring

Attention:  You will only have this option if one of your Configuration Sets connects to an Epson Stylus
Pro WT7900 proofer.

When you use an extra white ink to print on foil (transparent or metallic), this option allows you to customize your
white ink (for example, to get a cooler or warmer white).
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You can choose between:

• No Coloring: this uses the proofer's white ink to print objects in the white separation, without applying coloring to
this ink.

• Custom values: this allows you to color the proofer's white ink manually. Enter the CMYK values to add to the
white inks.

• Values from Color Management: this uses a Color Strategy to color the proofer's white ink.

This Color Strategy must have a white Extra Output Ink (called white) and map the white separation used in
the file to this white output ink.

Color Managing White Ink for an Epson WT7900 Proof

For example, you want to print a file with a cool white ink on your Epson Stylus Pro WT7900 proofer.

1. In Color Engine Pilot’s Designer book:

a) add your file’s white ink (here, cool white),
b) add a generic white ink. Call it white.

2. Create a Color Strategy that will color manage your file’s white ink:

a) add your generic white ink as an Extra Output Ink,
 

 
b) map your file’s white ink (cool white) to your white output ink,

 

 
c) make sure Extra Output Ink and Ink Mapping are selected in your Color Strategy.
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3. In Automation Engine’s Proof (FlexProof) ticket, go to the Output tab and:

a) select the Configuration Set corresponding to your Epson Stylus Pro WT7900 proofer,
b) in White Coloring, select Values from Color Management.

4. In the ticket’s Color tab:

a) select Manage Color,
b) select Color Strategy,
c) choose the Color Strategy with white ink mapping you created in Color Engine Pilot.

Color
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Simple Color Workflow

Check Manage Color to apply color management to your job.

If you choose to apply color management for Normal Proof the settings of the requested color management are, by
default, chosen by a Color Strategy which can be selected from the list.

If the color strategy toggle is disabled, the color management settings are entered with profile settings.

Then, Use the Document Profile as Source Profile if Availabe is set but as this document profile may not be
available, a backup of the source profile must still be chosen.

Choose the Process you want to simulate on the proof here. This process can be a registered ICC profile or an Esko
Profile.

There are some default Esko Profiles on the system, for example crom_offs (Cromalin Offset). If you have measured
an Esko Profile yourself, for example for your own Flexo press, you will be able to select it here.

Destination Profile

This is the profile for the proofer. Choose the proofer profile that describes the colors of your proofer here (for
example the characteristics of your proofer).

Both Esko Proofer profiles and ICC profiles of proofers are available in this list.

Also defaults are listed, for example ddcw_glossy, a description for a Digital Cromalin/WaterProof on glossy paper.

If you profiled your proofer using Color Engine Pilot, you will be able to select your Proofer profiles here as well.

Note:

The list of color strategies and destination profiles is filtered according to the CMS license that the dispatcher
holds.

If the Dispatcher has no CMS license, only “preview” and “linear” can be selected as color strategies,
whereas additional strategies are available with a 4-channel or multi-channel license.

Rendering intent

Rendering intent decides how you will visualize the simulated profile on your proofer. Since there are many
differences between the simulated process (for example a gravure press) and the proofer, the CMS software gives
some options to give you the best result for your purpose. Possibilities are:
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• Relative (No Background): Use this option if you do not want any background simulation. The white point of the
source will be mapped on the white point of the destination process. This rendering intent takes into account the
ability of the human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped on white of
destination colorspace). Use this option if you don't care too much about an exact color match but you want the
pictures at least to look nice on your proofer. It will give a visually pleasing result. If the gamut of the source is
wider than the proofer, the entire gamut is shrunk so that it fits inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an exact color match,
including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent will map saturated
colors on saturated colors.

Note:

For Esko profiles Perceptual, Relative and Saturation are in fact identical.

Black Mapping

This option is only available if you choose an Esko destination profile (not if your destination profile is an ICC
profile). Black will be mapped onto black or, in other words, the black separation will only be printed with black ink.

In case you want to simulate a very dark black, which is darker than the black of your proofer, you might want to
switch this option off. In this case all 4 proofer inks will be used to simulate the high density of the black.

Generate an error if the job contains unregistered inks

This toggle is by default unchecked. You can enable this option when Manage Color is on.

When this toggle is checked, the task will indicate an error if unregistered job inks are being color managed. The
resulting Error will indicate a message:

• The job contains unregistered inks
when launched as a stand-alone task.

• Proofing aborted because the file contains unregistered inks
in the Log window when launched as a workflow task.

.

This helps to avoid inaccurate results from unregistered inks. When unregistered inks are not present in the job or the
unregistered inks are deselected in the inks-tab, the task will launch without indicating an error.

Note:  When you select an Equinox source profile ( or use a Color strategy with Equinox source profile) with
Manage color toggle on, this task will perform a default check. This check verifies if all the selected job inks
are specified in the Equinox source profile. If they are not specified, the task will end in error with a message
such as :
Proofing aborted because the following input inks are not found in the source profile: cut glue

Color (Emulation Proof)

You need an extra license to see the Manage Color for Emulation Proof option. If unchecked, then the workflow
remains as described in the simple color workflow. Otherwise, extra options are available:
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Here, CMS options can be set twice:

• In the topmost section of the tab, you set the color management options for emulating the conventional press on a
digital press (conversion from the source profile to the emulation profile).

• In the second section, you set the color management options for the output proofing device (conversion from
emulation profile to destination profile).

The preferred option is to use a Color Strategy for both conversions. Select the emulation Color Strategy first, so
that the list of color strategies for the output settings can be filtered to have the same source profile as the emulation
profile selected in the emulation step.

Alternatively, you can manually select the source profile, emulation profile and destination profiles with their
respective rendering intents.

Tip:

If you select a multichannel printing profile in the Emulation Profile list (such as the seven-channel
IndiChrome Plus profile), you can use the Output Inks... button to enable or disable the additional inks (for
example, indiChr Orange, indiChr Green, and indiChr Violet).

This allows you to use a profile like IndiChrome Plus to generate output without one or more of the additional
inks (for example, without the IndiChrome Orange ink).

Generate an error if the job contains unregistered inks

This toggle is by default unchecked. You can enable this option when Manage Color is on.

When this toggle is checked, the task will indicate an error if unregistered job inks are being color managed. The
resulting Error will indicate a message:

• The job contains unregistered inks
when launched as a stand-alone task.

• Proofing aborted because the file contains unregistered inks
in the Log window when launched as a workflow task.

.

This helps to avoid inaccurate results from unregistered inks. When unregistered inks are not present in the job or the
unregistered inks are deselected in the inks-tab, the task will launch without indicating an error.

Note:  When you select an Equinox source profile ( or use a Color strategy with Equinox source profile) with
Manage color toggle on, this task will perform a default check. This check verifies if all the selected job inks
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are specified in the Equinox source profile. If they are not specified, the task will end in error with a message
such as :
Proofing aborted because the following input inks are not found in the source profile: cut glue

Verification

Note:  You can only set Verification options if you have chosen an EskoArtwork Proof Configuration Set in
the Output tab.

Print Verification Strip: To print a verification strip, select this option and fill in the options below (that become
available once Print Verification Strip is selected).

Strip Preset: a certain number of presets come with your color database. They contain information about the strip and
the measurement device to use, the tolerances in color difference, etc.

You can select a preset here, that will fill in the options below, or select Custom and fill the options in yourself. You
can also start from a preset and change the other options as desired (the Strip Preset field will then show Custom).

For more information about the strip presets available, see XXX.

In Strip Type, choose the strip to print with your job: this can be EskoStrip or Esko + Solid Color Strip. The Esko
+ Solid Color Strips contain the same patches as the EskoStrips, plus a 100% patch for every spot color present in the
job. When printing a color managed strip, you should use an Esko + Solid Color Strip.

For more details about the available strips, see the FlexProof/E documentation.

Apply Color Management to Strip: If you selected Manage Color in the Color tab, the Apply Color Management
to Strip option is available. Select it if you want to color manage your strip.

Verify strip (with Verification tool): If you have a Verification license and you are color managing your job, this
option is available. To verify your strip, select this option and choose what to use as a Reference.

You can choose either:

• Manually load reference values if you want to verify the color managed strip against a standard (e.g. Ugra/
Fogra) or a previous measurement.

You will need to load this standard manually in EskoArtwork Verification.
• Automatically load reference values from source profile if you want to verify the color managed strip against

the source ICC profile (set in the Color Strategy used or defined in the Color tab).

dE Formula: choose the Delta E formula to use when verifying your strip.

You can select between dE CIE76, dE CMC, dE 94 and dE 2000. If your company is already using one of those
standards, we recommend that you choose the same one. If not, you should choose the most recent one, dE 2000.

Click Edit Tolerances... to set custom tolerances for the measurements.

You can fill in:

• General dE Limits: the Delta E values that the color patches and paper should not exceed.
• Primary color dE Limits: the maximum Delta E values allowed for CMYK colors.
• Hue difference Tolerance Limits: the maximum Delta H values for CMYK, CMYKRGB and grayscale colors.

Delta H is the difference in Hue between the expected color and the printed color. XXX
• Tone Value Tolerance Limits

• Chromaticness Tolerance Limits

If you selected a Strip Preset, the tolerances may be automatically defined.

The verification will pass if the Delta E values are within the tolerances, or fail if they are bigger.

Strip Layout
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Proof IMP File (FlexProof)

This task is a combination of the Proof (FlexProof) task and the Export Imposition to GRI File task.

Publish Imposition on WebCenter Chain

You can publish your Imposition to WebCenter using this task chain. You can then approve/reject pages in
WebCenter. The input of this task can be an Imposition or a RunList. If you want to approve the RunList before
adding a layout you can use this task to publish a Runlist on WebCenter.
 

 
Your approval in the WebCenter is registered in the Automation Engine Proofs  view. You can proceed with these
proofs in the Automation Engine workflows.
 

 

This ticket has two subtasks(steps):

• Publish imposition on WebCenter. Read more in Publish Imposition on Webcenter on page 
• Send RunList to WebCenter. Read more in Send RunList to WebCenter on page 
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Publish Imposition on Webcenter

Mockup

In this tab, you can check the elements you want to be visible on output and select the appropriate mockup color from
the dropdown list to enhance visibility.

 

 

Publish

 



Automation Engine | The Tasks: an Overview | 379

 

Allow Viewing and Annotating in WebCenter

The files will be processed by Automation Engine and uploaded to WebCenter according to the settings for resolution
and image processing.

Resolution for non-images for linework and text etc.. can be set to either Optimal or Custom.

• Optimal: If you select this, Automation Engine will calculate the best resolution based on the size of the file.
• Custom: You can specify the required resolution.

For images, the maximum resolution available will be used.

Anti-aliasing: You can enable this image correction option to relevant objects. Anti-Aliasing smoothes the staircase
effect you get in the generated CTs of lineart objects that need pre-processing.

Allow Downloading in WebCenter

You can select which kind of files you want to make available for downloading in WebCenter here:

• Input files
• PDF files for proofing. You have to choose which Ticket should be used to generate the PDF files.

Note:  If you select PDF files for proofing the viewing quality will be limited to the resolution of the PDF
files for viewing.
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Send RunList to WebCenter

Destination

You can select the WebCenter settings.

• Site: You can indicate to which site you want to upload the documents. The sites available are the ones defined in
Configure.

• Project:You can indicate the name of the WebCenter project to which the imposition will be published.

Tip:  Use [JobName] as project name to map the jobs in Automation Engine to the projects in
WebCenter.

Note:  The project does not have to exist in WebCenter at upload time. If the project does not exist, it will
be created in WebCenter. The person that does the upload needs to be Project Manager in WebCenter to
be able to create a project in WebCenter over the upload.

• Folder: You can indicate in which folder the documents should be stored.
• Document Name: You can set the name of the published document and this setting allows to have documents

published with a name which is different from the name of the published file.
• Document Description: You can enter a description about the document which will be available in WebCenter.
• Project Template: Here you can enter the Webcenter Project Template. You should have created this project

template in WebCenter prior to using this ticket.
• User Name: Enter your WebCenter user name to gain access to the site. User name and password are used by

WebCenter to check if the Automation Engine operator has the right to publish in the specified project.
• Password: Enter your WebCenter password to gain access to the site.

Note:  You can use SmartName in most of the fields.
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Approval

The Approval tab allows you to select if and when the approval cycle should be started on WebCenter.

Note:  Make sure you have an approval cycle set up in WebCenter!You can do this by setting up an approval
cycle in a project template, and creating your the project from this template.

Select the Start the Approval Cycle option if you want the approval cycle to start automatically as soon as the file is
uploaded to WebCenter.

If the user you logged in with in the Destination tab has the Change Approval Setup permission in WebCenter, you
can also set the approval Due date. You can choose:

• today,
• tomorrow,
• today + x days (then define the number of days in the x = field that appears),
• job due date,
• other... (then enter the due date or select it in the calendar).

You can also select the hour at which the cycle should be completed (except when using job due date).

Publish on WebCenter

With the Publish on WebCenter ticket, you can upload jobs to a remote WebCenter site where they can be approved.

The JDF publishing technique makes it possible to provide a smooth integration between Automation Engine and the
WebCenter (Esko) remote approval system.

You can also submit documents to WebCenter without having to be approved.

This ticket has three tabs:

• Destination
• Publish
• Approval

Attention:  If the Waiting for Approval is checked in the Approval tab, the Publish on WebCenter task
will remain in the Tasks View as waiting for response until all contacts have given their approval.

Destination

WebCenter

Note:  You can use SmartName in most of the fields.

• Site: indicate to which site you want to upload the documents. The sites available are the ones defined in
Configure.

• Project: indicate in which WebCenter project the documents should be stored.

Tip:  Use [JobName] as project name to map the jobs in Automation Engine to the projects in
WebCenter.
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Note:  The project does not have to exist in WebCenter at upload time. If the project does not exist, it will
be created in WebCenter. The person that does the upload needs to be Project Manager in WebCenter to
be able to create a project in WebCenter over the upload.

Remember:  The recommended method to create Project  is by using Create/Modify WebCenter
Project ticket.

• Folder: indicate in which folder the documents should be stored.

Note:  This will be created if it does not exist if the user is a Project Manager in WebCenter

• Document Name: allows you to explicitly set the name of the published document and makes it possible to have
documents published with a name which is different from the name of the published file.

Note:  If left blank, it takes the name of the document.

• Document Description: allows you to enter a description for the document to upload. This description will be
available in WebCenter as  Version Comment.

• Project Template: indicate which WebCenter project template should be used. You should have created this
project template in WebCenter prior to using this ticket.

Note:  The template availability depends on the visibility of the user. If the user is a Project Manager
with limited visibility the templates are filtered as following :

• First WebCenter checks for Company visibility
• Template Member visibility is checked.

• User Name: enter your WebCenter user name to gain access to the site. User name and password are used by
WebCenter to check if the Automation Engine operator has the right to publish in the specified project.

• Password: enter your WebCenter password to gain access to the site.

Note:  The upload will fail in error if the user lacks upload rights even if the project exists.

Note:  If the document already exists, you will create a new version of the document.

Note:  If the document exists in a different folder, the task will fail.

Note:  When creating a project using this task, the project manager will be :

• the project manager of the template group if the user executing the task is part of that group.
• or the task executing user.

Publish

In the Publish tab you can decide if and who is to prepare pixel data for the WebCenter Viewer. You can decide what
will be made available on WebCenter; only Viewer pixel data or also downloadable (PDF) data.

Allow Viewing and Annotating in WebCenter

If the Prepare for viewing and annotating toggle is checked, the files will be processed by Automation Engine and
uploaded to WebCenter. The graphic files that are published will be rasterized into files readable for the viewer which
will be published with the original document.

Note:  This toggle cannot be turned on when WebCenter and Automation Engine are not in the same LAN.
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Tip:  makes the upload faster,it avoids having trouble in files with external references,you can select the
ticket of the PDF proxy file

The requested Resolution for text and linework can be set to either Optimal or Custom.

• When Optimal is selected, Automation Engine will calculate the best resolution, mainly based on the size of
the file. This determines the best resolution of the rasterized file, based on the size of the original document. It is
recommended to select this option.

• Custom allows you to specify the required resolution. If you set a high resolution, it will create large rasterized
files. When a low resolution is set, you will have a low quality view of the document in the WebCenter viewer.

For images, the maximum resolution available will be used.

Anti-aliasing is relevant for the line art objects in your design that need pre-processing and for which CTs are
generated. Anti-Aliasing smoothes the staircase effect you get in the generated CTs of lineart objects that need pre-
processing.

Automatic grouping of input file into digital film sets: In a workflow where the publish task just after a RIP task
that creates digital films, you may want to publish these files as one document. When this option is on, a set of digital
film files ( LEN files for example) will be bundled as one document when published in WebCenter. Each digital film
will make up one separation of the document. This option will be on by default.

Allow Downloading in WebCenter

Make available for download: If you do not turn the option on, the rasterized files will only be viewable. In order to
download them, check this toggle on. This option can be untoggled when you want the users in WebCenter to view,
annotate and approve the file. Use this option to keep production files protected and not downloadable.

Here you can select which kind of files you want to make available for downloading in WebCenter:

• Input files
• PDF files for proofing. In this case you should indicate which Automation Engine Ticket should be used to

generate the PDF files. Use this option to create a PDF proxy file in WebCenter instead of a real input production
file. When the documents you publish are not selfcontained, select this option.

If you select PDF files for proofing the viewing quality will be limited to the resolution of the PDF files for viewing.

When disabling both Prepare for viewing and annotating and Make available for download, a warning box is
displayed indicating that no data will be published. Click OK to restore the last selection.

 

 

Approval

The Approval tab allows you to select if and when the approval cycle should be started on WebCenter.

Note:  Make sure you have an approval cycle set up in WebCenter!
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You can do this by setting up an approval cycle in a project template, and creating your the project from this template.

 

 

Select the Start the Approval Cycle option if you want the approval cycle to start automatically as soon as the file
is uploaded to WebCenter. For this, you need to have an approval rule specified in the project or folder where you
upload the document to. By default, WebCenter will apply the folder approval setup if it exists. If not, the project
approval setup will be applied.

If the user you logged in with in the Destination tab has the Change Approval Setup permission in WebCenter, you
can also set the approval Due date. You can choose:

• today,
• tomorrow,
• today + x days (then define the number of days in the x = field that appears),
• job due date,
• other... (then enter the due date or select it in the calendar).

You can also select the hour at which the cycle should be completed (except when using job due date).

Status feedback: Use this option to specify whether you have one Approval tasks for each file that is uploaded, or
whether there is only one approval task per published set of files. The option is only useful when documents that are
published together.

Note:  Status feedback has effect on the feedback of the approval task. It does not change the behavior of the
approval.

Define what to do If multiple files are selected:
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• Launch a task per file will launch a new task for each individual file.
• Launch one single task for all files will launch all files in one task.

In Continue with the Next Step in the Workflow Task, indicate on what condition you want the workflow to
continue:

• select Continue with approved files and ignore rejected files if you want to continue even if some of the files
are rejected,

• or select Only continue when all files are approved.

Note:

Documents you approve conditionally in WebCenter will go through the Approved with a Condition output
of the Publish on Web task in your Automation Engine workflow.

 

 

Use a Wait for Action (Checkpoint) task for those documents, so the Automation Engine operator can fix
them manually.

For more details about conditional approval, see the WebCenter documentation.

Publish on WebCenter Task in Workflows

When used in a workflow, the Publish on WebCenter Task generates an Annotations summary if the WebCenter
document has annotations. At the end of the approval cycle, an HTML file will be generated as annotations summary.
The annotations summary redirects you to the WebCenter Annotations page in a browser.
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You can specify the location and name of the annotations summary HTML file in the Approval Tab in the
Annotations  field.

Note:  The HTML annotations summary file is generated only when connected to WebCenter 12.1 or higher
versions.

Publishing Automation Engine Products to WebCenter

When you publish a Product to WebCenter, the Product Properties and Product/Product Part Parameters will
be taken as WebCenter Attributes. If there are existing WebCenter attributes with corresponding names, their values
will be updated during publishing. The following Product (Part ) properties and Product (Part) Parameters are
synchronized with WebCenter Attributes:
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Automation Engine Properties/Parameter WebCenter Attribute

Product Customer Reference ae.p.cusref

Product Custom Field 1 ae.p.category1

Product Custom Field 2 ae.p.category2

Product Custom Field 3 ae.p.category3

Product Internal ID ae.p.id

Product ID ae.p.prodid

Product Name ae.p.name

Product Description ae.p.desc

Product Part Internal ID ae.ppid

Part Default Angle ae.pp.defaultangle

Part Default Dotshape ae.pp.defaultdotshape

Part URL ae.pp.url

Part Default Ruling ae.pp.defaultruling

Part Preferred InkBook ae.pp.preferredinkbook

Part Preferred InkBook UI ae.pp.preferredinkbookui

Part Internal ID ae.pp.id

Part Custom Field 3 ae.pp.category3

Part Custom Field 2 ae.pp.category2

Part File ae.pp.file

Part Status ae.pp.status

Part Status Nickname ae.pp.status_nickname

Part Status User ae.pp.status_user

Part Status Notes ae.pp.status_notes

Part Status Date ae.pp.status_date

Part Folder ae.pp.folder

Part Custom Field 1 ae.pp.category1

Part Name ae.pp.name

Part Inks ae.pp.inks

Part Barcodes ae.pp.barcodes

Product Customer Name ae.c.name

Product Customer Description ae.c.desc

Product Customer ID ae.c.id

MyProductParameter1 ae.p.par.MyProductParameter1

MyProductPartParameter2 ae.pp.par.MyProductPartParameter1

 When a Product pr Product Part is published, corresponding WebCenter Documents are automatically added to the
Bill Of Materials  of the WebCenter Project. The Product Amount for the Job (if given) is updated as the Count
property of the Bill of Materials.
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Note:  Synchronization of the Product Properties with the WebCenter Document Attributes and Bill Of
Materials is only supported from WebCenter 12.1 onwards.

Relocate Job

This task will change the location of a job. Enter the new path, but keep in mind to specify the name of the Job folder,
either manually or via SmartNames.

What do you want to do with the files?

• Copy the files to the new location.
• Remove the files from the original job folder.

 

 

Resize PDF for Output

This task allows to resize PDF pages and/or their contents for output to a proofer or a RIP.

Note:  The task uses the Dimension unit defined in the Preferences. You can use SmartNames for the values.

Resize to a specific page size: Select this parameter to adjust the PDF markup for a given paper size.

Leave it deselected if you only want to adjust the page contents (page boxes, etc.).

Selecting or deselecting this parameter affects which parameters you see in the Page Content and Page Size areas.
See Resizing PDF Pages on page  and Resizing PDF Contents on page  for details.
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Resizing PDF Pages

When Resize to a specific page size is selected, you can resize the PDF pages and their contents using the following
parameters:

1. In the Page Content area, select the Page Box to Use for positioning, scaling, etc.

2. Select how to Position this page box and its contents on the page:

• Don’t Fit (default): the file will be placed “as is”.
• Center on Page: the task will center the job in the selected page box.
• Scale to Fit (Reduce Only): the task will scale the job down if necessary, so it fits in the selected page box.
• Scale to Fit (Reduce & Enlarge): the task will scale the job up or down if necessary, so it fits in the selected

page box.
• Use Tiling: the task will keep the original file size, and tile it over several pages as necessary.
• Use Proportional Tiling: the task will tile the file over several pages as necessary, but make all tiles the same

size.
• Gripper on Top: the task will leave space for the gripper at the top of the page.
• Gripper at the Bottom: the task will leave space for the gripper at the bottom of the page.

When selecting Use Tiling or Use Proportional Tiling, you can enter the size of the Tile Overlap (where two
tiles are partly on top of each other).

When selecting Gripper on Top or Gripper at the Bottom, you can enter the amount of space needed for the
gripper in Gripper Size.

3. Select Mirror page if you want to mirror the page contents and the page boxes horizontally.

4. If desired, use the Scale parameter to define a scaling to apply to the artwork before placing it on the page.

Note:  The Scale, Horizontal Distortion and Vertical Distortion parameters are not available when
selecting Scale to Fit (Reduce Only) or Scale to Fit (Reduce & Enlarge) in the Position parameter.

5. If desired, enter a Horizontal Distortion and/or a Vertical Distortion to apply to the artwork before placing it on
the page.

Distortion is a stretch of the jobs’ original dimensions. It is specifically important for Flexo jobs.

When mounting a Flexo plate on the press, it is stretched out in one direction. By making the output slightly
smaller than needed, we compensate for this distortion. The dimensions of the original file remain unchanged.

You can either enter the distorted output values (e.g. 97% or 103%), or the positive/negative distortion values (e.g.
-3% or +3%). Leave the values at 100% (default) to apply no distortion.

6. Select Clip on selected page box if you want to clip away all artwork outside the page box you selected in Page
Box to Use.

Note:  The artwork outside the selected page box is not deleted, just clipped away by a clipping path (it is
invisible but still present in the file).

7. Select Crop to fit if you want to crop your Page Box to the content of your original file.
 

 

8. In the Page Size area, select the page size you intend to print to in New Page Size.

This page size is used by the Scale and Position parameters.
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• If you select a predefined page size, you will see an Orientation parameter, where you can select the
orientation of the paper you intend to use. Choose either Portrait or Landscape.

• If you select Custom as a page size, you will see a Page Width and a Page Height fields where you can enter
the dimensions of the custom paper you intend to use.

9. Enter the Page Margins required by the output device.

The Page Margins value you enter will be used for the four sides of the page. These margins cannot be used for
exposing.

10. Define Web Growth Compensation if necessary.

Web Growth Compensation allows you to compensate or simulate the “growth” of the paper after every separation
is printed on a web press.

• To compensate for web growth, enter a negative percentage to make every separation slightly smaller than the
previous one.

• To simulate web growth (e.g. for proofing), enter a positive percentage, to make every separation slightly
bigger than the previous one.

Note:  Web Growth Compensation/Simulation is only possible on separated files. If it is applied (value
other than 0) to a non-separated file, the job will fail.

You can use either no Web Growth Compensation (None), Simple or Complex Web Growth Compensation.

• Simple: this only applies compensation/simulation in the vertical direction (since this is the direction the paper
grows on web press).

In the Web Growth parameter (displayed when you select Simple), enter the (positive or negative) growth
percentage to apply to every separation printed.

If for example your printing order is CMYK, and the Web Growth Compensation parameter is set to 0.2%, the
Cyan separation will be at 100%, the Magenta will be at 100.2%, the Yellow will be at 100.4%, and the Black
at 100.6%.

• Complex: with complex Web Growth Compensation you can define a different Web Growth Compensation
percentage to apply to every separation, horizontally and vertically.

After selecting Complex, click the Add button and enter the Horizontal Compensation and Vertical
Compensation percentages for the first separation. Click the Add button again to define compensation
percentages for other separations.

Note:  The first entry (Horizontal and Vertical Compensation) will be used for the first separation
printed, the second for the second separation printed, etc.

Resizing PDF Contents

If you don't select Resize to a specific page size, you can resize/reposition the PDF contents using the following
parameters:

1. In the Page Content area, select the Page Box to Use for positioning, scaling, etc.

2. Select Center content on page if you want to center the page contents on the page.

3. Select Mirror page if you want to mirror the page contents horizontally.

4. If desired, use the Scale parameter to define a scaling to apply to the artwork before placing it on the page.

Note:  The Scale, Horizontal Distortion and Vertical Distortion parameters are not available when
selecting Scale to Fit (Reduce Only) or Scale to Fit (Reduce & Enlarge) in the Position parameter.

5. If desired, enter a Horizontal Distortion and/or a Vertical Distortion to apply to the artwork before placing it on
the page.

Distortion is a stretch of the jobs’ original dimensions. It is specifically important for Flexo jobs.
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When mounting a Flexo plate on the press, it is stretched out in one direction. By making the output slightly
smaller than needed, we compensate for this distortion. The dimensions of the original file remain unchanged.

You can either enter the distorted output values (e.g. 97% or 103%), or the positive/negative distortion values (e.g.
-3% or +3%). Leave the values at 100% (default) to apply no distortion.

6. In the Page Size area, use the Set Orientation parameter to alter the orientation of every page without resizing it.
You can choose either:

• Keep,
• Portrait,
• Landscape.

7. Use the Rescale page boxes and Rescale page size parameters to define what happens when you scale the page
contents:

a) Select Rescale page boxes to scale the page boxes together with the contents.

Deselect it to only scale the page contents and not the page boxes.
b) Select Rescale page size to scale the page size together with the contents.

Deselect it to only scale the page contents and not the page size.

8. Define Web Growth Compensation if necessary.

Web Growth Compensation allows you to compensate or simulate the “growth” of the paper after every separation
is printed on a web press.

• To compensate for web growth, enter a negative percentage to make every separation slightly smaller than the
previous one.

• To simulate web growth (e.g. for proofing), enter a positive percentage, to make every separation slightly
bigger than the previous one.

Note:  Web Growth Compensation/Simulation is only possible on separated files. If it is applied (value
other than 0) to a non-separated file, the job will fail.

You can use either no Web Growth Compensation (None), Simple or Complex Web Growth Compensation.

• Simple: this only applies compensation/simulation in the vertical direction (since this is the direction the paper
grows on web press).

In the Web Growth parameter (displayed when you select Simple), enter the (positive or negative) growth
percentage to apply to every separation printed.

If for example your printing order is CMYK, and the Web Growth Compensation parameter is set to 0.2%, the
Cyan separation will be at 100%, the Magenta will be at 100.2%, the Yellow will be at 100.4%, and the Black
at 100.6%.

• Complex: with complex Web Growth Compensation you can define a different Web Growth Compensation
percentage to apply to every separation, horizontally and vertically.

After selecting Complex, click the Add button and enter the Horizontal Compensation and Vertical
Compensation percentages for the first separation. Click the Add button again to define compensation
percentages for other separations.

Note:  The first entry (Horizontal and Vertical Compensation) will be used for the first separation
printed, the second for the second separation printed, etc.

Resolve OPI

Use this task to resolve the OPI-links (links to external high-resolution images) in incoming PDF files that contain the
low-resolution images and links to the corresponding high-resolution images.
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Note:  You can use SmartNames in most fields of this dialog. For information on SmartNames, see Using
SmartNames

Repository tab

• Add the location(s) of the external folder(s) that contain(s) the OPI-files.
• If necessary, add the location(s) of the excluded folders. These folders will not not be searched.

Note:  Use this option if all images can be found on the same volume and you want to exclude all folders
containing low-resolution files.

• Select the option Update OPI links only to only update the links to the high-resolution images and not to replace
the links by embeddeding the high-resolution images.

Mapping tab

Add the extensions that need to be replaced while resolving the OPI-links:

• In the From field enter the original extension. If left blank, the extension in the To field will be applied to all
linked files.

• In the To field, enter the new extension to give the linked files, or a comma-separated list of extensions to use as
replacement for the original extension.

Note:  If you enter multiple extensions, Automation Engine will search for a file matching one of them. Use
the backslash ( \ ) to preserve a character (for example to use a comma as part of an extension and not as a
separator).

Restore Job

Use this task to restore job folders you archived previously (see Archive Job).

1. Use the Output in field to define where to place the restored job.

This can be the job's original location, or another location.

2. Define the Job Name to use.

By default, this field contains the [JobName] SmartName, meaning that the original job name will be used when
restoring the job.

3. Define the Order ID and SubOrder ID to assign to the job.

By default, the original IDs are used (the fields contains [Order ID] and [SubOrder ID]).

4. Define the job's new Due Date.

You can choose a day and an hour or reuse the job due date.

5. If you want to delete the archive after restoring it, select Delete archived data.

6. Click Launch.

Rip IMP File to Screened and Unscreened Tiff File

This task is a combination of the Rip to Screened Tiff File task and the Export Imposition to GRI File task.

Rip to CDI LEN File

This task has a lot of settings in common with the Rip to Screened Tiff File task.

Select the device on which you want to expose.

This task has five tabs:
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• General (see the Rip to Screened Tiff File ticket.)
• Inks (see the Inks tab in a Rip to Screened Tiff File ticket.)
• Advanced (see the Advanced tab in a Rip to Screened Tiff File ticket.)
• Pre-Rip (see the Advanced tab in a Rip to Screened Tiff File ticket.)
• Output

Output

Note:

Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a blue icon .

 

 

Configuration Set

Name of the selected configuration file. These configuration files represent specific behavior of the output device.

Output File

Path: leave this empty to use the output path as defined in the Dispatcher (EskoLink queue - Output tab). If your
EskoLink queue has no value for the output place; then you can define output folders here.

Name: leave this blank to get an output file name based on the input file. The output name of a multipage file will
look as follows: <file >_<page>_<sink>. Non-multipage file will loose the <page> indication. Edit this to overrule
this standard behavior. Only plain letters and numbers will be allowed. Other, unsupported characters (symbols) will
be replaced by an _.

Resolution
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Define the resolution of the output file.

• Perimeter: When a predefined configuration set is chosen, this perimeter field will be grayed out and will show
the perimeter as it was set in the device queue (see Configure tool). When no ‘conf’ was selected. You will be able
to edit this field

• Pixelclock: Choose here the appropriate Pixelclock of your CDI. This field will most probably be fixed as it does
read what CDI type your device queue was based on (in the Configure tool). ‘VariablePLL ’ CDIs will not show
the Pixelclock field nor the Perimeter field.

• Actual resolution: This informational field shows the result of the desired resolution and the effect of the
perimeter on that desired resolution. It is the combination of these two, the so called ‘actual resolution’ that will be
requested to the Rip. The FlexRip will then (see the log file) round off any non-integer number.

Compression

Indicates the compression method that will be used.

Rip to Screened and Unscreened DCS File

This task has a lot of settings in common with the Rip to Screened Tiff File task.

Select the device on which you want to expose.

This task has five tabs

• General (see the Rip to Screened Tiff File ticket.) There's the obvious distinction between the Screened and
unscreened DCS file. The unscreened ticket will not show the screening options.

• Inks
• Advanced (see the Rip to Screened Tiff File ticket.)
• Pre-Rip (see the Rip to Screened Tiff File ticket.)
• Output

Note:

The fields in gray are the presets that are defined in the Dispatcher Queue settings.

Output

Note:

Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a blue icon .
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Configuration Set

Name of the selected configuration file. These configuration files represent specific behavior of the output device.

Output File

Path: is defined in the Dispatcher (EskoLink queue - Output tab). If your EskoLink queue has no value for the output
place; then you can define output folders here.

Name: leave this blank to get an output file name based on the input file. The output name of a multipage file will
look as follows: <file >_<page>_<sink>. Non-multipage file will loose the <page> indication. Edit this to overrule
this standard behavior. Only plain letters and numbers will be allowed. Other, unsupported characters (symbols) will
be replaced by an _.

Select a Resolution.

Single File DCS: when this toggle, all separations will be ripped to separate files first. Afterwards, they will all be
included in the final DCS file. This means that in the end only one file is created. If you don't select this toggle a
Master file will be created, referring to plate files. The number of plate files to which is referred equals the number of
separations.

Compression

Choose the compression for the output TIFF file: Flate, LZW or CCITT Group.

The LZW compression is most commonly used.

CCITT group compressions are more effective but take longer to generate (and to decompress on the receiving side).

The compression to use in your workflow depends on the TIFF downloader on the device you are creating the TIFFs
for.

Define the Preview resolution.
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• For placement only (in a DTP application)
• Proofable Preview (composite printing from a DTP application)

Inks

 

 

All Inks. The standard behavior of the default ticket is to offer all inks in the job to be exposed. Deactivating ‘All
Inks’ opens the ink list where you can select specific inks.The list contains ink names, ruling, angle, dot shape and ink
type.

Use technical inks in output. Normally technical inks are hidden when you save a job in an Esko editor. Check the
box to output the visible (non hidden) technical inks.

Keep similar inks in their original separations

Keep inks separated

Use Merge with to output inks on top of each other in the same output file. This is common when you use different
rulings for 1 ink.

For example, Let's assume that the job contains two Cyans, and that they have a different ruling. You might want to
put them on the same separation. You can do so by clicking in the 'Merge with' column and selecting the ink it has to
be merged with.

Click Merge Similar Inks to prompt the system to look for the same inks with a different ruling or angle. The image
shows how two Cyans (with a different ruling) were detected and put together. You can reset any modifications by
clicking Reset.
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Check the box Highlight modified values to have all modified values highlighted and preceded or followed by an
asterisk.

 

 

Rip to Screened and Unscreened PDF File

This task has a lot of settings in common with the Rip to Screened Tiff File task.

Select the device on which you want to expose.

This task has five tabs
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• General (see the Rip to Screened Tiff File ticket.) There's the obvious distinction between the screened and
unscreened PDF file. The unscreened ticket will not show the screening options.

• Inks (see the Rip to Screened Tiff File ticket..)
• Advanced (see the Rip to Screened Tiff File ticket.)
• Pre-Rip (see the Rip to Screened Tiff File ticket.)
• Output

Note:  The fields in gray are the presets that are defined in the Dispatcher Queue settings.

Output

Note:

Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a blue icon .

 

 

Configuration Set

Name of the selected configuration file. These configuration files represent specific behavior of the output device.

Plate Size
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This shows the plate size of the configuration file you selected.

Output File

Path: leave this empty to use the output path as defined in the Dispatcher (EskoLink queue – Output tab). If your
EskoLink queue has no value for the output place; then you can define output folders here.

Name: leave this blank to get an output file name based on the input file. The output name of a multipage file will
look as follows: <file >_<page>_<sink>. Non-multipage file will loose the <page> indication. Edit this to overrule
this standard behavior. Only plain letters and numbers will be allowed. Other, unsupported characters (symbols) will
be replaced by an _.

Select a Resolution.

Anti-aliasing When ripping to Unscreened PDF files the output tab offers the option to use Anti-Aliasing.Anti-
aliasing is relevant for the line-art objects in your design, that need pre-processing and for which CTs are generated.
Anti-Aliasing smoothens the staircase effect you get in the generated CTs of line-art objects that need pre-processing.

PDF Version

Select a PDF version from the list.

• PDF for Illustrator: Select this version if you want to open the generated PDF 1.4 file in Adobe Illustrator CS2 or
higher. Because Adobe Illustrator only supports a (undocumented) subset of PDF 1.4 features, some objects and/
or colorspaces must be split up, transformed and/or pre ripped in order to correctly represent them in Illustrator.

• PDF/X-1 a:2001 (ISO 15930-1)
• PDF/X-3 (ISO 15930-2)
• PDF 1.4: the Acrobat 5 file format

Single / Multi file

When selecting 'single' file output, all separations will be ripped to separate files first. Afterwards, they will all be
included in the final PDF or PostScript file. This means that in the end only one file is created. Selecting 'multiple' file
output creates a Master file, referring to plate files. The number of plate files to which is referred equals the number
of separations.

Softproofing

When soft proofing is enabled FlexRip/P writes a composite PDF file that combines the different separations in a
single PDF page. This PDF file can be used for colored viewing in Acrobat.

The combination of 'Single file' with 'Softproofing', can lead to four situations:

• All separations are written in a different page, and all pages are written in a separate output file. (no soft proofing,
multi file)

• All separations are written in a different page, and all pages are concatenated in a single file. (no soft proofing,
single file)

• Separations are kept together per page, and all pages are written in a separate output file. (soft proofing, multi file)
• Separations are kept together per page, and all pages are concatenated in a single file. (soft proofing, single file)

Compression: choose between CCITT (group 3 and group 4), Flate, RLE, LZW, JPEG and 'No compression'.

Encoding

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly all of the printable
ASCII character set. The resulting expansion factor is 4:5, making this encoding more efficient than hexadecimal.

• Binary: The image data is represented as binary data. This results in compact files that however are not editable in
a common ASCII editor. Nor can these files be sent over a communication line using a communication protocol
that relies on control characters in the data stream itself.
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• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They also can be sent
over a communication line using whatever communication protocol is available. The drawback, however, is that
hexadecimal image data may take up to twice as much size as binary data.

Rip to Screened and Unscreened PostScript File

This task has a lot of settings in common with the Rip to Screened Tiff File task.

Select the device on which you want to expose.

This task has five tabs

• General (see the Rip to Screened Tiff File ticket.) There's the obvious distinction between the screened and
unscreened PS file. The unscreened ticket will not show the screening options.

• Inks (see the Rip to Screened Tiff File ticket..)
• Advanced (see the Rip to Screened Tiff File ticket.)
• Pre-Rip (see the Rip to Screened Tiff File ticket.)
• Output

Note:

The fields in gray are the presets that are defined in the Dispatcher Queue settings.

Output

Note:

Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a blue icon .
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Configuration Set

Name of the selected configuration file. These configuration files represent specific behavior of the output device.

Plate Size

The plate size of the above selected configuration file is shown.

Output File

Path: leave this empty to use the output path as defined in the Dispatcher (EskoLink queue – Output tab). If your
EskoLink queue has no value for the output place; then you can define output folders here.

Name: leave this blank to get an output file name based on the input file. The output name of a multipage file will
look as follows: <file >_<page>_<sink>. Non-multipage file will loose the <page> indication. Edit this to overrule
this standard behavior. Only plain letters and numbers will be allowed. Other, unsupported characters (symbols) will
be replaced by an _.

Select a Resolution.

Anti-aliasing When ripping to Unscreened PostScript files the output tab offers the option to use Anti-Aliasing. Anti-
aliasing is relevant for the line-art objects in your design, that need pre-processing and for which CTs are generated.
Anti-Aliasing smoothens the staircase effect you get in the generated CTs of line-art objects that need pre-processing.

Single / Multi file When selecting 'single' file output, all separations will be ripped to separate files first. Afterwards,
they will all be included in the final PDF or PostScript file. This means that in the end only one file is created.
Selecting 'multiple' file output creates a Master file, referring to plate files. The number of plate files to which is
referred equals the number of separations.

Compression Choose between CCITT (group 3 and group 4), Flate, RLE, LZW, JPEG and 'No compression'.

Encoding

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly all of the printable
ASCII character set. The resulting expansion factor is 4:5, making this encoding more efficient than hexadecimal.

• Binary: The image data is represented as binary data. This results in compact files that however are not editable in
a common ASCII editor. Nor can these files be sent over a communication line using a communication protocol
that relies on control characters in the data stream itself.

• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They also can be sent
over a communication line using whatever communication protocol is available. The drawback, however, is that
hexadecimal image data may take up to twice as much size as binary data.

Rip to Screened and Unscreened Tiff File

Select the device on which you want to expose.

Note:  The fields in gray are the presets that are defined in the Dispatcher Queue settings.

General
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Transformations

Scale V and Scale H: Define here in % the requested vertical or horizontal scaling. Scaling direction is always
applied ‘as the file is ’ (so the V and H are the V and H as you see them in the editor).

Rotate: Choose the requested rotation from the list. Rotation is counter clockwise.

Shrink values from File: GRQ (QuickStep) jobs that have shrink values defined inside the GRQ file will show these
values here. You can choose to deactivate the toggle and still edit (overrule) the values.

Attention:

If you use both scaling and distortion (shrink) options, then both these scaling values will be executed!

For example: if you have distortion V 98% set here and in the above options Scale V 95%, then the output-
size for V will be 98% of 95% (which is 93.1 %).

So the job will be scaled first and then distorted.

Positive-negative : Define whether you want a positive or negative output file.
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Mirroring : Choose whether you want mirroring or not.

Original Size (incl. Margins):The system provides the original Job size, margins included.

Output Size (incl. Margins): The real output size. The size shown here is the original job size influenced by the
scaling factors (and/or distortions) and the chosen rotation.

Select a Mark Set from the dropdown list. These marks were created (in a central database) by the SmartMarks tool
in the LineWork editor (from the Production menu ).

Screening

Note:  The Screening options will not be shown in the Rip to Unscreened Tiff File ticket.

• Type: choose between Esko Classic (Precalculated), DynaCell, DynaCell HighlineXM, HighlineXM and
Seamless.

• Dotshape: The selection of JOB (Dotshape(s) from job)’ will show in orange when the job does not have the
predefined dots (in its ink menu).

Attention:  You can expose with an 'orange' dot shape, but the Rip's default dotshape will be used then.

Press Dot Gain Compensation

• Single Curve: Select the preferred DotGain Compensation Curve.
• Automatic: Select the preferred Screen based Dot Gain Curve.
• Platemaking DGC: displays the platemaking DGC defined (if any) in the FlexRip Configurator.

Tip:  The Dot Gain Compensation will be applied to Smart Marks as well. The Curve will be applied and
compensated for smart marks. To prevent this, rip smart marks spearately as copy-dot files.

Inks
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Inks on separate TIFF files This toggle appears when you're outputting to a merging device. Toggle it on to make
sure that different inks end up on different films.

All Inks The standard behavior of the default ticket is to offer all inks in the job to be exposed. Deactivating ‘All
Inks’ opens the ink list where you can select specific inks. The list contains ink names, ruling, angle, dot shape and
ink type.

If you are granted the Ink remapping in inks panel access right (see Access Rights on page ), you can edit the
inks.

Double-clicking the color swatch opens the Edit Ink dialog:
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You can edit Lpi, Angle and Dotshape. Click 'OK' to apply the changes, 'Cancel' to close the dialog without applying
the changes and 'Reset' to reset all values to default ones.

Use technical inks in outputNormally technical inks are hidden when you save a job in an Esko editor. Check the
box to output the visible (non hidden) technical inks.

Keep similar inks in their original separations

Keep inks separated

Use Merge with to output inks on top of each other in the same output file. This is common when you use different
rulings for 1 ink.

For example, let's assume that the job contains two Cyans, and that they have a different ruling. You might want to
put them on the same separation. You can do so by clicking in the 'Merge with' column and selecting the ink it has to
be merged with.

Click Merge Similar Inks to prompt the system to look for the same inks with a different ruling or angle. The image
shows how two Cyans (with a different ruling) were detected and put together. You can reset any modifications by
clicking Reset.
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Check the box Highlight modified values to have all modified values highlighted and preceded or followed by an
asterisk.

 

 

Advanced
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Hold In Rip Queue This option offers to hold the task in the rip-queue until someone manually releases this task. For
more information, please see the Tasks View.

Choose between:

• Don't change Y ruling: this is the default, the Y ruling is not adapted.
• Change Y ruling: change the Y ruling, possibilities are: -15%, -7%, 0% (changes nothing), + 7% and +15%.
• Change Y ruling stochastic: same as the 'Change Y ruling' settings, but the dotshapes is adapted to the Monet dot.

Merge Queue

 

 

If the device queue of a FlexRip/T4 Dispatcher allows the use of the Handlers’s background Merger software (see
setting in the Configure tool), you will get this extra ‘Merge ’ options tab.

Merge with other jobs Choose here if you want that merger program to merge these separations with separations
from other jobs or not. 'Merge with other Jobs' is deactivated by default.



408 | Automation Engine | The Tasks: an Overview

When activating the ‘Merge with other jobs’, the other merge options will be offered.

Hold in Merge Queue This will ‘hold’ the separations in the merger database. This means they are ‘not to be
considered for merging’. Use the Merger Monitor to see this database and to release the entries that were put on ‘hold
in merger’.

Force after… Use this toggle to have the separations be forced out of the merger database after a chosen time. This
prevents having to wait too long before the ‘minimum fill %’ has been reached.

Priority decides on the priority that entries will have in the merger database. Entries with a high priority will be
chosen sooner for merging with other entries.

Restriction The separations will only merge with other separations of jobs that have received the same restriction
value from the operator.This value can be anything, whatever makes sense for your workflow. Some examples:

• fruit This word 'fruit' could be the restriction: these separations will only be merged with other separations that
were also sent with the same restriction : the word 'fruit'. Practical reason could be that you wish to bundle the
'banana', 'cherry' and 'apple' job all on the same film.

• Bob. The word 'Bob' could be operator Bob's restriction to only get films with separations of 'his own jobs'.

Pre - Rip

 

 

The Pre-Rip tab contains options that are only relevant when the job really needs pre-ripping. The Pre-ripping
mentioned here is the ‘simplification’ that can be necessary before the job-objects can be offered to the Rip. The
decision to do this is taken automatically. And even when this is done, the options are best left to their default
settings. Special objects (in Normalized PDF format) that require the need for this ‘simplification for rip' pre-ripping
are:

• ‘Edge vignettes’ (vignettes with alpha channels effect on the edge of the object)
• Barco Blends (=non contourized GRO-blends)
• Warped CTs (warping done on Placed CTs)

Pre-ripping results in making a plain CT of these special objects that the rip can handle them. The resolution of such a
CT and the anti-aliasing can be set here.

CT Resolution

• Custom: The CTs created during pre-ripping will be at the resolution given by the user. This is the default choice
(with a value of 304.8 ppi) and guarantees the behavior of previous Esko Software Suite versions. This option
allows for maximum flexibility in CT resolution setting but is independent of output resolution.

• Output: The CTs created during pre-ripping will be at the same resolution as the output resolution of the rip,
with a maximum of 1000ppi. When selecting 'Output', the text field containing the CT resolution shows what that
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resolution will be, but remains un-editable. This option allows for the rip output to be optimal, but may slow down
pre-ripping and may require more disk space.

• Automatic: The CTs created during pre-ripping will be at a resolution as close as possible to 300 ppi, depending
on the output resolution. This CT resolution is calculated in such a way that the output resolution of the rip is an
integer amount of times this CT resolution. When selecting 'Automatic', the text field containing the CT resolution
shows what that resolution will be, but remains un-editable. This option is a compromise between optimal rip
output and fast pre-ripping using minimal disk space. Examples: If the output resolution of the rip is set to 609.6
ppi, then the CT resolution will be set to 304.8 ppi.If the output resolution is 600 ppi or 1200 ppi, then the CT
resolution will be set to 300 ppi.

Specify the output resolution for the generated CT(s). Default output resolution is 12 lpmm or 304 ppi.

Anti-aliasing is relevant for the line-art objects in your design, that need pre-processing and for which CTs are
generated. Anti-Aliasing smoothens the staircase effect you get in the generated CTs of line-art objects that need pre-
processing.

Vignette NoiseSmoothens the tone jumps or banding effect in vignettes by adding noise/grain (in %). The amount of
noise can be specified in the noise field. The higher the value, the more noise (grain) is added.

The Blend to CT toggle converts the Barco Graphics blend objects into a CT when exposing your job.

Use the Smooth Blend toggle to set the steps of the blend objects to 255 steps when exposing your job. As long as
Convert Blend Objects to CT is not activated, Smooth Blend appears dimmed. When Convert Blend Objects to CT is
activated and Smooth Blend also, the generated CT will ignore the original steps of the blends of your Barco Graphics
design. The amount of steps is set at the maximum which is 255. The goal is to obtain a fluid blend effect.

Output

Note:

Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a blue icon .
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Configuration Set

Name of the selected configuration file. These configuration files represent specific behavior of the output device.

Plate Size

The plate size of the above selected configuration file is shown.

Output File

Path: leave this empty to use the output path as defined in the Dispatcher (EskoLink queue – Output tab). If your
EskoLink queue has no value for the output place; then you can define output folders here.

Name: leave this blank to get an output file name based on the input file. The output name of a multipage file will
look as follows: <file >_<page>_<sink>. Non-multipage file will loose the <page> indication. Edit this to overrule
this standard behavior. Only plain letters and numbers will be allowed. Other, unsupported characters (symbols) will
be replaced by an _.

Select a Resolution.

Anti-aliasing When ripping to Unscreened PostScript files the output tab offers the option to use Anti-Aliasing. Anti-
aliasing is relevant for the line-art objects in your design, that need pre-processing and for which CTs are generated.
Anti-Aliasing smoothens the staircase effect you get in the generated CTs of line-art objects that need pre-processing.

Compression Choose the compression for the output TIFF file. The LZW compression is most commonly used.
CCIT group compressions are more effective but take longer to generate (and to decompress on the receiving side).
Which compression to use in your workflow depends on the TIFF-downloader of the device you are creating the
TIFFs for.

Run Script

You can use this task to run a script on the input file. You can run AppleScript, Shell Script in Mac while you can
Batch File and Windows Script in Windows . You can use scripting to automate Adobe Illustrator, Photoshop,
InDesign and InDesign Server via ExtendScript in Mac and Windows.
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1. Run on: is the name of the computer where your Automation Engine ScriptRunner is installed. You can read
more about configuring and naming Script Runner here Scripts

See Scripts for details on how to configure a Script Runner to your Automation Engine server.

2. Select the Script Type. You can choose from AppleScript, Shell Script and ExtendScript in Mac OS. You can
choose from Batch File, Windows Script and ExtendScript in Windows.

3. Select the Script File. You can browse to it, enter a path or/and use SmartNames.

4. If the script you want to run needs one or more parameter(s), enter them in Script Parameters: click Add and
type the parameters.

Select File

The Select File task allows you to select one or a group of files on which you can execute actions specified by the
ticket that is chained to the Select File task. The Select File task is always part of a task chain.

The biggest advantage of the Select File task is that it allows you to chain any task to this task: Copy or Move File,
Upload via FTP, Zip, Delete...

Note:  For example, you can make a task chain with of the following steps: Mark File + Normalize
PostScript / PDF / Illustrator 8.0 File + Export to PDF File + Select File + Copy or Move File.

Note:

From Automation Engine 10, you can use graphical workflows instead of task chains. Those workflows are
more efficient and flexible, with advanced selection and routing capabilities.
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See  The Workflow Editor on page  for more information.

 

 

Use this task to define which files you want to select and pass on to the next task in the chain.

Note:  You can use SmartNames, and * as wildcard character in all input fields.

1. Define what file types you want to select in the File Type list. You can:

• choose to select Any file type,
• pick one of the default file types,
• choose Select File Types and pick your desired file types in the Select File Types dialog.
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2. Select which files you want to select:

• Select task's input files will select all input files (of the selected File Type if you specified one).

Use the Only select when name matches option if you want to filter the input files to select based on their
name.

• Select marked files will select files you have marked earlier in the task chain (using the Mark File task).

Use the Only select when name matches option if you want to filter the marked files based on their name.
• Select Product Parts linked to a job with name will select Product Parts linked to a job of your choice.

Specify the job name in this option.

Use the Only select when File name matches option if you want to filter the Product Parts based on the name
of the file they contain.

See for Working with Products on page  more information about Products and Product Parts.
• Select other will select other files or folders (that have not been processed by the task chain).

1. Choose to select Files or Folders.
2. Use the Name Matches option to select those files or folders based on their name. This is not case

sensitive.
3. Define where the files or folders to select are located in Look in Folder. Choose to Look in subfolders or

not.
3. If desired, you can choose to make the Task end in Error when no files were selected.

Send E-mail

You can use this task to have Automation Engine send an e-mail automatically at a certain point in your workflow.

This e-mail can contain:

• custom text,
• job information (you can use SmartNames in all of the ticket's fields),
• the task input files.

Note:  The mail server settings must be correctly set in Configure for this task to work. See E-Mail
Configuration on page .
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1. Enter the e-mail address(es) you want the e-mail to be sent To. If you want to send the email to the customer, add
the SmartName(email address) from SmartName category Customer email address You can use SmartNames to
add the email address of the Task owner from Task information category in the SmartName field.

Note:  If you use SmartNames, make sure they resolve to a valid e-mail address.

2. If desired, add extra e-mail address(es) in Cc.

3. Enter the desired e-mail Subject.

4. Enter your Message.

5. By default, the Send E-mail task uses the system's local encoding.

If you notice unreadable characters when reading an Automation Engine e-mail in your e-mail program (for
example for Asian characters), you can change the encoding to UTF-8.

Add this to the Message field: to...

#set ($SubjectCharSet="utf-8") set the encoding of the Subject to UTF-8.

#set ($ContentType="text/
plain;charset=utf-8")

set the encoding of the Message to UTF-8
and use plain text.

#set ($ContentType="text/
html;charset=utf-8")

set the encoding of the Message to UTF-8
and use HTML.

6. If you want to include the task input files, select Attach input files.

7. You can set public parameters if you want to be able to fill in e-mail settings when submitting files to your
workflow from Shuttle.

See Using Public Parameters in the User Guide for details.

8. Save your ticket if you want to use it as an e-mail template later.

Note:

Self-closing tags are not supported (example <br/> or <address/>). When setting up HTML e-mails, you have
to use a separate opening tag and closing tag (example <address></address>), or the empty variant (example:
<br>).

Send PostScript File to Device

This task outputs a PostScript file to a PostScript device.

Use the dropdown list to select the PostScript device you want to output to. The devices are PostScript devices
defined on the server.

Send to Nexus

The Send to Nexus ticket consists of two parts:

• the top section of the ticket dialog is always the same, and allows you to:

• select a particular Nexus workflow from the Workflow list;
• indicate whether you want to launch a new, separate workflow in Nexus for every file you select in the Pilot

(Separate Tasks), or whether you want to send all the selected files to one Nexus workflow (One Single
Task).

• the bottom section of the ticket dialog contains fields for the public parameters for the workflow you selected.
These parameters can be different for every Nexus workflow (they are defined using NeXML).

 



Automation Engine | The Tasks: an Overview | 415

 

For more information, please see Integration with Nexus in the User Guide.

Send to Odystar

The Send to Odystar ticket consists of two parts:

• the top section of the ticket dialog is always the same, and allows you to:

• select a particular Odystar workflow from the Workflow list;

Tip:  If you can’t see the workflow you are looking for, use the refresh button .

• indicate whether you want to launch a new, separate workflow in Odystar for every file you select in the Pilot
(Separate Tasks), or whether you want to send all the selected files to one Odystar workflow (One Single
Task).

• the bottom section of the ticket dialog contains fields for the public parameters for the workflow you selected.
These parameters can be different for every Odystar workflow (they are defined in the Inspector).

Note:  You can also manage your Odystar workflow’s public parameters (not one by one but as a group)
in your task ticket. See Managing Public Parameters in Your Ticket.
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Split Pages

The Split Pages task can split a multi-page PDF into single page PDFs, or smaller multi-page PDFs, and generate a
RunList that contains references to all output PDFs.

Output in: select where you want to output the generated PDFs and the RunList. By default, this is the location of the
original file ([File URL]).

File Name: Enter the name of the generated RunList. By default, this is [File]_RunList.jdf.

Split Mode: Choose how you want to split the pages of the input file:

• Split Pages: the task will split the job into individual 1-page files, and generate a RunList.
• Split in Groups: the task will split the job into several files having the same number of pages, and generate a

RunList. You can enter this number of pages in the Group Size parameter.
• Extract Pages: the task will extract the pages you specify in the Page Ranges parameter, and generate a RunList.

Note:  Depending on the Split Mode you choose, you will see different parameters.

Group Size: This parameter is available when you choose the Split in Groups Split Mode.

Enter the number of pages you want each output file to have.

Note:  If the task cannot output files having the same number of pages (for example if you send a 5 pages
PDF to be split into files of 2 pages), the last output file will have less pages.

Pages File Name: Use this parameter to set the name of the output files.

You can use SmartNames in this field, including two extra SmartNames: [Page Label] and [Page Number] (the page
label and page number included in the PDF).

Page Ranges: This parameter is available when you select Extract Pages in the Split Mode parameter.

Enter the page ranges to extract: either single pages or page ranges with a hyphen (e.g. 1-3 for pages 1 to 3).
Separate the page ranges by commas.

Output as one multi page document: This parameter is available when you select Extract Pages in the Split Mode
parameter.

Select it if you want to output all of the page ranges you entered as one single document.

Output remaining pages: This parameter is available when you select Extract Pages in the Split Mode parameter.

Select it if you want to output all the pages you didn't include in the Page Ranges parameter as one multi-page PDF.

Remaining Pages File Name: This parameter is available when you select the Output remaining pages parameter.

It allows you to set the name of the multi-page PDF containing all the pages you didn't include in the Page Ranges
parameter.

You can use SmartNames in this field (including the [Page Label] and [Page Number] SmartNames).

Copy XMP data: Select this parameter if you want to copy the XMP data of the original file to the output files.

Step & Repeat CAD based

This batch step and repeat task is based on a die-layout, it places graphic files on the different designs in the CAD
layout.
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This task supports MFG files (Artios Manufacturing files) and CFF2 files.

General

 

 

Location Stations Define the folder where the task can find the stations.

When the task is unable to find the correct files, set the task's status to:

• Provide Info
• Generate a warning, the task will continue.
• Generate an error, the task will stop.

Add SmartMarks by selecting a SmartMark set from the dropdown list. You can also use SmartNames.

Check the 'Load Mark Set in bottom layer' box if you want to make sure the marks are positioned in the bottom
layer, to make them appear 'behind' the graphics.

The Limit Bleed toggle: the bleed can be limited to a specific distance. The bleed mask is created by spreading the
die shape.

Plate Setup

The sheet size is automatically extracted from the CAD template but neither Artios MFG nor CFF2 have a notion of
plate. As a result the plate size and position of the sheet on the plate have to be specified in the Plate Setup tab.
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Plate Size: enter -if necessary- the plate's horizontal and vertical dimensions.

The Fit Plate to Sheet toggle makes sure that the plate has the same size as the sheet. Deselecting this option enables
you to manually define the plate size and the sheet offset.

Define horizontal and vertical Sheet Offset

Position the sheet on the plate by dragging and dropping the red square (the sheet) to the right position on the blue
square (the plate).

Enter horizontal and vertical shrink values.

Tip:  All edit fields are SmartName-enabled.

CAD Options
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Both Mapping and CAD Style are options you can define in the Scope Editors.

Mapping allows you to select a set of Mapping rules. Mapping rules allow to map DXF layer names, DXF line styles
and DXF color numbers onto line types (ArtiosCAD style). Use the mapping rules to indicate which DXF elements
will be imported as cut, crease or bleed lines. The mapping rules are scanned from top to bottom, as soon as a DXF
element matches a rule, the action corresponding with this rule (ignore or import as cut, crease, bleed) will become
effective.

A CAD Style changes the appearance of the imported CAD lines.

Step & Repeat Tabular

This task will execute all step and repeat parameters (number of one-ups vertically and horizontally, gap between
one-ups, alignment, SmartMarks...), and output the sheet layout.

The ticket’s input fields also accept SQL queries, so that information stored in a database can be used to drive the
sheet layout creation.

The main benefit of this process is the single entry point for data: the typical production-critical data required for step
& repeat is usually known upfront and stored in a project or workflow management system.

The operator doesn't have to enter these values from a printed sheet, which results in serious performance increases
and reduction of human errors.

Tabular typically means 'next to each other'. In this task, data can be entered in three different ways:

• Manually entered numeric values,
• Esko formulas like [VPLATE] (the Esko legacy QuickStep formulas),
• User - defined SQL queries that retrieve the values from external (DIE) databases.

General
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Origin: define the point of origin from which the repetition is to be built. Choose from four possible origins.

 (top left),  (top right),  (bottom left),  (bottom right).

Unit: select a unit (mm or inch).

SmartMarks: Select SmartMarks from the dropdown list if needed.

Insert SmartNames button   Click this button to open the SmartNames dialog. The button is only enabled if the
selected input field accepts SmartNames.

Tip:  Double clicking or right-clicking a field also opens the 'Insert SmartNames dialog'.
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Check the 'Load Mark Set in bottom layer' box if you want to make sure the marks are positioned in the bottom
layer, to make them appear 'behind' the graphics.

Plate

Size: enter the horizontal and vertical plate formula, value or SmartName(s). Shrink: if necessary, enter a shrink
value, formula or SmartName.

Sheet

Size: enter the horizontal and vertical sheet formula, value or SmartName(s) (see Formulas for details).

Offset: enter an offset value.

Sheet Position on Plate: position the sheet on plate by moving the red rectangle (the sheet) on the blue square (the
plate).

Screen registration: relevant only to Esko FlexRip users.

When activated, the origin of the screening will be reset for each one-up on the layout. This guarantees that the exact
same screening will be applied for each one-up.

When deactivated, screening will be done continuously throughout the complete job.

Tip:

Right-click a field to open an extra dialog:

• Cut
• Copy
• Paste
• Clear Contents
• Insert Formula (choose between a global or a grid formula). See Formulas.
• Insert SmartNames

Note:  Some fields only accept SmartNames defined with Scope 'Step and Repeat' where as others also allow
global SmartNames. See SmartNames for more information.

Grids

A repetition chart may be composed of several grids. If a repetition chart is composed of two jobs, there will be two
grids. Each grid has its own number.

Grid Tab Columns
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1. Grid number You can click it to select the corresponding grid.
2. File Name This shows the name of the one-up assigned to this grid.
3.

Grid Mask  To define the mask area around a job.

Depending on where the repetition is positioned in the layout, a mask may or may not be required. Use the
dropdown list to choose between 'none' or 'borders'. The dropdown list appears when you click the field.

4.
Grid Mask Bleed   To extend a selected grid mask with a bleed.

Specify the spread distance in the Grid Mask Bleed input box.

Mask is spread but masks will not overlap.
5.

Vertical offset to sheet  To define the top or bottom shift of the grid in relation to the sheet, depending on the
setup of the origin.

6. Horizontal offset to sheet  To define the left or right shift of the grid in relation to the sheet, depending on
the setup of the origin.

7.
Vertical step  To define the vertical distance between two steps of the grid. The distance is calculated from
center point to center point of the job.

8.
Horizontal step  To define the horizontal distance between two steps of the grid. The distance is calculated
from center point to center point of the job.

9.
Vertical count  To define the number of times you want to repeat your job vertically.

10. Horizontal count  To define the number of times you want to repeat your job horizontally.
11. Angle  To define the angle to rotate your job when repeated.
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12. Head Turn / Stagger This column indicates if you have defined a head turn or staggering for your grid (for

example,  for vertical stagger, or  for column-based head turn). See Grid Settings for details on staggering
and head turns.

Managing Your Grids

Add Grid: Use this button to add an extra grid.

Note:  When you select multiple files in the pilot, the system adds enough grids to accommodate all the jobs
you selected (the ticket is automatically updated).

Remove Grid: To remove a grid, select it and click this button.

Edit Grid: Select a grid and use this button to define advanced grid settings (staggering, head turns...). See Grid
Settings.

Other Options

Insert SmartNames...  opens the 'Insert SmartNames' dialog, which allows you to insert 'Formulas' in the
selected field.

Note:  Some fields (Grid Mask and Grid Mask Bleed) cannot contain formulas.

Allow Multiple Inputs

This option determines what the task will do when you launch it on multiple files.

• Select it to generate one Step and Repeat file for all of the input files. Each imput file will be assigned a different
grid in the Step and Repeat.

• Deselect it to treat each input file separately, and generate a different Step and Repeat file for each input file.

Attention:

This option is only available when you open the Step & Repeat Tabular ticket from the Tickets view.

To use this option on your files, save your Step & Repeat ticket as a custom ticket first.

Grid Settings
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In the Settings Grid x dialog, you can change settings defined in the ticket (File Name, Die Shape, Bleed, and
Geometry options), but also define advanced settings (Head Turn/Stagger).

Head Turn

Use this parameter to rotate certain stations in the grid by 180 degrees.

•

Use the first button ( ) to keep all stations as they are, without rotating them (default).
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•

Use the second button ( ) to rotate objects in alternating rows by 180°.
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•

Use the third button ( ) to rotate objects in alternating columns by 180°.
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•

Use the fourth button ( ) to rotate objects both in alternating columns and in alternating rows by 180°.
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Stagger

Use the Stagger option to stagger (move) certain stations of your grid horizontally or vertically.

•

Use the first button ( ) to keep all stations as they are, without staggering them (default).
•

Use the second button ( ) to define a vertical stagger for your grid.
•

Use the third button ( ) to define an horizontal stagger for your grid.

To define a horizontal or a vertical stagger:

1. Click the horizontal or the vertical stagger button.
2. Enter a stagger value and choose a unit in the fields below the stagger buttons (mm, cm, mil, inch or percentage of

the width or height).

The example below shows a 4 x 6 Step & Repeat with a 50% vertical stagger.
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3. Adjust your staggering with the Restart after, Continuous or Up & Down options if you wish.

Restart after

You can choose to restart the staggering after a certain number of rows or columns. This means that:

• for vertical staggering: the top station of that column is positioned at the same height as the top station of the first
column (it has the same vertical offset from the top of the sheet).

For example, the staggering below restarts after 3 columns.
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• for horizontal staggering: the first (leftmost) station of that row is positioned at the same horizontal offset as the

first station of the first row.

Continuous

Select Continuous if you want to add extra stations to fill the blank space.

The example below is a 4 x 6 Step and Repeat (with staggering restarting after 3 columns), but the Continuous option
added some stations vertically.
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Up & Down

Use Up & Down together with Restart after to go back in the other direction gradually instead of at once.

The example below restarts after 3 columns, with the Up & Down option selected.
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Rules

 

 

You can modify the task's behavior by defining rules. Click 'Add' to open the 'Add Rule' dialog:
 



Automation Engine | The Tasks: an Overview | 435

 

Define the 'Condition' and the 'Action'.

For example, we want to define a rule that states that all jobs with more than 8 inks shouldn't be output.

First you define the condition, then you define what happens if the condition is not met.
 

 

1. Enter the parameter you want to use as check.
2. Choose an 'expression' from the dropdown list.
3. Enter the value for the parameter.
4. Choose the Action for when the conditions is not met from the dropdown list: OR the task finishes with a warning

OR the task finishes with a warning (there's no output).
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Formulas

Some of the fields work with formulas, which act as parameters and may represent different things.

There are two different kinds of formulas: Global formulas (that define the whole repetition) and Grid formulas (that
define individual grids).

Note:  A repetition chart may be composed of several grids. If a repetition chart is composed of two jobs,
there will be two grids. Each grid has its own number.

1. Global formulas:

• VPLATEFIT: vertical plate size that fits around a repetition sheet and SmartMarks.
• HPLATEFIT: horizontal plate size that fits around a repetition sheet and SmartMarks.
• VPLATE: vertical plate size.
• HPLATE: horizontal plate size.
• VSHEETOFFSET: vertical offset of the sheet relative to the Plate.
• HSHEETOFFSET: horizontal offset of the sheet relative to the Plate.
• VSHEETFIT: vertical sheet size that fits around the repetition.
• HSHEETFIT: horizontal sheet size that fits around the repetition.
• VSHEET: vertical sheet size.
• HSHEET: horizontal sheet size.
• SHEETTOP: top position of the sheet relative to the Plate.
• SHEETLEFT: left position of the sheet relative to the Plate.
• SHEETBOTTOM: bottom position of the sheet relative to the Plate.
• SHEETRIGHT: right position of the sheet relative to the Plate.
• NROFINKS: number of non-technical inks (Technical inks will not be printed).
• NROFGRIDS: number of grids

2. Grid Formulas:

x = the grid number.

• VLABELx: vertical size of non-rotated job.
• HLABELx: horizontal size of non-rotated job.
• VSTEPx: vertical step size, from center point to center point.
• HSTEPx: horizontal step size, from center point to center point.
• VSIZEx: vertical size of bounding box of rotated job.
• HSIZEx: horizontal size of bounding box of rotated job.
• VCOUNTx: number of vertical repetitions in grid x.
• HCOUNTx: number of horizontal repetitions in gridx.
• ANGLE: the angle of the rotation.
• GRIDVSIZEx: vertical size of the grid (top-bottom).
• GRIDHSIZEx: horizontal size of the grid (left-right).
• TOPx: top position of the grid relative to the sheet.
• LEFTx: left position of the grid relative to the sheet.
• BOTTOMx: bottom position of the grid relative to the sheet.
• RIGHTx: right position of the grid relative to the sheet.
• BLEEDx: distance to spread the grid mask with.

This example illustrates how one could use formulas to define an auto fill repetition: a defined sheet will be
automatically filled.
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The formulas break down like this:

1.
First you define the vertical (and horizontal ) count of the grid: the vertical count is the vertical size of
the sheet divided by vertical size of the job, hence: VSHEET / VLABEL1. (The horizontal count: HSHEET /
HLABEL1.)

2.
Then you are able to define the vertical  (and horizontal ) step: vertical gap is the vertical sheet size
divided by the vertical count, hence: VSHEET / VCOUNT1. (The horizontal step: HSHEET / HCOUNT1).

3.
Now for the vertical  (and horizontal ) offset: you want to center the repetition on the sheet. You can
do that by defining the vertical offset as half the vertical step minus the vertical size of the job, hence: (VSTEP1-
VLABEL1)/2. (For the horizontal offset: (HSTEP1-HLABEL1)/2 )

Database Query: an Example

Let's say you have a database in which you keep data about the Die you use:
 

 

You might want to use this data to set up a Tabular Step and Repeat Ticket.

It's possible to define SmartNames in such a way that they query a database, and the Tabular Step and Repeat Task is
able to use SmartNames.

Note:

Use the Configure tool to define SmartNames (see SmartNames).
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You can define SmartNames that query all the values of your database, using SQL commands, in this example, we've
defined the following:

• DB_DrumH: Retrieves the value for the horizontal size of the drum.
• DB_DrumV: Retrieves the value for the vertical size of the drum.
• DB_GapH: Retrieves the value of the gap's horizontal size.
• DB_GapV: Retrieves the value of the gap's vertical size.
• DB_Teeth: Retrieves the number of teeth.
• DB_StepH: Retrieves the value of the die's horizontal step.
• DB_StepV: Retrieves the value of the die's vertical step.
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You can use the SmartMarks in the Step and Repeat Ticket: Use the Insert SmartNames... button, or use the right
mouse button shortcut.

The General tab:
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The Grids tab:

 



442 | Automation Engine | The Tasks: an Overview

 

The ticket is now defined by using nothing but values queried from the database. Your database controls the output.

Step & Repeat Template based

This task will make a layout based on an indicated template layout.

The layout will be exactly the same as the template as new design files are typically 'same size' variants of the ones in
the layout template.

It can be used for all print segments: labels, boxes, flexibles etc..

The template that is indicated in the ticket can be:

• a layout file: PDFPLA, even legacy layout files like PLA or GRQ.
• a Normalized PDF one-up file (that contains external references) - even legacy GRS.
• depending on the version, also specific JDF can be used (containing right 'stripping' info).

The output file will be a PDFPLA file. If you do not specify a name, it will simply receive the name of the file you
selected in the Pilot, with a '_rep' attached to it. So if you want to step and repeat 2345banana.pdf and you do not
define an output name, it will be output as 2345banana_rep.pdfpla.

1. Select a normalized PDF file in the Pilot.
2. Open the 'Step and Repeat - Template based' ticket.
3. Select a Template. Enter a path or click the Browse button.
4. The ticket will present a list of stations (externally referenced files), according to the template you selected.
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The Template in the example contained two stations, job A and job B. Job B will be replaced by the file you
selected in the Pilot (in this case Test1.grs). The other Station has not been substituted yet. You can do that by
clicking the browse button and defining a Normalized PDF file.

Obviously, you cannot step and repeat more Scope native files than there are dummy stations in the Template. But
you don't have to substitute all dummy stations. There is an option that automatically deletes the unsubstituted
dummy stations in a template.

5. You can add SmartMarks. Use the list to select a Mark.
6. When the borders of a station file and substituted file do not fit, you can define the status of the task.

• Provide info.
• Generate a warning. The task will continue.
• Generate an error. The task will stop.

Attention:  If you use a Template which contains legacy QuickStep macros, these macros will be lost. You
need to replace these macros with SmartMarks.

Submit To Gang Run

Use this task to submit a graphic file for ganging together with other graphics onto a particular substrate. You can
send PDF (single page or multipage), TIFF, PSD or JPEG files to this task.
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Note:  Progressive JPEG compression is not supported.

Read more in:

General Tab on page 

Back Tab on page 

Substrate Tab

Substrate Tab

General Tab

 

 

• In the General tab, specify the Quantity of that graphic that you want to print.
• You can select Maximum Fill if you want to print as many copies as will fit in one sheet (if you are not sure how

many copies fit exactly and you don't want to waste paper).
• If the input file is a downscaled version of your graphic, enter the Scale to be used.

For example, enter 1000% to compensate a graphic that was downscaled to 10%.
• Enter/choose the ink used for the cut path in the Cut path table (the drop-down list will contain all inks used in

the input file).

You can Add several inks (for example if you have customers from different countries using different ink names
like cut, dcoupe, taglio...) and Move them Up or Down the list. The order is important as the task will use
the first ink it finds in the list.

You can use SmartNames to retrieve ink names from the job setup.

Select Create cut path from trim box if no ink is found if you want to use the trim box to create a cut path when
a file doesn't contain any of the inks you specified.
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• Specify a Due Date for the nesting (when the sheet with the nested graphics needs to be printed).

Back Tab

 

 

• In the Back tab, you can specify what to print on the back of each repetition of the graphic:

• No graphics.
• Even pages of multipage file: if you choose this, the odd pages of the file will be printed on the front, and the

even pages on the back (this only works with multipage PDFs).
• Graphics from front side: choose this if you want to print the same graphic on the front and on the back.

If your graphic has an irregular shape, you can select Flip horizontally so both graphics face the same
direction and have the exact same contour for cutting.

If your graphic contains text, you shouldn't flip it as this will make the text unreadable.
• Other graphics: you can Browse to the graphic you would like to print on the back side.

Tip:  Give the graphics to print on the back a consistent name, and use SmartNames to retrieve them
(for example, [File]_back.[Extension of File]).

Substrate Tab

• In this tab, specify the Substrate of the graphic that you want to print from the list of predefined Substrates from
the Gang Run View. Read more in Gang Run Printing View on page 

• Specify the Size of the Substrate on which you want your graphic to be printed.

When you have several sizes available for the same Substrate, you may specify Any as Substrate Size. In this
case, the task will try nesting the graphics on the different substrate sizes, and will pick the best size for the job (or
a combination of sizes).
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Extra Tab

In this tab, you can specify the Customer ID  values for the custom fields for the jobs. If you have defined your
custom fields in  Tools > Configure , add values for them here.

 

 

Track Edit Session

Automation Engine can track and log interactive editing actions. Decide in Configure if and for which editors you
want automatic tracking to happen.

When you open a file that resides in an active Job (folder) in an Esko editor, the Track Edit Session task will
automatically start logging the interactive editing actions. This tracking will stop when the file is closed.

As this tracking is actually an Automation Engine task, this also enables:

• Notifications (for example XML for reporting to other systems).
• Automatic storage in the Task History.

 

 

Note:  This task cannot be launched interactively. The Track Edit Session task will appear in the Task View if
the task has been configured in the Configure Track Edit Session panel. Keep in mind that the editor needs to
be restarted to activate the settings.

Note:  Track Edit Session also works when editing your file with ArtPro, but in this case it will only record
session times, not editing details.

Viewing the Edit Session Information in the Pilot

In the Pilot, the Tasks View offers more information about the Track Edit Task.
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The logging of the editing actions will appear:

• In the Pilot’s message window of that task.
• In the task’s log files.
• In notifications (TXT or XML or E-mail format).This can happen by setting up a general notification rule for all

Track Edit Session tasks.

• It is possible to save all notifications locally in a job folder or centrally in one or several files.
• It is possible to name TXT / XML logs via SmartNames. Typically this is the name of edited file.

How to Store the Editing Information System-Wide?

Many users want to store all this editing information in a system-wide way. This can be done easily through the
standard Notifications tool (see Defining a Notification Rule on page ).

The Track Edit session task starts automatically, so unlike other task types, you will not create your own Track Edit
Session ticket to add the notification in there. In this case, all you need to do is setting a general notification rule for
this task type. This is done in the Configure panel.

How can this edit log be stored automatically?

• Either you save all edit logs inside the job folder. You will then have to indicate a path for the XML/TXT under
the [JOB URL] and decide if you want 1 (XML/TXT) log per file or per date or if you want all logs in 1 file.
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• Or you save all edit logs per customer or even system-wide. You will then have indicate a general path to a higher
level 'above' all Jobs.

1. Go to  Configure > Notification > Rules > .
2. Select the Track Edit Session task in the Tasks tab.
3. Click Add. The Notification Rule Editor opens.
4. For an XML file, select the Create XML File in folder as Action.
5. Define the folder's Location and click OK.

 

 

Which Edit Actions are Logged?

Among the items logged are:

• Which user opens which file from which workstation?
• Start and stop timings of this editing session
• Was the file saved? When and with what name?
• Loading, saving, placing, exporting functions
• All changes to inks
• All changes to (Esko) bar codes objects: creating, modifying, type change
• All changes to layers
• All changes to pages
• Starting, stopping a session. Loading, saving, placing, exporting files
• Changes of page size, of margins, of reader's spread
• Losing the connection
• HIFI conversions
• Ink mapping
• Trap edits
• External references: creating, replacing
• Layers edits: creating, renaming
• PSFix: Process, Remove Spurious Contours, Remove Double Contours, ...
• InkWizard: destination profile, CMYK profile, ...
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• Die object edits: adding, turning, flipping, rotating

This is an example of what information can be available in a Track Edit Session log.

*** Start interactive PackEdge 7.0 ***
        Time 13/01/06 17:19  
        User wde@backstage1  
        Automation Engine server BACKSTAGE1  
        Loading file file://backstage1/wdedata/52355/
Scope/52355_Leffe_back.pdf  
        Remove layer OMBRE  
        Trap with local ticket Default  
        "Modified ink angle for C from 22 to 7 degrees" 
        "Created ink PANTONE 123 C (100 lpi, 7 degrees, dot ?, type Normal)"  
        "Created ink C (170 lpi, 75 degrees, dot ?, type Normal)" 
        "Created ink M (170 lpi, 15 degrees, dot ?, type Normal)"  
        "Created ink Y (170 lpi, 90 degrees, dot ?, type Normal)"  
        "Created ink ROUGE (170 lpi, 45 degrees, dot ?, type Normal)"  
        "Created ink BISTRE (170 lpi, 45 degrees, dot ?, type Normal)"  
        "Created ink ILLOGLOSS (170 lpi, 45 degrees, dot ?, type Opaque)"  
        "Created ink K (170 lpi, 45 degrees, dot ?, type Normal)"  
        "Created ink EP (170 lpi, 45 degrees, dot ?, type Technical)"  
        "Created ink roc (170 lpi, 45 degrees, dot ?, type Technical)"  
        Placing file file://backstage1/wdedata/52355/
Scope/52355_Leffe_collar.pdf  
        Changed page margins to top 3.998701, bottom 9.998703, left 4.001198,
 right 66.0012 mm  
        Changed page size to width 110.0024 mm and height 73.99741 mm  
        PS-Fix: modified 2 contour(s)  
        Applied Job inkmapping  
        "Modified ink angle for C from 7 to 75 degrees"  
        "Modified ink angle for M from 37 to 15 degrees"  
        "Modified ink angle for Y from 82 to 90 degrees"  
        "Removed ink C (170 lpi, 75 degrees, dot ?, type Normal)"  
        "Removed ink M (170 lpi, 15 degrees, dot ?, type Normal)"  
        "Removed ink Y (170 lpi, 90 degrees, dot ?, type Normal)"  
        Changed page margins to top 7.25, bottom 7.25, left 7.25, right
 8.361092 mm
        Exporting file file://backstage1/wdedata/52355/
Scope/52355_Leffe_back.tif  
        Saving file file://backstage1/wdedata/52355/
Scope/52355_Leffe_back2.pdf  
        *** End interactive PackEdge 7.0 ***  
        Time 13/01/07 17:22  
        Notification:Wrote XML file:E:\wdedata\52355\Scope\EditSessions
\52355_Leffe_back.  
    

For a more technical explanation of the Track Edit Session task, please refer to the document “Track Edit Session
Task XML Contents” on the documentation DVD.

Trap with PowerTrapper

The advantage of using a PowerTrapper is that you do not have to prepare the PDF file or create the trap layer in
advance. In addition, you can trap the input file without an intermediate file. You get trapped Normalized PDF file as
the output of this task.

You can choose your trapping settings in the Distance & Direction, Color & Shape, Processing, Rules and Output
tabs.
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Distance & Direction
You can set the trapping distance and direction at the tab Distance & Directions.
 

 

1. Trapping

You can choose between two trapping modes:

• Normal Trapping: This selects adjoining color pairs, which are likely to cause registration problems like ugly
light gaps, and unwanted halo effects. Lighter colors are generally trapped into darker colors to minimize the
visual effect of the trap.

• Reverse Trapping: This prevents overprint of adjoining color areas by trapping these color pairs with a white
knockout (erasing) trap. The white knockout trap is put on top of the lighter of the two colors. This is useful to
prepare a job for Dry Offset printing (example: metal beverage cans). This avoids overprinting of inks.

2. Trapping Distance

Enter the width you want to give your traps. The unit used is the General unit defined in Illustrator's Unit &
Display Performance Preferences. The default trap width is 0.2 mm (or equivalent in your chosen unit).

You can choose more trapping distance specifications such as: into black, into spot, into image and into
pullback further down in this tab.

3. Minimum Ink Difference

Trapping is applied to two adjoining colors when either:

• The two colors each consist of at least one ink but they have no common inks.
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• The two colors have common inks but there is a difference of at least the Minimum Ink Difference
percentage for two or more inks making up these colors.

These differences in ink percentages must be in opposite directions.

For example, with the default minimum ink difference percentage of 10%, the following two colors are trapped:

1st color: C 5% M 10% Y 50% K 15% (+10% K)

2nd color: C 5% M 10% Y 85% K 5% (+35% Y)

Increase the Minimum Ink Difference to trap colors that differ more, lower it to trap colors that are similar.
4. Image Trapping

• Automatic (default): this determines the most suitable trap direction automatically, by comparing the average
lightness of the CT image with the lightness of the adjoining area, then traps the lighter color into the darker
one.

• Always Towards Images: this always traps line art under adjoining CT images.
• Always Towards Line Art: this always traps CT images under adjoining line art.

If you want images to be trapped with each other, enable Trap images to images.
5. Pull Back

You can use ink pull back to keep away all but the darkest ink of a color area composed of multiple inks bordering
to a very light background. It prevents individual inks from the composed color to become visible on the
background due to registration errors during the printing process.

• Automatic (default): this creates pull backs on rich black or rich spot colors, when the color left in the pull
back area is not very different from the composed color.

• Only Pull Back Rich Black: this only creates pull backs on rich black.
• Do Not Pull Back: this never creates any pull back.

There will be automatic pull back for the darkest color. You can enable Also pull back light inks option to create
pull backs even when the pullback ink (ink remaining in the pull back area) is visibly different from the composed
color. Enable Pull back images and gradients to create pull backs on images and gradients.

6. Treat all spot colors as opaque inks

You can enable this option to set the trapping direction by ink sequence. PowerTrapper uses the color luminance
to define the trapping direction by default except for opaque inks. PowerTrapper uses ink sequence to determine
trapping direction in the case of opaque inks. If the Treat all spot colors as opaque inks option is enabled, color
luminance is used only for CMYK. For opaque and spot inks, the trap direction is determined by the ink sequence.

7. Overshoot Mode

You can choose between the following three overshoot modes:

• Automatic (default): The centerline behavior is according the rules determined in the color pair list.
• Never on Dark Areas: The centerline is forced not to get beyond the center of dark areas.
• Never: The centerline is forced not to get beyond the center of any area.

Color & Shapes
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1. Trap Color Intensity

By default, PowerTrapper uses the full color of the object to spread in the trap (100% trap color intensity).

You can create a trap of a lighter color by reducing the trap color intensity percentage.
2. Image Trap Color

Choose how to trap your images:

• Use Original Image Data (default): When spreading an image, PowerTrapper uses the underlying image
data (when the image is clipped) to create the trap.

Note:  An empty trap is created, when there is no underlying image data (when the image is not
clipped).

• Extend Image Data: PowerTrapper automatically extrapolates the image along its top, right, bottom and left
edges to ensure that the trap looks as expected even if there is no clipped image data outside the visible image.

• Use an Approximate Flat Color: Instead of using existing or extrapolated image data in the trap,
PowerTrapper uses a solid color. A suitable color is determined by averaging the image's colors along its
boundary with the object to trap.

3. Truncate Traps

PowerTrapper can truncate the trap so that it does not stick out on another color. There are two truncation
modes:

• On Center (default): when a portion of a trap comes too close to the contour of another object,
PowerTrapper limits it to half the distance between the trapped object and the other object.

• On Edge: when a portion of a trap comes too close to the contour of another object, it is truncated on the other
object's edge.

4. End Caps

This option specifies how to shape the ends of an open trap.
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• Square (default): this option ends the trap at right angle to the adjoining object.
• Round: this rounds the ends of the trap. This option is typically only used in combination with white knockout

(reverse trapping).

Note:  We recommend that you do not to use Round End Caps together with Truncate Traps On
Center, as this can generate some artefacts (the round caps are truncated).

• Object Dependent: with this option, the trap is a logical continuation of the contour of the spread object.
5. Trap Corners

This option allows you to change how the traps’ sharp corners are handled.

• Round (default): a round cap will be placed at all corners.
• Beveled: this cuts sharp corners off.
• Mitered: this option works with a miter ratio.

The miter ratio serves to limit the length of the sharp corner (the distance from the base of the trap to the
corner point).

The default miter ratio value is 4. This means that if the length of the sharp corner is more than 4 times the
Trapping Distance, then the corner are cut off (beveled). If it is less than 4 times the Trapping Distance, the
corner are left as it is.

6. Advanced Settings

Click the collapsible button to show the advanced settings.

Truncate Traps

If you want to truncate traps into black differently, select Into black and choose the truncation mode (On Center
or On Edge).
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Processing

1. Color pairs

PowerTrapper can trap all hits (occurrences) of a color pair the same way or recalculate the trap direction for
different hits.

• Each hit can have its own decision (default): this recalculates the trap direction for each hit of a color pair.
• Use the same decision for all hits: this traps all hits of the same color pair in the same direction.
• Use the same decision for objects smaller than: this uses the same trap direction for hits of a color pair

belonging to small objects, and recalculates the trap direction for hits belonging to bigger objects.

Use the field next to the option to determine the maximum size of small objects. The unit used is the General unit
defined in Illustrator's Unit & Display Performance Preferences.

The default size is 1 mm (or equivalent in your chosen unit).
2. Objects

In some cases PowerTrapper can safely ignore certain object types to speed up the trapping.

• Only selected objects
• Respect existing traps: if your document has already been trapped, select this option to keep the existing trap

layer out of the trapping process.
• Ignore bitmaps: this keeps bitmap pixel data from being trapped. Bitmap data is contourized before trapping

which may slow down trapping depending on the bitmap's contents. Bitmaps with lots of small isolated islands
typically take a longer time to trap.

Note:  When you indicate an object type to ignore, it is ignored completely as if it did not exist in the
job. Also, the ignored objects does not truncate trapping areas resulting from other objects below them.

3. Small Gaps
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Some input jobs contain very small unintentional gaps between neighboring objects, preventing the correct
trapping of these objects. Although it is better to clean up such jobs before trapping, PowerTrapper can ignore
these gaps automatically.

To use this option, select Close when smaller than and enter the maximum size small gaps can have.

The unit used is the General unit defined in Illustrator's Unit & Display Performance Preferences.

The default size is 0.01 mm (or equivalent in your chosen unit).

Note:  If you set a big gap size, trapping may become slower and small parts of the job may be ignored
during trapping.

Rules
You can define custom trapping settings for specific trapping pairs using the Rules tab.

1. When to use rules?

In most cases the general trapping settings entered in the Distance &Direction gives you excellent results. You
can refine them using rules. If you add a rule that is not coherent with your inputs in the other tabs, PowerTrapper
will overwrite them with the rules

Note:  This is an advanced feature and we recommend it for experienced users.

You can specify exceptions to the general trapping settings for certain color pairs using Add Rule. Some of the
instances where you can use it are :

• to set a different trap distance for a specific spot ink. Sometimes you need a larger trap distance for spot inks if
there is no other ink to help cover leaks on the press.

• to prevent trapping or ink pull back in specific cases. Depending on the type of the adjoining colors, trapping
and / or pull back may be undesirable.

• to force a specific trap direction. PowerTrapper Standalone determines the trap direction based on the relative
lightness of the adjoining colors. If the colors have a similar lightness level, it selects an arbitrary direction.
You can use a rule to make it always use a particular direction for a color pair.

• to specify a different shape and/ or truncation mode for certain color pairs. For example, you can choose to use
“On Center” truncation when trapping under a 100% black line and “On Edge” truncation on all other color
pairs.

2. Creating a rule
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• Click the Add Rule button at the bottom of the Rules tab.
• In the pop-up that opens, choose the trapping pair to apply the rule to using the From and To lists. You can

create a rule to trap from/to: any color, a particular ink (process, spot or opaque), a particular object (image,
gradient or empty background) or the registration color.

Note:  When trapping a particular ink, you can choose the ink name from which Minimum Density
the rule is applied and if the color must be pure (no other separation in the color object) to apply the
rule.

• Choose the contents of the rule.

Options Description

Trapping Direction • Automatic lets PowerTrapper
Standalone calculate the trapping
direction.

• Force Trapping from ‘From’ to
‘To’ always spreads the “From”
color/object on the “To” color/
object.
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Options Description

• Do Not Trap ‘From’ to ‘To’ never
traps the “From” and “To” colors/
objects together.

Trapping Distance Use this to define a special trapping
distance for the trapping pair.

Trap Color Intensity Use this to define a special trap color
intensity for the trapping pair.

Pull Back • Automatic lets PowerTrapper
decide if there should be a pull back
on the trapping pair.

• Always Pull Back always creates a
pull back on the trapping pair. The
darkest ink of the pair is the pullback
ink (remaining ink in the pull back
area).

• Do Not Pull Back never creates a
pull back on the trapping pair.

Pull Back Distance Use this to define a special pull back
distance for the trapping pair.

Reverse • Automatic lets PowerTrapper
Standalone decide if the trapping
pair should have a reversed trap.

• Always Trap Reversed always
generates a reversed trap for the
trapping pair.

• Do Not Trap Reversed never
generates a reversed trap for the
trapping pair.

Truncate Traps Choose if traps generated for the
trapping pair should be truncated on
center or on edge.

End Caps Choose how to shape the ends of open
traps for the trapping pair (square, round
or object dependent).

Trap Corners Choose how to shape the trapping pair's
trap corners (round, beveled or mitered).

• If necessary, use the + button to add contents to your rule. You can use the - button to remove contents.
• After defining the rules, click OK button. You can now see your rule at the Rules tab.

When trapping your document, PowerTrapper traps the trapping pairs that match rules according to those rules
and the rest of your document according to the main trapping settings. If necessary, you can add another rule or
remove a rule previously created. You can also edit a rule by double-clicking it in the Rules tab.

Output

You can specify the output at Output tab. You can enable Trap layer only or Load trap color pairs if present or
enable both
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See also: What is trapping?

Unzip

You can use this task to extract files from a zipped archive. (Please refer to the Zip on page .)

 

 

You can select to one of these options if the files already exist in the destination folder:

• Fail
• Overwrite the files and give a warning
• Overwrite the files

You can also specify character set in the given field to overrule the default character set to avoid problems due to
special characters while unzipping.

Upload via FTP

Use the FTP task to send your files to a server. You need to have an FTP account on that server.

1. Click New to define a location. The Edit Ftp Location dialog pops up.
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2. Enter the Connection information:

• Host: the name of the server you want to send your files to.

Tip:  To use a port other than the default port, add : and the port number after the host name. For
example: myftpserver:1085

• Folder: if you do not specify a path, the files will be stored on the default directory. If you do enter a directory,
the files will end up in the directory you specified.

Tip:  Using SmartNames to define the destination folder may help you to organize the arriving data.

• Connection Timeout: enter the connection timeout in milliseconds. You only need to change this if you are
working on a slow network and keep getting time out errors.

• Secure FTP: select this if you are connecting to a secure FTP server (over FTPS, not SSL or SSH).

Tip:  If you are experiencing problems using secure FTP, try connecting over regular FTP, and ask
your IT administrator to check the security settings of your FTP server.

3. Enter the User name and password you use to connect to the FTP server:

• User Name: enter a valid user name for the server.
• Password: a valid password for the account.

Tip:

SmartNames can be used to select user name and password.
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This might be useful as user name and password are often centrally stored and can so be SQL queried.
And when user names and passwords change, your tickets do not have to be changed.

4. Define settings for uploading your File on the FTP server:

• File Transfer: choose between Binary and ASCII.

Binary will always work, but if you have an ASCII file, the transfer will go a bit faster when selecting ASCII.
• If File Exists:

• Overwrite and give warning: the file will be overwritten, but the tasks finishes in the state Warning.
• Overwrite: this will just overwrite the file and the tasks finishes OK.
• Generate a unique filename: this will append the task ID to the file name, and store the file at the

destination under its unique name.
• Generate an error: the file will not be sent, the task will fail.

• Connection Mode: By default, the transfer uses Active Connection Mode (where the FTP server opens the
data connection).

If your system is behind a firewall that blocks incoming FTP server connections, select Passive to use Passive
Connection Mode (where the client initiates the connection).

Update SmartMarks Preview

object . property  =  trueorfalse

Prop name Prop value

Verify Certification

 A PDF file can be certified when it is being preflighted against a PDF profile (using Preflight with PitStop task.
The preflight information is stored in the certified PDF file. This include preflight profile, the preflight report and
the information on whether the PDF has subsequenlty been modified. If your PDF is not re-certified after subsequent
modification, it is no longer certified.

You can use Verify Certification task to verify if the PDF file is certified. Use this task to verify against a Profile. It
checks whether the PDF file was certified to comply with the selected profile settings.
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The task results in Verification OK if the profile that was used to certify the PDF is identical or stricter than the
selected profile in the task.

Version PDF

When working with various versions of a single PDF, such as multiple language versions or versions containing
minor differences, you can use this task to save on output material by:

• Combining a base file with multiple version files
• Extracting separations or layers from the base file and replacing them by variants
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Combine base file with version files

By combining a base file (or input file) with a number of version files you can create various flavours for the same
document and save on output material.

For example: your base file can contain graphics and the CMY-separations. Your version files contain text in
different languages in the K-separation. By combining the images in your base file with the various language
versions, you only need the make the plates containing the separations for the graphics once.

Add the Version Files and in the External File dialog specify:

• The location of the folder that contains the version files
• The name(s) of the version file(s) including the file extension
• The name of the output file (combination of the base file and a version file)

Then decide whether you want the Version Input File (base file or input file) to remain in the same place, to be
deleted or to be moved to another folder.

Finally select your Reference Page Box. Selecting the correct media box here can prevent errors such as double time
stamps in the text of a page mark, for example.

Note:  You can use wildcards to specify folder or file locations and names.

Note:  You cannot combine Normalized PDF files with PDF files.

Extract separations from input file

Extract a separation from the input file and map it to another separation to limit the total number of separations for
output.

An example: Map a 'black' Pantone color that is used for text to 'Key color' (Black in CMYK).

Extract layers from input file

Extract layers from the input file and split the input file into a fixed master and a variant part based on the graphical
object database. Often black is the variable ink.

You can also work with layers to extract the language layer from the input file and replace it with the corresponding
translation(s).

Note:  Work with wildcards to optimize your workflow: e.g. to only extract the language layer, use 'lang_*'
if you know that all language versions follow this name rule. This will allow for the lang_EN, lang_FR and
lang_ES layers to be automatically extracted from the base file.

Wait

Use in a workflow ticket (chain) to postpone the next task to a relative or absolute time/date.

For example, a hot folder with this workflow ticket will delete the (marked) input file 30 minutes after the resulting
report-PDF was made.
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Wait for Action (Checkpoint)

Use the Checkpoint task to make your workflow stop at certain predefined points so the user has time to check
whatever needs to be checked. When a task uses a Workflow ticket containing a check point, that task will appear in
the To Do List.
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Task Settings:

• To: choose a user from the dropdown list, for example the operator who launched the task.

You can also use SmartNames to specify the user. The SmartName should resolve to a user in following notation:
"name@domain" ( e.g. "admin@rdalpha09" or "admin@esko-graphics").
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Note:

The special users Any user and Task owner can be addressed through a SmartName defined using their
built-in parameter value.

1. Select Any user/ Task Owner from the dropdown.
2. Right-click on the field.
3. From the menu, select Copy Parameter Value.
4. Paste this value in the SmartName field. See the example screenshot.

 

 
• Subject: enter a short description.
• Message (Optional) : use this space to write extra information.
• Due date: choose from the dropdown options: Immediate, in half hour etc.. or choose other in the list and enter

a date and time.
• Output States: You can define custom output states here.
• Click Add to add a new output state. Enter a Name and Description (optionally) for the output state. Choose the

Type from the dropdown symbols.
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• Release automatically: select this if you want the task to release it to a specific state after a specified time.

• After : specify the waiting time before automatic release.
• Release to: specify the release state from the dropdown. This dropdown will contain the output states that you

have defined previously in the task.

Who is responsible for checkpoints in a hot folder workflow?

For example:

Files are dropped on a hot folder that contains a big workflow, including two checkpoints.They are copied to the
appropriate job and when they arrive at the first checkpoint, Automation Engine will notice that the task owner is set
to 'any user'. Since this workflow started from a hot folder, it is not clear who should perform the check. As a result,
the checkpoint is included in the list of (unassigned) checkpoints in the to do list.

Suppose that John takes ownership of this checkpoint and completes it. After checking it off a report is made further
in the flow and it needs to be checked as well. The file arrives at the second checkpoint. Fortunately, this time it is
clear who should perform the check. John!

The second 'Wait for Action' task states that the person responsible now is the 'Task owner', and Automation Engine
will remember who confirmed the first check. As a consequence, the task owner, in this case John, will now see this
checkpoint appear in his personal to do list. In the example screenshot, you can see that the task owner for the first
checkpoint was 'admin'. For the second checkpoint, the task will appear on operator 'digi2' his to do list.

 

 

Wait for Files

Use this task when you want to process files who aren't ready yet.
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The task will look for the files at a regular interval, and when it finds them, it will pass them on to the next workflow
task.

You can also define how long to wait for, and what to do if the files aren't found after that time period.

1. Select the File Type you want to look for.

You can either:

• select a specific file type from the list,
• choose to look for Any file type,
• select several file types (see below).

To select several file types:

a) Choose Select File Types... in the File Type list.

This opens the Select File Types dialog.
b) In this dialog, select the files types you want from the Available File Types column.
c)

Click  to send them to the Selected File Types column.
d) Click OK when you are done.

This shows the selected file types in between brackets.
 

 

2. Use the File Name Matches parameter to search on file names.

You can use wildcards and SmartNames.

You can also browse to a file with a name close to what you need, and add wildcards and/or SmartNames to that
example name.

 

 

3. Define where to look for the files in the Look in Folder parameter.

You can type in a location, Browse to it, or use SmartNames (for example [Job URL]).

Choose to Look in subfolders or not.

4. Define when to Stop waiting for the files:

• when a certain number of Files or Pages are collected,
• after a certain time if the files haven't been found (when Time exceeds...).

You can set the time in minutes, hours, days or weeks. To set a custom time, select other... then select a date
and time from the drop-down menus below.

Depending on what you choose, the task will finish either after it has found all the files/pages, or after a certain
time if it can't find all the files/pages.

Note:  If you don't give the task a time limit, and it can't find all the files, it will run indefinitely.

5. Select Task ends in error when not all files were found if you want the task to finish with an Error state when:

• the time you set in the Stop waiting when time exceeds ... parameter has passed,
• the task hasn't found your files at that point.

Note:  This parameter is only available when using the Stop waiting when time exceeds ... parameter.
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Wait for Files (via JDF)

Use this task when you are working with a JDF RunList, but the files referenced in the RunList are not ready yet.

Send the JDF RunList to this task, and it will check if the files are ready at a regular interval. When it finds all the
files, it ends in OK and passes them on to the next workflow task.

You can set where to look for the files, and what to do if the files aren't found after a certain time.

Example Workflow

You can use this task when working an MIS system:

1. The MIS system creates jobs via JDF, and sends the JDF RunList to your Automation Engine workflow.
2. The Wait for Files (via JDF) task checks if all the files referenced in the RunList are where they are supposed to

be.
3. When the files are ready, the task finds them and passes them on to the next workflow task.
4. The rest of the workflow starts on the files.

Parameters

Look in Folder

By default, the tasks looks for the files at the location defined in the RunList. However, you can set a custom location
in this parameter.

You can use SmartNames here: for example, use [URL of Folder of Input] if you know the files will be
copied in the same folder as the RunList.

Stop waiting when time exceeds ...

Select this if you want the task to finish after a certain time if the files referenced in the RunList haven't been found.

You can set the time in minutes, hours, days or weeks. To set a custom time, select other... then select a date and time
from the drop-down menus below.

If you don't select this parameter, the task will look indefinitely (or until it finds the files).

Task ends in error when not all files were found

This parameter is only available when using the Stop waiting when time exceeds ... parameter.

Select this if you want the task to finish with an Error state when:

• the time you set in the Stop waiting when time exceeds ... parameter has passed,
• the task hasn't found the files referenced in the RunList at that point.

Wait For Product Status

Use this task to hold a Workflow until the input Product Parts reach a specific Product Status. You can define the
Product statuses in Product Part Setup. Read more in :Status Tab on page 86.

For example, this task in a workflow can make sure that Plates/ Digital Print Jobs are made only after the Products
are approved.
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This Task

• holds the workflow if one of the Product Part file has not reached the status specified in the Task and waits until
all Product Parts reach that status.

Note:

• This task fails when all of the input files are not Product Parts.
• The Task fails if one of the input Product Parts get deleted from the database while the task is waiting.

Zip

This task creates a Zip file from the selected file(s) or folder.

Choose the task's behavior in case the zip file already exists:

• Generate an error.
• Replace the zip file.

See also the Unzip Task.

Deprecated and Obsolete Tasks

Why Are Tasks Deprecated or Obsolete?
Several tasks have been declared “obsolete” or “deprecated” in Automation Engine 12. This document explains what
that means and why certain tasks should no longer be used.

Deprecated tasks are older tasks that are either no longer used or replaced with newer tasks implementing similar
functionality.

By declaring tasks "deprecated" we want to give advance warning to customers that we are considering to take these
tasks out of a next version of the Automation Engine.
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This gives customers the chance:

• to replace these tasks by newer equivalents
• to contact Esko support with the request to keep a task in the software in case their workflow relies on tasks that

have no equivalent.

The next step is to declare a task "obsolete" - it is removed from the next version of the software.

Obsolete Tasks in Automation Engine 12.1
The following tasks are obsolete in Automation Engine 12 and are no longer available for use.

Task Reason for making this task obsolete

Add Parameters for Nesting Obsolete due to the changes in i-cut Automate
module. Use the Submit to Gang Run task as a
replacement.

Note:  The Submit to Gang Run
does not create an XML file (formerly
typically dropped into a hotfolder). This
information is written directly to the gang
run database.

 Modify your workflows with the new task. Also
convert nesting mechanisms via a hotfolder into a
Substrate queue in the Gang Run view.

Create Nested Layouts This task has become obsolete since the i-cut
Automate module has been reworked. The
functions and settings of this task are now divided
over the Substrate settings in the Gang Run
view and the Export Nested Layouts task. In
the substrate settings you will find all the sheet
specific settings and the nesting parameters. The
'Export Nested Layouts' task holds all the output
settings. Note that

Note:  The nesting no longer happens
in the task, but as part of a background
process triggered by the Gang Run
server.

Modify the workflows and convert nesting
mechanisms via a hotfolder into a Substrate queue
in the Gang Run view.

Create Preview This task was used to prepare a thumbnail image
for images. These display images were used by
editors in later steps of the workflow.  Today
editors make these display images when needed
without performance penalties, so there is no
longer any need to generate these display images
in advance.

Normalize EPF File EPF is an outdated data format written by
DeskPack Illustrator versions prior to DeskPack 7
R6. Since version DeskPack 7 R6 the Normalized
PDF format is used to send data to other Esko
applications, including Automation Engine.
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Note:  Adjust the workflows based on the obsolete tasks with new features or tasks.

Deprecated Tasks in Automation Engine 12.1
Deprecated tasks are marked in the Automation Engine Pilot by the suffix “(deprecated)” in the Task Type.

Figure 1: List of deprecated tasks in Automation Engine 12.1

“Deprecated” means that it is being considered to remove these tasks from a future version of the software. The exact
version has not been decided yet. Customers are recommended to start planning how they can switch to newer tasks
with equivalent functionality.

These tasks are not available for new customers. Existing customers that had the tasks, will still have access to them
after upgrade to Automation Engine 12.

The reasons for deprecating these tasks are listed in the table below.

Task Reason for making this task deprecated

Adjust PDF screening The user interface as well as the algorithm of this
task have been totally reworked. The old task has
been kept so existing workflows will not break
after an upgrade.

Contourize and Clean This task was used to turn scanned bitmap images
in vector art. We believe there are better tools
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available in desktop applications like Adobe
Illustrator.

Create Master DCS File This task was used to create a DCS wrapper for
a given set of images. The DCS could then be
placed in an application like PackEdge or Adobe
Illustrator. The replacement for this is to use the
Create Wrapper task. This task will create a
PDF. DCS is an old format. This PDF is a modern
equivalent that can be used in the same way as the
DCS.

Create Nested Layouts This task has become obsolete since the i-cut
Automate module has been reworked. The
functions and settings of this task are now divided
over the Substrate settings in the Gang Run
view and the Export Nested Layouts task. In
the substrate settings you will find all the sheet
specific settings and the nesting parameters.
The 'Export Nested Layouts' task holds all the
output settings. Note that the nesting itself no
longer happens in the task itself, but as part of a
background process triggered by the Gang Run
server. It is advised to rework workflows based
on the old tasks. That includes converting nesting
mechanisms via a hotfolder into a Substrate queue
in the Gang Run view.

Export to GRS File The GRS format was the native format for Esko
applications. Many years ago the GRS format
was replaced by Normalized PDF as the native
format for Esko applications. The ability to export
a Normalized PDF to GRS was meant to send files
to older Esko applications.  We believe this is no
longer needed.

Export to VRML File The Export to VRML task was used to export 3D
files in the VRML format. This is replaced by 3D
PDF generated by the “Export 3D” task.

FastVariants (3 tasks) These tasks are being replaced by “Version PDF”
and “Compare PDF”

Fork This task was used to connect task chains into
more complex workflows. This functionality
is replaced with the extended functionality of
Automation Engine workflows introduced in
Automation Engine 10.

Normalize TIFF/IT This task was used to create a Normalized PDF
starting from a TIFF/IT. We believe TIFF/IT is no
longer used.

Trap – Create Trap Layer,  Trap – Prepare and
Create Trap Layer and Trap – Prepare Trap Pairs

All the functions of these tasks have been
integrated in the Trap with PowerTrapper
task.  Modify your workflows with Trap with
PowerTrapper task.
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Attention:  Replace any deprecated tasks you might have in the workflow with the updated tasks.

Normalize TIFF / IT File (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

The TIFF-IT import task is used in two situations: to edit linework, or to import a TIFF-IT file containing copydot or
blends.

A TIFF-IT job can consist of four data files:

• an FP file (final page) which has links to the data files with the graphic content. This file is optional.
• an LW file (linework). This is a palette high-resolution image that contains the linework part of the job. This file is

optional or required, depending on whether or not it is referred to in the FP file.
• an HC file (true-color high-resolution image), containing the linework part of the job. It is possible, but unusual

that both the LW and the HC are used at the same time. This file is optional or required, depending on whether or
not it is referred to in the FP file.

• a CT file (true-color CMYK contone). This file is optional or required, depending on whether or not it is referred
to in the FP file.

The TIFF-IT Import task converts a TIFF-IT job to a single PDF referring to an external CT, plus optionally to a
number of LPs with copydot and/or high-resolution CTs with blend areas.

The external CT may stay in TIFF format or can be normalized to the BG CT format. LPs with copydot and CTs
with blends will be always BG ones. The rest LW/HC part of the job (after removing copydot and/or blends) gets
contourized and is stored within the PDF.

When the job is launched, the topmost image is passed as the 'input' file and references to other images are made by
entries in the task ticket. The server part of the task recognizes a job as being a set of free images and processes them
accordingly.

TIFF-IT
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The options on this tab change according to the type of job selected:

1. For jobs with a Final Page it shows the image files and indicates their presence (see first screen shot above).
2. For jobs without a Final Page, the TIFF/IT tab shows the name mode selector, one for each possible dependent file

(LW, HC and CT file) (see second screen shot above).

The different modes are:

• Select None if the dependent file is omitted (missing).
• As LW with extension: Enable this toggle if you want the name of the dependent file to be derived from the

primary one (by changing the extension).
• Other: Use the Browse button to indicate the path of the dependent file.

The special notation ('?') allows unique handling of jobs having both the more frequent extension ILW/IHC/ICT and
the less frequent one LW/HC/CT.

 or  indicates whether or not the image file exists.

Keep native and verify Certain file types like copydot, tiff and eps files are already in a reliable format. These files
will be verified and left in their native format. On-the-fly preview files will be created.

Output File
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The default page size is Job size. When Job size is selected, the page size found in the selected file will be taken
into account when importing. The Custom option allows you to enter page size values manually. The dropdown list
displays all possible options (Custom, A5, A3, Letter, Scanner Trim Size, Tabloid...).

Reader's Spread

None of the file formats that can be wrapped into a GRS has the notion of reader's spread. It can be useful, for
example when using the GRS files in FastImpose, to give an indication of whether the file is a single page or a
reader's spread.

• Single Page forces the file as single page output.
• Reader's Spread forces the file into a reader's spread format. The file will be set as double pages.
• Auto checks the size of the image and when the image width equals or exceeds two times the selected page width,

the reader's spread option is set. Otherwise it is treated as a single page.

Offset

Enter the appropriate values to give the page a horizontal and/or vertical offset.When no offset is given, the center
of the image will be positioned on the center of the page. If the page is smaller than the image (width, height, or
both), then margins will be set that enclose the image completely. The size of the margins will not be fixed. Margins
indicate the differences between the image size and the user-defined page size.

Margins

Tick the margins toggle and define the margins' dimensions if you want to give the margins of the page a fixed size
(for example 3 mm for bleed). Click the arrow in the dropdown list to switch between millimeters and inches.

Select the page number from the file that you want to output.

Display images

This option allows you to change the preview settings of the file. Select None, Thumbnail or Image from the
dropdown list.

Linework
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Contours:

• match pixels exactly (robust mode): Contourization is done using an older, but proven algorithm.
• match pixels exactly (fast mode): Contourization is done using a faster algorithm.

Tip:

In the unlikely event that contourization fails, try again in the robust mode.
• are straightened: This option straightens borders of continuous single color areas (for example the borders of

black characters on white paper).

Overprint Settings:

• Pure Black: Set the paint mode for objects containing 100% black and at least one other ink. Possible Rich Black
paint modes are:

• Keep Opaque (masking) sets the overprint mode to opaque for all objects containing 100% black and at least
one other ink.

• Force BG Overprint sets BG Overprint for all objects in 100% black and at least one other ink.
• White: Possible White paint modes:

• Keep Opaque forces all objects in white to Opaque.
• Make transparent will remove all white objects.

Copydot:

• Detect where the job contains copydot: the data will first be pre-read and analyzed for copydot and/or blends. The
areas found will be handled appropriate way.

• Job does not contain copydot: all data will be contourized.
• Job contains only copydot: all copydot-like data will be separated to LPs without detection.
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Note:  The implementation includes storing the results of the copydot/blend detection as part of the metadata
of the HC/LW file. If the job will be re-processed, then re-reading won’t be necessary.

Minimum size (square units): Six square units is the default value.

Tip:  If your job terminates with an error, check the log message. It may be that the selected minimum size
is too small. Select a higher value and relaunch the job.Error message: “ERROR: Premature end of data
splitting. Exception of class ACQF_EDataSelectHCWithTransparency with message: "A copydot or blend
area was detected which is transparent. The result of splitting can therefore not be guaranteed to be correct.
Please try doubling or tripling the "Copydot Minimum size" option value."

Image Directory: all .lp files are by default stored in the ct directory of the job folder. Use the Browse button to
select a different directory to store .lp files.

Inks

 

 

The Inks tab contains a fixed list of inks (default, cyan, magenta, yellow, and black).

Note:  You cannot add or modify inks in the Normalize TIFF/IT File task.

If an image contains definitions for its inks (for example a CMYK Tiff or a PhotoShop DCS2) and an ink of the
image matches an ink selected in the inks tab, then the angles, lineature, etc... in the output file will be the ones from
the inks tab. All inks in the image that do not match the selected ink in the inks tab will be processed according to the
default values for angle, lineature, etc...

If the image contains an ink that is not listed in the inks tab, its angles, lpi, etc... the default values will be taken into
account.

Values (angle, lpi, dotshape, ...) you define in the default line of the inks tab are used to define the angle, lineature,
etc... of new inks added to the inks tab. The default line has no effect on the output file.
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If the wrong ink is selected, together with the default ink, then the output file will be generated with brix parameters
from the default ink.

Add Parameters for Nesting(Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

Use this task to specify nesting parameters for a particular graphic (cut path, quantity needed, due date...).

If you want to combine several graphics onto a sheet, you should send them all to the same Add Parameters for
Nesting task.

You can send PDF (single page or multipage), TIFF, PSD or JPEG files to this task. Progressive JPEG compression is
not supported.

It outputs an XML file containing all of the nesting parameters for the graphic(s). You can then send that XML file to
the Create Nested Layouts task.

Note:  You can use SmartNames to retrieve the parameters needed from the job setup.

1. In the Front tab, specify the Quantity of that graphic that you want to print.

You can select Maximum Fill if you want to print as many copies as will fit in one sheet (if you are not sure how
many copies fit exactly and you don't want to waste paper).

2. If the input file is a downscaled version of your graphic, enter the Scale to use.

For example, enter 1000% to compensate a graphic that was downscaled to 10%.

3. If the graphics in your files have a bleed outside the cut path, you can clip it away by entering the bleed distance
into Bleed Clipping Mask.

4. Enter/choose the ink used for the cut path in the Cut path table (the drop-down list will contain all inks used in
the input file).

You can Add several inks (for example if you have customers from different countries using different ink names
like cut, découpe, taglio...) and Move them Up or Down the list. The order is important as the task will use
the first ink it finds in the list.

Note:  If you have specified a cut path ink name in the Prepare Graphics for Nesting task, you only need
to enter that one ink name.

You can use SmartNames to retrieve ink names from the job setup.

Select Create cut path from trim box if no ink is found if you want to use the trim box to create a cut path when
a file doesn't contain any of the inks you specified.

5. Specify a Due Date for the nesting (when the sheet with the nested graphics needs to be printed).

6. In the Back tab, you can specify what to print on the back of each repetition of the graphic:

• No graphics.
• Even pages of multipage file: if you choose this, the odd pages of the file will be printed on the front, and the

even pages on the back (this only works with multipage PDFs).
• Graphics from front side: choose this if you want to print the same graphic on the front and on the back.

If your graphic has an irregular shape, you can select Flip horizontally so both graphics face the same
direction and have the exact same contour for cutting.

If your graphic contains text, you shouldn't flip it as this will make the text unreadable.
• Other graphics: you can Browse to the graphic you would like to print on the back side.

Tip:  Give the graphics to print on the back a consistent name, and use SmartNames to retrieve them
(for example, [File]_back.[Extension of File]).
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Adjust PDF Screening (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

Use this task to change the screening parameters in the input PDF. You can use it to define specific screening
parameters for some or all inks in your file, and/or assign default screening parameters to inks with no screening
parameters specified in the file.

Note:  This task doesn't change the ink order in the PDF.

1. In the Inks table, double-click the first row in the Ink Name column, enter the first ink for which you want to
define (new) screening parameters and press Enter.

2. The Ink Book column, you will see all the ink books containing this ink name in the CMS database. Select the
correct ink book for your file.

3. Enter the Ruling, Angle and Dot Shape to use for this ink.

This uses the Ruling unit defined in the Preferences.

4. Repeat for all inks needing (new) screening parameters.

Tip:

To define the same parameter value for all inks in the table, double click the header of the parameter
column, enter that value and press Enter.

For example, to give all inks a runling of 150 dpi, enter 150 in the Ruling column header and press
Enter.

 

 

5. At the bottom of the task panel, enter the Default Ruling, Angle and Dot Shape values to use for inks you
entered in the Inks table without those values.

Note:  If you don't fill in default values, inks without a ruling defined will get a ruling of 120 lpi (or
equivalent in your ruling unit), and inks without an angle defined will get an angle of 45°.

Contourize & Clean (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

Contourizing is reading image pixel data and writing them as vector data. This reduces the amount of image data and
can straighten borders of continuous single color areas (for example the borders of black characters on white paper).
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Contourize

• Low Quality (fast speed): The fastest way of contourization with low data amount reduction ability; the contours
follows pixels as rectangles.

• Medium Quality (medium speed): Does not reduce the data very efficiently, but it is very fast; it straightens the
borders of continuous single colored areas.

• High Quality (slow speed): Is much slower than Medium Quality contourization, but it reduces the amount of
data a lot.You can define the margin the system has to take into account when it contourizes (enter the number of
pixels).

 

 

When the Copydot data toggle is selected, the system will check for Copydot data. If the system finds Copydot data
the task will be terminated. If the toggle is not selected, the job will be processed no matter what.
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Note:

The Background color is not contourized.

If you want to clean your job, select the Clean toggle first.You can set the cleaning parameters, you can also select
the unit of those parameters (pixel, mm, inch and mil).

You define the contours you want to keep, a zero will be ignored.

• Minimal Horizontal and Minimal Vertical size. You fill in the minimal size of the contours you want to keep, all
the others (smaller ones) will be cleaned.

• Maximal Horizontal and Maximal Vertical size of the contours you want to keep, all the contours that are larger
will be cleaned. Contours with a vertical size larger than maxv and a horizontal size larger than maxh will be
removed. A value of 0 in one of the fields will disable the check on maximum size. A scan can have a black
border on the edges, just like an image scan will often show the edge of the slide it was scanned from. That black
border will be made up of two contours with a large size, a size larger than the 'logical' size of the page. You can
therefore remove it by specifying the maximum sizes as equal to the page size.

Create Master DCS File (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

The Create Master DCS task is intended to bind a set of stand-alone files containing bitmap or copydot data
(particular ink separations of one image).

Output consists of a file in DCS 2.0 format with references to the separate plate files selected by the user.

This task is useful when separation plate files have been delivered without a master DCS file or when the master DCS
file is no longer valid (due to wrong references or wrong preview).

The Create Master DCS task supports the TIFF, JPEG and EPS file types, and can also be applied to a Folder.
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Separations

The Separations tab consists of three groups:

• Files
• Separations
• CopyDot
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Files

The Remove button is intended for removing files from the list. It is most useful if you select the entire Folder first.

Separations

This option allows you to control how ink names will be parsed from the file name.

• From extension: Enable this toggle to indicate that the short ink name is an extension of the file name. For
example 6787.c

• From suffix: Enable this toggle to indicate that the short ink name is a part of the file name.

In the Separator field you can enter the character which is inserted between the basic name of a file and the short
ink name. For example '$' in 6787$c.tif'

CopyDot

• Yes: Enable this toggle to indicate that all separations are Bitmap or Colored. The CopyDot marker is added.
• No: Enable this toggle to indicate that separations don't contain CopyDot data. The CopyDot marker is not added.
• Detect: Enable this toggle to indicate that all separations are Bitmap or Colored and the application detects

CopyDot data in at least one of them. The CopyDot marker is added.

Tip:  Using the Detect option has an effect on the speed, while the real separations data is read during
detection.

Note:  Files containing CopyDot data must be marked in order to be processed correctly in the workflow.
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Tiff Preview

 

 

Select whether or not you want to create a new preview or use an existing one. Depending on your selection, different
options will appear:

Use existing file(s)

When a file is selected, and you tick the Use File radio button, the Browse button will be activated.

When a folder is selected however, you will have to pick the correct extension from the list.

Create Tiff preview

Select the appropriate preview mode:

• CMYK
• RGB

Resolution

Set the resolution of the created preview image. Values are expressed in dots per inch (dpi).
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• Screen: Enable this toggle to create a preview at a resolution of 72 ppi.
• Medium: Enable this toggle to create a preview at a resolution of 150 ppi.
• High: Enable this toggle to create a preview at a resolution of 300 ppi.
• Other: Enable this toggle to create a preview at the resolution you specified in the ppi input box.

Note:  The values mentioned about are only valid if you work in ppi. The value specified here depends on the
resolution preference settings.

EPS Preview

The EPS Preview tab displays the same options as the Tiff Preview tab.

Create Nested Layouts(Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

Use this task to nest a set of graphics onto one or more sheets, and create production files (a PDF print file and a
cutting file) for digital printing and finishing.

Send the XML files generated by the Add Parameters for Nesting task to this task. You don't need to send the
graphics as each XML file contains a link to the related graphic.

You can also use (compatible) XML files produced by an MIS system.

Alternatively, you can send already stepped and repeated (PDFPLA) files to this task to generate production files.
This will then skip the nesting part and only output a print file and a cutting file.

Note:  You can use SmartNames to retrieve the parameters needed from the job setup.

Note:

In a workflow, this task has four output pins (Print Files, Cutting Files, Done Graphics and Remaining
Graphics), so you can send each type of file to the right place more easily.

 

 

If you select Create report, the task will have a 5th output pin for the report.

Sheet Setup Parameters

1. In the Sheet Setup tab, define the sheet size. You can either:

• Use a Sheet Template that you have defined in i-cut Layout.

Sheet templates contain height, width and substrate information.

Tip:

If you have several templates using the same substrate but in different sizes, you can also select the
substrate name as sheet template (shown in blue in the list).

In this case, the task will try nesting the graphics on the different substrate sizes, and will pick the best
size for the job (or a combination of sizes).

• Define a Sheet Height and a Sheet Width.
• Enter the Substrate that will be used for the sheet.
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You can also Fit the sheet size to the size of the nesting (you can fit either the Sheet Height, the Sheet Width or
the Width & Height).

For example, for roll-fed printing, the sheet height will typically be the height of the roll, and the width will be
fitted to the size of the nesting.

2. Optionally, you can add Margins around the nesting (a Top, Bottom, Left and Right Margin).

The margins won't be used for printing/cutting, but may contain some bleed.

3. If desired, you can add SmartMarks (that you created in i-cut Layout or PackEdge) to your sheet.

4. If printing Front and Back, define how the sheet will be turned for back printing in Backing Up: either Work-
and-Turn or Work-and-Tumble.

Nesting Parameters

1. Select the Nesting Type to use for the layout:

• Minimal Waste tries to reduce the waste in material to a minimum,
• Minimum Layouts reduces the number of production files to a minimum (as for each new layout, a new print

file and cutting file are generated),
• Guillotine Cut prepares layouts to be cut on a Guillotine table, reducing the number of cuts, and making sure

all cuts are possible on a guillotine cutter.

2. Select the Search Method to use for calculating the layout.

Depending on if you are running a test or processing graphics for production, you can set the layout search from
Very Fast to Slow (Very Accurate) (the faster the search, the less accurate the result can be).

3. Optionally, select Respect the graphics order if you want to nest the graphics in the order in which they are
coming in.

Tip:

You can put a Sort workflow control in front of the Create Nested Layouts task to sort the files in a
particular order.

Alternatively, you can put a Sort in front of the Add Parameters for Nesting task to have that order
already reflected in the XML file (when using an XML file for several graphics).

4. If you have selected Minimal Waste or Minimum Layouts, you can set:

• the Fill Starting Point on Sheet (where the first graphic will be placed): at the Top Left, Top Right, Bottom
Left or Bottom Right,

• the Primary Fill Direction (in which direction the sheet will be filled): Horizontal or Vertical.

5. If you have selected Guillotine Cut, you can set:

• the direction of the First Cut: Horizontal, Vertical or Don't Care,
• a Maximum Overrun to get less different layouts: if you are printing different quantities of your various

graphics, some of the graphics with a lower quantity might get printed in excess to keep the number of layouts
to a minimum. Enter the maximum number of excess graphics that can be printed in Maximum Overrun.

If you only want to print the exact quantity you specified for each graphic, keep the Maximum Overrun to 0.

6. If desired, you can add a Gutter in between cut paths (specify the width).

7. In Rotation, specify if the task can rotate the layout in case a better fit is possible. You can choose:

• Allow any angle,
• Allow 90 degree,
• Allow 180 degree,
• No rotation.

8. Optionally, you can center the nested graphics on the sheet: in Align nesting center graphics on sheet, select
either:

• No if you don't want to center them,
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• Vertical to center the graphics vertically,
• Horizontal to center the graphics horizontally,
• Vertical and Horizontal to center them in both directions.

9. Enter a Minimum Fill if you only want to output the sheet if it's filled to a certain level.

Note:

Do not put 100% here as only the graphics inside the cut path count as fill. The margins, gutters etc. all
count as waste.

By default, the minimum fill is set to 75%.

10. If there is a due date linked to your graphics (see Add Parameters for Nesting(Deprecated) on page ), select
what to do if the minimum fill hasn't been reached and the nesting hasn't been output by that date in Action when
Due Date Expires:

• Set Task Status to Error.
• Force Nesting and Save to PDFPLA to output the nesting as a PDFPLA instead of as production files.

You can then edit the PDFPLA manually in i-cut Layout (for example to print it on an offcut), or feed it back
to the Create Nested Layouts task together with other graphics to fill the sheet a little more.

• Force Nesting to output the sheet anyway.

Output Parameters

The task will output:

• PDF print files,
• cutting files (in your desired format),
• nesting reports (optionally),
• XML files containing references to any non-nested graphics and their quantity.

1. In Save Print Files, select how to output the PDF print files:

• as Single Files to have one single page PDF file per layout,
• as 1 Multipage File to have one multipage PDF file containing all the layouts.

Attention:  If the dimensions of the different layouts vary (for example when using substrate-based
nesting or the Fit option), the task cannot create a multipage output.

Note:

If multiple copies of the same layout need to be printed:

• For single page output, the number of copies will be part of the PDF file name.
• For multipage PDF output (and if the number of copies per page is less than 10), the same page will be

inserted multiple times, using forms to prevent the file size from growing.

2. In Save Cutting Files, choose the cutting file format you want to generate (i-cut, HPGL, PDF, MFG or ACM).

Note:  When generating an ACM file (for a Kongsberg table), you can select Print Side Up, to cut with
the print side visible.

Tip:

• If you have several cutting tables and you don't know yet which one you will use to cut the sheet,
you can generate several file formats: choose Select File Types..., select all the file types you want to
generate and click OK.

• If you want to check your cutting files for quality control, you can also output a PDF file and inspect it
in Acrobat.

3. If desired, you can Add Extra Structural Inks (for fold lines for example) that will be added to the cutting file
and excluded from the print file.
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Tip:  Use commas to separate the list. You can use wildcards (*).

4. If you want, you can create a nesting report (for example to use as feedback for a MIS system).

Select Create layout report if you want a report detailing the different graphics used in each layout.

Select Create report per graphic if you want a report detailing in which layout(s) each graphic is nested.

5. In Output Name, enter the base name to use for the output files.

For example, if you enter Promotional_Coasters, the first layout will be called
Promotional_Coasters_1.pdf, the second Promotional_Coasters_2.pdf, etc.

If you don't enter anything, the name of the first input file will be used.

6. Define where to save the production files, the report(s) and the XML file(s) referencing any non-nested graphics:

• If you want to save all output files in the same folder, select Save all files in the same folder, and browse to
that Output Folder.

• Otherwise, make sure Save all files in the same folder isn't selected, and browse to your chosen folder for
the Print Files, Cutting Files, Report Files and Remaining Files (XML file(s) referencing any non-nested
graphics).

Expand Variable Data to PPML File(Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

The Expand Variable Data to PPML File task performs expansion of the specified database entries into the
corresponding graphical output and comes in two variations; one for the PackEdge workflow and one for the
DeskPack workflow.

The Expand Variable Data to PPML File is used for the PackEdge and Plato workflow. The input file is a PDFPLA
file. The ticket allows you to set all variable data parameters.

In the Expand Variable Data to PPML File (DeskPack only) ticket, only the output location and a file name can be
specified. This task is only used for expansion executed from within stepX.

All workflows will start with this task. In most cases, the expansion task is followed directly by the RIP to WS4000
Series task, so creating a chained workflow ticket for both tasks is recommended.

However, independent use of the expansion task is also possible (in case you only care about the expansion output,
but do not want to run the RIP task afterwards).

It is compulsory to specify an output folder for the 'Expand Variable Data to PPML File (DeskPack only)' task. Not
doing so could generate a task error.

However, since you are allowed to use Smart Text in the specification, it is possible to create a path similar to this:
[joburl]/tmp_expansion/[date]_[time].

The contents of this folder must be maintained manually as the files are not deleted automatically.

The task takes the following input files:

• a design file containing variable elements (Normalized PDF file)
• a repetition file generated by the stepX plug-in (PDFPLA file)
• a database file (XML or CSV)

It can generate the following output files:

• one file with constant (unchanging) graphic elements (Normalized PDF file)
• several files with variable graphic elements (Normalized PDF files)

All these files are linked together by a standard PPML file.
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Grids

The VDP parameters must be specified for each grid individually. To specify the parameters for a grid, select the grid
on left. If the repetition layout contains more than one grid, use the + button to add the required number of grids and
specify parameters for every grid.
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Grid Contents

The expansion task can handle two types of grid contents. ‘Identical One-ups’ does not include any variable elements.
It will fill the empty space on a substrate that is unused by variable data. ‘Variable One-ups’ carries the design with
variable data elements. These two types of grid contents have different parameters. The main difference lies in the
absence of a database for identical one-ups.

Following enumeration gives you an overview of the differences:

Identical one-ups:

• Total number of one-ups for repetition
• Block size (optional)
• Gap size
• Gap at the beginning of the job (optional)
• Gap at the end of the job (optional)

Variable one-ups:

• XML database – file URL
• CSV database – one or two file URLs + other options (delimiter character…)
• Image Path URL – when Image Marks are used (optional)
• Block size: job, sheet or custom
• Gap at the beginning of the job (optional)
• Gap between blocks (optional)
• Gap at the end of the job (optional)
• Gap size
• Ordering
• Empty one-ups

Database

This parameter defines the database which will be used for expansion. The database is specified either by an XML or
a CSV file.

 

 

XML Database This type of database is a file in the eXtensible Markup Language format. Clicking ‘Open from
XML...’ opens a file browser, which allows you to select the XML file. Please note that the XML file must be stored
within an Automation Engine container.
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CSV Database A CSV is a Comma Separated Value file. The ‘Open from CSV...’ button opens a dialog box, where
the operator has to specify a URL to the database file, its Encoding and Field Separator options.If field names are not
stored in the first line of the database file, you can specify a separate file with the required information by using the
Field Names part of the dialog box. An overview of the settings will be displayed in the expansion task window.

Image Path The location specified here is used to fill in the ‘vdp_image_path’ File SmartName, which might be
necessary if the job uses Image Marks. It must contain a valid path which will be used to locate the images in the
variable data.

For a description of the Image Path parameter, please refer to Variable Data Printing workflow document..

Content Filling

This part of the dialog box is used to specify how the database values will flow through the variable job.

 

 
Block Size

Following options are available:

Complete Job This option defines that database will flow through the job without any interruptions.

One Frame The size of a frame is equal to size of the document defined in stepX or Plato.

Custom The size of a block is custom-defined. Units are grid rows, frame size, meters or feet.
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Filling Order

Following options are available:

• Rows: The numbering is restarted when the end of a row is reached and continues from the left cell of the next
row. The starting position is the top left cell of each block.

 

 
• Rows (ZigZag): The numbering is restarted when the end of a row is reached and continues from the cell located

below the last cell. The starting position is the top left cell of each block.

 

 
• Columns per Block: The numbering is restarted when the end of a column in a block is reached and continues

from the top cell of the next column. The starting position is the top left cell of each block.Note: If the Block Size
is set to ‘Complete Job’, then this filling order is equal to 'Columns per Job'.
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• Columns per Block (Reversed): The numbering is restarted when the end of a column in a block is reached and

continues from the bottom cell of the next column. The starting position is the bottom right cell of each block.
Note: If the Block Size is set to ‘Complete Job’, then this filling order is equal to 'Columns per Job (Reversed)'.

 

 
• Columns per Job: The numbering is restarted when the last cell of a column in the job is reached and continues

from the top cell of the next column. The starting position is the top left cell of the job.

 



Automation Engine | The Tasks: an Overview | 495

 
• Columns per Job (Reversed): The numbering is restarted when the last cell of a column in the job is reached and

continues from the bottom cell of the next column. The starting position is the bottom right cell of the job.

 

 

Create Gaps

Some jobs need to be interrupted after a certain amount of labels (defined by Block Size) and continue after this
interruption to the next gap or to the end of the job.No one-ups are printed in the gap area, so the press operator can
easily identify the gap as a white area. However, all elements outside the one-up area, such as die cut marks, are
printed.

Here you can specify where you want to the gaps to be generated. Following options are available:

Starting gap: This gap will be printed first from the press point of view.

Gap between blocks: These gaps will be generated in between Blocks.Note: When Block Size is set to ‘Complete
job’, this toggle is useless.

Ending gap: This gap will be printed last from press point of view.

The ‘Gap Size’ option specifies the size of the gaps in grid rows, frames, meters or feet.
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Put Empty One-Ups

In general, the database size is not an exact multiple of the number of cells in a block. One of the blocks cannot be
filled completely with database entries. It will be padded with empty one ups. The toggles ‘At the start’ or ‘At the
end’ specify where to put the empty one-ups from Filling Order point of view.

Export to GRS file (Deprecated)

Exports a Normalized PDF file to a GRS file.

 

 

External references External references have to be converted, you can define what the system needs to do:

• Write external references which are close to the input file to the output folder. All other external references will be
written in their original folder.

• Write all external references to the output folder.
• Write all external references to their original folder.

When converting again, you can opt to:
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• Reconvert if recently updated: only updated references will be reconverted, all other conversions will be used as
they were.

• Use previous conversions: the existing conversions will be used, potential updates will not be considered.
• Always reconvert: all external references will be converted at all times.

External images Referenced files in Normalized PDF job file format will be converted to referenced external files in
the GRS file. Indicate which images you want to have converted.:

1. Only images which are close to the input file.
2. All images
3. None

Fail when fonts are not found: when the fonts used in the file are not found the task will fail, when the toggle is not
selected, the task will end with a warning

Fail when external references are not found: the task will fail when not all external files were found.

Export to Normalized PDF File (DeskPack Only)(Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

This Task is only useful in a DeskPack workflow, please refer to the 'Adobe Illustrator Client' manual.

Export to VRML File (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

VRML stands for Virtual Reality Modeling Language. This task can make a 3D model of a Scope native file that has
a link to an ARD (Artios CAD) file. The result of the task is:

• A VRML file: a .wrl file. wrl stands for 'world' as in virtual world.
• One or more JPEG files, to build up the visualization of all the panels and all the sides of the 3D simulation.

Note:

• The Scope native file must contain a link to an ARD file.
• The ARD file must contain folding information.

Tip:  You will need a VRML viewer to view the result of the task. There are three types of VRML viewers:
a plug in, a helper application or a stand-alone application. Several freeware VRML viewers are available on
the Internet.

Tip:  Supports recto/verso graphics. If the input file has 2 pages, the second page will be placed on the inside
of the CAD file.

Note:

Linking a Normalized PDF file to an Artios CAD file can be done:

• using PackEdge,
• using Esko's ArtiosCAD plug-ins in Adobe Illustrator.

 



498 | Automation Engine | The Tasks: an Overview

 

You can set resolution in ppi, ppmm or ppcm and define the JPEG compression. Options range from: JPEG Limited,
JPEG Low, JPEG Standard Low, JPEG Standard (default), JPEG Standard High, JPEG High and JPEG Extreme.

Note:  There is a limit to the kind of resolution that the task will process, internally the output resolution is
restricted, so entering a higher resolution does not necessarily result in high resolution output. Except for
when the option high resolution images is selected.

JPEG Images:

• Separate Image on each face: creates a separate JPEG file for each face.
• High resolution images: use 'High Resolution Images when there is small text on the design, or other graphics

which require a high level of detail. A separate file is created for each face, but if more detail is available, the files
are larger.

• Single image: makes a single large JPEG file for each design instead of a single JPEG for each face. Use this
option when using the VRML file in other 3D graphics applications.

Creases:

• No creases
• Creases in board color: creases are included in the VRML, they have the same color as the board, the lightning in

the VRML rendition shows them as slightly contrasting.
• Creases in pink: turns the creases pink for easy visibility.
• Graphics on creases: wraps the graphics around the creases, this is the most sophisticated option, but it increases

the file size by 50 percent.

Animation:

• No animation: creates an unmoving view of the design.
• Forward: runs the animation continuously.
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• Forward and Back runs the animation forward, then backward, and repeats.
• With toolbar inserts a toolbar into the VRML file allowing you to manually step through the file, as well as toggle

design transparency.

Note:  This works only when the ARD file contains frames.

Output units: As there is no measurement ability in the browser window, the options in this group control the
granularity of the VRML plug-in's zoom tools. Selecting 'Meters' provide coarse zoom while selecting 'millimeters'
provides fine zoom. 'Centimeters' is the default, and should be selected when choosing 'With toolbar' in the
'Animation' group.

Include graphics: this toggle controls the export of graphics. Toggle on for rich detail, toggle off for the smallest
VRML files with the most robust performance.

Include corrugations: this option draws corrugations on the edges of corrugated boards. This depends on the ARD
file's substrate definition.

Use compression: this option controls whether the VRML geometric information file is compressed or not. A smaller
file is faster to download, but some VRML browser plug-ins do not support compression. The JPEG image files are
already compressed according to the JPEG Compression (at the top of the task).

View Zoom Factor: sets the initial field of vision in the VRML file. If you find that animations are bigger than the
browser window, try setting the value to a smaller number. You can enter zoom factors between 40 and 250 percent.

Background color

• No background: no background will be defined, the preferences set in the VRML plug-in will be used.
• Define values for Red, Green, Blue.

For example, this job (Lemon.pdf) contains a link to an ARD file which contains folding information.
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If we run this file through the VRML task, we get a wrl file that looks like this when we view it in a VRML browser:
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FastVariants - Check (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

FastVariants is the perfect solution to avoid problems in a double-burn workflow, when one of the plates on the press
is replaced for a new run, and the other(s) are identical.

Two double-burn workflows are possible:

1. A neutral version + K variant for each language separately.
2. Different variants as full CMYK.

Use the FastVariants - Check task to compare the non-variable inks of two files (CMY in most cases). It checks if
there are differences, and shows you where they are situated. If the result of the Check task is OK, the two files are
double-burnable and you can use the FastVariants - Split task.

In case the FastVariants - Check task is run on impositions, it compares the page assigned in the background
(imposition) layer with the master page of the assigned page in the variant (imposition) layer. By master page is
meant the appropriate page from the master (or original if there is no master) layer.
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The FastVariant task can also be run from the Pages View. A few remarks:

• The variant ink selection follows the use case.
• The FastVariants task also works on page selection.
• When two incoming files or layers are selected, the Check task checks these (appropriately normalized) files.
• Layers under incoming files are by default named as follows:

• 'original' stands for the originally normalized file.
• 'master' stands for the master file (result from the Split task).
• 'variant' stands for the variant file (result from the Split task).
• 'difference' stands for the difference file (result from the Check task).

Compare

 

 

You can either compare files or folders. Depending on what you selected, the Compare option will display 'Reference
File' or 'Reference Folder'.In case a folder is selected, the FastVariants - Check tool compares the folder file per file
on the condition that both folders contain an equal number of files and that the number of pages in the selected files
matches the number of pages in their reference files.

Use the Browse button to select the correct reference folder or reference file. This is the file or folder you want to
compare the selected file or folder with.

You can set the accuracy to normal, high, or very high. Depending on this setting, the checking will take more or less
time.
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Enable the Ignore variant ink toggle and select the appropriate ink from the dropdown list. FastVariants will now
compare the selected files or folders and will report all changes, except for those in the variant ink.If a folder is
selected, it is possible that not all inks appear in the list. If this is the case, enter the ink name manually.

Note:

This option is not relevant when comparing several versions of the same file.

In the Compare Area you can indicate what area should be taken into account when the file is being checked. If you
set the area to Job Size, the whole job will be compared, including margins. Custom allows you to set the size and
the offset of the area you want to have checked.Page size + bleed checks everything that is within the borders of the
file. You can specify an extra bleed distance.

Note:

Selecting the correct compare area is important to avoid irrelevant differences being reported, like for
example a time stamp in the text of a page mark.

Page Range allows you to indicate the range of pages that need to be checked. When multiple files or layers are
selected, the Checker task checks these files.

Differences

 

 

Enable the Save differences toggle to activate this part. When differences are found, but not saved, no separate layer
will be created.

Note:  Specify an output path and file name if you do not want the original input to be overwritten.

Select a color from the dropdown list to mark the differences.

If the Add reference layer toggle is checked, a separate layer with an external reference will be added to the job.
When the reference layer is present you can toggle the differences in PackEdge and check the differences visually.
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Check the box 'Make FastVariants 'Check' layer printable' to be able to see the layers containing differences when
proofing. If the toggle is not selected, however, then layers containing differences will still be visible in PackEdge,
but as they have the 'non-printable' mark, they will not be on the proof.

Make original layers printable

Make original layers printable. Set this mark for the original image.

Note:  Make sure that one of the print options is set.

FastVariants - Remove White Boxes (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

It is common in double-burn workflows that the different versions are supplied as separated PostScript files
containing only the variant ink, usually K.

These files can be easily combined with the neutral version by superimposing the two, for example by using layers in
FastImpose.

It is usually the case, however, that these separated PostScript files contain white opaque boxes that cause elements to
disappear from the neutral file, when the two are put on top of each other.

The FastVariants - Remove White boxes task is specially designed to remove these obtrusive white opaque boxes.

White opaque text will never be removed. White opaque strokes can be kept when the toggle has been enabled.

 

 

Enable the Keep strokes toggle to keep strokes with a maximum width of x mm or inches. All strokes smaller than
the selected width will be kept.
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FastVariants - Split (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

Use the FastVariants Splitter task to split the input file into a fixed master and a variant part based on the graphical
object database. The splitting is being performed on the basis of the variant parameter ink. In most cases, black will
be the variable ink.

The term Master refers to the fixed part of the job, Variant to the variable part of the job.

When this task is run on impositions in the Pages View, it splits an (original) page assigned in a variant (imposition)
layer into a variant and a master page. It replaces the original page by the variant page in the variant (imposition)
layer and assigns the master page to the background (imposition) layer, provided that this one is empty.

The FastVariant task can also be run from the Pages View. A few remarks:

• The variant ink selection follows the use case.
• The FastVariants task also works on page selection.
• When two incoming files or layers are selected, the FastVariants - Check task checks these (appropriately

normalized) files mutually.
• layers under incoming files are by default named as follows:

• original: original normalized file.
• master: master file (as a result of the Split task).
• variant: variant file (as a result from the Split task).
• difference: difference file (as a result from the Check task).
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Select the Variant Ink from the dropdown list.Enable the Extract Master toggle if you want to keep the fixed
(master) part of the job and have the variant part removed.Enable the Extract Variant toggle if you want to keep
the variant part of the job and have the fixed (master) part removed.Enable both toggles if you want to split the
(reference) file into a Master part and a Variable part.Enter an appropriate file names for the both Master and
Variant.

Page Range allows you to indicate the range of pages that need to be split.

Fork (Deprecated)

Note:  This is deprecated from Automation Engine. You can use the advanced routing functionality of the
Workflow Editor instead. See Using Routing in Your Workflow in the User Guide.

A workflow ticket consists of a number of sequential tasks. Each task is executed after the former was finished, each
task involves processing the output file resulting from the former process.

It is not possible to define a workflow ticket in such a way that more than one task involves simultaneous processing
of the output file of the former. However, by inserting a Fork task in the workflow ticket these kinds of workflows
can be built.

The Fork Task launches other tasks via the tickets as specified (based on SmartNames or on plain ticket names).

When such a task cannot be launched because the name cannot be resolved or the ticket cannot be found, then an
internal warning flag is set. Only when this happens for a line that is flagged as critical, the Fork task will end with an
error.

The Fork task allows you to launch multiple tasks at once. This makes a few new types of workflows possible.

• Workflows in which the order of the tasks is not important.

I want to create, from my normalized PDF, a small export PDF, a JPEG and a ReportMaker print card PDF. I do
not care which one is made first, I just need all 3 of them.

• Workflows in which the required mix of file formats is not possible to combine in 1 single workflow ticket.

My workflow ticket should include both PostScript output and output to FlexRip, but first the PostScript output.

The ticket(s) that a Fork task will launch can now be 'Smart-selected’.

For example If the Export to PDF ticket contains a SmartName that indicates the customer name (as filled in in the
Job Setup), then the fork ticket can generate different output, depending on the settings for that customer.

Even the task type can be 'Smart-selected' which enables Automation Engine to intelligently select the correct ticket,
based on the type of action that needs to be performed, for example:

• reach an HP or an Epson proof?
• reach a CDI Compact or a CDI Spark?
• create a PDF proof or launch a WebCenter approval cycle?

Defining a Fork Task

1. Select the Tickets View in the Views bar, or in the Go menu. Select the Fork task.
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2. Click the task's 'Add' button:
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It is possible to add a definition of a ticket by using SmartNames. You can for example define the task type or the
ticket name as a SmartName. This can help you to limit the number of tickets to choose from when launching a
task.

3. The Add dialog pops up. Depending on which 'Add' button you clicked, different Add dialog boxes will appear.If
you do not want to use SmartNames, you can simply select a task type from the list.

 

 

If you do use SmartNames, you also select the task type from the list and indicate whether this new fork ticket is a
Job ticket or a global ticket.Enter a new ticket name.

Let us assume you have two customers and one needs PDF 1.5 files and the other PDF 1.6 files. You can then
create a fork ticket called [export_for_customer] like this:
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4. The selected ticket is added to the fork list.

 

 

When you have two tickets in your ticket list: export_for_LabelPrinter and export_for_FoldingCarton and you
launch the task “Export_for_[Job Customer Name]” in a job where the customer name = FoldingCarton, then this
task will select the “Export_for_FoldingCarton” ticket.



510 | Automation Engine | The Tasks: an Overview

When you launch the same fork task in a job where the customer name = LabelPrinter, it will use the
“Export_for_LabelPrinter” ticket.

This means that using SmartNames in a Fork ticket does not limit the number of tickets as you still need both
“Export_for_...” tickets (you even need an extra fork ticket).

It does offer the advantage that the operator can always launch the same task “Export_for_customer”. So the risk
of mistakes will be reduced.

5. Add as many tickets to the fork you want.

Hit the 'Remove' button to remove the selected ticket from the list.

 

 
6. If you use the Fork task in a workflow ticket, you can choose whether the next step in the workflow will use the

fork's initial input files, or the fork's output files.

 

 

Fork Task Examples

An example in which the next step in the chain will use the Task's output files.

Let's assume you want to build a workflow ticket in which you chain a 'Normalize PostScript / PDF / Illustrator 8.0'
task to a 'Optimize and Clean (PSFix)' task to a 'Trap' task to a 'Fork' task to a 'Zip' task (which zips all the files the
fork task made) to a 'Upload via FTP' task.
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In this example, the 'Fork' task is defined in such a way that it:

• Produces a JPEG File (Create PAF / JPG / XML (LinkEdge) task)
• Produces a PDF version of a Report (Create Report (Reportmaker) workflow)
• Produces a small PDF file
• Produces a PDF for data exchange

The Fork task is also defined in such a way that the next step in the workflow will act upon the Fork Task's output
files!
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An example in which the next step in the chain will use the Task's input files.

Let's assume you want to build a workflow ticket in which you chain a 'Normalize PostScript / PDF / Illustrator 8.0'
task to a 'Optimize and Clean (PSFix)' task to a 'Trap' task to a 'Fork' task to a 'Step and Repeat' task (which step and
repeats the Fork task's input file) to a 'Expose on Barco ImageSetter' task.
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In this example, the 'Fork' task is defined in such a way that it:

• Produces a small PDF file
• Uploads this PDF file to the customers FTP server
• Adds a checkpoint

The checkpoint pauses the whole workflow, it is only when the customer is satisfied that the checkpoint is released
and the nex step in the chain will process. This next step uses the Fork Task's input files!

Note:  When the 'Critical Task' option is checked, and the task fails, Automation Engine will not continue
with the next step in the chain.
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Tip:

You can also use a fork to link to just one existing ticket, which you may overwrite/change later while
keeping the name.

This is how for example you can have a hot folder that launches a fork task.

A standard hot folder takes the ticket definition on board and so needs updating later.

A hot folder with a fork task that *links* to some ticket can thus automatically adapt its behavior to the latest
version of this linked ticket.

Trap - Create Trap Layer(Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

This task traps the input file according to the settings specified in the TCP file associated with the input file.

The output of this task is a trapped Normalized PDF file.

This task contains only the output options of the Trap task. All other trapping parameters are stored in the TCP file
located in the same folder as the input file.

The Create Trap Layer task has only one tab, and it's the same of the Prepare and Create Trap Layer task's output tab.

See also: What is trapping?

Trap - Prepare and Create Trap Layer(Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

This task offers you all the settings of the PowerTrapper: full automatic trapping.

It selects candidate trap color pairs and executes the trapping. The trapping areas are added in a separate layer on top
of the original job.

What is Trapping?

The trapping process is a safeguard against possible (even likely) fluctuations in the printing process. Minor
discrepancies in registration, slight paper shifting can cause inks to misregister.

When two abutting colored objects don’t meet exactly, you can end up with a printed result like the one below:

 

 

The overlap creates a dark area and the gaps cause an undesirable light area. To prevent these potential discrepancies,
a trap can be implemented, causing the original colors to slightly overlap each other:
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In general trapping is necessary when there are two abutting color areas that don’t share a common ink.

Placing a fine line where they join, made of a color that contains components of both abutting colors, can effectively
trap such areas.

Trap Expert

 

 

Select the automatic trap expert that will examine the job and select candidate color pairs for trapping. Depending on
the expert and its associated parameters, different color pairs may be selected for trapping.

Two Trapping Types:
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• Normal Trapping: This trapping expert selects abutting color pairs, which are likely to cause registration
problems like ugly light gaps, and unwanted halo effects. The expert automatically chooses the most appropriate
trap direction based on the relative luminance of the adjoining colors. Lighter colors are generally trapped into
darker colors to minimize the visual effect of the trap.

• Reverse Trapping: This trap expert prevents overprint of abutting color areas with different inks by selecting
these color pairs to be trapped with a white knockout (erasing) trap. The white knockout trap is put on top of the
lighter of the two colors. This expert is useful to prepare a job for Dry Offset printing (for example metal beverage
cans) where overprinting of inks is not allowed as the inks would contaminate each other on the blanket.

Minimum Ink Difference: Trapping is applied to two adjoining colors when one of the following two rules hold:

1. The two colors each consist of at least one ink but they have no common inks.
2. The two colors have common inks and there is a difference larger than the minimum ink difference percentage

for at least two different inks that make up these colors. These differences in ink amount must be in opposite
directions (see also example 3 below).

The minimum ink difference defined in the second rule can be altered by changing the value in the 'Minimum ink
Difference' input field. The default minimum ink difference percentage is 10%.

Image Trap Direction

• Automatic: Determine the most suitable trap direction automatically by comparing the average lightness of the CT
image with the lightness of the abutting area and trap the lighter color into the darker one. (default).

• Trap Images into Linework: Always trap CT images under adjoining line work.
• Trap Linework into Images: Always trap line work under adjoining CT images.

Image Trap Color Specifies the color of CT traps in those cases were the CT should be spread into an adjoining
color area.

• Original Image Data: Use the trap shape as a clipping mask on a copy of the original CT image placed in
overprint. This only works if there is additional image data outside the original CT mask (default).

• Extended Image: Same as above but the CT image is automatically extended (extrapolated) along its top, right,
and bottom and left edges to ensure the trap gets the expected color even if there is no image data outside the
original CT mask.

• Solid Color: Use a solid color as trap color instead of a (variable) CT. A suitable solid color is computed by
averaging the CT color along the boundary between the abutting color areas.

Image Trap Detail

This option is only used in a DeskPack workflow: image traps are rendered to linework.

• Coarse: is faster to process but will generate coarser results.
• Default: is a trade off between speed and detail.
• Fine: nice results, but larger files and slower to process.
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Optimized for: The “Optimized for” option has three possible values that each correspond to a different way to
represent the traps in this particular case.

• Scope 2 and lower When this option is selected, the trap will be created as a stack of objects. There will be as
many objects in the stack as there are colors/objects contributing to the transparency blend. Each object in the
stack will have the shape of the trap and the color of one of the transparent objects involved and will be put in
blend mode Darken. Note that this does not result in the correct trap color in all cases. The reason is that a stack of
trap objects each with blend mode Darken does not accurately represent the result of the original blend of objects
that can each have a blend mode different than Darken. The only advantage of using this mode is that it will not
create any new CT images and that it is 100% compatible with GRS and older versions of the trapping software
(Scope 2 and lower).

• Scope 3 When this option is selected, the trap will be created as a new internal raster image that is obtained by
rasterizing the original stack of objects/colors that contribute to the transparency blend. The raster image is put
in blend mode Darken and the trap shape is used as a clip mask on the image. The advantage is that (apart from
resolution limitations) the trap color is always correct. A disadvantage is that new images are created to represent
the traps, and that increases the document's filesize. Although these images are stored as internal (embedded)
images, such images will still become externally linked if the file is later exported to the legacy GRS format.
Therefore, if a GRS-based workflow is still used and/or needed, the use of this option is not advised.

• Esko Software Suite 7 and higher When this option is selected, the trap will be created as a transparency group
containing a stack of trapping objects corresponding to the colors and blend modes of the original objects taking
part in the transparency blend. The group as a whole is put in blend mode Darken. Note that this is different from
option 1 “Scope 2 and lower”, where each of the objects in the stack were put in blend mode Darken. This option
uses the new group transparency feature. This always results in the correct trap color without the need to create
any new raster images. It is advised to always use this option unless there is a frequent need to export documents
to GRS or to share files with sites that use Scope 2 or 3 versions. In those cases this option shouldn't be used since
the transparency group construct will have to be flattened on export to GRS or import in the older Scope system,
which could result in performance issues.

Ink Pullbacks

• Also for vignettes and images: normally the system only takes solid colors in account when it comes to ink
pullbacks. If you want to, you can force the system to perform ink pullbacks on everything, also on objects
overlapping vignettes and images.

• Ignore luminance: the system takes certain aesthetic precautions while trapping. It takes luminance into account
when calculating what ink (if any) to pull back. You can disable this behavior by selecting this toggle.

Scan
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During the scan phase the trapping software looks for areas in the job where trapping could be applied.

To do so, the objects to be examined will be converted to a flattened graph. In the flattened graph, the areas are
searched for places where two regions are approximating each other.

For each region, the accumulated color is taken into account. This accumulated color is the result of applying all the
paint and transparency settings of the objects contained in the given region.

The accumulated colors of the two regions are then checked for a chance to trap.

If there is a chance between the two colors to trap, a color pair is generated, and the place of proximity of the two
regions is stored as a 'color pair hit' with the given color pair.

There are two different kinds of color pair hits: direct hits and indirect hits.

• A direct hit of a color pair for a common edge between two regions occurs where one of the regions has one color
and the other region has the other color of the color pair.

In this case, there is a direct contact between the two colors of the region. In the picture below there is a direct hit
for the color pairs (C, M); (Y, C); (M, K) and (Y, K).
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• An indirect hit of a color pair occurs at places where the two regions are geometrically close to each other, but

not with a common edge.

This is the case at places where the regions touch each other just at one point, where four or more regions touch
each other.

In the picture above there is an indirect hit for the color pairs (C, K) and (Y, M) at the point where the four boxes
touch each other.

The scan tab contains options to fine-tune this scan action.

Objects:

• All: Scan all objects in the job when looking for trap color pairs (default).
• Green Selection: Only scan objects that have been selected in the LineWork editor (in the green user selection). If

this option is active but no green selection is found in the job, the entire job will be trapped instead.
• Close Gaps smaller than x mm: Some input jobs contain very small unintentional gaps between neighboring

objects, preventing the correct trapping of these objects.

Although it is better to clean up such jobs before trapping, the trapping engine contains an algorithm that tries
to ignore these gaps automatically.

When you enter a value (in mm, cm or inches), the algorithm will try to ignore gaps having a width smaller than
the value you entered. However, this gives no guarantee that all small gaps will be ignored.

The gap range is 0.0mm (meaning the algorithm is not used) to 0.1mm. The default value is 0.005mm.

Note:  If you set the distance too high, the scanning process will become slower, and small parts of the job
may be removed.

Restrictions: In some special cases the trapping software can safely ignore certain object types. This knowledge can
substantially speed up the trapping. The following object types can be ignored:

• Patterns: Ignores native fill and stroke patterns. Prior to trapping, fill patterns are converted to contours. Fine
patterns may result in a huge number of contours. In some cases this can cause memory shortage and/or long
trapping times.

• Bitmaps: Ignores bitmap pixel data. This type of data is contourized before trapping, which may slow down the
trapping action depending on the contents of the bitmap(s). Bitmaps (LPs) with lots of small isolated islands will
typically take a longer time to trap.
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• Overprinting Native Blends: This option is only used in a DeskPack workflow. Certain native Adobe Illustrator
blends cause performance issues, since they have little or no actual effect on the trapping process you may ignore
them.

• External Objects: Ignores references to external Normalized PDF, legacy GRS, LC, and LP files. If this toggle
is off then the external references are degraded to internal objects prior to trapping. By default external references
are not trapped because in some cases, when the input job contains many references to external files, this can
cause memory shortage and/or long trapping times.

• Existing Trap Layers: Ignores any existing trap layers contained in the job. This option is useful to re-trap a job
that was already trapped (with different trapping parameters).

Note:  When you indicate an object type to ignore, it will be ignored completely as if it did NOT exist in the
job. Also, the objects that are ignored will NOT truncate trapping areas resulting from other objects. Use these
options with care and only to speed up the trapping of specific types of jobs.

• Don't trap text smaller than x points

Small type must be kept as sharp as possible. Trapping may blur the sharp edges of small characters making them
harder to read.

The Trapping engine has an option to prevent trapping of text below a specific point size (1 point equals 1/72 of
an inch). Edges of text characters below the given point size will not be selected for trapping.

This option only affects the trapping of native text objects not that of contourized text (the default value 0 points,
meaning trap all text).

Allow Different Settings for One Color Pair: The trap expert can generate a different trap action for different hits of
the same color pair.

Select Yes to allow different settings for the different hits of one color pair. This is the default value.

Select No to force the trap expert to apply one identical action to all the hits of the same color pair.

Select Only for objects bigger than to force the trap expert to apply one identical action to the hits of one color pair
belonging to small objects, and to allow different settings for the hits belonging to the bigger objects.

Use the size parameter to select the size of small objects.

Rules Tab
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The rules tab allows users modify the default trap distance and shape settings and to specify one or more custom
trap color pair rules. Custom rules allow users to forbid specific types of trapping or to specify a different set of trap
settings (distance and shape) depending on the type of the abutting colors of the trap pairs.

Note:  Custom trap color pair rules are an advanced feature that should only be used when trapping with the
general settings does not give you the desired result.

How do Trap Color Pair Rules Work?

While scanning the job, the selected trap expert builds an internal list of abutting color pairs that are suitable
candidates for trapping.

Each of these color pairs has an associated set of trap parameters like the trap distance (width of the trap area) and
other parameters controlling the shape of the trap.

By default a single set of default parameters ('General Settings') is associated with each of the color pairs. If the
general settings are not appropriate for a specific type of color pair (for example CT to line work trapping), a rule can
be added to specify a different set of parameters for this type of color pair.

For example a rule can be created to trap spot colors into spot colors with a specific distance different from the
default.

In that case only the pairs of colors containing PANTONE inks will be trapped with that distance. All other color
pairs will be trapped with the default distance specified in the default settings.

Modifying General Settings

Select the default settings in the rule list by clicking on 'General Settings' and press the modify button. The modify
panel will appear:
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Action Group

This panel allows you to specify the actions that will be performed for each color pair (trap and/or pullback) and the
settings that will be used to create the trap area (distance, color and shape).

The radio buttons in this group specify the action performed on each candidate trap color pair. Two actions are
possible: Trap and Ink Pullback:

• A thin trap area will be created between the abutting colors where the colors will overprint each other. Traps are
also known as Frames or Grips.
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Options:

• Force: Force a trap area for each color pair.
• No: Forbid creation of trap areas for each color pair.
• Trap Expert: The selected trap expert automatically decides for each of the color pairs if they are to be trapped

or not. (default).
• Ink Pullback is an action that keeps away all but the darkest inks of a color area composed of multiple inks that

borders to a very light background. This action prevents that individual inks from the composed color will become
visible on the background due to registration errors during the printing process. Ink pullback is also known as
Cutbacks or Keepaways.

Object with 100%C,100%K on an empty background. 100%C is pulled back, a fine line of 100%K remains:

 

 

Options:

• Force: Force a pullback area for each color pair where this is possible. At least one of the two colors should be
composed of multiple inks.

• No: Forbid creation of pullback areas for each color pair.
• Trap Expert: The selected trap expert automatically decides for each of the color pairs they are to be pulled

back or not. (default).
• Reverse prevents overprint of abutting color areas with different inks by selecting these color pairs to be trapped

with a white knockout (erasing) trap.
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Options:

• Force: Force a Reverse area for each color pair where this is possible.
• No
• Trap Expert: The selected trap expert automatically decides for each of the color pairs (default).

Settings Group

• Trap Distance: Specifies the width of the trap area in millimeters or inch.
• Pullback Distance: Specifies the width of the pullback area in millimeters or inch. If a color pair is both trapped

and pulled-back, this distance will be used.
• Trap Color Opacity: Instead of spreading the full color, the trap color can be reduced to a percentage of the

original color. This options can be used to create a lighter trap color. (default 100%, spread full color)

Shape

• TruncateThe trap area is truncated to avoid that it exceeds the edge(s) of the color area under which is trapped.
There are two different truncation modes:

•
On Edge:  The trapping area is truncated on the object edge, even if a larger distance has been defined.
This is to avoid that the trapping area of an object exceeds the edge of the object under which is trapped. This
is the default truncation mode. (default)

•
On Center:  The system recalculates the trapping distance for the areas where a trapping area comes
too close to the contour of an object. In that case, the trapping area stops halfway the object. In all the other
areas, the complete trapping distance is applied.
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• End Caps This option specifies how the ends of an open trap area are constructed.

•
Perpendicular:  When this mode is selected, the trapping areas are placed at right angles relative to the
boundaries of the abutting color areas.

•
Object Dependent:  When this mode is selected the trapping areas are a logical continuation of the
contour of the object that is spread. (default)

•
Round:  When this mode is selected the trapping areas are ended with circular arcs. This mode is
typically used in combination with white knockout or ink pullback.

 

 

Corners This option allows you to change the way sharp corners in the trap areas will be handled.
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•
Mitered:  If the distance from the base of the trap to the corner point is larger than the miter ratio multiplied
by the trap distance then the corner will be beveled otherwise it will remain sharp. See also miter ratio option.
(default)

•
Round:  A round cap will be placed at all corners.

•
Beveled: 

 

 

Miter Ratio  Determines when a sharp corner is beveled. If the Distance from the base of the trap to the corner
point is larger than the miter ratio multiplied by the trap distance then the corner will be beveled otherwise it will
remain sharp. This option is only available when mitered corners are selected (default value 4).

Adding a New Rule

To add a new rule, press the 'New' button on the 'Rules' tab. The 'New Rule' panel will appear:
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The top section of this panel defines the type of color pair for which this rule applies. A rule will only 'match' with
color pairs that have the same type of trap and boundary color as specified in this color pair template. The bottom
section specifies the trapping actions associated with this type of color pair and the parameters of the trap area.

Color Pair Group Contains a description (template) of the color pair. On the left is the description of the trap color
and on the right is the description of the color that is being trapped into (the boundary color).

Both color templates are composed of the same fields:

Color Type

• Any Color: Matches to any color (wildcard).
• Process Ink: Any color containing at least one process ink (CMYK).
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• Spot Ink: Any color containing at least one PANTONE ink or at least one designer ink.
• Image: Any contone Image.
• Vignette: Matches to any vignette color
• Empty Background: The empty background. Can be used on the left side to match with color pairs for which ink

pullback will be performed.
• Registration Color: The color that is composed of all inks used in the job used at 100%.
• Opaque Ink: Any color containing at least one opaque (metallic) ink.

Ink Name When the color type is Process or Spot, an optional ink name may be specified. In that case the color
template will only match with colors containing the ink with that specific name (default 'Any').

Densities When the color type is Process, PANTONE, Designer or Opaque, additional constraints on the densities of
the specified ink (type) may be imposed.

Minimum Density: the color template will only match with colors that contain at least the given percentage of the
specified ink.

Density of other inks must be 0%: If this toggle is on, the color template will only match with colors that do not
contain any other (type of) inks than the one specified. If the toggle is off, the template will also match to colors
containing other inks. (default off)

The Action and Settings groups are the same as those in the 'Modify Rule' panel. Here you can specify which actions
to take for the specified type of trap color pair and what parameters to use to create the trap areas.

Finally press OK to add the new rule to the list of rules in the rules tab. Under the rules list a textual summary is give
of the settings associated with the selected rule. Differences with the default settings are indicated with blue text.

Rule Priority

Rules have a priority associated with their position in the rules list. The system always evaluates the list of rules in
a bottom-up fashion. The system first tries to match each color pair to the last rule in the list. If this rule’s color pair
template matches the color pair, then the evaluation stops and the settings associated with the rule are used for the
color pair. If the rule does not match then the next rule (the one above the last one in the list) is tested.

This process continues until a match is found or the top of the list is reached. If no matching rule was found, the
default settings are applied to the color pair. The “Default Settings” are always at the top of the list and contain the
parameters associated with all color pairs that do not match to a more specific rule.

 



Automation Engine | The Tasks: an Overview | 529

 

For the list above the color pairs will first be tested for a match with the rule 'Process Ink >PANTONE reflex blue
CVC', then with the broader rule 'Process Ink >PANTONE Ink' then with 'Any Color >Image', until a match is found.
If no match is found the default settings are applied to the color pair.

• Move Up / Down buttons:These buttons can be used to change the position and the associated priority of the
selected rule in the list. The 'General Settings' cannot be moved. They always remain at the top of the list.

• Remove button: This button removes (deletes) the selected rule from the list of rules. The 'General Settings'
cannot be removed. They always remain at the top of the list.

When to Use Rules?

Trap color pair rules are an advanced feature of the Trapping technology, intended for experienced users. The
Trapping engine will deliver high quality trapping results for most jobs without any customized rules if suitable
default settings are selected.

There are cases, however, in which the automatic algorithm based on the relative darkness of the colors to be trapped
is not perfect. In other cases a single set of trap parameters (distance, shape, color) independent of the type of trap
colors may be too restrictive. Customized rules offer a mechanism to specify exceptions.

Below a number of typical examples (use cases) are given to demonstrate the use of color pair rules.

1. Different widths for different types of traps. Depending on the type of the abutting colors a different trap distance
may be required. Sometimes larger trap distances are used for spot inks since there are usually no other inks
to help cover leaks on the press. Process tints typically only need a very small trap. A larger distance may be
required when trapping into a dark color (for example containing 100% black).
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To set a specific distance when trapping a CT into another color, add a new rule: 'CT' > 'Any Color' with the
required trap distance. If colors trapping into a CT should also be of this distance then a second rule 'Any Color' >
'CT' should be added.

2. Prevent Trapping or Ink Pullback in specific cases. Depending on the type of the abutting colors, trapping and/or
pullback of ink may be undesirable. In such cases a rule may be created with the 'Trap' and/or 'Pullback' action set
to 'No'.

To allow ink pullback only on colors containing 100%K: Set 'Pullback' to 'No' in the 'General Settings' and add
a rule 'Empty Background' > '100% Process Black' with 'Pullback' set to 'Trap Expert'. This rule will allow ink
pullback on composite colors containing 100% process black but forbid pullback on any other composite color.

3. Force a specific Trap direction.The trapping engine determines the trap direction based on the relative lightness of
the abutting colors. If the colors are of (almost) equal lightness, then the algorithm selects an arbitrary direction. In
some cases this direction can be selected with a rule.

By default the color 100%C is trapped into the color 100%M. To change the trap direction, add a new rule
'100%M' ® '100%C' and set the trapping action to 'Yes'. This will force the pair to trap in the specified direction.
Activate the toggles: 'Other Inks must be 0%' to prevent other color pairs containing cyan and magenta from being
affected by this rule.

4. Specify a different Shape and/or Truncation mode for certain color pairs.

Only apply 'On Center' truncation when trapping under a 100% black key line and 'On Edge' truncation on all
other color pairs. Use round corners on some types of traps and mitered corners on others.

Output

 

 

Include Original File

By default the trapping engine generates a copy of the original GRS job containing one additional layer which
contains all the trapping areas. When this option is off, the resulting GRS will only contain the new layer with
trapping areas. This layer can later be placed on top of the original job later using the Place option in the LineWork
editor. This allows you to add objects that don’t need trapping (for example bar codes and registration marks) in the
original job and add the trapping layer as a final step. (default: On)

Only Use PostScript Compatible Features to Create Trap Areas

By default the trapping engine uses proprietary paint operators (BG Overprint and in some cases Reverse Overprint)
to obtain the correct colors in the trap areas. Use of these special overprint operators gives the best results in an Esko
workflow (for example output using a Barco Rip). However, this default output model is less suited when the trapped
job should finally be output on a PostScript device or as a PDF file. In that case it is best to activate this option to
prevent long conversion times when exporting the trapped file to PostScript or PDF.

Note:  Trapping times may be longer when this option is active. In some areas where multiple traps overlap
each other, the resulting color may be undesirable. Therefore it is advised to use this option in combination
with Centerline truncation (as it prevents overlap of trap areas).
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Trap - Prepare Trap Pairs(Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 

Scans through the job and suggests a list of candidate trap color pairs.

The 'suggest' task has the same options as the Trap task except that it has no output options. The output of this task is
a trap color pair information file. This file contains all information gathered by the automatic trap expert during the
scan phase. This file has the same name as the input job and has the extension '.tcp'. It is placed in the same folder
as the input file. The settings associated with the color pairs in the TCP file can be edited in the LineWork editor.
Jobs that have been scanned by this task (and as a consequence have an associated TCP file) can be submitted to the
'Create trap layer' task.

Tasks with Special Licenses

Convert Colors

The Convert Colors task enables you to convert your files’ colors using Equinox.

For more information about Equinox, please see the Equinox documentation.

Color Strategy

This lists contains all of the color strategies defined in Color Engine Pilot. Choose the color strategy your want to use
to convert your file.

Hide Technical Inks

Select this option if you want to keep technical inks out of the conversion.

Note:  By default, this task flattens all the complex blend modes in your file, to make sure the colors are
converted accurately.
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The Automation Engine Viewer

About the Viewer

What is the Automation Engine Viewer?

The Automation Engine Viewer is a comprehensive, powerful and integrated Viewer and QA tool.

It can easily be integrated in your Automation Engine workflow, to view, check and compare graphic production data.

It can be launched directly from within the Automation Engine Pilot, on any Macintosh or Windows PC in your
network. Anywhere you can install and log on to an Automation Engine Pilot you can start the Automation Engine
Viewer (DTP, prepress, QA department, CSR desk...).

You can use as many Automation Engine Viewers as you have Automation Engine Pilot connections. Opening the
Automation Engine Viewer does not allocate an extra Pilot connection.

It is even possible to have two or more Automation Engine Viewers on one workstation by opening a second
Automation Engine Pilot (Pilot - File menu - New window) and opening a file in the Automation Engine Viewer from
there.

If you are an Esko Bitmap Viewer user, you will notice that the interface and shortcuts are nearly identical.

What does the Viewer offer you?

• Reliability: Showing the data in a correct way. At best in the same way the RIP / Proofer will see them.
• Detail: Unlimited zoom, high detail measuring, measuring traps and exact distances (die objects).
• Speed: Opening files swiftly, even when it concerns large files. Fast zooming.

Prepared View Data

Reliability is a must. Detail can also not be compromised, it is always offered. The challenge lies in opening very
large files quickly. That is why the Automation Engine Viewer offers 2 view modes: with or without Prepared View
Data.

• In case you do not prepare View Data, the server will stream the data to the Automation Engine Viewer. When a
large file has to be opened or compared or when the server is very busy, a delay can be noticed. Deep zoom detail
mode is immediately available.

• In case you do opt to prepare View Data in advance, then the Viewer will show you the prepared View Data
instantly. Zooming in will of course require object data streaming from the server, but then for a smaller area.

For more information about creating View Data, see Prepare for Viewer.

Supported File Types

The Automation Engine Viewer supports the following file types:

Graphic files, both with and without prepared View Data

Esko normalized data:

• Esko PDF
• Esko PDFPLA

Non-normalized graphic files:

• EPS
• PostScript
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• Legacy Esko GRS
• PLA
• Legacy Esko STA
• EPF (DeskPack)

• PDF
• ArtPro
• AI
• For Adobe Illustrator ‘EPS’ file types, the

same restrictions are valid as in PackEdge.

Please refer to the White Paper on EPF, which
is available on the Documentation DVD.

Images, both with and without prepared View Data

• Esko CT
• Image EPS
• DCS/EPS
• PSD
• TIF (< 600 ppi)
• JFIF
• LP

Post-RIP data only with prepared View Data and if an Esko Bitmap Viewer SITE license is available

• LEN
• TIF (> 600 ppi)
• DCS 2.0 (> 600 ppi)

Note:

When opening files that are not yet normalized, the Viewer needs to read in the data. This is equal to a
normalization step.

The Viewer Settings in Configure make it possible to indicate which Normalization ticket is preferred to
execute this hidden normalization (see Viewer).

If you use View Data, the Prepare for Automation Engine Viewer task will include a normalization step.

If you do not use View Data, the file will be normalized right after choosing ‘Open’.

Tip:  If you want to compare an Esko normalized file with its original non-normalized design, you can set up
a workflow where you always keep the first file version after the normalization - before starting to edit - and
compare that file with the resulting edited version.

Viewer Statuses in the Files View

The View column can display a number of different statuses. Select a file to find out its status.

1. A dash (-) indicates that the file is not viewable, for example text, Word documents, paf files... File extensions are
taken into account to decide whether or not a file is viewable.

2.  'View' indicates that the file could be viewable. It is possible based on the file extension, but no view files
have been generated as the calculation could provoke a performance slowdown.

3.
 'View (Prepared)' indicates that the file can be viewed as prepared view data has been

generated, either by launching a file with the Prepare for Viewer task (see Prepare for Viewer), or by copying or
moving files in a folder that is marked as Speed up for Viewing. Up-to-date view files are available.

4.
 'View' indicates that the file can be viewed. However, there are no view files available, and they will be

calculated on the fly if you want to view.
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5.
 'View (Prepared)' indicates that the file could be viewed, but viewing is disabled because the

view files are out of sync with the original file.

Digital Film Files

For digital film files, the situation is slightly different.

A) For .len files, it is mandatory that view files are prepared so as to be able to view.

1.
 'View (Prepared)' indicates that the files have up-to-date view files and can be viewed.

2. - (Need View Data) indicates that for the selected .len file no view data has been generated and it cannot be
viewed.

3.  indicates that the .len files have view data, but that the view data is not in sync with the original
file and can therefore not be viewed.

B) For .tif files, behavior depends on the resolution of the file.

A TIFF with low resolution (<600 ppi) can be viewed without having view files.

A TIFF file with a high resolution (>600 ppi) must have up-to-date view files to be able to view it.

Viewing a File using the Viewer

In the Files view, you can easily view different types of files using viewer. However, the viewing privileges depend
upon the specified user rights.

Note:  If the the user access right for deep zoom is not enabled (read more here Defining User Access Rights
)while defining user rights:

• you can only view prepared files
• your zoom is restricted.

To view the files:

• click the word View next to your file.
 

 
• right-click your file and select View...
• select your file and go to  File > View .

The Viewer Window

The Viewer comes with a number of powerful tools that make it easy to navigate, view and compare files.
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1. The View Selector
2. The Toolbar
3. The Tools Shortcut Bar
4. The Navigator Panel
5. The View Panel
6. The Channels Panel
7. The Info Panel

Note:  Some tools have an arrow in their lower-right corner. Right-click those tools to show more options.
 

 

Customizing the Viewer Window

You can hide some of the Viewer’s tools to get a bigger viewing area, and show them again when you need them.

•

Click  in the toolbar to hide or show the Tools Shortcut Bar.
•

Click  at right to hide or show the side tools panels.

The View Selector

The View Selector allows you to go through both:

• the recently viewed files,
• the pages of a (recently or currently viewed) multipage file.
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Select the file or page you want to view in the list, or use the arrows.

The Toolbar
 

 

The toolbar contains:

• a progress bar,
• multipage options (only when viewing a multipage file). See Viewing Multipage Files.
• a Compare tool that allows you to compare two files. See Comparing Files using the Viewer.
• an Information button that opens the Info dialog box (containing XMP metadata). See File Information (XMP

metadata).
• a Print button that opens the Print options dialog box. See Print.
• a Help button that opens the Viewer online help.
• a Close button that closes the file being viewed (but not the Viewer).

Note:  The Viewer documentation included in Automation Engine only highlights the most important tools
and options. Please refer to the online Viewer documentation for more elaborate information.

File Information (XMP metadata)

When viewing a file, some information is not visible but often useful:

• External references (names of referenced images or ArtiosCAD file)
• Barcode parameters (code type, number , bar width reduction…)
• Fonts
• SmartID
• Ink type (normal, opaque, varnish, technical)
• Layers

Clicking the Info button opens the Info dialog box.

The information displayed here is identical to the information you get when you select a file and click the Info button
in the Files View.
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Print

In case you want to share information that is visible in the Viewer to other people who do not have the Viewer online
at the same time, you can use the Print option.

This way you can for example e-mail a PDF file to someone to indicate a measurement that is part of a discussion.

Note:  An elaborate collaboration and annotation workflow is offered by WebCenter.

You can indicate which part of the file you want to print: the current view, the current window, or the image area.

You can set additional options, such as orientation and borders, as desired. The available options depend on your print
type selected. If 'image area' is selected, the 'Parameters' group appears.
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Click the Page Setup... button to set additional paper, margin and orientation options.

Click the Print... button to select the network printer you want to print to, indicate the print range and the number of
copies.

Check the Print to File box if you want to print to a PDF file.

The Tools Shortcut Bar

 

 

By default, the Tools Shortcut bar has the following tools:

• Reader spread (only when viewing a multipage file, see Viewing Multipage Files),
• arrows to navigate between pages or spreads (only when viewing a multipage file),
• Zoom tool,
• Zoom out tool,
• Pan tool.

Right-click the Shortcut Bar to show or hide different tools in it.

 

 

Note:  You can select a tool here even when it is not currently available in the Viewer (for example Page list
when viewing a single page file). This tool will then automatically appear in the Shortcut Bar the next time it
can be used (for example when viewing a multipage file).

Note:  When you hide the Shortcut bar (see Customizing the Viewer Window), the Zoom and Pan tools are
moved to the Tools panel.

The Tools Panel

The Tools panel hold the most frequenty used tools.

 

 

The Tools panel contains the following tools:

• the Zoom tool, that guarantees indefinite zoom.

Click the tool or use Ctrl+ '+' to zoom in.

Use Ctrl+ '-' to zoom out.
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• the Pan tool, that allows you to pan through your file,
• the Ruler tool (see The Ruler),
• the Densitometer tool (see The Densitometer),
• the Screen ruling and angle tool.

Note:  The Viewer documentation included in Automation Engine only highlights the most important tools
and options. Please refer to the online Viewer documentation for more elaborate information.

The Ruler

The Ruler tool calculates the distance between any two points in the work area.

When you measure from one point to another, a non-printing line is drawn and the options bar and Info palette show
the following information:

• The starting location (X and Y).
• The horizontal (W) and vertical (H) distances traveled from the x- and y-axes.
• The angle measured relative to the axis (A).
• The total distance traveled (D).

To measure between two points:

1. Select the Ruler tool.
2. Drag from the starting point to the ending point. Hold down the Shift key to constrain the tool to multiples of 45°.

 

 

Right click the measure icon to set some extra options, like for example showing or hiding units, changing the ruler
angle, or the display color...

Click the unit in the 'size' line of the Info panel to switch between points, millimeters, centimeters and inches.
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One of the other nice features of the Ruler tool is that it can be combined with different view tools. You can, for
example indicate a certain point, then change the view by zooming out, navigating, or turning back to a previous
view, and then indicate the second measuring point.

The Densitometer

Click in your file with the densitometer tool to measure a certain point, or drag it to measure an area.

The densities are shown in the Channels panel, and the location measured in the Info panel.
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By default, the densities are also shown in a pop-up near the location you measured.
 

 

Right-click the densitometer tool to hide or show this pop-up.

Calculate Screen Ruling and Angle

Note:  You can only use this tool when working with digital film (RIP’ed files).

1. Select the screen ruling tool.
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2. To select the area in which to measure the screen:

• click a point in the image,
• hold down your mouse and drag across an area (to make a more precise selection),
• make a selection and double-click the tool,
• double-click the tool to make a measurement based on the current view.

The Channels panel displays the screen rulings:

 

 

3. To show a channel’s screen angle (in the measured area), click its screen ruling value in the Channel panel.

 

 

4. To change the screen angle orientation, right-click the screen ruling tool button and choose either:

• Screen Orientation from XMP (used by default),
• Screen Orientation CW,
• Screen Orientation CCW.

The Navigator Panel

The Navigator panel allows you to see the part of your file you zoomed in on, and to reposition the zoom if
necessary.

The View Panel
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The View panel contains the following tools, divided over three lines:

First line:

•
 Previous view:Hold the Shift key to switch to the first view.

•
 Next view: Hold the Shift key to switch to the last view.

•

 Rotate view: Rotates the current view by 90 degrees clockwise.
•

 Mirror view: Mirrors the current view.
•

 Invert view: Inverts the current view.

Note:  The Viewer documentation included in Automation Engine only highlights the most important tools
and options. Please refer to the online Viewer documentation for more elaborate information.

Second line:

•
 Background Color: Changes the image’s or the window’s background color (see Background Color).

•

 Show margins (trim box): Displays your file’s trim box (see Show Margins).
•

 View from back: mirrors the current view and the sequence of the channels will be reversed.
•

 Set overprint highlight color: Highlights the overprints in the color of your choice (see Overprint
Highlight).

•

 Seamless view: Allows you to see several one-ups of your file without any space in between (see Seamless
View).

Third line:

•

 Total Area Coverage: Shows the sum of all separation-densities at a certain point in your document.
•

 Flexo Plate: Shows a single separation (by default the first in the list) as a simulated flexo plate.
•

Flexo Print: Shows the effect of highlight dot gain on the image.
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•

 Break Out: Shows an area where the percentage of a single separation is lower than the First Visible Dot
value. This can be used to track areas that won’t show up on print because the values are too low.

•

Registration Error: Shows a simulation of a design printed with registration errors of a specific press (as
defined in the Press Settings).

Background Color

To change the window and/or image background color:

1. Either:

• Click the Background color tool then the appropriate icon in the Select Background Color group that appears.
 

 
• Right click the Background color tool then select one of the options from the context menu.

 

 

2. In the Select Background Color dialog that opens, select either a color swatch, or an HSB or RGB value.
 



Automation Engine | The Automation Engine Viewer | 547

 

In the example below, the window color was set to black.

The image background was set to light grey, and whereas white is shown as light grey, all separation measurements
remain unchanged!
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Show Margins

When the trim box is set correctly, you can easily check the correct die settings and possibly predict a problem in the
later repeat layout.
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Overprint Highlight

Click the Set overprint highlight color button to get a clear indication of all areas with any form of overprint of 2 or
more separations.
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Click the color patch to select the highlight color of your choice.

 

 

Seamless View

• Click the Seamless view button to see a multi-up layout of the open file.

By default, the seamless repetition will be made around the trim-box.

If the trim-box is not defined (in the XMP metadata), it will be made around the image’s boundaries.
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• If necessary, you can adjust the seamless guides:

a)
click the seamless crop tool  to select the one-up’s trim box (or the image’s aboundary if no trim box is
defined),
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b) drag the trim box sides or corners to resize the area that is repeated.

Seamless with Overlap

By default, the seamless repetition will be made by clipping the image at the trim-box, and repeat the clipped part.

Sometimes however, the design to be checked is created to have a non-rectangular clipping.

 

 

To check such designs, the Overlap button  can often be helpful.

When turned on, the viewer will overlap the repeated areas rather than tiling them at the trim-box.
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Total Area Coverage

The Total Area Coverage (TAC) is the sum of all separation-densities at a certain point in your document.

TAC Level Limit

The TAC Level limit is the maximal Total Area Coverage that your document may contain. This value depends on
the press and the substrate your design will be printed on. Your printer should provide you with the TAC Limit value
to use.

Defining the TAC Limit

The TAC limit is defined in the Press settings. By default the TAC Limit is set to 270%.

To quickly see the maximum TAC in your document, use the TAC Limit slider.
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Move the slider to the right to use a TAC Limit value higher than that used by your current Press Setting. The more
you move the slider to the right, the less pixels will typically be over the TAC Limit.

Flexo Plate

If you change the Viewer Preview mode to Flexo Plate, a single separation (by default the first in the list) will be
shown as a simulated flexo plate.

 

 

In this Preview mode, only one separation can be viewed at a time.

Note:

Viewer uses the same technology as the Esko Flexo Tools for Photoshop.

First Visible Dot

The Flexo Plate preview will use the First Visible Dot percentage from the press settings:

• Pixels with a percentage lower than the First Visible Dot percentage will be shown as areas without dots.
• Pixels with a percentage equal or higher than the First Visible Dot percentage will be shown as areas with dots.
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Plate Color

This preview predicts how clean your flexo plates will be. Especially in very light or very dark areas, you could end
up with isolated dots or holes on the flexo plate, and those areas are difficult to hold on the plate or the substrate.

You can choose the plate color (Cyrel Red, Blue, Green or Safran Yellow, or a High Contrast Blue&White) to match
the type of plate you are using.

Flexo Print

This Viewer preview mode shows the effect of highlight dot gain on the image.

This effect is equivalent to a curve adjustment. To determine this curve, the Flexo Print Preview will use the First dot
and the Dot gain in highlights settings from the Press Settings.
 

 

Going from light to dark:

• The Print Preview layer will display percentages below the First visible dot percentage as 0%.
• The First visible dot percentage will be shown using the First Dot Prints as percentage.
• Percentages above the First visible dot percentage will be shown darker.
• Towards the midtones this darkening effect will fade out until the Range value.
• Percentages above than the Range value are displayed unchanged.

Break Out

A Breakout is an area where the percentage of a single separation is lower than the First Visible Dot value. This can
be used to track areas that won’t show up on print because the values are too low.

Your printer should provide you with the First visible Dot value. The First visible dot is set in the Press Settings.
When switching to Breakout mode, the preview will be dimmed and all areas where a single separation has a value
lower than the First Visible Dot value (but higher than 0%), will be displayed in highlight color.

You can measure the actual percentages in that specific area using the densitometer.
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Registration error

The Registration Error Preview is a simulation of a design printed with registration errors of a specific press (defined
in the Press Settings, see ). It can be very helpful to see if trapping is applied sufficiently and correctly.

 

 

The Registration Error value is taken from the Press Setting you selected. The separations are randomly shifted. In
fact, all separations are moved exactly the distance of the Registration Error, but all under a random angle.

If you want to see another random registration error simulation, click the Simulate Again button.

In the example above, you can see a small area of a job in regular preview (left) and with registration errors (right). In
this case, you can clearly see no trapping was applied, so white lines appear at the registration shifts.

The Channels Panel
 

 

The Channels panel shows the file’s channels and offers extensive separation viewing possibilities.
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 Click the View channels in separate windows button to switch between a composite view and a view of one
or all separations.
 



Automation Engine | The Automation Engine Viewer | 559
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Click the separation's box to add or remove a channel from the selection.

Right click the box to see only the selected views.

 

 

You can decide to show separations with the same ink name as one, or to split them. For example the K and K/1 Esko
inks are shown as one by default.

Double-click a channel to show the Channel Colors dialog.
 

 

In this dialog, you can edit the channel’s display color definition: select a new display color from the list, or set new
RGB values.

Check the Opaque box to make the selected separation opaque.

The arrows at the bottom allow you to change the order of separations that are shown in the list.
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Note:  The Viewer documentation included in Automation Engine only highlights the most important tools
and options. Please refer to the online Viewer documentation for more elaborate information.

The Info Panel

The Info panel displays file information (dimensions, resolution), and viewing conditions (magnification used, mouse
position, readouts from the ruler selection when using the ruler...).

Note:

To change the current units, click on one of the small triangles and select the desired unit in the pop-up
window that opens.

You can select units independently for sizes and resolutions.

 

 

Working with the Viewer

Comparing Files using the Viewer

The Automation Engine Viewer is not only a powerful viewing tool, but also contains a strong comparison tool.

To compare two files, open one file in the Viewer, then click the Compare  button to open the second file.
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It is an ideal way to compare two files and have a close look at the differences, if needed per separation, including
changes in the images (internal or referenced images).
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While comparing you can use other tools like for example 'view separations in separate windows', measure,
(de)select, rotate, etc...
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Viewing Differences in the Separations

In case you compare files that have different separations, then all differences will be shown in both common and
unique separations.

When the compare tool is activated, the Channels group will display an additional number of icons.

Move over the icon with the cursor and the tooltip will indicate what it stands for.

Right-click the following icons   to get additional options that allow you to change view modes, highlight
colors and difference levels.

 

 

In the example below, only the difference is shown.
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Comparing Files of Different Sizes

Comparing files with different sizes may seem like a challenge as they are not aligned in the Viewer, but the Viewer
has some tools that make it very easy.

 

 

You can align both files by:

 

 

• Rotating one file (by 90 degrees),
• Mirroring one file,
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• Inverting one file,
• Aligning both files on one corner,
• Aligning with the help of a ruler (see Align from Ruler, Auto Align from Ruler and Auto Align).

Note:  You can find the ruler tools under the alignment button.
 

 
• Aligning both files on their trim box,
• Indicating the offset manually (typing in the fields).

Align from Ruler

The ruler tool works by defining two points (one in each file) that have to be aligned.

Tip:  Click the Align from Ruler tool to show additional information.
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1.

Select the reference version of the file by clicking the  icon.

2.
Click the alignment icon  and select Align From Ruler in the list.

3. Indicate the ruler anchor point.
 

 

4.

Switch to the other version by clicking the  icon (or use Ctrl + S).

The anchor point, here in the red circle, will be in a different location in the second file version.

5. Indicate the point that should be positioned on the ruler anchor point (here in the blue circle).
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6. Click the Align From Ruler tool again. The files are now aligned.
 

 

Note:  Depending on how precisely you defined the second ruler point, you may have to zoom in and
repeat the alignment procedure to align your files with more precision.

Auto Align from Ruler

Auto Align from Ruler is used the same way as the Align from Ruler tool, but is more accurate at high resolution.

If the details of the alignment points match, the viewer will be able to increase the alignment precision (and have a
good alignment with fewer iterations).

Auto Align

Auto Align does not use the ruler, but rather the currently visible view of the two compared images to attempt an
automatic alignment.

Using this tool repeatedly with one or more zoom-ins can be a very convenient and quick way to align two images.

For convenience, a separate tool button  is available to perform an Auto Align operation without having to open
the Alignment pop-up menu.Clicking this button will perform an Auto Align from Ruler if a ruler selection is active,
otherwise an Auto Align (from view).

Viewing Multipage Files

Page Lists

When opening a multi-page document, the Viewer offers a special preview and navigation panel called the Page list
panel. The Page list panel occupies the left part of the Viewer window.
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The Page list panel can be shown (or hidden) by clicking the  button in the top right part of the file selection
bar. This button is not visible if only single page documents are opened in the viewer.

The major part of the Page list panel is occupied by the page list thumbnail view. This view shows thumbnails of the
all the pages in the current multi-page document paired two and two according to the file’s binding definition.

The size of the thumbnails can be changed by right-clicking the Page list view button in the file selection bar.

 

 

You can switch the main view to a specific page by clicking the corresponding page thumbnail.

Below the thumbnail view is a navigation bar that applies only to the currently selected multi-page document.
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Reader Spreads

You can use the Reader spread button  in the file selection bar, to show your file in reader spread view (pages
side-by-side). The reader spread view shows pairs of pages as they will appear in the final document.

The pages are assembled by stitching two pages together on the pages' trim-boxes. If one of the two pages is missing
(if the active page is the first or the last), the active page will be shown with an empty (white) area next to it.

 

 

Note:  In reader spread view, clicking  displays the previous / next reader spread (set of two
pages).

There is a single active page in reader spread view. You can see which of the two pages is active in the Page list

panel, or by turning on the page margins  in the View panel.

You can choose to show the trim boxes of the two page margins in different colors, or to only show the trim box of
the active page.

You can also clip the reader spread on its trim box.
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Note:  The document comparison is disabled while reader spread view is active. If document comparison is
turned on, reader spread view is automatically turned off and visa versa.

Comparing Mutipage Documents

When comparing two multi-page documents, the view will present an option panel where you decide which pages to
compare to which.

 

 

Printing Multipage Documents

When viewing a multipage document, you can also choose to print all pages.
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Compensating Distortion

What is Distortion?

Distortion is a technique used to pre-compensate graphics that are to be printed with a non-uniform printing
technology. Distortion is typically done in the ripping process, the last step before printing.

The Viewer uses the file’s XMP metadata to detect if the files are distorted in the vertical and/or horizontal directions,
and by how much.

The Compensate Distortion Tool

To make comparison of files with and without distortion, or files with different distortion values easier, the Viewer
offers a simple distortion compensation tool.

Note:  You should compensate the distortion before aligning the files for comparison.

Use the Compensate Distortion button  to activate or deactivate the distortion compensation (this button is
only shown if one of the open files is distorted).

The tool tip of the Compensate Distortion button will show what the distortion of the current file is.

 

 

When the distortion is compensated, the resolutions and the size will be adjusted in the Info panel.
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Managing View Data

You can create View Data using the Prepare for Automation Engine Viewer task. See Prepare for Viewer for more
information.

Should you decide to work with prepared View Data, keep in mind that Automation Engine creates this View Data in
a (hidden) .view folder next to the opened file.

The size of this view data depends on the size of your designs. By default an automatic resolution is chosen. But you
should weigh the time that the server spends on creating the View Data, against the speed improvement you will
notice when initially opening a file that has prepared View Data.

Manually manipulating this data will surely create Viewer errors and is therefore strongly disadvised.

A mechanism is provided to delete the View Data:

• You can manually delete the (hidden) view data, by:

• right-clicking a file and choosing ‘Delete View Data’. This will remove the View Data for the selected file
only.

• right-clicking a folder and choosing ‘Delete View Data’. This will remove the View Data for all files in the
folder.

• When you demote or remove an Automation Engine Job (or Export / Archive it), the View Data is automatically
deleted.
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The ArtPro Action List Editor

Automating ArtPro Processing

Automation Engine can automate tasks in ArtPro and convert Nexus workflows into one or more Automation Engine
workflows. You can do this using the Apply ArtPro Action List task (see Apply ArtPro Action List), which takes
native ArtPro files as input, processes them and can output either ArtPro files or a range of vector formats. The task
uses an ArtPro Action List to define the chain of actions to be executed. This Action List file can be created and
edited by using the ArtPro Action List Editor.

Note:  A considerable number of actions are identical or very similar to functionality that can be found in
ArtPro. In these cases, a basic explanation is given in this reference manual. For a fully detailed description
please refer to the ArtPro manual.

The ArtPro Action List Editor actions contain an elaborate number of vector outputs which converts the ArtPro native
file format to a range of vector output formats.

Working with ArtPro Action Lists

Install the ArtPro Action List Editor on your client machine (where the Pilot is installed):

• On PC:

1. Open an Explorer window and type the following in the address bar: \\Automation Engine Server
Name\Automation Engine 10.1 Windows Client (where Automation Engine Server
Name is the name or IP address of your Automation Engine server).

2. Copy Automation Engine ArtPro Action List Editor 10.1.0.exe on your client machine.
3. Double-click the exe file to install the application.

• On Mac:

1. In Finder, go to  Go > Connect to Server...  (or use Command + K).
2. In the Server Address field of the Connect to Server dialog, type smb://Automation Engine

Server Name/Automation Engine 10.1 Mac Client (where Automation Engine
Server Name is the name or IP address of your Automation Engine server).

3. Copy Automation Engine ArtPro Action List Editor 10.1.0.dmg on your client machine.
4. Double-click the dmg file to install the application.

To open the ArtPro Action List Editor, select an Action List in the Apply ArtPro Action List task panel and click
the Edit button.
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The Action List you selected opens in the Action List dialog box. It is divided into three sections:

• Available Actions
• Selected Actions and
• Options for "selected action"

The Available Actions section has two columns. The left most is populated with all the available actions. The next
column is populated with the filtered actions. Drag and drop desired actions from this column to the Selected Actions
section. Enter an optional label to each action in this section to help identify these unique actions when using public
parameters.

In the Options for "selected action" section, the main parameters of the selected action are displayed. These
parameters can be edited. When you close the window, you are provided with an option to save the changes. The
default file extension for the ActionList is *.aal and the format is always UTF8.

Action List Menu Options

The following is a list of menu options available in the ArtPro Action List Editor:

1. File menu:

• New Action List...: Click this option to open a new Action List.
• Open Action List...: Click this option to open an existing Action List.
• Save Action List...: Click this option to save an Action List.
• Save Action List As...: Click this option to provide a name to the Action List and save it in a desired location.
• Exit: Click this option to exit the ArtPro Action List Editor.

2. Edit menu:

• Cut: Use this option to cut an action from the Selected Actions section.
• Copy: Use this option to copy an action in the Selected Actions section.
• Paste: Use this option to paste a copied action into the Selected Actions section.
• Delete: Use this option to delete an action from the Selected Actions section.
• Select All:
• Edit Preferences...: Click this option to view the Preferences dialog box which contains two tabs: GUI and

Server. Configure the Distance Unit and Font Size Unit in the GUI tab. Configure the Server details in
Server tab.
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3. View menu:

Hide/Show Library: Use this option to hide or show the Library (Available Actions section). Hide Library
option is initially displayed in this menu which toggles to Show Library after user has hidden the Library.

4. Window menu:

Action List: name.aal: This menu displays names of all the Action Lists currently opened by a user.
5. Help menu:

About ArtPro Action List Editor: Click this option to view a window which displays information about the
ArtPro Action List Editor.

Creating an Action List

To create an Action List:

1. Click the New Action List... in the File menu.
2. The Action List: Untitled.aal* dialog box appears. Using this dialog box, add actions to the Action List and

define attributes for actions.
3. In the first column of the Available Actions section, select All to view all the available actions in the second

column. Or filter the actions to view only some particular set (selection-related actions, check-related actions...).
Also, use the search field to display certain actions (for example, type "OPI" in it to display all OPI-related
actions).

4. Double click or drag actions from the second column of the Available Actions section to the Selected Actions
section.

5. Choose an action in the Selected Actions section and click Delete in the Edit menu to remove it from the section.
6. Click an action in the Selected Actions section to view the associated parameters in the Options for "selected

action" section. These parameters can be edited.
7. Click Save Action List As in the File menu to save this action list in a desired location.

Action lists have to be stored in the \\server\bg_data_custom_v010\dat\ArtPro Action Lists
folder for the task panel to pick them up. By default, the ArtPro Action List Editor also saves them there, but
you can choose a different location in the Save Action List As... dialog box.

Handling Fonts in ArtPro Files

Important:  All fonts used in ArtPro files handled by Automation Engine should either be:

• embedded,
• referenced and located in a folder accessible to the Automation Engine server.

If your file has non-accessible fonts, you will get an error when trying to add or edit text, update text objects
using ArtLink, export the file to PS or PDF...

ArtPro Files coming from a Nexus on Mac System

Type of ArtPro file in Nexus workflows Consequence on fonts in Automation Engine

ArtPro files created, edited or opened in ArtPro. These ArtPro files have all fonts and outlines
embedded (subset).

They can be opened, repeated, output… in any
ArtPro action list in Automation Engine, without
any font problems.

Exception: ArtPro files containing ArtLinked text
containing a character that was not embedded



Automation Engine | The ArtPro Action List Editor | 577

Type of ArtPro file in Nexus workflows Consequence on fonts in Automation Engine

(not yet used in the ArtPro file and the font is not
available).

ArtPro files created by a Nexus workflow (files
that have not been opened and saved by ArtPro).

These files do not contain any font embedding.

Therefore, they cannot be used to generate PDF
export, unless: 

• You add a Text to Paths action before
outputting the file to PDF.

• You add all the necessary font folders (see
below) in your first action.

ArtPro files created by a Nexus workflow starting
with a PS/PDF import.

Referenced fonts are not available during this
workflow!

Any action that needs text outlines (Generate
Marks, Print to File, Export PDF…) will error.

To avoid this, you need to:

1. Insert a Save immediately followed by an
Open ArtPro file.

2. In the Open ArtPro file action, define the
necessary font folder.

Handling the Fonts Correctly in an ArtPro Action List

In general, opening an ArtPro file does not need the glyphs from the characters in the job, since ArtPro always stores
the vectorized representation of the complete text block in the file.

When using ArtPro Action Lists and importing PDF files with non-embedded fonts, the fonts need to be available on
the Automation Engine server. Do the following to make them available:

1. Create a fonts folder in a container of the Automation Engine server.
2. Move the fonts from Mac to (that folder on) Windows using a third party font conversion tool (for example

CrossFont).
3. Adapt the actions that need font resources (for example the Importing action) in your ArtPro action lists.

Note:  We recommend using TrueType fonts.

Available Actions

Adjust Stroke Width

This action allows to change the width of all (or all selected) strokes. For example: This can be used to give hairlines
a minimal width. First use the Selector to select all strokes smaller than the minimum width, then use the Adjust
Stroke Width action to change the width of the strokes.

Apply Pictures

This action applies an ArtPro file or picture to all objects in the file.

http://www.acutesystems.com


578 | Automation Engine | The ArtPro Action List Editor

This function may be useful to replace the graphics in an existing step and repeat template with another graphics file.
The box popup determines which box of the picture (only for ArtPro files and PDF files) is used to center the graphics
when applying the pictures to the objects in the file.

Remove Unused Separations removes all empty separations after the Apply Pictures.

The Place Single Separation ArtPro File in Single Separation option defines how to insert ArtPro files with only
one separation. If the option is switched off, objects in this AP file with 100% of the single separation are considered
to be registration color and thus get 100% of every ink in the ArtPro file after insertion. If this option is switched on,
the file is inserted in one single separation instead.

ArtLink

This action gives full access to ArtPro’s ArtLink module from within the ArtPro Action List Editor and allows
automatic generation of multiple versions of a template file based on database information. The different versions are
in different files or different layers, depending on the setting of the radio button at the bottom.

Since the template file needs to be made in the ArtPro application, please refer to the ArtPro manual for a full
description of the ArtLink module. For specific information on the use of Text parameters in ArtLink, please refer the
Technote on ArtLink Text Parameters.

The template file which is generated in ArtPro contains all “hot linked” objects which refer to parameters in the
database or automatic parameters based on job content. In what follows we describe how an action list needs to be set
up in order to automatically generate ArtLink versions with the ArtPro Action List Editor.

Using ArtLink in an Action List

Example:

A basic ArtPro action list could contain a Select File action and an ArtLink action.

The input folder contains an ArtPro template file "ice cream template.ap", a database file "ice cream.txt" and an
images folder which contains the various images which will be used for the versioning: strawberry, lemon, lime,
orange, peach and tomato.

The Select File action contains two entries whose name ends with ".txt", referring to the database file and whose
name ends with ".ap", referring to the ArtPro template file.

The Group Files option should be on, meaning these two files are grouped together for the ArtLink action, which
needs the database file and the ArtPro file. Note that the database file always needs to be the FIRST entry in the list.

Setting the ArtLink Action

The ArtLink action has a number of parameters set.

ArtPro Template
The ArtPro file selection does not need to be selected here since it is actually determined by the Select File
mechanism. This can be used if the ArtPro File with the links is a fixed file.

Additional Resources
Additional Resources will allow to locate the Color Book and the Ink Book that needs to be used, similar as one
would load these in ArtPro when colors or inks need to be defined from a library (example: PANTONE™ library).

File & Fonts Settings...
The File & Fonts Settings... button allows working with root folders, folder mapping and font folders for the ArtPro
template file, since this is actually an ArtPro file and may contain images (on the same or a different server) and fonts.
The fonts are obviously necessary if variable text needs to be applied depending on the database parameters. For a full
description of the File & Fonts Settings... we refer to the Open ArtPro File action.
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Save ArtPro
The Output File Naming Template button determines how the files, generated by the ArtLink action are named and
where they are saved.

As is clear from this resulting folder when the job has been executed, six jobs have been generated, each with a
variable extension:. Alnk_1 to .Alnk_6.

It is also possible to define if a Preview needs to be saved and at what resolution.

Save Records
It is possible to define if the results of the different records should be saved in multiple ArtPro files ("Files") or in one
single ArtPro file containing different Layers ("Layers"). In that case, the name of the different layers is defined using
the File Naming Template.

The Database File

The database needs to be a text file as shown in this example:

PANTONE;ice;barcode;pict

"300";"Blue Curacao Ice Cream";"54327719";":~images:strawberry"

"399";"Margharita Ice Cream";"54327627";":~images:lemon"

"370";"Caipirinha Ice Cream";"54327719";":~images:lime"

"orange";"Tequila Sunrise";"543277726";":~images:orange"

"1645";"Peche Mignon Ice Cream";"54327733";":~images:peach"

1797";"Bloody Mary Ice Cream";"54327740";":~images:tomato"

The first line describes what variables will be used, while the values for the variables are each described on one line
in the file.

• PANTONE™: the color entry in the color book to be used
• ice: a text string
• barcode: the value of a barcode to be used
• pict: an image to be used

Note:  The images are described as ~images:xxx where ~ describes the current position of the template file
and images is a subdirectory which is located relative to the current position of the template file. Images will
also be searched through the Files & Folders settings, so the full exact path is not always necessary.

The Results

After processing, six ArtPro files have been generated, a zoomed view of the first ArtPro file clearly shows the
variables which have been used: the color, the text string, the barcode and the image.

The File Naming Template in the ArtLink action allows the use of parameter values from the database records. The
value of the n-th field can be used as a template key for the Save ArtPro file template.

Borders

The Borders action allows to modify the job size information of the current file.

Different job sizes can be defined in one file: media box, crop box, bleed box, trim box and art box. Note that if
multiple boxes need to be modified, multiple Borders actions need to be set in the action list, as one Borders action
changes only one of the Borders.

Each box sizes can be set to a fixed size depending on the size dialog or to a fixed size depending on dimensions
which are put in the Vertical and Horizontal fields.

The square buttons in the lower part of the window determines in what direction the new box size is applied,
depending on the current content of the file.
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It is equally possible to calculate a difference to the current size of any page box (selected by the "start from Box"
option), using the DV field (difference vertical) and DH (difference horizontal) field. In this case the Vertical and
Horizontal fields needs to be set to 0, while the DV and DH values (positive or negative) are used to make the current
box size larger or smaller again with the direction depending on the selected square button in the lower part of the
window.

Suppose a file was imported from PostScript with the bleed contained in the job size, it could now have a Trim box
which is for example 3mm smaller in all directions when setting DV and DH both to -3 mm. After being handled by
the Borders action, it contains the page box information defined by these settings. Hence Step and Repeat applications
or imposition applications can now place the files based on the Trim box (for example).

Certified PDF

Certified PDF allows to integrate the Certified PDF Workflow functionality into Automation Engine. The aim is to
provide functionality to import Certified PDF, edit and then export as Certified PDF with information about edits and
changes to the document. Certified can be divided in three parts: Input, Output and Certified ArtPro sessions.

Certified ArtPro Sessions
Automation Engine can work in Certified Mode, by switching it on in the Certified PDF action.

User name, Short user name, etc. - provides the information about the user who is editing the PDF document. That
information is stored in Certified PDF each time when a new session is started.

If Certified Mode is enabled, the filed "User name" is mandatory. So, before switching on Certified Mode a User
Name should be specified. Otherwise, switching to Certified Mode is not allowed and a message box is displayed
stating that User Name must be defined before turning Certified PDF on.

Working Certified Mode in Automation Engine affects the way it works for all following open/save actions.
Whatever the Certified options states are, Automation Engine is now recording the history of changes made to the file
and saves them with the ArtPro files. From version 8.0, all ArtPro files have the possibility to be exported to Certified
PDF and all the history of changes are recorded. Those changes are recorded as sessions.

A session is a track of changes from beginning of the session to the end of the session.

A session starts when:

• A file that does not yet contain a session is created or opened. This can be: opening an ArtPro file from version
lower than 8.0, importing a PDF (Certified or not) or importing any other file format.

• An ArtPro 8.0 or higher is opened, changed and saved. The active session is closed and a new session is opened.
• Certified PDF file is exported and Certified mode is on. In that case, the old sessions are recorded to PDF file and

a new session is opened.

The session is not begun when:

• Certified PDF file is exported and Certified mode is off. The active session is continued.

Clip to Border

The Clip to Border action clips all the objects to the edge of the selected PageBox.

Objects which are completely out of the pagebox are removed, objects partially inside the selected pagebox are
clipped to the pagebox.

Choose All radio button to apply the Clip to Border action to all objects or choose Selections Only radio button
apply it to the selected objects only.

Close ArtPro File

This action removes the currently open ArtPro file from memory. Note that every ArtPro action list needs to be
terminated by a Close ArtPro File action.
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When building an ArtPro action list that does not contain a Close ArtPro File action, the system issues a warning
when closing the action list. Click the Cancel button and make the necessary adjustments.

Clicking the OK button merely closes the warning window, it is up to the operator to go back to the action list and
add the Close ArtPro File action at the appropriate location. Failing to do so results in wrong output. Since data
continues to remain in memory, Automation Engine continues to process the different pages and documents on top of
each other until it runs out of memory.

Create ArtPro File

This action generates a blank ArtPro file which can be used later for adding pictures, inserting other files, etc.

Create Layer

The Create Layer action creates a new layer in the ArtPro file currently open in memory. Further processing takes
place in the newly created layer.

A typical example is a double burn workflow, where multiple files are imported (CMYK of first version, K of
second version, K or third version, etc.…). To make later editing easier, set a Create Layer action before each of the
imports, hence layering the final output file. The name of the layer is determined by the template.

It is possible to move the selection to the newly created layer, by switching on the appropriate option. Using the
Position dropdown, create a layer on top or at the bottom of the file.

Delete

This action allows to delete objects, unused separations, unused layers and defined separations from the current file.

Objects

Delete objects Select Delete Objects checkbox, click All radio
button to delete all objects or click Selection
Only radio button to delete only selected objects.
Although not often used, deleting all objects could
be used to delete the contents from a file but retain
all pagebox settings for another document (or
picture) to be imported into or placed. For more
information on selections, see the Selector.

Separations

Separations mode Select Leave as is in the dropdown menu toleave
the separation “as is”. Select Remove in the
dropdown menu to define what separations to
delete (Remove) or select Only Include in the
dropdown menu to define what separations to
keep. The Delete Unused Separation option is not
influenced by this setting.

Die/ Transparent/ Varnish/ Opaque The checkboxes allow to set if separations should
be removed or included based on the separation
type.

Separations list If Separations mode is set to Remove, all
separations defined in the list are deleted from the
file. If Separations mode is set to Only Include,
only the separations defined in the list are kept and
all others are removed.
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A separation name can be added by clicking the
+ button and typing the name in the text field. By
selecting a separation from the list and clicking -, a
separation name can be removed from the list. The
separation names in the list can contain wildcards
(*).

Delete Unused Separations If this option is selected, unused separations
are removed, regardless of the Separation mode
setting.

Layers

Delete Layers If Delete Layers is selected, all layers defined in
the list are deleted from the file. A layer name can
be added by clicking the + button and typing in the
name in the text field. By selecting a layer name
from the list and clicking -, a layer name can be
removed from the list. The layer names in the list
can contain wildcards (*).

Delete Unused Layers If this option is selected, unused layers are
removed.

Difference

The Difference action is used to calculate the differences between two ArtPro files.

This function is useful to verify that the graphics of two different language versions fit, to find out what changes a
customer made to the new label, to verify that corrections on files have been executed, etc.

The difference calculation is based on a pixel comparison. Based on the resolution set in the Resolution field, the
system compares the pixels of the two files at the same location.

When a difference is found between two pixels, one pixel is put in the resulting difference file at the same location.
When no difference is found, no pixel (or a gray pixel in separated mode) is put in the resulting file. This means that
when two files are compared that are identical, the resulting difference file is either empty or completely gray.

The comparison and the type of resulting file is dependent on the setting of the radio buttons at the bottom of the
dialog box:

Separated Each separation of the two files are compared
on a separation basis. For each separation, a
grayscale TIFF is written to disk. In the resulting
grayscale images, a 50% gray pixel means there is
no difference for that specific pixel, if the first file
for the pixel is darker that in the other file, a darker
pixel is put in the difference files and vice versa.

CMYK CMYK pixel data of the two files are compared
in this case. If no difference is found, the
resulting difference pixel is white, when there is
a difference, the pixel (CMYK) of the second file
at that location is put in the difference file. The
resulting file in this case is a CMYK TIFF file.

Note that with this comparison method, ONLY
the CMYK information is taken into account,
differences in PANTONE™ separations are
disregarded.
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Binary This results in one single 1-bit TIFF file where
differences are shown as black pixels.

Align Horizontal / Vertical When the ArtPro files to be compared have
different job sizes, these popup menus allow to
define how the jobs have to be aligned before
comparison.

Delete Matching Files Removes the TIFF files of the separations in which
no difference between the two jobs has been found.
The Separated mode is the only setting that results
in multiple files, hence this setting is the only one
affected by this option.

Make Report Job Generates a new ArtPro document, with the
name of the compared files, date and time of
comparison, used resolution and all difference files
placed underneath each other, preceded by the
separation name.

Output Allows to specify the name and the location of the
difference file.

File & Font Settings Since the Difference action actually opens two
ArtPro files, in some cases it may be necessary to
specify Root Folders, Folder Mapping and Fonts
folders. Please refer to the Open ArtPro File
action for full details.

Export CIP3

The Export CIP3 action creates a CIP3 file of the active job.

CIP3 is a file format used to transfer data about a specific file through the production process. Besides a preview
which can be used to extract ink key settings, this CIP3 file contains information concerning separations, ink
coverage, job dimensions, etc.…

Two main settings are present: the oversampling of the preview as well as the resolution of the preview that is
included in the CIP3 file.

Export Illustrator

This action exports an Illustrator native file (up to Illustrator 7.0) from the current ArtPro document.

Include Traps
Determines if traps are included in the Illustrator file. Multistep gradations are not converted into Illustrator multistep
gradations but are exported as CT’s with the resolution as determined by this input field.

Compatibility
Determines whether an Illustrator 7.0, 5.0, or 3.0 file is exported. Depending on this setting, a number of restrictions
apply:

1. Export to Illustrator 3.0 was developed for line art only:

a. text is not supported, use the Text to Paths action before this export
b. images are not supported
c. gradations are not converted, only the first color of the vignette is exported
d. multistep gradations are not exported

2. Export to Illustrator 5.0 does not support TIFF images:
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a. placed TIFFS, mapped TIFFS and internal images are not supported
b. non linear multistep gradations are not supported

3. Export to Illustrator 7.0:

a. mapped pictures are exported as CMYK TIFF images

Select the Output Fully Transparent Object checkbox to obtain transparencies as output using Export Illustrator.

Downsample Images
To sample the images in the file 2 times, 4 times, 8 times or not at all.

Export Macroflex

The Cyrel Macroflex uses the same philosophy as the Mount-O-Matic, but is manufactured by DuPont and has some
differences.

The minimum distance between the two registration marks is 127 mm. The registration marks also contain characters
that refer to the used separations in the group. A refers to the first separation, B to the second,... .

The Macroflex is not using a cylinder to put the polymer on, but is a flat table model. First of all, an adhesive sheet
of laminate the size of the cylinder is put on the table. The camera can move horizontally and vertically to show the
exact position on the sheet for each piece of polymer. An operator glues the polymer onto the sheet. Once completed,
the sheets of all separations are put on the cylinders of the flexo printing press.

Export Mount-O-Matic

With Export Mount-O-Matic it is possible to export an ASCII text file that contains all information specifically for
the Mount-O-Matic machine.

Mount-O-Matic is a device allowing flexo printers to reduce the use of photopolymer in the plate making process.
This machine is useful when only small parts of the file contain information.

Shrink means the same as vertical distortion and serves as information for the Mount-O-Matic. As the Mount-O-
Matic file only contains coordinates and not the actual contents of the file, the same vertical distortion has to be used
when printing the job to film.

Export PDF

This action converts the ArtPro file in memory to a vector PDF file. By default this PDF file is written to the job
directory.

The Export PDF dialog box is based on different sets of settings or Flavours: “For Press”, “For inPDF”, “For
Viewing”, “Normalized PDF” and “JDF”. The settings for each of these flavours can be changed. “inPDF” is used to
create inPDF files.

Next to the flavour, an indication to the compliancy is given: this shows that, based on the settings, the file will be
PDF 1.3, 1.4, 1.5 or JDF compliant.

Placed Files (S&R)

When outputting a PDF of a file containing placed EPS, this EPS is placed in the PDF file as a PDF XObject. This
works on certain Rips. The Rip must accept PDF XObjects containing PostScript.

Placed DCS works only with Separated PS Output and not when outputting PDF.

Load Settings from XML

Select an XML file using a Select File action. The settings from that XML file can be loaded in the Export PDF
action, overwriting the settings. The XML file can be saved (for example) in ArtPro, using the Export PDF Flavor
option.
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Normalized PDF

With the Normalized PDF flavour, output PDF files that can be opened and edited in PackEdge, Automation Engine
etc.

1. Normalized PDF Options:

When using Normalized PDF as flavour, some specific functions are used and some general options are changed.

a. Generate Normalized PDF:

With this option in the General tab, the PDF file structure is If no screening is defined on all or some objects,
a default screening will be applied to these objects. The defaults are: PDF and XMP information is included in
the PDF file.

b. Force Default Screening

This option (in the Optimize tab) is used in combination with the Include Screening option. Since
Normalized PDF does not allow objects without any screening definition, this option applies a default
screening on objects that do not have any screening defined yet. This default screening is the default screening
angles (15, 45, 75...) and a default ruling of 120 lpi.

c. Images:

Images are included as Esko links and also embedded at low resolution. This means image downsampling is
set at 96 dpi, the Link option is set to “Esko” and the Embed Images option is on.

2. Normalized PDF Restrictions:

a. Screenings:

If no screening is defined on all or some objects, a default screening will be applied to these objects. The
defaults are:

• ruling: 120
• dotshape: simpledot (round)
• angles C: 15, M:75, Y:0,B:45 any other : 45

b. PANTONE inks not in Esko color books:

These inks are saved as unregistered inks. Inks found in Esko ink books get the correct ink book reference. Ink
type is kept (technical, opaque, varnish, normal).

c. Placed or repeated Files:

Placed or repeared files (ArtPro, Normalized PDF) are expanded in PackEdge.
d. No barcode information.
e. No font file information.
f. Text:

All text is saved and the font is subsetted and embedded. This results in real text in Esko Software. However,
2-byte fonts are always vectorized when exported to any PDF flavour in ArtPro.

g. Images:

Images keep their links if possible (most TIFF, JPEG and PSD files). This is also the case for mapped images.
Some image formats such as DCS images, PSD with multiple alpha channels, TIFFs with extra channels (often
generated by ArtPro PS/PDF import) are not supported or incompatible with the Esko Software. These images
are embedded or generate a .ct fle on Esko software - depending on the settings.

General Settings

Generate Normalized PDF Please refer Normalized PDF above.

Generate Separated PDF With this option on, the ArtPro document is
exported as a separated PDF in which each page
represents a separation of the ArtPro document.
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It can be combined with the Add Composite on
Page 1 option.

Add Composite on Page 1 This option is available when Generate Separated
PDF is on. If enabled, the first page of a separated
PDF will contain a composite proof of the ArtPro
document. All subsequent pages represent a
separation used in the ArtPro document.

Add Notes With this option on, all ArtPro notes are included
in the PDF file and appear in Acrobat or the
Reader as normal, editable PDF notes.

Add Non Printing Layers If switched on, layers set to non printing are
exported into the PDF file. With this option
off, these layers are not output, so the PDF file
contains only layers with the Print option on.

Include 1.5 Layers PDF 1.5 allows the use of layers. If the option is
switched on, the ArtPro layers are put in the PDF
file as 1.5 layers. The compliancy is set to PDF
1.5. This allows user to switch layers on/ off in
Acrobat.

Output Fully Transparent Objects Without this option, fully transparent objects are
ignored. With this option on, transparent objects
are output.

Page Layout The Page Layout section allows to set Orientation,
Mirror and Distortion.

The Orientation can be set to portrait, turn right,
turn left or upside down. It defines the direction in
which the file is put on film or on paper. Choosing
portrait outputs the file in the upright position,
turn right rotates the file 90° and turn left rotates
it -90°. By activating Mirror, the job is mirrored
before exporting, resulting in a wrong-reading
output. Distortion is defined as a percentage of
the jobs original dimensions. This distortion is
specifically important for flexo jobs. On mounting
a flexo plate on the press, it is stretched out in
one direction. By making the output slightly
smaller than needed, we compensate for this
distortion. The original dimensions of the ArtPro
file remain unchanged. Positive values make
the job bigger and negative values make the job
smaller. Example: Vert. distortion = -2.35% makes
the output 97.65%. In this way the output can
also be scales: example, entering -50% for both
Vertical and Horizontal Distortion outputs the job
at half of its original size.

Add Thumbnail With this option on, a thumbnail is created of
the file, a small preview, that can be shown in
thumbnails in Acrobat. With this option off, the
thumbnail in Acrobat is gray.

Add Standard Preview Preview can be defined by resolution (default 72
ppi) or by max size (in kb). This can be useful
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when creating a PDF of a large size S&R, of which
the preview at 72 ppi would be several Mb.

Add Separated Preview It is now possible to save a separated 72dpi
preview in the PDF file. This non-standard
preview can only be used by other Artwork
Systems software, such as ArtPro S&R...

Use Anti-Aliasing Allows to define if Anti-Aliasing needs to be
applied when calculating the preview.

Previews & Page Boxes Thumbnails are created using the Media box.
Separated previews are also created using the
Media box. The Standard Preview is based on
the Art box, in order to be compatible with other
applications. This implies that the Standard
Preview does not show any bleed. For JDF output,
these settings are used for all PDF files created.

Marks This option allows to add marks into the PDF file.
The Marks button and option work in exact the
same way as in the Generate Marks Action.

Optimize Settings

Use Picture Caching Picture Caching makes the output faster by
keeping all images that are put in the PDF file in
the RAM, until the complete file is written. This
keeps application from having to read an image
multiple times from the hard disk, if it is used
multiple times in the file. The condition is that
enough RAM is required on the machine. This is
very useful if images are stored on a remote file
server.

Output Gradients as Images If this option is switched on, all gradients are
converted to images instead of including them in
the PDF file as PDF Shadings.

Compress Page Description When this settings is switched on, the PDF file is
compressed. This option is switched on by default.

Include Screening If the option Include Screening is on, Extended
Screening and PostScript Screening information is
saved in the PDF file. screening is not included.

Generate JDF Output JDF Output is an optimization system for
outputting S&R of PDF files. When outputting a
Step & Repeat to JDF, multiple files are generated.
First of all, the one up file(s) are exported to
PDF file(s). If the One up already was PDF,
the file is just copied, unless the option Copy
File is off. Second, one or more PDF files are
generated containing all elements that are on the
Repetition: registration marks, test strips, extra
information, etc. Items that are grouped, are in the
same file. Third, a JDF file is created, containing
the positioning of all these PDF files.
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Copy PDF If the Copy PDF option is on, the original PDF
files in the S&R will be copied to the output folder
of the JDF Output. If the option is off, these single
PDF files will not be copied, and the JDF will
contain a link to their original location.

Target Size This option can be used to ensure that the size
of the PDF file does not exceed a certain size
(example: 5000 kb) This can be used for files that
need to be sent, example, by e-mail. In order to
keep the file size below the maximum size, images
may have to be downsampled and/ or compressed
more than set in the dialog box. Do not use this for
files that are sent to Press!

Split Long Paths Just like PS output, paths with many anchor points
can be split up as parts. The more parts that need
to be exported, the longer it takes. The default
settings is 500.000 points.

Text Settings

Vectorise text Before exporting, ArtPro converts all text to paths
to avoid font problems at a later stage. When this
option is switched off, the text is in the PDF file
as real text. If text is not set to be vectorised, it is
always embedded. Japanese 2-byte characters are
always vectorised.

Subset Embedded fonts... Subset Fonts define whether fonts should be
embedded as subset if only a part of the characters
are used. How much of the font characters should
be used before the font is embedded completely,
can be set in the When percentage of characters
used is less than field. If this value is set to 100%,
a subset is created for every font which is not used
completely.

Color Settings

Force Opaque Inks to knockout If the option Force Opaque Inks to Knockout
is on, overprints is first flattened, so a visually
correct result is generated, but the resulting PDF
is NOT OK for printing! In order to warn that the
result is correct visually, but not for print, a red
exclamation mark is shown when switched on.

Fail on Nonseparable Blend modes If the file to be exported contains Nonseparable
Blend modes (Hue, Saturation, Color,
Luminosity), the file fails if this option is switched
on. These Nonseparable Blend modes operate on
a 3 component color space. This means that to
calculate the resulting color, CMYK needs to be
converted to 3 components, the Blend needs to be
calculated, and the result needs to be converted to
CMYK again. However, no instructions are given
on how these conversion from one color space to
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another should happen. This results in different
behaviors and different color results in different
applications/ RIPs.

Exclude Separations This option can be used to exclude separations
from the output. By clicking the Options button,
the Output Separations dialog is opened. By
Adding a separation (click the + button and
define its name. Wildcards can be used), you can
exclude this separation for output. By selecting
an entry in the list and clicking the - button, you
can remove it from the list. The Search Unused
Separation setting at the top, excludes separations
that are not used. It only turns separations off,
separations excluded earlier can not be removed
from the Exclude list, even if they are in use.
The Search Unused Separation option does not
take registration color into account. The Exclude
separations can not be used in combination with
the Include separations option.

Include Separations This option can be used to include only the
selected separations from the output. By clicking
the Options button, the Include Separations
dialog box is opened. By Adding a separation
(click the + button and define its name. Wildcards
can be used), you can include this separation
for output. By selecting an entry in the list and
clicking the - button, you can remove it from the
list. The Include separations can not be used in
combination with the Exclude separations option.

Color Management Color management is a technique used on color
in documents to ensure that consistent color is
reproduced throughout the print production cycle.
Managing color means making sure color is
reproduced in the same way for each device the
system is outputting to.

If a profile has been defined at the time of
importing or opening a file in the action list, it
is possible to override the settings for output
(example: color profiles for proofers or separated
output) in this menu.

DotGain This allows to apply a dotgain file on the output.
For a full explanation on Dotgain, we refer to
the ArtPro manual, in the Screening section. The
applied dot gain curve is applied to the PDF as a
transfer function in the Graphic state. The dot gain
curve for placed files works without problems with
placed ArtPro files and PDF files coming from
ArtPro or the ArtPro Action List Editor. Placed
PDF files from other applications work fine, as
long as they do not define their own dot gain
curve inside the PDF, as the embedded curve has
priority. If a placed PDF file coming from ArtPro
or the ArtPro Action List Editor already contains
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a dot gain curve, a warning is generated on PDF
Output.

Always Generate CMYK Separations This option includes all CMYK separations to
deviceN color spaces as soon as one of the CMYK
separations is used. This option is only useful for
customers that use a GMG color manager on their
PDF files.

Flattener The Flattener is used to translate transparencies
and blends. This is necessary when outputting PDF
1.3 compliant.

The Flattener section, contains all settings to
flatten Blend modes and overprints. It can also be
run as a separate action: Flatten Transparencies.
The Flattener replace all blend modes by “normal”
objects, maintaining the final result, that is, the
blend is calculated to whatever is underneath at
that time, and is adapted in a lineart object (if
possible) or an image.

Image Settings

Use Image Downsampling At All images with a resolution higher that this value,
is resampled. This allows you to create smaller
PDF files, example: for a quick soft proof.

For Images Having at Least If this option is on, only images with a resolution
higher than the entered resolution, is downsampled
to the down-sample resolution. In the example
above, when switching on the option, images with
a resolution below 450 ppi remain unmodified,
while images with a resolution above 450 ppi are
downsampled to 300 ppi.

Use Averaging When Downsampling This option is the same as in the more print
settings. When it is activated, image quality is
better, but the output is slower. The difference
with PostScript output is that CCITT images are
averaged too when outputting to PDF.

Image Compression No Compression, Lossless compression (Flate),
Maximum Quality, High Quality, Medium
Quality or High Compression. None means that
all compression is taken off. Compressed images
are decompressed in the PDF file. A lossless
compression means that the file will still be
complete after decompression. There is no loss
of quality. In the three other cases, the files are
compressed with a JPEG compression. A higher
compression means smaller files, but worse quality
and vice versa.

Include RGB preview of images This adds a lowres 72ppi preview of the large
images inside the PDF. These previews are used
by some Acrobat plug-ins, to speed up previewing
files.
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Image Clipping The Image Clipping option allows to force clip
images to the smallest size inside the clipping path.
Allows calculation to include the full picture if
clipping does not give any benefit, that is, if the
sum of the image parts is close to or bigger than
the size of the full image. A full image is only
included once in the PDF file, even if it is placed
multiple times.

Links This option allows to include OPI comments into
the PDF file. Choose between None (no links),
OPI links or Esko links. The option Embed Images
allows to define if images with OPI comments
should be embedded as well. OPI comments can
not be used in, for example, Illustrator, unless the
InPDF plug-in is used. For more information, see
the InPDF documentation.

File & Fonts settings This option allows to open the Root Folder, Folder
Mapping, Fonts Folder and Color Management
settings. These are the same as when opening an
ArtPro file.

Certified PDF

If the “Output profile” file is selected then PDF file is preflighted after being exported. The Output profile can be
cleared by shift-clicking the Browse button. If Certified PDF Enabled is unchecked, then regular non-certified PDF
file is saved and no new session is started. The Incremental save option works only if the last Certified PDF (that is,
the imported Certified PDF or the last Exported PDF) is still available. The option means that the previous Certified
PDF file’s contents are merged with the exported PDF, so that “rollback” the PDF document to the previous session
is possible. Using this option can result in a large PDF file. To keep both the PDF as the ArtPro file in a certified
(“green”) state, it is necessary to save the ArtPro file after the Certified PDF Export.

Export Picture List

The Export Picture List action creates a Picture List file from the Step and Repeat file. An option allows to define
whether mapped pictures should be included or not. The File Name Template allows to define name and location. A
Picture List can be used in the Import Picture List action.

Fit Borders

The Fit Borders action adjusts the job size and the selected page boxes (All or a selection from the Border popup
menu) to all the elements which are on the current document. Note that when All is selected, this means that the
media box, crop box, bleed box, trim box and artbox are all set to the same size. Users can define if they want to fit
the borders only vertically, horizontally or both. They can define whether it should be applied to selections only or on
all.

Fit to Border

The Fit to Border action fits all the objects to the edge of the selected PageBox. If the option Scale Proportionally
is on, all objects are scaled proportionally, until the bounding box of the selected object reaches the selected border,
either in Vertical or in Horizontal direction. If the Scale Proportionally option is off, the selection is scaled to fit the
borders both vertically and horizontally. This can sometimes be used when creating sleaves.

The Scale factor can be rounded off using the Scale round to value. If set to, for example, 5, the scale is rounded
down to the closest multiple of 5. If set to 0, no rounding is applied. The upscaling can be limited using the Limit
scale to field. The Fit To Border action can be applied to all objects or only to the Selection. Apply on Notes
transforms notes along with the rest of the file, so that the positioning of the notes inside the file remains the same.
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Fit to Paper

The Fit To Paper action selects the most appropriate paper size from a list of paper sizes. This allows to select the
most appropriate page size (for proofers) or plate size (for image setters) for a job, based on the available proofers
and/ or plate sizes. These paper sizes can be entered in the Action settings, using the + button. The Media Box defines
what box is to be used to determine the optimal paper size. It can be set to Center on Page, Upper Left on Page or
Fit To Page. Only this last option actually scales the job to fit on the optimal paper size. If the Rotate to fit option is
on, it is allowed to rotate the job when searching for the optimal paper size.

Flatten Transparencies

The Flattener section, as found in the Export PDF and Print dialog boxes, contains all settings to flatten blend modes
and overprints. It can also be run as a separate action: Flatten Transparencies. The Flattener replaces all blend
modes by "normal" objects, maintaining the final result, that is, the blend is calculated to whatever is underneath at
that time and is adapted in a lineart object (if possible) or an image.

Please note that placed PDF or placed ArtPro files can not be flattened! In those cases a warning is generated:
Flattener was unable to process placed art... This happens only if in the job, some objects with
transparency have to be flattened with a placed image.

Resolution The Resolution allows to set at which resolution an
image should be made, when necessary.

Noise for Gradients If it is necessary to translate a gradation into a ct,
the Noise For Gradients field sets the amount of
noise that has to be applied.

No noise from/ to This allows to define a range in which no noise
should be applied to gradations. This is useful, for
example, in autoblend screening.

Vectorise Opacity Channel This is an optimization tool for the flattener. It
reduces the path containing an ArtColor internal
image, removing all areas being completely
transparent (by vectorizing the opacity channel)
before flattening. This way, objects underneath a
part of an image where it is 100% transparent, no
longer need to be flattened.

Flatten Overprints If the Flatten Overprints is on, objects containing
blend modes as well as, objects containing
overprint (that is, “trans” in the Paint Style) are
flattened. This can be used to get a correct preview
in older Acrobat versions and Mac OS X Preview.

Ignore Overprints on Placed Art This option allows to ignore Overprints on top of
placed Art. If this option is not on, Overprints on
top of placed Art (example: a S&R) results in a
failed job.

Full Step and Repeat

The Full Step and Repeat action is based on ArtPro Interactive Step And Repeat. This functionality allows you to
create a repetition of one single file at a time, based on either count or fill size.

General

Count/ Fill size There are two ways to make a step and repeat in
Full Step and Repeat: count, where the horizontal
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and vertical number of labels is defined, or fill
size, where the size of the paper is defined and as
many labels as possible is put in this area.

When using the fill size, the number of labels is
calculated and equally divided in the remaining
space around the S&R. When count is used, the
fill size is calculated. When a group of labels
is selected in ArtPro afterwards, all the used
parameters are displayed.

Step The Step is the space used for every file. Unlike
the Size shown above, the step size takes rotation
and bleed (margin) into account.

Margin Margin is used to define the bleed between the
labels. It is the difference between the Step and
the box size. The horizontal and vertical margin
can be set separately. If the bleed of the single file
exceeds the bleed applied on the repeat, the jobs
are cut off in the middle.

Gap/ After The Gap is the distance in between labels. After
defines after how many labels the gap should be
entered. A value of 2, for example, results in two
labels without gap, then the gap and then again two
labels without, etc.

Distort The Distort value allows to define a distortion for
every repeat block separately.

Bleed The Bleed defines how much bleed is used to the
outside of the repetition. So there is a different
setting for bleed in between jobs and around
the repetition. It is ignored if the Keep Bleeds
checkbox is selected. It is always check if there
is enough bleed in the selected file. The trim box
size is subtracted from the bleed box and divided
by two. This size has to be bigger than the bleed,
otherwise an error message is displayed.

Keep Bleeds When the Step distance is smaller than the
bounding box of the ArtPro file, the different
labels do not overlap, but they are cut off. Keep
Bleeds forces bleeds in the original file to be used,
even if there is no place to put them. This function
can be useful to generate repeats of round labels.

Angle Using the Angles popup,define rotation for the
labels. The options next to the angle, allow to set
labels to switch direction every other label, either
vertical or horizontally.

Cut Marks If the Cut Marks option is on, cut marks is
automatically generated around the repeat block.
The cut marks are generated on the used box size.
When bleed is applied in between labels, double
cut marks automatically appear. The cut marks are
filled with registration color.
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Pattern
This option is used to make nested S&R. This means that the second row or column is shifted each time and the step
distance can be decreased so the labels fit into one another.

Pattern Using the Pattern buttons, define whether every
second column or every second row should be
shifted. The first button creates a rectangular
pattern, with no staggering. The second two create
most basic staggering: every second row or column
is shifted, and contains one label less than the first
row or column. The next two buttons generate
rows and columns with the same number of labels.
The buttons for round labels shift round labels into
each other to save space.

Stagger offset The offset can either be half of the step size or any
user defined value. When using the Round Label
pattern, the offset is automatically derived from the
size of the job and can no be changed.

Continuous Stagger Without the Continuous Stagger option, all
even rows or columns are shifted, the odd rows
or columns remain unchanged. When using the
Continuous Stagger option, every row or column
is shifted in regard to the previous.

Include Partial Labels/ Do not clip partial labels When using the Include Partial Labels option, the
gaps created by the shift of a row or a column is
filled up with the part of the label as if the repeat
was continued outside the job size. When setting
the Do Not Clip Partial Labels option on, these
labels are placed completely instead of just a part.

Advanced

Page Box Before stepping the selected file, it is possible
to decide which box size needs to be used. By
default, this value is set to Trim Box. When Page
Box is modified, the values in step distance and
size are automatically adapted.

Place Single-Separation ArtPro File in Single
Separation

This option defines how to handle repeating
ArtPro files with only one separation. If the option
is switched off, objects in this AP file with 100%
of the single separation are considered to be
registration color, and thus get 100% of every ink
in the ArtPro file after repetition. If this option
is switched on, the file is placed in one single
separation.

File & Font Settings Provides access to the root folders, folder mapping
and fonts folders when the file to be stepped is
an ArtPro file. For a description of this function,
please refer to the Open ArtPro File action.

Color Management Settings This setting determines if color management has
to be applied for the Step and Repeat job. When
enabling color management, it is possible to select
a color management settings file, previously saved
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by ArtPro. This file contains all ICC profiles and
settings to determine how color has to be treated
throughout the rest of the workflow (example:
proofing of the Step and Repeat document),
including ICC profiles for proofing, printing, etc.

Generate Marks

This action physically adds marks to the file, based on the dimensions of the box set in the action dialog box.

Marks
The Marks settings define what marks will be used:

User Text This allows to add user defined text. The text can
be defined using the File Naming Template, so
that file names, user names, user keywords etc. can
be included in the marks text.

Job Name Puts the name of the ArtPro file in the lower left
corner in all separations.

Version Number This is the number that is shown in the Job Size
dialog box. Every time an ArtPro job is modified
after saving, the version number is increased.

Date & Time Puts the current date and time in the lower left
corner in all ink separations.

Separation Names Puts the names of the separations on the separate
films.

Distortion Puts the distortion from the Print dialog box in the
file. The value is preceded by V or H, depending
on the direction of the distortion.

Dot Gain Filename If a dotgain file is selected in the print dialog box
and the dotgain compensation option is tagged, the
dotgain file name can be added to the comments.

Color Setting Name If a set of Color Management settings are loaded,
the name of this set can be added too.

Crop Marks The crop marks are put on the bounding box.

Registration Marks Appears in the four corners outside the job or
centered on the job when the option centered is
on. The width of the registration marks is 1/300
inch (about 0.08 mm) and the color is always
registration.

Marks File This option actually allows to select a physical
marks file from disk, clicking on the button with
the three dots opens the browser for selecting the
file. For a description on marks files please refer to
the ArtPro reference manual.

Options
The Options define how the marks will be handled.

Vectorize Text Converts all the text to paths, to avoid font
problems on the RIP.
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Set Inside Border Sets the text on the inside of the borders instead of
outside the job borders.

Use Text Settings Define the font to be used for the marks using
this settings. This can be interesting for japanese
users. If a default japanese font (example: Osaka)
is defined, all marks text will also contain japanese
characters.

Box The Box dropdown allows to define to what
borders the marks should be applied.

Adjust Crop Box/ Adjust Media Box This modifies the crop box after creation of
the marks, so that the job and the marks are
completely inside the crop box. In that case, it
may be necessary to change the media box as well,
to avoid a crop box bigger than the media box.
Therefore the option Adjust Media Box can be
used.

Files & Fonts This button allows to define root folders, folder
mapping and fonts folders, similar as in the Open
ArtPro File action (please refer to this action for a
full description). This functionality has been made
available in case ArtPro files have been placed in
an open job during the action list, to allow for the
retrieval of the linked images or used fonts at the
time of printing.

Unit Allows to define what unit should be used in the
Marks. This unit can also be used for the ArtLink
parameters added by the Marks action.

For PS/ For PDF As the Dotgain curve and Distortion can be placed
as Marks and these two settings can be made in the
Print menu and in the Export PDF dialog, a pop-
up has been added next to the Generate Marks
button. The pop-up allows to set what Dotgain
and Distortion should be shown in the marks: the
settings for PS (from the Print dialog) or those
from the Export PDF dialog. The pop-up only
has affect when the Generate Marks action is
used. If Marks are added, for example in the Print
action, the appropriate settings (in this example,
the settings as defined in the Print dialog box) is
shown in the marks.

Generate Strokes

The Generate Strokes action creates strokes around all objects or around all selected objects (see Select Objects for
more information).

Width/ Inside/ Outside The Width defines the line width for the Stroke.
Filling in the width results in a symmetrical
Stroke. Otherwise Outside/ Inside distances can be
defined separately.

Corners/ Caps The Corners and Caps settings allow to define the
shape of the strokes in the (outside) corners and at
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the end points. For elaborate information, we refer
to the ArtPro manual.

Separation Name/ Ink book Strokes generated by this action gets 100% of the
separation entered here and overprint for all other
separations. If the separation does not exist yet, it
is created. In that case, the specifications for the
ink is searched in the defined Ink book.

Apply on All/ Selections Allows to define whether strokes should be applied
on all objects or only on the selected objects.

Add Stroke to Crop Box/ Trim Box/ Bleed Box Allows to add a stroke on the selected page box.

Dashed The Dashed option allows to generate dashed
strokes. The Dash distances and Gap distances
define the length of the individual dashes and gaps.

Gravure Job Ticket

Gravure job ticket offers export for Gravure systems from Hell Gravure. The resolution and oversampling rate
defined in the action is used if it can not be retrieved from the job ticket. Each job ticket and thus every separation
can have a different value. The PackBits compression is only applicable for separations with a resolution above 600
dpi and without oversampling. In any other case, the TIFF is compressed using LZW or (if the “Compress” option is
off) without compression. PackBits compression results in lower compression rate, but will be calculated much faster
than LZW compression, so it is the best solution for high resolution files. The Gravure job ticket also checks if the
separation count in the ArtPro file matches with the ticket count in the folder. For more specific information, contact
Hell Gravure.

Gravure Tiff

Gravure Tiff is used to output ArtPro files directly as TIFF data for gravure printing. It creates one TIFF file per
separation.

The parameters

1. Output

Choose TIFF in the Output menu.
2. Oversampling

Oversampling means that ArtPro makes the calculation of the TIFF on a resolution which is too high, that is,
higher than the one needed. Afterwards it is ‘averaged’, this means that it is converted to low resolution by
calculating the average of each group of lines. This gives a kind of “blurred” effect. Oversampling requires a long
calculation time and therefore needs optimization.

The oversampling filter can be chosen from none to 8 times:

• none: a lot of jaggies
• 4 times: default value, this is the oversampling value used the most in the packaging and label market
• 6 times: very high, example: for stamps

Example:

If you have an oblique black line on 360 lpi (= 140 l/cm), the edges are very much pixelized. Oversampling
means that you calculate with a higher resolution than the one you need. Oversampling 4, means that the image is
calculated at 4x the resolution (360 lpi) = 1440 lpi. Every line is divided by 4. So there are 16 pixels read (4x4) for
one output pixel. The output pixel gets the grayvalue of the 16.

3. Resolution
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The resolution of the TIFF file can be defined in l/cm or l/inch. A normal engraving resolution is 140 l/cm or ±360
l/inch.

4. Noise for gradation

The default : 3 %

1 byte = 256 gray values

Gradations normally do not have more than 250 bands (steps of 0.4 %). ArtPro creates 400 bands instead of 250.
The added noise makes the steps invisible. The desired amount of noise can be entered in this field.

5. IBM PC Byte order

By default this option is selected, because most engraving machines are IBM-oriented. The system IBM uses
‘Little-endian’ while Macintosh uses ‘Bigendian’.

6. 1 Bit

This option allows you to choose between 1 bit data (checked) and 8 bit 256 graylevel data (default, unchecked).
Most systems take 8 bit data.

7. Save Fast Forward Data

This option creates an extra text-file (.SVS) with a description of which parts of the TIFF-output file are blank and
hence can be skipped. Some engraving machines have the possibility to take this information into account.

Grid Step and Repeat

Similar to the other step and repeat action, this action gives access to ArtPro’s grid step and repeat module from
within the ArtPro Action List Editor.

The grid step and repeat allows to create a repetition of different ArtPro (or other supported) files with the same size
that are all placed in the same folder. The one-up files can be defined using a Select File action before the Grid Step
and Repeat action.

This repetition can be executed with or without a layout file which is actually a simple spreadsheet containing the
positioning of the different files.

For more information we refer to the Grid Step and Repeat section of the ArtPro manual.

Gridwarp

The Gridwarp action allows to calculate complex warping of documents based on a source grid and a destination
grid.

This action can handle the warping of all element types like gradations, images, etc.…. and is typically used for the
warping of conic cups, metal containers, etc.…

Grid Warp can be done using two files, an ArtPro and a Grid file. In that case, the operation of the Gridwarp action
is similar to the operation of the ArtLink action where two files are selected by the Select File mechanism. Using
the Select Grid button, a fixed Grid File can be used. If no Grid File is presented, the Grid defined in the ArtPro file
itself (if provided) will be used. This allows to set up grid warp in ArtPro, and let Automation Engine do the actual
calculation.

Import Picture List

With Import Picture List it is possible to import an ASCII text file containing information on name, position and
size of the bounding box of placed pictures.

These Picture List files can be created in ArtPro, using the Export Picture List function (see the ArtPro Manual) or
from any other application, if the ASCII text file has a construction as shown in the example below. If not defined in
the file, the placing is done on the box defined next to Use Box, centering the image on the bounding box. The other
options are the same as for opening an ArtPro file.

ArtPro Picture File V1.0
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units mm

size 1005.72826.63

Bambolina1 -1.99 -1.99 142.4 126.99 0 16 32 TrimBox

Bambolina1 -1.99 125 142.4 125 0 16 32 TrimBox Bambolina1 -1.99 250 142.4 125
0 16 32 TrimBox

Bambolina1 -1.99 375 142.4 125 0 100 60 TrimBox

Bambolina1 -1.99 500 142.4 125 0 16 32 TrimBox

Bambolina1 -1.99 625 142.4 126.99 0 16 32 TrimBox

Bambolina1 140.41 -1.99 140.41 126.99 0 16 32 TrimBox

Bambolina1 140.41 125 140.41 125 0 16 32 TrimBox

Bambolina1 140.41 250 140.41 125 0 100 60 TrimBox

Bambolina1 140.41 375 140.41 125 0 16 32 TrimBox

Bambolina1 140.41 500 140.41 125 0 16 32 TrimBox

Bambolina1 140.41 625 140.41 126.99 0 16 32 TrimBox

Bambolina1 280.83 -1.99 142.4 126.99 0 16 32 TrimBox

Bambolina1 280.83 125 142.4 125 0 100 60 TrimBox

Bambolina1 280.83 250 142.4 125 0 16 32 TrimBox

Bambolina1 280.83 375 142.4 125 0 16 32 TrimBox

Flatten 421.23 0 292.24 413.32 0 16 32 TrimBox

Flatten 421.23 413.32 292.24 413.32 0 16 32 TrimBox

Flatten 713.47 0 292.24 413.32 0 16 32 TrimBox

Construction of a Picture List File

1. ArtPro Picture File V1.0
2. Units
3. Size; the job size, in the unit set above.
4. Filename; when importing a picture list, Nexus will place the pictures described in the Picture List file, if the

files are in the same folder as the picture list. If not, ArtPro will prompt for the specific file. If the file is found in
the folder or a file has been selected by the user, the picture will be applied on the path, placing its center on the
center of the bounding box.

5. Position of the bounding box; the position of the top left corner of the bounding box is defined. The first value is
the vertical distance from the top left corner of the job size, the second is the horizontal distance.

6. Size of the bounding box; the next two values define the vertical and horizontal size of the bounding box.
7. Rotation; the rotation can be 0, 90, 180 or -90 degrees.
8. Picture center offset, defining where to center the image, based on the topleft corner of the bounding box.
9. Page box to be used.

Importing

This action is probably the most important action and allows to Import PostScript 3 and PDF files in to the native
ArtPro file format (with full preflight and correction capabilities).

When a file is imported, typically all elements are made editable and all paths in the PostScript or PDF document are
converted to internal ArtPro paths.



600 | Automation Engine | The ArtPro Action List Editor

This allows for imported documents to be edited with the Edit or ArtPro application. However, text in the PS or PDF
documents, in some cases will be converted to outlines (depending on the settings in the Font Settings dialog box and
depending on Creator of the PS or PDF file). This means that although text can be added in Edit or ArtPro, text from
the original document cannot always be modified using the text editing functionality.

Importing Screening

1. Detecting Esko screening

When importing a PS/ PDF file containing Esko screenings, these screenings are recognized and automatically
converted to a PostScript screening with the correct Esko dot shape.

2. Different rulings / dot shape per separation

In ArtPro files, it is not possible to have screenings with different rulings or dot shapes per separation. However,
in Esko software these screenings can be defined. When importing such a file, these screenings are split up into
different ArtPro screenings. The objects using this screening are split up accordingly and put on top of each other
in overprint.

Importing Normalized PDF
Normalized PDF files can be imported just like any other PDF. Keep in mind that in Normalized PDF, image links
are included as EskoLinks.

1. Normalized PDF Restrictions
2. No support for Esko .ct file links

If you want to import normalized PDF back in Artpro, make sure the .ct files are embedded before generating the
PDF file in the Esko Software.

Page Settings
When opening the Import PostScript/PDF dialog box, the Page button is selected.

1. Import Page

If a multiple page PS or PDF document has to be imported, this setting defines what pages should be imported.
If Import Page is inactive, all pages of the PS or PDF file will be imported. This function would typically be
inactive, while the page range to be imported would be determined by the Select Page action. This would actually
invoke the importing action multiple times (creating a document for every page).

If the Select Page action was not used for multipage documents, all pages would be imported in one document.
The positioning of the individual pages depend on the setting of the Multiple Page offset option (see below).

If Import Page is active, only one page out of the multipage document will be imported. The page that has to be
imported can be entered in the Import Page field. The Import Page field can take a string input (a page label) as
well as a numeric input (a page number).

For PS files, the PS import has to jump to the right page of the file before starting import. (Selected Only).
However, some application define crucial information at the beginning of the PS file, on page 1 (example: Quark
defines all fonts on page 1). Therefore, we have to interpret page 1 as well (without generating output) before
importing the selected page (First and Selected). In some poorly constructed PS files, it is possible that the
information needed for the selected page is scattered over the pages in front of it. In that case, the option Until
Selected should be used.

2. Ruler at top left

By default a PostScript or PDF file will be imported placing the PostScript origin (= 0,0) on the center of the
ruler. If you switch the option Ruler at top left on, the top left of the page will be placed in the center of the ruler,
placing the file in the lower right section. The origin in the PS file is in most cases the bottom-left corner of the
page, although this is not a general rule. Example: In EPS files from Adobe Illustrator, the PS origin is the same as
the origin of the ruler in the Illustrator file.

3. Multiple Page Offset
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When importing a multipage PostScript or PDF file without a Select Page action in front, ArtPro puts all pages
with the 0,0 point in the center of the ruler. This results in multipage documents being placed on top of each other.
If you use the Multiple Page Offset, all pages are put next to each other.

4. Import Separated File as Multipage

This option should be switched off in an action list. It relates to importing a separated file, e.g. files using the
%PLATECOLOR command to identify the separation name or older separated PostScript files.

With the Import Separation File as Multipage on, all the elements of a separated file will come in as grayscale, and
the different separations will be treated as individual pages, so they will be placed on top of each other, unless the
Multiple Page Offset is on.

When importing a separated file with the Import Separated File as Multipage option off, the Separated PostScript
file converted to one (composite) ArtPro file with all the separations.

The individual paths coming from the different separations, will be merged together into a path with the combined
color information, based on the Merge Equal Paths option (see later). Images will be recombined into one mapped
picture.

Font Settings

1. Use Replacement Font instead of included Fonts

If this option is disabled the system uses the fonts in the file (if embedded). If they are not embedded the system
uses the fonts in the Fonts Folder. If this option is enabled the system uses the fonts in the Fonts Folder first and
uses the embedded fonts when the fonts are not available in the Fonts folder.

2. Fail if Missing Font

When this option is enabled and fonts are not available in the Fonts Folders or embedded in the PS or PDF file, an
error appears on the Importing action when executing the action list, regardless of the Preflight Settings (Cruise
Controls). Use this option when no Cruise Controls are in use.

3. Fail if Courier

Similar to Fail if Missing Font, an error appears if there is a Courier font being used in the document, regardless
if it is a missing font or no missing font.

4. Convert to real text

When this option is enabled, the system attempts to convert the text in the document to real editable text which
can be modified in Edit or ArtPro. To do so, the font must be present on the Edit or ArtPro system. Note that
this option works only for files coming from certain applications. Also note that only roman characters can be
converted to real text. All other characters (special, accented...) can not be kept, and will be vectorized.

5. Font Folders...

It is possible to select multiple Font folders, in which system looks for fonts that are not installed nor embedded in
the PS file.

This allows importing a file with the fonts in a separate folder, without activating the fonts. Keep in mind that
these fonts are treated the same way as fonts embedded in the PS file, so all text are converted to outlines. The
font folder can be used for Type 1 fonts and Truetype.

To add font folders, go to the Font Folder..., click the + button. A dialog box appears to select a folder. Click on
the correct folder and click Choose. The font folder is added immediately and system searches the folder and all
subfolders for printer fonts.

A font folder is shown with its complete path. To stop using a font folder, simply select it from the list and click
the - button. The Reset button deletes all the font folders from the list.

The PS default fonts toggle makes system use a set of default fonts, like Helvetica, Courier, Times, Symbol...
They are stored in a folder called PS Fonts. On Windows, this folder should be on your hard disk alongside the
application file. On Mac OS, this folder should be inside the bundle of the ArtPro Action List Editor.

This set cannot be modified. The system tries to use the embedded fonts first and then the font folders.
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You can open a File Naming Template dialog box allowing to define the name for the font folder based on the
job name, user name...

Color Settings
The Color Settings contain all separation related settings and determine how the custom colors or CMYK separations
are handled in the file. All functionality is available to either keep separations as they are defined in the PostScript
or PDF file, to convert them to CMYK or to merge them with another separation. This can be done either in an
automated way (example: Convert All Custom Colors to CMYK) or for specific separations only which are known to
be in the files that are processed.

This is discussed in the Custom Colors section. The list of the custom colors can be seen by clicking the Custom
Colors... button.

1. Single Separation

This option allows to import a single separation from a PS file or a PDF file. The name of the separation is to be
filled in the text field, example: “Black” or the name of any of the other separations in the file to be processed.
A typical example of the use of this functionality is double burn or versioning, example: language changes,
packaging versions, etc.…

To summarize an action list like this would handle folders containing two or more files, preferably with a naming
convention which identifies each version. For example, the English version of a document could have the
extension “_eng”, the Spanish version of a document could have the extension “_esp”.

To simulate a plate change of black only on the press and allow for the merging of the black plate of the Spanish
version with the color plates of the English version following actions would be defined:

a. Select file: English version.
b. Importing: CMYK of English version.
c. Save ArtPro file: English version.
d. Export PDF: English version.
e. Select file: Spanish version.
f. Importing: Black Plate only of Spanish version, the Remove Separation option will ensure all Black from the

English version is made transparent.
g. Save ArtPro File: English CMY with Spanish K.
h. Export PDF: English CMY with Spanish K. (e.g. for proofing)
i. Close File: remove the file from memory.

This allows to actually proof the merged files exactly the way they would be put on press. Since this merging
takes place at the single file level, it is possible to identify potential problems (example: moved graphics or
images, text running through images, etc.…) early in the process and physically correct them in ArtPro, even if the
original documents are not available.

Double burn action lists are supported for single page as well as multipage documents, while more than two
versions are equally supported.

2. Remove Separation

When Single Separation is active, Remove Separation makes the original separation transparent while the new
separation from the file is being imported.

3. Force Black Overprint

When Force Black Overprint is checked, 100% black in the PS or PDF file is converted to all transparent
+ 100% black in the ArtPro file. If Force Black Overprint is not checked (default), all 100% Black in the
PostScript or PDF file is treated as any other color, meaning that the result depends on the Ignore all Overprints
flag.

4. Ignore All Overprints

When Ignore All Overprint is not checked (default), overprint in the PostScript or PDF file is converted to
transparent in the ArtPro file. If Ignore All Overprint is checked, overprint in the PostScript or PDF file is
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translated to 0% in the ArtPro file. This option can be used to take out the trapping. Note that this option is not
removing the transparent strokes, but only taking off overprints. If both Force Black Overprint and Ignore All
Overprints are switched off, the file is not changed and can still be modified later.

5. Keep Screenings

This option keeps the screening definitions, if they were available, in the PostScript file or PDF file.
6. Fail on Nonseparable Blendmodes

A file to be imported can be set to fail if it contains Nonseparable Blendmodes (Hue, Saturation, Color,
Luminosity). These Nonseparable Blendmodes operate on a 3 component color space. This means that to calculate
the resulting color, CMYK needs to be converted to 3 components, the Blend needs to be calculated and the result
needs to be converted to CMYK again. However, instructions on how these conversion from one color space to
another should happen cannot be given. This results in different behaviors and different color results in different
applications / RIPs.

7. Fail if Transparencies in Incompatible Colorspace

If the file to be imported contains Transparencies (Blendmodes) on objects in incompatible Colorspaces (example:
RGB), the file fails when this option is switched on.

8. Fail if Transparencies imported on Existing Job

If PDF 1.4 transparencies are imported on top of a job containing any objects, this option causes the job to fail.
9. Remove unused separations

This option automatically removes all separations that are defined in the file but which are not used.
10. Convert C/CV/CVC/CVU/CVP to...

All the separations in the custom color list, that have a different extension only are automatically converted to the
one extension defined in this menu. So if there is a PANTONE 300 CVU, PANTONE 300 CVC and PANTONE
300 CV, they all can be converted to example: PANTONE 300 CVC, automatically.

11. Convert CMYK to Hexachrome CMYK

This option allows to replace CMYK by Hexachrome CMYK and thus allowing a smoother integration with
Hexachrome compatibility.

12. Convert all custom colors / Others

With this option checked, all separations in the file are converted to process colors, example CMYK, based on
the CMYK values for the separations as they are defined in the PS or PDF file. The Others option is used for
separations that are available in the file but not described in the header. This should typically not be the case in a
well constructed PS or PDF file, but does sometimes happen. This option equally makes sure that these colors, if
they appear, are converted to process colors as well.

13. Custom Colors

The Custom Colors button enlarges the Color Settings menu with additional fields and a color list which allows
to merge PANTONE™ colors or selectively convert PANTONE™ colors to CMYK without having to convert
them all.

The additional fields that become available show a color list, a From and To field and an Add, Delete and Reset
button. In the example, some entries has been made in the color list: Blue is merged into Reflex Blue. This is used
if there are, for instance, two special blue colors in a file which need to merge together in one color. It is obvious
that the names of the separations have to be known before this action list is executed. If the Convert To color
does not exist in the file, it is automatically created.

To make an entry, type the name of the “From” separation in the left field (e.g. Warm Red), and the name of the
“To” separation in right field (example: PANTONE™ Red) and click Add. Note that this first will leave the color
(indicated by the color swatch in front of the entry in the list) by default black. To change this, click on the swatch
and set the desired colors as CMYK values, these values will be used for display (for example when using ArtPro)
and for proofing to a CMYK device.

If a separation needs to be converted to CMYK, simply check the Convert button. Set Exclude to keep the
specified separation, even if Convert All Custom Colors is used.



604 | Automation Engine | The ArtPro Action List Editor

To delete an entry from the list, select the entry and click Delete button. A Color list can be saved to an external
file, and loaded.

14. Color Management

Define different profiles for importing CMYK, RGB or grayscale files through Import PS. Click the Color
Management button to open the Import tab in the Color Management dialog box.

15. Color Book

The Color Book for import is the same (and uses the same UI) as the ArtPro color book. Custom colors can
be defined in import to be converted into the color book inks. This means, for example, convert them into
hexachrome values, if a hexachrome color book was selected. The selected Color book is shown next to the Color
Book button and an option is provided to turn it on or off.

Blends, Shadings and Gradations
Use this to define how gradients, blends and shadings should be handled on PS or PDF import. It is advised to switch
Recognize Gradations and Convert Shadings into gradations on, to recognize gradations from most popular
applications.

1. Recognize gradations (PS Only)

In a PostScript file, gradations can be described by a large number of paths or by a TIFF. In most cases, these can
be recognized and replaced by ArtPro gradations, if the option is checked (default).

With this option, gradations from Freehand and Illustrator are automatically converted into ArtPro gradations or
multistep gradations. Freehand and Illustrator vignettes which are not linear are converted into multistep vignettes
with midpoints. Gradations from QuarkXPress are converted into ArtPro linear or multistep gradations.

If the option is not checked, depending on how the gradation was defined in the PostScript file, it is imported as a
series of paths, or it is converted to a TIFF image.

2. Convert Shadings into Gradations

PostScript Level 3 and PDF 1.3 and above often use the shading command to define gradations. With this option,
most shadings are converted into AP gradations or Multistep gradations. If this option is switched off, an image is
generated.

3. Convert blends into CT at

When blends are used in a document, they normally come in as a series of paths, with changing paint styles. These
blends are very difficult to select, modify,... Especially trapping becomes very difficult. Therefore, usually blends
are flattened into images, with one single path and one single paint style.

With this option on, blends are even converted to internal ArtPro CT’s automatically. This means the pictures are
embedded in the ArtPro document in a ‘.ct’ file. The resolution for these images can be set and the unit can be
changed from pixels per inch to pixels per cm.

4. Resolution for Shadings

This option is for shadings that cannot be converted to ArtPro gradations (example: mesh gradations). All these
gradations are automatically converted and extracted as a TIFF image on disk. The resolution for those TIFFs can
be set here. Shading conversion to images is a very time consuming calculation. Therefore, the default resolution
is set to 50ppi, but a higher resolution is recommended in some cases, depending on the shape of the object. Check
the objects carefully.

Images generated during PS/PDF import always generate a mapped image.
5. Interpolate Shadings to 300ppi minimum

When working on certified or using Cruise Controls, it is very likely that lowres images generate a warning or
error. This would also happen for images generated when converting a shading.

To avoid this, the Resolution for Shadings can be set to a higher resolution (300ppi), but the sampling of shadings
at a high resolution is very slow and time consuming.
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The option Interpolate Shadings to 300ppi minimum samples at a low resolution and creates a higher resolution
image from it. The lowres images are interpolated to a resolution higher than 300ppi. The resolution is a multiple
of the sample resolution, example: if the sample resolution is 70ppi, the image after interpolation is 70 x 5 = 350
ppi. This results in a high resolution image, generated at higher speed.

Links
This determines how links are handled upon import. With links we refer to either OPI links (%%ALDImage
commands) in PS or PDF files or references to EPS images in PS documents or EskoLinks.

• Placing or importing

The different pictures that could be used in the original document are TIFF (with or without clipping path), DCS,
JPEG, PDF, EPS lineart, regular EPS image (with or without clipping path), EPS duotone, tritones..., LoRes or HiRes
images from OPI systems...

Most of these images can be brought into the ArtPro file in different ways:

Most of them can either be placed or imported, depending on the kind of image and the desired result. Example:
When EPS images are imported, EPS is converted into a TIFF on disk and the TIFF is placed in the ArtPro file. The
big advantage is that the TIFF image can be mapped, which gives us benefit for trapping, previewing, ink swapping,
ink coverage... Therefore in ArtPro it is recommended to work with mapped images (TIFF, JPG, Photoshop PSD and
DCS) all the time.

Because of functionality, it is always recommended to map images upon import except for specific cases like copydot
images, PDF images, etc. When images are placed and not mapped, they remain as they are (example: compression,
content, etc.) and appear identically in the output as they have been placed. This method is typically recommended
for copydot images. Note that only TIFF images, JPG images, PhotoShop PSD and PhotoShop DCS (without vector
data) files can be mapped, hence EPS images (any type, also DCS) can ONLY be mapped if they have been imported
and thus converted to a TIFF image on disk. Copydot images can equally be imported, (example: DCS copydot – 1 bit
data) but this is not recommended since the image would be decompressed while writing to a TIFF file hence produce
extremely large files.

Note:

TIFF images are not imported but only placed (and possibly mapped). Importing is only relevant for
PostScript images (for example: EPS images) which are then processed through the Import action separately
if “importing” has been set.

Summarized:

TIFF: A TIFF image can only be placed, not imported. A placed TIFF file can be mapped and thus trapped
automatically.

EPS image: An EPS image can be placed or imported. A placed EPS can not be mapped. When it is imported, the
pixels are converted to TIFF data. If the image has a clipping path, it can be converted to an internal path with the
image inside.

EPS graphics: If an EPS graphics file, example: a logo or chart, is placed, it can be transformed (rotated, scaled,...)
but not edited (it is treated as one object). By importing that same logo, all the vectors are converted into internal
paths which can be edited and trapped.

EPS duotones (+ monotones, tritones and quadtones): Can be placed or imported. An imported duotone is correctly
converted to a mapped picture. The condition here is that they should be created with Adobe Photoshop 5 or later.
Duotones from older versions of Photoshop are extracted as CMYK images when imported, so these should be placed
instead.

DCS: A DCS image is in fact a preseparated EPS. So the same rules apply. Importing makes it a TIFF, which allows
us to map, preview, trap,...But a DCS cannot be imported directly (example: dropped in a hot folder to be imported),
it has to be used in a PS or PDF file. In other words, if the DCS image is placed in a (Illustrator, XPress,...) document
that is saved out as a PS or PDF it can be imported and mapped correctly.
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OPI images (Open Prepress Interface): When OPI low resolution EPS sample images are used in a document that
needs to be imported, the images always have to be placed, if they are not automatically replaced by their high
resolution version upon import (see the OPI section). If they are imported, completely new (low resolution) TIFF
images which is not recognized and replaced by the OPI server are created, resulting in a low resolution output. If
low resolution TIFF images are used, they can typically (for most OPI servers) mapped and further worked with
(example: for trapping).

• Omit/ Embed

There are three ways to put an image in a PS or PDF file.

• ‘OPI’: The image is omitted (TIFF, EPS, DCS,...). This means the original picture is not included in the PS
file, only the link is available. The link is a path, indicating the place where the image can be found on the
hard disk or anywhere else in the network (example: on the file server). These PS/PDF files are obviously very
small. They are quick to write and copy.

In the Links tab of PS/PDF Import, they respond to the settings under Omit. In the picture list, under display
links, these images have OPI: in front of the name.

• ‘EPS’: The image is embedded. The complete original picture as well as the link is included in the PS file.
This means in ArtPro we can choose which to use. These are usually EPS. They respond to the settings under
Embed. These images can be recognized in the picture list, by the ‘EPS:’ in front of the name. These PS/PDF
files are larger.

• The image can be completely embedded without the link. This is usually with TIFF images. (Freehand is an
exception. All TIFFs are always embedded in the PS files, with the link). Because no link or name is available,
ArtPro can not display these images in the picture list. No link settings can be defined. These images are
extracted to TIFFs on disk during import.

• EskoLink: These are linked images in a Normalized PDF. These act in the same way as OPI links but use
a different syntax. EskoLinks allow to define different density per separation and allows the definition of
separation remapping.

How to handle links on Import:

1. Use Link and Place All

The original file referred to by the link is searched and this file is placed. The embedded information (if present)
is ignored. The file is searched at its original location, unless the link is re-routed in the Display links... part of
the dialog box or if rerouting is defined in the OPI settings. If the image is not found, the embedded information is
used. If it is not available, the result is an empty path.

This setting is mostly used for TIFFs and JPEGs, omitted from the file, lores OPI images, single file DCS or
duotones from Photoshop (version 5 or below).

2. Use Link and Import EPS

The file referred to by the link is searched and this file is used. The embedded information (if present) is ignored.
If the file referred to is an EPS/DCS, it is imported, converting lineart to ArtPro native lineart and extracting
images to disk according to the settings in the Images settings. If the file referred to is not an EPS or DCS
(example: TIFF), it is placed.

The file is searched at its original location, unless re-routing is defined in the OPI settings. If the image is not
found, the embedded information is used. If it is not available, the result is an empty path.

This setting has to be used for DCS and duotones (if you want them converted to mapped TIFFs). It is also used if
there is an OPI swap. In general, most OPI images have the same format (example: EPS). ArtPro is rerouted to the
hires. If that hires is an EPS.duotone/ DCS it is imported and converted to a TIFF. In all other cases it is placed.
This option is used for EPS, when they are either omitted from the PS file or embedded and the original has been
modified since.

3. Ignore All Links

The link is ignored and only the embedded information (if present) is used. This embedded information is
imported, converting lineart to ArtPro native lineart and extracting images to disk according to the settings in the
Image settings.
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This setting is used for embedded (hires) EPS and TIFFs. There is no difference in result whether you apply use
link and import or Ignore all links. However, if the links are ignored, we need not worry about ArtPro finding the
original on disk (is the link correct?, does it need re-routing?,...).

When importing a PS/PDF file, 1, 2 or 3 needs to be chosen for all ‘omitted’ images (the ones in the list with OPI
in front of the name) and also for all the embedded images (the ones with EPS).

4. Extensions

It is possible to override the above option settings with the Extensions fields. Consider the example where all
EPS images are linked and imported. Depending on the types of EPS pictures, it may be considered to make an
exception to this setting, example: one would not want to equally import copydot EPS pictures. To avoid this,
but still allow for other EPS pictures to be imported and hence trapped, it is possible to work with an extension
for the copydot images. If the copydot images would be defined as “.cpd” (as an example), then typing “.cpd” in
the Extensions field next to Use Link and Place All would place ONLY the images with a .cpd extension, while
importing the others.

It is equally possible to add multiple entries in the Extensions fields separated by a space, example:
“.cpd .main .duotone” etc.…

5. Into Opacity: B/W, Gray, 5th Channel, Invert

With the Into Opacity options, you can define that linked TIFFs in the PostScript file should be put into the
opacity channel, and thus be made transparent.

1. B/W

If the B/W option is checked, all black&white bitmaps referred to by link are put into opacity with a solid
black image channel. So, all black pixels remain black and all white pixels become transparent.

2. Gray

If the Gray option is on, all grayscales, referred to by link, will be put into opacity, with a solid black image
channel. The resulting CT will be black for the percentage of the grayscale, and transparent for the remaining
percentage.

3. 5th Channel

If this option is checked, a 5 channel TIFF referred to by link, results in a four channel internal CT and the 5th
channel is used as opacity channel. The areas of the Photoshop alpha channel that were 100% masked, result in
100% image in ArtPro. The areas that were 0% masked, become completely transparent. Any value in between
(example: soft edges on the mask) result in a partial transparency (see pictures). If the option Invert is on, the
opacity channel is inverted, using the Invert button in the Mapped Picture paint style. This way, the alpha
channel can be made up in two ways, positive or negative. With Into Opacity it is also possible to work with
extensions (see above): Example: B/W is off, gray is on, extension = .gr This means all B/W is not affected
and all grayscales with an extension .gr is put into opacity. All other grayscales are not affected.

OPI
This is used for rerouting linked images. The rerouting could happen based on the name of the image or based on the
path of the images. There are mainly two reasons why rerouting may need to take place:

• Low resolution images need to be replaced by (rerouted to) high resolution images.
• Missing images need to be rerouted to their correct (current) location.

Note:  Re-routing can only be done when OPI links are available for the images and the Use Link and Place
All or Use Link and Import EPS options are set.

1. Perform OPI swap

This option enables the rerouting as defined in this menu. If the option has not been set, all settings are ignored
and no rerouting takes place when OPI links are used by the system.

2. Sample Extension / Hires Extension
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The Sample Extension and Hires Extension fields are used to swap the extension of the image that is linked.
This is typically used for OPI servers which are set to add an extension to or replace an existing extension with
another when low resolution images are generated from high resolution images.

Every extension that is entered in the Sample Extension field is cut off from the linked file before it is actually
searched, while every extension that is entered in the Hires Extension field is added to the linked file before it is
actually searched.

If the Sample Extension field contains “.lay” and the Hires Extension field is empty and the image that is linked
is “image.lay”, then the system actually searches for “image”, the “.lay” extension is cut off.

If the Sample Extension field contains “.lr” and the Hires Extension field contains “.hr”, and the image that is
linked is “image.lr”, then the system actually searches for “image.hr”, the “.lr” extension is cut off and the “.hr”
extension is added.

It is equally possible to enter multiple extensions in the fields, separated by spaces. If the extensions of the file
referred to in the link matches an extension entered in the Sample Extension field, the extension is cut off and
when present, it is replaced by the extension in the Hires Extension field at the same position. Extensions that
only need to be cut off and not replaced should be at the end of the list.

Example:

• Sample Ext. field: “.lr .low .lay”
• Hires Ext. field: “.hr .high”

The result of this operation is:

• “.lr” is replaced by “.hr”
• “.low” is replace by “.high”
• “.lay” is cut off

3. Sample Folder / Hires Folder

Similar to the Sample Extension and Hires Extension fields, the Sample Folder and Hires Folder fields are
used to reroute the system to search for an image in a folder different from the folder determined in the path of
the OPI link. In OPI swapping environments, this is typically used for OPI systems that are set to generate low
resolution images of high resolution images with the same name but in a different folder.

Suppose all low resolution images are stored in a folder “ForLayoutUse” and all high resolution images are stored
in the folder “Originals”, both under the same subdirectory, then “ForLayoutUse” would be filled in the Sample
Folder field, while “Originals” would be filled in the Hires Folder field.

When the OPI link in the file is then: E:/CustomerX/Images/ForLayoutUse/Image, the system will actually search
for and use: E:/CustomerX/Images/Originals/Image

It is also possible that one path is changed twice, for example: by putting multiple entries in the Sample Folder or
Hires Folder fields separated by spaces. This implies that there should be no spaces in folder names that need to
be replaced.

For example, if the Sample Folder contains “LR Customer” and the Hires Folder contains “HR”, then the OPI
path E:/JOBNR/ImagesCustomer/LR/Image is replaced by E:/JOBNR/Images/HR/Image.

In the above examples, it is clear that all OPI paths have been generated by a system on Windows. The above
would work for cases where the front-end station creating the PostScript or PDF file with OPI links is based on
Windows and has the same mount point and drive letter for the image server as the Automation Engine. As in the
first example, for both Automation ENgine and the front-end Windows machine, E:/ is the network drive for the
image server entered at the mount point where the CustomerX folder is the first available subfolder.

It is clear that in a day to day production environment, the above situation is mostly hypothetical. Indeed, mostly
Macs are being used as the front-end, while if even Windows machines would be used, they would often have a
different mount point to the image server than Automation Engine.

In these cases, the Folder Mapping mechanism can be used to remap the drives for the OPI paths.
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An example clearly illustrates this. Suppose the Image Server has following structure for the images that are made
available to the network: E:/Server/Images/…

Suppose that the Images folder has been made available to the Mac environment as Image Server and this volume
gives access to the content of the Images folder.

Suppose that the Server folder has been made available to Automation Engine and this folder is mounted as a
network drive under G:/, hence this G:/ gives access to the contents of the Server directory.

If now an OPI link on the Mac is defined as: ImageServer:image then Automation Engine actually needs to
find: G:/Images/image To achieve this, we would enter “Image Server:” in the Client field, while entering “G:/
Images/” in the Server field. Clicking Add appends this definition to the list. It is possible to have multiple OPI
folder mappings active at the same time. The system equally automatically converts between Macintosh notation
of subfolders and Windows notation of subfolders (: and /).

4. Root Folder

If a linked file cannot be found at its original location or at the location it is supposed to be found after re-routing,
the file will be searched for in the folder or volume that is defined as Root folder. Nexus will not only search in
the Root Folder but equally in all subfolders. When a Root Folder has been defined, it is displayed underneath the
Root Folder button. To remove the Root Folder setting, click on the Root Folder button while holding the SHIFT
key.

Note that Nexus will use the first instance of the file that it finds, which may be potentially dangerous in
production environments. Suppose the image to be found is called “logo.TIFF” and the logo is not found at its
location, Nexus checks the Root Folder and its subfolders.

Suppose in the production environment, two customer directories have been set underneath the root folder
directory: RootFolder/CustomerA/Images/logo.TIFF and RootFolder/CustomerB/Images/logo.TIFF.

Even if the CustomerB logo needs to be used, the system always picks the first instance of the name that it finds,
in this case the logo of CustomerA! It is also not advisable (for speed reasons) to select a complete disk or a very
big image tree as root folder.

5. Exclude Folders from Search

When searching through the Root Folder, folders names entered in this field are not searched. This can be used
when all images can be found on the same volume, with the possibility to exclude all folders containing low
resolution files, example: all low resolution files may always be put in folders called ForLayoutUse.

Image Settings

1. Vectorise Bitmaps: Always/ Most/ Never

When importing a PostScript or PDF file containing 1-bit images or a 1-bit image is detected via OPI, this setting
defines how to handle those.

When set to Never, the 1-bit images are placed as images. When set to Always, 1-bit images are always
vectorised. When set to Most, the 1-bit images containing more than 5mio pixels are placed, images smaller than
5mio pixels are vectorised. For example: This option can be used to vectorise small logos but leave large scans
such as copydot files, unmodified.

When vectorizing a Bitmap, the Precision can be set to Exact (no reduction factor and straighten margin is
applied), Fine, Normal and Coarse. For more information, refer the ArtPro Manual.

If a bitmap is placed as an image, the bitmap is converted into a Mapped TIFF with image channels and an opacity
channel. The image pixels constitute the image and the white ones are transparent to the background.

Both a vectorised TIFF and a bitmap mapped TIFF are colored exactly like in the original document. When
importing a PDF file, the result is always a grayscale TIFF. In most cases a vectorised bitmap is smaller and
quicker to handle than a mapped TIFF.

2. Make Images Internal
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After importing, all TIFF and JPG pictures (placed in the PostScript or PDF file or extracted by Automation
Engine) can be automatically converted into Internal Images in ArtPro, by activating the option Make Images
Internal. It is only used in exceptional cases. For more information on internal images, see Chapter 5: Contone of
the ArtPro Manual.

3. Extract included images

If an image has to be extracted on disk during PS/PDF import (see also Links), a file is saved to disk. During
Import, identical images are detected and deleted. This means that, if Automation Engine extracts images from the
PS or PDF file and writes them to disk, these images are compared and if the same image is used several times,
only one of them is kept. The comparison is done after writing the TIFFs and before making them internal (if
necessary). This comparing can take some time but results in faster editing and smaller file sizes.

The File Name field in this dialog box is set to define how the extracted images of the PS or PDF file is named
and to what location they are saved. The path name in this case determines where they are saved. If empty they
are saved to the current job folder. It is advisable to use the document page number in the Template, as otherwise
some files can be overwritten with multipage PS import and Select Page Action.

4. Resolution / Detect Image Resolutions

When images are extracted during the import of a PDF or PS file and the Detect Image Resolutions in
PostScript / PDF Import option is on, Automation Engine checks the internal resolution of the image.

If this resolution is an integer (example: 360 ppi), the image saved uses this resolution and is placed in the ArtPro
file at 100% scaling. If the resolution is not an integer (example: 243,6 ppi), or if the Detect Image Resolutions
in PostScript / PDF Import option is off, the resolution as defined in the Import PS/PDF dialog is used and the
scaling is adjusted (in this case, the 300 ppi image is placed at a scaling of 123.56%).

5. Use Original Name

When the original name of an image is known, the extracted file is saved with the original name if this option is
checked. If this option is off or the original name is not known, the user is prompted for a name but by default the
name of the PostScript file followed by .# and a number is used.

6. Use Photoshop clipping path

If a PS file is imported, in which Photoshop TIFF files are placed, containing a clipping path, this clipping path
can be converted to ArtPro line art, with the TIFF file placed inside it’s path. This option only affects TIFF files
coming in with OPI. Clipping paths on EPS images are always used. Another difference is that during Import
PS, all paths are imported as straight line vectors, while when using the Use external clipping path option when
placing a picture, the curves are kept as curves.

7. Recognize TIFF Channels

When OPI linked pictures have to be placed, Automation Engine tries to recognize any spot colors when placing a
TIFF file and if the Recognize TIFF Channels is switched on.

A TIFF file can contain channels indicating masked areas (type1), channels indicating selected areas (type2) and
channels indicating spot colors (type3).

Channels of type 1 and 2 are treated as alpha channels, thus put into the opacity channel. If the TIFF contains
more than one alpha channel, only the first is used and all others are ignored, though the separation are generated
based on the channel names present in the TIFF. These separations have CMYK value 0, 0, 0, 100 and only reflect
the number of channels in the TIFF.

If spot color channels are found, a separation is created with the same name as the TIFF file channel.

The color definition (CMYK representation) for this spot color is first searched in the ink book. If not found there,
the color information from the TIFF file is used.

If ArtPro encounters an unknown color space, a new separation is created with the channel name and with CMYK
representation 0, 0, 0, 100.

General Settings

1. Clip Text
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Text that was clipped in another application is clipped in ArtPro as well after Import PostScript/PDF. In order to
make this possible, though, clipped text is vectorised in ArtPro and thus no longer available as real text. Normal
text (not clipped) is not affected by this option, which is checked by default.

2. Merge Equal Paths

If Merge Equal Paths is unchecked, all paths are converted to ArtPro in the normal way. If checked, two or more
identical paths on top of each other are merged into one single path with the combined color information. This
option is automatically enabled for separated files.

3. Recognize Illustrator Layers / Merge Equal Layers

When checked, all the original layers from imported Illustrator (<9) EPS files are recreated in Automation Engine
and all the elements are put back on the correct layers. All PDF files containing PDF 1.5 layer information, also
generate the correct layers in Automation Engine. Make sure to generate PDF 1.5 output from certain applications
(example: Illustrator CS) to include all layer information.

If unchecked, all vectors are put on one single layer called PostScript Import. This option can be used with or
without Merge Equal Layers. If Automation Engine finds multiple layers with the same name, those layers are
merged into one (example: An EPS with a ‘Dielines’ layer is imported on an ArtPro template with ‘Dielines’ in
it). It is possible in Automation Engine to have several layers with the same name.

4. Ignore Page Commands

In a normal PostScript file, the document size is defined at two places: the bounding box, in the header of the file
and page commands, later in the PostScript. In most cases, the Page Commands are more exact than the bounding
box. For files coming from certain versions of Barco systems, the Page Commands are rounded off, while the
bounding box is exact. In those cases, you can choose to Ignore Page Commands and use the PS bounding box
instead.

5. Keep Strokes

When checked, all strokes found in the PostScript or PDF file are imported as ArtPro Strokes. If the option is
unchecked, the strokes are converted to regular ArtPro paths.

6. Memory

This parameter indicates how much Virtual Memory is allocated to the Import function, in order to store its
variables, key words, dictionaries, etc. Generally, 20000 kB (default) is sufficient to perform the function.
However, when the error message VMError appears, the value should be increased.

Certified PDF

When importing any file type other than PDF, the Sessions log indicates that no input profile was applied and the
session begins AFTER the import.

• Importing non-Certified PDF

When importing a non-Certified PDF file and Certified Import is enabled, Automation Engine Certifies the PDF
file and import the Certified PDF instead of the original. Unless Overwrite input file on re-preflight is checked,
a new certified PDF is saved (according to the Template settings) and this certified PDF is imported. This is saved
as a separate session.

• Importing Certified PDF

1. Re-Preflight if profile does not match: Selected

The job is re-preflighted if the input profile and the embedded profile do not match. If they match, the session log
indicates that both profiles are identical. When comparing two profiles, their content is checked and not just the
name.

2. Re-Preflight if profile does not match: Unselected

The Certified PDF is imported without re-preflighting it. The Session window indicates the profile it was
originally certified by.

• Re-preflight
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When Re-preflighting, Automation Engine creates a new session, preflight the file and close the session. The file
is saved according to the File Naming Template settings.

1. Overwrite input file on re-preflight

When checked, there is no new PDF file created by Automation Engine. Instead, it replaces the original PDF file.
2. Get all bounding boxes for preflight report

When checked, this option forces Automation Engine to obtain bounding boxes for the last preflight report. If
activated, it gets full information for every report item along with bounding box of the area where the error/
warning occurred. This causes an additional preflight of the input document and consume additional time.

Cruise Controls (Preflight Settings)

This dialog box is used to set a preflight profile.

Several controls are available which are split up in four categories: Lineart Color Controls, Image Controls, Object
Controls and Text Controls. These controls are found in the left pane. Clicking the triangle in front of each of the
controls will show the available controls for that category.

In the right window the selected controls, e.g. preflight settings, are shown, each with an either green, orange or red
circle in front. The color determines the severity of the control: red refers to error level, orange to warning level and
green to note level.

To change the severity level for a preflight item, click on the preflight item and select the appropriate severity level
from the dropdown menu. To add a preflight item to the list, double-click on the control in the left window.

To remove a preflight item from the list, select “Delete Control” from the contextual menu, or select it and press Cmd
- Backspace.

The Save Controls, Clear Controls and Load Controls buttons allow to respectively save all the selected controls
with their severity level to a file, clear the list or load controls and their severity level from a previously saved file.

Note that a job is not held based on preflight, in the case of a warning level or error level there is only an exclamation
mark in front of the job in the Job list indicating that the error button should be clicked to verify the error log
information for that specific job. However, even if there was a preflight error, the job still continues to run until
completed!

When preflight has been performed for a file and the file has been saved it contains a complete Cruise Report
(preflight report). Using ArtPro it is possible to view this report and actually use it to navigate to the appropriate
object in the file that triggered that specific entry in the Cruise Report.

By switching on the Save Report option, a preflight report can be saved in PDF format to the location specified in the
Template. Using an E-mail action, this report can be emailed as an attachment, using a Select File action to select the
PDF file only.

Following are the different Cruise Controls or preflight settings which are available:

1. Info

With these settings, information about the imported file can be found:

Filename: The original name of the imported file

Format: What file format the imported file has (as found in the header of the file)

Title: Title of the document of which the imported file was created

Creator: Application in which the imported file was created

Date: Date on which the imported file was created

Type: What type of file was imported (Comp. / Separated)
2. Lineart Color
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* Overprint: Overprint defined in the imported file is detected. Overprints in a document could indicate that the
file may already contain some trapping.

* Custom Colors: Using this control, get notified when and where a custom color is used in the imported file.

* Ink Coverage: Ink coverage can be checked not to exceed a given percentage, example: 300%. This is used to
find a common error, like the use of registration color, where simple black was needed.

3. Image

This category contains all controls to avoid most common errors in images.

* Resolution: if the resolution of all images used in the imported file is bigger or smaller than 72, 300, 1000
ppi or a freely entered value, a warning is generated. This can point out low resolution images or images with
an excessive resolution. Very important to know here is that ArtPro takes the scale factor of an image into
account. The real resolution is the scan resolution divided by the scale factor in % and multiplied by 100. The real
resolution of a 300 ppi image scaled to 200% is 150ppi. The real resolution of a 72 ppi image scaled to 20% is
360ppi.

* Color: Images in the specified color space (RGB, CMYK, LAB, Separated or grayscales) can be found. This
could also be very useful because ArtPro does not support any RGB images.

* Links: With the Link settings, OPI or EPS comments can be checked:

OPI Comments: indicates if OPI comments were encountered in the imported file.

OPI Recognized: indicates if the found OPI comments were used.

EPS Linked: indicates if linked EPS files were encountered in the imported file.

EPS Imported: indicates if these found EPS files were imported (instead of being placed).
4. Object Kind

Object controls offer the possibility to point out objects smaller or bigger than a given value. For example, to
avoid hair lines or small text printed in flexography.

* Text: text smaller or bigger than 12pt, 6pt or any entered value can be looked up and reported.

* Strokes: strokes can be checked for size to be bigger or smaller than 2 mm, 1 mm, 0.5 mm or a user defined
value.

5. Text

Text controls contains three criteria for font control:

* Font Missing: A criteria can be set to search for missing fonts during import. ArtPro reports if no font
information was found at all, meaning the printer as well as screen fonts were missing.

* Font Name: If a font, used in the imported PS or PDF file matches the name entered here, a warning is
displayed. This way, the system can notify the operator when for instance, a courier is used in a file, for this is
often a replacement font.

In the definition of the font name, a wild card can be used. If you enter Cour*, all font names starting with "cour"
are found, including courier bold, courier italic, etc. The name is not case sensitive.

To add controls to the list, double click on the control or select it and click on the button with the arrow to the
right. To remove controls from the list, select it and click on the button with the arrow to the left.

* TrueType: checks if TrueType fonts were used in the imported file.
6. Transparency

Transparency controls contains three criteria:

* Blend Modes: A criteria can be set to search for used blend modes.

* Opacity: If an opacity higher, lower or equal to the entered value is encountered. If set to “Lower than 100%” is
set, all objects with an opacity other than 100% trigger the control.

* Opacity Masks: checks if Opacity Masks were used in the imported file.
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7. Preflight Report

The Preflight Report allow to get information from the PDF Preflight Reports. This of course only applies on
importing PDF files that were preflighted.The Cruise Controls that can be used are the three levels of Preflight
report: fixes, warnings and errors.

Please note that Bounding Boxes for preflight entries are only available if the file was preflighted or re-preflighted
during import, with the Get all bounding boxes for preflight report option selected (see above).

Ink Coverage

The Ink Coverage action calculates the surface ink coverage of the document and saves the information as a text file
on disk. The Template Editor button again determines the naming and location of the file.

Per separation in the job, a value is given as a percentage and as a surface coverage (example: square mm). Equally a
total surface value is given.

Note:

In the case of pictures, ink coverage only works when there are mapped pictures or when placed ArtPro
pictures contain a separated preview. In other cases an average value is used. When using ArtPro, this average
value can be adapted in the paint style. The only relevant setting in this action is the samples per inch that is
taken which determines the accuracy of the ink coverage. After running the job, the results can be seen in the
Job Editor.

Ink Coverage Check

Ink Coverage Check verifies if the amount of ink does not exceed the Ink Limit.

Special separations such as opaque separations, die or transparent separations can be excluded. The page box to be
used can be set, as well as the resolution at which the job needs to be rasterized for checking.

Insert ArtPro file

This action inserts an existing ArtPro file or picture into the file which is currently being processed.

The file that is inserted can either be a fixed file (name is selected in the Insert File window) or a file which has been
determined by a previous Select File action (in this case the file to be placed would be selected from a folder which is
dropped in the hot folder) or a file which has been generated elsewhere in the action list. An example of the last case
is the result of a Difference action that needs to be inserted (place as picture) in a new ArtPro file.

The insertion is done on the bottom right quadrant of the current position of the ruler, determined by the position of
the ruler in the Importing action, the position of the ruler in an opened ArtPro file or the position of the ruler after the
Move Ruler action.

Browse

Allows to physically select a fixed file from the system. Click Browse to open the Browse menu. After selection the
name of the file with its full path is displayed underneath the Browse button.

When no file is selected, the file to be inserted needs to be determined by a previous Select File action in the action
list.

Overwrite separation angles and frequency

When inserting an existing ArtPro file, the system loads colors correctly. If separations were different, Automation
Engine adds the appropriate separations in the separation table. When there are identical separations, this option
overwrites the angles and frequency of the current separations with the values of the file that is being inserted.
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Merge Layers with Same Name

The ArtPro file format supports layering. When this option is set, content of layers in the inserted ArtPro file is
merged with content of layers in the current file, if they have the same name.

Ignore Screening Errors

Since Extended Screenings are stored differently in newer version of the application, opening a file from older
version may result in a conversion of the screening. If this conversion fails, the job fails, unless the Ignore Screening
Errors option is selected. As a conversion error means the screening settings are changed, it is advised to use the this
option only for action lists that do not have any screened output or if screening settings are defined in the action list
itself.

Place as picture using

This option is used for placing image files or treating an ArtPro file as a picture (which would mean the content of the
ArtPro file is not available, for example, for trapping or internal modifications).

Supported picture types include EPS, DCS, TIFF, PSD, ArtPro, PS, PDF and TIFF/IT.

When the Place as picture using option selected, the drop-down menus present beside this are enabled which can be
used when inserting a file with it to place the selected file as a picture inside the open file.

At the time of inserting, a rectangle is created of the same size as the border defined in this popup menu, in which the
file is placed as a picture. The Align picture on option can be used to define on what border the placed file should be
positioned. The top left corner of the selected border is placed in the center of the ruler.

For example: combination of both options allow you to place the inserted file positioned on its trim box (top left
corner of the trim box in the center of the ruler), but place it inside it's bleed box.

Place Single-Separation ArtPro File in Single Separation

This option defines how to handle inserting ArtPro files with only one separation. If the option is switched off, objects
in this AP file with 100% of the single separation are considered to be registration color. Thus they get 100% of every
ink in the ArtPro file after insertion. If this option is selected, the file is inserted in one single separation instead.

Recognize TIFF Channel

The Recognize TIFF Channel Option allows to recognize TIFF Channels when inserting a TIFF File.

A TIFF file can contain channels indicating masked areas (type1), channels indicating selected areas (type2) and
channels indicating spot colors (type3).

Channels of type 1 and 2 are treated as alpha channels and put into the opacity channel. If the TIFF contains more
than one alpha channel, only the first is used and all others are ignored, though the separation are generated based on
the channel names present in the TIFF. These separations have CMYK value 0, 0, 0, 100, and only reflect the number
of channels in the TIFF.

If spot color channels are found, a separation is created with the same name as the TIFF file channel. The color
definition (CMYK representation) for this spot color is first searched in the ink book. If not found there, the color
information from the TIFF file is used.

If Automation Engine encounters an unknown color space, a new separation is created with the channel name and
with CMYK representation 0, 0, 0, 100.

Layer Versioning

The Layer versioning action allows to create multiple ArtPro files from a single file, based on its layers. The Base
Layers are used for every ArtPro file, while every Version Layers results in a separate ArtPro file. This can be used,
for example, to split up a file with layers “Base graphic”, “Base Text” “English” “French” “German”, into 3 files:
everyone having the Base layers and one with the French, one with the German and one with the English layer.
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Base Layers
The Base Layers are the layers that are used for every ArtPro file. These can defined by name or by range. When
defining a base layer by name, it can be added to the list by clicking the + button. Layers can be removed from the
Base Layers list by selecting it and clicking the - button. The name of a layer can be defined by doubleclicking it in
the list. When defining the name of the Base Layers, wildcards (*) can be used.

When defining the range, you can, for example, define that layer 1 - 3 are base layers.

Version Layers
The Version Layers can be defined by the user or it can be set to use all non base layers as version layers.

When defining the Version Layers, you can add and remove versions. The Template key for a version can be used
in the File Naming Template in order to define the names of the resulting ArtPro File. For every version, you can
define what layers need to be used. If the option is selected and the entered Layer is not found in the original ArtPro
File, the action fails.

The option Ignore Case In Layer Names defines whether the definition of layer names should be case sensitive or
not. If other layers than the ones defined in the versions and base layers are found, the action fails if the option Fail
if extra Layers found is selected. This option is disabled when the All Non Base Layers option is selected for the
Version Layers.

When saving the various ArtPro files, you can define if the file needs to be saved with preview (and its resolution)
and if the Certified PDF information should be included.

Make Thumbnail

Make Thumbnail is an action to create a TIFF or JPEG preview of an ArtPro file.

Resolution can be set up to 120 dpi. Noise for gradation can be set. There is no oversampling.

Compression can be set to TIFF, High Quality JPEG, Medium Quality JPEG or High Compression JPEG. The
Template can be used to define name and location of the thumbnail.

Modify Layers

The Modify Layers action allows to change the settings of layers. In the Layer fields you can enter any number of
layers, using full name or a wildcard (*).

If the Matching option is selected, all layers matching the entered string are affected. If it is not selected, all layers
NOT matching the string are affected. This allows, for example, to select all layers except “varnish*”

With the checkboxes you can set the layer(s) to (in)visible, (un)locked or (non-)printing.

If a layer name is not found, this line is ignored. However, if the “Abandon” option at the end is on, the rest of the
action list is abandoned.

Layers with hidden, locked or non-printing checks, stay like that until other Modify Layers actions remove check or
until the action list closes the ArtPro file.

Modify Paint

The Modify Paint action allows to modify the paint (in percentage of a given separation) of objects or selected
objects, change the overprint, or modify the start and end color of gradations.

Modify Screen

This action will apply user defined screening parameters to all selected objects.

The screening parameters in this case are PostScript based. The Dot Code field allows you to enter a PostScript string
to execute your own personalized screening.

Use a Screening set allows to select a screening set as saved in ArtPro based on the name in the Screen field. The
file can be selected using the Browse button. See the ArtPro documentation for a full description.
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Modify Separations

The Modify Separations allows to change settings for separations.

Rename C/U/CV/ CVC/CVU/CVP to
This allows to convert different CVC flavours to the same extension.

Delete CMYK Flags
This allows to remove CMYK flags. These flags indicate what separations should be handled as CMYK (for placing
pictures, importing PS files, etc.) even if they are replaced by spot colors.

Separation list
The separations are selected by name. Wildcards can be used, example: “Die*” selects all separations whose name
starts with Die. Separations are added by clicking the + button.

Rename
A separation can be renamed by entering the original separation name and the new separation name and check
“Rename”. Note that renaming is NOT the same as remapping !

Create
A separation can be created by entering the separation name and check “Create”. In the example, a separation
PANTONE Red will be created.

Set to

1. Remap

A separation can be remapped by entering the original separation name and the “target” separation. If the Target
separation does not exist, the job will fail.

2. Convert to CMYK

A separation can be converted to CMYK by entering the name of the separation and entering “CMYK” as target.
3. 0 / Trans

A separation can be set to knockout by entering “0”. All objects containing “trans” for that separation are changed
to “0”. By entering “Trans”, the separation is set to overprint, changing all “0” values to “trans”. The Apply on
Selection can be used to set the desired separation to 0% or Trans only for the selected objects.

4. Opaque / Die / Trans

Allows to set the attribute of a separation to opaque, die or transparent (varnish).

The Opaque/ Die/ Trans information is used in the JDF export and in the Vector trapper action.

Move Ruler

Every document in Import has a ruler position, depending on how the ruler position was set when importing a file or
when opening a file.

The Move Ruler action moves the ruler within the current file to a new position based on an offset from the current
ruler position or an offset from the position of any of the corners or centers of the pageboxes. This offset is set by the
Vertical and Horizontal fields. This is very useful when pictures or other files need to be added to the current file at an
offset from the ruler position or any of the corner or center points of one of the pageboxes.

Nested Step and Repeat

The Nested Step and Repeat action is based on the PowerStepper module in ArtPro.
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It is used to make step and repeat based on the MFG (ArtiosCAD), CFF2 or DDES information. MFG, CFF2 and
DDES files are generated on CAD/CAM systems to create die cuts (example: Dimensional Impressions’ “Score”).
Through this action these files can be used to automate the step and repeat process without having to calculate
positions, rotation and nesting. For a full explanation of the Nested S&R functionality, we refer to the ArtPro Manual.

The action typically needs two files as input:

• The CAD file
• The ArtPro file

The CAD file can also be specified in the action settings.

Nested Layout File Format

Instead of selecting an image, the user can also select a ‘layout’ file, that contains the names of several images,
together with information on where they should be placed.

Layout files are tab-separated text files with a small header. Here is an example:

ArtPro Nested S&R Layout V1.0

JokerBoxBerries.aw 1-35

JokerGreen3.aw 46-7

The first line identifies the file as a ‘layout’ file that can be used for Nested S&R. It is followed by an empty
line. Each following line contains the name of an image and the station numbers at which these images should be
placed. In the example, the file ‘JokerBoxBerries.aw’ is placed at station numbers 1 through 3 and 5 and the file
‘JokerGreen3.aw’ is placed at station numbers 4 and 6 through 7.

When using a layout file, you can deselect the option Filenames in Layout File must match and provide the files to
be placed using a Select File before the action.

Open ArtPro File

This action opens an existing ArtPro file, either input through the Apply ArtPro Action List task, generated earlier
in the action list or defined earlier in the action list (example: through the Select File action).

When an ArtPro file is dropped in the hot folder, the line art file AS WELL as the CT file (when available) need to be
dropped. The system automatically selects the line art file for opening while recognizing the appropriate CT file. In
order for this to work correctly, the corresponding action list has to be created with the option Preserve Filenames
active. This makes sure that the appropriate line art and CT file names are not modified by the system which would
result in the system not finding the CT portion of the file.

The Open ArtPro File action contains functionality related to used images, used fonts and color management.
Although an ArtPro file can contain a line art portion and a CT portion (for internal images), an ArtPro file can
equally contain LINKED images, these are images which are used in the ArtPro file but which are not embedded in
the CT portion of the file.

The Open ArtPro File action contains four main portions: Root Folders, Folder Mapping, Fonts Folders and Color
Management.

Root Folders
When images were used residing on the front-end Macintosh or on a server which can not be mounted on the Nexus
system, the Root Folders functionality can be used to define where Nexus has to locate linked images which are used
in the ArtPro file for opening.

In this example one Root Folder has been defined: E:/AE/ AP_files. When an ArtPro file that contains linked images
which were previously stored on a local Mac needs to be opened, they need to be copied to this folder or a subfolder
of this folder first. A Root Folder can be added by typing in the appropriate path and clicking the Add button or by
selecting it through the Browse mechanism. Equally, a Root Folder can be removed by clicking the Remove button.
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Multiple Root Folders can be set, when opening an ArtPro file, Automation Engine goes through the respective root
folders (and subfolders) until the image has been located.

Note:  You can use a File Naming Template to locate the root of the images.

Folder Mapping
The Folder Mapping mechanism can be used when images which are residing on a server and which can be mounted
on the Automation Engine are used.

As an example, in the ArtPro file, the path of an externally linked image can be defined as: Intel_Mac:images:image1.

Obviously, on the Automation Engine, the file server would be mounted at a different mount point with a different
name. Typically the image server would be mounted to a drive letter, for example, G:.

To allow Automation Engine to automatically locate images on the Image Server when opening an ArtPro File, the
Folder Mapping mechanism allows to substitute a portion of the path name used in the ArtPro file with another
name. In above example, Intel_Mac would be substituted with G:/, which would tell the Automation Engine to find
above image as G:/images/image1.

To define a Folder Mapping substitution, enter the respective fields On Client (how the local Macintosh sees the file
server) and On Server (how the AUtomation Engine sees the file server) and click Add. Similarly, Folder Mapping
substitutions can be removed by clicking the Remove button.

Fonts Folders...
When live text has been used in the ArtPro document, Fonts Folders can be used to allow Automation Engine to
extract the outline information from the Mac fonts for trapping, printing, exporting, ArtLink functionality, etc.…
Please note this is only valid for Type 1 fonts and Truetype fonts.

To define a fonts folder click the Add button and browse to the appropriate folder. Similarly, fonts folders can be
removed by selecting them and clicking the Delete button.

Although the ArtPro file format (version 6 and onwards) contains all the outline information for live text in the
document, the font is still important for special functionality like ArtLink, Regmarks, etc.… By clicking the folder
icon next to a font folder, you can select Edit, which opens a File Naming Template dialog box allowing to define
the name for the font folder based on the job name, user name,...

Color Management
This setting determines if color management has to be applied during the action list. When enabling color
management, it is possible to select a color management settings file, previously saved by ArtPro. This file contains
all ICC profiles and settings to determine how color has to be treated throughout the rest of the action list, including
ICC profiles for proofing, printing, etc.

Tip:

You can use Make SMB Compatible to rename all the linked images with a crossedge sign (#). This
character will be replaced by an underscore. Use this option to make these images compatible with Windows
fileserver. In this case, the ArtPro file should be saved to disk so that the image links point to the renamed
images.

If the ArtPro file itself contains a working space different from the one defined in the Color settings file, the action
list stops if the option Stop when working space profiles are different is checked.

Map Pictures
If the Map Pictures option is selected, images are converted to mapped pictures if possible. For more information on
Mapped Pictures, we refer to the ArtPro documentation.

Ignore Screening Errors
Since Extended Screenings are stored differently in files from older version, opening a file from them results in a
conversion of the screening. If this conversion fails, the job also fails, unless the Ignore Screening Errors option is
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selected. As a conversion error means the screening settings are changed, it is advised to use the Ignore Screening
Errors option only for action lists that do not have any screened output or if screening settings are defined in the
action list itself.

OPI Generation

The OPI Generation action allows to generate low resolution images from high resolution images, example: for use
in a page layout environment.

In this action the resolution and format (TIFF or EPS) can be selected. When a document is printed with Omit
Images, the Importing action can then recognize the OPI comments in the PostScript or PDF file and reroute back to
the high resolution images.

Optimizing

The Optimizing action deletes (parts of) the contours that are not needed to produce correct print output. The
function makes it possible to “clean” or flatten a document, removing all the superfluous and unnecessary paths.
For each path the program checks all the contours on top of it and decides which objects should be cut, united or left
untouched to maintain the same structure in the job.

Optimize is especially useful to eliminate unnecessary contours from an imported PostScript file, to perform faster
trapping, faster printing,... Keep in mind though, that the objects are typically less editable after optimization than
before. We hence only recommend to use the Optimizing action for complicated graphics documents.

The effect of optimizing are, the graphics look a lot cleaner and are faster to print and trap. However, the editability is
considerably reduced.

PowerTrapper

The PowerTrapper dialog box is used to make trapping settings.

1. Choose your trapping settings in the Distance & Direction, Color & Shape and Processing tabs.
2. If needed, define trapping rules using Add Rule.
3. Save your trapping settings as a Trap Preset to be able to reuse them on another document.

Distance & Direction

1. Trapping

You can choose between two trapping modes:

• Normal Trapping: This selects adjoining color pairs, which are likely to cause registration problems like ugly
light gaps, and unwanted halo effects. PowerTrapper Standalone automatically chooses the most appropriate
trap direction based on the relative luminance of the adjoining colors. Lighter colors are generally trapped into
darker colors to minimize the visual effect of the trap.

• Reverse Trapping: This prevents overprint of adjoining color areas by trapping these color pairs with a white
knockout (erasing) trap. The white knockout trap is put on top of the lighter of the two colors.

This is useful to prepare a job for Dry Offset printing (example: metal beverage cans) where overprinting of inks
is not allowed as the inks would contaminate each other on the blanket.

2. Trapping Distance

Enter the width you want to give your traps. The unit used is the General unit defined in Illustrator's Unit &
Display Performance Preferences. The default trap width is 0.2 mm (or equivalent in your chosen unit).

3. Minimum Ink Difference

Trapping is applied to two adjoining colors when:

• the two colors each consist of at least one ink but they have no common inks.
• the two colors have common inks but there is a difference of at least the Minimum Ink Difference percentage

for two or more inks making up these colors.
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These differences in ink percentages must be in opposite directions.

For example, with the default minimum ink difference percentage of 10%, the following two colors are trapped:

1st color: C 5% M 10% Y 50% K 15% (+10% K)

2nd color: C 5% M 10% Y 85% K 5% (+35% Y)

Increase the Minimum Ink Difference to trap colors that are more different, lower it to trap colors that are more
similar.

4. Image Trapping

• Automatic (default): this determines the most suitable trap direction automatically, by comparing the average
lightness of the CT image with the lightness of the adjoining area, then traps the lighter color into the darker
one.

• Always Towards Images: this always traps line art under adjoining CT images.
• Always Towards Line Art: this always traps CT images under adjoining line art.

5. Pull Back

An ink pull back keeps away all but the darkest ink of a color area composed of multiple inks that borders to a
very light background.

It prevents individual inks from the composed color to become visible on the background due to registration errors
during the printing process.

• Automatic (default): this creates pull backs on rich black or rich spot colors, when the color left in the pull
back area is not very different from the composed color.

• Only Pull Back Rick Black: this only creates pull backs on rich black.
• Do Not Pull Back: this never creates any pull back.

6. Advanced Settings

Expand the collapsible button to view the Advanced Settings.

1. If you want to use a different distance when trapping into black, spot colors, images or when creating pull
backs, enable the corresponding option and enter the trapping distance to use.

The unit used is the General unit defined in Illustrator's Unit & Display Performance Preferences.
2. Image Trapping

If you want images to be trapped with each other, enable Trap images to images.
3. Pull Back

If you chose to use Automatic pull back (see Pull Back), the Also pull back light inks option is available.
Enable it if you want to create pull backs even when the pullback ink (ink remaining in the pull back area) is
visibly different from the composed color. Enable Do not pull back images and gradients if you do not want
to create pull backs on images and gradients.

4. Overshoot Mode

You can choose between the following three overshoot modes:

• Automatic (default): The centerline behavior is according the rules determined in the color pair list.
• Never on Dark Areas: The centerline is forced not to get beyond the center of dark areas.
• Never: The centerline is forced not to get beyond the center of any area.

Color & Shapes

1. Trap Color Intensity

By default, PowerTrapper uses the full color of the object to spread in the trap (100% trap color intensity).

However, you can create a trap of a lighter color by reducing the trap color intensity percentage.
2. Image Trap Color
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Choose how to trap your images:

• Use Original Image Data (default): When spreading an image, PowerTrapper uses the underlying image
data (when the image is clipped) to create the trap.

Note:  When there is no underlying image data (the image is not clipped), it creates an empty trap.

• Extend Image Data: PowerTrapper automatically extrapolates the image along its top, right, bottom and left
edges to ensure that the trap looks as expected even if there is no clipped image data outside the visible image.

• Use an Approximate Flat Color: Instead of using existing or extrapolated image data in the trap,
PowerTrapper uses a solid color. A suitable color is determined by averaging the image's colors along its
boundary with the object to trap.

3. Truncate Traps

PowerTrapper can truncate the trap so that it does not stick out on another color. There are two truncation
modes:

• On Center (default): when a portion of a trap comes too close to the contour of another object,
PowerTrapper limits it to half the distance between the trapped object and the other object.

• On Edge: when a portion of a trap comes too close to the contour of another object, it is truncated on the other
object's edge.

4. End Caps

This option specifies how to shape the ends of an open trap.

• Square (default): this option ends the trap at right angle to the adjoining object.
• Round: this rounds the ends of the trap. This option is typically only used in combination with white knockout

(reverse trapping).

Note:  We recommend you not to use Round End Caps together with Truncate Traps On Center,
as this can generate some artefacts (the round caps are truncated).

• Object Dependent: with this option, the trap is a logical continuation of the contour of the spread object.
5. Trap Corners

This option allows you to change how the traps’ sharp corners are handled.

• Round (default): a round cap will be placed at all corners.
• Beveled: this cuts sharp corners off.
• Mitered: this option works with a miter ratio.

The miter ratio serves to limit the length of the sharp corner (the distance from the base of the trap to the
corner point).

The default miter ratio value is 4. This means that if the length of the sharp corner is more than 4 times the
Trapping Distance, then the corner are cut off (beveled). If it is less than 4 times the Trapping Distance, the
corner are left as it is.

6. Advanced Settings

Click the collapsible button to show the advanced settings.

Truncate Traps

If you want to truncate traps into black differently, select Into black and choose the truncation mode (On Center
or On Edge).

Processing

1. Color pairs

PowerTrapper can trap all hits (occurrences) of a color pair the same way or recalculate the trap direction for
different hits.
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• Each hit can have its own decision (default): this recalculates the trap direction for each hit of a color pair.
• Use the same decision for all hits: this traps all hits of the same color pair in the same direction.
• Use the same decision for objects smaller than: this uses the same trap direction for hits of a color pair

belonging to small objects, and recalculates the trap direction for hits belonging to bigger objects.

Use the field next to the option to determine the maximum size of small objects. The unit used is the General unit
defined in Illustrator's Unit & Display Performance Preferences.

The default size is 1 mm (or equivalent in your chosen unit).

Restrictions

In some cases PowerTrapper can safely ignore certain object types to speed up the trapping.

• Ignore existing trap layer: if your document has already been trapped, select this option to keep the existing
trap layer out of the trapping process.

• Ignore bitmaps: this keeps bitmap pixel data from being trapped. Bitmap data is contourized before trapping
which may slow down trapping depending on the bitmap's contents. Bitmaps with lots of small isolated islands
typically take a longer time to trap.

Note:  When you indicate an object type to ignore, it is ignored completely as if it did not exist in the
job. Also, the ignored objects does not truncate trapping areas resulting from other objects below them.

2. Small Gaps

Some input jobs contain very small unintentional gaps between neighboring objects, preventing the correct
trapping of these objects. Although it is better to clean up such jobs before trapping, PowerTrapper can ignore
these gaps automatically.

To use this option, select Close when smaller than and enter the maximum size small gaps can have.

The unit used is the General unit defined in Illustrator's Unit & Display Performance Preferences.

The default size is 0.01 mm (or equivalent in your chosen unit).

Note:  If you set a big gap size, trapping may become slower and small parts of the job may be ignored
during trapping.

Add Rule
Add Rule allows to define custom trapping settings for specific trapping pairs.

1. When to use rules:

In most cases the general trapping settings entered in the Trap dialog box gives you excellent results, but in some
cases you may need to refine them using rules.

Add Rule allows to specify exceptions to the general trapping settings for certain color pairs. They are an
advanced feature and should be used only by experienced users.

For example, you can use them in the cases below:

• To set a different trap distance for a specific spot ink.

Sometimes you need a larger trap distance for spot inks if there is no other ink to help cover leaks on the press.
• To prevent trapping or ink pull back in specific cases.

Depending on the type of the adjoining colors, trapping and / or pull back may be undesirable.
• To force a specific trap direction.

PowerTrapper Standalone determines the trap direction based on the relative lightness of the adjoining colors.
If the colors have a similar lightness level, it selects an arbitrary direction. You can use a rule to make it
always use a particular direction for a color pair.

• To specify a different shape and/ or truncation mode for certain color pairs.
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For example, you can choose to use “On Center” truncation when trapping under a 100% black line and “On
Edge” truncation on all other color pairs.

2. Creating a rule

• Click the Add Rule button at the bottom of the Trap dialog.
• In the pop-up that opens, choose the trapping pair to apply the rule to using the From and To lists. You can

create a rule to trap from/to: any color, a particular ink (process, spot or opaque), a particular object (image,
gradient or empty background) or the registration color.

Note:  When trapping a particular ink, you can choose the ink name from which Minimum Density
the rule is applied and if the color must be pure (no other separation in the color object) to apply the
rule.

• Choose the contents of the rule.

Options Description

Trapping Direction • Automatic lets PowerTrapper
Standalone calculate the trapping
direction.

• Force Trapping from ‘From’ to
‘To’ always spreads the “From”
color/object on the “To” color/
object.

• Do Not Trap ‘From’ to ‘To’ never
traps the “From” and “To” colors/
objects together.

Trapping Distance Use this to define a special trapping
distance for the trapping pair.

Trap Color Intensity Use this to define a special trap color
intensity for the trapping pair.

Pull Back • Automatic lets PowerTrapper
decide if there should be a pull back
on the trapping pair.

• Always Pull Back always creates a
pull back on the trapping pair. The
darkest ink of the pair is the pullback
ink (remaining ink in the pull back
area).

• Do Not Pull Back never creates a
pull back on the trapping pair.

Pull Back Distance Use this to define a special pull back
distance for the trapping pair.

Reverse • Automatic lets PowerTrapper
Standalone decide if the trapping
pair should have a reversed trap.

• Always Trap Reversed always
generates a reversed trap for the
trapping pair.

• Do Not Trap Reversed never
generates a reversed trap for the
trapping pair.
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Options Description

Truncate Traps Choose if traps generated for the
trapping pair should be truncated on
center or on edge.

End Caps Choose how to shape the ends of open
traps for the trapping pair (square, round
or object dependent).

Trap Corners Choose how to shape the trapping pair's
trap corners (round, beveled or mitered).

• If necessary, use the + button to add contents to your rule. You can use the - button to remove contents.
• After defining the rules, click OK button. You can now see your rule at the bottom of the Trap dialog box.

When trapping your document, PowerTrapper traps the trapping pairs that match rules according to those rules
and the rest of your document according to the main trapping settings. If necessary, you can add another rule or
remove a rule previously created. You can also edit a rule by double-clicking it in the Trap dialog box.

Print to File

The Print to File action converts the ArtPro native file format to a composite or separated EPS file, depending on the
Device Type that has been chosen.

Depending on the action list, the Print to File action can be simply followed by a Close File action, an FTP action, a
Copy File action or a Convert EPS to PS and a Send over PAP action. This depends on what device the file needs
to be printed to and how the device is physically connected to Automation Engine. This is described later in this
section.

Load Settings from XML

After using a Select File action to select an XML file, the settings from that XML file can be loaded in the Print to
File action, overwriting the existing settings.

General Concepts

1. Flattening

When creating a PS file, the ArtPro file is flattened if needed, as PS does not support blend modes, opacity, etc.
The settings of the Flattening Options are used.

2. Composite PostScript®

Composite PostScript means all information is calculated into a single page, unseparated PostScript file.

In a Composite file, placed EPS files are copied unmodified. This means that if you work with DCS for instance,
the placed low resolution is sent to the printer. Both TIFF files and ArtPro files are converted into PostScript at
full resolution (or any resolution defined by other print settings).

There are mainly 4 ways of generating PostScript for Printers/ Proofers.

1. Using DeviceN (Composite L3 Printer)

When outputting composite PostScript using the Level 3 DeviceN comments, a composite PostScript is
generated, containing all transparencies and spot colors. If this composite output is handled by a RIP, capable
of handling these level 3 commands, a correct output can be achieved. This option is preferred if the Proofer/
Printer can handle it.

Please note that composite output, even when using the DeviceN command does not include dotgain or
screening information.

2. DeviceN Off, Use Setcustomcolor OFF
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The complete job, if necessary, is flattened to remove all overprints and transparencies, and converts all
PANTONE™ colors into CMYK.

The result is a flattened CMYK composite PostScript file which can be sent to any color proofer.
3. DeviceN Off, Use Setcustomcolor ON

This creates a flattened file, flattening all CMYK overprints and blend modes.

The resulting PostScript file contains CMYK objects in combination with separation color objects. This
PostScript file still contains overprinted objects. Not every color Proofer can handle this.

4. Bitmap Proofer

This option forces to Rip the complete job into a CMYK image at a given resolution and generate a PS file
containing only the Ripped CMYK image.

3. Separated PostScript®

If you make a file with All Separations, a multipage PostScript file is created. Each page contains black and white
information describing the separation of one ink. So the file contains as many pages as there are inks in the ArtPro
file.

If you make a file per separation, a single page PostScript file is created containing the black and white
information of the film (ink) you asked for.

Placed art in separated output:

• EPS files containing CMYK, grays and custom colors are separated by ArtPro using separation code. Some
EPS files however, are not suited for this separation code. Therefore an alternative separation code is provided
(by switching on the Simple separation code option) for these situations. If you work with DCS files (or
DCS-2), ArtPro replaces the low resolution file by the high resolution separations.

• TIFF CMYK files are separated and converted into PS.
• ArtPro files are converted as normal, this means any picture in the file is expanded with high resolution.
• OPI: PostScript output of TIFF files always contain OPI comments (as specified in Aldus Open Prepress

Interface Specification 1.2 and 1.3). This makes it possible to work with low resolution images on the Mac and
in proofs (= unseparated output) and high resolution images on film (= separated output). Even if the TIFF file
type is not supported (not CMYK), OPI comments are generated.

Examples of TIFF files which are supported by OPI are RGB and palette TIFF files. These files can be placed
in ArtPro, can be seen on screen and make a color proofer output. However, separation cannot be made for
these TIFFs, unless you use OPI replacement.

4. Placed Files (S&R)

Placed PDF 1.3 files are converted to PS during output. Placed PDF 1.4 files cannot be converted to PostScript
Level 3 and generate an error Cannot convert PDF 1.4 into PostScript. Note that the distinction
between PDF 1.3 and 1.4 is not done on the header, but on the presence of PDF 1.4 functionality.

Device Type

1. Color Proofer

Color Proofer is the standard Composite PostScript output to send to PostScript proofing devices.
2. Color L3 Proofer

Color L3 Proofer generates composite output, using Level 3 commands such as DeviceN and shadings. This
results in composite output, containing all spot colors, overprints, etc. Screening and Dotgain Compensation is not
included.

3. Separated Proofer

Separated Proofer is a device to print separations on a color proofer, for example: a LaserWriter. Although it is
sent to a Proofer, the output is separated.

4. Bitmap Proofer
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This output, originally developed to be able to output overprints and transparencies, has become obsolete because
of the L3 commands. With the Bitmap Proofer output, the ArtPro file is RIPped into image data which is sent
to the proofer, preceded by a PostScript header and followed by a PostScript footer. The image data consists of
CMYK information. This output can get quite substantial, depending completely on the output resolution and the
file size.

In the RIP tab of More Settings, the desired resolution can defined. The ideal resolution is equal to the resolution
of the proofer device being used.

5. Custom proofer

Custom proofer is the output device for proofers with all More Settings available. Any device type actually has a
number of preset More Settings, of which some can be modified and others are grayed out. Custom Proofer has
the preset More Settings from Color Proofer, but all settings are available for modification.

6. Generic ImageSetter

This is the default device for the output of Separated PostScript, for a general type of imagesetter or platesetter.
7. Agfa

To generate output for an Agfa imagesetter, choose Agfa in the Device Type list. The type of PostScript generated
for Agfa is separated PostScript.

8. Barco RipScript

This device type generates separated PostScript, to be exposed through Barco RipScript.
9. Barco TransScript

This output generates EPS files which can be sent to an old Barco system, through Barco TransScript. Note that
these files are not standard EPS files and are not to be used in applications other than Barco TransScript. For more
information on how to output through Barco TransScript and the limitations of this method of output please refer
to the ArtPro manual.

10. Creo (Layout / Single Job)

These two devices make it possible to use OPI server functionality for Step & Repeat on Creo Servers. Whereby,
high resolution image data is stored on the server and a preview version is stored with the original file. At
output the server automatically replaces the preview version with the high resolution data, according to the OPI
comments contained in the Step & Repeat Print file. Printing will therefore be considerably faster, as network data
transfer between Automation Engine and the Creo server system is reduced to a minimum.

1. Procedure

a. Print the single job in the Print menu with the option Creo (Single Job) and send it through to the Creo
server.

b. Create the S&R file of the single original ArtPro job and save it.
c. Print the repetition file to Creo (Layout)

Besides the OPI possibilities, the Creo output contains DIG comments, allowing Print files from
Automation Engine to be used in the VPS, the Creo Virtual Proofing System. Therefore, even if the OPI
Step&Repeat is not used, Creo Layout should still be used to enable the VPS.

11. Crosfield

Crosfield output is based on Generic Imagesetter but fine-tuned to make the Crosfield OPI work. The setting
Include Gradations comments allows Crosfield to put gradations (converted to CTs) in the Lineart level (at high
resolution) and CTs in the CT level.

12. DCS-2 Single File / DCS-2 Multifile

The DCS-2 output creates a DCS file, a separated file format including all separations and a preview. With
Multifile, the result is as many files as there are separations and an additional preview file. For Single file,
separations as well as preview are contained in one single file.

The DCS files can be placed in other applications (example: page layout or imposition applications,...) or can
be used with OPI servers when printing Step & Repeat files or from imposition applications. Hereby, the high
resolution image data (DCS 2 file) is stored on an OPI server and a preview version, generated by the OPI system
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is stored with the original file. At output the OPI server automatically replaces the preview version with the high
resolution data, according to the OPI comments contained in the Step & Repeat file or the imposition file.

To print Step and Repeat files from one-up ArtPro files follow this procedure:

Save the single job in the Print menu with the option DCS-2 and send it through to the OPI server.

Create the Step and Repeat file of the single original ArtPro job, either in a step and repeat action list or manually
on an ArtPro front end station and save it.

Print the repetition file to Generic Imagesetter in the Print menu, with the option Replace Placed ArtPro by OPI
in the More Settings.

13. Delta Technology

This output device is only to be used for repetitions. For every group, a Delta list is created. In the case of S&R, a
delta list will be created for a single label. The next time the same Delta list is used, the RIP only has to place it,
resulting in a very high S&R optimization. To use this S&R optimization, the clipping box has to be a rectangle.
For S&R Tabular, this is no problem, but nested CFF2 repetition can cause troubles.

14. LinoType-Hell

LinoType-Hell output is based on Generic Imagesetter. This output supports the Automatic Page Positioning
feature from Linotype-Hell.

15. Optronics

The Optronics is the same as Generic Imagesetter output.
16. Nexus

This Device Type should be used when printing to NexusRIP workflows as it results in separated PostScript
optimized for NexusRIP. This device is used to print single documents (to a low resolution link file) as well as
S&R or imposition data with links.

17. Purup

Purup is based on the Generic Imagesetter output, but fine-tuned for use with the Purup OPI system, Imagelink,
which is based on low resolution DCS files.

18. Quark Separable EPS

To generate an EPS file that can be separated by Quark XPress® you can choose Quark Separable EPS as Device
Type. As this is a composite output, it has some serious limitations concerning transparencies. Therefore, DCS-2,
L3 Proofer or PDF Export is more advisable. For more information please refer to the ArtPro manual.

19. Scitex Separated / VIP / PCF

The best way to send to Scitex is using separated output, as composite output has too many limitations. The
only reason to use composite (VIP) output is for APR, Scitex OPI system on the VIP rips or if the files are to be
handled further on the Scitex systems.

To generate composite output for the Visionary™ Interpreter for PostScript® from Scitex, choose Scitex VIP in
the Device Type list.

Scitex VIP is a computer application which converts PostScript files into the Scitex formats. The Scitex VIP
output always makes PostScript output to a file, as it is not a real device but a computer application.

In some cases the VIP can be selected in the chooser, in other cases VIP has to be opened and the PostScript file
loaded into the VIP. This depends on the customers’ configuration. The type of PostScript generated for Scitex
VIP is composite PostScript. The composite output is then to be separated by the Scitex RIP. Please bare in mind
that composite PostScript is much more limited when it comes down to supporting transparencies, or not standard
ArtPro functionality like mapped pictures, etc.

Output to Scitex PCF is specifically meant to output step and repeat data to Scitex’s native format. For more
information on these device types, please refer to the ArtPro manual.

20. Screen

The Screen is the same as Generic Imagesetter output.
21. Think Laboratories
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A Generic Imagesetter output, fine-tuned for Think systems.
22. Custom ImageSetter

Custom ImageSetter is the output device for imagesetters with all More Settings available. Any device type
will actually have a number of preset More Settings, of which some can be modified and others are grayed out.
Custom ImageSetter has the preset More Settings from Generic ImageSetter, but all settings are available for
modification.

Other Settings

1. Paper Size

The Paper Size drop-down menu includes the different sizes. If a PPD needs to be assigned, it should be done
through the Convert EPS to PS action. from Mediabox always uses the Media Box. from Pagebox uses the
active (that is, the last selected) page box. If any objects are outside the selected page box, a warning is generated.
When choosing from Job (default), the active page box is used, enlarged if necessary to fit all objects.

Following sizes are included in the Paper Size menu:

• A4: 210 x 297 mm
• A3: 297 x 420 mm
• US Letter: 8.5 x 11 inch
• US Legal: 8.5 x 14 inch
• Tabloid: 11 x 17 inch
• Tabloid extra: 12 x 18 inch

2. Layout

For proofer output, choose between Center, Fit always, Fit Large Paper or Tile output. Center will position
the job centered on the paper size, taking into account the indicated Distortion for size. A distortion of 0% results
in a true size job output. If the job is bigger than the indicated paper size, it is clipped on the edges. Fit Always
enlarges or reduces, so that the ArtPro file matches the paper size. Fit Large Paper fits large format ArtPro jobs
to smaller paper sizes, without enlarging the job when the paper size is larger than the job size. Tile is used when
a job is larger than the paper size. It divides the job over several pages, with the indicated Tile Margin and Tile
Overlap. Define a Tile Margin if you do not want to use the complete paper size. The Tile Overlap indicates
how much of the tile edges are printed on the next page, as to create an overlap area.

3. Orientation

The Orientation can be set to Portrait, Turn right, Turn left or Upside down. It defines the direction in which
the file is put on film or on paper. Choosing portrait outputs the file in the upright position, turn right rotates the
file 90° and turn left rotates it -90°.

4. Mirror / Negative

When Mirror checkbox is selected, the job is mirrored before exposing, resulting in a wrong-reading output.
Negative allows outputting separations as negatives. Note that these settings are additional to the settings on the
RIP actions.

Example: a negative setting on Print to File and a negative setting on the Assemble a Screen Page Sub action
results in a positive output. The same is true for Mirror. Equally note that the imagesetter or platesetter device
can also have a negative and mirror setting.

5. Output

This allows to define the name of the output file, using the File Naming Template.
6. Title

The Title allows to define the title comment in the PostScript file. This comment can be extracted, example, in a
NexusRip workflow, to extract the job name instead of the PostScript file name.

7. Distortion

A document can be output with a vertical and/ or horizontal distortion. It is defined as a percentage of the jobs
original dimensions and is applied to the PostScript file.
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This distortion is specifically important for flexo jobs. On mounting a flexo plate on the press, it is stretched out in
one direction. By making the output slightly smaller than needed, we compensate for this distortion. The original
dimensions of the file remain unchanged.

Positive values make the job bigger and negative values make the job smaller. Example: When vertical distortion
is -2.35% it makes the output 97.65%. In this way you can also scale the proofer output: example, entering - 50%
for both vertical and horizontal distortion outputs the job at half of its original size.

8. Clip

If the job is bigger than the paper or the film, you may output in parts. If Clip is not active, the complete job is
printed or exposed and is thus clipped on the output when it is bigger than the paper size. When Clip is checked,
you can define the tile dimensions by clicking on the Rectangle... button. The tile indicated in the Rectangle
dialog will output.

9. Rectangle...

Clip Rectangle allows to define what part of the job should be printed.

1. Pagebox Clipping

When Pagebox Clipping is selected, the job size chosen under Use Box is used to clip the output. The
different boxes can be defined in the Job Size dialog box.

2. Manual Clipping

If Manual Clipping is selected, the size and position of the part to be printed can be set manually. In the
Vertical and Horizontal field, the size of the rectangle to be printed can be entered. If the Lock to Ruler
option is selected, the rectangle to be printed moves along when moving the ruler (see Move Ruler action).

3. Automatic Clipping

If Automatic Clipping is selected, the size and position of the part to be printed is defined by the job size and
the settings of the Divide and Print Part fields.

Divide: in the Divide field, enter how many parts the job should be split up, for both vertical and horizontal.

Print Part: in the Print Part field, define which part of the job should be printed.
10. Marks

Besides the Cut marks, other objects like registration marks as well as job and separation identification can be
added to the file through Generate mark.

11. Separations

The Separations menu has a dual function, to define which separations have to be output and to define how
separations need to be mapped to other separations. By default the window is blank and the Search Unused
Separations option is selected. This means that the system checks which separations are in the document and
output separations which are not empty. When there are non-mapped pictures in the file though, all separations are
output. The Separations window contains two areas, the Separation Mappings area and the Exclude area.

1. Separation Mappings

To add an entry to the Separation Mappings list, click the + button and enter the separation name in the
From field. By entering the To separation, you can remap the separation to another plate. Note that it is
equally possible to enter “CMYK”, which allows to convert a separation to CMYK on output without actually
modifying the document itself.

The Print icon can be toggled on or off by clicking the Print button.

An example on the use of the Separations dialog box, is in a double burn action list, where there are three
different black separations in the file: English Black, Spanish Black, and Graphics Black. In this case, the
Graphics Black should be mapped to the English Black as well as to the Spanish Black, hence they are merged.
Seven separations are output into six plates.

2. Notes on separation mapping

Mapping of output separations is fully supported for all paint styles. Even placed ArtPro jobs can be merged.
Example: for a layout, containing two ArtPro jobs, each with a different spot color, both separations can be
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merged during output. This is even possible if the jobs contain TIFFs. This is because no merging is done
within the placed ArtPro jobs. Note however that remapping is only available for Separated outputs!

Separating placed EPS- and PDF-files takes into account overprints, PS3 and PDF1.3 vignettes (Illustrator 8
and 9) and Photoshop duotones.

3. Screening for mapped separation

When you have a step & repeat file containing multiple jobs and you want to map separation X from job
A into separation Y from job B, separation X will still be output with its own screening settings as long as
this job (A) does not contain separation Y. When job A contains separation X as well as separation Y, the
screening which will be used to output the mapped separation X into Y will be separation Y.

4. Exclude Separations

This option can be used to exclude separations from the output. By clicking the Options button, the Output
Separations dialog box is opened. By Adding a separation (click the + button and define its name. Wildcards
can be used), you can exclude this separation for this. By selecting an entry in the list and clicking the - button,
you can remove it from the list.

5. Search Unused Separations

The Search Unused Separations setting excludes separations that are not used. It only turns separations
off, separations excluded earlier are not removed from the Exclude list, even if they are in use. The Search
Unused Separations option does not take registration color into account.

12. Dot Gain Compensation

The Dot Gain Compensation button defines if the dot gain curve(s) selected in the Dot Gain File... menu (see
below), has to be calculated on the PostScript output. With this option off, all curves are ignored for output. Dot
Gain Compensation is only available on separated output.

13. Dot Gain File ...

The Dot Gain File ... button allows you to select a Dot Gain File. The file name of the selected Dot Gain file is
shown on the right side of the button. If a Dot Gain File is selected in the Print menu, this Dot Gain File overrides
all Dot Gain settings in the Screening dialog (example: an opened ArtPro file). The exception is a placed EPS that
contains a dot gain compensation, in which case both curves are used. A selected file can be removed by clicking
the Dot Gain File button while holding down the SHIFT key. Dotgain files are generated in and saved from the
screening dialog. (please refer to ArtPro manual for more details).

14. Color Management

If a color management profile has been defined at the time of importing or opening a file in the action list, it is
possible to override the settings for output (example: color profiles for proofers or for separated output) in this
menu.

15. Flattening Options

When creating a PS file, the ArtPro file is flattened, as PS does not support blend modes, opacity, etc. The settings
of the Flattening Options are used.

16. File & Fonts Settings

The File & Font Settings allows to define root folders, folder mapping and fonts folders, similar to the Open
ArtPro File action (please refer to this action for a full description). This functionality has been made available
in case ArtPro files have been placed in an open job during the action list, to allow for the retrieval of the linked
images or used fonts at the time of printing.

More Settings

In this dialog a whole list of Print Settings are available. Depending on the active Device Type the settings are
defined automatically, whereby some are checked by default. For some devices, some settings are not accessible
(gray) and others can be (de)activated. For Custom Proofer and Custom Imagesetter all the options are available
so as to allow specific customized output. The More Settings are divided up in seven categories: Page, Separations,
Paints, Text, Optimize, RIP and Preview. For more information, please refer to the ArtPro reference manual.

1. Page
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These settings are related to the type of file of the EPS (PS) file that is generated by the Print to File action
(composite versus separated,...), and the comments in the header. Changing these settings may in some specific
cases be necessary to have a receiving application or printer recognize the file or to have the correct type of file
generated.

2. Separations

These settings determine how separations and page commands are defined in the file. Depending on the Device
Type that has been selected in the main Print to File dialog box, these settings are correctly defined by default.
Only in specific cases should changes be made.

3. Paints

These settings are related to how colors and overprints are defined in the file and how gradations and images are
handled. The system supports applying image averaging at the time of downsampling. This results in better image
quality when downsampling has been applied, but slows down the generation of the PS output.

4. Text

These settings determine how text is handled in the file. Settings can be made to vectorise text or to embed fonts.
5. Optimize

These settings determine how the PostScript needs to be optimized and how OPI comments need to be handled
in the file, including the use of OPI comments for placed ArtPro files, allowing for a productive Step and Repeat
solution (example: with the Creo Layout device).

The PS Optimize settings include the ability to split long paths (important for output to PS Level 1 RIPs or for
RIPS with limits to the amount of points on a path due to insufficient memory) and the use of picture caching
which improves output speed when images need to be put into the output multiple times (example: when image
trapping has been applied).

6. RIP

These settings allow for specifying special comments needed to output PostScript to a RIP system, including the
NexusRIP. Note that the ArtPro Action List Editor has the ability to add an XML job ticket (Write Job Ticket) to
the PS file, that contains specific information about the job, including the job size, separations, screening used,
etc. This job ticket is then read by NexusRIP and put into the link file when a link file is generated. This allow
ArtPro to display all the information about a specific job (the job ticket) when this link file is placed (example: a
step and repeat file). For more information and an example please refer to the ArtPro manual.

7. Preview

These settings determine the type of preview that is generated (if any) and if a mask needs to be generated in the
preview (example: to support transparent views for clipping paths). Some receiving systems may not support this
preview mask. In these cases the mask can then be switched off, but the file is still output correctly.

PrintCheck

The Printcheck option allows to create an image of the complete job. Besides the resolution, the noise for gradation
can be set. The compression allows to choose between tiff and jpeg, with 3 possibilities on compression : High
compression, Medium compression or High Quality. The file can be exported as a Tiff/JPEG or an EPS. The Box
drop-down menu allows to define what border has to define the boundaries of the image to be created.

Regmarks

The Regmarks action allows to use personalized marks.

The idea is to create one ArtPro file with the marks you need based on a blank document. The job size is not relevant
for applying the registration marks.

When using this selected ArtPro file with this action, the marks will automatically adapt to the job size of the current
document while the inks will equally be adapted.

There are two ways of selecting a Regmarks file: either select a fixed file by using the Select File button in the action,
or select a variable Regmarks file by using the Select File action.
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For a description of how to build a registration mark file in ArtPro we refer to "Import marks" in the ArtPro manual.

With the Box menu, define on what page box the regmarks need to be applied or to use the bounding box of the
selection.

With the Merge Layers function, you can define that layers with the same name in the Regmark file and in the open
file, should be merged together.

Reorder Layers

The Reorder Layers action allows to change the order of layers.

Layers with a name that match one of the entries are placed in the specified order. Other layers are placed underneath
in their original order.

Entries in the list can be added and removed using the Add and Remove buttons. An entry can contain a wildcard (*).

If two different layers match the same entry, their relative order depends on the original order.

If a layer name matches different entries, the best matching is chosen. Example: a layer name Trap layer matches
more with “Trap*” than with “*”.

Reorder Separations

Reorder Separations allows to change the order of the separations in the Separations list.

Separations with a name that match one of the entries are placed in the specified order. Other separations are placed
underneath in their original order.

Entries in the list can be added and removed using the + and - buttons.

An entry can contain wildcards (*). If a separation matches two different entries, it is placed at the topmost position.
If two different separations match the same entry, their relative order depends on the original order.

There is an option to reverse the separation order. This option can be used for some special printing procoesses like
dry offset. When reverse is enabled, separation reorder cannot be done.

Save ArtPro File

This action saves the currently processed file to an ArtPro file on disk.

Output
The Template allows to set the name of the file to be saved.

Compatibility
The Compatibility allows to choose to save the document as ArtPro 9.x/8.x or as ArtPro 7.5 / 7.0 / 6.5 file or as
ArtPro 6.0 file. An ArtPro document saved in an earlier file format does not contain version specific information.
Example: an 8.0 document saved as ArtPro 7.5 document will not contain blend modes. The file is flattened before
saving.

Include Preview
When With Preview is checked, a (separated) preview is included in the ArtPro file. The Resolution field allows to
define the resolution (in ppi) for this preview. Default is 72 ppi.

When the preview is added to the file, it is shown in the Job Editor, if the Thumbnail option is enabled. in the
Preferences.

Save Hidden Layers
This option defines whether layers with a “Hidden” state should be included in the saved file or not. See also the
Layers related actions.
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Profiles
Embed entire profile in ArtPro files allows to include the used Color Management profile in the ArtPro file. This
can be useful when moving files to another system. The option Don't embed profiles for imported pictures with
embedded profiles disables embedding profiles already embedded in the pictures.

Flattener Options
When saving as ArtPro 7.5 file, the ArtPro file is flattened. The settings of the Flattening Options are used.

Certified PDF sessions information
The option Include Certified PDF information allows to define if Certified PDF information should be included in
the ArtPro file. If the option is checked, the information is included in the file, even when saving as ArtPro 7.5 file. If
that file is open in ArtPro 7.5, that information is ignored. If the option Save Certified PDF Information is selected,
the Certified PDF information is saved in a separate XML document. The File Naming Template is used to define its
name and location.

Flattener Template
If the Flattener needs to save images, the name of these images are defined by the File Naming Template next to the
Flattener Options.

Select File

Automation Engine is capable of working with hot folders that can accept files, as well as hot folders which can
accept folders. When a folder is submitted to a hot folder, this action determines which file(s) from the folder is
selected for processing. It can also be used to filter on a list of files which should be used as input to the following
action. The Select File contains several items for selecting a file for further processing.

Select Options
The Select Options show the criteria used. A line can be added using the + button or removed using the - button.
When a criteria is selected, its settings are shown in the Select Item Options. The available settings depend on the
Select mode (By Name, By File Type,... see below).

Select By Name

1. Whose Name

The system selects a file based on the name of the file. The parameters are: is anything, starts with, “ends with”,
“contains”, “does not contain”, “does not start with” and “does not end with”.

The Edit Template button allows to use the File Naming Template. It is also possible to use Regular
Expressions.

2. Position From 0 To 500

The Position From... To... fields work in combination with the Whose name contains... option. Using the
position fields, you can point out what character positions of the file name is checked. When setting Whose name
contains as “APR” from position 2 to 4, files which have APR on character position 2 to 4 are searched. As the
first character is position 0, the 3rd, 4th and 5th characters are searched.

Select By Documenttype

1. File Type

You can use this to select an ArtPro, PDF or PS file which matches the other criteria.
2. Number of Separations

The Number of Separations can be set to Equals, More than or Less than.
3. Number of Pages

The Number of Pages can be set to Equals, More than or Less than.
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4. Page Box

The selection can be set for the selected page box to be within the entered values.
5. Orientation

The orientation criteria can be set to All, Portrait or Landscape.

Select Objects

Select Objects allows to select/ deselect objects.

First
The radio buttons define what to do prior to the selection.

Do nothing means leaving the selection as is. This can be useful to combine multiple Select Objects actions.

Invert Selections inverts the selection prior to applying the select action.

Select All or Deselect All allows to start from scratch with either everything selected or everything deselected.

Paint Style

1. Flat Paints

Allows to Select/ Deselect Flat Paints. This can be used in combination with the Matching option (see below).
2. Gradations

Allows to Select/ Deselect Gradations, either Linear, Circular or Multistep gradations. This can be used in
combination with the Matching option (see below).

3. Matching

Using the Matching option in the Paint Style tab, it is possible to select objects with a Flat Paints or a
Gradation within the defined percentage range. The separation names can contain wildcards. The Overprint
column allows to select objects that are transparent for that specific separation.

4. Pictures

Allows to Select/ Deselect Pictures, either placed, mapped or Patterns.
5. Images Type

Selects all placed files of the file type defined by the menu: TIFF, ArtPro files, EPS, TIFF, TIFF/IT or PDF.
6. Images Color

Selects all images in the file based on the setting of the dropdown menu. Choices are: CMYK, RGB, grayscale, B/
W (Black and white one bit images) or All.

Transparency

1. Blend Mode

Selects all objects with a certain Blend Mode. By setting the dropdown menu to All, you can select all objects
containing any Blend Mode.

2. Opacity

Allows to select all objects with an opacity higher (At Least), lower (At Most) or Equal to the value entered.
3. Opacity Masks

Selects all objects containing a Soft Mask.
4. Objects/ Groups with Transparency

Selects all objects or groups containing any transparency.
5. Overprint

Selects all objects containing overprint.
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Objects

1. Text

To select all text, or text smaller or bigger than the entered pointsize.
2. Vectorized Text

To select vectorized text. Text that was converted to outlines using the Text to paths action or during import is
remembered.

3. Font Name

Selects all text items or text blocks containing the font entered in the input field. A text item containing more than
one font, is selected completely if the entered font is used.

4. Screen Name

Selects all items using the screen settings entered in the input field.
5. Object Name

This helps to select objects with that name ( eg. a layer from an imported MFG file which imported as a sub-layer
in ArtPro.)

6. Strokes

To select all strokes or those smaller or bigger than the entered value.
7. Traps

Selects all traps created by Automatic Trapping. A trap that has been edited is longer be recognized as a trap and
thus not be selected.

8. Barcodes

Selects all Barcodes containing bar code information. With some transforms (example: unproportional scaling),
an invalid barcode is created. A warning is given when transforming and the bar code is longer selected with this
function.

9. Thin Part Fixes

Select the thin part fixes done in ArtPro.
10. Slices

Selects all slices (used for Grid Warping).
11. Open Paths

Selects all paths that are open.
12. Blends

Selects all blends.
13. Link

To select all objects containing a link for ArtLink.
14. Objects Inside / Outside bounding box

In the Objects tab you can define to select or deselect objects inside or outside a defined pagebox.
15. Layers

This allows to select or deselect objects that are in a Layer that matches (or does not match) the entered name.
The layer name can contain wildcards.

Selections

The radio buttons at the bottom define whether the defined objects should be selected or deselected.

Using Within Selections in combination with Select searches for objects that match the defined criteria inside the
current selection. Objects that do not match these criteria are deselected.
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Using Within Selections in combination with Deselect, deselects the objects inside the selection that match the
defined criteria. Objects that do not match these criteria remain selected.

The Fail if Number of Selections... option allows to have the action fail if the number of selections is higher than,
lower than or equal to the entered value. This can be used to have the action fail if any text is smaller than 7 pt, for
example.

Separate

This action separates the file or repetitions into its separations. The separations are placed under and next to each
other in a single ArtPro file. You can define the Vertical Gap and Horizontal Gap to be left in between the
separations and the number of columns to be used (that is, the number of separations to be placed next to each other).
In order to print a “separated” file like this, the option All Separated Pages on Same Film should be selected, in the
More Settings of the Print to File action.

Set Station Numbers

The Set Station Numbers action is based on the Station Number part of the Step And Repeat Nested action. It
allows to set station numbers on an existing step and repeat file. For more information on Station Numbers, we refer
to the ArtPro manual.

It is possible to define the origin for the Offset, using the square buttons. By default, this is set to place the Station
Numbers centered on the bounding box of a station.

The File Naming Template can be used to define the text of the Station Numbers to be added.

Spread

This action allows to apply a spread on all objects or on the selection. The action is based on the Interactive
Trapping function in ArtPro. For a more elaborate description, we refer to the ArtPro documentation.

When a Spread is applied on an object:

1. The paint style of the original object is changed to 0% for every separation.
2. A slightly larger Spread object is generated.
3. The Spread object gets the paint style of the original object, BUT changed to “trans” for every separation that had

a 0% value.
4. If the original object had a blend mode, the original and spread object are grouped and the blend mode is applied

on the group.

Tabular Step and Repeat

The Tabular Step and Repeat action gives access to ArtPro’s tabular step and repeat module from within the ArtPro
Action List Editor. For a full description we therefore refer to the ArtPro manual.

This action can be used to Step and Repeat not only ArtPro files but also TIFF files, EPS files, DCS files and PDF
files. Hence any of these file formats could be handled by an action list that starts with a Tabular Step and Repeat
action.

Equally, the Tabular Step and Repeat action could be preceded by a Select File action which would select a file
from a folder.

This would typically be the case, when an ArtPro file and a Regmarks file are bundled in a folder for Tabular Step
and Repeat. The Select File action would then select the ArtPro file (or any other of the supported formats) that
needs to be stepped, and be followed by a Select File action to select the Regmarks (ArtPro) file that needs to be
used to generate the register marks.

The first drop-down menu, Use Box, allows to determine which page box (example: media box, bleed box, trim box,
etc.) needs to be used as reference for the Step distance. For example: if the Trim box is selected, the step distance
horizontally and vertically is based on the size of the Trim box (unless Freeze Step is selected).
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Step and Repeat Settings

1. Count

Amount of instances of the file, horizontally and vertically.
2. Begin Pos.

Horizontal and vertical offset to the ruler position for the first instance of the document to be stepped.
3. Step

Only when in combination with the Freeze Step option, this fields determine the offset between the steps. When
left (0,0), the step distance is actually based on the selected pagebox (in the example: the Trim box) of the file that
is stepped.

4. Angle Setting

The Angle setting determines the rotation of the file to be stepped.
5. Cut Marks

The Cut Marks option adds cut marks for any of the stepped instances.
6. Keep Bleeds

Includes the bleed of the stepped file in the step and repeat document. Bleeds are always kept outside of the step
and repeat job size. Note that bleeds overlap when the step distance is set to the Trim box.

7. Place Single-Separation ArtPro File in Single Sep

This option defines how to handle repeating ArtPro files with only one separation. If the option is not selected,
objects in this AP file with 100% of the single separation are considered to be registration color and thus get 100%
of every ink in the repetition. If this option is selected, the file is inserted in one single separation instead.

8. File & Font Settings

This gives access to the root folders, folder mapping and fonts folders when the file to be stepped is an ArtPro file.
For a description of this function, please refer to the Open ArtPro File action.

a. Color Management Settings

This setting determines if color management has to be applied for the step and repeat job. When enabling color
management, it is possible to select a color management settings file, previously saved by ArtPro. This file
contains all ICC profiles and settings to determine how color has to be treated throughout the rest of the action
list (example: proofing of the step and repeat document), including ICC profiles for proofing, printing, etc.

Text to Paths

This action automatically converts all text or the selected text to outlines. Note that when importing PS or PDF files,
text could already have been converted to outlines if the Convert to Real Text option has not been set during the
Importing action. This is especially useful when ArtPro files are used and files need to be exported to environments
where the fonts are not available.

Transform

This action applies a transformation to objects in the document. The transformation is done either to all objects or to
the selected objects only (see Selector).

Following transformations can be executed:

• Move horizontally and vertically
• Scale horizontally and vertically
• Rotate
• Shear

Options

1. Repeat
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The repetition field allows to execute the transformation multiple times.
2. Copy

The Copy option copies the contents of the file before executing the transformation. If at the same time repetition
is set there will equally be multiple copies.

3. Apply on

a. Path, Paint and Soft Mask

The Path, Paint and Soft Mask options determine if the objects and their contents are transformed or only the
contents without the objects or the objects without the contents. Suppose a clipping path with an image would
be transformed and Path is not checked, then only the image itself is transformed and not the clip path.

b. Notes

Transforms the notes along with the rest of the file, so that the positioning of the notes inside the file remains
the same.

c. Center Paint

The Center Paint option is only available if the Apply on: Paint and Soft Mask is off. It transforms the path
only, but then reposition the paint based on the center point of the path: the point in the paint that was on the
center point of the original path is placed on the center point of the transformed path. For example: this can
be used when scaling or distorting Step and Repeat files, without scaling the contents of the paths, but still
retaining their position inside the paths.

4. Scale Strokes

If the Scale Strokes option is unchecked, the stroke width does not change when scaling. If the option is checked,
the stroke remains a stroke and its width is changed for the same percentage as the parent path was scaled.
Thus, scaling an object with a 3 mm stroke to 150%, results in an object with a 4.5 mm stroke. When scaling is
unproportional, the stroke width is scaled by the geometric mean of vertical and horizontal scaling. This means
the stroke is scaled proportionally. The geometric mean is the square root of the product of vertical and horizontal
scaling.

5. Use Ruler

For scaling and rotating, the Use Ruler option defines to use the center of the ruler as the center for rotation and
scaling. If the option is unchecked, the center of the selected objects is used.

Trim & Bleed

This function calculate trim and bleed for all objects in the file.

The action is typically when performing in Step and Repeat and has been described in the Nested Step and Repeat
section.

Update ArtLink

The Update ArtLink action is comparable to the ArtLink action. All of its settings can be found in the ArtLink
dialog box.

While the ArtLink action creates as many versions as there are records in the database, the Update Artlink action
does not create any files or versions. It modifies the open ArtLink file using the information from one specific
database record (defined in the Record Number field) or from information included in the XML file.

Additional Key Values

The Additional Key Values allow to define keys to be used in the File Naming Template when updating the file.
These keys are defined from the action list rather than coming from the database. For example: this can be useful to
set the name of the operator.
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Vector Trapping

This action gives access to ArtPro’s PowerTrapper module from within the ArtPro Action List Editor and performs
the trapping on all elements in the file.

For a full description of all the different settings we refer to the Automatic Trapping section in the ArtPro manual.

Since this action actually generates additional objects containing the trapping information it is possible to view and
edit the traps in ArtPro or to export them to PDF or composite PS.

1. Remove traps first

If the Remove traps first checkbox is selected, all existing traps are removed before trapping is calculated. The
selection of the original objects is kept, allowing to immediately trap the same selection again with different
parameters.

2. Trapper Version

The Version defines what trapping routine has to be used. Version 1 (Packaging) starts to trap in the background
and works its way to the front, while version 2 (Commercial) starts in the front and works towards the back.
This second routine should be faster in general, though version 1 might give more consistent results, as it has a
longer development history. Therefore we recommend to use version 1 for packaging and labels and version 2 for
commercial work.

4stage Trapper uses a totally different kind of procedure. Unlike Version 1 and 2, it does not work object based
and only calculates traps for where different colors actually meet.

The 4stage Trapper is the only good way to trap objects containing transparencies. The traps made by the 4stage
trapper are defined using transparencies as well.

Distance

1. Into Color

Defines the spread distance for trapping colors under colors. When you enter a value for Into Color, it is
automatically copied for Into Black as well.

2. Into Black

Defines the spread distance for trapping colors under black. If Into Black needs a different value than Into Color,
enter Into Color first and then Into Black because by default the value from the first field is copied into the
second. Sometimes you may want a bigger spread under the black color, example, for a centerspread. To create
a centerspread (center trapping in black, example, for comic strip drawings), the spread value should be set to
slightly more than half the width of the thickest black line. When the spread value is higher than half of the black
line width, in the middle, where the spreads meet from both sides, the spreads is limited to the center and does not
overlap.

3. Into CT

Defines the spread distance for trapping colors to pictures. For Version 1 and Version 2, the color type can be flat
color or linear gradation. Multistep gradations and other pictures are not trapped automatically. The 4stage trapper
can trap anything.

4. Center Error

These fields specify the accuracy for the centerspread (see example on the right). When Off option is selected
for Center Error means no centerspread is calculated. The percentages, together with the distance, define the
precision for center trapping. The lower the percentage, the more precise. Example: with a trapping distance of
0.5 mm and 8% accuracy, the trap centerline is at a maximum distance of 0.04 mm off the real centerline. Keep
in mind that increasing the accuracy increases the trapping time! Also note that a smaller trap distance results in
more accurate centerspreads, so do not set the distance higher than necessary. The accuracy cannot be different
for normal colors and for black for the 4Stage trapper or if the trapping distances are equal. This means that if the
black trap distance is changed to equal the normal trap distance, the accuracy is automatically set to the one for the
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normal colors. General settings are 8% for normal colors and black. If you have a job where centerspread under
black is important, put the accuracy to 2%, 1% or even 0.5%.

5. Corners/ Miter

This field defines the trap corners, which can be mitered, rounded, bevel or square. The miter limit can be set to a
maximum of 4.

Direction

1. Separation Threshold

It indicates the minimum difference that must exist between touching colors before they are trapped. There must
be a difference more than the Separation Treshold in at least one separation in each direction. The usage for the
different versions is described below.

2. Black Margin

The Black Margin defines what colors are treated as black. From what percentage should an object be trapped
with the distance Into Black and from what percentage Into Color. The default value is 85%, meaning a box of
100% yellow is spread into a box of 90% black with the distance of Into Black. If the black in this example was
only 80%, it would trap at the distance for Into Color. It actually does not just apply for black but in general for
all dark colors. If the black value in color on proofer multiplied with the percent value in paint style is higher than
the black margin, the distance into black is used.

3. Trap Intensity

The Intensity, by default 100%, defines the "intensity" of the trap and can be adjusted according to the needs.
When a job is trapped, the traps should be as inconspicuous as possible. With a lower intensity, the traps become
lighter and so less visible. But keep in mind that if the intensity is too low, the trapping will not be correct.

4. Keep Away Rich Black

A rich black is a black element, to which another color was added, to make it look darker. Usually, a tint of cyan
is added to the black, but this could be done with any separation, cmy or spot. The idea is to make 100% black
look darker on print, as black, like other inks, is a transparent ink, which sometimes looks more like a dark gray
than black.

If the Keep Away Rich Black option is on, a rich black area is trapped so that the supporting color is kept away
from the edge of the black, on white as well as on color. This means that on a white element, a trap line is created
with only black and no supporting color.

5. Split Gradations

Vignettes are by default spread or choked as one object, that is either completely spread or completely choked.
In theory, though, this trapping is not always correct. A gradient could be darker than the background at one end
(choke) and lighter at the other (spread).

This option makes it possible to partially spread and choke one vignette. When it is active, the calculation of the
automatic traps divide the vignette path into several parts depending on the colors. On the basis of the light-dark
principle the different parts are then spread or choked. Hence, some parts of the same vignette can spread to the
outside whereas other parts can choke to the inside.

6. Gradation Mode

When set to Step into Gradations, the program decides on the trap direction according to the light-dark principle.
When set to Always towards Flat, gradient is always forced to spread into flat colored backgrounds, even if this
background is lighter.

This option is not applied for multistep gradations. Forcing a multistep gradient into a flat color has to be done
manually. The 4state Trapper always uses Step into Gradations.

7. Trap Images / All Separations (Packaging and Commercial only)

In order to trap mapped pictures automatically, enter a distance for Into CT and activate the Trap Images option.
By default it is switched off so that selected pictures are ignored during autotrapping.
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Using Version 1 & 2, mapped pictures trap with flat colors or linear gradations, not with multistep gradations or
other pictures. The autotrap result is a mapped picture with a minimum value added for the underlying colors or a
gradient transparent on top of the picture.

When all separations are active (default), it traps all the separations of the color, whether they are in the picture or
not. When the option is not active, the image is only trapped into separations that are not in it.

For example, a cmyk image is put on top of a cyan background and a pantone 032. With the option unchecked, it
only traps into the pantone 032. With the option checked, it traps in both. By default, all colors are spread in the
image and black is choked. This can be adjusted using the Black Margin (see earlier). The 4stage Trapper always
traps All Separations.

8. Image to Image (4stage Trapper only)

Using the 4stage Trapper, images are always trapped towards lineart. If the Image to Image option is checked,
images are also trapped towards images.

9. Image Mode (4stage Trapper only)

When set to Step into Image, the program decides on the trap direction according to the light-dark principle.
When set to Always towards images, the background is always forced to spread into the image, even if this
image is lighter.

10. Trapping Pairs

The Trapping Pairs button opens the dialog that holds the actual trapping pairs. A trapping pair is represented by
a From color, a To color and a Mix color. The From and To are the original colors, whereas the From is spread
into the To color. The Mix is the color of the actual trap.
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The RunList Editor

The RunList Editor enables you to create and modify RunLists.

A RunList is a file used to collect several files into one job folder, or to make one final PDF out of several smaller
PDFs (e.g. for imposition). It contains the names of the files to be collected or joined, their collecting / joining order
and their original location.

You can use this for example with the Wait for Files (via JDF) task. If you want to collect a number of files with
different file names, you can create a RunList referencing those files, and feed that RunList to the Wait for Files (via
JDF) task.

Setting Up the RunList Editor

1. Install the RunList Editor on your client machine (where the Pilot is installed):

• On PC:

1. Open an Explorer window and type the following in the address bar: \\Automation Engine
Server Name\Automation Engine 10.1 Windows Client (where Automation Engine
Server Name is the name or IP address of your Automation Engine server).

2. Copy Automation Engine RunList Editor 10.1.0.exe on your client machine.
3. Double-click the exe file to install the application.

• On Mac:

1. In Finder, go to  Go > Connect to Server...  (or use Command + K).
2. In the Server Address field of the Connect to Server dialog, type smb://Automation Engine

Server Name/Automation Engine 10.1 Mac Client (where Automation Engine
Server Name is the name or IP address of your Automation Engine server).

3. Copy Automation Engine RunList Editor 10.1.0.dmg on your client machine.
4. Double-click the dmg file to install the application.

2.

Double-click the RunList Editor shortcut  on your desktop to open the RunList Editor application.

3. Go to  Edit > Preferences  (on PC) or  RunList Editor > Preferences  (on Mac) to open the Preferences
window.

4. Connect the RunList Editor to your Automation Engine server:

a)
In the Servers tab, click the  button at the bottom of the Servers list.
In the pop-up that opens:
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b) enter the User Name and Password you use to login to the Pilot,
c) select Manual in the Browse Method list,
d) enter your server’s name or IP address in Server Address,
e) fill in the Server Port used by your server.

This is the port you defined in Configure for Shuttle communication (see Automation Engine Setup for
Shuttle).

f) Click the Add button.

This adds a connection to your server in the Servers list. You should see a green dot if the connection was
successful.

5. In the Units tab, choose the units to use when submitting to a workflow that has public parameters:

a) Choose to define the Distance in Millimeter, Point or Inch.
b) Choose to define the Resolution in Pixels Per Millimeter or Pixels Per Inch.
c) Choose to define the Screen Ruling in Lines Per Millimeter or Lines Per Inch.

Creating a RunList

1. Go to  File > New  to create a RunList.

You can also use Ctrl + N (on PC) or Command + N (on Mac).

This opens the following dialog:
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2. Add files to the RunList:

a) Click the Add Pages button in the toolbar.
b) In the pop-up that opens, use the Browse... button to browse to your file.
c) Define which of the file’s pages you want to add to the RunList (for example, if you want to add the pages 1,

2, 3 and 7, enter 1-3, 7 in Page range).

 

 

Note:  By default, the From 1 to ... option is selected, selecting all pages.

d) Click OK.

This creates an entry for every file you add.
 

 

You can see the RunList’s total number of pages at the bottom of the dialog.

Note:

You can also drag and drop one or several file(s) into the dialog to add them to the RunList.

By default, this adds all of the files’ pages, but you can double-click an entry to edit it.

3. If necessary, click the Add Blank Page button in the toolbar to add blank pages to the RunList.

4. You can also add a placeholder for a file that is not available yet:

a) Click the Add Pages button.
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b) Type the file name in the pop-up’s File Name field.
c) Click OK.

The RunList dialog will show an orange “?” icon, to indicate that you still have to provide a link to the file.
 

 

Tip:

• You can also create placeholders for several files that are not yet available. See Adding a Number of
Placeholders on page .

• You can use Undo (Ctrl + Z on PC or Command + Z on Mac) or Redo (Ctrl + Shift + Z on PC or
Shift + Command + Z on Mac) when creating or editing a RunList.

• To delete a RunList entry, select it and press Delete (on PC) or Command + BackSpace / Delete (on
Mac).

You can use Ctrl + A / Command + A first to select all entries for deletion.

5. When you are done, go to  File > Save  (or use Ctrl + S on PC or Command + S on Mac) and give your RunList
a name.

RunLists are saved in the JDF format.

Adding a Number of Placeholders

To create placeholders for several files that are not yet available:

1. Go to  RunList > Auto Add...

This opens the Auto Add Name Format dialog.

2. In Number of Pages, enter the number of placeholder entries to create.

3. Use the Prefix Text, Number Format and Suffix Text fields to define the name to give to the placeholders.

The Number Format specifies the number of digits to use in the file name.

For example, this format:
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generates the entries below:

 

 

While this format:

 

 

generates those entries:
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Viewing the RunList Files

Context for the current task

•

To view the pages grouped by file, click  and select RunList (on PC), or click  (on Mac).
 

 
•

To view each page individually, click  and select Page List (on PC), or click  (on Mac).
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Changing the Files' Extension

• Go to  RunList > Change Extension...  to change the extension of all your individual files at once.

For example, you can use this to create the RunList from original InDesign files, then change the extension to
PDF to use individual PDF files in your workflow.

Note:  If you don’t have the files with the new extension at the location defined in the RunList, they will
have an orange “?” icon.

Sorting the RunList's Files

• Select entries in the main dialog and go to  RunList > Sort Selection By Name  to sort them alphabetically.
• You can also drag the entries to reorder them.

This updates the order of the RunList pages automatically.

 

 

 

 

Submitting the RunList to a Workflow

Once your RunList is ready, you can submit it to an Automation Engine workflow of your choice.

Attention:  Make sure that:

• The RunList Editor is connected to your Automation Engine server (see Setting Up the RunList Editor on
page ).
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• The workflow you want to submit your RunList to is public (see Making Your Ticket Public in the User
Guide).

• The RunList and the individual files it references are accessible to the Automation Engine server (saved
on an Automation Engine container).

• You have replaced any placeholders in the RunList by the actual files.

1. Go to  File > Submit...

This opens the following dialog:
 

 

2. Select the workflow you want to launch on your file in the Workflow list.

3. In Launch As, you can change the name of your RunList before launching it into the workflow if desired.

4. If you also want to submit the individual files referenced in the RunList, select their check boxes.

For example, when submitting to a workflow starting with a Wait for Files (via JDF) workflow step:

• submit the referenced files along with the RunList from the RunList Editor,
• in the Wait for Files (via JDF) parameters, use [URL of Folder of Input] for Look in Folder.

The referenced files will be copied to a temporary folder alongside the RunList, and picked up by the workflow
step.

5. Click Launch.
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PitStop Profile Editor

You can easily create and manage PitStop PDF  Profiles and Action Lists using PitStop Profile Editor from
Automation Engine.

Read more about PitStop in http://www.enfocus.com/en/support/knowledge-base

Setting Up the PitStop Profile Editor

You can download PitStop Profile Editor the Client Apps section of of Automation Engine server web page.
You can access it by browsing to http://<name of your server>  or  http://<name of   your
server>:9999 .Read more in Main

1. Download and install the PitStop Profile Editor on your client computer where the Pilot is installed.

• On PC:

1. Double-click on the Automation Engine PitStop Profile Editor.exe.
2. Click Next on Esko Installshield Wizard on your client machine.
3. Confirm on Installshield Wizard that you want to install PitStop Profile Editor by clicking Yes
4. Browse to the location where you want the Wizard to create subdirectories. The default location will be C:

\Esko.
5. Click Next.
6. Finish the installation.

• On Mac:

1. Double-click on the downloaded Automation Engine PitStop Profile Editor.dmg.
2. Double-click on the Automation Engine PitStop Profile Editor.pkg. The Assistant will

guide you through the installation.
3. Click Continue.
4. Click on Change Install Location to specify the location where you want the subdirectories.
5. Click Install. Fill in your credentials to confirm the installation.
6. A message The installation was successful will appear. Close the installation.

2. Start the application from:

• All Programmes > Esko > Automation Engine PitStop Profile Editor > PitStop Profile Editor .
• Applications > Automation Engine PitStop Profile Editor > PitStopProfile Editor .

3. Fill in the host name of the Automation Engine server in the  Edit > Preferences  window. This will integrate the
application with the PDF Profiles and Action Lists from this server. 

 

 

http://www.enfocus.com/en/support/knowledge-base
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You can now access the the PDF Profiles and Action Lists from the Automation Engine Server.

 

 

Using SmartNames in PitStop Profile Editor

You can use SmartNames in PitStop Profiles and Action Lists in Automation Engine Profile Editor. You can make
use of PitStop's "Smart Preflight" and reduce the the number of Profiles and Action Lists.

The PitStop Profile Editor loads the global SmartNames from the Automation Engine server that has been entered in
the preferences. 
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1.
Create SmartNames in SmartNames View by clicking New SmartName icon  in the toolbar.

Read more in Creating a SmartName

2. Start the application from :

• All Programmes > Esko > Automation Engine PitStop Profile Editor > PitStop Profile Editor .
• Applications > Automation Engine PitStop Profile Editor > PitStopProfile Editor .

You can access the PDF Profles and Action lists in the PitStop Profile Editor.
 

 

3.
Select one of the PDF Profiles and click on the menu button  to expand menu options. From the following
drop-down, choose New.

4. Enable one of the CHECK ONs.

a) You can now choose from Available Checks pertinent to your CHECK ON.
b)

Click on Actions  and Enable Variable Names.
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5.
Click on the blue SmartName (Variable)  icon. Created SmartNames (Global) and System SmartNames will
be available.

6. Choose the desired SmartName and Click OK. You can also give a brief Description.

You can use a SmartName in fields requiring:

• text
• niumber
• measurements (size in "mm", "cm" , "in", "p" (picas) or "pt" (points) ).

Attention:  Specify units in the measurement SmartNames (i.e. "mm", "cm", "in", "p" etc). . If the unit
is not specified, SmartName value assumes points as its units. For example, SmartNames representing
A4 dimensions, should resolve to "210 mm" and "297 mm". If the SmartNames resolves to "210" and
"297", the dimensions will be taken as 74mm x 105mm while preflighting.

• toggling on or off.

Note:  The SmartName value "0", "FALSE" or empty, corresponds to check box which is off. "1",
"TRUE" or anything else corresponds to on.
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Tools

The Tools menu contains tools useful to administrate Automation Engine.

 

 

You can also find the most important tools under the Views, in the left pane of the Pilot. But this list of tools does not
contain all of the tools.

 

 

To Do List

The To Do List lists all actions that need user intervention. Among these actions are Messages, Checkpoints, Red
Alerts, Milestone Actions.

You can open the To Do List from  Tools > To Do List , or by clicking the To Do List view.

Use the To Do List to view, modify, forward and delete these actions, and all related files.
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Checking To Dos

Actions

You can see a list of To Dos in the Actions panel. For each To Do, you can see:

• what the To Do is about (its Subject),
• which user it is assigned To,
• it's current State,
• if it is linked to a Job and to which,
• the Type of the To Do (Message, Checkpoint, Milestone Action...),
• the To Do's Due Date.

Tip:

• Initially, the entries in the To Do List are not sorted. You can sort them by clicking the appropriate
column heading.

You can also show / hide or reorganise columns by going to  View > Select Columns in 'To Do List'...
• You can refresh the list using Ctrl + R or  Edit > Refresh .

Filter

You can filter the list of actions using the drop-down menu. The default filters are My Actions, All Actions,
Checkpoint Actions, Messages and Milestone Actions.

You can define a custom filter. See Defining a Custom Filter on page .

You can also type text in the input field to search on the Subject text or the name of the file(s) linked to the To Do.

Details

Select a To Do in the Actions panel to show its Details below. They include extra information, like where the Files
linked to the To Do are located, and if the To Do includes a Message...
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Defining a Custom Filter

1.
Select <custom> in the filter drop-down menu and click .

This opens the Modify Filter dialog.
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2. Use the Operator tab to choose whose To Dos you want to see.

Select Filter on Operator and select the desired operators (you can also Select All).

3. Use the Due Date tab to filter on the To Dos' due dates.

Select Filter on Due Date and select either a range of due dates, or a time span from the current date and time.
 

 

4. Use the State tab to filter on the To Dos' states.

Select Filter on State and select the states (either Pending, In Progress or both) to show with this filter.

5. Use the Type tab to filter on the To Dos' types.

Select Filter on Type and choose from the list (Wait for Action, Milestone Action, Message).

6. When you are done, click Save As... and give your new filter a name.

You can also Apply the filter straightaway.
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Handling a To Do

To handle a To Do, select it in the To Do List and:

• To mark that you are handling it, select the I am currently handling this to do item in the Details pane.
• To open a To Do's file in the Viewer, click View next to the file path in the Details pane.

 

 
• To open a To Do's file in the associated application, double-click it in the Details pane.
• To open the folder containing the file(s), click the folder icon  next to the file path in the Details pane.
• To go to the job in the Files View (if the To Do concerns a job), go to  File > Go to Job  or use Ctrl + Alt + O.
• To release the files of a Wait for Action To Do to one of the output states of the Wait for Action (Checkpoint)

task / workflow step, click  then the output state you want to release the file to (by default
Completed or Aborted).

See Wait for Action (Checkpoint) on page  for more information about the Wait for Action (Checkpoint)
task / workflow step.

•
To forward a To Do to another user, click  and select the user to forward the To Do to.

Note:  You can also change the Subject, Due Date, State and Message at this point if desired.

•
To delete a To Do, click .

Creating a To Do

You can only create Message To Dos from the To Do List.

1.
Click  in the To Do List tool bar.

2. In the New Action dialog that opens:

a) Enter a Subject.
b) Choose who to assign the To Do To.
c) Link this To Do to a Job if needed.
d) Choose a Due Date.
e) Choose the To Do State.
f) Enter a Message if desired.

 



660 | Automation Engine | Tools

 

3. Click OK when you are done.

Explore

For data that cannot be accessed via the Pilot, you can use this shortcut to see your data directly on the file server,
through the client's OS. This means that when you are using a Windows Pilot client, this tool will open a Windows
Explorer to show your data. When you are using a Mac OS Client, this 'Explore' tool will show the data though the
Mac OS file system browser, provided that the file server has the right share mapping to that Mac OS client.

Task History

To keep your Tasks view manageable, you might have to clean the task lists. If you do not want to keep some tasks,
you can delete them. If you want to keep certain tasks or tickets for later use, you can add them to Task history. After

choosing a task, you can click on  in the Tasks View to move it to task history.

To view the history Choose  Tools > Task History . You can only view the tasks in the history after clicking Apply.
Alternatively you can press Enter in your keyboard to view the tasks in the history.
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The Task History has a lot in common with the Tasks View. It lists all 'moved' tasks which you can relaunch, view
and save.

You can archive entries in the Task History (more on that in the section on How To Archive? on page ) which
you can restore later. You can make XML reports of the tasks and use them to bill your customers.

The Task History has three parts:

 

 

1. Task History XML Report
2. Task History Search options
3. Task History List

Task History Menus

File Menu

• Open Task: opens the ticket used for the selected task.
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•
Export XML Report...  Writes a report of the current selection. This XML report contains task name, ticket
name (whether or not the ticket was modified), the Operator, when it started, when the tasked ended, Status,
Priority, job folder...

• Archive... It is possible to archive the data in the database to an XML file. This allows you to put the file on CD
or store it somewhere else.

• Import Archive... Restores the data in the selected XML file in the database. A browse window pops up, browse
to the archive.XML and click OK. The archive will be restored.

• Restart History Server This will shut down the History Server and reboot it.
• Close Window [Ctrl + W] Closes the window. If only one window is left, this is disabled (use Exit, to close the

last window).

Edit Menu

• Select All [Ctrl+ A] Selects all entries in the table.

View Menu

• Columns: define which columns you want to see, for more information, please refer to the section on Columns.
• Customize Current Filter: Please see filtering.
•

 Manage Views [Ctrl + Shift + F] Here you can save the View Settings or select a previously created view.
• Related Workflow Tasks: Some tasks are part of a workflow, use this function to get a list of related tasks.

 

 
• Stop [Escape] This cancels the current database query and lets you set up a different specification.
• Refresh [F5] Perform another database query with the current settings.

Task History Toolbar

•
 Open Task: opens the selected task.

•
 XML Report... Writes a report of the current selection. This XML report contains task name, ticket name

(whether or not the ticket was modified), the Operator, when it started, when the tasked ended, Status, Priority,
Job folder...

•
 Opens the Filter Settings dialog. Please see filtering.

•
 Views: use the dropdown list to select 'Manage Views...' or an already defined view.

Filter

Filter Settings allow specific modification of the way the Tasks View is filtered. There are five tabs.
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• Operator Define the filter according to the Operator. Tick the ones you want to monitor.
• State Define the filter according to the Status of the task. Just tick the ones you'd like to view.
• Task Type By default, the Tasks View will show all tasks launched, but you can modify the filter in such a way

that the Tasks View shows nothing but the type of tasks you are interested in.
• Date Define the Filter according to date and time.

• in a given time window (between [date and time] and [date and time])
• during the previous X hour(s)
• during the previous X day(s)
• during the previous X month(s)

• Advanced

The Advanced Filter settings allow for precise queries.

Hit 'New' to define a rule. The set up is easy. You define a rule that shows X containing a certain string.

Task History List

The Task History list looks a lot like the Tasks View task list.

The list lists all tasks that have been moved from the Tasks View to Task History. You define what you want to see.
You can define the number of columns (see View Menu > Columns), you can click the head of a column to get the list
to sort the way you like it, and you can filter the entries (see View Menu > Filter).
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How To Archive?

Archiving serves two purposes:

• The Task History is used to make the Tasks View quicker, more user-friendly. All tasks stored in the Task
History can be relaunched, it is a so called 'living archive'. As time goes by, you will end up with a Task History
containing a lot of tasks that you may never want to relaunch. You can delete these tasks, but if you think that's
not a good idea, you can use the Archive function. so archiving can be a part of the Task History database
maintenance.

• Archiving can be used to make a backup of the Task History data for safety reasons. You archive your data
frequently, not because you need the space, but because you want to store your XML archive safely elsewhere, so
you can easily restore it when problems should arise.

Archiving will store all information of certain tasks in an XML file. This adds the possibility of restoring those XML
archives into the Task History. So your information will never be lost.

Note:

Archiving only works on selected tasks.

Archiving doesn't delete the archived tasks from the Task History.
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1. Select the tasks you want to archive.

If you want to archive all taks, press CTRL + A. If you want to make a subselection, the Task History reacts to the
known shortcuts such as CTRL + click and SHIFT + click.

If you want to make an intelligent selection, and you don't want to lose time, you'd better use the Filter .
You define what you want to see in the Task History (for instance all tasks originating from one particular job, or
handled by one particular operator, ...), click CTRL + A and you're ready to archive.

2. Click Archive (File Menu > Archive).
3. A browse dialog pops up, allowing you to browse to the place where you want the archive XML to be stored.

Make sure to give the archive XML a meaningful name in order to avoid confusion later on. Confusion might
arise if you bear in mind that the Task History also uses the XML language to write an XML report.
 

 

Click OK.
4. A' Confirm' dialog pops up and asks you whether or not you want to delete the archived items:
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Cleanup Rules

Select 'Cleanup Rules' in the Tools menu if you want to apply rules. To define cleanup rules, you have to use the
Configure Tool (see Task Cleanup Rules on page ).

The 'Cleanup Rules' dialog box offers a view of all rules that have already been defined.

Click the 'Details...' button to inspect the settings. You can view them but you cannot edit them (use the Configure
Tool for that.)

Merger Monitor

If you use an Expose On ticket to expose on a device that has been configured to work with merge queues, you can
monitor the merging activities.

Start the Merger Monitor by selecting 'Merger Monitor' from the Tools Menu.

 

 

The Merger Monitor consists of two panels. The left-hand panel lists all devices  on which jobs have been
merged or are currently waiting to be merged. In the example above there's one device listed example_merge. Every
device on which something has been merged stays listed until the server is rebooted.

Select a device to see what is in the merge queue. Jobs that are to be merged are assembled in pools.

A pool is a group of jobs with the same characteristics (same plate size, negative or positive, ...). These characteristics
are defined by the so-called extract restrictions. For instance: jobs with a different Dot Gain Compensation setting
will not be merged together. They will not belong to the same pool.



Automation Engine | Tools | 667

Some of these restrictions depend on the setting in the General tab of the ticket you use.

1. VDistortion and HDistortion: Jobs must have the same vertical and horizontal distortion before they can be in
the same pool.

2.

Reverse : Jobs have to be reversed in the same way before they can be in the same pool.
3.

Mirror : Jobs have to be mirrored in the same way before they can be in the same pool.
4. Dot Gain Compensation: Only jobs with the same Dot Gain Compensation belong in the same pool.

The other restrictions are defined in the Output tab of the ticket you use.

1. Conf: Jobs need to have the same plate size before they can be in the same pool.
2. Output path and Output File Name: Jobs with different Output paths or Output File names will end up in

different merge pools.
3. Resolution: Jobs need to have the same resolution before they can be in the same pool.
4. Compression: Jobs need to have the same compression before they can be in the same pool.

Notice that example_merge has two pools : 20051128–1 and 20060215–1. When you select the device, but not
a pool, you get an overview of all jobs waiting to be merged. In order to visually indicate that jobs belong to different
pools they have a different background color. White and gray are used consecutively.

The right hand panel provides detailed information on jobs in the merge queue.

• The taskID
• Priority: this is the priority you defined in the Expose On ticket, not the priority of the task.
• The name of the Job
• The inks you are exposing, you defined them in the Expose On ticket.

Note:  There are two ways in which the inks are listed. C&M&Y&K or C+M+Y+K. They can be merged
on separate films or on the same film.

• The Page
• The Size HV (mm)

Note:  The symbols used to indicate the size tell you whether or not the job can be rotated in the merger.
<> (154<>191) indicate that the job can be rotated, an x (154x191) indicates that it cannot.

Rotation is an option you can set in the Transformations part of General tab of the ticket you use to
launch the task.

• Fill %: Jobsize/Platesize

These percentages are relative, the overall fill depends on the margins and gap as they are currently defined in
your ticket. You cannot simply add the percentages to get a correct idea of the overall fill. There are all kinds of
reasons why jobs cannot be merged together and why the fill percentage is -as a result- not yet reached.

• The State of the job in the Merger queue

A job can be on hold  (it's an option you can choose in the 'Expose On ticket'). A job can be released , but
that does not mean that it will be merged, it still has to wait till the fill percentage is reached.You can Force a job

out  of the Merger queue. The forced out job will take as many jobs possible, if they have a 'release status',
with it.

Queue Monitor
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1. Menus
2. Toolbar
3. Contents: lists all tasks in a selected queue. Right-clicking a task activates a context menu which offers the same

functionality as the Task menu.

Queue Monitor menus

File Menu

File Menu options:

• New Window: opens a new Queue Monitor window.
•

Start / Stop queue : These buttons allow you to start or stop the selected queue.

You can also do this by selecting Start / Stop Queue form the 'Advanced Menu' or by right-clicking a device in the
Device List. The devices' status is visible in the Queue State column.

• Schedule queue... allows you to schedule the activity of specific action queues. You can define 3 time intervals
during which queues are kept on hold.

Set the FTP queue on hold till 2.30 PM. At that time your waiting FTP tasks will start processing
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The scheduled status will be visualized in the Queue Monitor toolbar.

 

 
• Close window: closes the Queue Monitor.

View

The View Menu offers 'Columns' from which you can select the columns you want to see or hide. For more info,
please refer to the part on 'Columns'.

Task

The Task Menu offers the same functionality as the Pilot's Task Menu. You can also right-click a task in the queue.
The context menu will offer you the following options:

• Open Task
• Log Info ...
• Hold
• Hold Until...
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• Release
• Cancel
• Annotation...
• Priority...
• Relaunch

Toolbar
 

 

1. The Queue drop down list. Select the queue you want to monitor from the list.
2.

 Opens the selected Tasks.
3.

 Relaunches the selected task(s).
4. Status indicates the status of the selected queue.
5.

The Start / Stop queues buttons . These buttons allow you to start or stop the selected queue.
6.

The Schedule Queue button  opens the Schedule Queue dialog box.

Contents of selected queue

Lists all tasks in the selected queue.

Right-clicking a task opens a pop up menu with the same functionality as the Task Menus.

You can modify the look of the list by drag & dropping the heads of the columns, and by selecting 'Columns...' from
the View Menu.

Configure

Use the Configure tool to connect to a variety of devices and applications, and define general Automation Engine
settings.

To start Configure, go to  Tools > Configure  in the Pilot.
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To Define Settings in Configure

1. Select the settings category, or the device / application you want to connect to, in the left pane.
2. Go to File > New.
3. Define your settings.
4. Go to File > Save.

Note:

PC shortcuts:

• Insert: to add a device
• Delete: to delete the selected device
• F2: to rename the selected device.

Automation Engine Database

Here you can configure:

• the Flexo Plates database,
• the JDF database,
• the Task History database,
• the Jobs database.

FlexoPlates

This database stores all the information about LEN files sent to the Digital Flexo Suite using the Make Plate on CDI
task.
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You can see this information in the CDI view (see CDI View).

By default, Automation Engine uses the Jobs on page  database as FlexoPlates database. To use a custom
database, do the following:

1. In Database, enter the name to give to your database. By default, this is FlexoPlateHistory.
2. In DBMS Type, choose the type of database you are using.
3. In Host, enter the name or IP address of your database server.
4. Enter the Port to use (or leave it blank to use the default port).
5. Enter the User name and Password used to connect to the database.
6. Click Synchronize to synchronize the information in the database with your Automation Engine server.

Task History
Setup

These settings will be filled out correctly when the system is installed.

 

 

Note:  DBMS stands for DataBase Management System.

• Database: Enter the name of the database.
• DBMS type: Select the correct driver type from the list. The screenshot shows the driver type for an SGLdriven

database.
• Host: Enter the name of the server.
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• Port: Indicate which port the system uses to talk to the database.
• Enter the correct user name and password.

Use the Synchronize button to test the settings immediately. If you do not click Synchronize, the changes will be
effective the next time the system is rebooted.

Maintenance

This tab has a button to Delete all Task History data. This is only useful when you have major problems with your
database that cannot be fixed without deleting the database, or when you want to alter your database (for example add
columns and you don't want to run a conversion script on the existing data, so you delete all Task History data and
start with a fresh, altered database). The system will ask for confirmation.

 

 

Jobs
Setup

These settings will be filled out correctly when the system is installed. However, you can change these settings.
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Note:  DBMS stands for DataBase Management System.

• Database: Enter the name of the database.
• DBMS type: Select the correct driver type from the list. The screenshot shows the driver type for an SGLdriven

database.
• Host: Enter the name of the server.
• Port: Indicate which port the system uses to talk to the database.
• Enter the correct user name and password.

Use the Synchronize button to test the settings immediately. If you do not click Synchronize, the changes will be
effective the next time the system is rebooted.

Maintenance

Dangling Jobs are active Automation Engine Jobs that have a link to job folder that is not (or no longer) there,
probably because the folder was (re)moved, or renamed.

These Jobs can be removed from the Database via the Maintenance tab.

Ideally, each Job corresponds to one folder on disk. But... it may occur that a user or operator moves or deletes
a folder of a Job via Windows Explorer or Macintosh Finder. This way, discrepancies can arise between the
information of a job in the Automation Engine database and the actual situation on disk.

Removing dangling jobs will bring the folders on disk and the Automation Engine database back in sync.
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Click Remove to make the database check for each folder whether or not the folder - as contained in the database -
still exists.

If the folder does not exist, the job will be removed from the Automation Engine database. This implies that instead
of deleting jobs via the Pilot, you are able to delete jobs by deleting the corresponding folder.

 

 

Create DCS Master
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When you use the Create Master DCS task you might want to map short names used in plates (that might not mean
anything) to full ink names. This is handy for instance for plates with international ink definitions.Default, C,M,Y and
K are mapped unto Cyan, Magenta, Yellow and Black

To add an ink definition, double-click an input field and you can start typing. Use TAB to switch fields.

Digital Delivery

This is where you configure destinations to be used in the Publish on Web task. The Digital Delivery configuration
allows you to specify to which central server files have to be uploaded.

The configuration is vendor-dependent. Digital Delivery is not used for approval purposes.

 

 

Delivery
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• Website: indicate the web address.
• Delivery Method: is vendor-dependent.

Connect to JDF Processor

• Hot Folders

• Upload Folder: this is the folder in which the Publish task will drop the JDF files containing the information
about the files to be approved.

• Download Folder: this is the folder in which the WebCenter JDFProcessor will drop the JDF files when
approval is finished or failed, or in other words, where Automation Engine reads the returning JDF.

• JMF

• URL: Enter the correct URL so that Automation Engine and WebCenter are able to communicate with each
other over JMF.

Digital Press

Use this to connect to a digital press through the DFE (Digital Front End) server that drives the press.

1. Select Digital Press and use File > New to create a new digital press connection.

2. Enter the name of your DFE Server and click Connect.

Note:  Make sure the DFE server is running and reachable over the network.

If your connection is successful, you will see Connection OK! and details about the DFE server.
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3. If your DFE server drives several digital presses, select the Press you want to connect to from Automation
Engine.

You will see details about the digital press.

4. Use File > Save to save your connection.

E-Mail Configuration

Mail Server Tab
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PostMaster is the email address that will get a warning mail when an e-mail could not be delivered.

Check with your IT department for the correct settings of the SMTP Server and SMTP Port.

When the SMTP server requests authentication, fill out the User and Password.

The following authentication schemes are supported by the Automation Engine mail component: PLAIN, LOGIN and
DIGEST-MD5.

For SMTP, unrestricted, secure and encrypted connections are supported.

Test Tab
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Click the Test E-Mail button to see whether the mail system is working properly. The user as whom you are logged
on will receive a test e-mail.

External Databases

Read about configuring External Databases in Configuring Exteral Databases

Configuring Exteral Databases

1. Go to  Tools > Configure  in the Pilot.

2. Select External Databases in the Configure Panel on the left.

3. Go to  File > New  to add a new database.

4. Give the database name.
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5. Choose the appropriate DBMS type and enter the connection URL. Verify if the URL works by using the Test
Connection  button.

Esko provides the drivers for following Database Management Systems (DBMS).

• Microsoft SQLServer  : jTDS  (jtds.jar)
• Oracle 10 : Oracle driver  (ojdbc14.jar)
• DerbyServer :  Derby driver  (derbyclient.jar)
• Generic ODBC :  32 bit only - generic java odbcjdbc bridge driver (standard included in JRE)

Note:

Not all drivers are freely available and not all are tested. Choose connection type as Other to access
another DBMS type for the necessary information and drivers on how to access the DBMS via standard
jdbc technology.

6. Enter the Database URL. This URL must be setup according to the JDBC syntax and will vary depending on the
DBMS and its settings.

Some examples are given below :

• Connecting to a Microsoft SQL Server:

 

 

jdbc:jtds:sqlserver:/DBSERVER01:1433/
ProductionDetails;user=admin;password=admin

• DBSERVER01: the database server hostname
• ProductionDetails : the database

• Connecting to a Oracle 10g Server:

jdbc:oracle:thin:@DBSERVER01:1521:ORAPRD

• DBSERVER01: the database server hostname
• ORAPRD : the SID

• Connecting to a Derby server :

jdbc:derby:c:\\Database\\ProductionDetails;create=true

c:\Database\ProductionDetails  is the folder where the database files are located and create is
a parameter to create a new database.

• Connecting to a database server via ODBC :

jdbc:odbc:ProductionDetails
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ProductionDetails is the name of a System Data Source.

Note:

32 bit only: Automation Engine can only work with 32 bit ODBC datasources. On a 64 bit Operation
System, add your data source via the 32 bit ODBC Administrator. This can be found in \Windows
\SysWOW64 .

• Connecting to a MySQL server:

Use connection type Other. Provide URL and the driver details. In this example, the driver has been
downloaded from the manufacturer website (http://dev.mysql.com/downloads/connector/j/
 

 

jdbc:mysql://DBSERVER01/ProductionDetails?
user=admin&password=admin&autoReconnect=true

• DBSERVER01: the database server hostname
• ProductionDetails : the database
• The autoReconnect parameter can be set to keep unused connections open.

7. Click  File > Save  to save the configuration.

Note:  Acknowledge the disclaimer in the setup menu to save the settings successfully.

FastImpose Site Preferences

The FastImpose site preferences are useful when you want to map certain names to customized ones. For example if
you want to map C to the French 'bleu' on your plates for instance.

Ink Names

Click Add and two values are added to the list: key and value, double click the words to edit them:
 

http://dev.mysql.com/downloads/connector/j/
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Tip:

A black rectangle around the field indicates that you can edit it.

If you want to 'C' to 'Bleu' you enter C in the Name column, and Bleu in the Customized Name column:
 

 

This will change nothing to your job, but if you used marks that would output 'C' on plate, now it will read 'Bleu'.

Surfaces

A number of values are defined (F/B, Front/Back, Back, F, Front, B) but sometimes these definitions do not conform
to your language or your way of working, so you can change them.Let's say you want Front/Back to read Recto/
Verso, you just edit the Customized Name by double clicking.

Tip:

A black rectangle around the field indicates that you can edit it.
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FlexProof - Image Downloader

Select the Image Downloader folder icon, open the File Menu and choose New. Three tabs appear:

• General
• Queue
• Merge

Note:

When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Proofer Node Enter the FlexProof PC name.

Fill out these fields before you click Synchronize with ProofNode.This may take a few seconds, the system
will fill out the ‘Type’ field.

Note:
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The name of the Image Downloader ProofNode is case sensitive. This is not the case for the other
devices.

Tip:

You can retrieve your host name by typing host name in a command prompt.

Queue

Queue This field will have ImageDownloader1Queue in it initially. This field will update automatically when
you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the
same time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will result
in each expose command to that EskoLink being handled one by one: the second job will be ripped after the
first one is completely finished. Also remember the following rules:- having jobs ripped earlier on the FlexRip
does not mean your output device can output them any earlier. - some people prefer the Automation Engine
queue 'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow
trainer or customer service for more advice on these Queue 'job limits'.

Merge

Merge: Yes is the default setting.

Select a unit. Margin Set an extra margin around the separations.

Gap Extra added zone (of empty pixels) around each separation that will result in a ‘gap’ between the merged
separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

FlexRip - Approval

Select the FlexRip - Approval folder icon, open the File Menu and choose New.Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Approval1 Queue in it initially. It will update automatically when you rename
the device.
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Queue Job Limit A Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs at the
same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the same time,
then set the job-limit of the Automation Engine queue on 2.

Putting this job-limit on 1 will result in each expose command to that EskoLink being handled one by one:
the second job will be ripped after the first one is completely finished. Also remember the following rules:-
having jobs ripped earlier on the Rip does not mean your output device can output them any earlier. - some
people prefer the Automation Engine queue 'job limit' on 1 because that guarantees the 'first in first out' rule.
Do consult your Esko workflow trainer or customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations. If you decide to set it to Yes, other toggles will appear.

Gap Extra added zone (of empty pixels) around each separation that will result in a ‘gap’ between the merged
separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

FlexRip - B

Select the correct device folder icon, open the File Menu and choose New.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Three tabs appear:

• General
• Queue
• Merge

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will initially read MegaSetter1Queue. This field will update automatically when you rename
the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the
same time, then set the job-limit of the Automation Engine queue on 2.

Putting this job-limit on 1 will result in each expose command to that EskoLink being handled one by one:
the second job will be ripped after the first one is completely finished. Also remember the following rules:
- having jobs ripped earlier on the FlexRip does not mean your output device can output them any earlier. -
some people prefer the Automation Engine queue 'job limit' on 1 because that guarantees the 'first in first out'
rule. Do consult your Esko workflow trainer or customer service for more advice on these Queue 'job limits'.
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Optimize Expose Sequence This toggle ensures 'faster' output (all separations will be ripped in one pass).
For some jobs, however, this way of working results in memory problems, when this happens, you can
deselect this toggle, all separations will be ripped separately (the rip will be restarted after every separation).

Merge

Merge We advise to set this to No as merging will happen after this pass on the way to the Imagesetter, in
doing so you achieve high flexibility in merging (positive and negative can be merged on one film).

Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.

Gap Extra added zone (of empty pixels) around each separation that will result in a ‘gap’ between the merged
separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

FlexRip - BI (Barco Imagesetter)

Select the BI folder icon, open the File Menu and choose New. Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have BiModel11 Queue in it initially. This field will update automatically when you
rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the
same time, then set the job-limit of the Automation Engine queue on 2.

Putting this job-limit on 1 will result in each expose command to that EskoLink being handled one by one:
the second job will be ripped after the first one is completely finished. Also remember the following rules:
- having jobs ripped earlier on the FlexRip does not mean your output device can output them any earlier. -
some people prefer the Automation Engine queue 'job limit' on 1 because that guarantees the 'first in first out'
rule. Do consult your Esko workflow trainer or customer service for more advice on these Queue 'job limits'.

Optimize Expose Sequence: This toggle ensures 'faster' output (all separations will be ripped in one pass).
For some jobs, however, this way of working results in memory problems, when this happens, you can
deselect this toggle, all separations will be ripped separately (the rip will be restarted after every separation).
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Merge

Merge The dropdown list only offers 'No' as an option. That's because the BI cannot merge jobs. Select a
unit.

Margin Set an extra margin around the separations.

FlexRip CDI, CDI Spark and CDI Compact

These three can be configured in the same way.

Select the correct device folder icon, open the File Menu and choose New.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Four tabs appear:

• General
• Queue
• Merge
• JDF
• CDI

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will initially read CDI1 Queue, CDI Compact1 Queue or CDI Spark1 Queue. This field will
update automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2
jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at
the same time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will
result in each expose command to that EskoLink being handled one by one: the second job will be ripped
after the first one is completely finished. Also remember the following rules: - having jobs ripped earlier
on the FlexRip does not mean your output device can output them any earlier. - some people prefer the
Automation Engine queue 'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your
Esko workflow trainer or customer service for more advice on these Queue 'job limits'.

Optimize Expose Sequence: This toggle ensures 'faster' output (all separations will be ripped in one pass).
For some jobs, however, this way of working results in memory problems, when this happens, you can
deselect this toggle, all separations will be ripped separately (the rip will be restarted after every separation).

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.

GapExtra added zone (of empty pixels) around each separation that will result in a ‘gap’ between the merged
separations.
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Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

JDF

If your CDI is equipped with a JDF/JMF enabled Device Controller, you can specify on which URL (http
address) this JDF/JMF Device Controller can be reached. To this address an imagesetting JDF file, together
with the ripped data will be sent. The accompanying JMF file will indicate that the data can be submitted in
the queue.

A JDF/JMF Device Controller installs a tight link between the Automation Engine Server and the Grapholas
system. Advantages are:

• automatic transport of the ripped bitmap files towards the Grapholas system for access in the PlatePrep
application.

• closer followup of the real plate exposure process from within the Automation Engine Pilot.

CDI

Pixelclock is set to 360000

The Perimeter of the drum in mm, inches or mil.

The content of this tab depends on the Grapholas software. If you have recent Grapholas software these
settings will be 'automatic'. The CDI Spark for instance does not have these settings anymore.

FlexRip Indigo 4000 Series

Select the Indigo 4000 Series icon, open the File Menu and choose New.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Two tabs appear:

• General
• Queue

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

QueueThis field will have HP Indigo 45000 Queue in it initially. This field will update automatically when
you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the
same time, then set the job-limit of the Automation Engine queue on 2.

Putting this job-limit on 1 will result in each expose command to that EskoLink being handled one by one:
the second job will be ripped after the first one is completely finished. Also remember the following rules:
- having jobs ripped earlier on the FlexRip does not mean your output device can output them any earlier. -
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some people prefer the Automation Engine queue 'job limit' on 1 because that guarantees the 'first in first out'
rule. Do consult your Esko workflow trainer or customer service for more advice on these Queue 'job limits'.

FlexRip - Proofer Output

Select the Proofer Output icon, open the File Menu and choose New.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Three tabs appear:

• General
• Queue
• Proof

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Proofer Output1 Queue in it initially. This field will update automatically
when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2
jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at
the same time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will
result in each expose command to that EskoLink being handled one by one: the second job will be ripped
after the first one is completely finished. Also remember the following rules: - having jobs ripped earlier
on the FlexRip does not mean your output device can output them any earlier. - some people prefer the
Automation Engine queue 'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your
Esko workflow trainer or customer service for more advice on these Queue 'job limits'.

Proof

A workflow choice must be made: or you choose to let the FlexRip recombine the separations or you choose
to add a 'Proof (FlexProof)' task.

Recombine separations:

• On the FlexRip, you can add a margin (in mm/mil/inch), no merging is possible.
• By sequencing a 'Proof (Image Downloader)' Task: you have to specify the 'FlexProof - Image

Downloader' device from the dropdown list. (The list only shows those devices that are configured for the
same node (RIP and Proof node must be identical).

FlexRip - Screened Output

DCS

These are the settings of FlexRip devices.

Select Screened Output > select DCS > Select 'New' from the File Menu.
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Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Three tabs appear:

• General
• Queue
• Merge

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

QueueThis field will have Screened Output1 Queue in it initially. This field will update automatically
when you rename the device.

Queue Job LimitA FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the same
time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will result in each
expose command to that EskoLink being handled one by one: the second job will be ripped after the first one
is completely finished. Also remember the following rules:- having jobs ripped earlier on the FlexRip does
not mean your output device can output them any earlier. - some people prefer the Automation Engine queue
'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels) around each
separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

TIFF

Select Screened Output > select TIFF >open the File Menu and choose New.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Three tabs appear:

• General
• Queue
• Merge

General

Type When you configure a new device, the system will tell you that the Type is Unknown.
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Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Screened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the same
time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will result in each
expose command to that EskoLink being handled one by one: the second job will be ripped after the first one
is completely finished. Also remember the following rules:- having jobs ripped earlier on the FlexRip does
not mean your output device can output them any earlier. - some people prefer the Automation Engine queue
'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Optimize Expose Sequence This toggle ensures 'faster' output (all separations will be ripped in one pass). For
some jobs, however, this way of working results in memory problems, when this happens, you can deselect
this toggle, all separations will be ripped separately (the rip will be restarted after every separation).

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels) around each
separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

Note:

Putting Merge on 'Yes' may result in a very large output file.

PDF

Select Screened Output > select PDF >open the File Menu and choose New.

Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.
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Queue

QueueThis field will have Screened Output1 Queue in it initially. This field will update automatically
when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the same
time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will result in each
expose command to that EskoLink being handled one by one: the second job will be ripped after the first one
is completely finished. Also remember the following rules:- having jobs ripped earlier on the FlexRip does
not mean your output device can output them any earlier. - some people prefer the Automation Engine queue
'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels) around each
separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

Note:

Putting Merge on 'Yes' may result in a very large output file.

PS

Select Screened Output > select PS >open the File Menu and choose New.

Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Screened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the same
time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will result in each
expose command to that EskoLink being handled one by one: the second job will be ripped after the first one
is completely finished. Also remember the following rules:- having jobs ripped earlier on the FlexRip does
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not mean your output device can output them any earlier. - some people prefer the Automation Engine queue
'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels) around each
separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

Note:

Putting Merge on 'Yes' may result in a very large output file.

FlexRip - Unscreened Output

DCS

These are the settings of FlexRip devices.

Select Unscreened Output > Select DCS > open the File Menu and choose new.

Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Screened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the same
time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will result in each
expose command to that EskoLink being handled one by one: the second job will be ripped after the first one
is completely finished. Also remember the following rules: - having jobs ripped earlier on the FlexRip does
not mean your output device can output them any earlier. - some people prefer the Automation Engine queue
'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge
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Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels) around each
separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

Note:

Putting Merge on 'Yes' may result in a very large output file.

TIFF

Click the Screened Output icon, select TIFF from the list, open the File Menu and choose New.

Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip. This may take a few seconds.

Queue

QueueThis field will have Unscreened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the
same time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will result
in each expose command to that EskoLink being handled one by one: the second job will be ripped after the
first one is completely finished. Also remember the following rules:- having jobs ripped earlier on the FlexRip
does not mean your output device can output them any earlier. - some people prefer the Automation Engine
queue 'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow
trainer or customer service for more advice on these Queue 'job limits'.

Optimize Expose Sequence This toggle ensures 'faster' output (all separations will be ripped in one pass).
For some jobs, however, this way of working results in memory problems, when this happens, you can
deselect this toggle, all separations will be ripped separately (the rip will be restarted after every separation).

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.
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GapExtra added zone (of empty pixels) around each separation that will result in a ‘gap’ between the merged
separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

PDF

Click the Screened Output icon, select PDF from the list, open the File Menu and choose New.

Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Unscreened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the same
time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will result in each
expose command to that EskoLink being handled one by one: the second job will be ripped after the first one
is completely finished. Also remember the following rules:- having jobs ripped earlier on the FlexRip does
not mean your output device can output them any earlier. - some people prefer the Automation Engine queue
'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels) around each
separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

PS

Click the Screened Output icon, select PS from the list, open the File Menu and choose New.

Three tabs appear:

• General
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• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof PC name. Also enter the exact EskoLink Portnr. that the specific
Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Unscreened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands at the same
time, then set the job-limit of the Automation Engine queue on 2. Putting this job-limit on 1 will result in each
expose command to that EskoLink being handled one by one: the second job will be ripped after the first one
is completely finished. Also remember the following rules: - having jobs ripped earlier on the FlexRip does
not mean your output device can output them any earlier. - some people prefer the Automation Engine queue
'job limit' on 1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels) around each
separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no output is
generated before the fill quota is reached.

Gang Run Printing

You can group compatible jobs in the Gang Run view. For this, define one or more custom fields and specify their
use as a grouping key. When jobs are submitted to the gang run for a certain substrate, they are grouped automatically
when they have the same grouping key values. Typical examples of grouping keys are: Customer, Printing Method,
Finishing Method, etc.
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1. Go to  Tools > Configure .

2. In the Configure window, select Gang Run Printing.

3. Specify names for each custom field under Name Custom Field.

4. Enable Use as grouping key to use Custom Field as grouping key.

5. You may select Use the Customer field as grouping key.

6. Click  File > Save > .

Jobs

Job Setup

Six Custom Fields can be specified. When entering names in custom fields 3 to 6, an extra tab Categorization will
appear in the Job Setup dialog box.

Tip:  Examples: region - brand.

Note:  Think about these carefully, changing this later will create confusing lists of values for these fields.
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JDF Setup

JDF Setup offers you the possibility to define the default settings for job creation. These settings are used when a new
Job is created while processing a JDF file for job creation.

If you want to use the same job structure each time a new job is created via JDF, this can be done by taking over the
job structure of a specified job. Check 'Apply Job Setup' and click 'Select' if you want to copy the setup from another
job. You can indicate what items should be copied. Traditionally it will be Tickets, Parameters and Hot Folders.
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On the Custom Fields tab, you can define how the data in the Comment elements from the JDF file is used to
populate the custom fields (Categories) that appear in the Job Setup dialog. To do this, type an XPath expression into
the field corresponding to the category that you want to fill in automatically.

For all additional information about the Custom Fields options, please contact your local Esko JDF consultant.
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Job Web Page

Define the Job Web Page's path here. Obviously, it needs to be a valid URL, so if you use SmartNames, make sure
they resolve correctly. This allows you to go to your WebCenter project from within your Automation Engine Job!

Enter the name of your WebCenter site, and add “/projdetails.jsp?projectName=[JobName] at the end.

 



702 | Automation Engine | Tools

 

In the Pilot, you can right-click a job folder and select 'Go to Job Web Page' from the pop up menu. A browser will
start up and load the path defined here.

Attention:  This only works if you map the job on a project by name, but this will be the most common case.
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Smart Job Location

The Job’s job folder can be set on a Smart path [Smart Job Location]. It allows you to configure Automation Engine
in such a way that the location for a new Job can be extracted from a set of rules defined in Configure, instead of
having to enter this information manually in the 'New Job' or 'Job Setup' dialog boxes.

When creating a new Job manually or via JDF certain pieces of information have to be entered in the system. One of
them is the Job location.

There are three kinds of specifications that you can use to set up the Smart Job Location: Customers, Rules and
Container. These 3 ways have their own order: if the 'Customers' check does not return an valid path for the job
folder, then ‘Rules’ will be checked etc..

In the 'New Job' or 'Job Setup' dialog boxes you will see an extra toggle 'Show Job Location'. Check this toggle to
make Automation Engine use the Smart Job Location rules.

Automation Engine offers three ways to set rules for Smart Job Location:

• Customers: This is a simple rule based on the customer name only. It allows you to specify 1 smart place for all
Jobs of that specific customer.

• Rules: Allows you to set extensive conditional rules.
• Container: Allows you to set a fixed Container for all job folders to be created (from now on).
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Tip:

It is possible to use this Smart Job Location as a SmartName for the indication of the folder for the Job in
JDF. Use <SJL\>.

Customers

Here you can see the customer defined job location. It shows you 1 smart place for all Jobs of that customer. If you
create a job and attach a customer to the job, the location defined in the customer's setup will be used.
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Rules

If no customer is selected for the new job, or no location is defined for the customer, a specified rule will be taken
into account.

Click the 'New Rule' button in the Rules tab to set up new rules. It enables extra conditions that you can make as
extensive as necessary. Even regular expressions can be used.

Click the Help button for an overview of the characters that can be used to indicate your regular expressions.
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This example shows how you can distribute many jobs automatically over subfolders, based on the Number in the Job
Order ID.

 

 
Container

If no rules apply to the new job, the default job location will be used.

In case the 'Customers' and 'Rules' checks did not return any valid path for a job folder, then this rule will be taken: a
main choice for the JobContainer is decided here.
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Nexus

1. Choose  Tools > Configure  and select the Nexus category.

2. Click  File > New

3. Enter the name of the Nexus server in the Host field.

4. Enter the Port on which the Nexus server is accessible.

5. Click Test Connection to verify the settings you entered.

Note:  You can also test whether the Nexus SoapServer is online by browsing to the following url in your
favorite web browser: http://NexusServerName:5182

Notification

The configuration of the notification consists of 3 parts:

• Rules
• Via File
• Templates

Notification Rules

Instead of deciding on notifications per ticket, you can define general notification rules. You can set a notification
rule on a specific task or on a specific device (queue).

There are two tabs:Tasks and Devices. Both these tabs list either tasks or devices for which you can define
notification rules.

For example:

• Milestone task: send out an XML every time a Milestone task ends.
• CDI Compact device: send out XML on all actions on that CDI device. Have each notification added to the main

XML representing that CDI.

Note:  It is not possible to set up a notification rule for a device if a dedicated rule can be set up for the
corresponding task.

Defining a Notification Rule

1. Click 'Add'.

The 'Notification Rule Editor' pops up.



708 | Automation Engine | Tools

 

 
2. Define the Notification.

Define the condition for the notification and the action.

A notification may consist of an e-mail sent to the task owner (or to any other valid address), it may also be an
entry in a XML/text file, or an XML/text file in a certain folder.

The place where the Text and XML notifications end up is defined in the Notification via file part of the
Configure Tool.

Note:  When selecting “Send an e-mail”, you can add more than 1 e-mail address in the 'To' field
(including SmartNames) by using ' ; ' as a separator.

You can add the input files, the output files, the task's log file and or the ticket to the notification.

The notification can be based on a template. Hit the 'Edit templates ...' button to create and modify templates.

For more information, please see 'Edit Notification Templates'.

Note:  The Template list and Edit templates button will only be visible if templates have been created
before.

Note that SmartNames can be used in the To field, for example to refer to e-mail addresses of:

• the Job’s CSR,
• up to 3 customer contacts.

3. Click OK.

The notification rule is added to the 'Notification' dialog.

Via File

There are two tabs: this allows you to determine the default location of the Text and XML report (entries). You can
enter a path for both Text and XML notifications. Use the Browse buttons to define a different location.
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Text file notification: You can append the message in a log file (*.log). You can create a new file for each message in
the same folder.

XML notification: You can append the message in a log file (*.XML). You can create a new XML file for each
message in the same folder.

To set general rules, you need the Notification Rules part of the Configure tool.

Include task messages: the task messages and / or task parameters will be added to the notification.

Notification Templates

You can base your notification on a template. This means that you prepare a template with a default structure.

You can also use the default template.

Click 'Edit Templates' in the Notification Rule Editor to add a new one, or to copy, modify, rename or delete an
existing template.

Please see Edit Notification Templates for an explanation of how to create a new template.



710 | Automation Engine | Tools

Edit Notification Templates

You can base notifications on a template. This means that the notification will be structured exactly the way you want
it to be structured.

You can either choose an existing template from the list, create a new one, or modify an existing template.

Creating a template

1. Click 'Add'.
 

 
2. The 'Add' dialog pops up. Enter a name for the template. Click OK.

 

 
3. The 'Edit Template' dialog pops up. It has dedicated fields for:

• the e-mail subject line (SmartName enabled),
• the text of the e-mail message (SmartName enabled),
• code-based conditional information (SmartName enabled),
• attachments.
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Tip:  You can also Edit Notification Templates in the Configure tool, provided that you already have
templates available: go to Configure > Notification > Rules > Select a task > Add...

Odystar
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Enter the name or IP address of the Odystar server in the Host field.

Enter the Port on which the Odystar server is accessible.

Click Test Connection to verify the settings you entered.
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Note:  You can also test whether the Odystar Hub is online by browsing to the following url in your favorite
web browser: http://OdystarServerNameorAddress:5182.

Preflight Tools

Use the Preflight Tools category in the Configure tool to define the settings necessary for Automation Engine to
work with the supported preflight tools.

This is used in the Preflight via External Application on page  task.

Important:

• Your PitStop Server application has to run on your Automation Engine server.
• You must share your PitStop folder (located for example in C:\Program Files\Enfocus

\Enfocus PitStop Server 09) to be able to access it from the Preflight ticket.
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Tool Name: select one of the supported preflight tools.

Report Language: select the appropriate language from the list. The report language selection for Enfocus PitStop
Server can be set in the PitStop Server preferences.

Report Units: select the unit to be used in the preflight report.

Report Type: select the output type of the preflight report: PDF, XML or both.

Executable File: enter (or browse to) the path to the preflight tool executable file.

Profile Folder: enter (or browse to) the path to the folder where the default profiles for the selected preflight tool are
stored.

Action Folder: enter (or browse to) the path to the folder where the action lists for the selected preflight tool are
stored (only from PitStop Server 4). The Preflight task will allow you to select multiple actions from this folder.
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Note:  Tickets created prior to BackStage 7 Release 5 will be loaded with one single action in the list.

Processing Preferences

Embedded images

Normalized PDF files have the ability to save all their images internally, but this may result in oversized files. You
can define the maximum size for internal images here. Images exceeding the defined size will be saved externally.

 

 

Products
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Product Setup

Click Product Setup to customize the Custom Fields that appear in the Products workflow.

 

 

The examples used in the dialog above will result in the following:
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JDF Setup

Check the box to create a Data Zone and File when a new Product is created from JDF.
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Part Description

Data
Zone

Indicates where to create the Data Zone of the Product Part (i.e. the physical folder) when JDF
references an unexisting Product Part.

File Indicates where to create the subfolder and/or file in the Data Zone when JDF references an
unexisting Product Part.

Folder When the box is checked, the structure of the new Data Zone will be identical to the structure
of the file specified.

On the Product Setup and Part Setup tabs, you can add rules to map values from JDF onto the Product attributes
when Products are created via JDF. Specify XPath expressions for each attribute that should be overruled by the
system value.
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For more information about how to use JDF in combination with Products, please refer to the document "JDF and
Products" on the Documentation DVD.

 

 

On the Updating tab, indicate what should happen when a Product that already exists is updated over JDF.

For more information, check ”Create a Product with the Add to Products task" which describes the manual
counterpart.
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Smart Product Location

Smart Product Location is a tool that helps deciding where to place or create product data. It is not needed when your
file is already in the right place when you make it a Product.

It allows you to configure Automation Engine in such a way that the location for a new Product can be extracted from
a set of rules defined in Configure, instead of having to enter this information manually.

This implies that the Product's folder can be set on a Smart path [Smart Product Location].

When creating a new Product manually or via JDF certain pieces of information have to be entered in the system. One
of them is the Product location.

There are three kinds of specifications that you can use to set up the Smart Product Location: Customers, Rules and
Container.

These 3 ways have their own order: if the 'Customers' check does not return an valid path, then level 2 will be
checked etc..
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Automation Engine offers three ways to set rules for Smart Product Location:

• Customers: This is a simple rule based on the customer name only. It allows you to specify 1 smart place for all
Products of that specific customer.

• Rules: Allows you to set extensive conditional rules.
• Container: Allows you to set a fixed Container for all Products to be created (from now on).

Smart Product Location is used in two cases:

• when choosing 'Upload as Product' (for example data that is still on a on a CD or on your desktop)
• when creating/placing Products via JDF

When you selected 'Upload as Product' this panel will show the extra 'Smart Product Location' at the bottom of the
panel.

 

 

Click 'Show Product Location' to see where the uploaded file will be placed.
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The Smart Product Location rules are set in Configure. This is a typical example.

 



Automation Engine | Tools | 723

 

Product Part Data Zone

Every Product Part has a Data Zone. It contains the Product Part file itself and any additional related files.

The depth of the Data Zone indicates the number of folders between the root of the Data Zone and the folder
containing the Product Part.
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The value entered here is used when you change the Product Part Properties File. For example when you browse for a
file which is outside the Data Zone, a new Data Zone is automatically calculated based on the Default Depth value.

Scripts

You can configure your Script Runner to your Automation Engine server. A Script Runner is a stand alone
Automation Engine Server component on which you can create scripts. These scripts can be used in the Run Script
task.

This computer must have Script Runner installed and running. For more information on installing a Script Runner,
refer to Getting Started with Scripting

1. Choose Scripts  from the categories on the left. Choose  File > New .
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2. Give a suitable name to the Script Runner by choosing  File > Rename

3. Enter the computer name or IP address of the local computer in Host field.

4. Enter the Port used to connect this computer to your Automation Engine server.

By default, this is 1983.

5. Click the Test Connection button. You will see all the scripts available on the Script Runner or a message 'No
scripts available'.

RealTimeProof Sites

RealTimeProof is a web approval product from Kodak (merged in 2006 into a new product called 'TeamWorks').
Automation Engine can communicate with RealTimeProof via JDF ('Digital Delivery').

The RealTimeProof Sites node consists of two tabs:

• General
• Roles

General

Set the parameters for the RealTimeProof site as follows:

1. Specify the web address of the remote approval system.
2. Define the location where the publish task will write the JDF.
3. Define the location where the updated JDF will be written.
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Tip:  See the specific Approval installation and configuration documentation on the Scope DVD.

Roles

The roles tab allows you to add, remove or edit roles that will be used when setting up contacts in the Publish on Web
ticket, like for example approve, review... All roles have to match with the types of roles that are used at the remote
approval site.

 

 

Shuttle
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Enter the Port to use for communication between your Automation Engine server and the Shuttle clients.

Note:  By default this is port 5182, but if this port is already used by other processes, you should enter the
next available port.

Choose an Upload Folder using the Browse... button.

This is where Shuttle clients will upload files that are not located in a container (except the Shuttle plug-in, that will
always upload files to the DeskPackContainer).

Note:  The Upload Folder must be located on a container.

Select Start Shuttle server automatically when Automation Engine is started if you plan to make frequent use of
the Shuttle technology.
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Click the Start button to start Shuttle server. This is not required to use the Shuttle application. However, starting
the server is required to use Shuttle via applications like ArtPro, PackEdge and Illustrator. Shuttle server makes
Automation Engine’s workflows, tasks and files accessible to the Shuttle clients.

Save the settings by clicking  File > Save .

Task Cleanup Rules

You can define Task Cleanup Rules to automate the cleaning up of the tasks pane.

These rules can be selected and applied in the Monitor.

1. Click New....

This opens the New Rule dialog box.
2. Enter a Rule Name of your choice.
3. Choose if this rule will Move entries to History, or Delete them.
4. Choose what to apply the rule on: Single Tasks or Chains.
5. Use the Operator tab to choose whose entries you want the rule to clean up.

Select Filter on Operator and select the desired operators (you can also Select All).
6. Use the Time tab to select the entries to clean up based on their date.

Select Filter on Date and choose to move / delete the tasks / chains finished since a certain number of minute(s),
hour(s), day(s) or month(s).

7. If you are cleaning up Single Tasks, you can use the Task Type tab to only clean up certain task types.

Select Filter on Task Type and select the desired task types.
8. Use the State tab to select the entries to clean up based on their state.

Select Filter on State and select the desired states (Successfully done, Done with warning, Cancelled, Failed).
9. When you are done defining the rule, click OK.
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Attention:

The order of the Task Cleanup rules is very important. You have to define them in such a way that a rule does
not block the following rules.

For example, if your first rule moves all successful tasks after two days and the second rule deletes all Proof
tasks after 10 hours, the result will be that the first rule dominates and successful Proof tasks will only be
moved after 2 days (first rule) instead of being deleted after 10 hours (second rule).

You can overcome this behavior by changing the order of the rules (use Move Up / Move Down).

Track Edit Session

Automation Engine can be configured so that all sessions in the Esko editors are logged.

You can view this information in the Task View of the Pilot or as an XML file.
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Select the application(s) for which you want to start the “Track Edit Session” task.

When you open a file that resides in an active Job (folder) in an Esko editor, the Track Edit Session task will
automatically start logging the interactive editing actions. This tracking will stop when the file is closed.

Note:  Keep in mind that the editor needs to be restarted to activate the settings.

Note:  For ArtPro, the Track Edit Session only records session times, not editing details.
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Viewer

About the Viewer configuration settings

When a folder is marked as a Speed Up for Viewing folder, Automation Engine creates View Data for any new files
it finds there every time it accesses the folder (for example when a task writes or reads files in this folder).

The 'Speed up for Viewing' settings in Configure allow you to select:

• which Prepare for Automation Engine Viewer ticket should be used and which types of files should be taken
into account;

• a file streaming session limit.

Note:  Files relating to Digital Film will be handled separation by separation.

How to configure the Viewer

Proceed as follows:

1. In the Preferences for automatic normalization area, select the Normalize ticket of your choice.

Files that have not yet been normalized require a normalization step before Automation Engine is able to create
and show View Data.

2. Select the ArtPro to PDF ticket of your choice.

ArtPro files need to be converted to Normalized PDF before you can view them.
3. Select the Prepare for Viewer ticket you want to use for view data generation.
4. Configure how many Viewers can be used simultaneously to view files with no view data prepared using the File

Streaming Session Limit option in the Server Admin Wizard.

See more in Processing Capabilities
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You can also set your preferences for viewing by enabling the options :Anti-aliasing and /Or Merge Similiar Inks.

WebCenter Sites

Automation Engine users can publish data to a WebCenter project ('delivery') and request to hear the approval status.

'WebCenter Sites' allows you to configure to connection with WebCenter, and to indicate if you want communication
via JDF or JMF.
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Delivery

• Website: Specify the web address of the WebCenter site.

Tip:

After you have filled out the WebCenter address, click “Open” to check if the WebCenter site is up and
running.

If you are redirected to the login page, it means that the address was filled out correctly and that the site is
up and running.



734 | Automation Engine | Tools

To check whether the JDF processor is running, click the “Check” button. After a few moments, you
should get a window saying “Connection OK”, meaning that the built-in JDF processor is running.

Note:

When you connect to a secured WebCenter site (for example one that uses HTTPS://), you have to export
its security certificate and import it on the Automation Engine server, or publishing to WebCenter from
Automation Engine will result in an error.

• WebCenter and Automation Engine are on the same LAN Check this toggle if Automation Engine and
WebCenter’s application server are on the same LAN. This will most likely be the case.

Uncheck this toggle if WebCenter and Automation Engine are remote.
• WebCenter's Approval Client If WebCenter and Automation Engine are remote, you need to create an

Automation Engine Approval client in WebCenter first.

In Configure, fill out the client Name and Password and click the 'Check Connection' button. For more
information, please refer to the section “Create an Automation Engine approval client in WebCenter”

The Info button displays the following information:”In case Automation Engine and WebCenter are not in the
same local area network (LAN), the retrieval of the approval results is secured by a name and password. The name
and password specified in Automation Engine must match the name and password specified in WebCenter by the
WebCenter administrator. When clicking the 'Check' button, the WebCenter version will be checked and the name
and password will be validated by WebCenter.”

Connect to JDF Processor

You can connect to the JDF Processor either via HotFolders, or via JMF.

• Hot Folders

• Upload Folder: this is the folder in which the Publish task will drop the JDF files that contain the information
about the files that need to be approved. Use the “hotin” folder that was created when the Automation Engine
server was configured as a channel on the JDFProcessor for WebCenter.

• Download Folder: this is the folder in which the WebCenter JDFProcessor will drop the JDF files when
approval is finished or failed. Use the “hotout” folder that was created when the Automation Engine server
was configured as a channel for the JDFProcessor for WebCenter. This folder will be registered as a JDF Audit
Hot Folder on the Automation Engine server.

• JMF: check the toggle and keep the default value of the URL field, which is “http://<Automation Engine Server
Name>:4411/JDFP/JMF/”. You can check the connection by clicking the “Check” button.

Tip:

By default, the WebCenter entry on the left-hand side is called “WebCenter” followed by a number. It is good
practice to give this entry a more meaningful name by clicking File > Rename.

Create an Automation Engine Approval Client in WebCenter

If WebCenter and Automation Engine are remote, one has to configure an Automation Engine approval client in order
to give Automation Engine permissions to listen to the approval messages that are stored in WebCenter.

You can create an Automation Engine approval client as follows:

1. Go to the WebCenter site and log in as Administrator.
2. Go to the Admin section and select 'Configurations'. You are now directed to the “Automation Engine Approval

Clients” page.
3. Click the link “New Automation Engine Approval Client”.
4. Fill out a name and a password for the Automation Engine client. You are free to choose your name and password,

but do not forget that this name and password also have to be filled out when configuring the WebCenter site in
Automation Engine.
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 Containers

A container is a special folder containing your files, folders and jobs, that Automation Engine can access. It can be
located either on your Automation Engine server or another machine.

By default, you have an empty ExampleJobContainer, on the drive Automation Engine was installed on.

You can have many containers, that you can see in the Pilots’ Containers mode.

 

 

To create a container, see Creating a Container.

Creating a Container

To create a container, do the following:

1. Go to  Tools > Containers to open the Containers window.
 

 

2.

In that window, go to  File > New or click .

This opens the Create Container Wizard.

3. Click Next in the wizard’s first screen.

4. Select either:

• Local Folder on the Server to create a container on your Automation Engine server,
• Existing Shared Folder
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5. Click Next.

6. If you selected Local Folder on the Server:

a) Select in which drive you want your container to be.
 

 

Selecting a drive shows the containers already existing on that drive.
b) Click Next.
c) Enter the name to give your new container.
d) Enable Make this Job Container available for Macintosh if you want to be able to access it from Pilots

running on Macintosh machines.
e) Click Next.

Your container is created.
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f) Click Next to create another container, or Finish to leave the wizard.

7. If you selected Existing Shared Folder:

a) Enter the Computer Name of the machine where the share folder is located, or use the Browse... button to
select that machine in your network.
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b) Click Next.
c) The wizard shows a list of all available shares on that machine. Select the share you want to use as a container.
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Attention:  The existing shared folders will not be displayed if the system does not recognize the 
bgsystem user (ask the default password to Esko).

d) Click Next.

Your container is created.
e) Click Next to create another container, or Finish to leave the wizard.

Deleting a Container

You can delete a container from Automation Engine without losing the container’s contents. Deleting a container 
simply makes its contents invisible to your Automation Engine server.

To delete a container:

1. Select the container to delete in the Containers window.

2.
Click  or use to  File > Remove.

Note:

If there are jobs in the container you want to delete, they will be listed in the confirmation dialog. 

If you delete the container anyway, the job folders will become normal folders.
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Relocating a Container

If one of your containers goes offline (for example the disk hosting it crashes) but you have a backup of it, you can
restore this container on another disk.

 

 

1. Select the offline container and go to  Edit > Relocate.

2. Enter the name of the computer you want to restore your container on, or browse to it.
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3. Select the share you want to restore your container on.
 

 

The Select the share dialog shows all shares available on the computer you have chosen.
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4. Click OK in the Select the new location of this container dialog.

Your container is now restored on the share you selected (and has the name of the share).

 

 

Refreshing the Containers’ List

The containers’ availability is automatically checked every 5 minutes. If you need to check it manually/refresh the
connection, you can:

• go to  Edit > Rescan,
• use CTRL + R,
• press F5 in the Pilot’s Files view when using the Container mode.

Customers

This tool allows you to manage the customers list on your system. The goal is to retrieve these customer details
automatically from your MIS system, via JDF/JMF.

A customer has an ID, a name and a description.
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Customers menus

File

• New Customer [CTRL + N]: opens the 'New Customer' dialog. You can also click the new customer icon in the

toolbar 
• Modify Customer...: allows you to edit the selected customer data.
• Close Window [CTRL + W]: closes the Customer tool.

Edit

•
Delete [Del]: removes the customer from the list. You can also use the delete button 

New Customer
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The General tab contains three fields:

• ID
• Name
• Description

In the Contacts and Address tab, 3 contact names with e-mails and detailed addresses can be specified.

The Additional Info tab provides 5 extra custom fields for even more information.

This data will be used in the customer tab of the Job Setup.

To edit the data select Modify Customer from the File Menu or double-click a customer in the list.

Users

To manage users, go to  Tools > Users...  in the Pilot to open the Users window (or click Users under Tools in the
Pilot left pane).
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From this window, you can:

• create a user (see Creating Users on page ),
•

delete a user (select the user to delete and click the delete icon ),
• view which group a user belongs to,
• view which users are logged on,
• change users' propert
• go to Access Rights , Red Alerts, and Connections).

Menus in the Users window

File Menu

The File Menu consists of the following items:

• New User... allows you to create a new user. For more information, see Creating Users on page .
• New Action... opens the New Action window, allows you to add a Milestone action to an user.
• Delete deletes the selected user(s).
• Properties... displays the selected user's properties. For more information, see Properties.
• Close Window closes the Users window.

When the tab Groups is selected, the File menu contains:

• New Group... allows you to create a new user group. For more information, see Creating Groups on page .
• New Action..., Delete, Properties and Close Window.

Edit Menu

You can use the Edit menu to Copy and Paste a user's Favorites, Views and/or Red Alerts to another user.

Note:

• Regular users can only copy Favorites from another user and paste them to their own user profile.
• Administrators can copy and paste Favorites, Views and/or Red Alerts as they wish.

They can also copy Favorites to multiple users.
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View Menu

The Users window has two ways of presenting things:

1. Users: shows all defined users and lists their access rights,
2. Access Rights: displays all access rights and lists all known users.

You can also click the Users and Access Rights buttons.

Creating Users

1. In the Pilot, go to  Tools > Users .

2. In the Users window, do one of the following:

• go to  File > New User ,
• use the CTRL + N shortcut,
•

click the  icon.

The New User dialog opens.

3. Enter the user's Name, Full Name, Password, Description and valid E-mail address.

4. If you want the user to be able to administer Automation Engine, check the toggle.

This will give all user access rights to that user.

5. Click OK to add your new user to the Users list.

Attention:

Automation Engine requests permission from the Windows OS while creating a user. Therefore, some
changes (for example, changing the password) require the use of Windows User Administration tools.
These changes must also meet the existing domain policies (for example, the length and complexity of the
password).

Properties

Tip:  Double click a user to open the Properties window.
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• The General tab lists information entered when creating the user.

Note:  The information cannot be edited in any way, except for the e-mail address (click the Change
button to make the field editable).

• The Views tab lists which Views the user has access to (see Views on page ).
• The Access Rights tab lists the user's access rights (see Defining User Access Rights on page ).
• The Red Alerts tab lists which Red Alerts are presented to a specific user (see Red Alerts on page ).
• The Connections tab lists from where and with what application the user is connected to the server. Naturally,

several connections are possible and the Connections tab will be empty when the user is logged off.

Defining User Access Rights

Not all users have the same responsibilities, so you can assign them different access rights in Automation Engine.

• To give access rights to a single user:

a) in the Users window, double the user you want to give access rights to,
b) in the Access Rights tab of the Properties window, check the access rights you want this user to have.
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Note:  Automation Engine Administrators automatically have all access rights. You cannot change this.

• To give a particular access right to several users:

a) in the Users window, click the Access Rights button to switch to the Access Rights view,
b) select the access right you want to give to your users,
c) check the users you want to give this access right to.

 

 

Access Rights

This access right: affects...

Containers: create / delete Creation and deletion of containers.
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This access right: affects...

Files: copy / move / delete files on
disk

what you can do with files in the Pilot interface. See the Copy
or Move File on page  and Delete File on page 
tasks.

Hot Folders: create / modify / delete if you can manage Hot Folders or not. See Creating a Task
Hot Folder and Modifying Hot Folder Settings in the User
Guide.

Job Parameters: create / modify /
delete

what you can do with Job parameters. See Job Parameters.

Jobs: create / modify / delete if you can manage Jobs or not. See Creating a Job on page
.

Monitor: move tasks to trash or
history

what you can do in the Tasks list. See Tasks list and Task
History on page .

Pilot : Start the Pilot (in addition to
Shuttle)

your access to Pilot

Queues: stop / start device queues what you can do with Queues. See Queue Monitor on page
.

Task launching: set priority
(immediate / high)

if you can set a higher priority to the tasks you launch.

Tasks: ink remapping in inks panel if you can edit inks when ripping to a TIFF file or proofing to
Kodak Approval.

Tickets: create / modify / delete
(Global and Job tickets)

if you can manage Global and Job tickets. See  Tickets on page
 and Working with Tickets on page .

Tickets: create / modify / delete (Job
tickets only)

if you can manage Job tickets. See Working with Tickets on
page .

Tickets: Show All Tickets and their
Parameters (Public and other)

what tickets and parameters you can see in the Pilot (in the
Tickets View, when launching a task / task chain / workflow
on the file in the Files View, or when opening a processed file
from the Tasks list).

If this is deselected, you will only be able to use:

• public tickets (see  Tickets on page ),
• public parameters in those public tickets (see Using Public

Parameters),
• the Launch with option on files (not the New Task

option) (see Launching a Task on a File and Launching a
Workflow on a File),

Note:

• Newly created users have this access right by
default.

• You will not be able to create any ticket if you
don't have this access right.
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This access right: affects...

• Users with this access right can use a Pilot
preference to simulate how the Pilot would look
without this right (see Tickets Preferences).

This is useful for administrators who want to
check how users without the full Pilot access right
will see the tickets and their parameters.

Upload points: Create/Modify/
Delete

whether you can create/modify/delete Upload points

Viewer : Deep Zoom the deep zoom rights in unprepared files as well as very deep
zoom viewing in prepared files.

Views

For Administrator Users

As an administrator, you can decide:

• which views you want to see and which not,
• which views other (non-administrator) users are allowed to see.

In the example below, the user called johndoe is not allowed to see the Milestones and Hot Folders views.

 

 

Note:

You can also setup the views assigned to users from the Pilot's Views pane:

1. Right click in the Views pane and select Select Views...
2. The Properties window opens, showing the Views available for the user currently logged on. Select or

deselect views as necessary.

Administrators can also copy the view settings of a user to one or several other users:



Automation Engine | Tools | 751

1. Select the user you want to copy the settings from, and go to  View > Copy Views  (or click right that user and
select Copy Views).

2. Select the user you want to give the settings to, and go to  View > Paste Views  (or click right that user and select
Paste Views).

For Non-Administrator Users

As a non-administrator user, you can only remove some of the available views for yourself. You cannot add views
that the administrator disabled, or change the views for another user.

In the example below, the Milestones and Hot Folders views are not available because the administrator disabled
them for this user.

 

 

Note:  When a user has changed his own view preferences, Automation Engine will automatically refresh
after closing the Users window.

Red Alerts

When certain events are detected by the Automation Engine server, a Red Alert is broadcast to users.

Use the Red Alerts tab in the user Properties to configure which Red Alerts are shown to a specific user (deselect
the alerts you down want to show to that user).
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Groups

Creating Groups

1. In the Pilot, go to  Tools > Users .

2. In the Users window, go to Groups tab.

3. Do any of the following action in the Groups tab.

• Go to  File > New Group.. .
• Use the CTRL + N shortcut.
•

Cllick on the  icon.

The New Group dialog opens.
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4. Enter the Name, Description and select a Color for the new Group.

5. Click OK. The new Group will be added to the database.
You can view the existing Groups under the Groups tab.

Defining Group Access Rights

You can assign relevant access rights to your Groups.

• In the Users window under the Group tab:

a) Double-click the group to which you will assign access rights.
The Properties window will pop up.

b) Check the access rights relevant for the group in theAccess Rights tab of the Properties window.
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Note:  Automation Engine Administrators automatically have all access rights. You cannot change this.

• You can give a particular access right to several groups/users in one go. Read more in Defining User Access
Rights on page 

A Group member has access rights that are assigned to the Group. This overrules the User Access Rights
previously defined. If a user is a member in differerent groups, the relevant access rights will be a sum of the
access rights assigned to these groups.

Assigning a Group to a User

• To assign members to a specific Group:

a) Go to the Groups tab.
b) Click on one of the Groups. All the users will be listed underneath.
c) Select the users to be assigned to this group from the list.
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• To assign a Group or Groups to a User:

a) Double-click the user from the Users wndow.
b) Go to the Groups  tab of the User properties window.
c) Add the member to one or more of the groups from the group overview.

Upload Points

Upload points are scanning points which will scan and download files to Automation engine from FTP sites or
mailboxes. Supported protocols are :

Supported Protocols Protocols Not Supported

FTP (FTPS) HTTP GET : scanning foreign websites

MAIL  (pop3/imap) HTTP POST : channel for uploading files via
HTTP POST

Mail Upload points

These Upload Points can be placed on the Automation Engine user's (or the client's ) infrastrcuture. When an
incoming mail with an attachment is scanned, these Upload points upload them to Automation Engine's designated
folder and delete the mail.

FTP Upload Points

FTP Upload Points can be placed on the infrastructure of the Automation Engine user or on their customer's
infrastructure. The Upload point scans the configured folder (including the subfolders) on the FTP site regularly.
When a new file is noticed, the upload point downloads it to the designated location and deletes the file. However, the
folders (subfolders) are not deleted retaining the FTP site's folder structure.

Creating Upload Points

The Upload Points is available under Tools view in the Automation Engine Pilot where you can :

•

create a new Upload Point by clicking on the New Upload Point icon  in the toolbar or by choosing  File
>  New Upload Point . Read more in

•

duplicate an Upload Point. Select the Upload Point you want to duplicate and click on the Duplicate 
icon in the toolbar.

•

delete an Upload Point. Select it and click on the Delete  button in the toolbar or choose  File > Delete .
You can also delete multiple Upload Points.

•
use Scan Now icon  to scan for incoming files at the selected Upload Point.

• activate or deactivate an upload point. Do the following:

1. select the Upload Point
2. right-click
3. click on Activate Upload Point or Deactivate Upload point.
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Note:  This view is available in Container Job overview modes.

Creating Upload Points

Creating Upload points for Mailboxes

You can Create/Duplicate/ Modify Upload Points.

Note:  The user requires an access right:  Upload Points: create/modify/delete

1.

In the Automation Engine Pilot, go to the dedicated Upload Poiuts view under tools and then click on .
Alternatively, go to  File > New .

You can see all created Upload points in the Upload Points view. You can duplicate the settings of a specific

Upload Point by selecting it and clicking on 

2. In the resulting window, select Mail and click OK.
New Mail Upload Point window will open up.

3. Enter a Name for the Upload Point.

4. Define the Settings for the Upload Point.
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• Incoming Mail Server: enter the mail server name
• Account Type: depending on your mailbox, choose from POP and IMAP
• Secure Mail: check this if it is secure mail box
• User Name: username used to access the mail account
• Password: password of the mail account
• Customer: give the customer details

5. Define the Action to be performed on incoming mail attachments.

• Move Files to: choose from:

• Hot Folder.
• Folder : which is a typically a Job folder.
• Customer Upload folder : which is a semi-fixed folder per customer.

Note:  To use the Customer Upload folder, you need to link the Customer in the Settings
mentioned above.

• Folder: enter the folder path or use browse to locate the folder. Or use SmartNames to specify the destinataion
folder.

Note:

• Rename Files To: specify the file names. You can use SmartNames to change the file names
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Creating FTP Upload Points

1.

In the Automation Engine Pilot, go to the dedicated Upload Poiuts view under tools and then click on .
Alternatively, go to  File > New .

You can see all created Upload points in the Upload Points view. You can duplicate the settings of a specific

Upload Point by selecting it and clicking on 

2. In the resulting window, select FTP and click OK.
New FTP Upload Point window will open up.

3. Enter a Name for the Upload Point.

4. Define the Settings for the Upload Point.

• Server: give the name of the server
• File Transfer: Choose from ASCII and Binary.

Tip:  Binary will always work, but if you have an ASCII file, the transfer will go a bit faster when
selecting ASCII.

• Connection Mode:

• Passive:

Tip:  By default, the transfer uses Active Connection Mode (where the FTP server opens the data
connection). If your system is behind a firewall that blocks incoming FTP server connections,
select Passive to use Passive Connection Mode (where the client initiates the connection).

• Select Secure FTP if you are connecting to a secure FTP server (over FTPS, not SSL or SSH).If you are
experiencing problems using secure FTP, try connecting over regular FTP, and ask your IT administrator to
check the security settings of your FTP server.

• User Name: Enter the User Name and Password you use to connect to the FTP server.
• Customer: optionally give the customer details

5. Define the Action to be performed on incoming mail attachments.

• Move Files to: choose from:

• Hot Folder.
• Folder : which is a typically a Job folder.
• Customer Upload folder : which is a semi-fixed folder per customer.

Note:  To use the Customer Upload folder, you need to link the Customer in the Settings
mentioned above.

• Folder: enter the folder path or use browse to locate the folder. Or use SmartNames to specify the destinataion
folder.

Note:

• Rename Files To: specify the file names. You can use SmartNames to change the file names
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Using SmartNames

 What is a SmartName?

A SmartName is a variable that refers to a predefined value, for example [File] refers to the name of the input file,
and [Date] refers to the current date. SmartNames are for instance used in the Automation Engine panels to define
the output folder and output name of the different tasks.

You can use SmartNames to fill in settings all across Automation Engine. They are displayed in green and between
square brackets.

 

 

You can also combine them with plain text.

 

 

Using SmartNames ensures you can use existing information as a setting without having to remember it, and reduces
errors.

SmartName Scope

You can use SmartNames anytime you see the SmartName symbol  in a text field.

But depending on where you are in Automation Engine, different SmartNames may be available.

Global SmartNames

Those SmartNames are available everywhere in the application.

SmartMarks SmartNames

Those SmartNames are only available when using SmartMarks.

Step and Repeat SmartNames

Those SmartNames are available in Step and Repeat tasks.

Stripping SmartNames

Those SmartNames are only available when retrieving values from JDF files (with the Import JDF Stripping task).

Imposition SmartNames

Those SmartNames are available in when working with impositions (for example, in the Export Imposition to PDF
File ticket).

Unit textfield SmartNames

SmartName enabled unit textfields are available in tasks where units have to be entered. You can do unit conversions
and simple arithmetics using the operators +, -,* and  / . You can also use brackets if necessary while calculating.
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UploadCenter SmartNames

These SmartNames have a limited scope of use. They are only available while working with the UploadCenter. Read
more in

Default SmartNames

Default SmartNames come with Automation Engine. They are System Value SmartNames, with means they refer to
a value in the internal Automation Engine database.

For example, [CSR for the Job] refers to the name of the selected job’s Customer Service Representative, while
[Date] refers to the current date.

Default SmartNames can have different scopes. See SmartName Scope).

SmartNames Categories

Default SmartNames with a Global scope are sorted into categories, so you can find them more easily. These
categories are:

Date

Use SmartNames of this category to insert the current date or time.

File Information

SmartNames of this category correspond to file-related information in the Automation Engine database (file name,
type, extension...).

Job Information

These SmartNames refer to job information you entered when you created the job (see Creating a Job in the User
Guide). They include customer information, job due date, job location...

Miscellaneous

These SmartNames return the name of the Automation Engine server(s). They are useful when running distributed
processing.

Path Information

These SmartNames correspond to job location values (file’s original and temp folder location).

Product Information

SmartNames of this category correspond to product-related information in the Automation Engine database (product
ID, description, Product and Product Part Parameters...).
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Product Parameters

SmartNames of this category correspond to product specific parameters. This category is only available tasks and
workflows if input Product Setup contains Product Parameters. Read more about setting them up in : Parameters Tab
on page 84 and about using them in : Using Product /Product Part Parameters.

Product Part Parameters

These are Product Part specific parameters. This SmartName category is available in workflows and tasks where input
Product Part Setup contains Product Part Parameters. Read more about setting them up in : Parameters Tab on page
86 and about using them in : Using Product /Product Part Parameters

Task Information

Use SmartNames of this category to insert task-related information (task name, operator, application version...).

Workflow Parameters

These are workflow specific parameters. This SmartName category is available in workflow where input Workflow
Parameters are defined. Read more about setting them up in : Creating Workflow Parameters and about using them
in : Using Workflow Parameters

Creating a SmartName

You can create your own custom SmartNames in addition to the default ones. These are available for use in:

• all tasks to smarten up your output paths and output file names.
• graphic templates like SmartMarks sets.
• ReportMaker and DesignWizard templates.
• other places in tools and tasks (Notifications, FTP task, tabular Step and Repeat task, Job setup fields etc..).

1. Select  Views > SmartNames  in the Pilot.

2.
Click on the New SmartName icon  in the toolbar. Alternatively, choose  File >  New SmartName .

This opens the Add SmartName dialog.
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Note:  In the Add SmartName  dialog, to make all options available, click on the disclosure button next
to the Name field.

3. Enter a Nameand a suitable Description for your SmartName.

You can select Private. Private SmartNames are not visible when applying SmartNames in a ticket.

4. Choose your SmartName’s Scope:

Choose... if you want to use this SmartName...

Global everywhere in Automation Engine

.

SmartMarks where Automation Engine uses SmartMarks
(for example in the Create Design
(DesignWizard) task).

Step and Repeat in Step and Repeat tasks.

Stripping when retrieving values from JDF files (with
the Import JDF Stripping task.,

Imposition when working with impositions.

UploadCenter when you want to limit the SmartName use to
the UploadCenter.
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Tip:  Set the SmartNames you want to use in tickets' output fields to Global.

5. Choose your SmartName Type:

Choose... to create a SmartName that...

Database Query retrieves a value from an external database,

String Extract extracts a string from other SmartNames,

System Value retrieves a value from Automation Engine’s
internal database,

Script uses JavaScript to define a value,

XMP XPath retrieves a value from the XMP metadata
section of a normalized PDF file,

XPath retrieves a value from an XML document.

Conditional resolves when specified conditions are met.

6. Define the Details of your SmartName, depending on the SmartName Type you have chosen.

See Creating a String Extract SmartName and

Creating A Conditional SmartName as examples.

7. Click OK.

You can use Save As... in the Add SmartNames dialog to enter a new name for the SmartName. This is useful
when creating multiple variations of a SmartName one after the other from the same dialog.

8.
Check the result of the new SmartName in using Preview  feature. Read more about previewing in Using
Preview to Check SmartName Results

Creating a String Extract SmartName

This SmartName extracts a string (a series of characters) from another SmartName’s value.

For example, it can extract part of a file name. This is especially useful if you use a fixed structure when naming your
files.

After choosing the String Extract Type in the Add SmartName dialog, fill in the Details area:
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1. To choose the SmartName you will extract a string from:

a) click  in the Extract part of: area,
b) in the Insert SmartName dialog, select your desired SmartName and click Insert,
c) click Close when you are done.

2. Choose the extraction method to use:

• Start from Position: use this to extract a certain Number of Characters from the SmartName value, starting
from a specific character (Position).

For example, to extract label from the file name Orange_label_report.pdf, use this:
 

 

The string label starts at the 8th character, and is 5 characters long.
• Use Separation Character: use this to separate the SmartName value into parts every time a certain

(Separation) Character occurs, and extract one of the parts.

For example, to extract label from the file name Orange_label_report.pdf, use this:
 

 

This separates the string at each underscore, and extracts the second part of the string (label).
• Regular Expression: use this to extract certain characters from the SmartName value using a Regular

Expression.

Note:  Use parentheses around the part of your regular expression matching the string you want to
extract.

For example, to extract label from the file name Orange_label_report.pdf, use this:
 

 

This regular expression translates as:

.*_: any character, 0 or more times, followed by an underscore,

(.*): any character, 0 or more times,

_report.pdf: the string “_report.pdf” at the end.

This extracts the set of characters after the first underscore and before _report.pdf (label).

Note:  For more information about Regular Expressions, see Regular Expressions.

Regular Expressions

The Use of Regular Expressions in Automation Engine

Regular expressions are text patterns that are used to match strings.
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They can contain a mix of plain text and special characters to indicate what to match.

Character Description Example

^ Beginning of the string. ^abc will only
lead to a match if the string begins with
abc.

^C matches Cyan but doesn't match
PANTONE 120 C.

$ End of the string. xyz$ will only lead to
a match if the string ends with xyz.

120$ matches PANTONE 120 but
doesn't match PANTONE 120 C.

. The . matches any character. ab.d matches abcd as well as ab9d or
ab-d.

[abc] Brackets enclosing a set of characters
indicates that any of the enclosed
characters may match the target
character.

[abc] matches a, b or c but doesn't
match x or y.

[^abc] The ^ inside the brackets means that
none of the enclosed characters may
match the target character.

[^abc] matches x or y but doesn't match
a, b or c.

[a-zA-Z] The - inside the brackets is used to
show a range of characters.

[a-zA-Z] matches all upper and
lowercase characters, [0-9] matches all
digits.

\d matches a numeric character (digit)
(exactly the same as [0-9]).

\d\d matches 96 but doesn't match 5a.

\D matches any non-numeric character
(exactly the same as [^0-9]).

\D\D matches A+ but doesn't match
A4.

\s matches a whitespace. \d\s matches '5 ' but doesn't match 5a.

\S matches any non-whitespace character. \s\S matches ' 6' but doesn't match ' '.

\w matches an alphabetic (word) character
(exactly the same as [a-zA-Z0-9]).

\w\w matches 9d but doesn't match 5+.

\W matches any non-alphabetic character
(exactly the same as [^a-zA-Z0-9] or [^
\w]).

\W\W matches '+ ' but doesn't match
5+.

? The ? matches the character to its left 0
or 1 times.

esk\w? matches esk as well as esko but
doesn't match eskonv.

* The * matches the character to its left 0
or more times.

esk\w* matches esk as well as Esko.

+ The + matches the character to its left 1
or more times.

esk\w+ matches esko as well as Esko
but doesn't match esk.

{n} The {n} matches the character to its
left exactly n times.

a{3} matches aaa but doesn't match aa
or abc.

{n,} The {n,} matches the character to its
left at least n times.

a{3,} matches aaa or aaaaaa but doesn't
match aa or abc.

{n,m} The {n,m} matches the character to its
left at least n times, but no more than m
times.

a{3,5} matches aaa, aaaa or aaaaa but
doesn't match aa or aaaaaa.
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Character Description Example

\ The \ can precede a special character
(like * or [) if you want to search for it
literally.

esko\\artwork\*nv matches esko
\artwork*nv.

Some More Examples

Example Matches Doesn’t Match

\d{6}-\w{5}-\d{1,3}\.pdf 312454-ESKO4-1.pdf

235682-USA12-23.pdf

31245A-ESKO4-1.pdf

312456-USA-23.pdf

PANTONE \d+ C$ PANTONE 120 C

PANTONE 15 C

PANTONE 120 U

PANTONE 15 CU

[Yy].* Yes

y

N

no

(Cyan)|(Magenta)|(Yellow) Cyan

Yellow

Black

Cyan SpotColor

Creating A Conditional SmartName

Conditional SmartNames get their values returned when specified conditions are met. From Automation Engine
12.1 onwards, you can create conditional SmartNames without writing a javascript. While creating a conditional
SmartName:

• you can set a number of Conditions(IFs) and an alternative block(Else).
• these conditional blocks will be evaluated in the set order.
• SmartNames will be resolved when specified conditions are met.
• if conditions are not met, SmartNames will resolve based on the alternative (Else) block if specified conditions

remain unsatisfied.

1. Select  Views > SmartNames  in the Pilot.

2.
Click on the New SmartName icon  in the toolbar. Alternatively, choose  File >  New SmartName .
This opens the Add SmartName dialog.

3. Set the IF conditions depending on your requirement. Each conditional block can have one or more criteria. You
can set If  All/Any/None of the following are true to specify which of the criteria apply.

4. Specify the Return value for each of the conditional blocks. You can also add more conditional blocks(Ifs) using
Add in Windows or + in mac.
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• The new conditional block will be added at the end. This will contain one criterion by default and will contain
the value as in the previous condition.

Note:  The conditions and the return value are SmartName enabled.

• When you rightclick on a IF condition, you will get a menu with Duplicate, Move Up and Move Down. You
can also drag a condition up or down.

• You can use Remove(- on mac) or x at the top right corner of each conditions to delete them.

a) You can set criteria for each If condition. You can select the attribute of the criteria from the dropdown on the
left. Choose File or Other.

If you choose Other, a dialog containing all the available attributes will pop up. You can also define a new
attribute for Other. For example, PageHeight, PageWidth and so on.

b) Select the text expression or the number expression from the drop down list.

You can choose any of the following expressions from the dropdown depending on whether it is a text or
numeric condition.
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• For a text criterion, choose from the following expressions:

• Contains, begins with, ends with, is andis empty.

You can use   (space) for AND and ; for OR. For example, a text criterion specifying:

• Inkname contains Pantone C " will resolve with an Ink name with Pantone and C.
• Inkname is C; M; Y; K; will resolve when Inkname is any of these.
• You can use double quotes to specify the exact text corresponding to the attribute. For example,

Inkname contains "cyan" will only resolve for "cyan".
• For a number criterion, choose from the following expressions:

• equals, is greater than, is less than, and is between.

• When using these expressions:

• if the attribute does not correspond to a number, it will be ignored
• you can use standard unit symbols. If you specify equals5mm, it will resolve to an attribute which is

3inches.

Note:  You should form criteria with units that are convertible. If the specification is
equals5mm , it will fail to resolve to an attribute "6ppi" or "6".

Note:  Your specified number expressions will not resolve to text strings. For example,Job Name
equals MyJobName will be ignored.

Note:  Quotes (") and semicolons (;) are not accepted as values in the text and number conditions.

c) Add and specify more criteria.

You can add more criteria to a condition using +. If you hold alt while clicking on +, a logical operator will
appear. You can add sub-criterions to each of the criteria.

Note:  The last criterion of a conditional block cannot be removed.

5. Set the alternative as the Return value under If none of the above match.

Note:  You cannot delete the alternative block.

6. Click OK.
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System Value SmartNames

Creating a System Value SmartName: Product Part Data Zone Smart Names

You can use  System Value  SmartNames to comply with naming conventions. System value SmartNames are
typically used for matching Job URLs and Product Part Data Zone URLs.

Product Part Data Zone SmartName retrieves the DataZone URL (of the product part) from the Automation Engine
Products  Database.

In the example screen shot, Automation Engine will search for the Product with name corresponding to the input File 
Name of the input File. The resolved value will be the DataZone URL where the first Product Part is located. If you
have checked more Details, the Product that matches at least one of them will be used to resolve the SmartName.

 

 

Note:  If there are multiple Products which match the selections, the first Product Part will be used to resolve
the SmartName.

System Value SmartNames : Upload Center SmartNames

You can use Upload Center SmartNames in Upload Points to:

• comply with naming conventions. For example, you can use the default System Value SmartName
UPMailSubject to synchronise the file name with the mail subject.

• to create temporary customer related folders. for example, a new subfolder per day.
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Using Preview to Check SmartName Results

1.
You can Preview results of SmartNames by clicking on  icon in the SmartNames View.
There will be a Result column in the Preview mode. The values in the Result column are resolved depending on
the :

• the server
• the job in the Job context
• Task. To select a task to be used for resolving, click the "Browse" button in the text field beneath the

checkbox labelled "A task"
• example values

2. You can select either a Task or a File to resolve a SmartName by using the Browse.
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Note:  When a file is selected, the job  context is taken from the job the file is associated with instead of
the current job context.

3. You can set Example Values for certain SmartNames by entering the example valuel in the text field Set
example values. Press Enter

Note:  Set Example Value field will be disabled if the selected SmartName does not support example
values.

To view the result values as plain text, without the replacing of known/unknown SmartNames, click the checkbox
"Plain text"

In the Results,

• the known and unresolved SmartNames will be shown within the green square brackets (in green font).
• the unknown SmartNames will be shown in red font.
• you can refresh the Result values by clicking on Reload Resolved Values.
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Product Part Parameter and Workflow Parameter SmartName in Preview

The SmartNames Table in the Preview mode by default lists all SmartNames except Workflow parameters and
Product/Product part parameters. However you can select the specific Workflow or Product (Product Part) to bring
in their parameters into this SmartNames Preview. This preview can be used to create new SmartNames based on the
listed ones.
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In the SmartNames Preview, there is a section Include SmartNames from. Here you can select a Workflow
Parameter or  Product or Product Part Parameter.

If you select a Workflow the Workflow Parameters defined in the workflow are added to the Preview table. When a
Product/ Product Part is selected, Product or Product Part Parameter SmartNames is added.

You can select a Workflow parameter or Product Parameter independently of each other.

Using a SmartName

You can use SmartNames anytime you see the SmartName symbol  in a text field.

1. Click .

2. In the Insert SmartNames dialog:

a) browse to your SmartName using the Categories,
b) select it,
c) click Insert.

You can also double-click the SmartName.

 

 

Tip:

• You can type the first letters of the SmartName you are looking for to show it in the list.
• The dialog closes automatically after inserting a SmartName. To keep it open (to insert more

SmartNames), hold Alt while clicking the Insert button or double-clicking a SmartName.
• If there are several SmartName-enabled text fields (in a ticket for example), keep the Insert

SmartNames dialog open and just click on the next SmartName-enabled field to insert SmartNames in
it.

• You can choose a smartname as Folder of first input of master workflow from Task information or
Name of folder of originating input of (enclosing) workflow  from Workflow context to keep the
names of folders from the original input for the output
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Using the ScriptRunner

Concept definition.

Scripting for Script Runner On Mac OS.

A Script Runner on Mac OS supports AppleScript and Shell Script to automate operations.

Note:

Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These scripts are solely
intended to demonstrate techniques for accomplishing common tasks. Additional script logic and error-
handling may need to be added to achieve the desired results in your specific environment.

 

It is up to the user to verify that his intended use of the offered automation functionality is compliant with any
third party license agreement and/or other restrictions applicable to any non-Esko products.

Using AppleScript on Script Runner

AppleScript is a scripting language that makes direct control of scriptable applications and of many parts of the
Mac OS possible. An AppleScriptable application is one that makes its operations and data available in response to
AppleScript messages, called Apple events.

We recommend using AppleScript because:

• it is highly integrated into the Mac OS
• it is supported by a lot of third party applications
• it has a high level of accessibility for scripting beginners

1. Open the AppleScript Editor and add following code.

Options Description

main This function will be called by the Script
Runner. Only the code in this main function
gets executed.

inputs The first argument of the main function: a list
of input file paths (type: list of strings).

outputFolder Second argument of the main function: the
folder where AE expects the script’s result
files. AE will continue the flow with the
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Options Description

files you write in this folder. If you leave
this folder empty, AE will continue the flow
with the inputs of the Run Script task (type:
string).

params Third argument of the main function:
additional script parameters injected into the
script via the Run Script ticket (type: list of
strings).

log Extra log information in the Run Script task
details

return “OK” This will communicate with the Run
Script task that everything went fine. Other
possibilities are return “Warning” and
return “Error”.

2. Save this code as an AppleScript text file in the Script Runner’s AppleScript folder (default: /Library/Scripts/
Esko/AppleScript) or in the Automation Engine AppleScript folder.

Note:  Script Runner supports ‘Text’ format. Therefore it is essential to change the file format to ‘Text’.

3. You can add following code to test this script locally in the AppleScript Editor. Save the file and click Run to
execute the script.
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Notice the ‘Hello, World!’ and ‘OK’ result in the event log. The Script Runner does not attend to the test code in
your script. It will execute the contents of the main function and ignore the rest. Therefore, you can keep your test
code for future local testing.

4. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New Task. Choose
the Run Script task, modify its settings and launch the task.
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Read more in Run Script

Note that the ‘Hello, World!’ in the task details and ‘OK’ state are corresponding with log “Hello,
World!”’ and ‘return “OK”’ in the script.

Using AppleScript On Script Runner: A Sample Case
In this example, we use AppleScript to copy every input file with a size smaller than the size specified in the script
parameters to the output folder.

We can use inputs, outputFolder and params in the AppleScript to achieve our objective. First, we
demonstrate how to duplicate files without the size restriction and then proceed with the actual case.

1. Open the AppleScript Editor and add the code given below. This code is aimed to iterate through the list of inputs.
It enables you to handle the inputs one by one, via the ‘input’ variable.
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2. You can modify the Script as given below to duplicate the files to a specified output folder without size
restrictions. Save this code as an AppleScript text file in the default AppleScript folder of Script Runner(default: /
Library/Scripts/Esko/AppleScript) or in the Automation Engine AppleScript folder.

3. Add the file size check in the code as given below. This will duplicate the file when the input file size is smaller
than the maximum size from the script parameters. If this condition is not met it will add an entry in the log and
there will be "Warning". Save the file.
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4. Open the Automation Engine Pilot. Go to Files view where you can select the files to be copied and open a New
Task. Choose the Run Script task, modify its settings and launch. This modified ticket will duplicate every
selected file which is smaller than 10MB to the current job’s Script Output folder. In this example, we excuted this
task for two files(Blairon.pdf: 22MB and Dansk Droge.pdf: <1MB).

‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to duplicate (>
10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task details.
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Using Shell Script on Script Runner

In this example, we use a Shell Script to copy every input file with a size smaller than the specified size in the script
parameters to the output folder.

1. Open a text editor and add following code. When the Script Runner executes this code, $1 (the script’s first
argument) will contain a string of input file paths separated by :. The code splits up the concatenated file paths
into a real list. This helps to iterate through the list and handle the Run Script task’s inputs one by one.

2. Write and save the code as below. This script copies the input to the output folder if the input’s file size is smaller
than the maximum size from the script parameters. If the size of the file is bigger, it adds an entry in the log and
makes sure the task ends in ‘Warning’ state (via exit value ‘1’). Save this code as a text file to the Script Runner's
Shell folder (default: /Library/Scripts/Esko/Shell) or to the Automation Engine Shell folder.



782 | Automation Engine | Using the ScriptRunner

$1 First shell script argument: the Run Script
task’s inputs. A string of input file paths,
separated by ‘:’.

$2 Second shell script argument or output folder:
This is the folder where Automation Engine
expects the script’s result files. AE will
continue the flow with the files you write in
this folder. If you leave this folder empty, AE
will continue the flow with the inputs of the
Run Script task.

$3, $4, $5, … Remaining shell script arguments: additional
script parameters which you can inject into
the script via the Run Script ticket.

exitValue Ending Status of the task

0 OK

1 Warning

2 Error

3. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New Task. Choose
the Run Script task, modify its settings and launch. This modified ticket will duplicate every selected file which
is smaller than 10MB to the current job’s Script Output folder. In this example, we excuted this task for two
files(Blairon.pdf: 22MB and Dansk Droge.pdf: <1MB).
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‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to duplicate (>
10MB). Therefore, the task ended in ‘Warning’ state (due to exitValue=1 in the code) and added an entry in
the task details.

Scripting for Script Runner on Windows

A Script Runner on Windows supports Windows Script and Batch File. We recommend Windows Script for its
scripting abilities comparable to batch files, its wider range of supported features and the simpler syntax. Windows
Script is plain-text VBScript or JScript which is interpreted and run by the Windows Script Host.

Using Windows Script on Script Runner

1. Open a text editor and add the following code:
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Function Main The function that will be called by the Script
Runner. Script Runner executes only the code
in this main function.

inputs First argument of main function: a list of
input file paths(type: list of strings).

outputFolder Second argument of the main function: the
folder where AE expects the script’s result
files. AE will continue the flow with the
files you write in this folder. If you leave
this folder empty, AE will continue the flow
with the inputs of the Run Script task (type:
string).

params Third argument of the main function:
additional script parameters injected into the
script via the Run Script ticket (type: list of
strings).

WScript.Echo This puts some extra log info in the Run
Script task details and log. This call prints
text to the Console and adds a newline
character without Script Runner context.

Main = “OK” This will communicate with the Run
Script task that everything went fine. Other
possibilities are Main = “Warning” and
Main = “Error”.

2. You can test this script locally by adding the following code: Save this file. Open command prompt. Change
the directory to the script’s parent directory. Run command ‘cscript MyHelloWorld.vbs’.
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This will produce the output ‘Hello, World!’ to the console. The Script Runner does not attend to the test code in
your script. It will execute the contents of the main function and ignore the rest. Therefore, you can keep your test
code for future local testing.

3. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New Task. Choose
the Run Script task, modify its settings and launch the task.

Note that the ‘Hello, World!’ in the task details and ‘OK’ state are corresponding with WScript.Echo
“Hello, World!” and Main = “OK” in the script.
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Using Windows Script On Script Runner: A Sample Case
In this example, we use Windows Script to copy every input file with a size smaller than the size specified in the
script parameters to the output folder.

We can use inputs, outputFolder and params in the AppleScript to achieve our objective. First, we
demonstrate how to duplicate files without the size restriction and then proceed with the actual use case.

1. Open a text editor and add the code given below. This code is aimed to iterate through the list of inputs. It enables
you to handle the inputs one by one, via the ‘input’ variable.

2. You can modify the Script as given below to duplicate the files to a specified output folder without size
restrictions. Save this code as a text file with ‘.vbs’ extension (VBScript) in the Windows Script folder of Script
Runner (default: C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\WindowsScript) or in the Automation
Engine WindowsScript folder.
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3. Add the file size check in the code as given below. This will duplicate the file when the input file size is smaller
than the maximum size from the script parameters. If this condition is not met it will add an entry in the log and
there will be "Warning". Save the file.
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4. Open the Automation Engine Pilot. Go to Files view where you can select the files to be copied and open a New
Task. Choose the Run Script task, modify its settings and launch. This modified ticket will duplicate every
selected file which is smaller than 10MB to the current job’s Script Output folder. In this example, we excuted this
task for two files(Blairon.pdf: 22MB and Dansk Droge.pdf: <1MB).
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‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to duplicate (>
10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task details.

Using Batch File for Scripting on Windows
In this example, we use Batch File to copy every input file with a size smaller than the size specified in the script
parameters to the output folder.

1. Open a text editor and add the code given below. This code is aimed to iterate through the list of inputs. It enables
you to handle the inputs one by one, via the command %1 (the script’s first argument) will contain a string of input
file paths, separated by ‘;’.
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2. You can modify the Script as given below to duplicate the files to a specified output folder with a size check.
Save this code as a text file with ‘. bat ’ extension in the Script Runner Batch File Folder (default: C:\Esko
\bg_data_fastserverscrrunnt_v100\Scripts\BatchFile) or in the Automation Engine BatchFile folder.
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%1 First batch file argument: the Run Script
task’s inputs. A string of input file paths,
separated by ‘;’.

%2 Second batch file argument or output folder:
the folder where AE expects the script’s
result files. AE will continue the flow with
the files you write in this folder. If you leave
this folder empty, AE will continue the flow
with the inputs of the Run Script task.

%3, %4,%5… Remaining batch file arguments: additional
script parameters, injected into the script via
the Run Script ticket.

Exit value Ending Status of the task
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0 OK

1 Warning

2 Error

3. Open the Automation Engine Pilot. Go to Files view where you can select the files to be copied and open a New
Task. Choose the Run Script task, modify its settings and launch. This modified ticket will duplicate every
selected file which is smaller than 10MB to the current job’s Script Output folder. In this example, we excuted this
task for two files(Blairon.pdf: 22MB and Dansk Droge.pdf: <1MB).

‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to duplicate (>
10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task details.

Using ExtendScript on Script Runner(On MacOS/Windows)
A Script Runner supports direct interpretation of ExtendScript by the Adobe Creative Suite (CS) application selected
in the Run Script ticket.

ExtendScript is JavaScript extended for Adobe CS applications. Adobe provides a complete integrated development
environment (IDE) for programming ExtendScript which is the ExtendScript Toolkit (ESTK). Latest versions of the
ESTK are available with the Creative Suite. For more info and Adobe scripting resources visit the Adobe Scripting
Center.
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1. Open the ExtendScript Toolkit and add following code. Save this code in the Script Runner’s ExtendScript
folder. The default location is : /Library/Scripts/Esko/ExtendScript for a Script Runner on Mac OS or C:\Esko
\bg_data_fastserverscrrunnt_v100\Scripts\ExtendScript on Windows. Alternatively, you can save them in the
ExtendScript folder of Automation Engine.

 

 

Main This function will be called by the Script
Runner. Only the code in this main function
gets executed.

Inputs First argument of main function: a list of
input file paths (type: list of strings).

outputFolder Second argument of the main function: the
folder where AE expects the script’s result
files. AE will continue the flow with the
files you write in this folder. If you leave
this folder empty, AE will continue the flow
with the inputs of the Run Script task (type:
string).

params Third argument of main function: additional
script parameters, injected into the script via
the Run Script ticket. (type: list of strings)

$.writeln This writes extra log information in the Run
Script task details and log. Without Script
Runner context this call prints text to the
Console, and adds a newline character.

alert This registers some extra log info in the Run
Script  task details and log. Without Script
Runner context this call displays an alert box.

return “OK”; This will communicate with the Run
Script task that everything went fine. Other
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possibilities are Return = “Warning”
and Return = “Error”.

2. To test the script locally in the ExtendScript Toolkit, add following code, save and run.

 

 

Note that the alert box pops up and the ‘Hello, World!’ and ‘OK’ result in the Console.

 

The Script Runner does not attend to the test code in your script. It will execute only the contents of the main
function and ignore the rest. Therefore, you can keep your test code for future local testing.

3. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New Task. Choose
the Run Script task, modify its settings and launch the task.
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Note that the ‘Hello, World!’ in the task details and ‘OK’ state are corresponding with $.writeln("Hello
World!")  and Return = “OK” in the script.

Using ExtendScript on Script Runner: A Sample Case.
In the following example we are going to use ExtendScript to Open a file in Illustrator and print it using a Print
Preset.  

Note:  When you use ExtendScript on Windows, you can avoid troubles while accessing your user specific
settings such as Adobe applications' Presets , Actions etc by stopping the Script Runner service and running
it as an application for the logged in user (who also defined Adobe settings).

Open  Start > All Programs > Esko > Automation Engine Script Runner > Preferences .

Stop the Script Runner and uncheck Start at login (which actually means ‘Start as service’) and Close
Preferences.

Start as a console application by double clicking its executable: Script Runner’s program folder>
\bin_ix86\egscrrun.exe (e.g.C:\Esko\bg_prog_fastserverscrrunnt_v120\bin_ix86\egscrrun.exe)
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Note:  To prevent having to start up the Script Runner every time you log in, add its executable to your
user’s/system’s Startup Items.

1. Define a My Print Preset in your Adobe Illustrator application.

2. Open the ExtendScript Toolkit and add following code. This code is aimed to iterate through the list of inputs. It
enables you to handle the inputs one by one, via the input variable.

3. To print every input file using a Print Preset from the script parameters of the  Run Script task, write the code as
below. Save this code in the default ExtendScript folder(of Script Runner or Automation Engine).

4. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New Task. Choose
the Run Script task, modify its settings and launch the task.
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Launching this ticket will result in the selected Illustrator files being printed using the Print Preset specified as
script parameters (My Print Preset) in the task.

Appendix : Script Samples

Note:

Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These scripts are solely
intended to demonstrate techniques for accomplishing common tasks. Additional script logic and error-
handling may need to be added to achieve the desired results in your specific environment.

 

It is up to the user to verify that his intended use of the offered automation functionality is compliant with any
third party license agreement and/or other restrictions applicable to any non-Esko products.

AppleScript Code Samples

MyHelloWorld.applescript

on main(inputs, outputFolder, params)
 log "Hello, World!"
 return "OK"
end main
on run
 -- Our main function is not using any of its arguments, so provide empty ones
 set inputs to {} -- empty list
 set outputFolder to "" -- empty string
 set params to {} -- empty list
 main(inputs, outputFolder, params)
end run

MyDuplicate.applescript

on main(inputs, outputFolder, params)
 set returnValue to "OK"
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 -- Translate the output folder (UNIX path) into an AppleScript file reference
 set outputFolderReference to POSIX file outputFolder
 
 -- Get the maximum size from the script parameters and convert from megabyte
 to bytes
 set maxSize to (item 1 of params) * 1000000
 
 -- Iterate through the list of inputs
 repeat with input in inputs
  -- Translate the input (UNIX path) into an AppleScript file reference
  set inputReference to POSIX file input
  
  -- Get the size of the input
  set inputSize to size of (info for inputReference)
  
  -- Check wether the input is OK to duplicate
  if inputSize < maxSize then
   -- Duplicate input to output folder
   tell application "Finder" to duplicate inputReference to
 outputFolderReference with replacing
  else
   log input & " is too big to duplicate"
   set returnValue to "Warning"
  end if
 end repeat
 
 return returnValue
end main

Shell Script Code Sample

MyCopy.sh

#!/bin/bash

# Split up the input file paths into a list
# via the Internal Field Separator (IFS)
OLDIFS=$IFS # Always keep the original IFS
IFS=":" # Now set it to ':'
# Split up '$1' into the 'inputs' variable, with ':' as separator
inputs=( $1 )
IFS=$OLDIFS # Restore the original IFS

inputCount=${#inputs[@]}

# Get the output folder
outputFolder=$2

# Get the maximum size from the script parameters
# and convert from megabyte to bytes
maxSize=`expr $3 \* 1000000`

exitValue=0

# Iterate through the list of inputs
for (( i=0; i<${inputCount}; i++ ));
do
 input=${inputs[$i]}
 # Get the size of the input
 inputSize=`ls -l "$input" | awk '{print $5}'`
 
 # Check wether the input is OK to copy
 if [ $inputSize -lt $maxSize ]; then
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  # Copy input to output folder
  cp -f "$input" "$outputFolder"
 else 
  echo "$input is too big to duplicate"
  exitValue=1
 fi
done

exit $exitValue

Windows Script Code Samples

MyHelloWorld.vbs

Function Main(inputs, outputFolder, params)
 WScript.Echo "Hello, World!"
 ' Set the function's return value.
 Main = "OK"
End Function

' Our main function is not using any of its arguments,
' so provide empty ones.
Dim inputs()
Dim outputFolder
Dim params()
Main inputs, outputFolder, params

MyCopy.vbs

Function Main(inputs, outputFolder, params)
 Dim returnValue
 returnValue = "OK"
 
 ' Get the maximum size from the script parameters
 ' and convert from megabyte to bytes.
 Dim maxSize
 maxSize = params(0) * 1000000
 
 ' Create the file system object that is going to do the copying.
 Dim filesys
 Set filesys = CreateObject("Scripting.FileSystemObject")
 WScript.Echo "File system object created"
 
 ' Iterate through the list of inputs.
 For Each input In inputs
  ' Turn the input path into a file object.
  Dim inputReference
  Set inputReference = filesys.GetFile(input)
  
  ' Check wether the input is OK to copy.
  If inputReference.Size < maxSize Then
   ' Copy input to output folder.
   Dim outputFile
   outputFile = outputFolder & "\" & filesys.GetFileName(input)
   filesys.CopyFile input, outputFile
  Else
   WScript.Echo input & " is too big to copy"
   returnValue = "Warning"
  End If
 Next
 
 ' Set the function's return value.
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 Main = returnValue
End Function

Batch File Code Sample

MyCopy.bat

@echo off
rem First script argument contains the input file paths
set inputs=%1
rem Trim surrounding quotes
for /f "usebackq tokens=*" %%a in ('%inputs%') do set inputs=%%~a

rem Get the output folder
set outputFolder=%2

rem Get the maximum size from the script parameters
rem and convert from megabyte to bytes
set /a maxSize=%3*1000000

set exitValue=0

rem Iterate through the input file paths which are separated by ';'
:ITERATE_INPUTS
if "%inputs%"=="" goto EXIT
for /f "tokens=1 delims=;" %%a in ("%inputs%") do call :HANDLE_INPUT "%%a"
for /f "tokens=1* delims=;" %%a in ("%inputs%") do set inputs=%%b
goto ITERATE_INPUTS

:HANDLE_INPUT
rem Get the size of the input
for %%? in (%1) do set inputSize=%%~z?
rem Check wether the input is OK to copy
if %inputSize% lss %maxSize% (
 rem Copy input to output folder
 copy /y %1 %outputFolder%
) else (
 echo %1 is too big to copy
 set exitValue=1
)
goto :eof

:EXIT
exit %exitValue%

ExtendScript Code Samples

MyHelloWorld.jsx

function main (inputs, outputFolder, params) {
    $.writeln ("Hello, World!");
    alert ("Another way to say: Hello, World!");
    return "OK";
}
// Our main function is not using any of its arguments, so you can test main
 without arguments
main ();

MyPrint.jsx

function main(inputs, outputFolder, params) {
    // First and only script parameter is the print preset.
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    var printPreset = params[0];
    
    var returnValue = "OK";
    
    // Iterate through the list of inputs.
    for (i=0; i<inputs.length; i++)
    {
        var input = inputs[i];
        
        try
        {
            // Open the input file.
            var myDocument = app.open(File(input), DocumentColorSpace.CMYK);
            // Create print options and set the print preset.
            var options = new PrintOptions();
            options.printPreset = printPreset;
            // Print the document.
            myDocument.print(options);
            // Close the document without saving.
            myDocument.close(SaveOptions.DONOTSAVECHANGES);
        }
        catch (e)
        {
            // Log problem info and set the return value to "Warning".
            $.writeln("Problem while printing " + input);
            $.writeln("Name: " + e.name);
            $.writeln("Message: " + e.message);
            returnValue = "Warning";
        }
    }

    return returnValue;
}
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